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Modeling Fundamentals

Modeling is the practice of constructing a graphical
representation of something real for the purpose of studying,
documenting, reasoning, testing or communicating it to
others. The resulting models can be compared to machines
that do work and often provide deep insights into the way
things in the real world are structured or behave. Enterprise
Architect is typically used to model complex enterprise,
business, engineering, real-time and software systems, and
is a multi-disciplinary platform that facilitates teams of
people working together to describe, visualize, construct and
test complex systems through the use of modeling.
Enterprise Architect's modeling platform is based on the
Unified Modeling Language (UML), a standard that defines
rules and notation for software-centric systems but that can
be extended to allow any type of system to be modeled.

Modeling Features

Feature Description

Models Models are the top level of an Enterprise
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Architect Project. A Project can have one
or many models contained within it.

Views Views provide unique windows and
dialogs to explore the relationships of the
elements in your model.

Packages Packages are the containers for your
elements and your diagrams. Their
contents can be viewed in many different
ways dependant on your needs.

Diagrams Diagrams are used to define specific
relationships between a select number of
elements in a visual manner.

Elements Elements are the building blocks of your
model; create and reuse elements to build
up your systems.

Connectors Connectors define the relationships
between modeled elements.

Tagged
Values

Extend the default properties of modeled
elements, connectors and features with
custom properties called Tags that can be
given values.
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Notes Provide a text-based description of
modeled: elements, connectors features,
diagrams and more. Notes can be shown
on the diagram, in the element or from
the Notes View.

Hyperlinks Hyperlinks add an incredible versatility
to both navigation of your model and the
provision of information through the
various methods of communication
within your project. In developing your
model, you inevitably have to store
information and structures in different
places for different purposes and in
different formats. Creating hyperlinks
helps you to draw separate objects and
documents together wherever appropriate
to define or support a given context.

Templates
and Wizards

Use patterns, templates and wizards to
rapidly build your models. Use
pre-existing ones, or create your own!

Automation Extend the power of Enterprise Architect
to create your own domain-specific
Add-Ins, scripts and functionality.
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Structural Components

Using Enterprise Architect, you can quickly build a model
using a hierarchy of Packages to represent the structure and
organization of the model.

Component Description

Models A model is the highest conceptual level,
representing a distinct and complete
representation of all or some part of a
modeled system.
A Project can contain multiple models.

Views Views are the second level within a
model and define a specific viewpoint of
the system being modeled - for example a
Use Case view, a Requirements View or
a Dynamic (behavioral) View.
Views are simply Packages that have an
additional conceptual meaning.

Packages The basic containers that create the
overall model structure. Packages hold
other Packages, elements, diagrams and
similar model constructs.

Diagrams Diagrams are visual representations of
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how model elements are connected or
behaviorally related. They can also
display the characteristics of an element,
such as attributes, methods, notes and
Tagged Values in a convenient visual
style.

Elements Elements are the basic building blocks of
models. They represent both structural
constructs such as Classes and Interfaces,
as well as behavioral constructs such as
Activities, Actions and States.

Connectors Connectors represent the various kinds of
relationship between elements within a
model - including behavioral
relationships, associations, taxonomic
relations and similar.

Tagged
Values

Tagged Values are customizable, profile-
or user-defined properties that are
generally related to a Stereotype and
define additional attributes and
characteristics of an element. They are
one of the fundamental means of
extending UML into more
domain-specific areas.

Notes Notes are the standard common
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language-based descriptions of what an
element, diagram, feature or relationship
is for and how it is used within the model.
Notes are often used as a first step to
eliciting the meaning and use of an
element - which is later refined into
something more concrete and precisely
specified.

Reference
Information

A variety of basic types of information
that is used across a particular model - for
example, Stereotypes or Tagged Values.
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Translation Facilities

Enterprise Architect is used in almost every country in the
world, and versions of the product are available in which the
user interface and Help system are defined in one of several
common natural languages. The model content is then
written and read in the same natural language. However,
now more than ever teams are engaged in distributed
modeling, and collaborative development has become the
norm in the business, technology, engineering and scientific
communities. Much of this collaboration takes place across
not only temporal and geographical boundaries, but also
linguistic boundaries as the models are read, digested and
augmented by groups of people who speak different natural
languages.

Enterprise Architect (using a built-in Cloud integration
service) provides a way for individual users to display a
translation of the descriptions (notes) for various objects
such as elements, operations and connectors. The
mechanism uses a built-in and exemplar integration service
layer to connect to remote translation services provided by
Google and Microsoft. This means that a model developed
in, say, Switzerland using German can be translated and
viewed in Canada in English. A German modeler might
define a Requirement element named 'Das System muss die
ausgewählten Kanaleinstellungen anzeigen' and a Canadian
modeler could translate and view that Requirement as 'The
system must display the selected channel preferences'.  Not
only that, but either modeler is likely to have
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French-speaking colleagues who would prefer to translate
the same Requirement into French as 'Le système doit
afficher les préférences de canal sélectionnées'.

You can also record translations of element and operation
names. Modeling can thus overcome not only temporal and
geographic barriers, but linguistic barriers as well.

A Glossary facility also exists to override the translation of
terms that are proprietary, such as product names, or
in-house vernacular that should not be translated; this
mechanism also provides specifically-defined translations of
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terms for which the translation services would not provide
the best result. A user can also manually update translated
notes, and when the original text is updated the edited
translation will be flagged as potentially out-of-date.

Documentation can be generated to any selected language,
providing a way of producing a software and portable model
narrative accessible by almost anyone in the world - perfect
for cross-linguistic teams that have contractual obligations
to have formal documentation in a number of languages.

In brief, the facilities of the Enterprise Architect text
translation feature include:

An Integration plug-in that enables connections to internet·

translation facilities via Pro Cloud Server version 4.1 and
above; available in the Corporate, Unified and Ultimate
Editions of Enterprise Architect, for automatic
translations

A 'Translations' page of the 'Manage Model Options'·

dialog, through which you configure the mode of
translation, the translator application, translation options
and the languages from and to which to translate the text,
for the model (if User Security is enabled, you require
'Manage Reference Data' permissions to do this)

Separate tabs in the Notes window to enter and display the·

Notes text in the local (or primary) language and to enter
or initiate translations of that text; the 'Translation' tab
enables you to select from a range of languages and to
force or automatically apply translation (if using an
internet translator application)

A manual translation facility that enables you to type, in·
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the 'Translation' tab of the Notes window, translations of
the Notes text displayed in the 'Local' tab; available in all
editions of Enterprise Architect

Notes text context menu options to flag specific instances·

of a term for customized translation or for protection from
translation

A tab of the Properties window for elements and·

operations to manually record the translated object name
and alias in each of the selected languages

Glossary model elements that you can use to either block·

translation of a term within a section of text, or ensure that
it is translated to a specific text string

An option in the 'Generate Document' dialog, 'Generate'·

tab to specify the language in which to generate the
document

Configuring Automatic Translation

Automatic translation using an external translation service is
configured as a Data Provider in the Integration Plug-ins
facility of the Pro Cloud Server.

The procedures to configure Integration Plug-ins and to
specify the Data Provider are fully documented in the
Integration Plug-ins Install and Configure and Add/Edit
Data Provider Help topics. However, this summary of steps
puts the procedures in the context of the automatic
translation service:

Open the Sparx Systems Pro Cloud Config Client.1.
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Click on the 'Integration' tab.2.

Click on the Add button to display the Add Data Provider3.
window.

Tick the 'Enabled' checkbox.4.

Give the service a name.5.

Click on the drop-down arrow in the 'Provider' field and6.
select 'Translator'.

In the 'Custom Properties' panel, select a Translation7.
Provider, such as Google or Microsoft.

You will then need to restart the Pro Cloud service. We
suggest you reboot the machine. Then, when you open the
selected repository, automatic translation should now be
available.

Note that as this is using an external translation provider it
might incur a cost on the data translated and might require
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setting up an account with the provider

The Properties Window Translation Tab

If you have enabled the Notes Translation facilities, and you
are reviewing elements, connectors, attributes or operations,
the Properties window has a 'Translation' tab containing two
categories - 'Name' and 'Alias'. Each category has a field for
each of the selected languages.

Simply click on each of these fields and type in the
translation of the object's Name and/or Alias in the
corresponding language. The languages are specified in the
'Manage Model Options' dialog for your model, by the
model administrator.
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The Data Miner

The Data Miner provides a comprehensive means of
extracting data from a range of external data sources
including: databases (ODBC, ADO, OLEDB, JET), text
files (XML, JSON, plain text), Excel (xls, CSV), and online
files or URLs.

The goal is to create a reproducible import process defined
in a model format. This consists of:

Data configuration process to hold the complex data·

connections and information

Combined with the ability to run JavaScript over the data·

set
DMConnection DMScripts

+ ProcessData(): void

DMSet

«SSHarvester»«SSDataSource»

This feature is available in the Unified and Ultimate
Editions of Enterprise Architect, from Release 15.0.

Access

The Perspective for the Data Miner is: Perspectives >
Management > Data Miner.

The Data Miner diagram and several model patterns can be
accessed through the Model Wizard (Start Page 'Create from
Pattern' tab), while a number of model templates, model
elements and connectors specific to the Data Miner facility

(c) Sparx Systems 2022 Page   35 of 1974



Modeling Fundamentals 3 October, 2022

can be accessed from the Diagram Toolbox.

Data Miner Model

The Data Miner Model allows you to define three core
element types:

Element Type Description

DMConnecti
on

A DMConnection element is used to
define a connection to an external data
source. Any number of DMConnections
can be defined.

DMSet A DMSet provides the link between the
connection and the script that processes
the data. It can define a query that will be
applied on the connection for connection
types that require it. For example, an
ODBC DMConnection will require a
DMSet that specifies an SQL Statement
in the Query custom property, where a
File DMConnection does not require the
DMSet Query to be used.
When performing data mining using SQL
expressions (via ODBC or from an
Enterprise Architect repository), you can
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visualize the retrieved data in a grid view,
by right clicking on the DMSet element,
and selecting 'Open Data Miner
Visualizer'. This will display the returned
data in a table form.

DMScripts A DMScript element can be used to
process the raw data returned from a
DMSet. It can contain one or more
JavaScript scripts to process the retrieved
data using the Automation Interface.

Multiple connections

A full Data Miner is defined by a DMConnection connected
to a DMSet, optionally connected to a DMScripts. The
mining capability can be extended in numerous ways:

Multiple DMSet elements can query the same·

DMConnection

Each DMSet can be connected to multiple DMConnection·

elements

Each DMScripts can process multiple DMSet elements·

Each DMScripts element can have multiple scripts to be·

run on the data
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Notes

The Data Miner is available in the Unified and Ultimate·

Editions
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Data Miner Toolbox

To create Data Miner elements and relationships on Data
Miner diagrams, you can use the 'Data Miner' page of the
Diagram Toolbox. The Data Miner diagram and several
model patterns can be accessed through the Model Wizard
(Start Page 'Create from Pattern' tab), while a number of
model templates, model elements and connectors specific to
the Data Miner facility can be accessed from the Diagram
Toolbox.

Access

Use the methods outlined here for displaying the Diagram
Toolbox for the Data Miner and accessing Model Wizard
patterns.

Perspective Perspective > Management > Data Miner

Model
Wizard

Set the Perspective: Perspective >
Management > Data Miner
Use the Model Wizard (Start Page 'Create
from Pattern' tab) (Ctrl+Shift+M):

Management >  Data Miner > (select·

pattern) or
Diagram > Type > Management > Data·

Miner > (select Data Miner diagram)
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Ribbon Design > Diagram > Toolbox -   to
display the 'Find Toolbox Item' dialog
and specify 'Data Miner'.

Keyboard
Shortcuts

Ctrl+Shift+3 :  | Data Miner

Data Miner Elements

Item Use to

DMConnecti
on

Defines a connection to an external data
source.

DMSet Defines an intermediate element in the
link between a DMconnection and a
DMscript which is used to process the
data.

DMScripts The element type that contains JavaScript
script(s) for retrieving data using the
Automation Interface.
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Data Miner Connectors

Item Use to

Data Source Used for setting a connection from a
DMSet to a DMConnection.

Data
Harvester

Defines a connection from a DMScript to
a DMSet.
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Data Sources

A DMConnection element sets the connection to the
external data source. The connection types that are
supported include:

ODBC - for connecting external databases·

EA Repository - sets a connection to an Enterprise·

Architect repository

File - for file types such as CSV and XML·

External Data - access to Pro Cloud Integration·

URL - HTTP GET and POST·

Setting a Data Type

To set the Data Source Type, in the Properties window,
under DMConnection,  select the Type from the drop-down:
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With the DMConnection Type selected, you can now enter
the connection details based on the type selected.

Type Description

ODBC (Open
Database
Connectivity)

An ODBC connection can be used to
connect to external databases or
database-like providers. Direct
connections can be made to local
Microsoft Access or Firebird files, or an
existing ODBC connection can be used to
connect to any other ODBC database
provider.
To set an ODBC connection:

Right-click on the DMConnection·

element
Select 'Edit Data Miner Connection'.·
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Select the type of database to connect to
and follow the prompts to select the
database.

Enterprise
Architect
Repository

Directly connect to another Enterprise
Architect repository by selecting this
type.
To set a connection to a repository:

Right-click the DMConnection element·

Select 'Edit Data Miner Connection'·

Click on the Add New button to select·

the connection type.
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File Some file types can be used in the Data
Miner. In general the DMScripts
processor will be given the text from the
file. The Data Miner doesn't attempt to
interpret the file in any way, so the script
must ensure it is in the expected format.
To set a connection to a file:

Right-click the DMConnection element·

Select 'Edit Data Miner Connection'·

External Data The Data Miner External Data connection
is for linking to an existing Enterprise
Architect Integration external source.
This requires that the Pro Cloud
Integration feature has been configured to
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access an external source.
To configure an External Data
connection:

Select from the Ribbon : Specialize >·

Tools > System Integration > Open
External Data
Browse to the list of items to be·

retrieved
right-click on the Integrations menu·

item and select 'Create Data Miner'.

This will create a DMConnection element
with all the required connection settings
to retrieve the external data.

URL Text can be retrieved from online by
specifying a URL. It's possible to add
simple authentication and extra headers
to the request and to send as a HTTP
'GET" or 'POST' request.

Right-click the DMConnection element·

Select 'Edit Data Miner Connection'·
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The Data Miner will not attempt to
interpret the data. It will pass it to the
DMScripts as simple text.
Properties:
URL - Set the URL to access the data.
Method - Options:

GET·

POST·

PUT·

User - Sets the User Name for authorized
access.
Password - Sets the user access
password.
Ignore SSL Errors - Set this to ignore
returned SSL errors.
Data to POST - Send additional data
along with the request when the server
requires it. Setting this is usually only
required when a 'method' is 'POST' or
'PUT'.
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Additional Headers - Set any additional
headers required in the URL. Standard
headers will be included automatically.
Note: Check the API documentation of
the server for any required headers.

Notes

The settings are stored in the Data Miner section in the·

element Properties, in the 'Path' field; while this memo
field can be edited directly, we recommended that you
avoid doing so

Each DMConnection can be harvested by multiple DMSet·

elements

Multiple DMConnection elements can be harvested by a·

single DMConnection
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Data Miner Set

A Data Miner Set element (DMSet) can be used to return a
set of data from a DMConnection element. It will retrieve
data from all DMConnection elements that it is connected
to, and optionally run a query on connections that support or
require it.

Data Miner Set  - Type

The Data Miner has two options for the Type:

SQL·

None·

The SQL Type setting can be used with Data Sources that
are set to the Type - 'ODBC' or 'EA Repository'. For the
other Data Source types, set this option to None. The DMSet
Type is set in the Properties window (Ctrl+2) > DMSet >
Type.
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Data Miner Visualizer

For a Data Miner Set that is typed as SQL, you can access
the Data Miner Visualizer. This is used for setting a SQL
query to be run, that returns the set of data to be processed
in the Data Miner Script. The Visualizer also shows the
results of the SQL query.

To access this:

Right-click on a DMSet element·

From the context menu, select Open Data Miner·

Visualizer

For more details see the Data Miner Visualizer Help topic.

Notes

Each DMSet can harvest data from multiple·

DMConnection elements

Multiple DMSet elements can harvest data from a single·

DMConnection
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Data Miner Visualizer

If you are using an SQL query, the Data Miner Visualizer is
a handy way to see the data that will be retrieved by the
Data Miner. It provides a quick and easy means to modify
the SQL query and check the returned data.

To create a query:

Right click the DMSet element·

Select 'Open Data Miner Visualizer'.·

Type in the query to be run·

Click the play button.·

For a correct SQL statement this will return a set of rows
containing the retrieved data.

Where there are connections to multiple DMConnection
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elements, use the drop-down to select another
DMConnection.

The Data Miner Visualizer has two tabs:

Query·

This is where the SQL query is defined.
Click on  button to test the query.
Click on the  button to save the query to the DMSet -
Query.

Scratch Pad·

The Scratch Pad can be used to test out new queries
without having them saved to the DMSet element.
Click on  button to test the query.
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Data Miner Scripts

A Data Miner Scripts element (DMScripts) can be used to
process the raw data returned from a DMSet. The script is
written in JavaScript and will receive the data in a number
of different formats, depending on the source.

Add a new script

The scripts to be run are defined as 'Operations' on the
DMScripts element. Add one or more operations and define
the JavaScript code to be run on the Data Miner data.

For access to starter scripts you can use a Pattern or use the
Model Wizard to create a new Data Miner model:

Select a Package in the Browser window·

Set the Perspective to: Perspective > Management > Data·

Miner.

Then either:

Create a new Data Miner diagram·

Drag a Pattern from the Toolbox·

Or:

Open the Model Wizard (Start Page > 'Create from·

Pattern')

Locate the Data Miner pattern you want to use·

Click on the Create Model(s) button to create one of the·

Data Miner models in your Package
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The DMScript element will contain sample JavaScript code
to use as a starter for creating your own Data Miner.

Connecting a script operation to a DMSet

The connection between a DMScript and a DMSet must be a
connection to a specific operation in the DM Script element,
not just to the DM Script element itself. The connector type
is 'Harvester'.

To set this connection:

Select the DMScripts element·

Click on the operation in the element·

This will show the Feature Linker on the side of the
element:
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Drag the Feature Linker to the DM Set element·

Select Harvester in the context menu.·

Each script operation can be connected to multiple DMSet
elements and, when run, will receive each data set in turn.

Script

The script is written in JavaScript and uses the Data Miner
Package automation classes. To access the Script for
editing:

Select the DMScripts element·

Right-click on the element·

Select Edit Data Miner Processor.·

For more details on using the Data Miner automation, see
the Data Miner Package Help topics. For more details on
using the automation to create elements and connectors in
the model see the Element Package and Connector Package
under the automation Reference Help topic.

Run the Data Miner

Run all scripts:

Right click on the DMScripts element·

Select Run Data Miner Processor.·
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Run a specific script:

Select the script operation in the DMScripts element·

Right click the script operation and select Run.·
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Model Perspectives

Enterprise Architect is used by a wide range of teams, from
executives and Business Architects who model
organizational change and strategic direction at the highest
level, through to Technology Architects who model
infrastructure and implementation at the lowest level, with a
large number of other disciplines in between. These
additional disciplines include Business Analysts, Process
Analysts and Requirement Analysts; Information Architects,
Data Architects, Application Architects and Security
Architects; System Engineers and Product Engineers;
Testers; Scrum Masters and many more.

Enterprise Architect has a huge range of available features
supporting these disciplines that, when seen together, might
be difficult to assess. To ensure a modeler can quickly
identify and use the features of greatest value to the role
they are performing at a particular time, Perspectives have
been created to bundle the features - including modeling
languages and example patterns - into sets. This allows you
to effectively change roles and focus simply by switching to
another Perspective - almost like putting on a different hat.
When a Perspective is selected the tool instantly changes to
hide the irrelevant features and only display the ones
defined for that Perspective. Some modelers might select or
be assigned a single Perspective for the lifetime of a role or
project, whilst others might switch Perspectives five or six
times a day.
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The Perspectives are completely configurable, allowing fine
grain inclusion (and thus exclusion) of language constructs
and tool features; this can be done at a whole-model level,
security group level or personal level.

Perspectives:

Are selections of Technologies - some specific to one of·

the many modeling languages - and their model and
diagram Patterns

Are tailored to domain-specific modeling scenarios; when·

you work in a specific domain, you can apply a
Perspective to expose appropriate facilities and hide all
others

Remove the significant distraction of having to identify·

and assess multiple technologies before proceeding with
your work
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Help you to select and apply an environment of particular·

modeling languages or Technologies, enabling you to
work effectively and efficiently on the task at hand

Help you to switch easily and quickly between tools when·

your modeling focus changes; you simply select another
Perspective from the list of Perspective Sets (which
identify the domain they support) and Enterprise Architect
then hides the features of the previous Technologies and
applies the new environment

Initially you can select from the built-in Perspective Sets
and the more than eighty Perspectives they provide. As your
experience in modeling with Enterprise Architect develops
and your work becomes more specific, you can create
custom Perspectives either just for yourself or for all users
of the model. This helps you work within a Technology that
you might have recently imported and activated, or apply a
combination of Technologies that are not associated in the
built-in sets.

Overview

You select and switch to the required Perspective through:

The <perspective name> option at the top right of the·

screen (which identifies the currently-active Perspective),
or

Through the 'Start > All Windows > Perspective'·

drop-downs in the ribbon, or

Directly through the Perspective Portal in the Portals·
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window

Selecting a built-in Perspective automatically brings up the
Start Page 'Create from Pattern' tab (the Model Wizard),
which provides a rich set of new model patterns and
guidance notes, filtered to narrow down the available
patterns, technologies, diagram types and other modeling
constructs to the precise set required, with similar actions on
the Diagram Toolbox pages and dialogs. This helps you to
quickly build accurate, focused models with minimal 'noise'
and maximum fidelity.

Applying a Perspective mainly takes place through the
Model Wizard, 'New Diagram' dialog, Diagram Toolbox
and 'Stereotypes' dialog, for creating model structures. Note
that the <perspective name> option sets the global
Perspective for the model and in these dialogs and displays,
but the windows, dialogs and ribbons allow you to swap to a
different Perspective for a work task instantly, making it
easy to find and change to the exact modeling tools required
at that moment.

As a huge boost to modeling encompassing several
disciplines and modeling domains, selecting a Perspective
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provides its Technology as an available development tool,
whilst all existing model structures that make use of the
hidden Technologies still render and work as normal.  If you
have a model that contains, say, a BPMN View and a
SysML View, you might apply a Perspective to support the
creation of BPMN structures and see only BPMN templates
and Toolbox items in your BPMN development. But if you
open a SysML diagram during this work, you will still see
the SysML Toolbox pages, Properties pages and options that
enable you to properly examine that diagram.

To further enhance your modeling experience, you can also
use the Perspective Sets window to filter the Perspectives,
hiding complete Perspective sets or individual Perspectives.
This enables you to reduce the list of Perspectives offered
for selection to just those you are likely to use.

Additionally, the model administrator can tailor the
Perspectives and/or ribbons available to each User Security
Group, as a Perspective Setting or Ribbon Set for each
group. This filters the Perspectives available to a user
according to their security group, rather than their personal
choice. See the Perspectives for Security Groups Help topic.

Regardless of which Perspective you select, all of the coding
languages, templates, RTF templates and images remain
immediately available.

For specific instructions on using Perspectives, see the
Using Perspectives Help topic.
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System Perspectives

Enterprise Architect provides a rich set of more than eighty
Perspectives built directly into the application, which have
been crafted to align with the multitude of roles that
modelers perform; these Perspectives are grouped into Sets
that make finding the right Perspective quick and easy, and
include:

Business Sets for Strategy, BPMN, Business Analysis and·

more, helping the business user focus on their current task

SysML, MBSE, Software, Simulation and others, for the·

Systems Engineer and Software Engineer

ArchiMate, TOGAF, Zachman Framework and·

GRA-UML, version-specific Sets that provide the most
common tools for the needs of Enterprise Architects

SPEM, Process Guidance and MDG Technology Builder·

for Project Managers

Each set contains a number of relevant and useful
Perspectives. This image shows an example of the Analysis
Perspective Set, which contains a number of Perspectives.
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For a more comprehensive description of the built-in
Perspectives, see the Types of Perspective Help topic.

Custom Perspectives

In addition to the built-in Perspectives, you can create any
number of your own Perspectives on the 'Model-Based Sets'
or 'Personal Sets' tabs. While the built-in, or system,
Perspectives typically contain a single language or
technology - for example the Business Process Model and
Notation (BPMN) Perspective allows you to focus on just
BPMN  - custom Perspectives allow you to open a number
of technologies at the same time. For example, if you
regularly create prototypes you might want to create a
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'Prototyping' Perspective that groups the technologies and
modeling languages you use in that work.

Custom Perspectives do not automatically open the Model
Wizard.

These custom Perspectives can be created, modified and
deleted as the roles you perform change over time. For
information on creating custom Perspectives, see the
Customizing Perspectives Help topic.
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Types of Perspective

There is a wide selection of built-in Perspectives provided
within Enterprise Architect, each containing a suite of
Patterns. The Perspectives themselves are organized into
groups called Perspective Sets.

Extensive research has been conducted to define sets of
Perspectives that are expertly tailored to meet the needs of
modelers who work in a particular project discipline or team
role. For example, there are Perspectives for strategists,
enterprise and solution architects, requirement analysts, user
experience designers, informaticians, systems engineers and
many more, remembering that a user can switch to another
available Perspective at any time when their role or
modeling emphasis changes. You can select certain sets and
hide others; effectively, it is like having access to fifty
different tools, but all cleverly concealed when they are not
required, allowing you to stay focused on the task at hand
with the tools, workspaces, languages and features that are
needed, including best practice patterns to get your
modeling off to a flying start.

This Types of Perspective topic is a reference, describing
each Perspective Set and Perspective. You can also create
your own Personal Perspectives, which are included under
the second item in the full list of Perspective Sets.

To select and apply any of these Perspectives, see the Using 
Perspectives Help topic.
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Perspectives

Category Perspectives

All This category lists every Perspective Set
and Perspective available.

Personal This category lists every custom
Perspective that is available to you.

Specialized This category lists all Perspectives
provided by imported User Technologies
(including the UML Technology).

UML The UML category provides the
Perspectives for normal UML modeling,
including:

All UML Modeling - all modeling tools·

and objects provided by the other
Perspectives in this group
UML Structural Models - the modeling·

tools and objects for structural UML
models, such as:
     -  Package diagrams
     -  Class diagrams
     -  Object diagrams
     -  Composite Structure diagrams
     -  Component diagrams
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     -  Deployment diagrams
UML Behavioral Models - the·

modeling tools and objects for
behavioral UML models, such as:
     -  Use Case diagrams
     -  Sequence diagrams
     -  Communication diagrams
     -  Timing diagrams
     -  Interaction Overview diagrams
     -  Activity diagrams
     -  StateMachine diagrams

Strategy The Strategy category provides
Perspectives for:

All Strategy - all modeling tools and·

objects provided by the other
Perspectives in this group
Mind Mapping - the basic Mind Map·

diagram
Strategy modeling, such as:·

     -  Organizational Chart
     -  Value Chains
     -  Strategy Maps
     -  Balanced Scorecard
     -  One-level and Two-level Flow 
Charts
     -  Decision Analyses with Decision 
Tree and with Decision Models
     -  SWOT Analysis
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Risk Analysis - the Risk Taxonomy -·

Threat Community diagram

Analysis The Analysis category provides
Perspectives for:

All Analysis - all modeling tools and·

objects provided by the other
Perspectives in this group
Custom Diagram Style - the 'Simple·

Style' diagram rendering for
presentations and non-technical display
of information
Amazon Web Services (AWS) - for·

creating Amazon/AWS diagrams in
Enterprise Architect
Google Cloud Platform (GCP) Icons -·

for creating Google Cloud Platform
diagrams
Microsoft Azure - a new Image library·

of graphics (icons and images) required
to model Microsoft Azure deployments
Whiteboards - diagram structures in·

Whiteboard and/or Hand-drawn mode
Simple Analysis, based on a Two·

Activity Process
Case Management Model and Notation ·

(CMMN) analysis, with a:
     -  Claims Management example
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     -  Basic 5-Task Plan
     -  Three Choice Tasks Pattern
     -  Two Phase Case Plan
Eriksson-Penker Business Extensions ·

(EPBE) modeling, the basic business
process
Web Stereotypes, based on a simple·

Java Server Page (JSP) model

Requirements The Requirements category provides
Perspectives for:

All Requirements - all modeling tools·

and objects provided by the other
Perspectives in this group
Creating a range of Requirement·

Hierarchy diagrams, and a
Requirement Specification View
Working with Decision Model and ·

Notation (DMN) to:
     -  Create a simple Decision diagram
with a Decision Table
     -  Set up a DMN Business
Knowledge Model
     -  Model a DMN Decision
Setting up a Modeling Business Rules·

model
Setting up one-level and two-level Data ·

Flow Diagrams models
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UX Design The UX Design category provides a
number of Perspectives for modeling user
interfaces on various devices, including:

All UX Design - all modeling tools and·

objects provided by the other
Perspectives in this group
User Interaction & Experience for·

various phone and tablet devices
Interaction Flow Models IFML·

Interaction flows on desktop
applications, information entry,
interaction on wireframe devices, and
information searches
A basic Enterprise Architect user·

interface model for a window with lists
and combo boxes
An alternative simple user interface·

Win32 User Interface Dialogs·

Business
Modeling

The Business Modeling category
provides these Perspectives:
All Business Modeling - all modeling
tools and objects provided by the other
Perspectives in this group

Business Process Model and Notation ·

(BPMN) - Patterns for:
     -  BPMN 2.0 modeling
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     -  BPEL 2.0 Starter model
BPSim Business Simulations - Patterns·

for BPMN 2.0 and BPEL 2.0 modeling,
plus:
     -  Patterns for Business Process
Simulation (BPSim) constructs and
     -  Patterns for a number of BPSim
Case Studies
Business Motivation Model (BMM)·

Business Model Patterns for Business·

Use Case models and Use Case
Realization
Business Modeling/Interaction model·

Patterns
BABOK - a wide range of Patterns·

supporting models for:
     -  Strategies
     -  Collaboration activities
     -  Analyses
     -  Business Processes
     -  Project Management activities
     -  Standard business documents
BIZBOK - Patterns for modeling·

BIZBOK activities
Value Delivery Modeling Language ·

(VDML) - Patterns for modeling in
Value Data Markup Language
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Software
Engineering

The Software Engineering category
provides Perspectives for software
development, including:

All Software Engineering - all·

modeling tools and objects provided by
the other Perspectives in this group
Code Engineering, modeling programs·

in a number of programming languages
Service Oriented SOMF 2.1, for·

several Conceptual Association types
SoaML, for modeling aspects of basic·

service provision
XSLT Feature demonstrations, such as·

XSLT transforms and debugging
WSDL - providing a complete WSDL·

template model
XML Schema - providing an XML·

Schema Package and diagram
ICONIX modeling·

Gang of Four (GoF) Patterns Patterns·

for Creational, Structural and
Behavioral models

Systems
Engineering

The Systems Engineering category
provides Perspectives to support Systems
Engineering projects:

All Systems Engineering - all modeling·

tools and objects provided by the other
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Perspectives in this group
Systems Modeling Language (SysML),·

with a wide range of Patterns for
generating:
     -  Project structures
     -  Requirements diagrams
     -  Use Case diagrams
     -  Activity diagrams
     -  Block Definition diagrams
     -  Internal Block diagrams
     -  Parametric diagrams
     -  StateMachine diagrams
     -  Libraries
     -  Model elements
     -  OpenModelica Case Studies
UAF, with Patterns for:·

     -  Strategic Views (St-xx)
     -  Operational Views (Op-xx)
     -  Services View (Sv-xx)
     -  Personnel Views (Pr-xx)
     -  Resources Views (Rs-xx)
     -  Security Views (Sc-xx)
     -  Projects Views (Pj-xx)
     -  Standards Views (Sd-xx)
     -  Actual Resources Views (Ar-xx)
     -  Dictionary View (Dc)
     -  Requirements View (Rq)
     -  Summary and Overview (SmOv)
     -  Information View (If)
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     -  Parameters Views (Pm-xx)
     -  The SysML 1.5 sets (as listed,
except for OpenModelica Case Studies)
Unified Profile for DoDAF/MODAF ·

(UPDM) with Patterns for:
     -  UPDM Frameworks (DoDAF and
MODAF)
     -  DoDAF All Viewpoints (AV-n)
     -  DoDAF Capability Viewpoints
(CV-n)
     -  DoDAF Data and Information
Viewpoints (DIV-n)
     -  DoDAF Operational Viewpoints
(OV-n)
     -  DoDAF Project Viewpoints
(PV-n)
     -  DoDAF Services Viewpoints
(SvcV-n)
     -  DoDAF Standard Viewpoints
(StdV-n)
     -  DoDAF Systems Viewpoints
(SV-n)
     -  MODAF All Views (AV-n)
Viewpoints
     -  MODAF Acquisition (AcV-n)
Viewpoints
     -  MODAF Operational (OV-n)
Viewpoints
     -  MODAF Service Oriented Views
(SOV-n) Viewpoints
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     -  MODAF Strategic Views (StV-n)
Viewpoints
     -  MODAF System Viewpoints
(SV-n)
     -  MODAF Technical Standards
Views (TV-n) Viewpoints
Executable StateMachines, with·

various Patterns including a set to
demonstrate case studies
Matlab/Octave Solvers·

AUTOSAR, by LieberLieber - sets of·

patterns for creating models in
accordance with the AUTOSAR 4
Virtual Function Bus specification in
LieberLieber AUTOSAR Engineer
MARTE - a range of UML-type·

Patterns for creating diagrams under
the 'Modeling and Analysis of Real
Time and Embedded systems' profile
from the OMG

Simulation The Simulation category provides
Perspectives to allow easy access to the
wide variety of Simulation technologies
available in Enterprise Architect:

All Simulation - all modeling tools and·

objects provided by the other
Perspectives in this group
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SysML with Modelica·

UML Behavioral·

Executable StateMachines·

Matlab/Octave Solvers·

BPSim·

Decision Modeling·

Executable Business States·

Win 32 UI Models·

Database
Engineering

The 'Database Engineering' category
provides sets of Perspectives for
modeling a range of DBMS repositories,
including:

All Database Engineering - all·

modeling tools and objects provided by
the other Perspectives in this group
Starter Model and Model Structure·

Patterns for each of the main DBMSs
supported by Enterprise Architect
Patterns for simple Entity Relationship ·

Diagrams (ERDs) models
Patterns for simple ArcGIS ·

Geodatabases projects and workspaces

Enterprise
Architecture

The Enterprise Architecture category
provides a number of Perspectives for
Enterprise Architecture frameworks,
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including:
All Enterprise Architecture - all·

modeling tools and objects provided by
the other Perspectives in this group
ArchiMate Modeling Language,·

supplying Patterns for:
     -  Basic viewpoints such as
Organization, Application Usage and
Service Realization
     -  Motivation Viewpoints such as
for Stakeholders, Principles and
Requirements Realization
     -  Strategy Viewpoints
     -  Implementation and Migration
Viewpoints
The Open Group Architecture ·

Framework (TOGAF), with Patterns
for:
     -  A Starter Model
     -  The Architecture Development
Method
     -  The Enterprise Continuum
     -  The Technical Reference Model
     -  Catalogs
The Zachman Framework·

GRA-UML annotations library and·

starter model

Information The Information Exchange category
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Exchange supports a number of built-in
technologies, providing Perspectives and
basic model Patterns for:

All Information Exchange - all·

modeling tools and objects provided by
the other Perspectives in this group
Ontology Definition Metamodel·

Geography Markup Language (GML)·

Archetype Modeling Language (AML)·

National Information Exchange ·

Modeling (NIEM) 3.0, 3.1, 3.2 and 4.0
Reference Models and NIEM 3 and 4
starter models
SIMF·

Universal Business Language (UBL)·

UML Profile for Core Components ·

(UPCC)
UMM 2.0 Profile·

Publishing The Publishing category provides
Perspectives for communicating
information on the model, including:

All Publishing - all modeling tools and·

objects provided by the other
Perspectives in this group
Document Generation·

Standard Charts·
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Dynamic Charts·

Diagram Legends to define how·

diagram legends are set up and used
Model Glossary·

Construction The Construction category provides these
Perspectives:

All Construction - all modeling tools·

and objects provided by the other
Perspectives in this group
Project Management, for Project·

Management and Roadmap diagrams
Kanban Boards workflows·

Reviews and Discussions to define the·

structure and function of these team
collaboration activities
Construction View to show a simple·

Construction rendering of an element
with its management items, and more
complex diagrams that include the
elements related to the Construction
element
Test Management to define how tests·

are planned and managed
Change Management to define a model·

for managing issues and changes

Management The Management category provides
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Perspectives to support:
All Management - all modeling tools·

and objects provided by the other
Perspectives in this group
The Data Miner·

Software & Systems Process ·

Engineering Meta-Model (SPEM)
Process Guidance - working up process·

templates
The MDG Technology Builder·

Model Add-Ins·

Threat Modeling·

My
Perspectives

The 'My Perspectives' category holds the
Perspectives that you have created for
yourself, using the 'Start > All Windows
> Perspective > Settings' option. For
further details, see the Customizing
Perspectives Help topic.
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Using Perspectives

You can access both built-in and custom Perspectives from
a number of different points. This makes it easy to start your
work in the appropriate environment with the required
Perspective from any point, and to quickly and smoothly
switch to a different Perspective if the need arises.

Conversely, if you prefer to have a wider range of tools and
languages immediately available to you, you can select the
appropriate 'All <perspective group name>' option in the
Model Wizard or  list to filter for all Perspectives for a
domain.

Note that if a 'Perspective for Security Group' has been set
for the model and you are a member of that security group,
you will not be able to change the visibility of Perspectives
as that will be defined by the administrator for the group.

Access

Currently, selecting a built-in Perspective will take you to
the Model Wizard (Start Page 'Create from Pattern' tab).
Some access paths first take you to the Perspectives Portal,
and when you select a Perspective from there the Model
Wizard has focus and you choose the appropriate Patterns to
use (if required).

Other paths take you directly to the Model Wizard, where
you first select the Perspective and then the Patterns to use
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(if required).

Selecting a custom Perspective does not open the Model
Wizard, because custom Perspectives generally expose
combinations of Technologies and facilities, and the system
cannot determine which Technology to open the Wizard at.

Ribbons Start > All Windows > Perspective >
<perspective group> > <perspective>
Design > Package > Model Wizard >
Create from Pattern > <perspective>
Explore > Portals > Perspectives >
<perspective group> > <perspective>

Context
Menu

Right-click on Package > Add a Model
using Wizard > Create from Pattern >
<perspective>

Other Start Page | Open a Portal | Perspective
Portal > <perspective group> >
<perspective>
(Top right corner of screen) >  >
<perspective group> > <perspective>
('My Perspective' options just apply the
custom Perspective)

Navigator Toolbar :  :  >
<perspective group> > <perspective>
In the 'New Diagram' dialog, click on the
Select From button and select the
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required Perspective

Use a Perspective

Having selected a Perspective, and depending on what
Perspective that is, you would expect to see impacts on the
Model Wizard, 'New Diagram' dialog, Diagram Toolbox
and 'Stereotypes' dialog, each offering fewer options more
specific to the Technology or operations you are working in.
For Perspectives related to Code Engineering, the code
editors and code generators might also have a narrower
focus.

As you develop models and/or engineer code, you will see
the structures you require and not have to pick them out
from many other structures of no relevance to the work you
are doing.

Filter Perspectives Available

You are unlikely to use all the Perspectives available in
Enterprise Architect, so if you prefer you can exclude the
individual Perspectives - or complete Perspective Sets - that
you do not need from display in the Model Wizard and 
selection lists. You do this using the 'Perspective Sets'
dialog:

(c) Sparx Systems 2022 Page   83 of 1974



Modeling Fundamentals 3 October, 2022

     Start > All Windows >  Perspective > Settings

The 'Perspective Sets' dialog defaults to the 'System' tab. If
you want to exclude a complete Perspective Set, deselect the
checkbox against that category in the 'Perspective Sets'
panel.

Otherwise, if you want to just exclude individual
Perspectives click on the parent Perspective Set name and,
in the 'Perspectives' panel, deselect the checkbox against the
Perspective name. In this illustration, the CMMN and
Erikson-Penker Model Perspectives have been excluded
from display.

Note that if you exclude a Perspective Set, the checkboxes
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against the individual member Perspectives remain selected.
However, the Perspectives do not show in the selection lists
in, say, the Model Wizard.

If you decide to show any excluded Perspectives again,
return to the dialog and select the appropriate checkboxes.
Alternatively, show all Perspectives as explained in Revert
to All Perspectives.

Revert to All Perspectives

If you have filtered your list of Perspectives, or been
working within a specialized Perspective such as
Requirements or a customized Perspective, and you want to
return to a non-specific environment, either:

Select the 'Start > All Windows > Perspective > Settings'·

ribbon option to display the 'Perspective Sets' dialog, and
click on the Reset All button  or

Select  > All·

Notes

A Perspective hides all Technologies that are not·

specifically associated with it; if you use custom
Technologies in your work, add them to a custom
Perspective with any built-in Technologies you want to
use, so that all your specialized tools are available
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together

An individual Technology might not present all facilities·

you need (for example, ICONIX does not have a diagram
profile, so a Perspective that just exposes ICONIX does
not allow you to create diagrams); select or create a
custom Perspective that includes a Technology that adds
the missing facilities (in this case, the UML Technology)

In order to function when included in and presented by the·

Perspective, a Technology must remain enabled in the
'Manage Technologies' dialog
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Customizing Perspectives

Whilst Enterprise Architect boasts a wide range of system
(built-in) Perspectives, as users and teams gain more
experience with the huge number of technologies and
features in the tool, or their roles change, they might want to
create their own personal or model based Perspectives more
specifically tailored to their area of work, or to expose
Technologies they have recently imported. Enterprise
Architect provides the ability for Perspectives to be
completely customized down to the level of the items that
appear on a technology Toolbox page, and these definitions
can be created once and then reused by different team
members or even across different repositories.

Before starting, review the Technologies available to you in
Enterprise Architect and identify and enable those you want
to apply in a Perspective, either individually or in
combination. This is particularly important for any custom
Technologies you have, as selecting a Perspective makes
available only those Technologies it specifically contains
and hides all others - including your custom Technologies.

You can create custom Perspectives for your own personal
use, or for all model users, and move or copy individual
Perspectives between the two levels. You can also publish
custom Perspectives, exporting them as a set from one
model and importing them as a set into other models.

The procedures for working with personal custom
Perspectives and model-level custom Perspectives are the
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same, except where specifically stated in this topic.

If you have User Security enabled on a model or project, as
an administrator you can also set up Perspective Settings
that identify the Perspectives available to users in each of
the defined security groups. See the Perspectives for
Security Groups Help topic.

Access

These access options display the 'Perspective Sets' dialog,
through which you can create customized Perspectives.

(c) Sparx Systems 2022 Page   88 of 1974



Modeling Fundamentals 3 October, 2022

Ribbon Start > All Windows > Perspective >
Settings >  Personal Sets    or
Model-Based Sets

Create Custom Perspective

Ste
p

Action

1 Click on the New button. The 'Create Perspective'
dialog displays, prompting you for the name of the
new Perspective. Type in the Perspective name.
In your Perspective, you can restrict the creation of
constructs (types of diagram, element, connector and
Pattern) from within other Technologies. (See the
Restrict Custom Perspective section later in this
topic.) If you want to do this, select the 'Strict'
checkbox.
Click on the OK button. The name is added to the
'Perspective' panel.
If you have selected the 'Strict' checkbox for a
Perspective, the word 'Yes' displays in the 'Strict'
column and the Restrict button is enabled.

2 Click on the Perspective name, and then on the 
button. The 'Select MDG Technologies' dialog
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displays.

3 Select the 'Add' checkbox against each MDG
Technology to include in the Perspective Set.
You can click on the All button and then deselect the
checkbox against each Technology to omit, or click
on the None button to clear all selected checkboxes
and then re-select those against Technologies you
want to keep.
If you want to group your selections by Technology,
click on the 'Group Categories by Technology'
checkbox.

4 When you have added the necessary Technologies to
the Perspective, click on the OK button. The
Technologies in the new custom Perspective are
listed in the 'Technologies' panel in alphanumerical
order.
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5 If you prefer to:
List the Technologies in the Perspective in a·

different sequence, click on each Technology
name in turn and use the Up Hand button or Down
Hand button to move the Technology name to the
correct position in the sequence
Remove a Technology from the Perspective, click·

on the Perspective name and click on the red X
button to redisplay the 'Select MDG Technologies'
dialog, listing just the Technologies that are in the
Perspective; clear the 'Add' checkbox against each
Technology to be removed, and click on the OK
button
Add another Technology to the Perspective, click·

on the  button to redisplay the 'Select MDG
Technologies' dialog, listing the Technologies that
are not already in the set; select the 'Add'
checkbox against the required Technology, and
click on the OK button

You can also edit the Perspective name, and clear or
select the 'Strict' checkbox; right-click on the
Perspective name and select the 'Edit' option. The
'Edit Perspective' dialog displays, on which you can
overtype the name and/or alter the checkbox
selection. Then click on the OK button.

6 Click on the Save button and, if you have finished
setting up or changing a Perspective, click on the

(c) Sparx Systems 2022 Page   91 of 1974



Modeling Fundamentals 3 October, 2022

Close button.

Restrict a Custom Perspective

Enterprise Architect is a tool for all seasons and is used to
create models for initiatives of all sizes, from small
endeavors such as a website for a small retail store right up
to highly complex systems used in aerospace missions.
Many of the supported languages and technologies also have
this dimension, defining mechanisms for simple grammars
through to extremely complex mechanisms for modeling
large real-time systems.

Enterprise Architect provides the Strict Perspectives as a
mechanism to restrict users to just the subset of the
technology and the tool that they need to undertake their
modeling tasks. For example, there might be a group of
strategic modelers who just need to model straight-through
processing. They only need access to the basic BPMN
modeling palette such as Activities and Control Flows, and
are not concerned about Pools, Lanes Gateways and
Message Flows, for example, and certainly don't want to see
Choreography diagrams. The librarian could set up a Strict
Perspective restricted to just these modeling elements,
connectors and diagrams.

To set a custom Perspective to 'Strict', click on the
Perspective name and click on the Restrict button. The
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'Modeling Permissions/Restrictions' dialog displays, listing
the constructs (diagram, element, connector and Pattern) of
each Technology in the Perspective.

Click on the type of construct for each Technology in turn,
and in the lists in the right-hand panel select the checkbox
against each type of element, relationship, diagram, link rule
or Pattern to allow in the Perspective. If it makes the process
easier, use the All button or None button to select all
checkboxes or clear all checkboxes before checking or
clearing individual entries.

When you have finished setting the allowed constructs, click
on the OK button to return to the 'Perspective Sets' dialog.

(c) Sparx Systems 2022 Page   93 of 1974



Modeling Fundamentals 3 October, 2022

Publish Custom Perspectives

If you have custom Perspectives in one model, you can
publish them by exporting them as a set to file and
importing them into other models.

On the appropriate tab ('Model-Based Sets' or 'Personal1.
Sets'), click on the Publish button to display the 'Publish
Perspectives' dialog.

In the 'File Path' field, type in or browse for the location2.
of the external file:
     -  From which to import previously-captured custom
Perspectives, or
     -  Into which to export the current set of custom
Perspectives

Select the appropriate radio button for the import or3.
export operation you are performing.

If you are importing Perspectives from the file, and they4.
might clash with existing Perspectives in your model,
select the 'Generate new perspective id' checkbox to give
each imported Perspective a different ID.

Click on the OK button. The exported Perspectives are5.
copied to the specified file. Imported Perspectives are
listed on the 'Perspective' panel of the 'Model-Based Sets'
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or 'Personal Sets' tab, as appropriate.

Move or Copy Custom Perspectives

If you have created a Perspective in either the 'Model-Based
Sets' tab or the 'Personal Sets' tab, you can move or copy
that Perspective from its source tab to the other. You might
move a Perspective to make yours available to other users,
or to restrict a model Perspective to your own use, or copy
the Perspective and edit it to create a variant for general or
personal use.

Right-click on the selected Perspective to move or copy that
Perspective, or click in the white space of the 'Perspective'
panel to move or copy all Perspectives in the list. A short
menu provides options to move or copy the Perspective to
the alternative group - 'Model-Based Sets' or 'Personal Sets'.
Click on the appropriate option; the move or copy takes
place immediately and the Perspective name is displayed in
the target panel.

Delete a Custom Perspective

If you no longer want to use a custom Perspective, you can
delete it from the list of those available.

On the 'Model-Based Sets' or 'Personal Sets' tab of the
'Perspective Sets' dialog, click on the custom Perspective
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name and then on the Delete button.

In response to the confirmation prompt, click on the Yes
button.
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Perspectives for Security Groups

Perspectives can be integrated with User Security, allowing
administrators and librarians to define the set of
Perspectives available to a given security user group. This
ensures that users in the group have all the tools and
languages they need, whilst helping them focus on their
work by completely hiding any irrelevant tools that might
otherwise be distracting. This results in productivity gains,
while still allowing the modelers to switch between
Perspectives that have been assigned to them. So, for
example, a security group called Strategic Process Modelers
could be defined and an administrator could assign to it the
entire Strategy Perspective set and the Decision Modeling
Perspective from the Requirement set. All users assigned to
this group would have access to, and be able to switch
between, the individual Perspectives or, by selecting All,
would be able to access the technologies in all their
Perspectives. Users who have been assigned as members of
a number of groups will have available to them the amalgam
(union) of all their groups' Perspectives.

An administrator or librarian who has defined fine-grained
technologies using the strict and restricted feature can apply
these restricted Perspectives to any group, thus ensuring that
the members of the group have only the restricted set of
elements, connectors and diagrams from the specified
technology. For example, there might be a group of strategic
modelers who just need to model straight-through
processing. They only need access to the basic BPMN

(c) Sparx Systems 2022 Page   97 of 1974



Modeling Fundamentals 3 October, 2022

modeling palette such as Activities and Control Flows, and
are not concerned about Pools, Lanes, Gateways and
Message Flows, for example, and certainly don't want to see
Choreography diagrams. The librarian could set up a Strict
Perspective restricted to just these modeling elements and
connectors and diagrams. They then apply it to the group
Strategic Process Modelers and ensure the users are made
part of that group using the 'Security Users' dialog, available
from the 'Configure' ribbon. This gives an administrator fine
grained control of what parts of the language their project
team can use, resulting in boosts in productivity and outputs.

The model administrator can similarly tailor the ribbons
available to each user security group, as a Ribbon Set for
each group, so that particular ribbons can be hidden to
further customize and focus the modelers' workspace.

It is important to note that the 'hidden' technologies are not
disabled - the model is still logically correct and fully
supported for every underlying technology; it is simply that
a particular security group will not be able to model using
the hidden technologies.

This feature is available in the Corporate, Unified and
Ultimate Editions of Enterprise Architect, from Release
15.0.

Access

Ribbon Start > All Windows > Perspective >
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Settings > Group Restrictions
On the 'Perspective Sets' screen, The
'Perspective Settings for Security Groups'
panel displays, listing the existing
security groups for which Perspective
Sets have been defined. (Existing security
groups that do not have a Perspective
Setting will show in the list if the 'Hide
Unconfigured' checkbox is deselected.)

Notice that in the 'Perspective Set'
column against the security group
'Authors' the value 'Authors' indicates the
Perspective Setting that exists for that
group.
At the top of the list is the group '<Model
Default>', which enables you to refine the
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Perspectives and ribbons available to all
users of this model - it is effectively an
'all model users' security group.

Create or Edit a Perspective Setting for a
Security Group

Click on the required security group name, then click on6.
the  icon on the right of the field in the 'Perspective Set'
column. The 'Perspectives for Security Group' dialog
displays.
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The dialog lists all of the Perspective Sets available in
Enterprise Architect and, when you click on the name of a
Perspective Set, all of the Perspectives available in the
selected set (as shown for the 'Analysis' Set). All Sets and
Perspectives have checkboxes, which initially are all
selected.

To make a complete Perspective Set unavailable to users7.
in the security group, click on the corresponding
checkbox to clear it.

To make individual Perspectives unavailable within an8.
active Perspective Set, click on the corresponding
checkboxes to clear them.

Work through all the Perspective Sets to define all the9.
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Perspectives that are not available to the users in the
security group. If you want to reset all unselected
checkboxes to selected, click on the Reset All button.

When you have defined the Perspective Setting, click10.
on the 'Perspective Group Name' field and type in a name
for the Perspective Setting for the security group.

Click on the OK button. The 'Perspective Settings for11.
Security Groups' tab of the 'Perspective Sets' screen
redisplays, with the name of the Perspective Setting in the
'Perspective Set' field for the selected security group.

You can repeat the process for another user security12.
group.

When you have set up your Perspective Settings for the13.
security groups, click on the Close button to close the
'Perspective Sets' screen.

Create a Ribbon Set for a Security Group

This process is similar to that for creating a Perspective
Setting for a security group.

Click on the required security group name, then click14.
on the  icon on the right of the field in the 'Ribbon Set'
column. The 'Ribbon Set for Security Group' dialog
displays.
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The dialog lists all of the ribbons available in Enterprise
Architect and, when you expand the name of a ribbon, all
of the option panels available in the selected ribbon (as
shown for the 'Design' ribbon). All ribbons and panels
have checkboxes, which initially are all selected.

To make a complete ribbon unavailable to users in the15.
security group, click on the corresponding checkbox to
clear it.

To make individual option panels unavailable within an16.
active ribbon, click on the corresponding checkboxes to
clear them. Clearing all the panel checkboxes for a ribbon
also hides the complete ribbon (you cannot display an
empty ribbon).
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Work through all the ribbons to define all the option17.
panels that are not available to the users in the security
group. If you want to reset all unselected checkboxes to
selected, click on the Reset All button.

When you have defined the Ribbon Set, you can also18.
identify one ribbon as being the default that is shown
whenever users in the selected security group open
Enterprise Architect. Click on the drop-down arrow in the
'Default Ribbon' field, and select the required ribbon
name.

Click on the OK button. The 'Perspective Settings for19.
Security Groups' tab of the 'Perspective Sets' screen
redisplays, with the name of the Ribbon Set in the 'Ribbon
Set' field for the selected security group.

You can repeat the process for another user security20.
group.

When you have set up your ribbon sets for the security21.
groups, click on the Close button to close the 'Perspective
Sets' screen.

Notes

Only model administrators can edit these settings·

You cannot hide the 'Start' ribbon, 'Specification -·

Specify' ribbon or 'Document - Edit' ribbon, or any panels
that they contain

If the 'Settings' ribbon is hidden, the Model·
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Administrator's login overrides that to ensure that the
administrator can administer the model

Using the Reset All button for a Perspective Setting or·

Ribbon Set effectively cancels any special settings for the
security group, and gives the member users access to all
Perspectives and ribbons
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Time Aware Models

The Time Aware Modeling feature allows analysts to create
incremental versions of their models by providing easy
access to tools that facilitate the migration of elements
through multiple versions. It is now easy to see the
evolution of a model over different versions, and create new
versions of model elements automatically without altering
the underlying structure of the 'As-Is' model.

Background

Models by definition are an abstraction of things that exist
in the real world. Just as time is an important dimension in
the physical world, it is also an important concern with
models that represent that world. These are some common
situations where time and the evolution of versions is
important in modeling:

Architects use models to document the current state and·

then move on to the more challenging and rewarding task
of defining what the future state will look like, often in a
series of transitions

When new customers are acquired, a Business Analyst is·

often challenged with describing how a base product
should be configured for these different customer groups,
resulting in different versions of the same product

Business Strategists typically prescribe what a Capability·
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model will look like for the organization of the future,
resulting in at least two versions of the Capability model

During mergers and acquisitions, Business Architects are·

tasked with describing the possible states of the enterprise
after the takeover is complete

Engineers are required to develop better or more efficient·

solutions to meet the challenges of the future, so define
newer and better versions of the solution

Testers need to be aware of different versions of a product·

when designing and running test cases

Infrastructure engineers have to define future·

environments in response to performance or security
concerns, creating multiple versions of servers, devices
and even whole facilities

All of these situations require that time is incorporated into
the models so that it can be reasoned and made explicit.
Enterprise Architect's Time Aware modeling facilities can
be used in all these situations, to ensure that time is included
as a first class citizen in the models. Time is not measured
or modeled in absolute or relative terms, but by representing
any number of future states or differences in the form of
versions.

Introduction

Time Aware modeling is based on using tools to clone a
Package structure (Packages and diagrams only) as a new
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version, and then selectively over-riding parts of the old
version with new elements and relationships using either the
'Clone as New Version' capability or simply adding new
material to the model as required. This method allows a
highly selective and incremental revision or development of
a model, whilst maintaining traceability to both earlier and
later development.

Time Aware modeling is not dependent on Version Control
or Baseline functionality, but is an entirely separate
capability that helps analysts manage multiple versions or
revisions of a model in a consistent and fully traceable
manner. Conceptually it is analogous to the branching and
merging in a Version Control system but as stated it is a
separate and unrelated mechanism.

Benefits

Easily compare 'As-Is' and 'To-Be' models·

Make changes to subsequent versions without altering the·

underlying structure of the 'As-Is' diagram

Get greater control over the evolution and traceability of·

your overall model

Create Traceability diagrams that outline each stage of the·

elements' evolution

Time Aware Model

(c) Sparx Systems 2022 Page  108 of 1974



Modeling Fundamentals 3 October, 2022

(c) Sparx Systems 2022 Page  109 of 1974



Modeling Fundamentals 3 October, 2022

Clone Structure as New Version

When using Time Aware modeling, you will typically want
to create a new version of a group of elements that are
collected together in one or more Packages, and so will need
to create a new version of a whole Package structure.
Creating a clone of your current model structure is a simple
migration process driven by version number. The structure
migration process builds a clone of your current Package
hierarchy, including diagrams, and updates the Packages
and diagrams with a user defined version number. You can
also change the structure name, if necessary. All diagram
elements translated to the clone diagram are included as
linked elements (references) to ensure their encapsulation is
maintained with the 'As-Is' model.

As the 'To-Be' model evolves, linked diagram elements from
the previous version can be selected and automatically
cloned into the new Package structure as required. This
ensures model assets continue to develop seamlessly
between the 'As-Is' and the 'To-Be' model without crossing
over.

The facility can operate on Model Packages, Views and
lower-level Packages regardless of their location in the
Browser window.

Access
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Ribbon Design > Package > Manage > Clone
Structure as New Version

Context
Menu

Browser window | Right-click on
Package | Clone Structure as New
Version

Create new clone structure

Ste
p

Action

1 On the 'Enter Name and Version' dialog, the 'Name'
field defaults to the currently-selected Package
name; if necessary, overtype this with a new name.
Type in the version number for the ('To-Be') clone of
the selected structure, and click on the OK button.
The 'Select Structure destination' browser displays.

2 Select the Package in the project under which to
create the clone structure. The current location of the
structure is highlighted until you select the clone
location.

3 Click on the OK button. The clone structure is
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inserted under the target Package, and the clone
diagrams are all opened within the Diagram View as
separate tabs.

Example

Start with selecting the root of your 'As-Is' model structure.

Select the 'Design > Package > Manage > Clone Structure as
New Version' ribbon option.

(Alternatively, right-click on the Package and select the
'Clone Structure as New Version...' context menu option.)

Specify the name, version number and the target Package
for the structure clone.

Finish with the new 'To-Be' model structure.
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Notes

All Packages in the new structure will be updated with the·

newly entered version number

All diagrams in the new structure will be updated with the·

newly entered version number

Elements in the new structure shown in the Browser·

window are linked elements from the 'As-Is' source
Package and retain their 'As-Is' version status

Note, Text and Boundary elements are cloned into the·

new version with the diagram

Object and Sequence elements are copied into the new·

structure as new elements with the new version number,
and with Trace connectors to the original version elements

On the 'Select Structure destination' dialog, you can either·

select an existing Package as the destination, or create a
new Package
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Clone Diagram as New Version

There will be circumstances when a modeler needs to clone
a diagram on an ad-hoc basis. Even when the modeler has
used the 'Clone Package Structure' facility, a diagram might
have subsequently been added to the original structure and
this diagram can then be cloned separately to ensure the two
versions of the Package structure are kept synchronized.

Creating a clone of your current model diagram is a simple
migration process driven by version number. The diagram
migration process builds a clone of your selected diagram
and updates it with a user defined version number. All
diagram elements contained on the clone diagram are
migrated as linked elements to ensure their encapsulation is
maintained with the 'As-Is' model.

As the new diagram version evolves, linked diagram
elements can be selected and cloned into the new diagram's
location as required. This ensures model assets continue to
develop seamlessly between the 'As-Is' and 'To-Be' models
without crossing over.

As you can have a sequence of cloned diagrams in separate
Packages, it might not be apparent that a diagram is one of a
line of clones. You can check whether a diagram has clones
using the 'Show Diagram Versions' dialog.

Access
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Ribbon Design > Diagram > Manage > Clone as
New Version

Create new clone diagram

Ste
p

Action

1 On the 'New version number' dialog, type in the
version number for the ('To-Be') clone of the
selected diagram, and click on the OK button.
The 'Select Diagram destination' browser displays.

2 Browse for and select the destination ('To-Be')
Package for the clone diagram, and click on the OK
button.
The diagram is cloned to the destination Package,
and automatically opened in the Diagram View.

Example

Select a diagram to clone.
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Select the 'Design > Diagram > Manage > Clone as New
Version' ribbon option.

Specify the version number and the target location for the
clone diagram. Review the clone diagram when it is
automatically opened.

Show Diagram Versions

When a diagram is cloned, a custom reference is added to
the diagram (in the t_xref table). This custom reference
provides information on the clone, through the 'Show
Diagram Version' dialog.

To display this dialog, right-click on the diagram in the
Browser window and select the 'Show Diagram Versions'
option.
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Where there is more than one clone in a sequence, the
versions are listed with the most recent first and the original
clone last.

You can open either the clone diagram (the source) or the
diagram it was cloned from (the target) by  clicking on the
Open Source button or Open Target button.

You can also right-click on a diagram entry and select from
there context menu options:

Open Source Diagram - display the clone diagram in the·

Diagram View

Open Target Diagram - display the cloned diagram in the·

Diagram View

Find Source Diagram - highlight the clone diagram in the·

Browser window

Find Target Diagram - highlight the cloned diagram in the·

Browser window

Notes
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Clone diagrams will be updated with the newly entered·

version number

Browser window elements in the new structure are linked·

elements from the 'As-Is' Package source and retain their
'As-Is' version status

Note, Text and Boundary elements are cloned into the·

new version with the diagram

Object and Sequence elements are copied into the new·

version, with the new version number, and with Trace
connectors to the original version elements

You can either select an existing Package or create a new·

destination Package in the 'Select Diagram destination'
dialog
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Clone Element as New Version

Cloned elements are the core of the Time Aware modeling
capability. When a clone is made, a new element is added to
the 'To-Be' model and a trace relationship is added that
connects the new element back to its 'protege' in the 'As-Is'
model. This allows details to be added to the cloned element
leaving the 'As-Is' element in its original state. Creating
clone elements helps maintain seamless development
between the 'As-Is' and 'To-Be' model, ensuring changes are
well defined, encapsulated and traceable.

Creating a clone of the linked elements on a diagram is a
simple migration process driven by version number. The
element migration process builds a clone of your selected
element and updates it with a user defined version number.
In addition to duplicating their base version, the necessary
relationships between the clone and the original are created
to ensure the logical consistency and traceability of the new
model. When cloning an element as a new version,
Enterprise Architect intelligently determines where to route
the new element's relationships to correctly reflect the intent
of the new model version.

Where a relationship exists to another model element in a
previous version, the model is examined to see if there is a
new version of the target element first and, if so, that
element is now used as the target of the relationship. If there
is no over-ride, the relationship is set to the existing
element. This behavior is extremely useful when studying
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the impact of making changes to elements in base versions
that are expected to remain unchanged throughout multiple
versions of a model's lifecycle.

Access

On a 'To-Be' clone diagram containing an external element
(an element held in a different Package) to be cloned, click
on the element.

Ribbon Design > Element > Manage > Clone
Element as New Version

Context
Menu

On a diagram, right-click on element |
Clone Element as New Version

Create a new clone element

Ste
p

Action

1 On the 'New version number' dialog, the 'Enter
Value' field defaults to the version number of the
current diagram as the version number to apply to
the clone element. You would tend to use this
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number but, if necessary, you can overtype it with a
different one.

2 Click on the OK button. The external element
becomes a clone in the diagram's parent Package,
with the specified version number.

Example

Select a linked element on the 'To-Be' diagram clone.

Select the 'Design > Element > Manage > Clone Element as
New Version' ribbon option.

Alternatively the option can be found in the diagram context
menu.

Finish with the new 'To-Be' element.
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Update linked diagram objects

When an element has been updated to the current version,
update diagrams might still contain linked diagram object
references to the old version of that element. If you want to
make one of these diagram objects the same version as the
updated element:

Right-click on the object linked to the old version and1.

Select the 'Update Element to Version '%s' option from2.
the element context menu

This will update the old linked diagram object with the new
version of the diagram object.

Notes

The clone element will be created in the same Package as·

the current diagram

When cloning an element, all parent and child elements·

will also be cloned to maintain element hierarchy

The 'Clone Element as New Version' menu option is not·
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available for elements contained in the diagram's parent
Package

Package, Note, Text and Boundary diagram elements are·

excluded from this feature

The clone element will maintain relationship links with·

previous version elements

A Trace relationship link is created between the clone and·

the source element

Use the 'Filter to Version' option in the diagram·

'Properties' dialog to filter elements by version on the
diagram
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Traceability

Time Aware models are effective, but it quickly become
difficult to understand all the connections between new and
existing elements particularly over multiple versions.
Enterprise Architect is a collaborative platform and excels at
creating visualizations of the relationships and traces
between different parts of the model. There are a range of
useful and compelling tools that can be used to visualize
these relationships.

The Traceability Window

You can use the Traceability window to trace element
relationships. Access the window using the 'Design
>Element > Trace' ribbon option.
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Insert Related Elements

You can use the Insert Related Elements feature to create a
Traceability diagram that outlines each stage of the
element's evolution.

Ste
p

Action

1 Create a Custom diagram with the name
'Traceability'. (Use 'Technology Type': 'Extended'
and 'Diagram Type': 'Custom'.)

2 Drag the subject element from the Browser window
onto the diagram.

3 Right-click on the element in the diagram and select
the 'Design > Element > Add Element > Related
Element' ribbon option. The 'Insert Related
Elements' dialog displays.

4 On the dialog:
Select 'Trace' in the 'Connector types' panel·

Set the 'Find Relationships to' depth level·

Click on the Refresh button·

5 In the list of results, select the checkbox against each
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required diagram element, and click on the OK
button. The elements are added to the diagram.

Example

Drag the required element onto the diagram.

Click on the element and select the 'Design > Element >
Add Element > Related Element' ribbon option, or
right-click and select the context menu option 'Insert Related
Elements...'

Configure the 'Insert Related Element' dialog.
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Finish setting the diagram layout and property options, and
click on the OK button.
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Relationships

The docked Relationships window is a useful tool for
viewing the relationships between 'As-Is' and 'To-Be'
models. Selecting the 'Source Version' and 'Target Version'
report columns brings clarity of relationships.

In the Relationships window, right-click on a selected
relationship to open the context menu; you can view
properties, find element usage and locate source and target
elements.
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Version Filtering

When working on a diagram containing elements from
different versions of your model, you can easily select to
filter out elements not in the current version.

Ste
p

Action

1 Right-click on the diagram background and select
the 'Properties' option to display the diagram
'Properties' dialog.

2 The 'Version' field displays the diagram version
number; all elements having a version number
different from this will be grayed out.

3 Select the 'Filter to Version' checkbox to enable the
diagram filter feature, and click on the OK button.
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Filter Example
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Model Validation

You use Model Validation to check UML models against
known UML rules. The set of rules to validate against can
be customized by enabling and disabling certain rules and
rule categories. You can run Model Validation against a
single UML element, a diagram or an entire Package. You
can add to the system-provided validation rules by using an
Add-In or an MDG Technology (such as BPMN) that
contains its own rules. Model based add-ins are an effective
tool for creating new and specific rules sets that implement
custom rules specifically related to a single project, client or
domain.

Access

Ribbon Design > Package > Manage > Validate >
Validate Current Package

Validation Concepts
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Concept Detail

Validating
Objects

Validating a UML:
Element validates the element and its·

children, its features (attributes and
operations) and its relationships
(connectors)
Diagram validates the diagram itself·

(for correctness) as well as any
elements and connectors within the
diagram
Package validates the Package and all·

sub-Packages, elements, connectors
and diagrams within it

Example -
Model
Violation

This UML diagram contains several basic
violations of the UML rules:
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If you run Model Validation on this
diagram, these violations are identified in
the System Output window:

A UML ExpansionRegion·

(ExpansionRegion1) is missing its
child input ExpansionNode
An invalid self-generalization exists on·

Class2 (UML elements cannot be
self-generalized)
An OCL violation exists for the·

anonymous Association (between
Class2 and Object1)
A UML ExceptionHandler·

(ExceptionHandler1) is missing its
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child input ObjectNode
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Configure Model Validation

Before you perform a model validation, you enable or
disable the rules that are applied by the model validator.
You can define additional rules from any additional Add-Ins
that might be installed besides Enterprise Architect.

Access

Ribbon Design > Package > Manage > Tools >
Validate > Configure Validation Rules

Configure Validation

On the 'Model Validation Configuration' dialog, click on the
checkbox against each Validation Rule to apply in
performing a model validation. Click on the OK button to
set the validation rules selected.
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Run Validation

After you have configured the validation you want to
perform and set the validation rules to be applied, you can
execute the validation on objects you have selected from
either the Browser window or a diagram. If you do not want
to continue a validation you have started, you can cancel it.

Access

Ribbon Design > Package > Manage > Validate >
Validate Current Package

Keyboard
Shortcuts

Ctrl+Alt+V

Validation

While the validation executes it displays a progress window.
When validation is complete, the results are displayed in the
System Output window. You can highlight and select on a
diagram the element that an error message refers to, by
double-clicking on the error line in the System Output
window.
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Cancel Validation

At any time during a validation, either:

Click on the Cancel Validation button on the validation·

progress window, or

Select 'Design > Package > Manage > Validate > Cancel·

Current Validation'

Notes

If the System Output window does not automatically·

display, select 'Start > All Windows > Design > Explore >
System'.
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Rules Reference

Model Validation works by applying a set of validation
rules to the selected object. These rules are arranged in
groups.

Rule Groups

Group Description

Well-Formed
ness

The validator applies these rules to check
whether or not an element, relationship,
feature or diagram is well-formed; for
example, whether the object is a valid
UML item or whether a diagram contains
valid elements within it.
As explained in Error Message Format,
these rules generate messages with the
codes:

MVR01... (Element: Well Formedness·

checkbox selected)
MVR05... (Relationship: Well·

Formedness checkbox selected)
MVR08... (Feature: Well Formedness·

checkbox selected)
MVR0B... (Diagram: Well Formedness·

checkbox selected)
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Element
Composition

The validator applies these rules to check
whether or not a UML element contains
valid children, whether it contains the
right number of valid children, and
whether or not the element is missing any
required children.
These rules generate messages with the
code:

MVR02... (Element: Composition·

checkbox selected)

Property
Validity

The validator applies these rules to check
whether or not the element, relationship
or feature has the correct UML properties
defined, and whether the properties
contain incorrect or conflicting values.
These rules generate messages with the
codes:

MVR03... (Element: Property Validity·

checkbox selected)
MVR06... (Relationship: Property·

Validity checkbox selected)
MVR09... (Feature: Property Validity·

checkbox selected)

Custom
Properties

The validator applies these rules to check
an element, relationship or feature against
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any defined constraints in OCL.
These rules generate messages with the
codes:

MVR04... (Element: OCL·

Conformance checkbox selected)
MVR07... (Relationship: OCL·

Conformance checkbox selected)
MVR0A... (Feature: OCL·

Conformance checkbox selected)

Error Message Format

When you perform a validation, any violations of the rules
are listed on the System Output window. Each violation has
a violation ID of the format:

     MVRxxnnnn

MVR stands for Model Validation Rule·

xx is a hexadecimal number corresponding to the position·

of the validation rule in the 'Model Validation
Configuration' dialog, thus indicating which rule is
applied and violated

nnnn is the number of the violation message·

For example:

Messages with the ID MVR01nnnn indicate that the·

'Element: Well-Formedness' checkbox is selected and a
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violation of that rule has been detected

Messages with the ID MVR0Annnn indicate that the·

'Feature: OCL Conformance' checkbox (10th in order on
the dialog, or Ath in hexadecimal) is selected and a
violation of that rule has been detected
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Well-Formedness

Well-formedness rules are applied to check whether or not
an element, relationship, feature or diagram is well-formed.
For example, whether the target item is a valid UML item,
or whether a diagram contains valid elements within it.

Reported violations

Violation ID Description

MVR010001 «Element» is not a valid UML Element
Error: The element is not a recognized
UML 2.5 element.

MVR050001 «Relationship» is not a valid UML
Relationship
Error: The relationship is not a
recognized UML 2.5 relationship.

MVR050002 «Relationship» is not legal for «Start
Element» --> «End Element»
Error: The relationship between the given
start and end elements is not valid for
those elements.

MVR050003 «Parent Element»:isLeaf=true and cannot
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be generalized by «Child Element»
Error: The Generalization relationship
cannot exist between parent and child
elements because the parent element is
defined as a leaf element.

MVR050004 «Child Element»:isRoot=true and cannot
generalize «Parent Element»
Error: The Generalization relationship
cannot exist between parent and child
elements because the child element is
defined as a root element.

MVR050005 «Element» cannot generalize self
Error: The element cannot be
self-generalized.

MVR0B0001 Statechart violation: «extended
information»
Error: The State diagram contains a UML
violation; «extended information»
provides more details on the specific
violation.

MVR0C0001 Sequence Violation: «extended
information»
Error: The Sequence diagram contains a
violation, «extended information»
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provides more details about the specific
violation.
(This rule validates operations being
called by Messages - as selected from the
drop down combo box of the 'Messages
Properties' dialog - and will report a
violation if the operation does not belong
to the Lifeline.)

MVR7F0001 «Requirement» Not realized
Error: A Requirement element must be at
the target end of a Realization,
Association (including Aggregation and
Composition) or Generalization
connector.
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Element Composition

Element Composition rules are applied to check whether or
not a UML element contains valid children, whether it
contains the right number of valid children, and whether or
not the element is missing any required children.

Reported violations

Error ID Description

MVR020001 «Element» is missing required child
element «Child Element»
Information: The element is missing a
child element of type Child Element.

MVR020002 Invalid UML Package child
Information: The element cannot be a
direct child of the Package and must be a
child of another element (for example,
Ports must be children of other elements,
and not direct UML Package members).

MVR020003 Invalid child «Child Element name»
(«Child Element Type»)
Information: The child element is invalid
on the tested parent element.
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Property Validity

Property Validity rules are applied to check whether or not
an element, relationship or feature has the correct UML
properties defined for it and whether they contain incorrect
or conflicting values.

Reported violations

Error ID Description

MVR030001 «Element»:«Property» property is
undefined
Information: The element property
contains no value.

MVR030002 «Element»:«Property» property has
invalid value: "«Value»"
Information: The element property
contains an invalid value.

MVR030003 «Element»:isLeaf=true and cannot be
abstract
Information: The element's isLeaf and
isAbstract properties are both set to True,
which is invalid.
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MVR060001 «Relationship»:«Property» property is
undefined
Information: The relationship property
contains no value.

MVR060002 «Relationship»:«Property» property has
invalid value: "«Value»"
Information: The relationship property
contains an invalid value.

MVR090001 Attribute/AssociationEnd mismatch,
«Attribute»: «Mismatch description», ...
Information: The given attribute has an
associationEnd of the same name but they
differ in the listed details.
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OCL Conformance

OCL Conformance rules are applied to validate an element,
relationship or attribute against any defined constraints in
the Object Constraint Language (OCL). OCL is used to
describe expressions on UML models, and to express
constraints free of side-effects. You can add OCL
constraints to any element, relationship or attribute in
Enterprise Architect.

Define OCL Constraints

You can add an OCL constraint to a model object by setting
OCL as the Constraint type in the object 'Properties' dialog.

For Detail

An Element Right-click on the element and select
'Properties | Properties Dialog'. Click on
the 'Constraints' page; in the 'Type' field
click on the drop-down arrow and select
OCL.
To perform an OCL Validation:

Select 'Design > Package > Manage >1.
Tools > Validate > Configure
Validation Rules' and select the
'Element: (OCL) Conformance'
checkbox.
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Click on the element and select 'Design2.
> Package > Manage > Tools >
Validate > Validate Current Package'.

Any OCL syntax violations are recorded
in the 'Model Validation' tab of the
System Output window.

A
Relationship

On a diagram, right-click on the
connector and select the 'Properties'
option; select the 'Constraints' page, and
in the 'Type' field click on the drop-down
arrow and select 'OCL'.
To perform an OCL Validation:

Select 'Design > Package > Manage >3.
Tools > Validate > Configure
Validation Rules' and select the
'Relationship: (OCL) Conformance'
checkbox
Click on the connector and select4.
'Design > Package > Manage > Tools >
Validate > Validate Current Package'

Any OCL syntax violations are recorded
in the 'Model Validation' tab of the
System Output window.

An Attribute Right-click on the element and select
'Attributes | Constraints'; in the 'Type'
field, click on the drop-down arrow and
select 'OCL'.
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To perform an OCL Validation:
Select 'Design > Package > Manage >1.
Validate > Configure Validation Rules'
and select the 'Feature: (OCL)
Conformance' checkbox.
Click on the element and select 'Design2.
> Package > Manage > Validate >
Validate Current Package'.

Any OCL syntax violations are recorded
in the 'Model Validation' tab of the
System Output window.

Reported violations

Error ID Description

MVR040001 OCL violation: «violated OCL»
Information: The element's OCL
constraint uses incorrect syntax.

MVR070001 OCL violation: «violated OCL»
Information: The relationship's OCL
constraint uses incorrect syntax.

MVR0A0001 OCL violation: «violated OCL»
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Information: The attribute's OCL
constraint uses incorrect syntax.

Notes

To have a valid OCL constraint, the syntax must be·

correctly formed; if the expression is not correct, a
message displays stating that the OCL constraint is not
valid
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Model Transformation

One of the great advantages of creating models is the ability
to manipulate them to produce outputs, thus saving time and
reducing the possibility of errors. Enterprise Architect
implements Model Driven Architecture (MDA)
transformations using a flexible and fully configurable
template system. The templates act as instructions to a
machine that takes a model as input and transforms it to a
more resolved model as output. The input could be a large
and complex model or a single element and one input model
could be transformed to a variety of output models.

The transformations are commonly unidirectional and take a
Platform Independent Model (PIM) and transform it to one
or more Platform Specific Models (PSM). A good example
of where this is useful is where a system must be
implemented in a number of different relational database
systems. A single platform independent conceptual model
(the PIM) could be transformed to a number of platform
specific models, say Oracle, MySQL and SQLite. As a
further productivity boost, once the output models are
produced they can also be converted to programming code,
database definition language or schemas. Enterprise
Architect automatically creates traceability that can be used
to visualize how elements in the input model have been
transformed to elements in the output model.

Facilities
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Facility Description

Transform
Elements

Discover how to transform elements on a
diagram or from a Browser window
Package.

Built-in
Transformati

ons

Enterprise Architect provides a number of
built-in transformations that support a
wide range of target languages. Each is
fully customizable to your specific needs.

Edit
Transformati
on Templates

Learn how to adjust the transformation
templates to produce transformations
specific to your system.

Write
Transformati

ons

All the information you will need to
create your own transformations.

Ready-built Transformations
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The Enterprise Architect installer includes a number of basic
built-in transformations, including:

PIM to:·

     -  C#
     -  C++
     -  DDL table elements
     -  EJB Entity Bean
     -  EJB Session Bean
     -  Java
     -  PHP
     -  VB.Net
     -  XSD

Data Model to Entity Relationship diagram (ERD)·

Entity Relationship diagram (ERD) to Data Model·

Sequence diagram to Communication diagram·

Communication diagram to Sequence diagram·

Java model to JUnit test model·

.NET model to NUnit test model·

WSDL interface model to WSDL·

Further transformations will become available over time,
either built in or as downloadable modules from the Sparx
Systems website.

Customized Transformations
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You can modify the built-in transformations or define your
own, using Enterprise Architect's simple code generation
template language. This involves little more than writing
templates to create a simple intermediary source file; the
system reads the source file and binds that to the new PSM.

Transformation Dependencies

When you execute a transformation, the system creates
internal bindings (Transformation Dependencies) between
each PSM created and the original PIM. This is essential,
providing the ability to forward synchronize from the PIM
to the PSM many times, adding or deleting features as you
go; for example, adding a new attribute to a PIM Class can
be forward synchronized to a new column in the Data
Model.

You can observe the Transformation Dependencies for a
Package using the Traceability window, to check the impact
of changes to a PIM element on the corresponding elements
in each generated PSM, or to verify where a change required
in a PSM should be initiated in the PIM (and also to reflect
back in other PSMs). The Transformation Dependencies are
a valuable tool in managing the traceability of your models.

Enterprise Architect does not delete or overwrite any
element features that were not originally generated by the
transform; therefore, you can add new methods to your
elements, and Enterprise Architect does not act on them
during the forward generation process.
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Example of a Transformation

This diagram highlights how transformations work and how
they can significantly boost your productivity.
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Notes

If you are using the Corporate, Unified or Ultimate·

Edition, if security is enabled you must have 'Transform
Package' access permission to perform an MDA
Transformation on the elements of a Package
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Write Transformations

Enterprise Architect provides a facility to create your own
transformations; this can be useful to automate the process
of generating more specific models from more general ones,
reusing the transformation and preventing errors from being
introduced as they might if the models were created by
hand. The existing templates will provide a useful guide and
reference to assist you when creating new templates.

Transformation templates are based on the Code Generation
Template Framework, and an understanding of the way
these templates work is critical to be able to adjust existing
transformation templates or to create new ones. Therefore it
is suggested that you read and understand the topics
discussing Code Generation Templates prior to using the
Transformation Template language.

Access

Ribbon Design > Package > Transform >
Transform Templates

Keyboard
Shortcuts

Ctrl+Alt+H
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Factors concerning Transformation
Templates

Factor Detail

Default
Transformati
on Templates

Enterprise Architect provides a set of
default transformation templates that you
can use 'as is' or customize to your
requirements.

General
Syntax for
the
Intermediary
Language

Transformations in Enterprise Architect
generate an intermediary code form of the
model being created in the
transformation. You can review and edit
this code.

Intermediary
Language
Debugging

You can also debug transformation
scripts by checking the intermediary code
generated from the Transform script.

Editing
transformatio
n templates
and code

When writing transformations, you use
the facilities of the common Code Editor.

Code
Template

You use the Code Template Framework
to perform forward engineering of UML
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Framework models. The Transformation Template
Framework is derived from this.

Syntax for
Creating
Objects

To generate objects or elements in a
transformation, you apply a specific
syntax in the template script.

Syntax for
Creating
Connectors

To generate connectors (relationships) in
a transformation, you also apply a
specific syntax in the template script.

Transforming
Duplicate
Information

In many transformations there is a
substantial amount of information to be
copied. Rather than place this information
in the template, you can use macros to
read it from its source.

Transforming
Template
Parameter
Substitutions

In a transformation template, if you are
transforming Template Binding connector
binding parameter substitutions, you can
use the Template Parameter substitution
macros.

Converting
Types

You can apply various methods for
converting data types to different target
platform types.

Converting
Names

You can apply various methods for
converting names of elements to different
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target platform naming conventions.

Cross
References

During a transformation, you can perform
cross verification of transformed
elements.

Notes

Further hints and tips can be gleaned from a close study of·

the Transformation Templates provided with Enterprise
Architect

The Transformation Template editor applies the facilities·

of the common Code Editor
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Default Transformation Templates

Transformation templates provide the ability to represent the
existing information in a model in a modified way. When
creating a new transformation Enterprise Architect provides
a default set of transformation templates that perform a
direct copy of the source model to the target model. This
allows you to think in terms of how the source model and
target model are different. For each template you are able to
prevent properties from being copied and add additional
information until the appropriate target model is created.

You can list and examine the default templates in the
Transformation Editor. The combination of default
templates varies according to the language you are
transforming.

Access

Ribbon Design > Package > Transform >
Transform Templates

Keyboard
Shortcuts

Ctrl+Alt+H
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Notes

When creating a new transformation you must modify at·

least one template before the new transformation becomes
available
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Intermediary Language

All transformations in Enterprise Architect create an
intermediary language form of the model to generate. You
can access and edit the file containing this intermediary
language code using an external editor. Each object is
represented in this language by the object type (for example,
Class, Action, Method, Generalization or Tag) followed by
the object properties and the features that it is made from;
the grammar of the object description resembles this:

     element:

          elementName { (elementProperty | element)* }

     elementProperty:

          packageName

          stereotype

          propertyName = " propertyValueSymbol* "

     packageName:

          name = " propertyValueSymbol* " (. "
propertyValueSymbol* ")*

     stereotype:

          stereotype = " propertyValueSymbol* " (, "
propertyValueSymbol* ")*

     propertyValueSymbol:

          \\

          \"

          Any character except " (U+0022), \ (U+005C)
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elementName is any one of the set of element types·

propertyName is any one of the set of properties·

Literal strings can be included in property values by
'escaping' a quote character:

     default = "\"Some string value.\""
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Intermediary Language Debugging

The script from an MDA template produces intermediate
language text. However, on generating the model this script
could return errors. When an error occurs, you can view and
debug the generated text externally, preferably in an editor
that prompts on updates to the file alterations.

Access

Ribbon Design > Package > Transform >
Transform Selection

Keyboard
Shortcuts

Ctrl+H (transform selected
elements)
Ctrl+Shift+H (transform current
Package)

Debug when errors are returned on
generating altered code

Ste
p

Description
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1 Select the Package to be transformed, and the
'Transform Package' option.
The 'Model Transformations' dialog displays.

2 In the 'Name' column, select the checkbox against
the type of transformation being altered.

3 In the 'Intermediary File' field, click on the  button
and set the file location into which to generate the
code.

4 Select the 'Write Always' checkbox, and click on the
Write Now button to generate the script.
This only generates the script, not the model.

5 If an error is returned specifying the line number of
the problem, open the file in an external Code Editor
(with Line Numbering) and locate the line number of
problem.

6 Alter the template code to correct the error.

7 Click on the Do Transform button to check that the
alteration has corrected the problem.
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Example

For a MySQL database, the template code might resemble
this:

$enumFieldName = “test”

Column

{

name= %qt%% CONVERT_NAME ($enumFieldName,
"Pascal Case", "Camel Case")%%qt%

type= %qt%% CONVERT_TYPE (genOptDefaultDatabase,
"Enum")%%qt%

}

This returns the output in the generated text file as:

Column

{

name = "test"

type = "ENUM"

}

If there is an error in the original transform, such as a
spelling error - ‘Colum’ - clicking the Do Transform button
returns an error message referring to the first line of
intermediate code that includes the error 'Colum’.
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Objects

Objects are generated in a transformation as text in this
form:

     objectType

     {

          objectProperties*

          XRef{xref}*

          Tag{tag}*

          Attribute{attributes}*

          Operation{operations}*

          Classifier{classifiers}*

          Parameter{parameters}*

     }

For example:

     Class

     {

          name = "Example"

          language = "C++"

          Tag

          {

               name = "defaultCollectionClass"

               value = "List"
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          }

          Attribute

          {

               name = "count"

               type = "int"

          }

     }

Every object created in a transformation should include an
XRef syntax element (see the end of this topic), as it helps
the system to synchronize with the object and makes it
possible to create a connector to that Class in the
transformation.

Syntax elements in the code

Element Detail

objectType objectType is one of these:
Action·

ActionPin·

Activity·

ActivityParameter·

ActivityPartition·

ActivityRegion·
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Actor·

Association·

Change·

Class·

Collaboration·

CollaborationUse·

Component·

DeploymentSpecification·

DiagramFrame·

Decision·

EntryPoint·

Event·

ExceptionHandler·

ExecutionEnvironment·

ExitPoint·

ExpansionNode·

ExpansionRegion·

ExposedInterface·

GUIElement·

InteractionFragment·

InteractionOccurrence·

InteractionState·

Interface·

InterruptibleActivityRegion·

Issue·
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Iteration·

Object·

ObjectNode·

MergeNode·

MessageEndpoint·

Node·

Package·

Parameter·

Part·

Port·

ProvidedInterface·

RequiredInterface·

Requirement·

Sequence·

State·

StateMachine·

StateNode·

Synchronization·

Table·

TimeLine·

Trigger·

UMLDiagram·

UseCase·

objectPropert
ies

objectProperties is zero, or one instance
of one or more of these:
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Abstract·

Alias·

Arguments·

Author·

Cardinality·

Classifier·

Complexity·

Concurrency·

Filename·

Header·

Import·

IsActive·

IsLeaf·

IsRoot·

IsSpecification·

Keyword·

Language·

Multiplicity·

Name·

Notes·

ntype·

Persistence·

Phase·

Scope·

Status·
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Stereotype·

Version·

Visibility·

Attribute Attribute has the same structure as
objectType, and includes these
properties:

Alias·

Classifier·

Collection·

Container·

Containment·

Constant·

Default·

Derived·

LowerBound·

Name·

Notes·

Ordered·

Scope·

Static·

Stereotype·

Type·

UpperBound·

Volatile·
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Attribute also includes these elements:
Classifier·

Tag·

XRef·

Operation Operation has the same structure as
objectType, and includes these
properties:

Abstract·

Alias·

Behavior·

Classifier·

Code·

Constant·

IsQuery·

Name·

Notes·

Pure·

ReturnArray·

Scope·

Static·

Stereotype·

Type·

Operation also includes these elements:
Classifier·
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Parameter·

Tag·

XRef·

Parameter Parameter has the same structure as
objectType, and includes the Tag element
and these properties:

Classifier·

Default·

Fixed·

Name·

Notes·

Kind·

Stereotype·

Tag Tag has these properties:
Name·

Value·

Special Cases

Certain types of object have variations of the object
definition syntax.

Object Detail
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Packages Packages differ from other objects in
these ways:

They have a reduced set of properties:·

alias, author, name, namespaceRoot,
notes, scope, stereotype and version
The property namespaceRoot is only·

given to Packages
A name must be specified for each·

Package
The name property can be a qualified·

name; when a qualified name is
specified, the properties given are
applied only to the final Package
Only Packages can contain other·

Packages
Packages cannot contain attributes and·

operations

XRef Cross references are defined using the
transform statements. The properties
include:

Namespace·

Name·

Source·

Notes·

Tables Tables are a special type of object, with
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these differences from other object types:
They can include columns and primary·

keys
They cannot include attributes·

Columns Columns are similar to attributes, but
have an autonumber element containing
Startnum and its increment, and these
added properties:

Length·

NotNull·

Precision·

PrimaryKey·

Scale·

Unique·

In the column definition, you cannot
assign a value to the NotNull,
PrimaryKey or Unique properties.

(c) Sparx Systems 2022 Page  179 of 1974



Modeling Fundamentals 3 October, 2022

Connectors

The process of creating connectors in a transformation has
the same form as for creating elements (objects). It is a little
more complex, because you also define each end of the
connector - the source and target.

Connectors are represented in the Intermediary language as:

     ConnectorType

     {

          connectorProperties*

          AssociationClass {associationClassProperties*}

          Source {sourceProperties*}

          Target {targetProperties*}

     }

For example:

     Association

     {

          name="anAssociation"

          stereotype=""

          direction="Unspecified"

          Source

          {

               access="Private"

               navigability="Unspecified"
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          }

          Target

          {

               access="Private"

               multiplicity="1..*"

          }

     }

Syntax elements in the code

Element Detail

ConnectorTy
pe

ConnectorType is one of these:
Abstraction·

Aggregation·

Assembly·

Association·

Collaboration·

ControlFlow·

Connector·

Delegate·

Dependency·

Deployment·

ForeignKey·

Generalization·
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InformationFlow·

Instantiation·

Interface·

InterruptFlow·

Manifest·

Nesting·

NoteLink·

ObjectFlow·

Package·

Realization·

Sequence·

Substitution·

TemplateBinding·

Transition·

Usage·

UseCase·

Uses·

connectorPro
perties

connectorProperties is zero, or one
instance of one or more of these:

alias·

direction·

notes·

name·

stereotype·

tag·
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XRef·

associationCl
assProperties

associationClassProperties are one
instance of these:

Classifier·

XRef·

sourcePropert
ies
targetProperti
es

sourceProperties and targetProperties are
each a reference to an element and zero,
or one instance of one or more of these:

aggregation·

alias·

allowduplicates·

changeable·

constraint·

containment·

navigability·

membertype·

multiplicity·

Notes·

ordered·

qualifier·

role·

scope·

stereotype·

tag·
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Element
Reference

An element reference is either a guid that
references an element that already exists
before the transformation, or an XRef to
reference an element that is created by a
transformation.

guid·

XRef·

Notes

Each connector is transformed at both end objects,·

therefore the connector might appear twice in the
transformation; this is not a problem, although you should
check carefully that the connector is generated exactly the
same way, regardless of which end is on the current Class
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Transform Connectors

When you transform a connector, you can use two different
types of Class as the connector ends: either a Class created
by a transformation, or an existing Class for which you
already know the GUID.

Connect to a Class Created by a
Transformation

The most common connection is to a Class created by a
transformation; to create this connection you use three items
of information:

The original Class GUID·

The name of the transformation·

The name of the transformed Class·

This type of connector is created using the
TRANSFORM_REFERENCE function macro; when the
element is in the current transformation, it can be safely
omitted from the transformation. The simplest example of
this is when you have created multiple Classes from a single
Class in a transformation, and you want a connector
between them; consider this script from the EJB Entity
transformation:

Dependency

{
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%TRANSFORM_REFERENCE("EJBRealizeHome",classG
UID)% stereotype="EJBRealizeHome"

Source

{

%TRANSFORM_REFERENCE("EJBEntityBean",classGU
ID)%

}

Target

{

%TRANSFORM_REFERENCE("EJBHomeInterface",class
GUID)%

}

}

In this script there are three uses of the
TRANSFORM_REFERENCE macro: one to identify the
connector for synchronization purposes and the other two to
identify the ends; all three use the same source GUID,
because they all come from the one original Class. None of
the three have to specify the transformation because the two
references are to something within the current
transformation - each of them then only has to identify the
transform name.

It is also possible to create a connector from another
connector. You can create a connector template and list all
connectors connected to a Class from the Class level
templates; you don't have to worry about only generating the
connector once, because if you have created a
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TRANSFORM_REFERENCE for the connector then the
system automatically synchronizes them.

This script copies the source connector:

%connectorType%

{

%TRANSFORM_CURRENT()%

%TRANSFORM_REFERENCE("Connector",connectorGU
ID)%

Source

{

%TRANSFORM_REFERENCE("Class",connectorSourceG
UID)%

%TRANSFORM_CURRENT("Source")%

}

Target

{

%TRANSFORM_REFERENCE("Class",connectorDestGUI
D)%

%TRANSFORM_CURRENT("Target")%

}

}

Connecting to a Class for which you know
the GUID
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The second type of Class that you can use as a connector
end is an existing element for which you know the current
GUID. To create this connection, specify the GUID of the
target Class in either the source or target end; this script
creates a Dependency from a Class created in a
transformation, to the Class it was transformed from:

Dependency

{

%TRANSFORM_REFERENCE("SourceDependency",class
GUID)%

stereotype="transformedFrom"

Source

{

%TRANSFORM_REFERENCE("Class",classGUID)%

}

Target

{

GUID=%qt%%classGUID%%qt%

}

}

Notes

Each connector is transformed at both end objects,·
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therefore the connector might appear twice in the
transformation; this is not a problem, although you should
check carefully that the connector is generated exactly the
same way, regardless of which end is on the current Class

(c) Sparx Systems 2022 Page  189 of 1974



Modeling Fundamentals 3 October, 2022

Transform Foreign Keys

Enterprise Architect supports the transformation into
Foreign Keys of many different types of relationship defined
between entities in a logical model.

Each Foreign Key in a Physical model is represented by the
combination of a stereotyped connector and an operation in
each of the involved Tables. Foreign Key transformations
are achieved with the 'Connector' template in the DDL
language. This template generates an intermediate dataset
that is then interpreted by Enterprise Architect's
transformation engine to create all the required physical
entities and connectors.

By default, Enterprise Architect supports transformations of
these connector types:

Generalization - this kind of connector will create a·

Foreign Key with a multiplicity of 0..1 in the source and 1
in the destination

Association Class - this kind of connector will create a·

'join' table linking both the source and destination Tables

Association/Aggregation - these kinds of connector use·

the multiplicity defined in the Logical model's
relationship to join the source and destination Tables

All Foreign Key definitions will cause the addition of a new
integer (or equivalent) column in both source and
destination Tables, which will act as the Primary Key in the
source Table and the Foreign Key column in the destination
Table. The default names for the new columns will be the
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Table name with the suffix of 'ID' added, whilst the names
of the Foreign Keys will be automatically generated using
the FK DDL template.

(c) Sparx Systems 2022 Page  191 of 1974



Modeling Fundamentals 3 October, 2022

Copy Information

In many transformations there is a substantial amount of
information to be copied.

It would be tedious to type all of the common information
into a template so that it is copied to the transformed Class;
the alternative is to use the TRANSFORM_CURRENT and
TRANSFORM_TAGS function macros.

Use of Macros

Objective Detail

Copy Object TRANSFORM_CURRENT
(<listOfExcludedItems>)

The function generates an exact copy of
all the properties of the current item,
except for the items named in
<listOfExcludedItems>.

Copy
Connector

Another form of the function is available
when transforming connectors to copy
either end of the connector:
TRANSFORM_CURRENT
(<connectorEnd>,
<listOfExcludedItems>)
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This generates an exact copy of the
connector end specified by
<connectorEnd> (either Source or Target)
except for the items named in
<listOfExcludedItems>.

Copy Tags TRANSFORM_TAGS
(<listOfExcludedItems>)

The function generates an exact copy of
all the Tagged Values of the current item,
except for the items named in
<listOfExcludedItems>.
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Convert Types

Different target platforms almost certainly require different
data types, so you usually require a method of converting
between types. This is offered by the macro:

CONVERT_TYPE (<destinationLanguage>,
<originalType>)

This function converts <originalType> to the corresponding
type in <destinationLanguage> using the datatypes and
common types defined in the model, where <originalType>
is assumed to be a platform independent common type.

A similar macro is available when transforming common
datatypes to the datatypes for a specified database:

CONVERT_DB_TYPE (<destinationDatabase>,
<originalType>)

This function converts <originalType> to the corresponding
datatypes in <destinationDatabase>, which is defined in the
model; <originalType> refers to a platform independent
common datatype.
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Convert Names

Different target platforms use different naming conventions,
so you might not want to copy the names of your elements
directly into the transformed models. To facilitate this
requirement, the transformation templates provide a
CONVERT_NAME function macro.

Another way in which you can transform a name is to
remove a prefix from the original name, with the
REMOVE_PREFIX macro.

CONVERT_NAME (<originalName>,
<originalFormat>, <targetFormat>)

This macro converts <originalName>, which is assumed to
be in <originalFormat>, to <targetFormat>.

The supported formats are:

Camel Case: the first word begins with a lower-case letter·

but subsequent words start with an upper-case letter; for
example, myVariableTable

Pascal Case: the first letter of each word is upper case; for·

example, MyVariableTable

Spaced: words are separated by spaces; the case of letters·

is ignored

Underscored: words are separated by underscores; the·

case of letters is ignored
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The original format might also specify a list of delimiters to
be used. For example a value of '_' breaks words whenever
either a space or underscore is found. The target format
might also use a format string that specifies the case for
each word and a delimiter between them. It takes this form:

     <firstWord> (<delimiter>) <otherWords>

<firstWord> controls the case of the first word·

<delimiter> is the string generated between words·

<otherWords> applies to all words after the first word·

Both <firstWord> and <otherWords> are a sequence of two
characters. The first character represents the case of the first
letter of that word, and the second character represents the
case of all subsequent letters. An upper case letter forces the
output to upper case, a lower case letter forces the output to
lower case, and any other character preserves the original
case.

Example 1: To capitalize the first letter of each word and
separate multiple words with a space:

     "Ht()Ht" to output "My Variable Table"

Example 2: To generate the equivalent of Camel Case, but
reverse the roles of upper and lower case; that is, all
characters are upper case except for the first character of
each word after the first word:

     "HT()hT" to output "MY vARIABLE tABLE"

REMOVE_PREFIX(<originalName>,
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<prefixes>)

This macro removes any prefix found in <prefixes> from
<originalName>. The prefixes are specified in a semi-colon
separated list.

The macro is often used in conjunction with the
CONVERT_NAME macro. For example, this code creates a
get property name according to the options for Java:

$propertyName=%REMOVE_PREFIX(attName,genOptPro
pertyPrefix)%

     %if genOptGenCapitalisedProperties=="T"%

     $propertyName=%CONVERT_NAME($propertyName,
"camel case", "pascal case")%

     %endIf%

Notes

Acronyms are not supported when converting from Camel·

Case or Pascal Case
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Cross References

Cross References are an important part of transformations.
You can use them to:

Find the transformed Class to synchronize with·

Create connectors between transformed Classes·

Specify a classifier of a type·

Determine where to transform to for future·

transformations

Each Cross Reference has three different parts:

A Namespace, corresponding to the transformation that·

generated the element

A Name, which is a unique reference to something that·

can be generated in the transformation, and

A Source, which is the GUID of the element that this·

element was created from

When writing the templates for a transformation it is easiest
to generate the Cross References using the macro defined
for this purpose:

     TRANSFORM_REFERENCE (<name>, <sourceGuid>,
<namespace>)

The three parameters are optional. The macro generates a
reference that resembles this:

     XRef{namespace="<namespace>" name="<name>"
source="<sourceGuid>"

If <name> is not specified the macro gets the name of the·
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current template

If <sourceGUID> is not specified the macro gets the·

GUID of the current Class

If <namespace> is not specified the macro gets the name·

of the current transformation

The only time that a Cross Reference should be specified is
when creating a connector to a Class created in a different
transformation.

A good example of the use of Cross References is in the
DDL transformation provided with Enterprise Architect. In
the Class template a Cross Reference is created with the
name 'Table'. Then up to two different connectors can be
created, each of which must identify the two Classes it
connects using Cross References, while having its own
unique Cross Reference.

Specify Classifiers

Objects, attributes, operations and parameters can all
reference another element in the model as their type. When
this type is created from a transformation you must use a
cross reference to specify it, using the macro:

TRANSFORM_CLASSIFIER (<name>, <sourceGuid>,
<namespace>)

This macro generates a cross reference within a classifier
element, where the parameters are identical to the
TRANSFORM_REFERENCE macro but the name
Classifier is generated instead of XRef.
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If the target classifier already exists in the model before the
transformation, TRANSFORM_CLASSIFIER is
inappropriate, so instead the GUID can be given directly to
a classifier attribute.

If a classifier is specified for any type, it overrides that type.
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Transform Template Parameter
Substitution

If you want to provide access in a transformation template to
data concerning the transformation of a Template Binding
connector's binding parameter substitution in the model, you
can use the Template Parameter substitution macros.

Factors in the Transformation

Factor Detail

Intermediary
Language

Template Parameter Substitutions are
represented in the Intermediary language
as:
     TemplateParameterSubstitution
     {
          Formal { FormalProperties }
          Actual { ActualProperties }
     }

For example:
     TemplateParameterSubstitution
     {
          Formal
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          {

name=%qt%%parameterSubstitutionFor
mal%%qt%
          }
          Actual
          {

name=%qt%%parameterSubstitutionActu
al%%qt%

%TRANSFORM_CLASSIFIER("Class",
parameterSubstitutionActualClassifier)%
          }
     }

Formal
Properties or
Actual
Properties

FormalProperties and ActualProperties
are zero, or one instance of one of these
properties:

name·

classifier·

Transform of
Parameter
Substitution
Actual
parameter

If the Actual parameter is assigned a
String Expression, it will transform as
Actual name. You can assign the Actual
Classifier if you know the GUID:
TemplateParameterSubstitution
(
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Formal
{
name=%qt%%parameterSubstitutionFor
mal%%qt%
}
Actual
{
name=%qt%%parameterSubstitutionActu
al%%qt%
classifier=%qt%%parameterSubstitution
ActualClassifier%%qt%
}
}

If you want the Actual parameter to be
transformed so that its Classifier is
assigned with an element that is
transformed, then use
TRANSFORM_CLASSIFIER or
TRANSFORM_REFERENCE, as shown:

TemplateParameterSubstitution
{
Formal
{
name=%qt%%parameterSubstitutionFor
mal%%qt%
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}
Actual
{
name=%qt%%parameterSubstitutionActu
al%%qt%
%TRANSFORM_CLASSIFIER("Class",
parameterSubstitutionActualClassifier)%
}
}

Or

TemplateParameterSubstitution
{
Formal
{
name=%qt%%parameterSubstitutionFor
mal%%qt%
}
Actual
{
name=%qt%%parameterSubstitutionActu
al%%qt%
%TRANSFORM_REFERENCE("Class",
parameterSubstitutionActualClassifier)%
}
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}
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Edit Transformation Templates

A single transformation applies a number of transformation
templates, each of which defines a type of object that is
acted on within the transformation, and the actions that are
performed on objects of that type. The system provides a
range of built-in default templates, and each type of
transformation uses a specific subset of these templates.
Typically, the transformation type and the subset of
templates are tailored to the target language. Some default
templates within a set have no content; these are 'latent', and
represent the potential for acting on an object that is not
generally included in the transformation but is perfectly
valid if you wanted to include it. An example of a latent
template is the Linked Class Base template in the C#
transformation.

You can tailor the transformation templates in various ways,
including:

Adjust the code in one or more of the templates in a·

default set

Add code to a 'latent' default template·

Add a new custom template, based on one of the defaults·

but serving a different purpose that you define

Add a new transformation type containing - initially - a·

basic set of default templates

Add (or remove) a stereotyped override for a template·

A stereotyped override directs the transformation to use the

(c) Sparx Systems 2022 Page  206 of 1974



Modeling Fundamentals 3 October, 2022

modified template only if the element and/or feature are of
the specified stereotyped types. If the object or feature are
not of that type, the transformation applies the base
template.

Access

Ribbon Design > Package > Transform >
Transform Templates

Keyboard
Shortcuts

Ctrl+Alt+H

Edit Transformation Templates

Option Action

Language Click on the drop-down arrow and select
the name of the transformation.

New
Transformati
on Type

Click on this button if you want to create
a new transformation.
A prompt displays for the name of the
transformation; type in the name and
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click on the OK button.
The 'Templates' list shows the default set
of built-in templates, from which you can
develop your transformation. Your
custom transformation is not saved or
available for use unless you add and/or
edit one or more templates in the
transformation.

Templates Lists the transformation templates for the
current transformation.
Click on a template name to highlight it
and display its content in the Template
panel. The 'Modified' column indicates
whether you have edited the template for
this transformation.

Template Displays the contents of the
currently-selected template, and provides
the editor facilities for modifying the
template (right-click on the code text).

Stereotype
Overrides

Lists the stereotyped templates, for the
active base template.
The 'Modified' column indicates whether
you have modified a stereotyped
template.

Add New Click on this button to create a custom

(c) Sparx Systems 2022 Page  208 of 1974



Modeling Fundamentals 3 October, 2022

Custom
Template

template to add to the current
transformation.
A dialog displays, prompting you to
specify:

The object type (base template type)·

that this new template will respond to -
click on the drop-down arrow and
select the name (custom template types
are not included in this list)
The name of the new template - type in·

the appropriate text
Click on the OK button. The new
template name is added to the list of
templates, and it is opened in the template
editor ready for you to add its code.

Add New
Stereotyped
Override

Click on this button to add a new
stereotype override for the currently
selected template. A dialog displays,
prompting you to specify the:

Base Class (stereotyped Class type -·

click on the drop-down arrow and click
on the type in the list) and/or
Feature (click on the drop-down arrow·

and click on the stereotyped feature in
the list)

Click on the OK button. The override is
added to the 'Stereotype Overrides' list.
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Get Default
Template

Click on this button to update the editor
display with the default version of the
current built-in template or to clear the
content of the current custom template.
If you have saved the changed template,
re-instating the default version is a
change, so the 'Modified' field still
displays the word 'Yes'.

Save Click on this button to save the new or
edited current template. You cannot
switch to another template without saving
the current template, so this effectively
saves the transition as well.

Delete Click on this button to delete the current
custom template or stereotype override,
or the most recent changes to a built-in
template (effectively returning it to the
default, base content). You cannot delete
a built-in template.
You are prompted to confirm the
deletion.

Help Click on this button to display this Help
topic.
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Notes

Transformation template editing is based very strongly on·

code generation template editing; for additional
information on editing transformation templates see the
Code Template Editor section and the Editing Source
Code topic
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Built-in Transformations

Enterprise Architect provides a rich set of built-in,
commonly performed transformations. These will prove
useful to a variety of disciplines from Domain Modeling to
Code Engineering. The facility to transform models is a
practical productivity tool and it is expected that modelers
will want to create their own custom transformations. The
built-in transformations provide useful examples and are a
valuable reference for the modeler.

Built-in Transformations

Transformati
on

Converts

C# Platform-Independent Model (PIM)
elements to language-specific C# Class
elements.

C++ PIM elements to language-specific C++
Class elements.

Data
Definition
Language

A logical model to a data model targeted
at the default database type, ready for
DDL generation.
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Entity
Relationship
Diagram to
Data Model

An ERD logical model to a data model
targeted at the default database type,
ready for DDL generation.

Data Model
to Entity
Relationship
Diagram

A data model to an ERD logical model.

EJB Session
Bean

A single Class element to the elements of
an EJB session.

EJB Entity
Bean

A single Class element to the elements of
an EJB entity.

Java PIM elements to language-specific Java
Class elements.

JUnit An existing Java Class element with
public methods to a Class with a test
method for each public method, plus the
methods required to appropriately set up
the tests.

NUnit An existing .NET compatible Class with
public methods to a Class with a test
method for each public method, plus the
methods required to appropriately set up
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the tests.

PHP PIM elements to language-specific PHP
Class elements.

Sequence/Co
mmunication
Diagram

All elements and messages in an opened
Sequence diagram into matching
elements and messages in a
Communication diagram, and vice versa.

VB.Net PIM elements to language-specific
VB.Net Class elements.

WSDL A simple model to an expanded model of
a WSDL interface, suitable for
generation.

XSD PIM elements to UML Profile for XML
elements, as an intermediary step in
creating an XML Schema.
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XSD Transformation

The XSD transformation converts Platform-Independent
Model (PIM) elements to UML Profile for XML elements
as an intermediary step in creating an XML Schema. Each
selected PIM Class element is converted to an
«XSDcomplexType» element.

Example

The PIM elements
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After transformation become the PSM elements

These in turn generate this XSD

<?xml version="1.0" encoding="ISO-8859-1"?>

<xs:schema
xmlns:xs="http://www.w3.org/2001/XMLSchema">

<xs:element name="Account" type="Account"/>

<xs:complexType name="Account">

<xs:sequence>

<xs:element name="name" type="xs:string"/>

<xs:element name="billingAddress" type="xs:string"/>

<xs:element name="emailAddress" type="xs:string"/>
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<xs:element name="closed" type="xs:boolean"/>

<xs:element name="deliveryAddress" type="xs:string"/>

<xs:element ref="Order"/>

<xs:element ref="ShoppingBasket"/>

</xs:sequence>

</xs:complexType>

<xs:element name="LineItem" type="LineItem"/>

<xs:complexType name="LineItem">

<xs:sequence>

<xs:element name="quantity" type="xs:integer"/>

<xs:element ref="StockItem"/>

</xs:sequence>

</xs:complexType>

<xs:element name="Order" type="Order"/>

<xs:complexType name="Order">

<xs:sequence>

<xs:element name="date" type="xs:date"/>

<xs:element name="deliveryInstructions" type="xs:string"/>

<xs:element name="orderNumber" type="xs:string"/>

<xs:element ref="LineItem"/>

<xs:element name="status" type="OrderStatus"/>

</xs:sequence>

</xs:complexType>

<xs:simpleType name="OrderStatus">

<xs:restriction base="xs:string">
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<xs:enumeration value="new"/>

<xs:enumeration value="packed"/>

<xs:enumeration value="dispatched"/>

<xs:enumeration value="delivered"/>

<xs:enumeration value="closed"/>

</xs:restriction>

</xs:simpleType>

<xs:element name="ShoppingBasket"
type="ShoppingBasket"/>

<xs:complexType name="ShoppingBasket">

<xs:sequence>

<xs:element ref="LineItem"/>

</xs:sequence>

</xs:complexType>

<xs:element name="StockItem" type="StockItem"/>

<xs:complexType name="StockItem">

<xs:sequence>

<xs:element name="catalogNumber" type="xs:string"/>

</xs:sequence>

</xs:complexType>

<xs:element name="Transaction" type="Transaction"/>

<xs:complexType name="Transaction">

<xs:sequence>

<xs:element name="date" type="xs:date"/>

<xs:element name="orderNumber" type="xs:string"/>
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<xs:element ref="Account"/>

<xs:element ref="LineItem"/>

</xs:sequence>

</xs:complexType>

</xs:schema>
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WSDL Transformation

The WSDL transformation converts a simple model into an
expanded model of a WSDL interface that is suitable for
generation. For example:

Transformation of this generates the corresponding WSDL
Component, Service, Port Type, Binding and Messages:

Classes are handled in the same way as in the XSD·

Transformation

All 'in' parameters are transformed into WSDL Message·

Parts in the Request message

The return value and all 'out' and 'return' parameters are·

transformed into WSDL Message Parts in the Response
message

All methods where a value is returned are transformed·

into Request-Response operations, and all methods not
returning a value are transformed into OneWay operations

The transformation does not handle the generation of·

Solicit-Response and Notification methods or faults
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In the resulting Package you can then fill out the specifics
using the WSDL editing capabilities of Enterprise Architect,
and finally generate the Package using the WSDL
generation tools.
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VB.Net Transformation

The VB.Net transformation converts Platform-Independent
Model (PIM) element types to language-specific VB.Net
Class element types, and creates encapsulation according to
the options you have set for creating properties from VB.Net
attributes (on the 'VB.Net Specifications' page of the
'Preferences' dialog). Note that the public attributes in the
PIM are converted to private attributes in the PSM.

Example

The PIM elements

After transformation, become the PSM elements
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Sequence/Communication Diagram
Transformations

It is possible to transform a Sequence diagram into a
Communication diagram, and to transform a
Communication diagram into a Sequence diagram. In each
case, every element or message in the source diagram type
is mapped 1:1 to a matching element or message in the
target diagram.

Access

Ribbon Design > Package > Transform >
Transform Selection

Keyboard
Shortcuts

Ctrl+Shift+H (transform current
Package)
Ctrl+H (transform selected elements)

Perform a Transformation

Field/Button Action
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Elements Lists and highlights all the elements from
the diagram, which will be included in
the transformation.

Transformati
ons

Select:
The 'Communication' checkbox, if·

transforming a Sequence diagram into
a Communication diagram, or
The 'Sequence' checkbox, if·

transforming a Communication
diagram into a Sequence diagram

In either case, the 'Browse Project' dialog
displays. Browse for and select the target
Package into which the target diagram
will be created, then click on the OK
button.

Do
Transform

Click on this button to execute the
transformation.
The target diagram is created and listed in
the Browser window under the target
Package with the name (depending on
which transformation you have
executed):
<source diagram name> Communication
or
<source diagram name> Sequence
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Notes

The diagram being transformed must be open in the main·

diagram view for the 'Communication' or 'Sequence'
options to appear in the Model Transformation dialog.

Once you have selected the 'Communication' or·

'Sequence' checkbox, these transforms ignore any other
field setting in the dialog except for 'Target Package', and
will perform a direct transformation of every element in
the source diagram
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PHP Transformation

The PHP transformation converts Platform-Independent
Model (PIM) element types to language-specific PHP Class
element types and creates encapsulation (producing the
getters and setters) according to the options you have set for
creating properties from PHP attributes (on the 'PHP
Specifications' page of the 'Preferences' dialog). Note that
the public attributes in the PIM are converted to private
attributes in the PSM.

Example

The PIM elements

After transformation, become the PSM elements

(c) Sparx Systems 2022 Page  226 of 1974



Modeling Fundamentals 3 October, 2022

(c) Sparx Systems 2022 Page  227 of 1974



Modeling Fundamentals 3 October, 2022

NUnit Transformation

The NUnit transformation converts an existing .NET
compatible Class with public methods into a Class with a
test method for each public method. The resulting Class can
then be generated and the tests filled out and run by NUnit.

Example

The C# elements (originally transformed from the PIM)
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After transformation, become the PSM elements
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Notes

For each Class in the C# model, a corresponding Test·

Class has been created containing a test method for every
public method in the source Class, plus the methods
required to appropriately set up the tests; you fill in the
details of each test
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JUnit Transformation

The JUnit transformation converts an existing Java Class
with public methods into a Class with a test method for each
public method. The resulting Class can then be generated
and the tests filled out and run by JUnit.

Example

The Java model elements (originally transformed from the
PIM)
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After transformation, become the PSM elements
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Notes

For each Class in the Java model, a corresponding Test·

Class has been created containing a test method for every
public method in the source Class, plus the methods
required to appropriately set up the tests; you fill in the
details of each test
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Java Transformation

The Java transformation converts Platform-Independent
Model (PIM) element types to Java-specific Class element
types, and creates encapsulation (producing the getters and
setters) according to the options you have set for creating
properties from Java attributes (on the 'Java Specifications'
page of the 'Preferences' dialog). Note that the public
attributes in the PIM are converted to private attributes in
the PSM. All operations in the interface are transformed into
pure virtual methods.

Example

The PIM elements
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After transformation, become the PSM elements
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ERD To Data Model Transformation

The Entity Relationship Diagram (ERD) to Data Model
transformation converts an ERD logical model to a data
model targeted at the default database type, ready for
generating DDL statements to run in one of the
system-supported database products. Before doing the
transformation, you define the common data type for each
attribute and select a database type as the default database.
You can then automatically generate the Data Modeling
diagram.

The transformation uses and demonstrates support in the
intermediary language for a number of database-specific
concepts.

Concepts

Concept Definition

Table Mapped one-to-one onto Class elements.

Column Mapped one-to-one onto attributes.

Primary Key Lists all the columns involved so that
they exist in the Class, and creates a
Primary Key Method for them.
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Foreign Key A special sort of connector, in which the
Source and Target sections list all of the
columns involved so that:

The columns exist·

A matching Primary Key exists in the·

destination Class, and
The transformation creates the·

appropriate Foreign Key

Generalization

ERD technology can handle Generalization, as shown. Note
that the copy-down inheritance is currently supported with
two levels only.

Example

The ERD elements
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After transformation, become the Data Model elements
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Notes

Sometimes you might go back to the ERD, make some·

changes and then need to do another transformation; in
this case, to achieve better results, always delete the
previous transformation Package before doing the next
transformation
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EJB Transformations

The EJB Session Bean and EJB Entity Bean transformations
reduce the work required to generate the internals of
Enterprise Java Beans. You can therefore focus on modeling
at a higher level of abstraction.

Transformations

Both transformations also generate a META-INF Package
containing a deployment descriptor element.

Transformati
on

Detail

EJB Session
Bean

This transformation converts a single
Class element (containing the attributes,
operations and references required for
code generation by the javax.ejb.*
Package) to

An implementation Class element·

A home interface element·

A remote interface element·

EJB Entity
Bean

This transformation converts a single
Class element (containing the attributes,
operations and references required for
code generation by the javax.ejb.*
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Package) to:
An implementation Class element·

A home interface element·

A remote interface element·

A Primary Key element·

Example

The PIM elements
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After transformation generate a set of Entity Beans, where
each one takes this form (for the Account Class):
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DDL Transformation

The DDL transformation converts the logical model to a
data model structured to conform to one of the supported
DBMSs. The target database type is determined by which
DBMS is set as the default database in the model (see the
Database Datatypes Help topic, 'Set As Default' option).
The data model can then be used to automatically generate
DDL statements to run in one of the system-supported
database products.

The DDL transformation uses and demonstrates support in
the intermediary language for a number of database-specific
concepts.

Concepts

Concept Effect

Table Mapped one-to-one onto Class elements.
'Many-to-many' relationships are
supported by the transformation, creating
Join tables.

Column Mapped one-to-one onto attributes.

Primary Key Lists all the columns involved so that
they exist in the Class, and creates a
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Primary Key Method for them.

Foreign Key A special sort of connector, in which the
Source and Target sections list all of the
columns involved so that:

The columns exist·

A matching Primary Key exists in the·

destination Class, and
The transformation creates the·

appropriate Foreign Key

MDG Technology to customize default
mappings

DDL transformations that target a new, user defined DBMS
require an MDG Technology to map the PIM data types to
the new target DBMS.

To do this, create an MDG Technology .xml file named
'UserDBMS Types.xml', replacing UserDBMS with the
name of the added DBMS. Place the file in the
EA\MDGTechnologies folder. The contents of the MDG
Technology file should have this structure:

<MDG.Technology version="1.0">

     <Documentation id="UserdataTypes" name="Userdata
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Types" version="1.0" notes="DB Type mapping for
UserDBMS"/>

     <CodeModules>

          <CodeModule language="Userdata" notes="">

               <CodeOptions>

                    <CodeOption
name="DBTypeMapping-bigint">BIGINT</CodeOption>

                    <CodeOption
name="DBTypeMapping-blob">BLOB</CodeOption>

                    <CodeOption
name="DBTypeMapping-boolean">TINYINT</CodeOptio
n>

                    <CodeOption
name="DBTypeMapping-text">CLOB</CodeOption>

                     ...

               </CodeOptions>

          </CodeModule>

     </CodeModules>

</MDG.Technology>

As an example, 'text' is a Common Type (as listed in the
'Database Datatypes' dialog) that maps to a new DBMS's
'CLOB' data type.
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Notes

You can define DBMS-specific aspects not depicted in a·

Logical model, such as Stored Procedures, Triggers,
Views and Check Constraints, after the transformation;
see the Physical Data Model Help topic

Example

The PIM elements
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After transformation, become the PSM elements

Generalizations are handled by providing the child element
with a Foreign Key to the parent element, as shown.
Copy-down inheritance is not supported.
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Data Model To ERD Transformation

The Data Model to Entity Relationship diagram (ERD)
transformation creates an ERD logical model from a Data
Model. It is the reverse of the ERD to Data Model
transformation. This transformation uses and demonstrates
support in the intermediary language for a number of
database-specific concepts.

Supported Concepts

Concept Effect

Entity Mapped one-to-one onto Table elements.

Attribute Mapped one-to-one onto Columns.

Primary Key Derived from the PrimaryKey type of
column.

Notes

Sometimes you might want to limit the stretch of the·

diamond-shaped Relationship connectors; simply pick a
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Relationship connector, right-click to display the context
menu, and select the 'Bend Line at Cursor' option
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C++ Transformation

The C++ transformation converts Platform-Independent
Model (PIM) element types to C++ specific Class element
types and creates encapsulation (producing the getters and
setters) according to the options you have set for creating
properties from C++ attributes (on the 'C++ Specifications'
page of the 'Preferences' dialog). Note that the public
attributes in the PIM are converted to private attributes in
the PSM. All operations on an interface are transformed into
pure virtual methods on an equivalent class.

Example

The PIM elements

After transformation, become the PSM elements
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C# Transformation

The C# transformation converts Platform-Independent
Model (PIM) element types to C#-specific Class element
types, and creates encapsulation according to the system
options you have set for creating properties from C#
attributes (on the 'C# Specifications' page of the
'Preferences' dialog).

Example

The PIM elements
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After transformation, become the PSM elements
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Transform Elements

A model transformation is a user initiated function that
starts the process of transforming one or more Platform
Independent Model (PIM) elements into their corresponding
Platform Specific Model (PSM) elements. This process
takes place in accordance with the rules that have been
codified in the Transformation Templates. The
transformation can be initiated by selecting a Package in the
Browser window or an element in a diagram.

Access

Ribbon Design > Package > Transform >
Transform Selection

Keyboard
Shortcuts

Ctrl+H (transform selected elements)
Ctrl+Shift+H (transform selected
Package)

Perform a Transformation

Option Action
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Elements Lists all of the individual elements
selected in the diagram or held in the
Package. Either:

Click on an element to include just that·

element in the transformation
Hold Ctrl and click on several separate·

elements to include them in the
transformation, or
Hold Shift and click on the first and·

last elements in a block to include
those elements in the transformation

All Click on this button to select all of the
elements in the list to include them in the
transformation.

None Click on this button to deselect all of the
elements in the list.

Include child
packages

(If you have selected to transform
elements in a Package.)
Select this checkbox to include (in the
'Elements' list and potentially in the
transformation) elements from the child
Packages of the selected Package.

Transformati
ons

Select the checkbox against each type of
transformation to perform. When you
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select a checkbox, the 'Browse Project'
dialog displays; locate and select the
target Package into which to generate the
transformed elements.
If you want to change a selected target
Package, click on the  button to the
right of the Package name and select the
new Package from the dialog.

Generate
Code on
result

Select this checkbox to specify whether
or not to automatically generate code for
transformed Classes that target code
languages.
If you select this option, the first time you
transform to the Class the system prompts
you to select a filename to generate code
into; subsequent transformations
automatically generate code to that
filename.

Perform
Transformati
ons on result

Select the checkbox to automatically
execute transformations previously done
on the target Class or Classes.

Intermediary
File

If you want to capture the intermediary
language file (for example, to debug it),
either type in the file path and name or
click on the  button and locate and
select the file.
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Write
Always

Select this checkbox to always write the
intermediary file to disk.

Write Now Click on this button to generate the
intermediary file without performing the
full transformation.

Do
Transform

Click on this button to execute the
transformation.
When the transformation is complete, the
'Model Transformation' dialog closes.

Close Click on this button to close the 'Model
Transformation' dialog without
performing the transformation.

Notes

When the dialog displays, all elements are selected and all·

transformations previously performed from any of these
Classes are checked

This procedure does not apply to the Sequence·

diagram/Communication diagram transformation, or the
Communication diagram/Sequence diagram
transformation
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Chaining Transformations

Chaining transformations provides an extra degree of
flexibility and power to performing transformations. For
example, if two transformations have a common element;
you might separate this element out into its own
transformation, and then perform the original
transformations from the common point. The separated
transform could even produce a useful model itself.

You can chain transformations by selecting the 'Perform
Transformations on result' checkbox in the 'Model
Transformation' dialog, so that transformations that have
already been performed on target Classes are executed
automatically next time that Class is transformed to.
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The Specification Manager

In developing a model, you can use a wide range of
Enterprise Architect tools to create the model specification.
For the preliminary specification, such as defining
Requirements, you can adopt one of two general methods:

Diagram-based, creating UML-defined element icons in,·

for example, Requirements diagrams, and building the
model graphically, or

Text-based, creating elements as simple text descriptions,·

sketching out the elements, relationships and properties in
a broad definition that you - or team members with more
specific roles - can refine and develop into a more
complete model

Your 'sketch pad' for the second approach is the
Specification Manager.

The Specification Manager is a simple document-based
interface to a selected Package or diagram in the model,
providing the means of creating and reviewing elements as
text representations of objects in the model, using a process
that is familiar to all users including business professionals
and management, who might not have expertise in model
development.

Facilities

The Specification Manager is also an interactive reporting
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tool for displaying, in icon form, the status of various other
features against each entry and providing access to edit each
feature.

In the Specification Manager you can:

Work on the element entries as paragraph text in the same·

way as you would edit a document using a word
processor; this includes copying or dragging text from an
external file into the Specification Manager, and
importing data from an external spreadsheet (.csv) file

Switch easily from element to element in a displayed·

Package, with a single mouse-click

Show and edit in-place the current status of a number of·

properties of each entry

Directly interface to a range of Enterprise Architect tools·

that you can quickly invoke to display, edit and discuss
the properties of the selected Package or element; these
tools span the range of Project Management and Model
Management facilities, including:
     -  Traceability (Traceability window and Relationship
Matrix)
     -  Change Management (Baselines and Auditing)
     -  Maintenance
     -  Testing
     -  Risk Management
     -  Documentation (document format, web format, and
spreadsheet format)
     -  Metrics
     -  Review and Discussion (Model Library, Discussions,
Formal Reviews and Model Mail)
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Once any tool window is open, the details reflect the
currently-selected element in the Specification Manager, so
you can quickly run through the properties of a number of
elements just by selecting them in sequence in the list.

The Specification Manager makes it very easy to develop a
simple, visual description of your model for initial
specification, ongoing development and program
management, with immediate access to a range of types of
detailed information on any selected element, should you
need this detail.
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Specification Manager - Overview

The Specification Manager is a document-based interface to
a selected Package in the model, providing the means of
creating and reviewing elements as text representations of
model objects in that Package. You can rapidly define or
edit properties of the elements in the Specification Manager
window itself, and also immediately open a range of
windows and dialogs to add or review further properties and
characteristics specific to each element. A key feature of the
Specification Manager is the speed and ease with which you
can create, filter and review a large number of elements
from one point, and develop or examine complex detail on
each element or not, as you require.

You also have the facility to switch the display of the
contents of a diagram to the Specification Manager view,
either completely or as an inline display panel beside the
graphical view of the diagram.

Access

Ribbon Design > Package > Specification View

Context
Menu

Right-click on Package | Specification
Manager
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Keyboard
Shortcuts

Ctrl+0

The Specification Manager View

The Specification Manager initially displays as a tabbed
view in the application work area, containing a:

Tailored instance of the Navigator Toolbar·

List header bar of column names, and·

Blank work area·

Displaying the Specification Manager automatically opens
the 'Specification - Specify' ribbon, which provides a range
of options for working in the Specification Manager.

The selected Package defaults to the currently-selected
Package or, if none have been selected, the first top-level
Package in your model, and the element type defaults to any
type held in the Package.
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If you prefer, you can drag the 'Specification Manager' tab
out of the application workspace and use it as a floating or
docked window.

To begin you can either:

Work with the selected Package, or·

If you have selected the 'Auto Synchronize' checkbox in·

the Specification-Specify ribbon 'Display' panel, click on
another Package in the Browser window to switch to that,
or

Select another Package from the Package path in the·

Navigator Toolbar, or

Create and/or select another Package in the 'Project' tab of·

the Browser window

If you want to select a specific type of element to review,
use the 'Element Type' icon in the 'Element' panel of the
'Specification - Specify' ribbon. This also provides the
option of switching back to displaying elements of any type
in the Package

You can also adjust the column headings to include the
columns that show the information of interest to you, and
display the Filter bar to further isolate particular elements
for review. For an existing Package, the Specification
Manager might now resemble this:
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The display shows:

The element icons and names, and any notes they might·

have (you can configure the display to hide the icons and
notes)

The text values of each property represented by a column,·

where those values have been set; you can quickly edit
any of the values

Icons in several columns, which indicate that the element·

has an associated object, file or Linked Document; you
can double-click on these icons to display the object
properties or document in the window in which it was
created and, if necessary, you can edit the details

After you become familiar with what each indicator icon
represents, you can display them all within the single 'All
Indicators' column to save space.

When you click on an element in the display, it is marked by
a vertical colored line in the left margin to indicate that the
element is selected, and a vertical or horizontal line against
the element property you clicked on, to indicate that the
focus is on that property. In the illustration, the Author of
the 'Party Description' element is selected. If you click again
on the element property, the margin line changes color, to
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indicate that the property is open for editing. For example:

Adding, displaying and changing information

When you create or review an element on the Specification
Manager, you operate through one of four areas:

The Navigator toolbar, which provides options to:1.
     -  Change the Package under review

The Specification - Specify ribbon, which provides2.
options to:
     -  Change the specification element type
     -  Set the option to automatically change the display to
whatever Package you click on
     -  Open tools to create, display or review the
properties, characteristics and associated records of
        the Package or specific elements in the Package
     -  Configure the appearance of the Specification
Manager display and the types of information you
        might develop from the data in the display

The display area itself, where you can:3.
     -  Perform in-place editing by directly editing text
(such as Version, Phase or element notes) or
        selecting alternative values from drop-down lists
(such as Difficulty, Status or Priority)
     -  Double-click on an indicator icon and review the
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record or document attached to the element
     -  Drag in elements from any page of the Diagram
Toolbox

The element context menu, which you can display by4.
right-clicking anywhere on an entry in the display; this
provides options for:
     -  Creating and deleting elements
     -  Editing element properties (including adding and
reviewing extended properties, or Tagged
        Values)
     -  Locating the element in the Browser window and
     -  Refreshing the display

Notes

In the Corporate and extended editions of Enterprise·

Architect, User Security can be applied to restrict or
enable access to a range of operations and functions; if
you cannot access a function in the Specification
Manager, check with your System Administrator or
Security Administrator to see if you have access
permissions to work with that function
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Specification - Specify Ribbon

The 'Specification - Specify' ribbon provides a selection of
facilities that you might use when creating and editing
model elements as a text-based specification, using the
Specification Manager. The ribbon becomes available when
the Specification Manager is open.

Panels

Panel Description

Element The 'Element' panel offers a range of
facilities for working with the elements
that are displayed in the Specification
Manager view. There are facilities for
adding new elements and viewing and
editing element properties.

Display The 'Display' panel provides a range of
options that make it possible to tailor the
appearance of the Specification Manager
view, to better display the information
you want to examine. There are options
providing visual cues, such as
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highlighting the selected element and
using bold fonts to emphasize element
names, as well as options to filter the list
of elements that are displayed.
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Using the Specification Manager

When you begin working in the Specification Manager,
there are three general areas of activity you work through:

Setting up the Specification Manager to suit your work·

requirements

Creating and/or organizing the elements in the View·

Performing whatever work you need to do on the·

elements

The Specification Manager is extremely versatile, and you
can use it very simply to create a set of basic elements or at
varying levels of complexity to develop and manage those
elements in your project, as you need.

Access

Ribbon Design > Package > Specification View

Context
Menu

Right-click on Package | Specification
Manager

Keyboard
Shortcuts

Ctrl+0
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Initial Tasks

Task Action

Specify the
type of
element to
work on

Either:
Work with the default (all element·

types) or
Select a specific type of element·

You specify the element type first
because when you come to browse for or
select the Specification Package, if you
have specified a particular element type
the system automatically filters the
Package selection to only those that
contain elements of that type.

Select the
Package to
work in

Either:
Work with the default Package·

Select another existing Package in the·

model, or
Create a new Package in the model·

Set up List
Header and
Filter bars

Use the 'Field Chooser' dialog to organize
the columns that contain the type of
information you want to work with. You
can use the Filter bar to select for
information that includes specific values,
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or hide the Filter bar altogether.
Some of the columns contain indicators
that represent records and documents
associated with an element. You can
access the item represented by an
indicator by clicking on it.

Configure the
display

As you begin, or at any other time in your
use of the Specification Manager, you
can change the appearance of the display
to, for example, use smaller or larger text
font, partially or totally hide Notes text,
or show the element names in bold.
You can further configure the display and
the element definition by including level
numbering and automatic naming, and by
applying customized properties such as
additional Requirement Types, Glossary
entries and Tagged Value Types.

Organize elements

Task Action

Add new
elements

Create new elements in the model as
direct members of the Package or as child
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elements of those members.

Delete
elements

You can filter out elements from the
display by type or according to the value
of various properties. However, if an
element does not belong in the Package
and model, you can delete it completely.

Reorganize
elements

The Specification Manager reflects the
sequence of elements in the Package as
shown in the Browser window.
To put the elements in the Specification
Manager in a different order, either:

Move them in the Browser window,·

then right-click on the Specification
Manager and select the 'Reload View'
menu option, or
Right-click on the element to move and·

select the 'Move Up' or 'Move Down'
option
Click on the element to move and on·

the 'Specification-Specify > Element >
Move Up' or 'Move Down' ribbon
options, or
Click on the element and press·

Ctrl+Shift+Up arrow or
Ctrl+Shift+Down arrow
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Review the elements

Task Action

Create and
Review
Relationships

You can examine existing relationships
and create new ones using the
Relationship Matrix, creating and using
specific Matrix Profiles.
You can also review existing
relationships by opening the Traceability
window, either from the Toolbar or by
double-clicking on the blue arrow
displayed in the 'Relationship' and 'All
Indicators' columns. If the element has no
relationships, the blue arrow is not
shown.

Discuss and
review
elements
amongst
project
members

It is possible to create review documents
and have recorded text message
discussions on the development of your
elements, using the Review, Discussion,
and Model Mail facilities.
If an element has an existing Discussion
or Review, this is represented by a
'speech bubble' icon in the 'Discussion'
and 'All Indicators' columns. You can
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open the discussion by double-clicking
on that icon.

Make,
Review and
Manage
Changes

You can easily view and edit elements
directly in the Specification Manager or
by displaying the appropriate window
such as the Properties window.
You can also monitor changes to the
selected Package or element made
anywhere in the system, using the
Baselines and Auditing Facilities.
Further, you can manage changes made
by other users, opening the Project Tools
window to quickly assign resources and
risks to the work on the element. You can
review work on the elements in the
Package by displaying the Specification
Manager in another tab in the form of the
Project Gantt chart.
Maintenance and Testing are integrated
and easily available to help improve
software quality from the beginning of
your project.
Existing records of these items are
indicated by icons in the corresponding
column, and can be quickly opened by
double-clicking on the icon.

Print the list A print-out of the Specification Manager

(c) Sparx Systems 2022 Page  280 of 1974



Modeling Fundamentals 3 October, 2022

of entries element list is a document containing a
simplified version of the screen display:

All elements are included, both parent·

and child elements
The columns are narrowed to fit the·

page width (if necessary)
The indicator icons are not printed·

The font size and type face are uniform·

across the report
To generate the print-out:

Click on the 'Specification - Specify >1.
Element > Documentation > Generate
Documentation (RTF/PDF/DOCX)'
ribbon option.
On the 'Generate Documentation'
dialog, the 'Template' field defaults to
'Specification Manager List'.
If necessary, specify the output file2.
location and extension, then click on
the Generate button.
Display and print the output file.3.

Generate
reports

If you should need to extract and/or
publish more of the information in the
Specification Manager, you can do so in a
range of forms such as:

Using other templates and generation·

options to produce standard or
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customized document reports in RTF,
DOCX or PDF format
Publishing on the web in HTML or·

Joomla!, or
Exporting to a spreadsheet tool in CSV·

format

Notes

As you work on the information on the Specification·

Manager, periodically press F5 to refresh the view to
include any updates performed by other users elsewhere
in the system

In the Corporate and extended editions of Enterprise·

Architect, User Security can be applied to restrict or
enable access to a range of operations and functions; if
you cannot access a function in the Specification
Manager, check with your System Administrator or
Security Administrator to see if you have access
permissions to work with that function
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Specification Manager Configuration

As you work with the Specification Manager, you can tailor
the display to provide more precise information, and to
better represent the information. The Specification Manager
provides options to:

Create reference data to work from·

Modify the appearance of the entries, including the·

amount of Notes text to show

Apply level numbering and automatic element naming·

and numbering
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Appearance Options

It is possible to tailor the appearance of the Specification
Manager view to better display the information you want to
examine.

Access

Ribbon Specification - Specify > Display > Notes
Format > [format option]
Specification - Specify > Display > Bold
Names
Specification - Specify > Display >
Collapsible Regions
Specification - Specify > Display >
Highlight Selection
Specification - Specify > Display > Font
Size > [size option]
Specification - Specify > Display >
Element Icon

Adjust the appearance of the display
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Aspect Description

Display of
Notes

In the Specification Manager you can
choose to hide, check, or create and edit
Notes text on the screen.
Click on the 'Notes Format' icon and one
of these options:

'Hide' to not show the Notes at all; the·

element rows close up
'Preview' to show the first line (the·

width of the 'Item' column) of Notes
text for each element; in this mode, you
cannot edit the Notes text in the
Specification Manager, only in the
Notes window
'Full Notes Inlined' to show the·

complete Notes text for each element
underneath the element name; in this
mode you can create, edit and delete
Notes text in the Specification Manager
and perform the same operations as are
available in the Notes window context
menu
'Full Notes in Column' to show the·

complete Notes text for each element in
a new column next to the element
names; you have the same freedom to
edit the text as for 'Full Notes Inline'
'Document View' to show the element·
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names and text only, with no column
headings or properties

Display
element
names in
bold

Select the 'Bold Names' checkbox. All
element names, including the names of
child elements, are displayed in bold.

Enable the
use of
Expansion
arrows on
parent
elements

If an element has child elements, you can
configure the Specification Manager to
either:

Hide the child elements but provide an·

expansion arrow that you can click on
to open and collapse the element
hierarchy (select the 'Collapsible
Regions' checkbox), or
Automatically display the child·

elements indented underneath the
parent element (deselect the 'Allow
Collapsible Regions' checkbox)

Highlight the
current
element
details

When you click on an element name or
property, the Specification Manager
defaults to indicating the selection with
side bars and/or underlines. You can, if
you prefer, also highlight the entire row
of data for the element, by selecting the
'Highlight Selection' checkbox.
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Show
Element
Type as Icon

The Package you are reviewing might
contain elements of a number of different
types, so it is helpful to be able to see at a
glance the type of the element you are
reviewing. Select the 'Element Icon'
checkbox to display an icon representing
the element type, to the left of each
element name.

Change Font
Sizes of
display

Across the Specification Manager view,
the various display components such as
parent element names, child element
names, Notes/property values and column
headings each have their own font size.
You can select to increase or decrease the
font sizes as a set across the display,
relative to the current sizes.
Select the 'Font Size' option and either:

'Small'·

'Medium' or·

'Large'·
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Model Options

The Specification Manager helps you to develop the
elements in a Package from 'the ground up'. You use
standard, or reference, data in doing this, such as the names
of team members who can create and edit model data, or the
automatic naming system to apply in creating your
elements. Because you can start from an early stage in the
model's development, some of the reference data you want
to use might not exist. The Specification Manager makes it
easier to keep the elements in focus and check the
development of properties as you use the facilities for
defining the types of data you need.

Access

Ribbon Design > Dictionary > Glossary >
Glossary View
Settings > Reference Data > Model Types
> General Types > Requirement
Settings > Reference Data > Model Types
> People > Project Authors
Settings > Reference Data > Settings >
Auto Names and Counters
Settings > Reference Data > UML Types
> Tagged Value Types
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Configure data for development

Data
Type/Option

Description

Project
Glossary

It is possible to create a Glossary of terms
and definitions used throughout the
Project, and to automatically link to the
definition of a term where it occurs in the
model text.

Requirement
Types

Requirement elements can be of one of
several system-defined types, as shown in
the 'Stereotype' column of the
Specification Manager, if you have
selected to work on Requirements.
If these types are not sufficient for your
needs, you can define alternatives on the
'Requirement' page of the 'General Types'
dialog.

Project
Authors

A Project Author is a system user who
has responsibility for creating modeling
structures and data in a project. Initially
there are no Project Authors defined on
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the system, and you might need to
identify the users who are in your
development team.
Click on the 'Settings > Reference Data >
Model Types > People > Project Authors'
ribbon option to display the 'People'
dialog, on which you define the Project
Authors.

Auto Names
and Counters

When you start to create elements in your
model, the system automatically gives
them a name based on the element type
and the number of elements of that type
that already exist. For example, if you
create a series of Requirement elements
the default names are 'Requirement1',
'Requirement2', 'Requirement3' and so
on. You then edit these default names.
Alternatively, you can define your own
default naming and numbering system for
specific element types, for either the
element name, the element alias, or both.
Display the 'Auto Name Counters' dialog,
with which you can define your naming
and numbering system.

Extended
Property
Types

You can add Extended Properties
(Tagged Values) to the elements in the
Specification Manager, using the
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'Extended Properties' option on the
element content menu.
However, you might want to use a type of
Tagged Value that is not currently
available; in this case, you can create that
type using the 'Tagged Value Types' page
of the 'UML Types' dialog.
Click on the 'Settings > Reference Data >
UML Types > Tagged Value Types'
ribbon option to display the 'UML Types'
dialog.

Notes

In the Corporate and extended editions of Enterprise·

Architect, a User Security system can be applied that
restricts or enables access to a range of operations and
functions; if you cannot access a function in the
Specification Manager, check with your System
Administrator or Security Administrator to see if you have
access permissions to work with that function
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Package Options

As you define the elements in your specification you can
make them easier to reference by giving them more
appropriate element names and/or numbers, either as the
elements are created or retrospectively when a naming and
numbering system has been finalized. You can also make
the elements easier to locate and view by enabling
level-numbering and indenting, helping you to organize and
review the sequence and arrangement of the elements in the
Specification Package. If you have been exploring other
areas of the Browser window, you can return focus to the
Specification Package in the Browser window.

Access

Ribbon Design > Package > Manage > Options >
Level Numbering
Specification-Specify > Element > Apply
Auto Naming
Specification-Specify > Display > Level
Numbering > Enable
Specification-Specify > Display > Level
Numbering > Indent Description
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Configure Package options

Option Description

Apply Auto
Naming to
Elements

If you had to create elements before
setting up an auto-naming and/or
auto-numbering system, you can select
this option to apply the system to the
existing elements retrospectively.
If you set up an auto-naming and/or
auto-numbering system before creating
your elements, that system is
automatically applied as you create the
elements.

Level
Numbering -
Enable

Click on this option to apply level
numbering to the elements in the
Specification Package and indent each
successive level, both in the Specification
Manager and in the Browser window.
Nested elements are numbered
hierarchically; that is:
1  Name
2  Name
    2.1  Name
            2.1.1  Name
            2.1.2  Name
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3

Level
Numbering -
Indent
Description

If you have enabled level numbering, this
option is available to indent the element
description under each element name, to
align with the element name. If the option
is not selected, the text is aligned with the
left-hand edge of the level number. For
example:
Option ON:
1  Name
    Description
2  Name
    Description
    2.1  Name
            Description
            2.1.1  Name
                       Description
            2.1.2  Name
                       Description
3  Name
    Description

Option OFF:
1  Name
Description
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2  Name
Description
     2.1  Name
     Description
            2.1.1  Name
            Description
            2.1.2  Name
            Description
3  Name
Description

Notes

In the Corporate and extended editions of Enterprise·

Architect, a User Security system can be applied that
restricts or enables access to a range of operations and
functions; if you cannot access a function in the
Specification Manager, check with your System
Administrator or Security Administrator to see if you have
access permissions to work with that function
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Select Specification Type

When you start to use the Specification Manager you can
work on elements of all types in the Package (the default) or
identify a specific type of element to work on. You can
select any type of element supported by Enterprise Architect
or the MDG Technologies that are integrated with the
system.

If you specify the element type first, when you go on to
locate the Package to work in, the system automatically
filters for Packages that already contain that type of element.

Access

Ribbon Specification-Specify > Element >
Element Type
Specification-Specify > Element >
Element Type > Limit Display to
Selected Type

Select the element type

Click on either:
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'Other', and expand the technologies and element groups·

until you can click on a specific element type to filter for,
or

An element type from the list of recently used types (if·

you have not previously selected a specific element, or
you have cleared the list, this list is not available)

Also check that the 'Limit Display to Selected Type' option
is selected.

To revert to listing any type of element in the Package, click
on either the:

'<Any>' option or·

'Limit Display to Selected Type' option again to deselect it·

The list of recently used types (after the 'Other' option)
accumulates entries as you focus on elements of different
specific types. This helps you cycle through work on
elements of a small group of types.

If the list is no longer relevant to your work (for example,
you have moved on to a different module or stage of
development) you can clear the list by selecting the 'Clear
Recent Items' option, and start to accumulate a different set
of frequently used element types.
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Select Specification Package

When you start to work with the Specification Manager, you
identify the Package in which to build your specification.
When you open the facility, the Specification Package
defaults to the first top-level Package in your model, as
indicated by the 'Package path' in the Navigator toolbar. If
this is the Package in which you intend to work, you can go
on to configure the display and create or review elements.

You might, however, want to use a different Package that:

Already exists in the model and already contains elements·

of the specified type

Already exists in the model but contains no elements of·

the specified type

You will create underneath the current Specification·

Package, or

You will create underneath a different Package elsewhere·

in the model

You can perform these tasks using the 'native' facilities of
the Navigator Toolbar.

Access

Click on a Package in the Browser window, then use one of
these options to open the Package in the Specification
Manager.
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Ribbon Design > Package > Specification View

Context
Menu

Right-click on Package | Specification
Manager

Keyboard
Shortcuts

Ctrl+0

Locate Existing Package Containing
Specification Elements

Ste
p

Action

1 In the Navigation toolbar, right-click on the name of
a Package in the Package path, and select the 'Go to
Package' option.
The 'Select a Specification Package' dialog displays.
This dialog presents your model hierarchy, filtered to
show only those Packages that already contain
elements of the type you selected as the
Specification element type (which is identified in the
'Element Type' field at the top of the dialog).

2 To expand a Package and reveal sub-Packages it
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contains, click on the expansion arrow next to the
Package name, or click on the Expand All button. (If
a Package does not contain any sub-Packages, it has
no expansion arrow.)

3 Click on the required Package, and click on the OK
button.
The Package name displays in the 'breadcrumb trail'
in the toolbar, and the elements in the Package are
shown in the main body of the Specification
Manager window, filtered to the specified type if
appropriate.

4 Customize the columns and/or add elements to the
Package.

Locate Existing Package

It is possible that you want to create your specification in a
Package that has been set up for this purpose but does not
yet contain any elements (or any elements of the specified
type). In this case the Package would not be included in the
'Select a Specification Package' dialog. To select this
Package for the Specification Manager:

Right-click on the Package name in the Browser window·

and select 'Specification Manager' from the context menu,
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or

Select the Package in the Browser window, then press·

Ctrl+0, or

Click on the Package name and on the 'Design > Package·

> Specification View' ribbon option

The Package name displays in the view header and Toolbar.

Create New Package

This method creates a new Package underneath the current
Specification Package.

Ste
p

Action

1 From the ribbon bar, select 'Specification-Specify >
Specification > Package > New'.
The 'New Package' dialog displays.

2 In the 'Name' field, type the name of the new
Package.
(Optionally, you can also select a radio button to
automatically create a new diagram in the Package.)

3 Click on the OK button.
The new Package becomes the current Specification
Package in the Navigator toolbar. The Package is
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also added to the Browser window, underneath the
previous Specification Package.

4 Customize the columns and/or add elements to the
Package.

Create New Package Elsewhere in the Model

This method creates a new Package underneath a different
Package in the model.

Ste
p

Action

1 From the ribbon bar, select 'Specification-Specify >
Specification > Package > New'.
The 'New Package' dialog displays.

2 Click on the Browse button beside the 'Owner' field.
The 'Select Owner' dialog displays.

3 Browse through the model and click on the existing
Package under which to create the new Package.
Click on the OK button.
The 'Owner' field in the 'New Package' dialog is
updated.
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4 In the 'Name' field, type the name of the new
Package. Optionally, you can also select a radio
button to automatically create a new diagram in the
Package.

5 Click on the OK button.
The new Package becomes the current Specification
Package, named in the window toolbar. The Package
is also added to the Browser window underneath the
selected parent Package.

6 Customize the columns and/or add elements to the
Package.
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Customize Columns

The Specification Manager can display a wide range of
properties for the elements in the selected Specification
Package, each property being shown in a separate column.
Using the 'Field Chooser' dialog, you can customize the
display of the columns so that you show as many or as few
as you need, in an appropriate sequence. Also, you can add
columns to show the values of specific tags used in
individual elements or globally across the Package.

Having added the columns you need, you can use full or
partial property values in the Filter bar as a means of
filtering the display to show only those elements that have
property values that match the filters.

Access

Ribbon Specification - Specify > Display > Show
Columns
Specification - Specify > Display > Filter
Bar

Other Right-click column headings | Field
Chooser
Right-click column headings | Toggle
Filter Bar
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Using the Field Chooser

Drag the column headings that you want to include out of
the 'Field Chooser' and onto the header bar, in the position
you want the column to occupy in the sequence of column
headings. You can drag an existing heading from its current
position in the bar to another position in the sequence,
including making it the final column.

If you do not want to include a column that is already in the
heading bar, drag it up or down out of the bar. It is
automatically returned to the 'Field Chooser' dialog.

Using the Filter bar

In the Filter bar, you define a text string that any displayed
values in the corresponding column must include.

In the filter field for a column, type the character or string
that must form part of the value shown in each row of that
column. As you type the string, element rows in the
Specification Manager that do not match the filter are
hidden from display.

To clear the text in the filter field, click on the green cross at
the right of the field.
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You can display or hide the Filter bar by right-clicking on
the column headings and selecting the 'Toggle Filter Bar'
option.

Add Tagged Value Column

If you want to show the value that any element in the list has
for a particular tag, you can add a column specifically for
that tag. There are two ways in which to do this:

Method Action

1 Open the 'Tags' tab of the 'Properties'
dialog for the element  (Alt+5 | Properties
Dialog > General > Tags) and drag the
tag onto the Specification Manager; a
new column is added for each tag you
drag onto the list.

2 Either:
Right-click on the element in the·

Specification Manager and select the
'Add Tag Value Column' option, or
Right-click on the column headings·

and select the 'Add Tag Value Column'
option, or
Select the 'Specification - Specify >·

Display > Tagged Value Column
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option
The 'Add Tag Value Column' dialog
displays.
Either type the tag name into the 'Tagged
Value' field, or select one of the two radio
buttons:

Global Tagged Values - populates the·

'Tagged Value' drop-down list with all
global Tagged Values in the project;
you can select a Tagged Value that is
applicable to a large number of
elements
Tagged Values from the selected·

element - populates the 'Tagged Value'
drop-down list with the Tagged Values
defined for the selected element (as
listed on the 'Tags' tab for that
element); select the Tagged Value from
this filtered list of tags

When you have selected the required tag,
click on the OK button to add a column
for that tag to the Specification Manager
columns.

Notes
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You can edit the values of the tags in the Tagged Value·

columns; see the Editing Elements Help topic

The column layout for any added Tagged Value columns·

is preserved when you close the Specification Manager
and re-open it for the same Package

You can hide a Tagged Value column by dragging the·

column title off the header bar - as for any other column -
so that the column header is added to the 'Field Chooser'
dialog

You can remove a Tagged Value column altogether by·

right-clicking on the column header and selecting the
'Remove Tag Value Column' option
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Adding Elements

The Specification Manager is an excellent model
development tool, through which you can create elements in
the Package you are reviewing in a number of ways. You
can add new elements either:

Directly to the Package or·

As child elements of an element in the Package·

There are several methods of adding a new element, some of
which vary depending on whether you have set a specific
element type as the Specification Type, or set the display to
list all types of element in the Package. If you import a set
of element data from an external spreadsheet (.csv) file, this
setting will also filter the imported information to show
elements of the specified type or all types.

Access

With the Specification Manager window open:

Diagram
Toolbox

Drag an element icon from an appropriate
page of the Diagram Toolbox onto the
Specification Manager

Ribbon Specification-Specify > Element > Insert
> Add Default
Specification-Specify > Element > Insert
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> Add Child
Specification-Specify > Element > Insert
> Repeat Previous
Specification-Specify > Element > Insert
> Add Other
Specification-Specify > Element > Insert
> Add Multiple Elements

Context
Menu

Right-click window | Add New Element
Right-click window | Add New Child
Right-click window | Repeat last Element
Right-click window | Create Multiple
Elements

Add New
Button

Click on the Add New button at the end
of the display

Keyboard
Shortcuts

Ctrl+N (new element)
Ctrl+Shift+N (new child element)
Shift+F3 (repeat previous element)

Add an element from the Diagram Toolbox

When you have the appropriate page of the Diagram
Toolbox displayed (press Ctrl+Shift+3), click on  and use
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the Toolbox 'Find Toolbox Item' dialog to locate the page),
you can drag an element icon to a specific point on the
Specification Manager View. The element entry
immediately above the cursor is indicated by a blue side-bar,
and a context menu displays with three options:

'Insert after Selection' - the new element will be added as·

a peer immediately underneath the highlighted element

'Insert as Child' - the new element will be added as a child·

of the highlighted element

'Add to End of Document' - the new element will be·

added to the end of the list, as a peer of the highest level
of the hierarchy

Add element using the Add New button

At the bottom of the Specification Manager view, this
button displays:

Select a current element, then click on the button or use the
keyboard down-arrow to move to and select it, then select
either:

An element type from the list of appropriate types based·

on the current Package type and content

The 'Other' option and select an element group and type·

from the submenu, or

The 'Any' option to display the 'New Element' dialog,·

from which you can select an element type from any
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defined in the model

The new element is added to the Package immediately after
and at the same level as the selected element.

The button can be hidden and redisplayed using the 'Add
New Button' option on the 'Display' panel of the
Specification - Specify ribbon.

Add element of predefined Specification
Type

If you have set the Specification Type to a particular type of
element:

An element of that type is immediately added to the·

Specification Manager; the element has either the system
default element name or a name that you have set up
under your own naming conventions

The name is highlighted and, if you want to change it, you·

can immediately type in an alternative name

If the element is a child of an existing element, the entry·

is added underneath the parent, indented and in a smaller
font; the parent element is given an expansion arrow

Add element of any Specification Type

If the Specification Manager is listing elements of any type,
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or if you have set the 'Specification Type' to '<Any>', the
'New Element' dialog displays. You can use this dialog to
create an element of any type that the model supports.

Add elements from Pattern

Enterprise Architect provides Patterns in the Diagram
Toolbox and in the 'Resources' tab of the Browser window;
you can create your own Patterns and make them available
from the same places. Patterns are a great way to create
template structures of elements in your specifications, and
you can 'drag and drop' them from the Toolbox or
'Resources' tab of the Browser window into the
Specification Manager.

When you release the mouse button to 'drop' the Pattern, a
short menu displays from which you select to add the
Pattern elements underneath the item immediately above,
either as a peer structure or as a child structure.

Notes

If you add an element of the defined Specification Type to·

the selected Package in the Browser window, it is also
added to the Specification Manager

In the Corporate and extended editions of Enterprise·

Architect, User Security can be applied that restricts or
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enables access to a range of operations and functions; if
you cannot access a function in the Specification
Manager, check with your System Administrator or
Security Administrator to see if you have access
permissions to work with that function
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Deleting Elements

The Specification Manager provides a direct view of a
Package in your model, and reflects the contents of the
Package as it appears in the Browser window. If you delete
an element from the Specification Manager, it is removed
from the model and therefore also disappears from the
Browser window. Any child objects that the element has are
also deleted from the model.

Access

Context
Menu

Right-click on element | Delete Selected

Keyboard
Shortcuts

Ctrl+D
Ctrl+Del

Delete an element

When you select to delete an element in the Specification
Manager, a prompt displays to confirm that you want to
delete the element from the model.
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Click on the Yes button. The element is removed from the
Specification Manager and all other windows and diagrams
in which it appears.

Notes

You cannot select more than one separate element at a·

time in the Specification Manager, and therefore you
cannot delete multiple elements there; you can, however,
select and delete multiple elements from the Browser
window, which also removes them all from the
Specification Manager in one operation

In the Corporate and extended editions of Enterprise·

Architect, a User Security system can be applied that
restricts or enables access to a range of operations and
functions; if you cannot access a function in the
Specification Manager, check with your System
Administrator or Security Administrator to see if you have
access permissions to work with that function
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Editing Elements

When you have created elements in the Specification
Manager, you can add and review the properties and
characteristics of each element to whatever extent you need.
You could simply set some basic properties such as the
element version, status and general description in the Notes
area, or you could develop extended properties (Tagged
Values) or add a Linked Document to add more detailed and
extensive information on the element.

Editing tasks

Task Action

Display/Edit
Element
Properties

Where a column in the Specification
Manager contains a property value, you
can double-click on the value and either:

Type a different value (such as the·

element name) or
Click on the field to display a·

drop-down arrow and select a value
from the list

Alternatively, click on the value and
press F2.
Otherwise, you can right-click on the
item and select the:
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'Properties' menu option (or press·

Alt+Enter) to display the 'Properties'
dialog, or
'Properties window' menu option (or·

press Ctrl+2) to display the Properties
window

Edit Element
Notes

The 'Specification - Specify' ribbon
provides the 'Notes Format' icon for
defining how you view existing Notes
text on each element, or how you create
and edit Notes, depending on how you
have configured the display of Notes on
the screen.
If you select the 'Preview' option, the first
line of any Notes text in the Notes
window displays underneath the element
name. You cannot add or edit text in this
space, but you can work on the text in the
Notes window itself (click on the text and
press the Space bar).
If you select a 'Full Notes' option, either
inline or in column, the complete text of
any existing Notes displays underneath or
to the right of the element name,
respectively. You can now create and edit
the Notes directly in the field - simply
click twice on the area and type in the
text. The text you type here can also be
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viewed in the Notes window; text edits in
one of the views (Notes window or
Specification Manager) are updated in the
other view as soon as you click off the
item.
In either view, you can also right-click on
a text string to display the 'Notes' context
menu and perform further operations, and
use keyboard shortcuts. These operations
include:

Creating a Glossary definition from the·

text, and linking to existing definitions
in the text
Generating a new element in the same·

Package, with the selected text as the
name and linked to the text
Generating a new element linked to the·

text, that you effectively drag directly
onto an open diagram
Creating a link from the selected text to·

an existing element in the model (in the
Notes window only)
Creating a hyperlink to a wide range of·

target objects, including image files,
diagram images, web pages, text files,
Help topics and Enterprise Architect
commands (Notes in the Specification
Manager, or using the 'Hyperlink' icon
in the Notes window toolbar)
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Mark the text for a specific translation,·

or for excluding from automatic
translation
Searching for instances of the selected·

text in a range of sources (options
derived from the 'Code Editor' context
menu)
Editing the text, with cut, copy, paste,·

undo and delete
Hiding or revealing Glossary definition·

markers (underlines) in the text
(Specification Manager Editing Notes
row)

You can also select to display only the
element names and notes in the
Specification Manager (Document View)
or to hide the Notes text altogether, in
which case the element rows close up.

Locate a
selected
element in
the Browser
window

Right-click on the element item and
select the 'Find in Project Browser' option
(or click on the item and press Ctrl+F).
The system expands the Browser window
and highlights the element name.

Review
extended
properties
(Tagged

Right-click on the element item and
select the 'Tagged Values' option (or click
on the item and press Ctrl+2).
The Properties window displays; select

(c) Sparx Systems 2022 Page  320 of 1974



Modeling Fundamentals 3 October, 2022

Values) on an
element

the 'Tags' tab, through which you can
view, add, edit and delete Tagged Values
on the selected element.
Once the Properties window is open, you
can click on any element in the
Specification Manager and immediately
switch the focus of the 'Tags' tab to that
element.
You can also show the values for specific
tags used in the Package, with a Tagged
Values column for each named tag. See
Customize Columns. If an element has a
Tagged Value that matches the column
header, you can edit the value. For:

Values selected from a defined list,·

double-click on the value and change it
in the 'Tags' tab
Free-text values, whether simple or·

<memo> type, click twice on the value
and edit it in place

The field is not editable if the element
does not have the tag, is locked or has
duplicate tag names.

Create and
edit a Linked
Document on
an element

You can create a Linked Document on
the selected element in the Specification
Package, by:

Right-clicking on the element line and·

selecting the 'Linked Document' option,
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or
Clicking on the element line and·

pressing Ctrl+Alt+D
The 'New Linked Document From
Template' dialog displays, from which
you select any template you want to base
the document on, or 'None' for a
free-style document with no template.
When you click on the OK button, the
'Linked Document Editor' view becomes
active, with the 'Document - Edit' ribbon,
and you can create a document describing
any aspect of the selected element.
If the element already has a Linked
Document, selecting the 'Linked
Document' option opens that document.
If you no longer want the Linked
Document, select the 'Start > Application
> Design > Document' ribbon option and,
on the 'Linked Document' tab of the
Document window, click on the  icon
and select the 'Delete Linked Document'
option.

Finishing and
Saving your
changes

A quick way to save your changes and
exit from the item editor is to press Esc.
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Notes

You can also copy-and-paste text from a text file into the·

Specification Manager, using the text to fill the element
name or notes text area of an existing element entry

In the Corporate and extended editions of Enterprise·

Architect, a User Security system can be applied that
restricts or enables access to a range of operations and
functions; if you cannot access a function in the
Specification Manager, check with your System
Administrator or Security Administrator to see if you have
access permissions to work with that function
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Indicator Columns

An element specification can have any of a number of
resources associated with it. You can obtain a quick
indication that resources exist for the element by displaying
the corresponding column (selected from the 'Field Chooser'
dialog) on the Specification Manager; if the resource exists,
an icon displays in the column against that element. When
an indicator is displayed, you can double-click on the icon
to immediately access the record or the first in a set of
records for the element, in the corresponding window. You
can use these windows to edit, delete or (where appropriate)
add to the records against the element.

The Package you are reviewing might also contain elements
of a number of different types, so it is helpful to be able to
see at a glance what the type is of the element you are
reviewing. In the 'Specification - Specify > Display' ribbon
panel, select the 'Element Icon' checkbox to display an icon
representing the element type, to the left of each element
name.

Columns

Column
Header

Indicator

Relationship
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Indicates that: The selected element has
at least one relationship to another
element, which is shown in the
Traceability window.

Resource
Indicates that: There is at least one
resource assigned to a task on the
element, in the Resource Allocation
window.

Risk
Indicates that...: There is at least one Risk
item defined for the element, in the Risk
window.

Maintenance
Indicates that...: There is at least one
Maintenance item defined for the
element, in the Maintenance window.

Test
Indicates that...: There is at least one Test
item defined for the element, in the Test
Cases window.

File
Indicates that...: The selected element has
at least one associated file, defined on the
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'Files' page of the Properties window.

Discussion
Indicates that...: There is a discussion
thread or review of this element, in the
Discuss & Review window.

Journal
Indicates that...: There is a Journal entry
for this element, in the Discuss & Review
window under the Journal tab.

Document
Indicates that...: There is a Linked
Document for this element.

All Indicators -
Indicates that...: Any or all of the listed
items exist for the element, as indicated
by the corresponding icon.
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Traceability

As you create and set up the elements in your Specification
Package, using the Specification Manager, it is critical to:

Trace any existing relationships those elements have to·

the elements in the model that realize them, or are realized
by them

Follow the relationships of such elements further, to·

check how changes to a source element or its relationships
might affect other relationship chains in which the target
elements are involved

Create new relationships, where you can do so quickly·

and with an immediate view of how elements as a group
are connected across the model

The two most significant tools for this are the Traceability
window and the Relationship Matrix.

When you display the Traceability window, you can review
every relationship in which the element selected in the
Specification Manager is the source or target, the details of
each of the related elements, and the relationships in which
each of those elements are involved.

In the context of the Specification Manager, the
Relationship Matrix provides a view of the relationships
between the elements within the Specification Package, or
between the elements of the Specification Package and a
different Package. You can also use it to quickly create
many relationships between the elements, defining a simple
organization within the Specification Package and defining
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its relationships with other Packages.

Access

Ribbon 'Design > Package > Specification View
> In Navigation toolbar, right-click on
final Package in the Package pathway >
Open Relationship Matrix > <options>
Design > Element > Trace

Keyboard
Shortcuts

Ctrl+7 (display Traceability window)
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Open Relationship Matrix

If you want to quickly create relationships on the elements
in your Specification Package, or review the relationships
that already exist, you can do so very easily using the
Relationship Matrix. By opening the Relationship Matrix
from within the Specification Manager, you can use the
parameters already set in the Specification Manager to
automatically configure the Relationship Matrix.

Access

Ribbon Design > Package > Specification View >
In Navigation toolbar, right-click on the
Package name > Open Relationship
Matrix > <options>

Open the Relationship Matrix

Option Action

As Source Open the Relationship Matrix with the
Specification Package set as the Source
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Package and the Specification Type
element type as the Source element type.
Other fields default from the last settings
of the Relationship Matrix; you can
change any fields as necessary.

As Target Open the Relationship Matrix with the
Specification Package set as the Target
Package and the Specification Type
element type as the Target element type.
Other fields default from the last settings
of the Relationship Matrix; you can
change any fields as necessary.

As Both Open the Relationship Matrix with the
Specification Package set as both the
Source Package and the Target Package,
and the Specification Type element type
as the Source and Target element type.
Other fields default from the last settings
of the Relationship Matrix; you can
change any fields as necessary.

Matrix
Profiles >
Create New
Profile

Define a Matrix profile with the
Specification Package set as the Source
Package and the Specification element
type set as the Source element type, and
automatically open the Relationship
Matrix with this profile in effect.
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Previous
Settings

Open the Relationship Matrix using the
previously-processed settings; that is, the
last settings under which changes were
saved to the repository.
These settings could have been defined
during your use of the Specification
Manager, or in the Relationship Matrix
independent of any use of the
Specification Manager.

Notes

In the Corporate and extended editions of Enterprise·

Architect, a User Security system can be applied that
restricts or enables access to a range of operations and
functions; if you cannot access a function in the
Specification Manager, check with your System
Administrator or Security Administrator to see if you have
access permissions to work with that function
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Create Matrix Profile

In using the Specification Manager you work on a specific
Package and element type. If you want to use a Relationship
Matrix profile to look more closely at the relationships of
elements in that Package, it is therefore more logical to
define the profile from the information already set in the
Specification Manager, before you open the Relationship
Matrix. The system helps you to do this. You can also apply
this procedure to creating the matrix profile represented by a
Matrix Specification Artifact element.

Access

Ribbon 'Design > Package > Specification View
> In Navigation toolbar, click on final 
> Matrix Profiles > Create New Profile

Create the Matrix Profile

Option Action

Profile Type in a name to identify the profile.
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Source Displays the name of the current
Specification Package, as the source
Package in the Relationship Matrix.
If necessary, you can click on the 
button and select a different Package.

Type (For the Source Package) Displays the
name of the current Specification element
type. If necessary, you can click on the
drop-down arrow and select a different
element type.

Target Defaults to the name of the current
Specification Package as the target
Package of elements in the relationships
to examine.
If you want to examine relationships to
elements in a different target Package,
click on the  button and, on the 'Browse
Project' dialog, locate and select that
Package.
Click on the OK button to put the
Package name in the 'Target' field.

Type (For the Target Package) Defaults to
'<All>' target element types.
If you want to examine relationships to a
specific type of element, click on the drop
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down arrow and click on the element type
name.

Relationship Defaults to 'Realization' as the type of
relationship to display.
If you want to examine relationships of a
different type, click on the drop down
arrow and click on the relationship type
name.

Direction Defaults to 'Source -> Target' as the
direction of the relationships to examine.
If you want to examine relationships in
the opposite direction, or in both
directions, click on the drop-down arrow
and select the appropriate option.

OK Click on this button to create the profile
and close the dialog.
The Relationship Matrix automatically
opens, applying the Profile that you have
just defined.

Cancel Click on this button to discard any values
you have entered, and to return to the
Specification Manager.
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Notes

After you have created a Matrix profile, the name of the·

profile is added to a list of profiles that include the
Specification Package and Specification element type,
under the 'Create new Profile' option; when you click on
the profile name, the Relationship Matrix immediately
displays with that profile in effect

In the Corporate and extended editions of Enterprise·

Architect, a User Security system can be applied that
restricts or enables access to a range of operations and
functions; if you cannot access a function in the
Specification Manager, check with your System
Administrator or Security Administrator to see if you have
access permissions to work with that function
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Reviewing Elements

When you are managing or working as a member of a
project team, it is useful to have mechanisms for reviewing
the work you are doing and keeping some record of those
reviews, whether they are casual discussions between peers
or coordinated, structured and formal reviews. The
Specification Manager supports the full range of review
types, focused on the elements that are defined in the
Specification Package.

Access

Ribbon Design > Package > Specification View >
click on required Package or element

Review facilities

Facility Description

Review
Documents

It is possible to create any number of
'Review Documents' on the elements of
the Specification Package, both to
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formalize and guide specific review
processes and to present the element
information to be reviewed.
The documents are stored in and easily
accessed from the 'Model Library'
feature. Select the 'Start > Collaborate >
Model Library' ribbon option.

Bind Package
to Model
Library
Folder

By default, 'Review Documents' are
stored in folders under a special category
of the Model Library, called 'Formal
Reviews'. You can, however, generate
those documents elsewhere in the Model
Library, by binding the Specification
Package to whichever Model Library
folder (topic) is most appropriate to the
Package.

Model
Library

The Model Library tools provide a
number of other facilities that can be of
use in discussing the development and
features of an element, such as the
'Resources' folder or the ability to
develop a sequence of communications
on a specific element, on a group of
elements, or on some broader aspect of
the model development.

Discussions Using the Discuss & Review window,
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you can initiate or respond to a general,
ad-hoc discussion amongst your team
members, on a specific element. The
facility maintains a record of each initial
comment or question, and every response
to that comment.
There is no limit on the number of
different discussions, on the number of
responses, or on the length of each item,
although the facility is better suited to
short queries and responses.
Similarly, you can perform a formal
review on one element or a group,
adhering to a stricter protocol and
timeframe.
When there is a discussion or a review on
an element, the  icon displays in the
'Discussion' and 'All Indicators' columns
on the Specification Manager. Simply
double-click on the icon to display the
discussion or review comments.

Model Mail The Model Mail facility is a personal,
project-internal email service. You can
use it to send emails to specific
individuals or groups on your project,
concerning the Specification Manager
contents or functions, or any other subject
you need to discuss.
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If you want to discuss a particular
element, click on it in the Specification
Manager, open Model Mail (right-click |
Collaborate | Send Mail) and create a
message, and use the 'Insert Quicklink'
button to create a hyperlink in the mail
message to the selected element.
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Create Review Document

When you are managing the work of a project team, it is
useful to have a mechanism for coordinating and guiding the
work that the team members are required to do on the
elements in the Specification Package, such as a review
document. You can generate this type of document quickly
and simply from the Specification Manager, to be
distributed, accessed and read through the Model Library
facility.

There are, broadly, two types of review document that you
can generate:

A specification document that contains the material to be·

reviewed - the individual features of each element - such
as a Model Overview, List of Issues or Maintenance
Report, and

A management or review document that guides the reader·

in applying tests, checks and procedures across the
Package, such a Phase Review, Test Plan or Training Plan

You can generate both kinds of document using a range of
templates, or create a document without using any template.
The templates are all those available through the Report
Generator (specification documents) or Linked Document
Editor (management documents), whether system-provided
or user-designed.

The specification documents automatically structure
information from the Specification Manager according to
the selected template and should not require further editing
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to serve their purpose (although it is possible to edit them if
you need to). They are therefore termed 'auto-generated
documents'.

By default, 'Review Documents' are stored in folders
(Topics) in a special category of the Model Library, called
'Formal Reviews'. You can, however, generate those
documents elsewhere in the Model Library, by binding the
Specification Package to whichever Model Library folder is
most appropriate to the Package. For example, if you have a
modular structure in the Model Library, you might want to
hold the 'Review Documents' for a Specification Package in
the same section of the Model Library as folders containing
discussions and documents on the part of the model
containing that Package.

Access

Ribbon Start > Collaborate > Model Library

Create a Review Document

Option Action

Name On the 'Team Document' dialog, type a
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name for the document.
This is the name that you use to recognize
and open the document in the Model
Library folders.

RTF
Template

Click on the drop-down arrow and select
either:

'None' to create a free-format document·

yourself, or
A document template name, to create a·

document of that type

OK Click on this button to open the document
in the 'Document Editor', which you can
use to populate the document with text
and images, format it and print it.
At the same time:

The Library window opens·

The 'Formal Reviews' category is·

created (if it does not already exist) in
the Model Library
A folder is created with the same name·

as the Specification Package (if it does
not already exist) in the 'Formal
Reviews' category
The review document name is added to·

this folder
If you have bound the Package to a
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different Model Library folder, the
'Review Document' is created in that
folder instead of under the 'Formal
Reviews' category.

Auto-generate a Review Document

Option Action

Name On the 'Team Document' dialog, type a
name for the document.
This is the name that you use to recognize
and open the document in the Model
Library folders.

RTF
Template

Click on the drop-down arrow and select
a document report system-template name,
to create a document of that type

OK Click on this button to generate the
document through the Document Report
Generator, containing the information
currently displayed in the Specification
Manager, within the parameters of the
report template.
At the same time:
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The Library window opens·

The 'Formal Reviews' category is·

created (if it does not already exist) in
the Model Library
A folder is created with the same name·

as the Specification Package (if it does
not already exist) in the 'Formal
Reviews' category
The review document name is added to·

this folder
The document is displayed in the 'Team
Document' tab for any further editing and
modification you need, although the
document is effectively ready for
immediate use.
If you have bound the Package to a
different Model Library folder, the 'Team
Document' is created in that folder
instead of under the 'Formal Reviews'
category.

Bind Package to Different Model Library
Folder

Ste Action
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p

1 On the 'Select a Topic to Link' dialog, click on the
expansion box next to the appropriate category name
to display the topic folders it contains.

2 Click on the appropriate topic folder name.

3 Click on the OK button.
When you:

Create a 'Review Document', it will now be·

automatically stored in the selected topic folder
Select the 'Show Current Review Folder' option,·

the Model Library window will open with the
selected folder name highlighted and expanded
Select the 'Current Reviews' option, the submenu·

will list the documents held in the selected folder;
click on one to open it

Notes

For a given Specification Package, you can generate as·

many review documents as you require

Before you generate a Review Document from the·

Specification Manager, you could run the system Spell
Checker over the Specification Package to remove any
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errors in the text
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View Review Document

In the Specification Manager, you can generate a range of
documents that either guide a structured review of the
elements you have listed, or provide the actual material - the
descriptions, features and properties of the elements - to be
reviewed. These documents are, by default, stored in the
'Formal Reviews' category of the Model Library, from
which point they can be accessed in a number of ways.
Whichever access path you select, the document opens in
the application work area and you can read the document
online, edit it and/or print it.

If you want to edit or print the document, you can do so
using the facilities of the common document editor, which is
used in creating and editing both documents and document
templates.

The Specification Manager also provides a facility for
changing the default folder into which the 'Review
Documents' are generated, and from which you can select
the documents to open.

Access

Ribbon To open the Library window:
Explore > Portals > Windows >·

Collaborate > Team Review    or
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Start > Collaborate > Model Library·

Other From the Library window:
Formal Reviews | <Package name> |·

double-click <document name>

Notes

If you have changed the default folder for the Package (by·

binding the Package to a folder other than those in the
'Formal Reviews' category), the 'Current Reviews' and
'Show Current Review Folder' options will automatically
show the new default folder and the documents it
contains; if you access the Library window directly, you
would need to know the name and location of the new
default folder
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Managing Changes

If you are responsible for a team of people who are working
on the specification, you can manage their work and monitor
the changes that they are making via the Specification
Manager, keeping the focus on the specification work rather
than having to establish the focus in each management tool
separately. You use the Specification Manager to:

Show if each element in the Package has a resource or·

maintenance item (the presence or absence of a column
indicator on the relevant column, or in the 'All Indicators'
column)

Where the element does have a resource or maintenance·

column indicator, open the appropriate window by
double-clicking on that icon

Where the element does not have a column indicator, or·

for other monitoring tools, maintain the focus on the
element for the window you open via the appropriate
ribbon

Access

Ribbon Design > Package > Specification View

(c) Sparx Systems 2022 Page  349 of 1974



Modeling Fundamentals 3 October, 2022

Management and Monitoring facilities

Facility Description

Manage
Package
Baselines

Press Ctrl+Alt+B or click on the 'Design
> Package > Manage > Manage
Baselines' ribbon option to open the
'Baselines' dialog, which you can use to
capture the state of development of the
Specification Package, as a Baseline. At a
later point, you can compare the current
state of the Package with this captured
Baseline (or another one) and establish
the changes that have been made since
that Baseline was made.
You can also roll back any of the changes
that you do not want to keep.

View Audit
Trail

Click on the 'Settings > Model >
Auditing' ribbon option to display the
Audit View and the 'Audit History' tab of
the System Output window.
You can use the Audit View initially to
turn on and configure Auditing, and then
to perform audit checks on changes to the
elements and connectors in the
Specification Package (which might
include changes to objects other than
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those of the Specification element type).
The results of the audit check are
displayed both in the Audit View and in
the System Output window.

Resources Click on the 'Construct > Resource
Management > Resources' ribbon option
to display the Resource Allocation
window. You can use this window to
define and allocate work for the people
(resources) working on the Specification
Package, either at Package level or at
element level (select an element on the
Specification Manager before defining
the work).
You can also select the Project Tools
window 'Risk', 'Effort' and 'Metrics' tabs
to define other aspects of work on an
element (the 'Construct > Project
Management > Effort', 'Risks' and
'Metrics' ribbon options). You create and
update the actual records through the
'<item> Details' dialog.
Once you have allocated a resource or
defined a risk, an icon displays on the
element row in the corresponding column
of the Specification Manager, and in the
'All Indicators' column. You can
double-click on the icon to redisplay the
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appropriate Project Tools window tab and
review the record, and add more records
if necessary.

Maintenance Click on the 'Construct > Change
Management' ribbon panel and select the
appropriate option for any of these
Maintenance items:

Features·

Changes·

Documents·

Issues·

Defects·

Tasks·

The corresponding tab of the
Maintenance window displays, through
which you can create a record to define
the maintenance item for the
Specification Package or a selected
element within it.
When you create one of these records, an
icon displays on the element row in the
'Maintenance' and 'All Indicators'
columns of the Specification Manager.

Testing Click on the 'Construct > Test
Management > Tests' ribbon option and
select the appropriate option for any of
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these test types:
All·

Inspection·

Unit·

Integration·

System·

Acceptance·

Scenario·

The Test Cases window displays at the
corresponding tab, through which you
can create a record to define a Test for
the Specification Package or a selected
element within it (the record is actually
created and edited on the '<item> Details'
dialog).
When you create one of these records, an
icon displays on the element row in the
'Test' and 'All Indicators' columns of the
Specification Manager. You can
double-click on the icon to redisplay the
Test Cases window and review the
record, and to add more records if
necessary.

View
Package as
Gantt or List

Click on the 'Design > Package > Gantt
View' or 'List View' ribbon option to
display the Package contents in Gantt or
List format, on a separate tab. The Gantt
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view lists all the elements in the Package,
showing their assigned resources and the
progress of work on their separate tasks,
both in text on the left hand side and as a
graphical timeline on a calendar on the
right. In List format, the elements are
simply listed in a more condensed form
of the Specification Manager, with no
Notes text, Maintenance items or Tests.
You can review the element properties or
resource details by double-clicking on the
item.

Notes

If a record or entry does not display on the Specification·

Manager when you save the record, press F5 to refresh the
display

Package Baselines and Auditing are available in the·

Corporate and extended editions of Enterprise Architect

In the Corporate and extended editions of Enterprise·

Architect, a User Security system can be applied that
restricts or enables access to a range of operations and
functions; if you cannot access a function in the
Specification Manager, check with your System
Administrator or Security Administrator to see if you have
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access permissions to work with that function
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Reporting

As you develop the elements in the Specification Package,
you can produce a number of documents and reports to
either disseminate the information you have compiled or to
extract additional information on the elements from other
aspects of model development and management, that might
not be immediately visible in the Specification Manager.

You can also export the data you have created to a .csv file
and perhaps onwards to another tool, or import element
information created outside Enterprise Architect.

Access

Ribbon Select the element in the Specification
Manager, and the 'Specification - Specify
> Element > Documentation' option, then
the required submenu option:

Generate Documentation·

(DOCX/PDF/RTF)
Publish as HTML·

Publish as Joomla! Article·

CSV Import/Export·

QA Reports and Metrics·

Spell Check Current Package·
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Review facilities

Facility Description

Generate
documentatio
n in report
document
format

Enterprise Architect provides a
comprehensive report generation facility,
through which you can create a range of
reports on different aspects of your
model. You can apply this facility to the
elements of a Specification Package, to
generate a report in any of these formats:

DOCX·

PDF·

RTF·

Select the 'Generate Documentation
(DOCX/PDF/RTF)' option.
The 'Generate Documentation' dialog
displays, with the 'Element' field set to
'Selected Elements' as the target contents
of the report, and the 'Template' field set
to 'Specification Manager List'.  The
output file extension determines the
output format of the document.

Generate As you develop the Specification
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documentatio
n in web
page format
(HTML)

Package elements you can publish them
on the web, where the outline structure
closely mirrors the Package structure and
makes it very simple to explore on-line.
You export the Package to web pages,
where the web report provides an easy to
use, highly detailed, JavaScript-based
structure. In addition, any hyperlinks in
the elements make browsing to related
information very simple.
Select the 'Publish as HTML' option.
The 'Publish as HTML' dialog displays,
with the Specification Package name in
the 'Package' and 'Title' fields.

Generate
documentatio
n as a
Joomla!
Article

An Enterprise Architect Package can be
published as an Article (HTML page) in a
local Joomla! installation, using the
'Publish as Joomla! Article' dialog. All
child Packages of the selected Package
will be automatically included for
publishing.
Select the 'Publish as Joomla! Article'
option.
The 'Publish as Joomla! Article dialog
displays, with the Specification Package
name in the 'Package' field.

Generate In Enterprise Architect you can import
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spreadsheet
file (CSV)
and import
from a
spreadsheet

data from a spreadsheet into a Package
and export element data from a Package
into a .csv file.
You can perform both of these operations
within the Specification Manager, to
bring in an existing set of element
definitions to the Specification Package
or transfer the Enterprise Architect
element definitions to a different location.
Select the 'CSV Import/Export' option.
As part of either operation, you need to
create a CSV Specification file.
Whilst your display might be filtered to
show a specific type of element, the
operations work on the Package itself and
incorporate all types of element within
the Package.
After you perform an import, refresh the
display (press F5) to show the imported
elements.

Generate
Quality
Assurance
reports and
Metrics

Enterprise Architect provides several
Quality Assurance reports for checking
the development and impact of
development of the elements in a
Package. You can access these within the
Specification Manager, so that the
Specification Package is automatically
the target of the report.
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You can also view and adjust the metrics
report should you want to monitor the
impact on the project metrics of the work
that the elements in the specification
might entail.

Spell-check
the Package

Before generating and/or printing any
information from the Specification
Manager, you could run the system Spell
Checker over the Specification Package
to remove any errors that might exist in
the element names and text.
Select the 'Spell Check Current Package'
option to display the 'Spell Check:
<Package Name>' dialog, and click on
the Start button.

Notes

In the Corporate and extended editions of Enterprise·

Architect, a User Security system can be applied that
restricts or enables access to a range of operations and
functions; if you cannot access a function in the
Specification Manager, check with your System
Administrator or Security Administrator to see if you have
access permissions to work with that function
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Model Elements

Elements are the building blocks of models and, together
with Connectors, they help a modeler to describe an
enterprise, business engineering, real-time or software
system. They can be found in the Browser window and will
typically appear on one or more diagrams, where a modeler
will describe what role they play in the model. They also
appear in a wide range of dialog windows that show other
aspects of the elements, such as testing and resource
allocation.

The element types are defined by the modeling languages or
profiles they belong to; for example, Classes and Use Cases
are part of the grammar of UML, Activities and Gateways
are part of the grammar of BPMN, and Blocks and
Requirements are part of the grammar of SysML. Each
element type has a notation that helps modelers recognize
the element and understand its purpose.

In a diagram, when you create or select an element, a small
toolbar of options also displays off the top right corner of
the element. The first of these is the Quick Linker arrow for
creating connectors and target elements, and the others are
Element Icons for performing specific operations on the
element's appearance in the diagram.

Elements typically have a name, description and a series of
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properties and features that describe them, including project
properties such as status, phase and author.

(c) Sparx Systems 2022 Page  363 of 1974



Modeling Fundamentals 3 October, 2022

Hyperlinks

Hyperlinks are very simple structures, but they add an
incredible versatility to both navigation of your model and
the provision of information through the various methods of
communication within your project. You can create
hyperlinks:

As elements or references in diagrams·

In the text of notes and descriptions in the properties of·

modeling objects and project management objects

In the element specifications in the Specification Manager·

In the text of Linked Documents or generated reports,·

through the document and template editors

In Model Mails and Model Library postings·

In each case, the targets of these hyperlinks might be:

Packages, elements, diagrams, attributes or operations in·

the model

Specific topics in the Enterprise Architect Help·

External files·

Web sites·

Model Library postings·

Diagram images and other graphics·

Commands to initiate operations and processes in·

Enterprise Architect

Model Searches to run·

Matrix profiles to display·
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Learning Center topics·

Between any two contexts, the way in which you create the
hyperlink and the range of objects you can link to might
differ, but the common benefit is that you are providing a
wealth of information on a specific point without
overburdening:

The object with a lot of text in one volume·

Yourself in having to re-create and maintain the·

information in every instance of its use

Your readers with too much information at once·

Table of Methods

Create a
Hyperlink

Description

As an
element on a
diagram

To create a Hyperlink element on a
diagram and assign a target object to it,
either:

Drag the 'Hyperlink' icon onto the·

diagram from the 'Common' page of
the Diagram Toolbox, or
Click on the icon in the 'UML·

Elements' Toolbar and then click on the
diagram

You provide the text of the link directly
on the diagram, then double-click on the
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element to display the element 'Hyperlink
Details' dialog on which you identify the
type of target object, the target itself and
any other necessary properties of the link.
Note that initially the link text is held in
the 'Alias' field and can be edited there,
but if you select certain types of target
object (such as another diagram) the link
text is read from the 'Notes' field and the
'Alias' field is disabled.
After you have defined the target object,
double-clicking on the element executes
the link; to edit the element's properties,
right-click on it and select the 'Properties'
option. For most type of link, the element
displays as shown here:

Certain types of link, however, have their
own icon; for example, a Hyperlink
element linking to a diagram or a link to a
Help topic ( ).

On a diagram
to another
diagram

To create a link to another diagram on the
current diagram:

Drag the target diagram on to the1.
current (host) diagram. The 'Select
Type' dialog displays.
Select the 'Hyperlink' option and click2.
on the OK button.
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The final hyperlinked diagram should
now have a link referencing the target
diagram, resembling this:

The link will open (in this case) the
'Location' diagram in the 'Location'
Package. The target diagram name is
written to the element 'Notes' field, and
you can edit this field in the element
properties to an alternative link text.
A hyperlink to a diagram, whether
created by this method or by dragging the
'Hyperlink' icon onto the diagram, has a
different icon to the standard Hyperlink
element icon, although in all other
respects it is the same type of element.
(If the hyperlink displays as a Sub
Activity, select the 'Start > Application >
Preferences > Preferences > Diagram >
Behavior' ribbon option and deselect the
'Use Automatic SubActivities' checkbox.)

On a diagram
to a file

To create a hyperlink on a diagram to an
external file, simply click on the file in a
file list (such as Windows Explorer) or on
your Desktop and drag it onto the
diagram.
A short context menu displays with two
options - 'Hyperlink' and 'Artifact'. Click
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on the 'Hyperlink' option to create the
hyperlink on the diagram.
The link is effective immediately, and
you can right-click on it to add or change
properties as necessary.
Files of most types - including .sql and
.ddl - are opened within the appropriate
Enterprise Architect code editor.

On a diagram
to a Script

You can create a hyperlink on a diagram
to execute a script. Simply drag the
required script from the Execution
Analyzer window onto the diagram. A
context menu displays, from which you
select whether the script to be executed is
a Build, Test, Run, Debug or Deploy
script. The hyperlink is effective
immediately; when you click on it, the
script executes.

As an Action
element on a
diagram

Drag an Action element from the
'Activity' page of the Toolbox onto the
diagram; a context menu displays (if not,
hold Ctrl as you drag the Action onto the
diagram).
Select the 'Other' option; the 'New Action'
dialog displays, with the 'Other' radio
button selected.
Click on the drop down arrow on the text
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field in the 'Select Kind' panel, and click
on the 'Hyperlink' option.
Click on the OK button; the Hyperlink
Action element displays on the diagram.
Right-click on the element and select the
'Advanced | Set Hyperlink' menu option;
the 'Hyperlink Details' dialog displays.
Set the hyperlink's properties.

From Notes
to a specific
element

Within the text of the 'Notes' field of an
object's 'Properties' dialog, or in the Notes
window, you have three options for
creating a hyperlink to another element:

Right-click on a highlighted text string·

and select the 'Create | Link to Existing
Element' option, to link to an element
anywhere in the model
Right-click on a highlighted text string·

and select the 'Create | New Element
from Selection' option, to create a new
element in the same Package and link
to it; the name of the element is the
highlighted text
Click on the 'Hyperlink' icon in the·

'Notes' toolbar to display the in-text
'Hyperlink Details' dialog, select
'Element' in the 'Type' field, and select
the existing element to link to; the
element name forms the link text in the
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'Notes' text, at the cursor position

In
Notes/Descri
ption text

In a 'Notes', 'Description' or similar text
field, you can also click on the
'Hyperlink' icon in the 'Notes' toolbar to
create links to a range of types of object
other than 'Element'. You can use full
paths or local (path substitution) paths,
and you can either select or type the link
text, or leave the text blank to use the link
address as the text.

Within the
Specification
Manager

As you build the specification of an
element and create Notes text to describe
it, you can add hyperlinks to a wide range
of target objects to support and enhance
the specification. Highlight the link text,
right-click on it and select the 'Create |
Hyperlink' option. The 'Hyperlink Details'
dialog displays, on which you specify the
target object type and the object itself.

In a report
document

When you generate a report on a section
of your model, the Document Generator
either:

Activates any hyperlink in that part of·

the model and includes the linked
object (generally a diagram image) in
the report, or
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Displays the hyperlink as a reference to·

the linked object (most other links)
You can, however, add other hyperlinks
directly to either the generated report or
the report template, to display material
external to the model; namely a web
page, Enterprise Architect Help topic, or
a document file. To do this, you
right-click on the appropriate point in the
report and select the 'Insert | Hyperlink'
option; then specify the access path of the
object to link to.

Within a
Linked
Document

When you have created a Linked
Document for an element, you can add
hyperlinks in the text of that document to
other elements in the model, and to web
pages, Help files, Model Searches and
Model Library Forums. When you next
open the Linked Document you can
double-click on the hyperlink to open the
linked files or to locate and highlight the
object in the Browser window.
To create a link to an element, you can
simply drag the element from the
Browser window into the document.
Alternatively, right-click in the text and,
for an element, select the 'Create | Link to
Existing Element' option or, for links to
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other objects, select the 'Create |
Hyperlink' option.

In a Model
Library post

The Model Library facility provides a
number of options for creating links out
of dragged objects or specifically
providing link text and a link address
within a document or post. The
'Resources' folder underneath a Model
Library Post consists entirely of links you
create to objects of relevance to the post.

In a Model
Mail

When you are using Model Mail to
discuss a modeling object or supporting
information, you can add a hyperlink to
your text to open the object that you are
discussing.
A quick way to create a hyperlink is to
select the modeling object in the Browser
window, place the cursor at the
appropriate position in your message text,
click on the Insert Quick Link button and
select the name of the modeling object.
The hyperlink to the object is
immediately created at the cursor
position.
If you need to search for the modeling
object, or you want to link to a different
type of target such as a file, Model
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Search or Model Library message, click
on:

The 'Hyperlink' icon in the toolbar or·

The Insert Quick Link button and select·

the 'Other' option
The 'Hyperlink Details' dialog displays.
Use this to create the required link.
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Hyperlink Target Objects

Some of the hyperlink facilities in Enterprise Architect are
filtered to create a link between two specific types of object.
Other facilities, however, give you a choice of types of
target object with minor variations in the information you
provide to identify the target. The widest variety of target
types is available from the:

Element 'Hyperlink Details' dialog displayed when you·

create a Hyperlink element on a diagram, and

In-text 'Hyperlink Details' dialog displayed when you·

create a hyperlink in the element Notes, either from the
Notes Toolbar or in the Specification Manager

The in-text 'Hyperlink Details' dialog does not prompt for
the link text, so you either highlight a word or phrase in the
text to act as the link text before you create the hyperlink, or
you allow the name or path of the linked object to become
the link text.

Most hyperlinks can only be actioned within the diagram or
element in which they are created, but links to diagram
images and Image Manager images are also actioned within
a generated report and actually show the linked image.

Identify Target Objects

This table provides instructions for specifying the target
object of a hyperlink, for each of the available types of
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object, using either of the two 'Hyperlink Details' dialogs.

Link to Action

An attribute In the 'Type' field, click on the drop-down
arrow and click on 'Attribute'. The 'Set
Attribute' browser displays, in which you
locate and click on the required attribute.
Click on the OK button to return to the
'Hyperlink Details' dialog, and again to
create the hyperlink.
If you activate the link, the attribute is
highlighted in the Browser window.

A source path In the 'Type' field click on the drop-down
arrow and click on 'Browse for File'. A
file browser opens, from which you select
the source directory containing a number
of files that the user might want to open.
Click on the OK button to return to the
'Hyperlink Details' dialog, and again to
create the hyperlink.
If a user activates the link, a 'Locate File'
dialog displays at the specified source
directory, and the user can select any of
the files in that directory to open within
Enterprise Architect or a registered
external application.
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An element
image

In the 'Type' field, click on the drop-down
arrow and click on 'Element Image'. The
'Select an Element' browser displays, in
which you locate and click on the
required image-stereotyped Artifact
element.
Click on the OK button to return to the
'Hyperlink Details' dialog, and again to
create the hyperlink.
If you activate the link, the element
'Properties' dialog opens. In a generated
report, the element image displays instead
of the link.

A diagram In the 'Type' field, click on the drop-down
arrow and click on 'Diagram'. The 'Select
Classifier' browser displays, in which you
locate and click on the required diagram.
You can search for the diagram by name
in a specific namespace in the model, or
across the whole model.
Click on the OK button to return to the
'Hyperlink Details' dialog, and again to
create the hyperlink.
If you activate the link, the diagram
opens. In a generated report, an in-text
link acts as a simple reference to the
diagram.
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A diagram
image

In the 'Type' field, click on the drop-down
arrow and click on 'Diagram Image'. The
'Select Classifier' browser displays, in
which you locate and click on the
required diagram. You can search for the
diagram by name in a specific namespace
in the model, or across the whole model.
Click on the OK button to return to the
'Hyperlink Details' dialog, and again to
create the hyperlink.
If you activate the link, the diagram
opens. In a generated report, an image of
the diagram displays instead of the link.

An
Enterprise
Architect
command

In the 'Type' field, click on the drop-down
arrow and click on 'EA Command'. In the
unlabelled 'Address' field, click on the
drop-down arrow and select the required
command from the list. If the command is
not part of the default set, click on the
drop-down arrow in the second field and
select the technology that provides the
command. For some commands you
might have to provide further parameters,
in which case the  button displays;
click on this button and complete the
resulting dialog.
Click on the OK button to create the
hyperlink.
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If you activate the link, the system
actions the command and displays the
resulting screen, dialog or message.

An element In the 'Type' field, click on the drop-down
arrow and click on 'Element'. The 'Select
Element' browser displays, in which you
locate and click on the required element.
Click on the OK button to return to the
'Hyperlink Details' dialog, and again to
create the hyperlink.
If you activate the link on a diagram, the
element is highlighted in the Browser
window.
If you activate an in-text hyperlink, the
system will act on the element according
to its type, with the same result as if you
double-click on the element in the
Browser window. For example, if you
click on the hyperlink to a Document
Artifact element, the document,
specification or matrix that the Artifact
represents opens; if you click on a
hyperlink to a Chart element, its
'Properties' dialog opens at the chart
'Source' page.
When hovering over the hyperlink, the
standard hyperlink element buttons will
also be displayed, allowing you to display
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the 'Properties' dialog, find the element in
diagrams, find the element in the Browser
window, or open the Linked Document
attached to the element.

A file 'File' is the default setting for the 'Type'
field.
In the 'Address' field, type or paste the
file path and file name to access, or click
on the  button to browse for the file. (If
you click on the 'Type' drop-down arrow
and select 'File', the browser displays
automatically.)
Click on the OK button to create the
hyperlink.
If you click on a link created through the
in-text 'Hyperlink Details' dialog, the file
opens in an editor. In the element
'Hyperlink Details' dialog you can specify
whether the file will be opened for editing
or just for viewing.

A Help topic In the 'Type' field, click on the drop-down
arrow and click on 'Help'. In the 'Address'
field, type or copy the .htm file name of
the Enterprise Architect Help topic to link
to; for example, add_a_legend.htm. You
can get this address by displaying the
Help topic and copying the contents of
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the address field at the top of the screen.
Click on the OK button to create the
hyperlink.
If you activate the link, the Help topic
opens from the Sparx Systems website.

An Image
Manager
Image

In the 'Type' field, click on the drop-down
arrow and click on 'Image Manager'. The
'Image Manager' dialog displays, in
which you locate and click on the
required image name.
Click on the OK button to return to the
'Hyperlink Details' dialog, and again to
create the hyperlink.
If you activate the link, the View Image
window displays, showing the selected
image. In a generated report, the image is
also displayed instead of the link.

A Learning
Center topic

In the 'Type' field, click on the drop-down
arrow and click on 'Learning Center'. The
path of the default Learning Center topic
(Use the Learning Center) displays in the
'Address' field. Click on the 'arrow-head'
symbols in the path to display the
contents of each child section and browse
to the topic you want to link to.
Click on the OK button to create the
hyperlink.
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If you activate the link, the Learning
Center view opens, displaying the topic.

A
Relationship
Matrix
profile

In the 'Type' field, click on the drop-down
arrow and click on 'Matrix'. The 'Select a
Matrix Profile' dialog displays; click on
the drop-down arrow and on the required
profile name.
Click on the OK button to return to the
'Hyperlink Details' dialog, and again to
create the hyperlink.
If you activate the link, the Relationship
Matrix displays with all fields set
according to the selected profile.

An Operation In the 'Type' field, click on the drop-down
arrow and click on 'Operation'. The 'Set
Operation' browser displays, in which
you locate and click on the required
operation.
Click on the OK button to return to the
'Hyperlink Details' dialog, and again to
create the hyperlink.
If you activate the link, the operation is
highlighted in the Browser window.

A Package In the 'Type' field, click on the drop-down
arrow and click on 'Package'. The 'Find
Package' browser displays, in which you
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locate and click on the required Package.
Click on the OK button to return to the
'Hyperlink Details' dialog, and again to
create the hyperlink.
If you activate the link, the Package is
highlighted in the Browser window.

A Model
Search

In the 'Type' field, click on the drop-down
arrow and click on 'Search'. The 'Select a
Search' dialog displays, in which you
specify the search term, the search
category that contains the search, and the
name of the search itself.
Click on the OK button to return to the
'Hyperlink Details' dialog, and again to
create the hyperlink.
If you activate the link, the Find in
Project view displays with the results of
the executed search.

A Simulation In the 'Type' field, click on the drop-down
arrow and click on 'SimRun'.
Click on the OK button to create the
hyperlink.
If you activate the link, a suite of
Simulation windows display, and a
simulation is executed on the current
diagram.
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A Model
Library
Posting

In the 'Type' field, click on the drop-down
arrow and click on 'Team Document'. The
'Select a Topic to Link' browser displays,
in which you locate and click on the
required review document.
Click on the OK button to return to the
'Hyperlink Details' dialog, and again to
create the hyperlink.
If you activate the link, the Team
Document view displays, showing the
Linked Document. The Library window
also displays, showing where the
document came from and providing the
opportunity to select and display related
documents.

A web site In the 'Type' field, click on the drop-down
arrow and click on 'Web Site'. In the
'Address' field, type or paste the web
address of the site.
Click on the OK button to create the
hyperlink.
If you activate the link, the selected web
page displays in a separate window.
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Notes

To activate a Hyperlink element, double-click on it; to·

activate an in-text link, press Ctrl as you click on it

When creating a hyperlink, for most target objects the·

system automatically opens a browser to populate the
'Address' field; when you edit the hyperlink, use the 
icon at the end of the field to display the browser and
change the target object
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Non-printable Elements

When you intend to generate a report that depicts diagrams
from your model, you might decide that you do not want to
show certain elements on a diagram in the report. You might
have, for example:

Notes and Text elements containing short pieces of·

information or explanations

Artifact elements containing standards or instructions in·

Linked Documents

Any other element that is not relevant to the purpose or·

subject of the report

You can exclude such elements (with their connectors) from
being printed in any depiction of the diagram in a report, by
manipulating the 'Printable' status of each non-relevant
element. Conversely, you can force the inclusion of these
non-printable elements in the printed diagram, by turning
off the 'Hide non-printable objects' option in report
generation.

Configure the Printable Attribute

All elements added to a diagram have the status 'Printable'
by default. To turn this off and make an element
non-printable (or turn it back on again) right-click on the
element and click on the 'Printable' option.

You can turn this option on or off for multiple elements, by
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selecting the elements and right-clicking on one of them to
display the context menu, then clicking on the option.

Activate Printable Option for Reports

You can control the printing of non-printable elements on
depictions of diagrams in reports, through the 'Options' page
of the 'Document Generation' dialog.

Option Action

Using in
Custom
Reports

Select the parent Package or element for
the diagram, and press F8; set up your
report generation parameters as required.
On the 'Options' page, the 'Hide
non-printable objects' checkbox defaults
to selected, to omit all elements that have
the 'Printable' option turned off from
depictions of diagrams in the report.
If you want to include non-printable
elements in the diagrams in the report,
click on the checkbox to clear it.

Using in
Document
Templates

The 'Hide non-printable objects' option is
a global, registry, setting and cannot be
turned off in document templates or in
document generation through the
Automation Interface.
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Notes

Turning off the 'Printable' option for an element also hides·

the element and its connectors when you print the
diagram, print to PDF and save an image of the diagram
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Tagged Values

Tagged Values are additional properties that can be assigned
to UML elements and connectors. The UML defines
properties such as name and description for elements and
connectors, and Enterprise Architect adds a number of
additional properties such as status, phase and author, but
Tagged Values provide a means of defining your own
properties (tags) and their values.

For example, a requirements modeler might want to record
the owner of a set of Requirements. The UML doesn’t
specify this property, but it can be easily added as a tag. A
tag named Requirement Owner could be created and then
each Requirement element could be assigned a value for the
owner. This information would also be available in
documentation.

Enterprise Architect has enriched the basic concept of
Tagged Values with its comprehensive structured Tagged
Value facility. To assist you when entering data, the values
can be restricted using user interface controls such as drop
down lists, spin controls, date selectors and many more.

Tagged Values are widely used in profiles and technologies
to add information that helps guide the presentation of
elements or metadata for code or schema generation.
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The Tagged Values tab

The 'Properties' dialog and Properties window both have
'Tag' tabs that you can use to view and modify Tagged
Values for a modeling item selected either from the current
diagram or in the Browser window. On the tab you can:

Assign a Tagged Value to an Item·

Modify Tagged Values·

Assign Notes to a Tagged Value·

Perform advanced tag management·

Note that Tagged Values from stereotypes are not displayed
on the 'Tags' tab, but in the:

Properties window, in a section of the main page·

underneath the 'General' page and

'Properties' dialog, on a separate <extension name> tab·

Model Elements and Features with Tagged
Values

These model components can use the 'Tagged Values' tab as
a convenient way to quickly view and modify Tagged
Values:

Elements - display their own tags, along with any·

inherited values
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Object Instances - display their own tags and those·

obtained from their classifier

Ports and Parts - display similar information to objects but·

show the Port/Part 'Type' instead of a classifier; tags are
included for all parents and other structures of the Ports
type

Attributes - display their own tags and those received·

from attribute type classifiers, with the inclusion of any
inherited tags

Operations - display their own tags·

Connectors - display their own tags·

When over-riding an inherited property, the system copies
the tag from the parent down to the child element and sets
the new value, leaving the original tag unchanged.

Tagged Values Toolbar Buttons

Using the buttons from the toolbar at the top of the 'Tags'
tab in the Properties window or dialog, you can add, edit,
sort, delete and re-arrange the Tagged Values of model
features.

From left to right, the button functions are:

Show in compartments - displays the Tagged Values in·

element compartments on diagrams

Sort and Show Alphabetically - sorts the current Tagged·
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Values alphabetically for the element

New Tagged Value - adds a new tag, to which you assign·

a value

Edit Tagged Value Notes - opens a note in which you type·

an explanation of the purpose of the Tagged Value

Delete Tagged Value - removes the currently selected·

Tagged Value

Default Tagged Value Types - provides quick access to·

tag definitions created using the 'Settings > Reference
Data > UML Types > Tagged Value Types' ribbon option

Tagged Value Options - provides options to show or hide·

the fully qualified paths for the Tagged Values in the
window, and to show duplicate Tagged Values

Help - displays information on the use of Tagged Values·
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Quick Start - Add Tagged Value To
Elements

You can quickly add a single Tagged Value to one or more
elements within a diagram, using a context menu option.

Access

Context
Menu

On a diagram, select one or more
elements, and right-click on one; select
the 'Add Tagged Values' context menu
option

Other On a diagram, select one or more
elements, and click on the  icon at right
end of the Element toolbar

Add a Tagged Value to elements

Ste
p

Action

On the 'Tagged Values' dialog, in the 'Tag' field, type
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1 in the tag name. (Do not use the drop-down arrow to
select an existing tag type.)

2 In the 'Value' field, type in the value for the tag.

3 Click on the OK button to add your new Tagged
Value to the currently selected elements.

Notes

To delete the Tagged Value, open the Properties window·

for the element, click on the 'Tag' tab and the tag name,
and click on the 'Delete' icon

To add notes to the Tagged Value, in the 'Tag' tab click on·

the Tagged Value name, and click on the  button in the
tab toolbar; the 'Notes' dialog displays

The notes are displayed in the lower portion of the·

Properties window (only if the 'Hide Properties Info
Section' checkbox is not selected in the 'Window
Behavior' tab of the 'Preferences' dialog - select the 'Start
> Appearance > Preferences > Preferences > General >
Window Behavior' ribbon option; if you change the
setting of this option, you might have to restart Enterprise
Architect to make the change take effect)
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Assign a Tagged Value to an Item

You can assign Tagged Values to a range of model objects,
including elements, object instances, connectors, attributes
and operations, using the 'Tags' tab of the Properties
window. You would probably have the window open
already as a docked window, and any object you select
becomes the focus of the window; you can then review and
add or delete Tagged Values for that object.

Access

Ribbon Start > All Windows > Properties >
General > Tagged Values
Design > Element >  Properties > General
> Tagged Values

Assign a Tagged Value to an item

Ste
p

Action

1 Select the model feature to which to assign a Tagged
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Value. This feature becomes the focus of the
window.

2 In the 'Tags' tab of the Properties window, either
click on the  icon or press Ctrl+N.
The 'Tagged Value' dialog displays.

3 In the 'Tag' field type the tag name, or click on the
drop-down arrow and select the appropriate tag to
assign to the item. The list of tags to select from is
filtered by the Perspective that is currently set for the
model.

4 If appropriate, type a specific value for the tag in the
'Value' field.

5 To confirm selection of the Tagged Value, click on
the OK button.
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Assign Notes to a Tagged Value

Once a Tagged Value has been assigned to a model feature,
you can add information and notes describing the Tagged
Value to the information property of the Tagged Value.

Access

Ribbon Start > All Windows > Properties >
General > Tagged Values
Design > Element > Properties > General
> Tagged Values

Assign a note to a Tagged Value

Ste
p

Action

1 Click on the model feature for which to edit the
Tagged Values.
Its Tagged Values display in the 'Tags' tab of the
Properties window.
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2 Click on the Tagged Value to add information to.

3 Click on the  button or press Ctrl+E.
The 'Tagged Value Note' dialog displays.

4 In the 'Note' field, type the information relating to
the Tagged Value.
Click on the OK button.

5 The information is displayed in the lower portion of
the Properties window whenever the Tagged Value
is selected.

Notes

The notes are displayed in the lower portion of the·

Properties window only if the 'Hide Properties Info
Section' checkbox is not selected in the 'Window
Behavior' tab of the 'Preferences' dialog (select the 'Start >
Appearance > Preferences > Preferences' ribbon option
and the 'General > Window Behavior' tab); if you change
the setting of this option, you might have to restart
Enterprise Architect to make the change take effect
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Modify Tagged Values

Once a Tagged Value has been assigned to a model feature
(such as an element or connector), it is possible to edit the
values in the 'Tags' tab of the Properties window.

Access

Ribbon Start > All Windows > Properties >
General > Tagged Values
Design > Element > Properties > General
> Tagged Values

Edit Tagged Values

Ste
p

Action

1 Click on the model feature for which to edit the
Tagged Values.
The 'Tags' tab shows all of the tags for the selected
feature, each with their current value.
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2 Edit the fields as appropriate; the information
entered can only reflect the value types that have
been defined by the tag's Tagged Value Type.
There are six types of value field for a Tagged
Value:

'Open' fields, in which you can type any·

appropriate value
Structured Tags, where you do not directly edit the·

composite value but expand the tag to show the
component tags and edit the component values in
'open' fields; the composite value updates as you
click off the component field
'Drop-down list' fields, where you click on the·

drop-down arrow to select from a discrete list of
possible values such as 'M' or 'F', or 'Win', 'Lose'
or 'Draw'
'Spin' fields, where you click on up or down·

arrows in the field to increase or decrease the
value within certain limits
Checklist fields, where you click on the  button·

in the field to display the 'Check List' dialog,
which lists a set of items that can be selected by
ticking the checkbox against each item; if any
checkboxes are not selected the value of the tag is
'Incomplete', and when all checkboxes are selected
the tag value is 'Complete'
'Further detail' fields, where you click on the ·

button in the field to display a dialog in which you
enter information (such as notes) or indicate a

(c) Sparx Systems 2022 Page  399 of 1974



Modeling Fundamentals 3 October, 2022

source of further information (such as a classifier)

Notes

To override a Tagged Value defined in a parent element,·

edit the value in the 'from <parentname>' compartment of
the 'Tags' tab; once this has been done the tag is moved
into the selected element's Tagged Values - this does not
affect the Tagged Values defined in the parent element
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Show Duplicate Tags

Tagged Values are by default set to hide duplicate values.
This setting is used to facilitate inherited and overridden tag
names.

Access

Ribbon Start > All Windows > Properties >
General > Tagged Values
Design > Element > Properties > General
> Tagged Values

Set the Tags tab to show duplicate values

Ste
p

Action

1 On the 'Tags' tab toolbar, click on the  (Options)
icon.

2 Select the 'Show Duplicate Tags' option.
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Alternatively

Ste
p

Action

1 Select the 'Start > Application > Preferences >
Preferences' option.
The Preferences window displays.

2 From the hierarchical tree, select the 'Objects' item.

3 Select the 'Show Duplicate Tags' checkbox.

Notes

In either procedure, to hide duplicate values again·

deselect the option or checkbox
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Advanced Tag Management

Tagged Values can also be managed within a type hierarchy
and with respect to element instances, using the 'Tags' tab of
the Properties window. It is possible to:

View Tagged Values inherited from parent Classes or·

realized interfaces or applied stereotypes

Override Tagged Values derived from parents or applied·

stereotypes with a unique value for the current element

Delete Tagged Values from the current element (if a·

parent version of the Tagged Value exists, it re-appears in
the list after the override is deleted)

For a reference Tagged Value (of type RefGUID), it is also
possible to locate and select the object that the Tagged
Value refers to, in the Browser window. Simply right-click
on the Tagged Value name in the 'Tags' tab and select the
'Find in Project Browser' option.

Tag Hierarchy

This diagram illustrates a complex tag hierarchy and the
way Tagged Values can be either inherited or overridden in
specialized Classes to create the final tagged property set for
an element. A similar concept applies to instances, where
the full tag set is created from the directly owned tags, plus
all of those merged in from the classifier's type hierarchy,
additional stereotypes and realized interfaces.
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«powertype»
Simple NIC

tags
DeliveryStrategy = Simple
IOSpeed = 10MB

SlowEthernet

tags
IOSpeed = 1 MB
Latency = 21 ms
ManufactureName = SimpleParts

«powertype»
BetterNIC

tags
IOSpeed = 25MB

«interface»
FastEthernet

tags
IOAccelerator = True

«powertype»
SuperNIC

tags
IOSpeed = 100MB

«realize»

«realize»
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Connectors

Relationships in any context can be hard to understand, and
relationships between model elements are no exception. In
modeling, the elements are only part of the model;
relationships are like a glue that binds the elements together
or, making a comparison with natural languages, if the
elements are nouns the relationships are verbs that describe
how the nouns relate to each other.

Relationships are represented in modeling diagrams by
different types of line, or connector, each line indicating the
kind of relationship and interaction there is between the
elements. The connector types are defined by the modeling
languages or profiles they belong to. For example,
Associations and Generalizations are part of the grammar of
UML; Sequence Flows and Message Flows are part of the
grammar of BPMN; and Allocates and Item Flows are part
of the grammar of SysML. Each connector type has a
notation that helps modelers recognize the connector and
understand its purpose; the types also inform tools such as
the Code Templates Framework how to generate resulting
models, schemas or programming code.

There are many different types and styles of connectors.
They can have arrows (indicating direction) or other
markers that express the semantics of the relationship; they
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can have names, stereotypes and Tagged Values, and a wide
range of other properties. Some connectors are like conduits
that allow material and tokens to flow; some are about
family, others tell an element to change its state, while still
more are about signals and structure. It is important to
remember that a diagram is just a projection (or view) of an
underlying model and just because a connector isn't visible
on the diagram it doesn't mean that it doesn't exist. Perhaps
the best way to think about a diagram is as a narrative or
story that is trying to reveal a plot to an audience. The
connectors play an important role in this story telling, and
hiding them or leaving them out is sometimes as important
as putting them in.

Connectors can also 'reach' inside the perimeter of the
element and be attached to an element's features (attributes,
operations and receptions). This is particularly useful when
doing data matching, for example, between two different
data sources.

There are a number of places where you can review
connectors in Enterprise Architect - other than in diagrams -
including the Traceability window, the simple Feature and
Gap matrixes, the Relationships Window, the Hierarchy
Window, the Relationship Matrix, the 'Details' tab of the
Inspector window and the 'Properties' dialog for an element.
They are, however, most expressive in diagrams, where
their characteristics and properties are easily observable.

Factors in Modeling Connectors
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Operation Discussion

Routing and
Bending

Connector lines require geometry to be
able to navigate around the elements on
the diagram as they emerge from one
element and connect to another.
Thoughtful placement of related elements
can limit the need to route connectors, but
it is often the case that connectors have to
be bent and directed. Some line styles -
such as the Auto Routing style - can
manage  this automatically, but using the
Custom Style is the most flexible method,
allowing any number of way-points to be
added to a connector, at each of which
the line can be bent to direct it in a
complex path through the diagram. The
Diagram Layout tool also provides ways
of automatically laying out a diagram to
organize it neatly with a minimum of
crossed lines. When lines do have to
cross you can select an option to add
jump symbols to reduce the ambiguity of
the line direction.

Changing
Style

Connectors have default line styles that
you can change to create more appealing
and meaningful representations of the
relationships; for example, a relationship
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of family can be represented by a Tree
style. This shows the parent element at
the top and the child elements in a row
underneath (or in a column to the side)
with the connectors between each child
and the parent having a common 'trunk' at
the parent, in a tree format. The same
relationships could also be viewed as a
collected set in an Orthogonal or Lateral
style. All connectors of a similar type can
be conveniently changed to the same type
on a diagram. Other line styles, such as
Auto Routing, will themselves change the
bends in a connector as an attached
element is moved in the diagram. The
Custom style is the most flexible,
allowing you to bend the connector at any
point to create any number of way points
and route the connector around the
diagram layout.

Using Color
and Line
Thickness

The color and thickness of lines can be
changed to create meaning and appeal in
diagrams. These changes are local to the
selected connector(s) on any diagram, but
using the style picker and painter of - for
example - the Layout ribbon you can
apply the selected line style to multiple
connectors. While the tool offers great
flexibility to assign styles manually, it is
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worth considering the use of Diagram
Legends, which can automatically change
the style of the connectors (and also
elements) based on connector metadata
such as the connector's stereotype.
Connector labels can also be changed at a
granular level. Each label reflects a
property of the connector, although you
can also edit the text in a label. You can
hide or show the labels, change their text
color and bold them, add direction
arrows, display the text horizontally or
vertically, and return the moved label to
its original position.

Connector
Direction and
Ends

In our natural languages verbs have
direction; for example 'The cat likes
Juliet.' is not the same as 'Juliet likes the
cat.' So too with connectors, direction
often reveals important semantics, and
the ends of the connector can be labeled
with a variety of markers that express the
details of the meaning. It easy to make
mistakes when creating diagrams, and to
draw the connectors in the wrong
direction. Fortunately there are some
useful features for working with
connector direction, including being able
to reverse the direction of a connector
without the need to recreate it. Connector
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ends can also be pinned so that the
connector stays bound to its attachment
point on the connected element.

Showing and
Hiding
Connectors

As mentioned earlier, a diagram is a
narrative and the choice to include, show,
hide or remove connectors is an
important decision in telling the right
story. When elements are placed on a
diagram Enterprise Architect will, by
default, add the existing connectors
(remembering that elements can have
reflexive connectors). A modeler can
choose a variety of options to either
completely hide specific connectors in
this diagram and/or other diagrams, hide
all the labels, or selectively hide parts of
the labels such as role names and
multiplicities. Hiding parts of the labels
can be a useful option when presenting to
non-technical audiences, who tend to be
distracted by all the detail. Connectors
that have been hidden can easily be made
visible again from the 'Diagram' panel of
the 'Layout' ribbon. You can also 'freeze'
a diagram so that it shows all the
connectors you require at that point, but
will not update with any other connectors
subsequently created between the
elements.
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Types and
Markers

Enterprise Architect is a standards-based
tool, and many of the diagrams and their
constituent elements and connectors are
intentionally defined as part of a
standard. Thus a Business Process
diagram will contain Activities and Tasks
sequenced with Control Flow connectors,
and a Domain diagram will have
Associations to express structural
relationships such as whole-part. The
modeler is thus aided and at the same
time straight-jacketed by what the chosen
modeling language defines as the
allowable connectors. We of course face
the same thing in our natural languages,
where we must choose the right form of a
verb or the meaning of the sentence will
be lost. So in English  'Jonathon went
fishing with Wendy' is a good sentence,
but 'Jonathon went Wendy with fishing' is
not. So too with the connectors, which
have markers, labels and annotations that
must be used to express meaning in the
models. For example, a Composite
Association in the Unified Modeling
Language has a solid black marker at the
whole end of the relationship with an
important multiplicity label at the other.
If you reverse the direction, the meaning
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of the 'sentence' will be changed.
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Connector Management Options

If you right-click on a connector in a diagram, one of two
connector context menus can display. These provide quick
access to some important functions.

Menus

Menu Description

Context
Menu

The menu is split into up to seven distinct
sections:

Specialize - displays in the first section·

only if you have Add-Ins installed and
registered
Properties, including Advanced·

features
Type Specific·

Style and Appearance·

Position·

Type Information - Displays the·

Enterprise Architect Help topic for this
connector type
Delete - deletes the connector·

Connector For connectors with Roles, right-clicking
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Role Context
Menu

a connector within 60 pixels of an end
point displays a role-specific context
menu that offers three additional menu
options:

'Source/Target Role...' - opens the·

connector 'Properties' dialog with the
respective role page selected
'Multiplicity' - opens a submenu·

through which you can set the
multiplicity for the role
'Link to Element Feature' - displays a·

dialog through which you can attach
the end of the connector to a specific
attribute or operation

Notes

Context menus vary slightly between connector types, and·

not all menu options are present on all connector context
menus; the type-specific menu options are not always
included
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Connector Type-Specific Options

The 'Type-Specific' section of the connector context menu is
specific to the object, and only appears for a few different
connectors. Some examples are described here.

Connector Options

Connector Menu Option

Transition Locate in State Table
Action: Switch a StateMachine diagram
to a State Table, with the selected
Transition cell highlighted on the table.

Transition Message
Action: Set the value of the Message.

Transition Find Triggers Associated
Action: Identify hidden triggers, and
locate a trigger in the Browser window; if
there:

Is one trigger, it is immediately·

highlighted in the Browser window
Are two or more triggers the 'Element·

Usage' dialog displays, listing the
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triggers; double-click on the required
trigger to highlight it in the Browser
window

Transition Queue Triggers in Simulation
Action: (Available when a simulation is
being executed.)
Adds the Trigger to the end of the list in
the 'Simulation Events' tab of the
Breakpoints & Events window, without
signalling it.

Transition Signal Triggers in Simulation
Action: (Available when a simulation is
being executed.)
Adds the Trigger to the 'Simulation
Events' tab of the Breakpoints & Events
window and signals it at the current step
of the simulation, leaving it with the
status signaled.

Association Find Association Class
Action: Locate and highlight the
Association Class element in the Browser
window.

Aggregation Set Aggregation to Composite
Action: Change the Aggregation to
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Composite.

Aggregation Set Aggregation to Shared
Action: Set the Aggregation to shared;
this appears after 'Set Aggregation to
Composite' has been selected.

InformationF
low

Find Items Conveyed
Action: (Listed only if there are
Information Items on the connector.)
Locate the Information Item in the
Browser window; if there:

Is one item, it is immediately·

highlighted in the Browser window
Are two or more items the 'Element·

Usage' dialog displays, listing the
items; double-click on the required
item to highlight it in the Browser
window

Notes

Context menus vary slightly between connector types, and·

not all menu options are present on all connector context
menus; the type-specific menu options are not always
included
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Manage Connector Properties

The 'Properties' section of the connector context menu
provides a small set of options.

Menu options

Option Action

<Connector
type>
Properties

Open the Properties window for the
selected connector.

Advanced Display the Advanced menu.

Attach Note
or Constraint

Attach a note or constraint to the
connector.

Notes

Context menus vary slightly between connector types, and·

not all menu options are present on all connector context
menus; the type-specific menu options are not always
included
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Advanced Connector Management
Options

The 'Advanced' section of the connector context menu
provides a number of options.

Menu Options

Option Action

Change Type Change the connector type.

Change
Direction

Keep the ends of the connector the same
but change the direction setting. There
are four options:

Unspecified·

Source -> Destination·

Destination -> Source·

Bi-Directional·

Reverse
Direction

Reverse the ends of the connector; for
example, if the connector is an arrow, the
arrowhead swaps to the other end.
This command maintains the direction of
the connector (such as Source ->
Destination).
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Set Source
and Target

Change the source and/or target of the
connector.

Specialize
Associations

Specify how the properties of this
Association specialize the properties of
other Associations.

Information
Items
Conveyed

Add information items to an Information
Flow connector.

Information
Flows
Realized

Realize any information items conveyed
on an Information Flow connector
between two elements.

Generalizatio
n Set

Click on the 'New' option to create a
Generalization Set, which enables you to
specify the relationship of a group of
Generalizations. Each Generalization is a
binary relationship that relates a specific
Classifier to a more general Classifier
(for example, from a Class to its
Superclasses). Each Generalization Set
defines a particular set of Generalization
relationships that describe the way in
which a general Classifier (or superclass)
can be divided using specific subtypes.
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Dependency
Stereotypes

Select a stereotype for the Dependency
(or Trace, Role Binding, Occurrence or
Represents connector).

Extension
Points

On an Extend connector between two Use
Cases, provides options to:

Specify which Extension Point (if any)·

in the target Use Case the connector
and its source Use Case relate to
Show or hide the Note element that·

identifies the defined Extension Point

Notes

Context menus vary slightly between connector types, and·

not all menu options are present on all connector context
menus; the type-specific menu options are not always
included
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Connector Style Options

The 'Style' section of the connector context menu provides a
number of options.

Style Options

Option Action

Line Style Set the connector line style; the options
are:

Direct·

Auto Routing·

Custom Line·

Bezier (not on all diagram types)·

Tree Style Horizontal or Tree Style·

Vertical
Lateral Horizontal or Lateral Vertical·

Orthogonal (with Square or Rounded·

corners)

Apply Line
Style on
Diagram

Apply the line style of the selected
connector to all other connectors on the
diagram of the same:

Type·

Subtype (including Type) or·
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Stereotype (including Type and·

Subtype)
This helps you apply a style change to
one connector to many other connectors
on the diagram, in one go.
On this section of a diagram there are six
connectors.

Class1

Class2

Class3

Class4

Class5

Class6

f

«qualify»

a

c

d

«qualify»

e

b

«qualify»

All connectors except a are·

Aggregation connectors (a is an
Association)
Connectors b and c are the subtype·

'weak' Aggregations; connectors d, e
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and f are 'strong' Aggregations
All connectors are Direct line style·

Connectors b, d and f have the·

stereotype <<qualify>>
Suppose you change connector d to the
line style Orthogonal Rounded.
If you right-click on connector d and
select the 'Apply Line Style on Diagram |
Connectors of the same Type' option, you
should see these changes to the
connectors (all connectors, being
Aggregations, are now Orthogonal
Rounded style except for a, which is not
the same type as the others):

Class1

Class2

Class3

Class4

Class5

Class6

f

«qualify»

a

e

b

«qualify»

d

«qualify»

c
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OR, if you right-click on connector d and
select the 'Apply Line Style on Diagram |
Connectors of the same SubType' option,
you should see these changes to the
connectors (only connectors e and f
change because only those two are the
same type and subtype as d, being strong
Aggregations):

Class1

Class2

Class3

Class4

Class5

Class6

f

«qualify»

a

d
«qualify»

b

«qualify»

c

e

OR, if you right-click on Connector d and
select the 'Apply Line Style on Diagram |
Connectors of the same Stereotype'
option, you should see these changes to
the connectors (connector f changes
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because it has the same type, subtype and
stereotype as d; connector b is unaffected
because it is not the same subtype, and e
is unaffected because it is not the same
stereotype):

Class1

Class2

Class3

Class4

Class5

Class6

f

«qualify»

a

e

b

«qualify»

d

«qualify»

c

Note that the 'Connectors of the same
Subtype' option is of value for the small
group of connector types that support
subtypes, such as Aggregations (Shared
or 'weak' and Composite or 'strong') and
Dependencies (Trace, Abstraction).
The option only applies if the subtype is
set from the context menu as part of the
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process of creating the connector. If the
subtype was derived from the nature of
the source element, target element and/or
base connector, the option does not
function.

Pin End(s) Pin the connector start and/or end to the
current position on the target element; a
sub-menu displays to offer the options of
pinning the start point only, the end point
only, or both.
Once one or both ends are pinned, a
fourth option is available to UNPIN both
ends.
Some connector line styles (such as the
Tree styles) are not compatible with
pinning the connector ends; if a pinned
connector is changed to one of these
styles, the connector ends will be
unpinned.

Bend Line at
Cursor

Insert an anchor point on the line at the
point of the cursor so you can change the
shape of the line.
Shortcut: Ctrl+Q

Suppress
Line
Segment

Hide a segment of a connector so that you
can view a part of the diagram that it
crosses.
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To reverse the change, right-click on the
connector and select the 'Show All Line
Segments' option.

Straighten
Line at
Cursor

Remove an anchor point on the line at the
point of the cursor.
(This is the exact opposite of 'Bend Line
at Cursor', and Ctrl+Q toggles the
connector point between the options).
Shortcut: Ctrl+Q

Notes

Context menus vary slightly between connector types, and·

not all menu options are present on all connector context
menus; the type-specific menu options are not always
included

If two connectors cross, the later connector has a 'hoop' at·

the intersection, indicating that the connectors are
crossing
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Connector Appearance Options

The 'Appearance' section of the connector context menu
provides a number of options.

Appearance Options

Option Action

Appearance Set the line color and line thickness of the
connector.
Select one or more relationships, then
right-click and select 'Appearance'.
On the 'Connector Appearance' dialog,
click on the drop-down arrow in the:

'Line Color' field, and select the color·

to apply to the connector lines
'Line Thickness' field, and select the·

line thickness of the connector lines
Click on the OK button to apply the
settings to all the selected connectors on
the element.
For the selected connectors, you can also
right-click and select 'Line Style', and one
of the listed styles. The style is
immediately applied to the connectors on
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the diagram.

Visibility Set connector visibility; see the Visibility
Sub-Menu table for sub-menu options.

Tidy Line
Angles

Tidy the line angles of a custom
connector.

Visibility Sub-Menu

Option Action

Hide
Connector

Hide the connector.
To show the connector again, see the
Hide/Show Connectors Help topic.

Hide
Connector in
Other
Diagrams

Hide or show the connector in other
diagrams.

Hide All
Labels

Hide or show all labels attached to the
connector.

Set Label Hide or show labels attached to the
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Visibility connector, individually.

Notes

Context menus vary slightly between connector types, and·

not all menu options are present on all connector context
menus; the type-specific menu options are not always
included

(c) Sparx Systems 2022 Page  433 of 1974



Modeling Fundamentals 3 October, 2022

Connector Tasks

This topic identifies the commoner tasks associated with
managing model connectors, including:

Connect Elements·

Connect to Element Feature·

Connect to a Connector·

Connector Styles·

Arrange Connectors·

Change Connector Type·

Create Connector in Browser Window·

Reverse Connector·

Delete Connectors·

Freeze Visible Connectors·

Hide/Show Connectors·

Creating Generalization Sets·

Change the Source or Target Element·

Relationship Visibility·

Add a Note to a Connector·

Tree Style Hierarchy·

Show Uses Arrow Head·

Set Association Specializations·

Change Sequence Message Scope·
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Notes

In the Corporate, Unified and Ultimate Editions, if·

security is enabled, you must have 'Update Element'
permission to update or delete a connector
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Connect Elements

This topic explains how to connect elements using the
appropriate connector types on a diagram.

Actions

Action Detail

Connect
Elements on
a Diagram

The fastest and simplest ways to create
connectors are using the Quick Linker
and using the Toolbox.
To create another connector of the same
type as the last connector you used, click
on the appropriate source element and
press F3.

Selecting
Connectors

To select a connector, simply click on it;
drag handles display, indicating that the
connector is selected.
This gives the connector focus for
keyboard commands such as 'Delete', and
displays connector properties in docked
windows such as the Properties window.
If there is more than one connector on a
diagram, you can cycle through them
using the arrow keys.
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Drag
Connectors

You can drag a connector to position it;
click on the connector and drag it to
where it is to appear - note that there are
some limitations on how far or to where
you can drag a connector.
You can also reattach the end of a
connector to a different source or target
element.

Connector
Properties
and
Commands

You can double-click on a connector to
change properties in the 'Properties'
dialog, or press Ctrl+2 and click on the
connector to access the properties in the
Properties window.
You can also right-click on a connector to
display the context menu containing
commands to change connector type and
direction.

Highlighting
Connectors

You can highlight the connectors on a
specific element by selecting the element
and then pressing and holding the L key -
all the connectors issuing from or
terminating at that element are
highlighted in separate colors. This is a
useful feature to apply in conjunction
with the context filtering facility on an
element on a diagram.
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Create
Connectors
Without a
Diagram

Sometimes it is useful to create
relationships between elements without a
diagrammatic representation; you can do
this using the Browser window and the
Relationship Matrix.

Notes

You can reposition a connector by selecting and dragging·

the connectors as required

If a connector has source and target roles, you can attach·

either end of the connector to a specific attribute or
operation in the source or target element

If required, you can also create a connector between·

another connector and an element, or between two
connectors
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Connect to Element Feature

If a connector has source and target roles, you can connect
either end of the connector to a specific operation or
attribute in the source or target element. This is entirely a
visual aid, to indicate which features are significant in the
relationship. In code generation or transformation, the link is
interpreted as a normal source-element to target-element
relationship.

Enterprise Architect provides an alternative method of
connecting element features, similar to the Quick Linker
facility. See the Feature Quick Linker Help topic. In that
facility, the connector does not have to exist first - you can
create the connector as part of the process.

Connect the end of the connector to a
specific operation or attribute

Ste
p

Action

1 Right-click on the end of the connector joined to the
element containing the required feature.

2 Select the 'Link to Element Feature' context menu
option.
The 'Link to Element Feature' dialog displays.
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3 In the 'Feature Type' field, click on the drop-down
arrow and select the required feature type -
'Attribute' or 'Operation'.
The attributes or operations from the element are
listed in the 'Feature' field.

4 Click on the required attribute, operation or
maintenance item, and click on the OK button.
The end of the connector changes to a bracket next
to the selected feature.

You might create a number of feature-to-feature
relationships between two elements (such as a Class
and a Table that represents the Class data) to
produce a diagram similar to this:

You can change the feature to which the connector is
attached by following the procedure and selecting
the new feature.
You can break the link to the selected feature in any
of these ways:

Work through the procedure, setting the 'Feature·
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Type' to 'None'
Delete the attribute or operation from the element·

Change the connector type to a type that does not·

have source and target roles
Change the connector to a different source or·

target element that does not contain the feature
Note that reversing the direction of the connector
does not break the connector's attachment to the
feature.

Notes

The 'Link to Element Feature' option is not supported for·

reflexive/self connectors

If you have created, or intend to create, multiple·

relationships between the features of two elements, you
can manage those relationships using the Feature Matrix
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Feature Quick Linker

When developing a model structure on a diagram, you can
either create connectors by clicking on a Toolbox icon and
dragging the cursor between two elements, or by using the
Quick Linker arrow to generate both a connector of an
appropriate type and a target element.

If a connector is to have source and target roles, you can
connect one or both of the ends of the connector to an
operation, attribute or Reception in the source or target
element to indicate which specific features are significant in
the relationship. You can create the connector first and then
configure it (as described in the Connect to Element Feature
Help topic) or you can use a facility similar to the Quick
Linker to generate an appropriate connector between the
source element or feature and the target element or feature.

Prerequisites

In order to display and use the Feature Quick Linker, you
must first:

Create or open the diagram in which to generate the·

feature connectors

Create the appropriate elements and features·

Display the Properties window for the diagram, expand·

the 'Connectors' segment and select the 'Show Feature
Linker' checkbox
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Connect Features

In the appropriate element on the diagram, click on and
highlight the required source feature. The Feature Quick
Linker icon displays against that feature.

Click on the icon and drag the cursor across to either the
element to link the feature to, or the feature within the
element for a feature-to-feature link. When you release the
left mouse button, a short menu displays listing the types of
relationship that are appropriate for the link. Click on the
required relationship type.

The diagram now shows the connector between the two
elements, with the end or ends that specify a feature having
a square bracket and anchor point, as illustrated here:

If appropriate, you can continue to create relationships
between features of the same pair of elements or those
elements and other elements.
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The Feature Matrix

If you have created - or if you intend to create - a number of
relationships between a pair of elements and their features,
you can create and/or manage those relationships using the
Feature Matrix. This is very similar to the main Relationship
Matrix in Enterprise Architect, except that it is focused on
two selected elements and shows the relationships for which
the source and/or target  is an element attribute, operation or
reception.

Prerequisites

In order to use this facility, you select two elements on an
open diagram in Graphical view

At least one of the elements in the pair that you select must
have attributes, operations and/or Receptions (for
relationships between an element and another element's
features).

You cannot use this facility for more than two elements at a
time; if you select more elements, only the first two selected
are shown in the Matrix

Access

On the diagram, select (for example, Ctrl+click) the two
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elements and select the Feature Matrix using one of the
methods in this table.

Ribbon Design > Element > Feature/Matrix

Context
menu

Right-click on one of the selected
elements and select the 'Show Elements
Matrix' context menu option

Adjust Display

On the Feature Matrix, the 'Source' and 'Target' fields
default to the names of the selected elements. You cannot
change these two fields. However, you can modify which
aspects of the relationship information are shown in the
Matrix, by changing the settings on other fields.

Field/Option Description
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Type These two fields identify the type of
feature to display relationships for, in the
Source and Target elements. In the
illustration both fields are set to
'Attribute', so the matrix shows
relationships between the attributes of the
two elements.
To include or switch to the required type
of feature, click on the drop-down arrow
and click on '<All>', 'Attributes',
'Operations' or 'Receptions'.

Link Type The 'Link Type' field indicates what kind
of relationship is shown in the Matrix. To
select the type of relationship to show,
click on the drop-down arrow and click
on the type. You can display relationships
of all types (with the default <All>
option) or a specific type - in the
illustration, this is 'Abstraction'.

Direction This field indicates the direction of the
relationships shown on the Matrix. In the
illustration, the field is set to 'Source ->
Target and the matrix cells indicating a
relationship show arrows pointing to the
target feature. If you want to change the
setting to show relationships created from
the target to the source, or relationships
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that are in any direction, click on the
drop-down arrow and select the 'Target ->
Source' or 'Both' value. The relationship
indicator arrows pointed towards the
source and in both directions,
respectively.

Refresh If you have changed the diagram whilst
displaying the matrix, click on this button
to ensure that the changes are reflected in
the matrix, where appropriate.

Options Click on this button to display a short
menu of options to capture the matrix
settings as a profile, capture the matrix
data as a file to export, or refine the
information displayed in the matrix. See
the Matrix Options table.

Create a New Relationship

Ste
p

Action

1 In the 'Link Type' field, select the type of
relationship you want to create, and in the 'Direction'
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field select the direction of the relationship(s) to
create.
You can also refine the display to show only features
of a specific type between which to create
relationships, by setting the source and target types
in the 'Types' fields.

2 Right-click on the empty square at the intersection of
the appropriate source row and target column.
You can select and operate on several squares
(creating several relationships) at once. Either:

Press Ctrl as you click on each intersecting square,·

then right-click on one of the selected squares, or
Click on the first square in the required row,·

column or block, then press Shift as you click on
the final square in the required row, column or
block; right-click on one of the selected squares

Note that if you click on a cell representing an
existing connector, you can go through these steps to
replace that connector with a different connector.

3 Select the 'Create new relationship' option.
If the 'Link Type' field is set to '<All>', the option is
'Create <direction>' and a further submenu displays
listing the type of relationship you can create; in this
case, click on the required type of relationship.
If, in addition, the 'Direction' field is set to 'Both',
you have two options:
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'Create Source To Target' and·

'Create Target to Source'·

Each option again displays a submenu of connector
types.

4 A connector of the selected type is created between
the two elements, and the appropriate indicator
displays in the matrix cell.

Manage Relationships

If you right-click on a cell representing an existing
connector, two additional options display:

'View Relationship' - which displays the 'Properties'·

dialog for the connector, and

'Delete Relationship', which prompts you to confirm the·

deletion; if you click on the Yes button the relationship is
immediately removed from the model (not available if the
'Direction' field is set to 'Both')

Matrix Options

Click on the Options button to display the menu providing
the options in this table.
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Option Description

Matrix |
Scale Setting

When you print the Feature Matrix, by
default it prints on as many pages wide
and long as the Matrix requires.
You can scale the printout into a fixed
number of pages wide; the row height is
automatically adjusted to maintain the
proportions of the Matrix. This reduces
the overall size of the printout and
improves appearance, especially when
used in conjunction with the 'Landscape'
option in the printer properties. For
example, a 16-page printout without
scaling can, with a scaling of 2 pages
wide, be reduced to 6 pages.
To set the page scaling:

Click on the 'Matrix | Scale Setting'1.
option. The 'Scale Matrix' dialog
displays.
Select the 'Scale Matrix Width into2.
Pages' checkbox, and type or select the
number of pages in width to scale to.
Click on the OK button to apply the3.
setting.

Matrix | Print Select this option to display the 'Print'
dialog, on which you select the output
printer and specify the printer properties,
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the range of pages to print, and the
number of copies.
The output is a WYSIWYG
representation of the Feature Matrix
contents.

Matrix |
Save as
Metafile

Select this option to save the matrix
contents as a .emf  graphics file. A
browser dialog displays on which you
select the target file location and specify
the filename in which to save the output.
You can incorporate this file in a
document or web report, as either a
hyperlinked file or an included file.

Matrix | Save
as PNG

Select this option to save the matrix
contents as a .png graphics file. A
browser dialog displays on which you
select the target file location and specify
the filename in which to save the output.
You can incorporate this file in a
document or web report, as either a
hyperlinked file or an included file.

Matrix |
Export to
CSV

Select this option to export the contents
of the Feature Matrix to a CSV file,
which is a convenient mechanism for
moving the matrix data to a spreadsheet
environment such as Microsoft Excel.
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The Windows 'Browser' dialog displays;
browse to the required file location and
type in a .csv filename to export to, then
click on the Save button to export the
data.

Profiles |
Save as New
Profile

If you use a particular combination of
field values often, you can save that
combination as a profile to make it easier
to recall it for use.
Select this option to save the current field
settings as a new profile in a Feature
Mapping Artifact. A dialog displays to
prompt you for the Artifact element
name; enter the name and click on the
OK button.
The profile is added to the diagram's
parent Package as an
<<EAFeatureMapping>> Artifact, and
the profile name displays at the end of the
'Profiles' sub-menu.

Profiles |
Update
Current
Profile

If you are using a profile and need to
change one or more fields to a value you
will continue to apply, you can update the
profile with the change(s). When you
select the option, the system displays a
prompt to confirm that the profile has
been changed.
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Profiles |
Delete
Current

If you no longer want to keep a profile,
select it and then select this option.
Alternatively, right-click on the
<<EAFeatureMapping>> Artifact in the
Browser window and select the 'Delete
<element name>' option.

Options Click on this option to display the
'Feature Matrix Options' dialog, and
select from these options:

Sort Axes - select the checkbox to·

display the feature names in each axis
in alphabetical order
Highlight source features without·

relationships - select this checkbox to
display, in pale blue, all cells in each
row belonging to a source feature that
has no relationships
Highlight target features without·

relationships - select this checkbox to
display, in pale pink, all cells in each
column belonging to a target feature
that has no relationships

Click on the OK button to action the
selected options.
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Connect to a Connector

Under certain circumstances, it can be useful to create a
connector that issues or terminates (or both) on another
connector. For example, you might create a connector
between two elements, and then create a link between that
connector and a Requirement element to show that the
relationship between the two elements was a predefined
specification of the design.

In releases of Enterprise Architect from 13.0 onwards, you
can add connectors to other connectors. The linking
connector can connect as source and target:

Two other connectors·

An element and a connector·

A connector and an element·

The appearance of each configuration of a
connector/connector link is illustrated here:

ClassA ClassB

ClassC ClassD

ClassE ClassF

«trace»«trace»
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As you create the connector on another connector, the
connector end displays with this circle symbol to indicate
that it is on another connector, and to help you position the
end accurately.

(Select connector) 

(Move connector end) 

There is effectively no limit to the number of connectors
that can issue from or terminate on another connector.

Once you have anchored one connector on another, if you
move either end or the whole connector and you have
selected the 'Layout > Align >  > Smart Placement' and
'Show smart placement guidelines' options, colored
guidelines appear on the diagram. These indicate where the
selected end of the connector is relative to potential anchor
points on the currently-anchored connector and others that
you might drag past. Note that the objects must be
contemporary - not at different hierarchical levels or in
different partitions of the diagram.

Create a connector on another connector

You can create a connector that issues from or terminates on
another connector in the same two ways as you create one
on an element; that is:

Using the Quick Linker arrow or·

Using a connector icon from the Toolbox·
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Method Action

Quick Linker Click on the source connector (or4.
element). A Quick Linker arrow
displays at the center point of the line.
Drag the arrow onto another connector5.
or onto an element, to display a short
menu of possible connector types;
select the appropriate type.

You can also drag the Quick Linker
arrow into empty space; a short menu of
element types displays and you can select
to generate an element of one of those
types whilst the system automatically
creates an appropriate type of connector
to it.

Toolbox Click on the icon for the required6.
connector type.
Click-and-drag from the source7.
connector or element to the target
connector or element.

Certain connector types are not
UML-compliant for linking to another
connector, and if you select such types
you might get an error message. You can
continue to create this type of connector
by de-selecting the 'Strict Connector
Syntax' option on the 'Links' page of the
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'Preferences' dialog (the 'Start >
Application > Preferences > Preferences'
ribbon option).
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Add a Note to a Connector

This topic describes how you can connect notes and
constraints to graphical relationships.

Notes enable you to provide explanations and further detail
for one or more connectors on a diagram, with a visible
Note element.

Add a note or constraint to a connector

Ste
p

Action

1 Right-click on one of the connectors to attach a note
to.
The context menu displays.

2 Select the 'Attach Note or Constraint' menu option.
The 'Link Relations' dialog displays.

3 Select the appropriate radio button in the Link Type
panel.

4 Check all the connectors that participate in the set.

5 Click on the OK button to complete the note or
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constraint creation.

6 Use the normal 'Note' dialog to enter the appropriate
text for the note or constraint.

Notes

The constraint note is drawn slightly differently to a·

regular note, and has { and } automatically added to
visually indicate the constraint form

As an alternative to the procedure, you can drag the Quick·

Linker arrow on an existing Note or Constraint, and drag
it to the required connector; a Notelink is automatically
created to attach the Note or Constraint to the connector
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Arrange Connectors

Connectors between two elements can be moved around the
element borders to create a good layout. There is a limit to
how much a connector can be moved around, but generally
it is very easy to find an acceptable layout. For the best
layouts, use the custom line style; this enables you to add as
many line points and bends as you require to create a clean
and readable diagram.

Move and arrange connectors on a diagram

Ste
p

Action

1 Click once on the connector to select it.

2 Holding the mouse button down, move the connector
in the required direction.

3 To refine the movement, click and hold very near to
one end of the connector; this enables a slightly
different movement range.

4 To further refine the movement and range, select
either a routed, direct or custom line style; each
behaves slightly differently.
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Change Connector Type

This topic explains how to change the type of a connector.
Note that not all connector types are available, depending on
the types of the source and target elements.

Access

Context
Menu

Diagram | Right-click on Connector |
Advanced | Change Type

Change a connector type

Ste
p

Action

1 In the 'Connector Type' field, click on the drop-down
arrow and select the required connector type.

2 Click on the OK button to apply changes.
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Change the Source or Target Element

After you have created a connector between two elements,
you might later want to change either the source or target.
Instead of deleting and re-creating the connector, Enterprise
Architect enables you to change the source or target. There
are two ways of doing this: using the 'Set Source and Target'
dialog or using the mouse.

Using the 'Set Source and Target' dialog

Ste
p

Action

1 Right-click on the connector to open the context
menu.

2 Select the 'Advanced | Set Source and Target' menu
option.
The 'Set Source and Target' dialog displays.

3 Click on the drop-down arrows on the 'From
Element' and 'To Element' fields, and select the
source and target elements.

4 Click on the OK button to apply changes.
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Using the mouse

Ste
p

Action

1 Click on the connector and position the cursor over
the 'handle' at one end.

2 When the cursor changes, click the right mouse
button and drag the handle to the new element.

Notes

The connector does not actually move until you release·

the mouse button over the new source or target element;
however:

A dotted line shows where the connector would be during·

the move

The solid outline of the nearest element or extension·

changes to a hatched outline as you move the cursor onto
it; this helps you identify where the connector should
connect to, if there are many closely-arranged elements,
Parts, Ports and other extensions
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Connector Styles

Connectors come in a number of different routing styles.
Additionally, if one solid-line connector crosses another, the
second one 'jumps' over the first (unless the 'Enable
Connector line jumps' option is deselected on the 'Diagram'
page of the 'Preferences' dialog). You can also bend a
connector to quickly and easily route connectors in the
required layout.

Styles

Style Description

Direct A straight line from element A to element
B.
You can move the line (back and
forward, up and down) to a limited
degree.

Auto Routing A vertical and horizontal route from A to
B with 90-degree bends.
You can move the line to improve the
route, but the location and number of
bends are not configurable.

Bezier A smooth curved line from A to B.
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Bezier style is directly available for Data
Flow diagram connectors, Mind Mapping
connectors, State Flows, State
Transitions, Object Flows, and Control
Flows.

Custom Line The most flexible option; you can add
one or more line points and bend and
push the line into virtually any shape,
using the 'Toggle Line Point at Cursor'
option.

Tree Style -
Vertical
Tree Style -
Horizontal

A line from element A to B with two
right-angle bends, and the end points
fixed to selected locations on the
elements (Vertical or Horizontal).

Lateral -
Vertical
Lateral -
Horizontal

A line from element A to B with a single
right-angle bend, and the end points fixed
to selected locations on the elements
(Vertical or Horizontal).

Orthogonal -
Square
Orthogonal -
Rounded

You can add one or more line points and
bend and push the line into a variety of
shapes, using the 'Toggle Line Point at
Cursor' option.
All line segments thus created are either
vertical or horizontal.
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Set the Connector Style

Ste
p

Action

1 Right-click on the connector to change.
The context menu displays.

2 Select the 'Line Style' option.

3 From the submenu, select the required style:
Direct·

Auto Routing·

Custom·

Tree·

Lateral, or·

Orthogonal·

(or Bezier, where appropriate)·

Set the Connector Style (alternative method)

Ste Action

(c) Sparx Systems 2022 Page  468 of 1974



Modeling Fundamentals 3 October, 2022

p

1 Select the connector to change.

2 Press these keys to change the style:
Ctrl+Shift+D for Direct·

Ctrl+Shift+A for Auto Routing·

Ctrl+Shift+C for Custom·

Ctrl+Shift+Z for Bezier (where appropriate)·

Bend a connector

Ste
p

Action

1 Right-click on the connector.
The context menu displays.

2 Set the line style to 'Custom Line' (Ctrl+Shift+C);
this enables the 'Bend Line at Cursor' option in the
context menu.

3 Click on the 'Bend Line at Cursor' option to add a
line point.
Right-clicking a line point displays the 'Straighten
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Line at Cursor' option, which you can use to remove
the line point.

4 Using the mouse, drag the line point to the required
position.

Bend a connector (alternative method)

Ste
p

Action

1 Hold down Ctrl or Shift and click on a point on the
connector to create a line point.
Ctrl+click also removes a line point.

2 Using the mouse, drag the line point to the required
position.

Tidy line angles (custom connector)

Ste
p

Action
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1 Right-click on the connector.
The context menu displays.

2 Click on the 'Tidy Line Angles' menu option; this
nudges the custom line in horizontal and vertical
increments, saving you the time of trying to get a
good layout manually.
You can set the 'Tidy Line Angles' option to operate
by default; click on the 'Start > Appearance >
Preferences > Preferences' ribbon option to display
the 'Preferences' dialog, and select the 'Diagram
Behavior' page.

Suppress individual line segments

Ste
p

Action

1 Right-click on the connector.
The context menu displays.

2 Set the line style to 'Custom Line' - press
Ctrl+Shift+C.
This enables the 'Suppress Line Segment' option in
the context menu.
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3 Click on the 'Suppress Line Segment' option to
suppress a line between two bend points.
The segment you right-clicked on is suppressed.

4 To show the segment again, right-click on the line
and click on the 'Show All Line Segments' option.
One application for this is to represent the
continuation of flow when your diagram crosses the
page boundary marker in the Diagram View.
When you suppress the line segment that crosses the
boundary, the link name (connector properties)
displays at both ends of the hidden segment; when
you print the diagram on multiple pages, the link
name identifies the connection apparently broken by
the page boundary.
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Create Connector in Browser Window

You can create a connector from one element to another
directly in the Browser window.

Connect elements from the Browser
Window

Ste
p

Action

1 In the Browser window, either:
Right-click on the element to create a connector·

for, and select the 'Add | Create Link' option, or
Select the element, press the Insert key and select·

the 'Create Link' option
The 'Create Link' dialog displays.

2 In the 'Direction' field, click on the drop-down arrow
and select the direction of the new connector
('Outgoing' means the selected element is the
source).

3 In the 'Link Type' field, click on the drop-down
arrow and select the type of connector.
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4 In the 'Choose target(s)' list, click on the name of the
target.
(If necessary, in the 'Select Target Type' field click
on the drop-down arrow and select a feature to list
only elements having that feature).

5 Click on the OK button to create the connector.

Notes

You can also reproduce an existing connector between·

two elements when you paste those elements from the
Browser window into a diagram as instances; an option
enables you to copy just the elements, or the relationship
as well
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Relationship Visibility

You can change the visibility of individual connectors or
relationships on an open diagram.

Access

Display the 'Set Visible Relations' dialog, using one of the
methods outlined here.

Ribbon Layout > Diagram > Appearance > Set
Visible Relationships

Keyboard
Shortcuts

Ctrl+Shift+I

Set relationship visibility

Ste
p

Action

1 On the 'Set Visible Relations' dialog, select the
checkbox against each list item to show, and clear
the checkbox against each item to hide.
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If you want to display the information in a more
readable layout, you can resize the dialog.

2 Click on the OK button to apply the changes.
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Freeze Visible Connectors

Working in a collaborative platform brings with it
challenges of working with models and diagrams that are
often in flux, and where a number of modelers contribute to
related diagrams and models. For example a diagram could
have been defined for a project iteration (sprint) and during
the sprint an architect could be working on the same objects
on another diagram for the next iteration, adding new
relationships. Enterprise Architect's default behavior is to
add these to any existing diagrams that contain the related
objects. This might not be a welcomed outcome for the
owner of the original diagram.

The Freeze Visible connectors feature is a useful way of
ensuring that a diagram set up at a certain point is not
automatically updated when new relationships are added to
the repository that connect two or more objects on the
diagram. By setting the diagram connectors' Freeze Visible
property the diagram owner is telling the tool not to update
this diagram when connectors are added somewhere else in
the model.

A modeler can, of course, continue to add additional
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connectors to the diagram or 'unfreeze' the connectors and
reload the diagram to see the changes. This feature
facilitates collaborative model creation and helps teams
work together without getting in each other's way. If this
situation occurs frequently it might be worth considering
using the Time Aware Modeling feature, which allows new
versions of existing elements to be created to model future
states.

You can hide or show connectors on the current diagram or
on other diagrams using the 'Links' tab of the Properties
dialog; see the Hide/Show Connectors Help topic.

Access

Design your diagram, and ensure that it shows the
relationships that you require. Then fix the diagram as at
this point in time by selecting one of these options:

Ribbon Start > Application > Design > Properties
>  Connectors : Freeze Visible
(Properties window)
Design > Diagram > Manage > Properties
> Connectors : Freeze Visible
(Properties dialog)

Context
Menu options

In Browser window: Right-click on
diagram name > Properties > Connectors
: Freeze Visible  (Properties dialog)
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On diagram: Right-click on background >
Properties > Connectors : Freeze Visible
(Properties dialog)

Keyboard
Shortcuts

Ctrl+2 >  Connectors : Freeze Visible
(Properties window)
Alt+1 > Properties >  Connectors : Freeze
Visible    (Properties window)
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Hide/Show Connectors

Connectors or relationships that appear in multiple diagrams
can be selectively shown or hidden. This makes it easier to
read diagrams where elements might have many connectors,
but not all are relevant in the context of the current diagram.

Hide or show a connector in the current
diagram

Ste
p

Action

1 Double-click on the required diagram element in the
Diagram view.
The element 'Properties' dialog displays.

2 Select the 'Links' tab.
This lists the connectors linked to the element,
whether or not they are hidden on the diagram.

3 Right-click on the connector to hide or show.
The context menu displays.

4 Select the 'Show Relation' option to show the hidden
connector on the diagram, or the 'Hide Relation'
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option to hide the visible connector.
Alternatively, hide a connector by right-clicking on
it on the diagram and selecting the 'Visibility | Hide
Connector' option; however, you must use the 'Links'
tab of the element 'Properties' dialog to show the
relationship again.

Hide or show a connector in other diagrams

Ste
p

Action

1 Right-click on the connector in the diagram.
The context menu displays.

2 Select the 'Visibility | Hide Connector in Other
Diagrams' menu option.
The 'Set Connector Visibility' dialog displays.

3 If the two connected elements have been included in
other diagrams, these diagrams are listed here.
In the list, all diagrams for which the checkbox is
selected show the connector; deselect the checkbox
for any diagrams in which to hide the connector.
If you want to display the information in a more
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readable layout, you can resize the dialog.
To hide the connector in all of the diagrams listed,
click on the Suppress All button.

4 Click on the OK button to save the changes.

Notes

Certain elements, such as Requirements, do not have a·

'Links' tab in the 'Properties' dialog
In these cases, open the Relationships window ('Start >
All Windows > Properties > Responsibilities >
Relationships') for the element, right-click on the
relationship in the list and select the context menu option
to hide or show that relationship in the diagram
Be aware that, in the Corporate, Unified and Ultimate
Editions with security on, locks on the diagram and
elements can make the required option unavailable

It is also possible to select an option that prevents·

relationships created on other diagrams from appearing on
your current diagram - that is, you freeze your current
diagram against that particular change; see the Freeze
Visible Connectors Help topic.
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Delete Connectors

This topic explains how to delete a connector from the
model. Note that is possible to either hide the connector in
one or more diagrams and still retain it in the model, or
remove it completely (deletion).

Delete a Connector

Ste
p

Action

1 Right-click on the connector and select the 'Delete
Connector' option.
The 'Remove Connector' dialog displays; this dialog
provides the options to hide the connector so that it
remains functional, or remove the connector
completely.

2 Click on the appropriate radio button and click on
the OK button.
If you select the 'Hide' option, it has the same effect
as hiding the connector on the 'Links' tab of the
source element 'Properties' dialog, or using the
'Visibility | Hide Connector' context menu option.
It also hides the connector on the Relationships
window.
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Notes

The dialog does not display if:·

     -  You have previously selected the 'Don't ask again'
checkbox or
     -  On the 'Links' page of the 'Preferences' dialog ('Start
> Appearance > Preferences > Preferences > Links')
        the 'Prompt on connector deletes' checkbox is not
selected

Selecting the 'Don't ask again' checkbox also deselects the·

'Prompt on connector deletes' checkbox

Selecting the 'Prompt on connector deletes' checkbox·

restores the dialog if you have used the 'Don't ask again'
checkbox

If you hide the dialog, the 'Delete Connector' context·

menu option defaults to the setting you last used on the
dialog; make sure that you have selected the right option
to default to
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Creating Generalization Sets

A Generalization Set enables you to specify the relationship
of a group of Generalizations. Each Generalization is a
binary relationship that relates a specific Classifier to a more
general Classifier (for example, from a Class to its
Superclasses). Each Generalization Set defines a particular
set of Generalization relationships that describe the way in
which a general Classifier (or superclass) can be divided
using specific subtypes.

Access

Context
Menu

Right-click on connector | Advanced |
Generalization Set | New

Create a Generalization Set

Ste
p

Action

1 Select the 'New' menu option.
The 'Generalization Set' dialog displays.
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2 In the 'Name' field, type the name of the
Generalization set; for example, 'Gender'.

3 In the 'Power Type' field, either:
Type a new power type, or·

Click on the drop-down arrow or  and select an·

existing one from the 'Select <Item>' dialog

4 Consider the 'Is Covering' checkbox. If you select
this, on a diagram the constraint {complete} will be
added to the label of each generalization that is a
member of the set. (If you do not select the
checkbox, the constraint is regarded as {incomplete}
although this is not displayed in the label).

5 Consider the 'Is Disjoint' checkbox. If you select
this, on a diagram the constraint {disjoint} will be
added to the label of each generalization that is a
member of the set. (If you do not select the
checkbox, the constraint is regarded as
{overlapping} although this is not displayed in the
label).

6 In the 'Is Member' column, select the checkbox
against each child subtype that is part of this
Generalization set.

7 Click on the OK button to save and apply the

(c) Sparx Systems 2022 Page  486 of 1974



Modeling Fundamentals 3 October, 2022

Generalization Set, and to close the dialog.
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Connector In-place Editing Options

You can edit many of the Enterprise Architect connector
labels directly on the diagram. Each label can be bound to a
single connector field.

Put a label in Edit mode

To put a label into Edit mode, either:

Select the 'Edit Label' option from the context menu, or·

Select a label and press F2·

To save the current text to the field, either press the Enter
key or deactivate the Edit window.

To cancel edit mode without saving any changes, press Esc.
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Reverse Connector

You can reverse the direction of a connector without having
to delete and re-create it. This is helpful if your design
changes or you add the connector wrongly to begin with.

Reverse the direction of a connector

Ste
p

Action

1 Right-click on the incorrect connector.

2 Select the 'Connection Detail | Reverse Direction'
context menu option.
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Set Association Specializations

UML enables specialization of properties defined by
Associations. Enterprise Architect enables this through the
'Specialize Associations' option in the 'Advanced' section of
the context menu for an Association.

A dialog displays, showing all Associations between the two
Classes connected by the current Association and their
parents.

The left two columns define the source role of the current
Association, while the right two define the target role. With
this you are able to select the relationships of each end of
the properties listed. When a relationship is set then this is
drawn at the corresponding end of the connector on any
diagram it appears on.

The dialog displays when you select the 'Advanced |
Specialize Associations' context menu option on the lowest
Association connector in this diagram.

Example
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Change Sequence Message Scope

A message in a Sequence diagram represents a dynamic
interaction from one element to another. Sometimes when
you are designing your model you might have to change
either the start or end point of a message as the
responsibilities of elements change during design. For this
reason, Enterprise Architect enables you to change the
message scope by setting a new start or end element.

Change Message Scope

Ste
p

Action

1 Select the message in the Sequence diagram.

2 Right-click on the message to open the context
menu.

3 Select 'Advanced | Set Source and Target'.

4 In the pop up dialog, in the 'From Element' and 'To
Element' fields, click on the drop-down arrows and
select the required elements.

5 Click on the OK button to save changes.
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The message is re-routed to meet your changed
requirements.
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Show Uses Arrow Head

By default the Use connector in Use Cases has no arrow
head.

Generate arrow heads on Use connectors

Ste
p

Action

1 Select the 'Start > Appearance > Preferences >·

Preferences > Links' option.
The 'Links' page of the Preferences window displays.

2 In the 'General' panel, select the 'Show Uses
arrowheads' checkbox.

3 Click on the Close button.
When you save the Use Case diagram, the Use
connectors change to display arrowheads.
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Tree Style Hierarchy

In Enterprise Architect you can create a tree style
inheritance diagram using a special form of the
Generalization connector, as shown.

Create a tree style connector

Ste
p

Action

1 Create a normal Generalization between two
elements.

2 Right-click on the connector to open the context
menu.
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3 Select the 'Line Style | Tree Style - Vertical' or the
'Line Style | Tree Style - Horizontal' menu option.

4 Enterprise Architect automatically makes the
Generalization layout conform to a specific shape.
By adding more Generalization connectors, and
checking their Tree Style options, you can achieve
the appearance of the example diagram.
You can slide the root and child Classes left and
right to achieve the required result; Enterprise
Architect maintains the conformity of the branch
connectors.

Set this style of connector as default

Notes

In the example diagram, the Son -> Parent connector has·

not yet been put in Tree Style - Vertical style

This style of diagram provides a clearer layout for·

inheritance hierarchies and is easy to work with

Ste
p

Action

1 Select the 'Start  > Appearance > Preferences >
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Preferences > Links' option.
The 'Links' page of the Preferences window displays.

2 Select the 'Generalization link style Default = Tree'
checkbox to make this branching style the default
style for inheritance connectors.
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Linked Documents

When you are developing elements in your model, you
might want to provide extensive documentation on an
element, to provide more structured text than you can create
in the element 'Notes' field. In this case, you can create a
formatted document that is linked to the element. You can
create a Linked Document from scratch, or from one of a
range of Linked Document Templates that you define with
the Linked Document Template Editor. The Linked
Documents are held within the model.

Working with Linked Documents

Task Detail

Create
Linked
Documents

You can create a Linked Document
either:

Within a Document Artifact element·

attached to your model element, or
Directly on the model element·

The advantages of using a Document
Artifact to host the Linked Document
include:

Visibility of the Document Artifact and·

hence Linked Document in the
Browser window
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As you can only have one Linked·

Document in an element, hosting each
of several documents in its own
Document Artifact and connecting the
several Document Artifacts to one
model element means that you have
broader scope for providing
information
Similarly, associating several elements·

with one document by connecting them
to the host Document Artifact element
means that you can share information
rather than duplicating it

The advantages of using a Linked
Document directly on an element include:

More tightly binding the content of the·

document to the element, so there is
less ambiguity in what the information
refers to
More tightly binding the document·

itself to the element, so there is less
risk of the document being changed,
moved or deleted without reference to
the element it belongs to

Create
Linked
Document
templates

You can base your Linked Document on
one of a range of system-provided
templates, each of which represents a
project document type.
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You can also create and use your own
Linked Document templates in the
'Resources' tab of the Browser window,
within the Linked Documents folder.

Edit Linked
Documents

You can define the style, format and
layout of your Linked Document both in
the template from which you create the
document and in the document itself. You
can edit the Linked Document from a
selected element in the Document
Window and in the Linked Document
Editor.

Create
hyperlinks in
Linked
Documents

Linked Documents are intimately
associated with specific elements, but you
can also create hyperlinks in the
document directly to other elements in
the model. Having followed the link, you
can perform any normal operation on that
element.
Similarly, you can create new elements or
diagrams to link to.
You can also create hyperlinks to other
forms of documentation.

Include
Linked
Documents

Linked Documents, however they are
created, are rendered into document
reports when you select the 'Linked
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in RTF
reports

Document' checkbox in the Document
Template Designer.

Locate
Linked
Documents

In diagrams, any element that has a
Linked Document is marked with an 'A'
symbol in the bottom right corner.
You can also use the Model Search
facility to search for elements that have
Linked Documents, by creating a custom
search containing this SQL Query (which
returns all variations of Linked
Document):

SELECT ea_guid AS CLASSGUID,
Object_Type AS CLASSTYPE, Name
AS Object, Object_Type AS [Type],
Stereotype, Author, Scope, Status, Phase,
CreatedDate, ModifiedDate
FROM t_object
WHERE t_object.Style LIKE
'#WC#MDoc=1#WC#'

Delete
Linked
Documents

You can completely remove a Linked
Document from an element, or you can
remove the contents of the document and
replace them with the contents of an
external file.
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Notes

You can create a Document Artifact element to contain a·

Linked Document in all editions of Enterprise Architect

You can create and link a document to any UML element·

in the model, in all editions of Enterprise Architect

You can work on Linked Documents through the·

Automation Interface, using the methods
GetLinkedDocument(), DeleteLinkedDocument(),
SaveLinkedDocument(string Filename) and
LoadLinkedDocument(string Filename)
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Create Document Artifact

You can create a Document Artifact element to host a
Linked Document for another model element. You can
either create an appropriate connector between the
Document Artifact and the documented element (to indicate
how the document impacts the element), or drag the
Document Artifact over the model element on the diagram
or in the Browser window so that it becomes a child of the
model element. Alternatively, if the document is not specific
to a model element, you can leave the Document Artifact as
an independent element in an appropriate location.

Create a Linked Document in a Document
Artifact

Ste
p

Action

1 Open the diagram containing the element for which
to create the Linked Document.

2 Open the 'Documents' page of the Diagram Toolbox.
Drag and drop the Document Artifact element icon
from the Toolbox into your diagram.

3 Double-click on the Document Artifact element. A

(c) Sparx Systems 2022 Page  503 of 1974



Modeling Fundamentals 3 October, 2022

default blank-page document opens in the Linked
Document Editor, based on the Normal.rtf style
template.
Alternatively, click on the Artifact and select the
'Start > Application > Design > Document' ribbon
option. A default blank-page document opens in the
Document Window, based on the Normal.rtf style
template.

4 Apply a template and/or continue to develop the
Linked Document as described in the Create Linked
Document on an Element topic, from step 2 onwards.

Notes

As another alternative, you can create a File Artifact·

element containing a document file that you have dragged
from a file browser onto an Enterprise Architect diagram;
see the Create File Artifacts Help topic

There is a limit of one Linked Document per Document·

Artifact element, but you can provide more than one
Linked Document for a model element by linking it to
more than one Document Artifact

This operation is available in all editions of Enterprise·

Architect

When you have saved the document, an A symbol·
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displays in the bottom right corner of the element
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Create Linked Document on an
Element

If you need to provide more extensive and structured
documentation on an element, you can develop this as a
formatted document directly linked to the element. You can
develop the document from a blank page or using a system
template or user-defined template, at several different points
in the work area.

Access

Select an element in the Browser window, Diagram List,
Package Browser, Specification Manager, Model Search or
diagram, then use any of the methods outlined here to open
the Document window or Linked Document Editor. Both
features activate the 'Document - Edit' ribbon, which you
use to enter and edit the text of the Linked Document.

Ribbon Start > All Windows > Design > Create >
Document (Document window)
Design > Element > Properties > General
> Document (Document window)
Design > Element > Manage > Edit
Linked Document (Linked Document
Editor)
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Context
Menu

Right-click on the element name |
Properties | Linked Document
(Document window)

Keyboard
Shortcuts

Ctrl+Alt+D  (Linked Document Editor)
Alt+1 > Document  (Document window)
Alt+5 > Document  (Document window)

Create a Linked Document

Ste
p

Action

1 The Linked Document Editor automatically opens in
edit mode.
The 'Linked Document' tab opens in Read mode;
click on the  icon and select the 'Edit Mode'
option. A default blank-page document opens, based
on the Normal.rtf style template.
The 'Document - Edit' ribbon also displays in the
Ribbon Bar.

2 If you do not want to apply a system template or
user-defined template, go to step 6.
If you do want to base the document on a selected
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template, select the 'Document - Edit > File > File >
New (Clear Document)' ribbon option. A prompt
displays for you to confirm that you are clearing the
current document; click on the OK button.
The 'New Linked Document from Template' dialog
displays.

3 In the 'Template' field, click on the drop-down arrow
and select the template from which to create the
document.
This can be either a system-supplied template or a
template that you have previously created yourself.

4 If you want to display the 'New Linked Document
from Template' dialog by default whenever you start
to create a Linked Document, select the 'Show this
dialog on document creation' checkbox.
If you no longer want to display the dialog by
default, deselect the checkbox.

5 Click on the OK button.
The new Linked Document opens. If you have based
the document on a selected template, the document
shows the content applied by the template.

6 Enter and format the text of the document, using the
facilities of the 'Document - Edit' ribbon.
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Notes

You can create only one Linked Document on an element;·

if you need to create more, develop each document within
its own Document Artifact element and link these to the
model element

This operation is available in all editions of Enterprise·

Architect

When you have saved the document, an  symbol displays·

in the bottom right corner of the element
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Edit Linked Documents

To develop the contents of a Linked Document, you use
either the Document Window or the Linked Document
Editor. These provide a frame for working on the document,
using a wide range of convenient features from the
Document - Edit ribbon. The features help you in formatting
and editing the document, and adding links from and
references to the content of the document.

In the Linked Document Editor some editor features are
duplicated in a right-click context menu for convenience.

The Document Window has additional facilities, as
described in the Linked Documents in the Document
Window Help topic.

Access

Select an element in the Browser window, Diagram List,
Package Browser, Specification Manager, Model Search or
diagram, then use any of the methods outlined here to open
the Linked Document.

Ribbon Explore > Portals > Windows >
Properties > Document
Start > All Windows > Design > Create >
Document
Start > All Windows > Properties >
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General > Document
Design > Element > Properties > General
> Document

Context
Menu

Right-click | Properties | Linked
Document

Keyboard
Shortcuts

Ctrl+Alt+D

Other From the Notes window or from the
'Notes' field of the element 'Properties'
dialog, click on the  icon on the Notes
toolbar.

Option Descriptions

The Linked Document Editor option descriptions are
grouped according to the actions you are performing.

Action

Creating and importing documents

Configuring the editor page display and formatting tools
shown
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Incorporating stylesheets, special texts and Tables of
Contents

Managing the base styles in the Normal.rtf style template
file

Moving through, searching and selecting text

Formatting characters and text strings

Formatting paragraphs and text blocks

Inserting tab points

Inserting sections, columns and page breaks, and
repaginating

Inserting and editing page headers and footers, and
footnotes and endnotes

Inserting tables

Inserting hyperlinks

Inserting images, OLE objects, frames and drawing
objects

Printer set up and printing documents
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Checking spelling and use of words

Tracking, accepting and rejecting changes to text

Protecting document text from accidental change

Create and refer to definitions of Glossary terms in the
Project Glossary (using the 'Create | Glossary Definition'
menu option)

Notes

Throughout your document editing:·

     -  To undo one or more immediately previous edits,
press Ctrl+Z, or select the 'Undo' ribbon or
         context menu option; you can still undo a change
even after you have saved the change
     -  To redo one or more immediately previous undone
edits, press Ctrl+Y, or select the 'Redo'
         ribbon or context menu option
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Linked Documents in the Document
Window

The Document window provides several quick methods of
checking elements for Linked Documents, and for reviewing
the documents that exist. It also provides searches to locate
and list any elements with Linked Documents in the model,
and any elements that have Linked Documents that have
been recently modified.

When you click on an element in the Browser window, a
diagram or an element list - such as the results of a search -
the Document window displays the name of the selected
element and, if it has a Linked Document, the content of that
document. If the element does not have a Linked Document,
the content panel is blank. If you click on another element,
the window updates immediately to show the element name
and Linked Document (if any) of that element. You can
therefore quickly scan a number of elements to check
whether they have Linked Documents, and/or review the
documents you locate. The 'Linked Document' tab provides
options for reviewing the Linked Document, including
switching to an Edit mode so that you can create or update
the document.

Note that there are also options for creating a Linked
Document via the Linked Document Editor, which is an
alternative method. See the Edit Linked Documents Help
topic.
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Access

Ribbon Start > All Windows > Design > Create >
Document
Start > All Windows > Properties >
General > Document
Design > Element > Properties > General
> Document

Context
Menu

Right-click on the element name |
Properties | Linked Document

View Document

When you first open the Document window, it shows the
selected element's Linked Document in Reading (View)
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mode. The element name displays in the menu button at the
top of the window, with the prefix 'Reading'. Click on the
menu button to access these options:

Option Description

Edit Mode Switches the document into 'Edit' mode
and displays the 'Document - Edit' ribbon,
which provides the facilities for updating
the document. If the element does not
currently have a Linked Document, you
can immediately start typing in the
display panel or import a file to create a
Linked Document for the element.
If the selected element is locked, the
menu button displays the text '[Locked] -
<element name>', and you cannot edit the
Linked Document. Similarly, if you have
edited the document but not yet saved the
changes, the menu button displays an
asterisk in front of the element name: for
example, *PersonClass.
While in edit mode, the Document
window becomes locked to the parent
element, and selecting another element or
context will not switch the window to a
different document. This helps you to
move around the model, checking and
gathering information without having to
close and open the document several
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times. Once you quit edit mode, the
window will again immediately refresh to
show the document for whichever
element you select. To switch out of 'Edit'
mode, click on the menu button and
deselect the option.

Lock
Element

Locks the element against changes -
including changes to the Linked
Document. Deselect the option to unlock
the element and allow changes.

Reload Refreshes the content of the displayed
document from the last-saved version.

Find in
Project
Browser

Expands the Browser window and
highlights the Linked Document's parent
element.

Find in
Diagrams

Opens the diagram containing the Linked
Document's parent element, with the
element selected. If the element exists in
more than one diagram, the 'Element
Usage' dialog displays, from which you
can select the diagram to open.

Fixed Zoom Displays a short list of magnifications (as
a percentage of 'normal' size) you can
select to zoom the document display to,
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as well as a 'Custom' option that opens a
dialog on which you can set any
magnification between 10% and 500%.
The zoom factor remains set after you
close the document, and is applied when
you re-open the document until you
specifically change the zoom.

Toggle Page
Border

Switches between full-screen display and
page outline display (the default) where
the information is shown within the
framework of a page border.

Find
Elements
with Linked
Documents

Opens the Find in Project view preloaded
with an executed search for elements that
have Linked Documents; as you click on
an item in the search results, the
Document window shows the
corresponding Linked Document.

Find
Elements
with Linked
Documents
Modified
Recently

Opens the Find in Project view preloaded
with an executed search for elements that
have Linked Documents that have been
updated within the last seven days (you
can re-execute the search with a different
number of days); as you click on an item
in the search results, the Document
window shows the corresponding Linked
Document.
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Delete
Linked
Document

Deletes the Linked Document currently
displayed in the window. A prompt
displays for you to confirm the deletion.

Print Displays the 'Print' dialog, which you use
to configure the print job for printing the
Linked Document.
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Replace or Delete Linked Documents

If a Linked Document is out of date you can edit the text, or
you can:

Delete the content and replace it from another file, or·

Delete the document altogether·

Access

Click on the element that contains the Linked Document.

Ribbon Start > Application > Design > Document
or
Explore > Portals > Windows >
Properties > Document
The Document Window opens, showing
the Linked Document on the element.

Delete the Linked Document

Ste
p

Action

Click on the  icon in the top left of the window,

(c) Sparx Systems 2022 Page  520 of 1974



Modeling Fundamentals 3 October, 2022

1 and select the 'Delete Linked Document' option at
the end of the menu.

2 A prompt displays for you to confirm the deletion;
click on the Yes button.

3 The Document window is cleared, and the  symbol
on the element in any diagram is removed. You can
now import or create content for another Linked
Document on that element, select a different
element, or close the Document window and/or
move on to other work.
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Create Linked Document Templates

To create a Linked Document, you can open an empty file
and add the text and contents as you want. You can also
base your Linked Document on a Linked Document
template that you either:

Select from a drop-down list of (initially)·

system-provided templates in the 'New Linked Document
from Template' dialog or

Create in the 'Linked Documents' folder of the 'Resources'·

tab of the Browser window

Linked Document templates that you create are added to the
drop-down list on the 'New Linked Document from
Template' dialog.

Access

Open the 'New Document Template' dialog using any of the
methods outlined here.

When opened using one of these methods, the 'Template
Type' field is set to 'Linked Document Template'.

Ribbon Start > All Windows > Design > General
> Browse > Resources > Linked
Documents > right-click on a <template
group> folder > Create Template
Explore > Portals > Windows > Explore
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> Resources > Linked Documents >
right-click on a <template group> folder
> Create Template

Create a template

On the 'New Document Template' dialog:

Ste
p

Detail

1 In the 'New template' field, type a name for your
template.

2 In the 'Copy template' field, if you want to base the
new template on an existing template, click on the
drop-down arrow and select the name of the source
template.
Otherwise leave the field set to 'None'.

3 Click on the OK button.
The template opens in the Linked Document
Template Editor in the Diagram View. Create and
edit the template contents as you need.

4 Save the template (File > Save) and close the editor
(  in the top right corner of the editor window). The
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template is immediately available for use.

5 If you want to assign your template to another group,
right-click on the template name in the 'Resources'
tab of the Browser window and select the 'Move'
option.
The 'Enter the Linked Document Template Group
name' dialog displays. In the 'Enter Value' field type
a new or existing category name and click on the OK
button.
The template is immediately transferred to the
named group.

Notes

You can transport customized Linked Document·

templates between models, using the 'Settings > Model >
Transfer > Export Reference Data' and 'Import Reference
Data' ribbon options
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Edit Linked Document Templates

To develop the contents of a Linked Document template,
held in the 'Resources' tab of the Browser window, you use
the Linked Document Template Editor. This opens the
Document - Edit ribbon, which provides access to a wide
range of convenient features for formatting and editing the
template, and for adding links from and references to the
content of the documents generated from the template. An
in-text context menu also provides editing options for the
template.

Access

Within the 'Resources' tab of the Browser window, click on
'Linked Documents > <template group> > Right-click on
template name | Open'

Ribbon Start > Application > Share > Resources
Explore > Portals > Windows > Explore
> Resources

Option Descriptions

The Linked Document Template Editor option descriptions
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are grouped according to the actions you are performing.

Actions

Creating and importing template documents

Configuring the editor display

Incorporating stylesheets, special texts and Tables of
Contents

Managing the base styles in the Normal.rtf style template
file

Moving through, searching and selecting text

Formatting characters and text strings

Formatting paragraphs and text blocks

Inserting tab points

Inserting sections, columns and page breaks, and
repaginating

Inserting and editing page headers and footers, and
footnotes and endnotes

Inserting tables
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Inserting hyperlinks

Checking spelling and use of terms

Tracking, accepting and rejecting changes to text

Protecting template text from accidental change

Inserting images, OLE objects, frames and drawing
objects

Printer set up and printing documents

Notes

Throughout your template editing:·

     -  To undo one or more immediately previous edits,
press Ctrl+Z, or select the 'Undo' context menu
        option; you can still undo a change even after you
have saved the change
     -  To redo one or more immediately previous undone
edits, press Ctrl+Y, or select the 'Redo' menu
        option
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Hyperlink From Linked Document

Within the text of a Linked Document, you have several
options for creating hyperlinks to other objects in the model,
and to web pages, Help files, Model Searches and Model
Library documents. You can also create links that generate
RTF reports or diagram images, so that updates to the linked
material can be quickly merged into the Linked Document
as a Custom Report.

When you have saved the Linked Document, you can click
on the hyperlink to open the linked files or to locate and
highlight the object in the Browser window. You can
perform all normal operations on the object, including
opening any Linked Document that element might have.
You can also, within the Linked Document, select a context
menu option to update any linked-in reports and diagram
images.

Using the Add Content to Document dialog

The 'Add Content to Document' dialog displays when you
drag an object from the Browser window onto the Linked
Document. This versatile dialog helps you add a number of
features to your document, as explained in this table.
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If you are creating a number of links of the same type, after
you create the first link you can simply press the Ctrl key as
you drag the next object onto the document without
displaying the dialog. The system creates further links of the
same type, until you display the dialog again and change the
'Insert as' option.

Task Action

Create
Hyperlinks to
Model
Objects

In the Browser window, click on the
object (of any type, including a diagram
or Package) and drag the object into the
Linked Document to the position at
which to create the hyperlink.
On the 'Add Content to Document' dialog
(if necessary) click on the 'Insert as'
drop-down arrow and select 'Insert as
Hyperlink(s)'.
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Click on the OK button. The system
creates the hyperlink, using the object
name as the hyperlink text. You can edit
this text if you prefer.

Insert an RTF
Report on a
Model Object

In the Browser window, click on the
required element, diagram or Package
and drag the object into the Linked
Document to the position at which to
insert the report text.
On the 'Add Content to Document'
dialog, click on the 'Insert as' drop-down
arrow and select 'Render as RTF'.
Click on the appropriate radio button
('All', 'User', 'System' or 'Technology') to
display the selection of RTF templates
you want to choose from, and click on the
required template.
Click on the OK button. The system
generates the RTF report according to the
template, and inserts it at the cursor
location.
At any later point, you or another user
can refresh the RTF reports in the Linked
Document by right-clicking in the
document and selecting the 'Update
Dynamic Report elements' menu option.
Note that this option will reinstate any
text you might have deleted from the
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inserted reports.

Insert a
Diagram
Image

In the Browser window, click on the
required diagram and drag the diagram
into the Linked Document to the position
at which to insert the diagram image.
On the 'Add Content to Document'
dialog, click on the 'Insert as' drop-down
arrow and select 'Insert as Diagram
Image'.
Click on the OK button. The system
generates the diagram image and inserts it
at the cursor location.
At any later point, you or another user
can refresh the image in the Linked
Document by right-clicking in the
document and selecting the 'Update
Dynamic Report elements' menu option.

Using the Linked Document Context Menu

You can also create hyperlinks to model objects within a
Linked Document using the Linked Document Editor
context menu. You first select a text string in the document
to act as the link text and, in the case of a new object, to act
as the name of the element.
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Option Action

Link to an
Existing
Element

Highlight the link text in the Linked
Document, right-click on it and select the
'Create | Link to Existing Element' option.
The 'Select Element' dialog displays,
through which you browse or search for
and select the element to link to.

Link to a
New Element
or Diagram

Highlight the link text in the Linked
Document, right-click on it and select the
'Create | New' option. A short submenu
displays from which to select a specific
type of element to create, or a diagram.
When you click on an element type, a
new element of that type is created.
If you select the 'Create | New | Diagram'
option, the 'New Diagram' dialog displays
and you can select the type of diagram to
create.
If the element type you require is not
presented in the short list, click on the
'Other' option to display the 'New
Element' dialog, from which you can
select the toolset containing the element
type to create, and the element type itself.
In each case, the new element or diagram
is added to the Package that contains the
parent element of this Linked Document.
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The link text becomes the name of the
new object, and in the Linked Document
is the hyperlink to that new object.

Link to an
Object or
Document in
the Model

Highlight an appropriate text string to act
as the link text, right-click on it and select
the 'Create | Hyperlink' context menu
option.
The 'Hyperlink Details' dialog displays,
through which you specify the type of
document or object to link to. Depending
on what object or document type you
select in the 'Type' field, a small dialog
displays to help you locate and select the
target. For the location, you can use
either full paths or local (path
substitution) paths.
In some cases you might not want to have
normal text as the hyperlink, but the text
of the link itself. In this case, do not
highlight any text or, in the 'Hyperlink
Details' dialog, type any link text in. The
system then inserts the address path or
the provided text as the link text.

Using the Ribbon Option
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You can also insert a Hyperlink in your document to link to
a web page, Help topic or external file.

Click on the point in the document to insert the hyperlink
and select the 'Document-Edit > Edit > Insert Hyperlink'
ribbon option.

The simple 'Insert Hyperlink' dialog displays, in which you
specify the type of document to link to, and the location of
the document file. See the Insert Hyperlinks Help topic.
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Create Element From Document

Whilst you can set up hyperlinks from the Linked Document
to existing elements and diagrams in the Browser window,
you can also create new elements to illustrate and support
information written in the Linked Document. You can create
and link to any type of element or diagram, but the facility
has specific options for these element types:

Class·

Requirement·

Issue·

The element or diagram is created in the same Package as
the element for which the Linked Document was created. A
hyperlink is automatically created in the document to the
new object. When you click on the hyperlink, the element or
diagram is highlighted in the Browser window.

Create element or diagram

Ste
p

Action

1 Open the Linked Document in the model element or
Document Artifact element.

2 Enter or select the appropriate text to act as the
hyperlink text (such as the element or diagram
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name).
Highlight this text and select the Document - Edit >
File > Model Link > New Model Element >
<element type> ribbon option.

3 If you select the:
'Class', 'Requirement' or 'Issue' option, the·

corresponding element is immediately created in
the Browser window
'Other' option, the 'New Element' dialog displays;·

specify the element type and - if appropriate -
stereotype, and click on the Create button
'Diagram' option, the 'New Diagram' dialog·

displays; specify the diagram type and click on the
OK button

4 The highlighted text is now a hyperlink to the new
object in the Browser window. Click on the link to
highlight the object.
You can now edit or expand the element or diagram
as required.
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In-place Editing Options

This topic explores the tasks that can be performed using
in-place editing of elements on a diagram in Enterprise
Architect. The tasks include:

In-place Editing Tasks·

Edit Element Item Name·

Edit Feature Stereotype·

Edit Feature Scope·

Edit Attribute Keyword·

Edit Operation Parameter Keyword·

Insert Operation Parameter·

Edit Parameter Kind·

Edit Custom Compartment·

Insert New Feature (Attribute or Operation)·

Insert Maintenance Feature·

Insert Project Features·

Insert Testing Features·

In-place Editing Tasks·
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In-place Editing Tasks

This topic explains how to edit and work with some
properties of an element directly in the diagram.

Use In-place Editing Options

Step Action

Open the diagram containing the element.

Click on the element, and on the item to
manipulate within the element.
The item line is highlighted in a lighter
shade (the default is white), to indicate
that it has been selected.

Edit and manipulate the items in the
element, either by pressing the
appropriate keyboard keys or by
right-clicking on the highlighted item and
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choosing a task from the 'Element Items'
context menu.
The available commands are listed in this
table. Not all options are available for
every type of item.

Options

Menu
option...

Action

Extensions Display a submenu of extension products;
click on one to display a further menu of
operations to perform within the selected
product.

Edit Selected Change the name, scope or stereotype of
the element or element item.
Shortcut: F2

Insert New
After
Selected

Insert a new item in the element.
Shortcut: Insert key

View Display the dialog containing details of
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Properties the element.
Shortcut: Enter key

Find in
Project
Browser

Locate the item in the Browser window.

Open in
Specification
Manager

If the element is a Package element, and
the selected item is a subPackage, you
can select this option to open and edit the
subPackage in the Specification Manager.

Add
Attribute

Add an attribute to the element.
Shortcut: Ctrl+Shift+F9

Add
Operation

Add an operation to the element.
Shortcut: Ctrl+Shift+F10

Add Other Insert a feature on the specific element
item, such as Maintenance features and
Testing features.
Shortcut: Ctrl+F11

Delete
Selected
from Model

Delete the selected item from the model.
Shortcut: Delete key

View Source Display the source code for the element,
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code in the default external editor.
Shortcut: F12

Visual
Analyzer

Set a breakpoint on a highlighted
operation (including a breakpoint, start
recording marker, end recording marker
or stack auto-capture marker.)

Set Type Set a classifier type for the selected item.
Shortcut: Ctrl+L

Navigate
Diagram
Selection

Navigate the diagram between elements
without having to use the mouse.
Shortcut: Ctrl+Shift+arrow

Highlight
Element

Toggle element highlight option on and
off.
Shortcut: Shift+Enter

Keys

Other keyboard options that are available while editing
element attributes or operations in a diagram include:

Shortcut Description
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Enter key Accept current changes.

Ctrl+Enter Accept current changes and open a new
slot to add a new item.

Esc Abort the edit, without save.

Tab key or
Shift+Tab

Move the cursor between segments of a
feature definition.

Shift+F10 Display the context menu for in-place
editing.

Ctrl+Shift+S
pace

Invoke the 'Select <Item>' dialog.

Ctrl+Space Display an autocompletion list for a
feature classifier.

Notes

Where an in-place editing menu command has a keyboard·

alternative, if the selected item happens to be off-screen
when you press the keys, the diagram automatically
scrolls to show the whole element, so that you can see
what you are changing
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Edit Element Item Name

You can edit the name of an element, operation or attribute
directly on the diagram using in-place editing.

Edit element or feature name

Step Action

1 Open the diagram containing the element.

2 Click on the element and on the name to
change within the element.
The item line is highlighted in a lighter
shade (the default is white), to indicate
that it has been selected.

3 Right-click on the item.
The context menu displays.

Select the 'Edit Selected' menu option, or
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4 press F2 to enable you to edit the item
directly from the diagram.
The name of the attribute or operation is
highlighted.

5 Delete or type over the name.

6 Press the Enter key to accept the change,
or Esc to cancel the change.
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Edit Feature Stereotype

You can use in-place editing to edit a feature stereotype
directly on a diagram.

Change the stereotype of an operation or
attribute

Step Action

Open the diagram containing the element.

Click on the element, and on the item to
edit within the element.
The item line is highlighted in a lighter
shade (the default is white), to indicate
that it has been selected.

Right-click on the item.
The context menu displays.
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Select the 'Edit Selected' menu option (or
press F2) to enable you to edit the
attribute or operation directly from the
diagram.
The name of the item is highlighted.

Move the cursor to the position before the
name or within the existing attribute or
operation stereotype (denoted by
«stereotype name»).

Delete or type over the previous name to
change the stereotype name of the
attribute or operation.

Press the Enter key to accept the change
or Esc to cancel the change.

Notes
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You can assign multiple stereotypes by including a·

comma-separated list inside the stereotype markers
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Edit Feature Scope

You can rapidly edit the scope of an attribute or operation
directly on a diagram, using in-place editing.

Change the scope of a feature

Step Action

Open the diagram containing the element.

Click on the element and on the item to
edit within the element.
The item line is highlighted in a lighter
shade (the default is white), to indicate
that it has been selected.

Right-click on the item.
The context menu displays.

Select the 'Edit Selected' menu option (or
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press F2) to enable you to edit the
attribute or operation directly from the
diagram.
The name of the item is highlighted.

Move the cursor to the scope of the item
and delete the previous entry.

Reassign the entry by typing in one of
these symbols:

+ indicates that the scope is Public·

- indicates that the scope is Private·

~ indicates that the scope is Package·

# indicates that the scope is Protected·

Press the Enter key to save the change, or
Esc to cancel the change.
The diagram is updated to reflect the
changes (also see the catalogNumber
attribute in the screen illustrations).
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Edit Attribute Keyword

You can add features such as attribute keywords and
classifiers directly to an element, using the Element
Keywords and Classifiers menu. This enables you to rapidly
assign details element item by element item, directly from a
diagram.

Add Features directly to an element

Step Action

In Enterprise Architect, open the diagram
containing the element.

Click on the element, and on the attribute
to edit within the element.
The item line is highlighted in a lighter
shade (the default is white), to indicate
that it has been selected.
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Right-click on the item.
The context menu displays.

Select the 'Edit Selected' menu option (or
press F2) to enable you to edit the
attribute directly from the diagram.
The name of the attribute is highlighted.

Right-click on the attribute name to
display the context menu.

From the context menu, you can:
Change the attribute classifier to static·

or fixed - select the 'static' or 'fixed'
menu options as appropriate; the
diagram is updated to reflect the
changes
Display the Class properties - click on·

the 'Goto Definition' menu option;
Enterprise Architect locates the Class
in the Browser window and opens its
'Properties' dialog

If the data type is a raw data type,
Enterprise Architect displays the
message: The data type is a raw data
type.

(c) Sparx Systems 2022 Page  553 of 1974



Modeling Fundamentals 3 October, 2022

(c) Sparx Systems 2022 Page  554 of 1974



Modeling Fundamentals 3 October, 2022

Edit Operation Parameter Keyword

You can directly edit operation classifiers by element, using
the in-place editing menu. This enables you to rapidly assign
parameter keywords.

Directly edit operation classifiers by element

Step Action

Open the diagram containing the element.

Click on the element, and on the
operation to edit within the element.
The item line is highlighted in a lighter
shade (the default is white), to indicate
that it has been selected.

Right-click on the item.
The context menu displays.

Select the 'Edit Selected' menu option (or
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press F2) to enable you to edit the
operation directly from the diagram.
The name of the operation is highlighted.

Right-click on the data type of a
parameter to display the context menu.

From the context menu you can:
Change the operation classifier by·

clicking on the appropriate menu
option - 'static', 'isquery', 'abstract' or
'fixed'; the diagram is updated to reflect
the changes
Display the Class properties - click on·

the 'Goto Definition' menu option
If the data type is 'Class', Enterprise
Architect locates the Class in the Browser
window and opens its 'Properties' dialog
If the data type is a raw data type,
Enterprise Architect displays the message
This data type is a raw data type
If the data type is not defined in the
model, the message is: The data type is
not defined in the model
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Edit Parameter Kind

You can edit operation parameter kinds such as (in), (inout)
and (out) directly from a diagram, element by element,
using the Element Keywords and Classifiers menu. This
enables you to rapidly assign the parameter directly from a
diagram.

Edit operation parameter kinds directly from
a diagram

Images Action

1. In Enterprise Architect, open the
diagram containing the element.

2. Click on the element, and on the
operation to edit within the element.
The item line is highlighted in a lighter
shade (the default is white), to indicate
that it has been selected.

3. Right-click on the item.
The context menu displays.

4. Select the 'Edit Selected' menu option
(or press F2) to enable you to edit the
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item directly from the diagram.
The name of the item is highlighted.

5. Right-click on the item name to
display the context menu.

6. Select the appropriate menu option for
the parameter kind value: (in), (inout) and
(out).
The diagram is updated to reflect the
change.
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Edit Custom Compartment

Items listed within a Custom Compartment can also be
in-place edited. They have a similar in-place editing menu
as other compartment items such as Operations and
Attributes within a Class.

For example: a SysML Block element can have a Parts
custom compartment. In-place editing can be performed
upon the Parts listed within this compartment.

In-place edit an item in a Custom
Compartment

Ste
p

Action

1 Open the diagram containing the element.

2 Click on the element and on the item to change
within the custom compartment.
The item line is highlighted in a lighter shade (the
default is white), to indicate that it has been selected.
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3 Right-click on the item.
The context menu displays.

4 Select the 'Edit Selected' menu option, or press F2 to
enable you to edit the item directly from the
diagram.
The name of the item is highlighted.

5 Delete or type over the name.

6 Press the Enter key to accept the change, or Esc to
cancel the change.

Notes

Custom Compartments such as Parts and Ports within a·

SysML Block also provide a Set Type command on the
right-click menu to set the classifier type of the selected
item.
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Insert New Feature

You can insert a new element feature directly on a diagram,
using in-place editing.

Add attributes and operations to a Class
diagram element

Step Action

In Enterprise Architect, open the diagram
containing the element.

Click on the element and, within the
element, on the item after which to insert
the operation or attribute.
The item line is highlighted in a lighter
shade (the default is white), to indicate
that it has been selected.

Either press the Insert key or right-click
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on the selected element item to display
the context menu, and select the 'Insert
New After Selected' menu option
Enterprise Architect inserts a new data
line in the diagram, underneath the
selected item.

Type in the relevant information for the
attribute or operation.
Use the Tab key and Tab+Shift keys to
move the cursor through the segments of
the attribute or operation, and select the
classifier from either the:

Autocompletion list (press the·

Ctrl+Space keys) or
Select <Item> dialog (press the·

Ctrl+Shift+Space keys)

Press the Enter key to accept the change
or Esc to cancel the change.
The diagram is updated to reflect the
changes.
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Insert Operation Parameter

You can add operation parameters to an operation through
the in-place editing options, using hotkey commands or
menu shortcuts.

Add parameters to operations in a Class
diagram element

Step Action

Open the diagram containing the element.

Click on the element, and on the
operation to update within the element.
The item line is highlighted in a lighter
shade (the default is white), to indicate
that it has been selected.

Press F2, or right-click on the selected
item and select the 'Edit Selected' option.
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Move the cursor inside the parameter
brackets and type the parameter name,
followed by a colon (for example, bks:
for a vector containing books).

Give the parameter a type.
Place the cursor after the colon at the end
of the name and add the classifier; either:

Press Ctrl+Space to invoke the·

classifier autocompletion list
Press Ctrl+Shift+Space to select a·

classifier from the 'Select <Item>'
dialog or
Click the right mouse button to display·

the inline editing options context menu
and select the 'Insert Classifier' option

The 'Select <Item>' dialog displays.

Press the Enter key to accept the change
or Esc to cancel the change.
The diagram is updated to reflect the
changes.
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Insert Maintenance Feature

You can quickly insert a new maintenance item directly on a
diagram, using in-place editing.

Assign maintenance details directly to an
element from a diagram

Step Action

Open the diagram containing the element.

Click on the element name.
The name is highlighted in a lighter shade
(the default is white), to indicate that it
has been selected.

Either press Ctrl+F11 or right-click on
the highlighted name and select the 'Add
Other' option.
The 'Insert Feature' dialog displays.
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Click on the appropriate radio button
option to associate the required
maintenance feature with the element
item.

Click on the OK button.
The '<Maintenance Feature> details for
<element>' dialog displays.

Complete the fields to define the
maintenance activity, and then click on
the Apply button.
To create a subsequent maintenance
activity of this type, click on the New
button.

When you have defined all of the
maintenance activities of this type, click
on the OK button.
The maintenance details are added to the
element.
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Notes

To ensure that the maintenance items are visible in the·

diagram element, as shown in step 7, select the
'Maintenance' checkbox on the 'Elements' tab of the
'Properties' dialog for the diagram
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Insert Project Features

You can quickly insert a new project item directly into a
diagram, using in-place editing.

Assign project details directly to an element
from a diagram

Step Action

Open the diagram containing the element.

Click on the element name.
The name is highlighted in a lighter shade
(the default is white), to indicate that it
has been selected.

Either press Ctrl+F11 or right-click on
the highlighted name and select the 'Add
Other' option.
The 'Insert Feature' dialog displays.
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Click on the appropriate radio button to
associate the required project feature with
the element item.

Click on the OK button.
The '<Project Feature> details for
<element>' dialog displays for a Decision
or Event item.
The '<Project Feature>' dialog displays
for a Risk, Metric or Effort item.

For Decision and Event items:
Complete the fields to define the·

project activity, and then click on the
Apply button
If creating a subsequent project activity·

of this type, click on the New button

When you have defined all of the project
activities of this type, click on the OK
button.
The project details are added to the
element.

Notes
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To ensure that the project items are visible in the diagram·

element, as shown in step 7, select the 'Project' checkbox
on the 'Elements' tab of the 'Properties' dialog for the
diagram
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Insert Testing Features

You can add test records such as Unit, Integration, System,
Acceptance, Inspection and Scenario tests directly to an
element displayed on a diagram.

Add testing features to an element directly
from a diagram

Step Action

Open the diagram containing the element.

Click on the element.
The element name is highlighted in a
lighter shade (the default is white), to
indicate that it has been selected.

Either press Ctrl+F11 or right-click on
the highlighted name and select the 'Add
Other' option
The 'Insert Feature' dialog displays.
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Click on the appropriate radio button
option to associate the required testing
feature with the element.

Click on the OK button.
The 'Test Details' dialog opens.

Complete the fields to define the test
activity, and then click on the Apply
button.
The test is added to the element.

To create a subsequent test activity of this
type, click on the New button.

Notes

To ensure that the test items are visible in the diagram·
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element, as shown in step 7, select the 'Testing' checkbox
on the 'Elements' tab of the 'Properties' dialog for the
diagram
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Behavior

Enterprise Architect enables you to define an element's
behavior through the element's operations and parameters.
You can also define the behavior of more specific
behavioral elements such as Activities, Interactions, Actions
and Interaction Occurrences, through the 'Behavior' tab of
the Properties window.
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Operations

Operations are features of a Class or other element that
represent the behavior or services an element supports. For
example, in a Customer Class, 'UpdateCustomerName' and
'GetCustomerAddress' can be operations. Operations have
several important characteristics, such as type, visibility
(scope), static, abstract and notes.

Access

Ribbon Design > Element > Editors > Features >
Operations

Context
Menu

Right-click element in diagram or
Browser window | Features | Operations
or
Right-click operation in Browser window
| Properties | Properties ('Operation'
dialog)

Keyboard
Shortcuts

F10

Other On a diagram, double-click on an
operation ('Operation' dialog)
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In the 'Project' tab of the Browser
window, double-click on an operation to
locate and highlight the parent element in
a diagram

Create and Modify Operations

You can create the operations of an element on the
'Operations' tab of the Features window, and modify the
basic properties. You use the Properties window or
'Properties' dialog for operations to provide more detailed
properties of the operations you need for an element.

Appearance on diagram

In diagrams, elements with operations (typically Classes)
list the operations in a properties compartment, in colored
text, as shown.
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The text color can be defined on the 'Standard Colors' page
of the 'Preferences' dialog. Some characteristics modify the
display; for example, static operations display underlined,
whilst abstract operations are italicized.

Appearance in Browser Window

In the Browser window, operations are listed underneath
their parent element name, each preceded by a pink box.

Notes

If the parent element provides source or target roles for a·

connector, the connector can be attached to a specific
operation

You can also drag, copy or move existing operations·

between elements; this facility is only available if the
target element supports operations
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Define Properties of Operations

You create operations for an element on the 'Operations'
page of the Features window, and provide a basic set of
properties. You can simply create a number of operation
names if you want to create operations quickly and not
necessarily fully define them as you create them. You
provide the more detailed properties of the operations using
the operation 'Properties' dialog.

Operations of State elements are managed differently - there
are three operations (Enter, Do and Exit) that are defined on
the 'Behavior' tab of the Features window. This tab displays
only when the selected element is a State. Similarly, if the
element is a Database Table, the 'Operations' tab is replaced
by a 'Constraints/Indexes' tab.

Access

Click on an operation in the Browser window or a diagram.

Ribbon Design > Element > Editors > Features >
Operations
Design > Element > Editors > Element >
Properties Dialog

Context
Menu

Right-click on the parent element |
Features | Operations or
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(Browser window) Right-click on the
operation| Properties | Properties
(Diagram) Right-click on the operation |
View Properties

Keyboard
Shortcuts

F10

Create and define Operations ('Operations'
tab, Features window)

Field/Button Action

Name Overtype the New Operation... text to
create a new operation, or click on the
name to edit an existing operation.

Parameters Lists the parameters that have been
defined for this operation on the
'Parameters' tab of the 'Properties' dialog
for the operation.

Return Type Defaults to 'void'. To change this,
overtype the field or click on the
drop-down arrow and click on:
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The required data type returned by the·

operation, as defined by the code
language (data type), or
'<none>' for no type (or you can type in·

a value manually if you prefer), or
'Select Type' and browse for the·

appropriate operation classifier (you
can add a new one if there are no
classifiers that suit)

To add new code language data types that
can be displayed in this list, see the Data
Types topic.

Scope Click on the drop-down arrow and select
one of:

Public·

Protected·

Private·

Package·

Stereotype (Optional) Define one or more
stereotypes for the operation; either:

Type a stereotype name, or·

Click on the  button and select the·

stereotype from the 'Stereotypes for
<object name>' dialog

If you select multiple stereotypes, they
are listed on separate lines of the
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'Stereotype' field.

Alias (Optional) Type an alternative name or
reference for the operation.

Context Menu options

Right-click on the 'Operations' tab of the Features window.

Option Action

Add New Add a new operation to the list, with
default values in the dialog fields.
Shortcut: Ctrl+N

Operation On the 'Behavior' tab for a State element,
opens the 'Operation' dialog to add the
details of the selected behavior operation.

Copy as New Copy a selected operation as a new
operation. Provide a new name for the
operation and click on the OK button.
Shortcut: Ctrl+C

Properties Display the 'Properties' dialog for a
selected operation.
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The 'Operation' tab of the 'Properties'
dialog has the same fields as the
Properties window for operations.

Properties
Window

Display the Properties window for a
selected operation.
Shortcut: Ctrl+2

Restore Sort
Order

If you have used the column header
arrows to reorganize the sequence in
which the operations are displayed, click
on this option to redisplay them in the
default sequence (alphabetical by name).

Move up Move the selected operation one row up
the list.
Shortcut: Ctrl+Up Arrow

Move down Move the selected operation one row
down the list.
Shortcut: Ctrl+Down Arrow

Field
Chooser

Display the 'Field Chooser' dialog, which
contains any column headings not
currently applied to the page.
Drag a column heading from the 'Field
Chooser' into the preferred position in the
row of column headings. You can also
drag the column headings into a different

(c) Sparx Systems 2022 Page  582 of 1974



Modeling Fundamentals 3 October, 2022

sequence.
To return a column heading to the 'Field
Chooser', drag it out of the heading row.

Enable
Group Box

Show or hide the Group Box, in which
you reorganize the list sequence of the
operations according to one or more
characteristics.

Toggle Filter
Bar

Show or hide the Filter Bar, in which you
type text strings that the data in the
corresponding column must match in
order to be listed.

Delete Immediately delete the selected operation
from the element.
Shortcut: Ctrl+Del

Help Display the Help topic pertinent to the
current tab.
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Operation Behavior

You can define the behavior of an operation in one of two
ways:

As behavior code to be inserted into an operation Body·

when that operation is generated to file

As a reference to a behavior element, such as an Activity·

or Interaction, or to another operation

Creation of the behavior code is discussed in the Behavior
Code Help topic.

You can also provide a text description consisting of
pseudo-code, structured text or just abbreviated notes, which
is used as a comment on the behavior code. You have the
option of displaying either this text or the reference on each
depiction of the parent element on a diagram. In this State
element example, the entry operation applies the behavior of
the ActivityComp Activity, whilst the exit behavior is
described in simple text.

The operation Behavior is also applied during Interpreted
Simulation and Executable StateMachine code generation
and simulation, to provide 'entry/do/exit' behavior for States.
In this case you create a short script in the 'Behavior' field,
using JavaScript, to enact the operation behavior. For an
example, access the EAExample Model and open 'Model
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Simulation > StateMachine Models > Nested Traces >
Example Class > Nested Traces', then open the 'Nested
Traces' StateMachine diagram. Note the entry and exit
scripts for each State. If you double-click on the 'entry' or
'exit' operations, the operation 'Properties' dialog opens and
you will see the scripts in the 'Behavior' tab.

Access

In a diagram or the Browser window, click on an operation
and then select one of the access methods identified here:

Ribbon Design > Element > Editors | Properties
Dialog > Behavior

Context
Menu

Properties | Properties > Behavior

Keyboard
Shortcuts

F10 > Behavior

Set Behavior

Either:

In the 'Behavior' field, type the text or pseudo code·
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description of the behavior, or

Click on the Element button to display the 'Select·

Behavior' dialog, then browse for and select the
appropriate element or operation; when you click on the
OK button, the fully qualified object name displays in the
'Behavior' field

If you want the behavior text or reference to be shown on
any diagram that the operation appears in, select the 'Show
Behavior in Diagram' checkbox.

If you want to use behavior code, click on the 'Code' tab and
enter the code in the field on that tab.

When you have defined the operation behavior, click on the
Save button.

Delete behavior

If you have typed in a behavior description in free text,
simply select and delete the text.

If you have selected another behavioral object, click on the
Element button and select the '<none>' option at the foot of
the 'Select Element' hierarchy.

Example of Associated Behavior

An operation of, for example, a Class is being associated
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with a behavior elsewhere in the model. The operation is
then set as the specification of that associated behavior. In
code generation, the behavior of the associated behavioral
element is generated as the operation's code; in this
illustration, op1 is associated with the Activity 'Activity'.

The generated code for op1 is as shown:
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     package Behavior;

     public class Container {

          public Container() {

          }

          public void finalize() throws Throwable {

          }

          public void op1() {

          /*Activity element(Activity)'s behavior rendered as

               operation(op1)'s code*/

               //Action1;

               if (cond1)

               {

                    //Action2;

               }

               else

               {

                     //Action3;

               }

               //Action4;

          }

          /*Activity element (Activity) not rendered*/

          public void Activity2()

          {

               // behavior is an Activity

          }
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          public void Interaction()

          {

               // behavior is an Interaction

          }

     } //end Container
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Behavior Code

Behavior code is inserted into an operation Body when that
operation is generated to file. This code is most useful when
combined with Design Patterns; elements within a Pattern
often require the same stub code. The behavior code is also
useful for ensuring that the generated code can be directly
compiled. The language-specific Patterns available from the
web site resources include behavior code for some of the
defined operations; this helps speed up the process of
applying Patterns from model to implementation.

By default, the behavior code is not imported into the model
during reverse engineering, but you can select to import the
code by ticking the 'Include method bodies in model when
reverse engineering' checkbox on the 'Source Code
Engineering > Attribute/Operations' page of the
'Preferences' dialog.

You enter the behavior code through the Code Editor, which
lists the operations within an element or within an Activity
or StateMachine diagram and enables you to enter the
behavior code for each operation individually. See the
Editing Source Code Help topic.

On the Operation 'Properties' dialog, there is a 'Code' tab on
which you can also enter the behavior code for the
operation.  The code editing facilities are more streamlined
but you can use context menu options to paste copied code
in from elsewhere. You can also click on the Code Editor
button to, again, create the code in the Code Editor. Bear in
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mind that switching to the Code Editor closes the operation
'Properties' dialog and does not transfer incompletely saved
code, so you should save any code you create in the
'Properties' dialog before making the switch.

The 'Properties' dialog also has a 'Behavior' tab on which
you can type pseudo-code or plain text to state what the
operation does. This text is added to the element  code as a
comment on the behavior code, and can be displayed on the
parent element in a diagram. See the Operation Behavior
Help topic.

Access

Before displaying the Behavior code, click on the required
operation in the Browser window or a diagram.

Ribbon Develop > Source Code > Behavior
Design > Element > Behavior

Context
menu

Right-click on operation | Properties |
Properties > Code   (if preferred, then :
Code Editor)

Options
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When selecting from the ribbon, you have three options for
developing code:

Edit Behavior·

Edit Internal Code·

Edit (or View) Source Code·

All three options display the Code Editor window, but show
the appropriate features, code and editing options for the
type of code identified by the option. Within the Code
Editor you can right-click on the Operation and select to
switch from whichever aspect you are working on to one of
the other two.
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Redefine Operation and Check for
Exceptions

If the parent element of a selected operation is the source
element for a Generalize connector, you can configure the
operation to redefine an operation in the target element.
Also, you can create code in your application to check for an
exception and, if one occurs, to switch to the code defined
by a Classifier element. You can identify the target
operation and/or the classifier element on the 'Redefines' tab
of the Operation 'Properties' dialog.

It is also possible to add or change these properties in the
'Raised Exceptions' and 'Redefined Operation' fields of the
Properties window for an operation.

Access

Context
Menu

On an open diagram, click on an
operation and then right-click |  View
Properties > Redefines
In the Browser window, right-click on an
operation | Properties | Properties >
Redefines
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Tasks

Task Action

Redefine a
target
element
Operation

Click on the Add button beneath the1.
'Redefined Operation' panel.
The 'Select Operation' dialog displays,
showing the operations in the target
element.
Click on the appropriate operation; if2.
you want to redefine more than one
operation in the target element, press
Ctrl as you click on each one.
Click on the OK button.3.
A statement displays in the 'Redefined
Operation' panel, of the format:
     <Package>::<Target
Element>.<Operation>
On the parent element in a diagram, the4.
Operation compartment shows the
complete statement, of the format:
     <Operation>:{redefines
<Package>::<Target
Element>.<Operation>

If you want to change the redefined
operation(s) at any point, return to the
'Redefines' tab and again click on the Add
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button, and repeat the process. The
original selection is replaced by the new
selection.
You can also add or change a redefined
operation (with a little more knowledge
of your element structures) in the
'Redefined Operation' field of the
Properties window for the operation.

Click on the operation in a diagram or1.
the Browser window, and press Ctrl+2.
In the Properties window, click on the2.

 icon at the end of the 'Redefined
Operation' field.
The 'Redefined Operation' browser
displays.
Locate and double-click on the3.
required redefined operation.
In the Properties window, click off the4.
'Redefined Operation' field; the name
of the selected operation displays in the
field.

Identify
Exception
Classifier

Click on the Add button beneath the5.
'Raised Exception' panel.
The 'Select Classifier' dialog displays;
locate and double-click on the
appropriate Classifier.
The name of the parent Package and6.
the Classifier displays in the 'Raised
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Exception' panel.
If you want to change the Classifier at
any point, return to the 'Redefines' tab
and 'Raised Exception' panel and again
click on the Add button, repeating the
process. The original selection is replaced
by the new selection.
You can also add or change the
Exception Classifier through the
Properties window for the operation.

Click on the operation in a diagram or5.
the Browser window, and press Ctrl+2.
In the Properties window, click on the6.

 icon at the end of the 'Raised
Exceptions' field.
The 'Raised Exceptions' browser
displays.
Locate and double-click on the7.
required classifier.
In the Properties window, click off the8.
'Raised Exceptions' field; the name of
the selected classifier displays in the
field.
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Operation Constraints

Constraints define the contractual behavior of an operation,
what must be true before they are called (pre-conditions)
and what is true after they are called (post-conditions). In
this respect they are related to the State model of a Class and
can also relate to the guard conditions that apply to a
transition. You can define both pre- and post- conditions for
an operation.

Access

Before displaying the 'Properties' dialog, click on the
required operation in a diagram or the Browser window.

Keyboard
Shortcuts

(From the diagram) Enter > Pre   or
Post
(From the Browser window) Enter |
Properties > Pre   or    Post

Define Constraints

The fields and options on the 'Pre' and 'Post' tabs of the
Properties window are identical. Click on the appropriate
tab to define the conditions prior to and following on from
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the operation behavior.

Option Action

Pre-Conditio
n:
Post-Conditio
n:

Type in the name or effect of the
condition.

Type Click on the drop-down arrow and click
on the appropriate condition type.

<notes> Type in any further explanation or
description that is necessary for the
condition.

New Click on this button to clear the fields to
define another condition.

Save Click on this button to save the new or
updated condition and to add the changes
to the 'Pre-Condition' or 'Post-Condition'
list.
This button also clears the data fields so
that you can create another condition.

Pre-Conditio
n
Post-Conditio

Lists the pre-conditions or
post-conditions that have been defined
for this operation.
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n Click on an item in this list to re-populate
the dialog fields with the details, to edit
or delete the condition.

Delete Click on an item in the 'Pre-Condition' or
'Post-Condition' list and click on this
button to delete that condition from the
operation.
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Operation Tagged Values

Both operations and the parameters assigned to operations
can have Tagged Values associated with them. Tagged
Values offer a convenient extension mechanism for UML
objects, so you can define any tags you need and then assign
values to them using this form.

Tagged Values are written to the XMI output, and can be
input to other third party tools for code generation or other
activities.

You can add and edit Tagged Values on an operation or
parameter using either the:

'Tags' tab of the Properties window for the operation or·

'Tagged Values' tab of the 'Properties' dialog for the·

operation

If the operation has any parameters, the parameter names
and Tagged Values are listed on the 'Tagged Values' or
'Tags' tab underneath the Operation name and Tagged
Values.

Access

Click on the operation in either a diagram or the Browser
window.

Ribbon Design > Element > Properties > General
> Tagged Values    (Properties window)
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Start > All Windows > Properties >
General > Tagged Values   (Properties
window)

Keyboard
Shortcuts

Ctrl+2 > Tags  (Properties window)
(On a diagram) Enter > Tagged Values
('Properties' dialog)
(In the Browser window) Enter |
Properties > Tagged Values  ('Properties'
dialog)

Add a Tagged Value for an operation or
parameter

Ste
p

Action

1 Click on the operation or parameter to which to
assign the Tagged Value.

2 Click on the  button in the Toolbar at the top of
the panel.
The 'Tagged Value' dialog displays.

3 In the 'Tag' field, type the tag name (or select a
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defined tag from the drop-down list).
In the 'Value' field type the initial tag value. (For
some types of Tagged Value, the 'Value' field is
grayed out. In this case, continue to step 4 and then
enter the value against the tag value on either the
'Tags' tab of the Properties window or the 'Tagged
Values' tab of the 'Properties' dialog.)

4 Click on the OK button to confirm the operation.

Notes

Tagged Values are supported for attributes, operations,·

objects and connectors

You can define custom tags using a predefined Tagged·

Value Type
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Override Parent Operations

You can automatically override methods from parent
Classes and from realized Interfaces, using the 'Override
Operations/Interfaces' dialog. You can configure the system
to display this dialog each time you add a Generalization or
Realization connector between Classes, and review their
possible operations/interfaces to override/implement.

Access

Use any of the methods outlined here to display the
'Overrides & Implementations' dialog.

On the dialog, you simply:

Select the checkbox against each operation or interface to·

automatically override (or click on the Select All button)
and click on the OK button; Enterprise Architect
generates the equivalent function definitions in your child
Class

To display the dialog automatically, from the Start ribbon,
select 'Appearance > Preferences > Preferences : Links' and
select the 'Show Override Operation dialog on new
connector' checkbox.

Ribbon Design > Element > Manage > Overrides
and Implementations
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Keyboard
Shortcuts

Ctrl+Shift+O
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Display Inherited Operations

You can configure a selected element in a diagram to
display the complete operation set obtained from all
ancestors in the element's type hierarchy, as well as those
directly owned.

Access

Context
Menu

Right-click element on diagram |
Compartment Visibility

Keyboard
Shortcuts

Ctrl+Shift+Y

Enable Behavior

On the 'Compartment Visibility' dialog, in the 'Show
Element Compartments' panel, select the 'Inherited
Operations' checkbox.

Example
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This diagram illustrates the behavior, where it has been
enabled for each element in a simple hierarchy. The Child
element inherits from all other levels of the hierarchy.
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Behavior Parameters

The 'Parameters' tab of the 'Properties' dialog for an
operation provides the facilities for defining, editing and
extending the parameters of behavioral operations,
Activities and Interactions.

Access

Ribbon Design > Element > Editors > Properties
> Click on the operation (diagram or
Browser window) :  > Parameters

Context
Menu

Right-click on operation (in diagram) |
View Properties > Parameters
Right-click on operation (in Browser
window) | Properties | Properties >
Parameters
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Define Parameters

Within the properties of an operation, Activity or
Interaction, you can define parameters to control how that
object and its subordinate objects behave.

The order or sequence of the parameters in the object
properties is reproduced in code. You can set and manage
the order using facilities available within the 'Parameters'
tab of the 'Properties' dialog for an operation.

Access

Click on an operation in the Browser window or in a
diagram.

Ribbon Design > Element > Editors > Properties
Dialog > [select or create an operation] >
Parameters

Keyboard
Shortcuts

F10 > Parameters

Define the Parameters

The first two fields are in the left-hand panel of the tab, and
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the remaining fields are in the right-hand panel.

Option Action

Parameter In the 'Parameter' list, overtype the New
Parameter text with the new parameter
name.

Type Click on the drop-down arrow and click
on:

The required data type of the operation,·

as defined by the code language (data
type) or
<none> for no type (or you can type in·

a value manually if you prefer), or
'Select Type' and browse for the·

appropriate operation classifier (you
can add a new one if there are no
classifiers that suit)

To add new code language data types that
can be displayed in this list, see the Data
Types Help topic.

Default
Value

(Optional) Type a default value for the
parameter.

Stereotype (Optional) Type in the appropriate
stereotype name, or click on the  button
and select one using the 'Stereotypes for
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<object name>'. You can select multiple
stereotypes, in which case each
stereotype is shown on a separate line of
the 'Stereotype' field.

Alias (Optional) Type an alternative name or
reference for the parameter.

Direction Click on the drop-down arrow and select
the way the parameter is passed to a
function:

In = By Value·

InOut = By Reference·

Out = Passed By Reference, but only·

the return value is significant
Return = The parameter is a returned·

value

Fixed Value Click on the drop-down arrow and select
True, even if the parameter is passed by
reference.

Multiplicity Click on the  button to display the
'Multiplicity' dialog, and define the
multiplicity of the parameter.

Lower bound - Type the lower limit to·

the number of elements that must be in
the collection
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Upper bound - Type the upper limit to·

the number of elements allowed in the
collection
Allow Duplicates - Select the checkbox·

to indicate that duplicate values are
allowed; this field maps to the UML
property isUnique, with a value False
Multiplicity is Ordered - Select the·

checkbox to indicate that the collection
is ordered
OK - Click on this button to save the·

information and close the dialog

Notes Click on the  button and type any
additional notes on the parameter. These
notes are unformatted.

Notes

To organize parameters into the required sequence, and·

reorganize the display of information, right-click on the
background of the 'Parameter' tab or on a specific
parameter and select from the same context menu options
as for the 'Operations' tab

Set the amount of parameter detail to display in a specific·

diagram using the 'Show Parameter Detail' drop-down list
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on the 'Features' tab of the 'Properties' dialog for the
diagram; the setting applies only to the current diagram,
and the default is to show the type only

You can set Tagged Values on a parameter, as well as on·

the parent operation
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Parameter Tagged Values

Behavioral parameters of operations, Activities and
Interactions can have Tagged Values associated with them.
Tagged Values offer a convenient extension mechanism for
UML elements; you can define any tags you need and then
assign values to them.

Tagged Values are written to the XMI output, and can be
input to other third party tools for code generation or other
activities.

Access

Display the 'Tags' tab of the Properties window, using any
of the methods outlined here. Then, in the Browser window
or a diagram, select the object containing the parameter.

Ribbon Start > All Windows > Properties >
General > Tagged Values
Design > Element > Properties > General
> Tagged Values
Explore > Portals > Windows >
Properties > Tagged Values

Keyboard
Shortcuts

Ctrl+2 > Tags
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Add a Tagged Value for a parameter

Ste
p

Action

1 The 'Tags' tab shows the Tagged Values for the
selected object and its parameters, under separate
headings.
Click on the required parameter in the 'Parameters'
section, and click on the New Tags button.
The 'Tagged Value' dialog displays.

2 In the 'Tag' field, type the tag name (or select a
defined tag from the drop-down list).
In the 'Value' field type the initial value of the tag.
(Extended tags might not allow you to set a value
through the 'Tagged Value' dialog; for such tags,
enter the value on the 'Tags' panel of the Properties
window.)

3 Click on the OK button to confirm the Tagged
Value.
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Notes

Tagged Values are supported for attributes, operations,·

objects and connectors

Custom tags can be created using a predefined Tagged·

Value Type
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Operation Parameters by Reference

In your project, you can set operational parameters to be
passed 'By Reference', as a global setting.

Access

Ribbon Start > Appearance > Preferences >
Preferences > Objects > Feature reference
indicator

Define Parameters

You can select to highlight parameters declared as 'Kind:
inout' or 'Kind: out' with an additional user-defined prefix or
suffix.

If you select the 'Highlight References' checkbox, you can
also indicate whether a prefix or suffix should be used, and
the actual reference character to use. In the example image,
the '&' character has been set as a prefix.

When you declare a parameter of type 'inout', it is assumed
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you are passing the parameter by reference rather than by
value. If you have elected to highlight references, then this
is displayed in the Diagram View.

The example shows that, in the getName operation, the
parameter 'strName' is a string reference, and is highlighted
using the chosen character and position.

Notes

This facility applies to operations only·
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Interactions and Activities

The behavioral aspects of Interactions and Activities are
modeled using the 'Behavior' tab of the Properties window
for the element, on which you assign parameters and return
types to the elements.

Access

Select an Interaction or Activity element on a diagram or in
the Browser window, then display the 'Behavior' tab of the
Properties window, using any of the methods outlined here.

On the 'Behavior' tab, click on the  button of the
'Parameters' field to edit the element's parameters on the
'Parameters tab'. When you create a new parameter using the
'Parameters' tab, it internally creates an Activity Parameter
Node for an Activity or an Interaction Parameter for an
Interaction.

In the 'Return' field, click on the drop-down arrow and select
the return type of the element. Alternatively, click on the 
button and use the 'Select Type' dialog to locate the
appropriate classifier.

The 'Specification' field is populated automatically when an
operation is associated with the Activity or Interaction as a
behavior.

Ribbon Design > Element > Editors > Properties
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> Behavior

Keyboard
Shortcuts

Ctrl+2 > Behavior
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Behavior Calls

A behavior call is the invocation of a behavior, which you
can represent with a CallOperation Action (Operation),
CallBehavior Action (Activity) or Interaction Occurrence
(Interaction) element. You model the properties of the
behavior call using the 'Behavior' tab of the Properties
window for the Action or Interaction Occurrence element.
You use behavior calls to:

Edit Arguments·

Re-associate the call with a different behavior·

Synchronize the arguments with the parameters in the·

associated behavior

Access

Ribbon Design > Element > Editors > Properties
> Behavior
Start > Application > Design > Properties
> Behavior

Keyboard
Shortcuts

Ctrl+2 > Behavior
Alt+1 | Properties > Behavior
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Editing a Behavior Call

Click on the  button at the end of the 'Argument' field to
display the 'Arguments' tab and create and delete arguments,
relating each one to a corresponding parameter in the
associated behavior.

Click on the  button on the 'Behavior' field to re-associate
the invocation with a different behavior or to remove any
association with the current behavior.

For Interaction Occurrence elements, an 'Interaction
Occurrence' panel is displayed as well. It enables you to
enter the return value and attribute of the behavior call.
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Associate with Different Behaviors

On the 'Behavior' tab of the Properties window for the
Behavior Call element, when you click on the 'Behavior'
field  button the 'Select Element' or 'Select Operation'
dialog displays, listing all available behaviors in the model.

Select '<none>' to remove any existing association between
an invocation and a behavior, or select another classifier to
re-associate the invocation with a different behavior.

When a valid behavior is identified in the 'Behavior' field,
the Synchronize with Parameters button is enabled for
synchronizing the arguments with the parameters.

Access

Ribbon Design > Element > Editors > Properties
> Behavior
Start > Application > Design > Properties
> Behavior

Keyboard
Shortcuts

Ctrl+2 > Behavior
Alt+1 | Properties > Behavior

(c) Sparx Systems 2022 Page  623 of 1974



Modeling Fundamentals 3 October, 2022

Behavior Call Arguments

You define the arguments of a Behavior Call using the
'Arguments' tab of the Properties window for the element.

Access

Ribbon Design > Element > Editors > Properties
> Arguments
Start > Application > Design > Properties
> Arguments

Keyboard
Shortcuts

Ctrl+2 > Arguments
Alt+1 | Properties > Arguments

Define the arguments of a Behavior Call

Ste
p

Action

1 In the 'Name' field, type the name of an argument to
map to the behavior.
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2 In the 'Param' field, click on the drop-down arrow
and select a behaviors parameter from the list of
parameters associated with the behavior.

3 In the 'Default' field, set any required default value.
Optionally, you can also:

Assign a stereotype from the 'Stereotype' field·

drop-down list, or by browsing for one using the
 button

Provide an alternative name or reference for the·

argument, in the 'Alias' field, and/or
Type in some notes to describe or explain the·

argument

4 If a diagram is displayed, and if required, select the
'Show in current diagram' checkbox to add an Action
Pin on the diagram to represent the argument.

5 Click on the Save button.

6 If appropriate, click on the New button and repeat
steps 1 to 5 for another argument:parameter
mapping.

Notes
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If you attempt to map a newly created argument to a·

parameter that is already associated with a different
argument, Enterprise Architect identifies the mapping and
prompts you to confirm that you intend to change the
association
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Synchronize Arguments

In your project, you can synchronize the parameters and
arguments in a behavioral invocation.

On the 'Behavior' tab of the Properties window for the
element, click on the Synchronize with Parameters button to
synchronize the number of arguments in the invocation
element with the number of parameters in the associated
behavior.

This automatically creates or deletes arguments based on the
number of parameters in the behavior.

If any arguments are to be deleted, Enterprise Architect
prompts you to confirm the operation. Click on the Yes
button to confirm.

Access

Ribbon Start > Application > Design > Properties
> Behavior
Design > Element > Editors > Properties
> Behavior

Keyboard
Shortcuts

Ctrl+2 > Behavior
Alt+1 | Properties > Behavior
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Notes

The Synchronize with Parameters button is enabled only·

if the invocation is associated with a valid behavior,
identified in the 'Behavior' field
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Classifiers and Instances

Some types of element (such as Classes) model
classifications, which provide a specification of an abstract
concept. For example, the concept of a Building can be
represented by a set of Classes that define types of building
such as Bungalow, Miner's Cottage, Office Block, Shop and
so on. Other types of element (such as Objects) model
instances of such classifications, such as 23 High Street
Shop or 45 Village Green Cottage. The instance elements
represent actual objects in a run-time scenario, based on the
specification of the classifier element. For example:

An Object element represents a man called Joe Smith, as a·

specific instance of the concept of 'a person' defined by
the Class element Person; the object is rendered as a
rectangle showing the name of the classifier - if you name
the object it becomes <ObjectName>:<ClassifierName>
or, in this example, Joe Smith:Person

If you develop a Person Class with attributes such as Age,
Name, Address and Sex, and functions such as GetAge and
GetName, then when you derive an object from that Class
the object takes on all the Person Class behavior and state
(as well as inherited state and behavior from the parent
elements of the Person Class, if any).
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Associating an instance with a classifier greatly increases
the descriptive power of the model in capturing the
functionality and responsibility of objects and their
associated state at run-time. This is an effective means of
moving your model from the analysis phase into detailed
design.

Notes

An object is an instance of a classifier at runtime, so the·

object's features are actually those of the classifier; in the
context menu for a classified object, if you select the
'Features | Attributes' or 'Operations' menu options, the
Features window displays for the classifier, not the object

Similarly, if you have set the classifier for an object in a·

Sequence diagram, when you add a message and display
the Properties window for the Message, the 'Message'
drop-down list is drawn from the operations of the target
object's classifier, not from the object itself
In this way you can associate Sequence diagram objects
with Classes and use the defined behavior of the Class to
model actual behavior at run time; the same concept
applies to Messages for a State Flow connector

In the Properties window, you can also select to include·

messages defined in the inheritance hierarchy of the
classifier for the target object
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Classify an Object

Objects can be created and classified in a number of ways.
You can define a classifier first and then create instances of
that classifier. Alternatively, you might develop several
separate objects that turn out to have a similar specification,
which you then formally define as a classifier. You would
then classify the existing objects as instances of that new
classifier.

Methods of Classifying an object

Method Detail

Drop
Classifier
Onto
Diagram

Drag an existing classifier element from
the Browser window onto a diagram.
Depending on how you configure the
'Drop <element> from Project Browser'
dialog, you can create an associated
object as an instance, or the instance is
automatically generated.
If your classifier contains Property
elements, you also have the option of
adding some or all of these properties to
the instance as 'slots'.

Classify (Where both object and classifier already
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Existing
Object

exist, separately.)
On a diagram, right-click on the object
and select the 'Advanced | Instance
Classifier' option. (Or click on the object
and press Ctrl+L.) You can also click on
the object in the Browser window and
press Ctrl+L.
The 'Select Classifier' dialog displays.
Browse or search through the model for
the classifier element to associate with
the object, and double-click on it.
The object is associated with the
classifier and displays the naming
convention as described.

Classify new
or existing
object from
classifier
Associations

A classifier is usually a component of a
model structure, and can have
Associations with other classifiers.
If an object is classified, any other objects
related to that object can be classified by
the related elements of the classifier. For
example:

Class A is associated with Class B and·

Class C
Object 1 is classified by Class A·

If you create an Association between·

Object 1 and Object 2, the 'Choose an
Association Connector' dialog offers
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the option of setting either Class B or
Class C as the classifier of Object 2
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Add Property Slots to Instance

A classifier element can have a range of characteristics that
are automatically applied to an instance based on that
classifier. You can also, optionally, add any Property
elements (Ports, Parts and Expose Interfaces) on the
classifier to the instance, as 'slots' for the definition of each
Property. This provides some flexibility in creating
variations of the design defined in the classifier. For
example, models of car might have doors of the same
specification, but in a two-door or four-door configuration.

Add classifier Property elements to an
instance

Ste
p

Action

1 Create and save the classifier element with the
configuration of Property elements you need.

2 Create or assign an instance of the classifier on your
work diagram.

3 Right-click on the instance and select the 'Features'
option.
The Features window displays at the 'Parts /
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Properties' tab, listing the Property elements defined
for the classifier.

4 Select the checkbox against each Property to
reproduce in the instance element, and click on the
Close button.
Each Property element is shown in the top left of the
instance; drag the elements into the arrangement you
want. The Property element name within the instance
is prefixed with a / character.
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Classify Object Via Classifier
Associations

When building an instance model from a predefined Class
model, Enterprise Architect can assist in setting classifiers
and role names for objects involved in a relationship. For
example, if ClassA has association relationships with
ClassB and ClassC, you can create an instance of ClassA
(ObjectA), then draw an association to a new unclassified
object and have the choice of selecting ClassB or ClassC as
the classifiers of the new object.

Access

Where you have an existing association between a classified
object and an unclassified object, use either method outlined
here, to display the 'Choose an Association' dialog.
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Context
Menu

Right-click on existing Association |
Advanced | Instance Classifier

Keyboard
Shortcuts

Select the existing Association : Ctrl+L

Choose an Association Connector dialog

Field/Button Action

Classifier
Name

Displays the name (if defined) of each
Association connector issuing from the
source object's classifier.
If the connector has no name, the value
<anonymous> displays.

Association Represents the source and target classifier
elements in each Association connector
issuing from the source object's classifier.
If you select one of these, the target
classifier becomes the classifier for the
target object element.
Select <none> if you want to create the
Association, but not based on the
classifier relationships.
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<Source
Object
Name> Role

Identifies any Roles defined in the
Association for the source classifier
element, according to the source role
multiplicity setting; if you select one of
these roles, this will become the specific
Role for the source object, as shown on
the name of the element on the diagram.
If the multiplicity is not set, or the upper
bound is * (asterisk), just the role name
displays in the list.

<Target
Object
Name> Role

Identifies any Roles defined in the
Association for the target classifier,
according to the target role multiplicity
setting; if you select one of these roles, it
will become the specific Role for the
target object as shown on the name of the
element in the diagram (and on the
'Binding' page of the Association
connector 'Properties' dialog).
If the multiplicity is not set, or the upper
bound is * (asterisk), just the role name
displays in the list.

OK Click on the Association and source and
target roles, then click on this button to:

Create the Association between the two·

objects based on the relationship
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between the two classifiers, and
Make the target classifier the classifier·

for the target object
If you selected the <none> entry, a simple
Association is created and the target
object is unclassified.

Cancel Cancel the dialog without changing any
classifier settings.

Notes

When creating a new association or object, the 'Properties'·

dialog might appear before the 'Choose an Association
Connector' dialog; complete any 'Properties' fields as
required, and click on the OK button
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Attributes

Attributes define the properties or internal data elements of
an element. Not all element types support attributes, and
others have restrictions; for example, attributes of Interfaces
must have Public scope. In the Browser window, elements
with attributes (typically Classes) have their attributes listed
under the element name, each preceded by a blue box ( ).
When depicted in diagrams, the attributes are listed in the
first properties compartment of the element, as shown in this
Customer Class example.

Attributes themselves have several important characteristics,
such as type, visibility (scope), derivation and notes.

Access

Ribbon Design > Element > Features > Attributes

(c) Sparx Systems 2022 Page  640 of 1974



Modeling Fundamentals 3 October, 2022

(Features window)
(Click on an attribute) Design > Element
> Features > Features Dialog ('Attribute'
dialog)

Context
Menu

These options display the 'Attribute'
dialog

Right-click on the attribute in the·

'Project' tab of the Browser window |
Properties | Properties
Right-click on the attribute in the·

'Details' tab of the Inspector window |
Edit <attribute name>
Right-click on the attribute in a·

diagram | View Properties
These options display the Features
window:

Right-click element in Browser·

window or diagram | Features |
Attributes or
Right-click attribute in Browser·

window | Properties | All Features

Keyboard
Shortcuts

These options display the Features
window when you click on an element in
the Browser window or a diagram:

F9  or·

Ctrl+5·
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This option displays the Features window
when you click on an attribute in the
Browser window or a diagram:

Ctrl+5·

This option displays the 'Attribute' dialog
when you click on an attribute in the
Browser window or a diagram:

F9·

Other In the 'Details' tab of the Inspector·

window, double-click on an attribute to
display the 'Attribute' dialog
In the 'Project' tab of the Browser·

window, double-click on an attribute to
display the parent element on a
diagram

Maintain Attributes

Action Detail

Create and
Modify
Attributes

On the 'Attributes' page of the Features
window, you can create and modify
attributes.
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Move and
Copy
Attributes

You can copy or move existing attributes
between elements, if the target element
also supports attributes.

Define
Properties

You can create property implementations
specific to your coding languages for
each attribute.

Identify
Inherited
Attributes

The attributes of an element can be
inherited from one or more successive
parent elements in the model. On a
diagram, you can show which attributes
are inherited from which 'owning'
element in the hierarchy.

Notes

Attributes, with Operations, Receptions, Interaction Points·

and Connection Points, are collectively referred to as
Features of an element

If you are creating many attributes, go to the·

'Attribute/Operations' page of the 'Preferences' dialog
('Start > Appearance > Preferences > Preferences >
Source Code Engineering > Attribute/Operations') and
de-select the 'After save, re-select edited item' checkbox;
now, when you create an attribute and click on the Save
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button, the 'Attribute' page fields clear ready for you to
enter the details of the next attribute - this helps you when
you want to create attributes quickly and might not
necessarily want to fully define each one as you create it

If the parent element provides source or target roles for a·

connector, the connector can be attached to a specific
attribute (as a feature)

An alternative method of creating relationships between·

elements and attributes is to drag an attribute onto an
Activity diagram, which generates an Object element
named after the attribute; you then create relationships to
and from this Object element
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Create and Manage Attributes

The Features window presents a tab displaying the attributes
that you create in an element. When you display the
'Attributes' tab, you can create and manage attributes using
the page itself and a context menu of options.

Access

Ribbon Start > Design > Features > Attributes
(Features window)
(Click on an attribute) Design > Element
> Features > Features Dialog ('Attributes'
dialog)

Context
Menu

These options display the 'Attribute'
dialog

Right-click on the attribute in the·

Browser window | Properties |
Properties
Right-click on the attribute in a·

diagram | View Properties
These options display the Features
window:

Right-click element in Browser·

window or diagram | Features |
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Attributes or
Right-click attribute in Browser·

window | Properties | All Features

Keyboard
Shortcuts

These options display the Features
window when you click on an element in
the Browser window or a diagram:

F9  or·

Ctrl+5·

This option displays the Features window
when you click on an attribute in the
Browser window or a diagram:

Ctrl+5·

This option displays the 'Attribute' dialog
when you click on an attribute in the
Browser window or a diagram:

F9·

Other In the Browser window, double-click on
an attribute to display the parent element
on a diagram.

Create a New Attribute

Either:
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Click on the New Attribute... text and type a name for the·

new attribute

Right-click on the panel and select 'Add New' (or press·

Ctrl+N) or

Right-click on an existing attribute and select 'Copy as·

New' (or press Ctrl+C), provide a new name for the
attribute and click on the OK button

A new attribute entry displays in the list.

Edit Attribute Properties

Option Action

Name If you want to change the attribute name,
click on the field and overtype it with the
new name.

Type Defaults to 'int'. To change this, overtype
the field or click on the drop-down arrow
and click on:

The required type or·

'<none>' for no type, or·

'Select Type' and browse for the·

appropriate attribute classifier (you can
add a new one if there are no classifiers
that suit)
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The type can be defined by the code
language (data type) or by a classifier
element; when you click on the
drop-down arrow, the set of values in the
list provides the data types, and the
'Select Type' browser provides the
possible classifiers.
To add new code language data types that
can be displayed in this list, see the Data
Types topic.

Scope Define the attribute as Public, Protected,
Private or Package; if necessary, click on
the drop-down arrow and select a
different scope.

Stereotype (Optional) Define one or more
stereotypes for the attribute; either:

Type a stereotype name, or·

Click on the  button and select the·

stereotype from the 'Stereotypes for
<object name>' dialog

Alias (Optional) Type an alternative name or
reference for the attribute.

Initial Value (Optional) Either:
Type in a simple initial value, or·
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Click on the  button and construct a·

more complex value on the Default
Initial Value window

Context Menu options

Right-click on the panel, or on a specific attribute name.

Option Action

Add New Add a new attribute to the list, with
default values in the dialog fields.
Shortcut: Ctrl+N

Copy as New Copy a selected attribute as a new
attribute. Provide a new name for the
attribute and click on the OK button.
Shortcut: Ctrl+C

Properties
Window

Display the Properties window, showing
the details for the selected attribute and
enabling you to add more-advanced
properties and Constraints.

Qualifiers Add Qualifiers to the selected attribute.
The 'Qualifiers' dialog displays.
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Restore Sort
Order

If you have used the column header
arrows to reorganize the sequence in
which the attributes are displayed, click
on this option to redisplay them in the
default sequence (alphabetical by name).

Move up Move the selected attribute one row up
the list.
Shortcut: Ctrl+Up Arrow

Move down Move the selected attribute one row down
the list.
Shortcut: Ctrl+Down Arrow

Field
Chooser

Display the 'Field Chooser' dialog, which
contains any column headings not
currently applied to the page.
Drag a column heading from the 'Field
Chooser' into the preferred position in the
row of column headings. You can also
drag the column headings into a different
sequence.
To return a column heading to the 'Field
Chooser', drag it out of the heading row.

Enable
Group Box

Show or hide the Group Box, in which
you reorganize the list sequence of the
attributes according to one or more
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characteristics.

Toggle Filter
Bar

Show or hide the Filter Bar, in which you
type text strings that the data in the
corresponding column must match in
order to be listed.

Delete Immediately delete the selected attribute
from the element.
Shortcut: Ctrl+Del

Notes

By default, the attributes are listed in alphabetical order;·

before being able to change this sequence with the 'Move
Up' and 'Move Down' options, you must deselect the 'Sort
Features Alphabetically' checkbox on the 'Objects' page of
the 'Preferences' dialog ('Start > Appearance >
Preferences > Preferences > Objects') - the system
prompts you to allow it to make this change for you

You can add Notes on the attribute through the Notes·

window, which has focus on the attribute while it is
selected in the Features window; similarly, you can assign
Tagged Values to the attribute through the 'Tags' tab of
the Properties window
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Attribute Tagged Values

Tagged Values are a convenient means of extending the
properties a model element supports, including attributes.
Such extensions can then be used by code generators and
other utilities to transform UML models into other forms.

Access

Ribbon Design > Element > Properties > General
> Tagged Valuies, click on an attribute
Start > All Windows > Properties >
Tagged Values, click on an attribute

Keyboard
Shortcuts

Ctrl+2 > Tags

Add a Tagged Value to an attribute

Ste
p

Action

1 Click on the  button in the window toolbar.
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The 'Tagged Value' dialog displays.

2 In the 'Tag' field, type the tag name or click on the
drop-down arrow and select a defined tag.

3 In the 'Value' field type a specific value for the tag.
(For some types of Tagged Value, the 'Value' field is
grayed out. In this case, continue to step 4 and enter
the value against the tag name in the 'Tags' tab of the
Properties window or 'Properties' dialog.)

4 Click on the OK button to confirm the operation.
The tag name and value are displayed under the
attribute name in the 'Tags' tab of the Properties
window.

Notes

Tagged Values are supported for attributes, operations,·

objects and connectors

You can define custom tags by creating a Custom Tagged·

Value Type
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Display Inherited Attributes

When displaying a Class with attributes in a diagram, you
can also show the inherited attributes from all parents in the
element's type hierarchy (that is, the element's ancestors).

Access

Context
Menu

Right-click element on diagram |
Compartment Visibility

Keyboard
Shortcuts

Ctrl+Shift+Y

Enable Display of Inherited Attributes

In the 'Show Element Compartments' panel, select the
'Inherited Attributes' checkbox.

You can also override an inherited attribute's initial value,
selecting the 'Features | Override Attribute Initializers'
option to display the 'Override Attribute Initializers' dialog.

When you view the inherited attributes, the system merges
the list of attributes from all ancestors and applies the
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attribute initializers, so that the final child Class displays the
correct attribute set and initial values.

Option Action

Variable Click on the drop-down arrow and select
the variable name.

Operator Click on the drop-down arrow and select
the appropriate operator.

Value Type a new initial value.

Note Type in any comments or notes
concerning the variable.

OK Click on this button to save the variable
and close the dialog.

Example
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Create Object From Attribute

If you drag an attribute from the Browser window onto an
Activity diagram, the attribute generates an Object element
of the same name.

This is very useful for creating connectors between elements
and specific attributes. For example, a Class element of
stereotype <<table>> defines its fields as attributes; Action
elements that define the use or update of those fields can
then be linked to the appropriate table fields via the attribute
Object elements.

Example

In this example diagram, the invoice Object was generated
by dragging the invoice attribute from the Billing Details
Class in the Browser window onto the diagram.

The user then created Object Flow relationships between the
Receive Invoice Action element and the invoice element,
and between the invoice element and the Make Payment
Action element.
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Notes

You can also create this relationship more directly by·

linking an attribute in an element to another element, or
linking two attributes in different elements
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Element Property Displays

Enterprise Architect provides a number of ways to define,
assign and review the properties and features of elements,
each offering different facilities more suited to one aspect or
another of model development.

User interface screens for accessing element
properties

Screen

'Properties' dialog - the element 'Properties' dialog
defines both the general properties of an element such as
its name, phase, version and status, and properties specific
to the element type such as Table columns, Activity
behaviors and Chart format.

Element Properties Window - this window displays the
general properties of the currently-selected element in a
single view. You can dock the window within the
Enterprise Architect workspace or have it free-floating
within or outside the workspace.

Details tab of the Inspector window - the 'Details' tab
presents all of the existing add-on properties of an
element in a folder structure, through which you can
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create further property objects, operate on them, and
delete them.

Responsibility window - this window provides a
convenient method of quickly adding, viewing, editing
and deleting rules applied to an element. The window
shows details of the requirements, constraints, scenarios
and files that impose such rules or restrictions on the
element.

'Select <Item>' dialog - This dialog is a multi-purpose
browser and search tool for locating model items such as
Classifier elements, properties, attributes and behaviors.
The '<Item>' in the dialog title changes to represent the
type of object the original operation is working on.
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Properties Dialog

The element 'Properties' dialog helps you to define and
review a wide range of properties of a selected element. For
a Class, these properties include:

General settings, such as name, notes, alias, stereotype (if·

any), version, scope, dates created and modified, and
status

Details such as cardinality, concurrency and features·

(attributes and operations) owned

Advanced, or custom, properties that you can edit·

Tagged Values assigned to the element·

Technology-specific Tagged Values grouped on a·

separate tab

Requirements associated with the element, both internal·

(responsibilities) and external

Constraints on the element's actions·

Scenarios under which the element operates·

External files associated with the element·

Links (relationships or connectors) in which the element·

is the source or target

These properties are presented on either a main tab of the
'Properties' dialog or a secondary tab in the panel at the right
of the dialog.

Access
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On a diagram or in the Browser window, select an element
and:

Ribbon Design > Element > Editors > Properties
Dialog

Context
Menu

Right-click on element | Properties |
Properties

Keyboard
Shortcuts

Alt+Enter
Shift+Enter

Other On the Properties window for an element,
click on the  icon

Buttons

On any tab of the 'Properties' dialog, at any time, you can
click on the buttons at the foot of the dialog and save or
clear your changes.

Button Action

OK Click on this button to save your changes
and close the 'Properties' dialog.
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Cancel Click on this button to abort your changes
and close the 'Properties' dialog.

Apply Click on this button to save your changes
and keep the 'Properties' dialog open, so
that you can continue working.
It is a good idea to click on this button
when you have finished working on a tab
and are just about to move on to another
tab.

Help Click on this button to display the Help
topic for the tab you are currently
working on.

Notes

There are several variations of the 'Properties' dialog:·

     -  The dialog for a Table or Stored Procedure element
has slight differences on the 'General' tab, and
         a 'Table Details' (or 'Stored Procedure Details') tab
instead of a 'Details' tab
     -  The dialog for a Class element of a stereotype other
than Table is as shown in the General Settings
         topic
     -  The dialog for an element of any type other than
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Class does not have a 'Details' tab
     -  System Boundaries have a single 'Properties' tab on
which you define the element appearance
     -  The 'Properties' dialog for Wireframe elements
automatically opens to either a main Wireframe' tab
         on which you can edit the element rendering
directly, or a second-level Wireframing Tagged Values'
         tab (from the General tab) if you define the element
rendering by editing the XML for the
         properties of that element type

In all cases, the 'Properties' dialog is expandable; you can·

enlarge it for adding longer entries and clearer reading of
the text field values

The 'Responsibilities' tabs - 'Requirements', 'Constraints',·

'Scenarios' and 'Files' - are the detailed definition screens
for the Responsibility window and can be accessed from it

The 'Tags' tab of the 'Properties' dialog provides facilities·

to create and edit Tagged Values on the object

If Tagged Values have been derived from a stereotyped·

element in a Profile, they are listed on a separate tab
having the Profile name

An Object element will show the properties of its·

classifier, some of which are changed to represent this
specific instance of the classifier
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General Settings

The 'General' tab of the element 'Properties' dialog provides
the name of the element and any notes that are recorded on
it. To the right of the tab are subordinate tabs, the number
and type of which depend on the type of element selected.
For a Class element, those tabs are:

'Main' - defining additional identification and status·

properties, as described here

'Details' - defining the cardinality, concurrency and·

features (attributes and operations) of the element

'Advanced' - defining any high-level properties of the·

element that might exist; the properties are a function of
the element type, and you do not add or remove them but
just reset their values

'Tags' - defines the Tagged Values of the element; any·

Technology-specific Tagged Values are grouped on a
separate tab

Access

On a diagram or in the Browser window, select an element
and:

Ribbon Design > Element > Editors > Properties
Dialog
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Context
Menu

Right-click on the element and select the
'Properties | Properties' option

Keyboard
Shortcuts

Shift+Enter
Alt+Enter

General Options & Main tab

Different types of element might have these fields in
different sequences.

Option Action

Name This field displays the element's name
which, for a new element, defaults to
either:

<element type><number of elements of·

this type already in the Package> (for
example, Class3) or
A name conforming to the·

auto-naming/numbering convention
you have defined

If necessary, overtype the default name
with a different name.

Notes Type in or edit any notes text associated
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with the element, applying any notes
facilities required such as hyperlinks or
Glossary terms.
You can format the notes text using the
Notes toolbar at the top of the field.

Stereotype (Optional) Type the name of a stereotype
for the element, or click on the  button
to the right of the field and use the
'Stereotypes for <object name>' dialog to
select one.

Alias (Optional, for elements other than an
Object element) Type in an alias or
alternative display name for the element.

Status Click on the drop-down arrow and select
the appropriate element management
status (such as Approved or Proposed).

Type For a Requirement element, defines the
requirement type. You can change the
type by clicking on the drop-down arrow
and selecting a new type from the list.

Role (Optional, for an Object element) Type in
the role played by the object represented
by the element.
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Keywords (Optional) Type in any significant terms
that the element might be associated with
and that might be filtered on to identify
the element in Use Case Metrics and
Searches.

Author This field defaults to the user ID of the
person who created the element. If
necessary, you can type in a different user
ID, or click on the drop-down arrow and
select one.

Complexity Click on the drop-down arrow and select
the appropriate development complexity
(used for project estimation). You
normally select from three levels:

Easy·

Medium·

Difficult·

You can change your user defaults to add
'Extreme' and 'Unknown' to this list of
options.

Difficulty An estimate of the difficulty in meeting
the Requirement, Feature, Change or
Issue defined by the element; select from:

Low·

Medium·
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High·

Priority The relative importance of meeting this
Requirement, Change, Issue or Feature
compared to other elements of the same
type; select from:

Low·

Medium·

High·

Language Defaults to the programming language
defined for the model (in the 'Default
Language for Code Generation' field on
the 'Source Code Engineering' page of the
'Preferences' dialog).
If this element is required to have a
different language, click on the
drop-down arrow and select it. If the
element is not language-specific, select
'<none>'.

Version Defaults to the value defined in the
'Object Display' options, for the version
of the current element.
If necessary, type over the field with a
different version number or code.

Phase Defaults to the value defined in the

(c) Sparx Systems 2022 Page  670 of 1974



Modeling Fundamentals 3 October, 2022

'Object Display' options, for the phase
this element is to be implemented in (for
example: 1, 1.1, 2.0, ...).
If necessary, type over the field with a
different phase number or code.

Package Identifies the parent Package of the
selected element.

Created Displays the date and time the element
was created.

Modified Displays the date and time the element
was most recently modified.
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Details

The 'Details' tab of a Class element 'Properties' dialog helps
you to define the structural and processing details for the
selected element, and provides direct access to the Features
window for defining attributes and operations in the
element.

Access

On a diagram or in the Browser window, select an element
and:

Ribbon Design > Element > Editors > Properties
Dialog > General > Details

Keyboard
Shortcuts

Alt+Enter > General > Details

Other Double-click on element : General >
Details

Set element details
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Option Action

Persistence Click on the drop-down arrow and select
the appropriate value (blank, persistent or
transient).

Multiplicity Click on the drop-down arrow and select
the number of instances of the element
that can exist - the value displays on the
element in a diagram, in the Name
compartment.
The format of the options in the selection
list is defined in the 'Cardinality' tab of
the 'UML Types' dialog.

Scope Click on the drop-down arrow and select
the element's scope ('Public', 'Private',
'Protected', 'Package').

Abstract Select the checkbox to identify the
element as being abstract.

Is Root Select the checkbox to identify the
element as being a root element that
cannot be descended from another
element.

Is Leaf Select the checkbox to identify the
element as being final, so it cannot be a
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parent for other elements.

Is
Specification

Select the checkbox to identify the
element as being a specification.

Is Active Select the checkbox to identify the
element as being an Active Class.

Concurrency Select the appropriate radio button to
identify how concurrent Activities should
be processed: Sequentially, Guarded,
Active or Synchronous.

Collection
Classes

Click on this button to define the
Collection Classes (for generating code
from Association relationships) that apply
to this Class only, as the source in an
Association relationship where the target
role has a multiplicity of 1 or more.
This setting overrides the default for the
programming language of the Class, set
in the 'Preferences' dialog.
The 'Collection Classes for Association
Roles' dialog displays.

Attributes Click on this button to define the
attributes for the Class.
The Features window displays, showing
the 'Attributes' tab.
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Operations Click on this button to define the
operations for the Class.
The Features window displays, showing
the 'Operations' tab.

Classifier
Behavior

(For a Class, SysML Block or SysML
Internal Block element, this field is
enabled if the element has a child
Interaction, StateMachine or Activity
element.) Click on the  icon and select
the child element, to indicate that the
execution of the element and its diagram
define the behavior of the classifier. On
the element on a diagram, note that the
classifier behavior is indicated by its own
compartment of the element.

Notes

When launched from an MDG Technology, the Attributes·

button and Operations button are not available
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Advanced Properties

The 'Advanced' tab displays the advanced properties of the
element (where they exist). You can reset the values of these
properties.

Access

On a diagram or in the Browser window, select an element
and:

Ribbon Design > Element > Editors > Properties
Dialog > General > Advanced

Keyboard
Shortcuts

Alt+Enter > General > Advanced

Other Double-click on element : General >
Advanced

Set a value for an advanced (or custom)
property

Ste Action
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p

1 Click on the data field to the right of the property
name.

2 Depending on the property, either:
Type the value in free text·

Click on the drop-down arrow and select the value·

from the list, or
Click on the  button and search for the required·

value

3 Click on the Apply button.
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Links

The 'Links' tab of the element 'Properties' dialog provides a
list of all relationships that the current element is a partner
in.

Access

On a diagram or in the Browser window, select an element
and:

Ribbon Design > Element > Editors > Properties
Dialog > Links

Keyboard
Shortcuts

Alt+Enter > Links
Shift+Alt+L

Context
Menu

Right-click on the element > Properties >
Special Action

Links Facilities

Facility Detail
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Relationship
Features

The 'Relationships' panel lists the
relationships this element has, showing
the:

Elements that this element is related to·

Stereotype (if any) of each related·

element
Type of each related element·

Type of each connection or relationship·

Stereotype (if any) of the connector·

Relationship
Editing

On the 'Relationships' panel you can
right-click on a relationship to display the
context menu and select to perform these
operations:

Display the 'Properties' dialog for a·

relationship - click on the 'Relationship
Properties' option
Highlight the related element in the·

Browser window - click on the 'Locate
Related Element' option
Delete the relationship from the model·

and all diagrams - click on the 'Delete
relationship' option; when the system
prompts you to confirm the deletion,
click on the Yes button to do so

If you have selected the element from an
open diagram, another pair of context
menu operations are supported:
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Hide the relationship on the open·

diagram - click on the 'Hide Relation'
option
Show a relationship that is hidden on·

the open diagram - click on the 'Show
Relation' option
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The Features Window

The Features window is a versatile and seamless tool for
creating and editing the features of the selected element. The
window has a number of tabs that help you to view, create,
delete and manage:

Attributes·

Operations and, for State elements, operation behaviors·

Reception elements·

On a State element, Internal Triggers·

Structural elements, such as the Parts and Properties·

added to elements

Edge-mounted elements (Interaction Points) such as·

ActionPins and Ports that form the primary interaction
points of complex, composite elements

Entry Points and Exit Points (Connection Points) on a·

State element

The Features window can be used in combination with the
Properties window and Notes window to define some or all
of the properties of a feature and, depending on the parent
element type, a range of other windows such as the 'Details'
tab of the Inspector window and the Responsibility window.
All these windows automatically refresh to show the
information for the object you have just clicked on, and you
can flow between them without opening and closing them.
You can very quickly define a range of properties, features
and characteristics for an element, and equally quickly work
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through a number of elements to define a structure in the
model.

Parts, Properties, Interaction Points and Connection Points
are maintained in the same way and are therefore all
documented as Structural elements.

Access

Ribbon Start > Application > Design > Details >
Features
Design > Element > Editors > Features >
Features

Context
Menu

Right-click on object > Features > All
Features

Keyboard
Shortcuts

Ctrl+5, F9 (Attributes), F10 (Operations)
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Responsibilities

The Responsibility window provides a convenient method
of quickly identifying, creating and deleting rules applied to
an element. The window shows the name and main
properties of the entities that impose such rules or
restrictions on the element, namely the element's:

Internal and external requirements·

Internal constraints (not external Constraint notes)·

Scenarios·

Files·

Each entity type is listed on a separate tab of the window.

The Responsibility window is typically used to examine Use
Case and Test Case elements, and any other elements that
realize an internal Requirement.

Access

Select the element in the Browser window or diagram and
select one of these options to display the Responsibility
window:

Ribbon Design > Element > Properties >
Responsibilities > <entity type>
Start > All Windows > Properties >
Responsibilities > Responsibilities
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Context
Menu

In the Browser window or on a diagram:
Right-click on the required element |
Properties | Responsibilities

Keyboard
Shortcuts

Ctrl+4 > <entity type>
Alt+1 | Responsibilities
Alt+5 | Responsibilities

The Requirements Tab

On the 'Requirements' tab you initially create the internal
requirements of the selected element. If an internal
requirement later proves to have broader scope, you can
select a context menu option to convert it to an external
Requirement element.

To add a requirement to the element, overtype the Add
Requirement text with the name of the requirement, and then
tab across the 'Status' and 'Priority' fields. These fields
immediately default to 'Proposed' and 'Medium'; if you want
to change either value immediately, click on the drop-down
arrow at the right of the field and select the required value.

If you right-click on an internal requirement name, a context
menu displays providing these options:

Add New - to open the 'Requirements' page of the·

element's 'Properties' dialog, where you can define the
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requirement

Modify Selected - to again open the 'Requirements' page·

of the element's 'Properties' dialog, where you can add or
change the details of the requirement

Move External - to display the 'Find Package' dialog, on·

which you locate a Package to hold the new external
Requirement element

Delete - to delete the requirement from the element; a·

prompt displays to confirm the deletion

If, however, you click on an external Requirement name,
only two options are enabled, to locate the element either in
the Browser window or in diagrams.

The Constraints Tab

On the 'Constraints' tab you can create the constraints of the
selected element and set them in a required sequence.

To add a constraint to the element, overtype the Add
Constraint text with the name of the constraint, and then tab
across the 'Type and 'Status' fields. These fields immediately
default to 'Invariant' and 'Approved'; if you want to change
either value immediately, click on the drop-down arrow at
the right of the field and select the required value.

If you right-click on a constraint name, a context menu
displays providing these options:

Add New - to open the 'Constraints' page of the element's·

'Properties' dialog, where you can define the constraint
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Modify Selected - to again open the 'Constraints' page of·

the element's 'Properties' dialog, where you can add or
change the details of the constraint

Move Up and Move Down - to move the selected·

constraint into a different point in the list of constraints

Delete - to delete the constraint from the element; a·

prompt displays to confirm the deletion

Moving Requirements and Constraints
between elements

A requirement or constraint you define for one element
might be usefully moved to another if, for example, you are
moving your model through stages in a lifecycle or, indeed,
modeling a lifecycle. It is possible to simply drag the
requirement or constraint from either the appropriate tab of
the Responsibility window or the 'Details' tab of the
Inspector window, onto a different element on a diagram.

From the Browser window, open the diagram containing the
target element, then click on the element from which to
move the requirement or constraint. It is convenient to have
both source and target elements on the same diagram, but it
is possible to select the source element in the Browser
window or on a different open diagram.

It is also convenient to have compartments enabled on the
target element, with the 'requirement ' and/or 'constraints'
compartments selected, so that you can observe the addition
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of the moved item. (Right-click on the element and select
'Compartment Visibility', then select the 'Requirements' and
'Constraints' checkboxes.)

Click on the item that you intend to move, and simply drag
it onto the target element. The item name will display in the
appropriate compartment of that element. What you would
observe might resemble this illustration.

The Scenarios Tab

On the 'Scenarios' tab you can create the scenarios of the
selected element. The first scenario you create here defaults
to the Basic Path, and subsequent scenarios default to
Alternate Paths. You cannot change the path type here, but
if you edit the scenario elsewhere the tab reflects any
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changes you have made.

To add a scenario to the element, overtype the Add Scenario
text with the name of the scenario. When you click off the
name, the 'Type' field is automatically set, and the
'Structured Scenario' field is populated with an Edit button.
To add details of the scenario steps, click on the Edit button
to display the Scenarios view for the element - this is
identical to the 'Scenarios' page of the 'Properties' dialog for
the element.

You can add a description of the scenario using the Notes
window; the 'Notes' field for the scenario is then updated
with that text.

If you right-click on a scenario name, a context menu
displays providing the option to delete the scenario. If you
select this option, a prompt displays to confirm the deletion.

The Files Tab

On the 'Files' tab you can link to one or more files external
to the repository. To link a file to an element, use the 'Add
New' context menu.

If you right-click on a file name, a context menu displays
providing these options:

Add New - to open the 'Files' page of the element's·

'Properties' dialog, where you can create a link to the file

Modify Selected - to again open the 'Files' page of the·

element's 'Properties' dialog, where you can add or change
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the details of the file

Launch File - to  open the file and read its content·

Delete - to delete the file from the element; a prompt·

displays to confirm the deletion
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Requirements

Requirements are of two types:

Internal requirements (responsibilities) and·

External requirements (system requirements, elements·

connected to the current element by - for example -
Realize connectors)

This topic focuses on internal, responsibility requirements,
although once you have created a responsibility you can
convert it to an external Requirement element.

To create the requirements that an element is being designed
to meet, you can use either the 'Requirements' tab of the
Responsibility window or the different 'Requirements' tab of
the element's 'Properties' dialog. The Responsibility window
helps you to sketch out the element's internal requirements,
and you can switch from there to the 'Properties' dialog to
add detail to the requirement. Alternatively, you can create
new internal requirements directly in the 'Properties' dialog.

You can show the internal requirements for an element on a
diagram, using the element 'Compartment Visibility'
function; it is also possible to show inherited requirements
in this way.

Information on using the Responsibility window is provided
in the Responsibilities Help topic. This Requirements topic
goes on to discuss the 'Requirements' tab of the element'
Properties' dialog.
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Access

On a diagram or in the Browser window, select an element
and:

Ribbon Design > Element > Editors >
Requirements | Right-click on a
requirement > Add New  or  Modify
Selected
Design > Element > Editors > Properties
Dialog > Requirements

Context
Menu

Right-click on element | Properties |
Responsibilities > Requirements |
Right-click on a requirement > Add New
or  Modify Selected
Right-click on element | Properties |
Properties > Requirements

Keyboard
Shortcuts

Ctrl+4 > Requirements  (tab of the
Responsibility window)
Shift+Enter > Requirements ('Properties'
dialog)
Shift+Alt+R ('Properties' dialog)
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Define internal Requirements

Field/Button Action

Requirement Type in the name and/or short definition
of the requirement.
This text will display on the element on a
diagram, if the visibility is set to show
internal requirements.

Properties In this panel, click on the value field
against each property, then click on the
drop-down arrow and select the
appropriate setting:

Status - select the current status of the·

requirement
Difficulty - select the value that most·

closely reflects the difficulty of
implementing the current requirement
Priority - select the value that best·

indicates how urgent the requirement is
Stability - select the value that provides·

the best indication of the probability of
the requirement - or understanding of
the requirement - changing; high
stability indicates a low probability of
the requirement changing
Type - select the value that most·
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accurately reflects the type or function
of the requirement; Functional
requirements are things that the system
must do, such as identify franked,
unfranked and total credit for a
dividend; Non-functional requirements
are things that the system must be, such
as reliable or cost effective

The 'Last Updated' field shows the date
on which the requirement was last
changed and saved.

Notes Type in any additional details or
comments on the internal requirement.
You can format the notes text using the
Notes toolbar at the top of the field.

New Click on this button to clear the fields or
set them to default values, so that you can
create a new internal requirement.

Save Click on this button to save your changes
to the currently-selected requirement.

Delete Click on this button to delete the
requirement currently selected in the
'Requirements' list.
A prompt displays to confirm the
deletion.
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Requirements Lists the names of the requirements
associated with the current element.
Both internal and external requirements
are listed on the right of the dialog; the
external elements are identified by the
word 'Yes' in the 'External' column.
If you want to convert an internal
requirement to an external Requirement
element, right-click on the requirement in
the list and select the 'Move External'
menu option.
Right-clicking on an external
Requirement element name provides the
options to locate the element in the
Browser window or in any diagrams that
contain it.
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External Requirements

External Requirements are those Requirement elements that
have been connected to the current element using a
Realization connector. By creating the connector from the
element to the Requirement, you create an expectation that
the element must implement the requirement as part of the
system solution.

In Enterprise Architect, linked Requirement elements are
listed in the Responsibility window and on the
'Requirements' tab of the source element's 'Properties'
dialog, and from there they can be located by right-clicking
on the name and selecting either the 'Find in Project
Browser' option or 'Find in Diagrams' option.

External Requirements are also shown in the 'Links' tab of
the 'Properties' dialog for the element, and again can be
located in the Browser window by right-clicking on the
external Requirement in the list and selecting the 'Locate
Related Element' option.

When an external Requirement is highlighted in the Browser
window or in a diagram, its properties are displayed in the
Properties window (press Ctrl+2 to display this window if it
is not open).
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Constraints

If you need to define the conditions and rules under which
an element operates and exists, you can do this by setting
Constraints on the element, in conjunction with its
responsibilities (internal requirements). Typical constraints
are pre- and post-conditions, which indicate things that must
be true before the element is created or accessed and things
that must be true after the element is destroyed or its action
is complete.

To create the constraints on an element, you can use either
the 'Constraints' tab of the Responsibility window or the
different 'Constraints' tab of the element's 'Properties' dialog.
The Responsibility window helps you to sketch out the
element's constraints, and you can switch from there to the
'Properties' dialog to add detail to the constraint.
Alternatively, you can create new constraints directly in the
'Properties' dialog.

You can show the constraints for an element directly on the
diagram, using the element 'Compartment Visibility'
function; this also reveals any constraints inherited from
parent elements.

Information on using the Responsibility window is provided
in the Responsibilities Help topic. This Constraints topic
goes on to discuss the 'Constraints' tab of the element's
'Properties' dialog.

Access
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On a diagram or in the Browser, select an element and:

Ribbon Design > Element > Editors > Constraints
| Right-click on a constraint > Add New
or  Modify Selected
Design > Element > Editors > Properties
Dialog > Constraints

Context
Menu

Right-click on element | Properties |
Responsibilities > Constraints |
Right-click on a constraint > Add New
or  Modify Selected
Right-click on element | Properties |
Properties > Constraints

Keyboard
Shortcuts

Ctrl+4 > Constraints  (tab of the
Responsibility window)
Shift+Enter > Constraints ('Properties'
dialog)
Shift+Alt+C  ('Properties' dialog)
Alt+9 > Constraints : Shift+Enter

Define constraints for an element
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Option Description
Constraint
(field) Type the name or value of the constraint.

Type
Click on the drop-down arrow and select
the appropriate type (Pre-condition,
Post-condition, Process, OCL or
Invariant).

Status
Click on the drop-down arrow and select
the appropriate status.

Notes
Type in any additional details or
comments on the constraint. You can
format the notes text using the Notes
toolbar at the top of the field.

New
Click on this button to clear the fields
ready to create a new constraint.

Save
Click on this button to save the constraint
data.

Constraint
(panel) This field lists the constraints defined in

the element, by name.

Delete
Click on a constraint in the 'Constraint'
list and click on this button to
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immediately remove the constraint from
the element.

(Up and
Down
Hands)

(If you have two or more constraints in
the element.) Click on a constraint in the
'Constraints' list and click on one of these
buttons to move the constraint one
position up or down in the list.
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Scenarios

A scenario is a real-world sequence of operations that
describes how the process represented by an element works
in real-time. Scenarios can be created for any element -
although they principally apply to Use Cases - to describe
functional behavior, business workflows and end-to-end
business processes.

You define scenarios in detail in the Scenarios View,
creating new scenarios or editing existing scenarios; for
each scenario you can then:

Create a series of steps for each part of the scenario·

Structure the scenario to show how the basic path·

diverges into alternate paths and exception paths

Generate a number of types of diagram from the structure·

Generate the structured scenario from an Activity diagram·

Generate the structured scenario from text on the·

clipboard

You can also create and review scenarios at two
less-detailed levels, using:

The 'Scenarios' tab of the Responsibility window to create·

an empty basic or alternate scenario, or to simply list the
scenarios for an element

The 'Scenarios' tab of the element 'Properties' dialog to·

create scenarios, add, edit and format Notes, change the
path type or change the sequence
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Locating Scenarios

To help you locate the elements for which scenarios have
already been defined, you can run the predefined 'Find
Scenarios' Model Search.

Select the 'Design > Element > Properties > Find Scenarios'
ribbon option to automatically execute the search on the
model, which displays a list of the elements that contain
scenarios.

You can either double-click on an element or right-click on
it and select the 'Properties' option, to display the 'Properties'
dialog for that element. Select the 'Scenarios' tab of the
dialog.

Notes

The Scenarios displays do not prevent you from creating·

more than one basic path for the scenario on an element,
but it would be unusual to define more than one
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Scenarios - Responsibility Window

The 'Scenarios' tab of the Responsibility window is the
simplest of the three screens on which you can create and
manage scenarios for an element.

You use this tab to create a Basic Path scenario or, if a Basic
Path already exists, an Alternate Path scenario. The tab also
simply lists the existing scenarios on an element, and
provides options to edit or delete any of these scenarios.

Access

On a diagram or in the Browser window, click on the
element and:

Ribbon Design > Element > Editors >
Responsibilities > Scenarios

Context
Menu

Right-click on element | Properties |
Responsibilities > Scenarios
Inspector window > Details | Scenarios
(right click) | Scenario List

Keyboard Ctrl+4 > Scenarios
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Shortcuts Alt+5 | Scenarios

Create a Scenario

In the 'Scenario' column, click on the Add Scenario text and
type in a name or title, then click away from the item line.

If this is the first scenario on the element, it is automatically
created as the Basic Path; subsequent scenarios are
automatically created as Alternate paths. You cannot change
these allocations on this tab.

Alternatively, right-click on the Add Scenario text and select
the 'Add New' option. The 'Scenarios' tab of the element
'Properties' dialog opens. See the Scenarios Tab - Properties
Dialog Help topic.

Review Scenarios

Where there are existing scenarios, the 'Scenarios' tab lists
them in the order in which they were created (or in the order
they have been reorganized into on a different screen). You
can see any notes that have been written elsewhere for each
scenario, and the type of each scenario. To display the full
text of the notes, hover the cursor over the 'Notes' field.
Alternatively, if the Notes window is open you can read and
edit the note text there.
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You can edit the scenarios in one of two ways.

Right-click on the scenario line and click on the 'Modify·

Selection' option to display the 'Scenarios' tab of the
Properties window, if you want to:
     -  Put the scenarios in a different sequence
     -  Add or edit Notes text
     -  Change the scenario name and/or path type

Click on the Edit button in the 'Structured Scenario'·

column to display the Scenarios View, if you want to:
     -  Put the scenarios in a different sequence
     -  Change the scenario name and/or path type
     -  Add or delete steps in the scenario, or re-sequence
them
     -  Link the Alternate and Exception paths to specific
steps of the Basic path
     -  Manage the elements that the scenario uses at
various steps
     -  Generate diagrams or Test Cases from the scenario

Delete Scenarios

If you no longer want to keep a scenario for an element,
click on the scenario name and either select the 'Delete'
option or press Ctrl+Delete. A prompt displays to confirm
the deletion.
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Scenarios - Properties Dialog

The 'Scenarios' tab of the element 'Properties' dialog enables
you to create and delete basic definitions of scenarios for the
selected element, add descriptions in the 'Notes' field, and
re-arrange the Basic, Alternate and Exception Scenario
paths in a list.

Access

On a diagram or in the Browser window, click on the
element.
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Ribbon Design > Element > Editors > Properties
Dialog > Scenarios

Context
Menu

Right-click on element | Properties |
Properties > Scenarios
On the 'Scenarios' tab of the
Responsibility window, right-click on
the:

Body of the tab and select the 'Add·

New' option, or
A scenario name and select the 'Modify·

Selected' option

Keyboard
Shortcuts

Alt+5 | Properties Dialog > Scenarios
Shift+Enter > Scenarios
Shift+Alt+S

Other Double-click on the element > Scenarios

Create a Scenario

If the element does not yet have a Basic Path defined, the
'Type' field defaults to 'Basic Path'.

If the element already has a Basic Path (and/or other paths),
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click on the New button; the 'Type' field defaults to
'Alternate'. If appropriate you can click on the drop-down
arrow and select 'Exception' (or, if necessary, 'Basic Path').

Click on the 'Scenario' field and type in an appropriate
scenario name or title.

Click on the large field under the Toolbar and type in any
notes, comments, description or explanation of the scenario
you are creating. You can use the Notes Toolbar and context
menu to format the text and perform other text processing;
see the Notes Help topic.

Click on the Save button; the new scenario is added to the
'Scenarios' panel at the bottom of the dialog.

Edit a Scenario

Click on the name of the scenario in the 'Scenarios' panel;
the details are displayed in the fields in the top of the screen.

You can change the type, name, and/or notes as required.

Note that the Basic Path can have a great deal of structural
specification work attached to it (via the Scenario View),
which will be deleted if the path is changed from Basic to
something else. If you attempt to make this change, a
warning message is displayed.  Always make sure that you
understand the implications of changing the type of, or
deleting, a Basic Path before continuing with the operation.

When you have edited the scenario, click on the Save
button.
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Reorganize Scenarios

If you want to change the sequence of the scenario paths for
the element, check the list in the 'Scenarios' panel and click
on the first scenario to move. Then click on the 'Up Hand'
icon or the 'Down Hand' icon to move the scenario up one
position or down one position in the list. Do the same for
any other scenarios that are not in the right sequence.

Delete Scenarios

If you no longer want to use a particular scenario, click on
the scenario name in the 'Scenarios' panel and click on the
Delete button. The scenario is immediately removed from
the element. You cannot delete the last remaining scenario if
it is the Basic Path.

Add a Specification Structure

If you want to create a scenario specification structure from
the scenarios, click on the Structure Editor button to display
the Scenarios View. This enables you to:

Add or delete steps in the scenario, or re-sequence them·
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Link the Alternate and Exception paths to specific steps of·

the Basic path

Manage the elements that the scenario uses at various·

steps

Generate diagrams or Test Cases from the scenario·

Add constraints or context references·
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Scenarios View

The Scenarios View can be displayed in a number of ways,
such as directly through the 'Element' panel of the Design
ribbon, or through the 'Scenarios' tab on either the element
'Properties' dialog or the Responsibility window. It offers a
wide range of facilities for generating and modifying
scenarios, which you can use to quickly and easily define
the structure, actions and interactions of the scenarios
defined for an element such as a Use Case. These scenarios
can be the main (basic) path, alternate paths or exception
paths.

When you open the Scenarios View it defaults to the basic
path so that if it does not already exist, you can create it.
You can create alternate paths and exception paths by
adding them to steps of the basic path.

Within the Scenarios View you can:

(c) Sparx Systems 2022 Page  710 of 1974



Modeling Fundamentals 3 October, 2022

Construct the scenario step-by step, or·

Import a text file that describes a scenario, or·

Generate a scenario from an Activity diagram that was·

itself generated from a scenario (thus regenerating the
scenario or importing it from another element)

Access

On a diagram or in the Browser window, click on the
element and:

Ribbon Start > Application > Edit >
Responsibilities > Structured Scenarios

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor

Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios

Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
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On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

Next Step

In the 'Scenario' field, type the name of the basic path of the
scenario.

To familiarize yourself with the facilities of the Scenarios
View, start with the Scenarios View Toolbar Help topic.

If you want to:

Construct the scenario step-by step, see the Set Up a·

Scenario Specification Help topic

Complete the scenario based on an imported text file, see·

the Import a Scenario File Help topic

Generate a scenario from an Activity diagram created·

from a scenario, see the Generate Scenario from Activity
Diagram Help topic
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Scenarios View Toolbar

In developing a scenario specification, you can perform a
wide range of operations using the icons on the Scenarios
View toolbar underneath the 'Type' and 'Scenario' fields on
the Scenarios View.

Access

On a diagram or in the Browser window, select an element
and:

Ribbon Start > Application > Edit >
Responsibilities > Structured Scenarios

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor

Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios

Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
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button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

Toolbar options

Icon Action

Click on this icon to save changes to the
scenario specification.

Click on this icon to return to the basic
path specification (if another path
specification is currently displayed).

(Enabled when the basic path is displayed
- you cannot add an alternate path to
another alternate path or to an exception
path.)
Click on this icon to create a branch from
the selected step to an alternate path
scenario; select the path from the
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displayed list. If the appropriate scenario
does not yet exist, double-click on the
new path line and type the scenario name,
then click off the line and back on to it.
Click on the OK button.

An entry for this alternate path displays·

in the 'Entry Points' tab, as step 'a' of
the basic path step it branches from; in
the 'Join' column, click on the
drop-down arrow and select the
number of the step at which action
flows back to the basic path, or select
'End' if the path terminates separately
from the basic path
You cannot join the end of the alternate·

branch to more than one step of the
basic path; if you change the join point
of the branch, any duplicates of that
branch are updated to remain in
synchrony with the join point

(Only enabled when the basic path is
displayed - you cannot add an exception
path to another exception path or an
alternate path.)
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Click on this icon to create a branch from
the selected step to an exception path
scenario - select the path from the
displayed list. If the appropriate scenario
does not yet exist, double-click on the
new path line and type the scenario name,
then click off the line and back on to it.
Click on the OK button.

An entry for this exception path·

displays in the 'Entry Points' tab, as
step 'a' of the basic path step it
branches from; in the 'Join' column,
click on the drop-down arrow and
select the number of the step at which
action flows back to the basic path, or
select 'End' if the path terminates
separately from the basic path
You cannot join the end of the·

exception branch to more than one step
of the basic path; if you change the join
point of the branch, any duplicates of
that branch are updated to remain in
synchrony with the join point

Click on this icon to display the 'Manage
Uses Context List' dialog, which you use
to set the 'Uses' column entries to linked
context reference lists.
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Click on this icon to move the
currently-selected step one place up
(including any new step ... line).

Click on this icon to move the
currently-selected step one place down
(including any new step ... line).

Click on this icon to display a list of
diagrams that you can generate from the
scenario; click on the type of diagram
that you want to generate.

Click on this icon to display a list of Test
Suites and Test Cases you can generate,
based on this Use Case scenario. Click on
the test structure you want to generate.

Click on this icon to delete the selected
step from the scenario.

Click on this icon to display the Help
topic for this tab.
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Scenarios View Item Context Menu

You can perform a wide range of operations in creating and
managing your scenarios, using the Scenarios View item
context menu.

Access

On a diagram or in the Browser window, select an element
and use one of these methods to display the Scenarios View.
Then right-click on an item in the Step/Action list.

Ribbon Start > Application > Edit >
Responsibilities > Structured Scenarios

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor

Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios

Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
button against a scenario (see the
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Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

Item menu options

Option Action

Create
Structure
From
Clipboard
Text

Click on this option to display two
sub-options to generate a set of steps
from a text description or list captured on
the clipboard; a new step is generated:

After each carriage return in the·

captured text ('New Line Delimited'),
or
For each sentence in the text; that is,·

after each full stop/space/capital letter
combination ('Sentence Delimited')

If a set of steps is already displayed, it is
overwritten by the generated steps.

Create
Structure

Click on this option to generate a set of
steps from an Activity diagram generated
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From
Generated
Activity
Diagram

from a scenario for a Use Case.
If a set of steps is already displayed, it is
overwritten by the generated steps.

Add
Alternate
Path

Click on this option to create a branch
from the selected step of the basic path to
an alternative path.
Shortcut: Ctrl+Shift+N

Add
Exception
Path

Click on this option to create a branch
from the selected step of the basic path to
an exception path.
Shortcut: Ctrl+Shift+E

Insert Step Click on this option to display three
sub-options, to insert a new step... line:

Above the currently-selected step·

(press Esc to return this new line to the
end of the scenario)
Below the currently-selected step·

(press Esc to return this new line to the
end of the scenario)
At the end of the scenario·

Shortcut: Shift+Insert, Insert or Ctrl+N,
respectively

Set Step As Click on the appropriate option to switch
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'User'
Set Step As
'System'

the entity responsible for performing the
action of the selected step between user
and system.

Link Step to
Use Case

Click on this option to display
sub-options to:

Extend an existing Use Case element·

Include the actions of an existing Use·

Case element, or
Invoke a Use Case as the action of the·

selected step
Selecting the appropriate sub-option
displays the 'Select Use Case' dialog,
which you use to browse for and select
the required Use Case element.
The appropriate 'includes', 'extends' or
'invokes' stereotyped connector is created
between the current element and the
selected Use Case.
For the include and extend actions, any
text in the 'Action' column is overwritten
by the link to the Use Case; for the
invoke action, this link is added to the
end of the 'Action' text:
     (Invokes: <Use Case Name>)

Merge With
Step

Click on this option to merge the selected
step with another.
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A list of the other steps in the scenario
displays; click on the step to merge with
the selected step.

Move After
Step

Click on this option to move the selected
step to another position in the scenario.
A list of the other steps in the scenario
displays; click on the step after which to
position the selected step.

Delete Click on this option to delete the selected
step; any subsequent steps are moved up
one place.
A prompt displays to confirm the
deletion. Click on the Yes button.

Highlight
Glossary
Terms

Select this option to reveal underlines and
other markers on text strings that have a
glossary definition assigned to them.
Select again to clear the 'selected' arrow,
to hide the glossary markers in the text.
This option is available in the Notes
window, 'Notes' and 'Description' fields,
Discuss & Review window tabs, Chat &
Mail window tabs, Scenario Editor,
Specification Manager and 'Mail
Message' dialog. This is a global option -
selecting it or clearing it for one screen
will affect all the other screens.
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Scenarios View Selected Text Context
Menu

In the Scenarios View, further facilities are available to
work with the user-editable text of any part of a
specification step. You access these facilities through the
item selected-text context menu.

Access

On a diagram or in the Browser window, select an element
and use one of these methods to access the Scenarios View.
In the Scenarios View, highlight the text string and
right-click on it.

Ribbon Start > Application > Edit >
Responsibilities > Structured Scenarios

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor

Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios
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Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

Text menu options

Option Action

Create Click on this option to display two
sub-options that you can select to use the
highlighted text as the base for either:

A glossary definition or·

A new element·

Link Step to
Use Case

Click on this option to display
sub-options to define the actions of the
selected step by:

Including the actions of an existing Use·

Case element
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Extending an existing Use Case·

element, or
Invoking a Use Case·

Selecting the appropriate sub-option
displays the 'Select Use Case' dialog,
which you use to browse for and select
the required Use Case element.
The appropriate includes, extends or
invokes stereotyped connector is created
between the current element and the
selected Use Case.
For the include and extend actions, any
text in the 'Action' field is overwritten by
the link to the Use Case; for the invoke
action, this link is added to the end of the
'Action' text:
     (Invokes: <Use Case Name>)

Link to
existing
Element

('Uses' and 'Results' field text only.) Click
on this option to create a Realization or
Dependency relationship to a
Requirement, Feature, Activity, BPMN
Task, DMN Decision or other element
elsewhere in the model.
You select the element and connector
types from submenu options that then
display the 'Select Element' dialog, which
you use to browse for and select the
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required element.

Insert context
reference

Click on this option to add a reference to
an element stored elsewhere in the model,
and create an entry for the element in the
'Context References' tab.
Selecting this option displays the 'Select
Element' dialog, which you use to browse
for and select the required reference
element.

Insert
glossary
definition

Click on this option to insert an existing
glossary term at the cursor position. To
select the term, double-click on it in the
displayed list.
When you select the term it is inserted
into the field as highlighted and
underlined text, which displays the
definition when you move the cursor over
it. If you highlighted part of the original
text, the term overwrites that text.

Manage Uses
Context List

(On highlighted text or a specific cursor
position in the 'Uses' column.)
Click on this option to display the
'Manage Uses Context List' dialog, which
you can use to:

Browse to or type in a context·

reference item

(c) Sparx Systems 2022 Page  727 of 1974



Modeling Fundamentals 3 October, 2022

Re-sort the list with up and down arrow·

keys
Remove an entry from the list·

Enable or disable the 'Uses Context·

List' facility across the model
You can resize the dialog to show the full
details of context reference items.
If you enable the 'Uses Context List'
facility, you do not necessarily have to
use the dialog to add context list items;
you can type or insert an element name
from the 'Context References' tab in the
'Uses' column, and that name is added to
the 'Uses Context List'.
If you disable the 'Uses Context List'
facility, the context list items in the 'Uses'
column are hidden.

Split Step Click on this option to split the selected
step into two consecutive steps.
The option is available only if you
highlight a portion of the text in the
selected field. The new step takes the
highlighted text as its 'Action' text.

Search for
<text>

Click on this option to display the Code
Editor menu of options for locating the
selected text in a number of locations.
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Undo Click on this option to undo any unsaved
changes you have just made in the step.

Cut Select this option to cut the selected text
to the clipboard.

Copy Select this option to copy the selected
text to the clipboard.

Paste Select this option to paste the current
contents of the clipboard.

Delete Select this option to delete the selected
text string.

Select All Select this option to select all text in the
current field.
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Scenarios View Entry Points Context
Menu

In the lower section of the Scenarios view, the 'Entry Points'
tab shows how the basic path, alternate path and exception
path scenarios for the element are organized and
interrelated. If an alternate path or exception path has been
defined but has not yet been added to the basic path, it is not
listed on this tab. You can perform certain operations on the
items of the 'Entry Points' tab, using the context menu.

Access

On a diagram or in the Browser window, select an element
use one of the options here to display the Scenarios View.
Then click on the appropriate entry in the 'Entry Points' tab.

Ribbon Start > Application > Edit >
Responsibilities > Structured Scenarios

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor

Keyboard Alt+2 > Responsibilities > Structured
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Shortcuts Scenarios

Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

Entry Points menu options

Option Action

Edit Path Click on this option to display the steps
of the scenario in the Scenarios view,
with the first step highlighted.

Join with
Step

(Available only if the basic path scenario
is displayed in the Scenarios view, to join
the selected alternate or exception path
with the basic path. Not available to
change the basic path scenario itself.)
Click on this option to highlight the 'Join'
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field and its drop-down arrow. Click on
the drop-down to define or change the
step number at which the alternate or
exception path rejoins the basic path.
Select 'End' if the path does not rejoin the
basic path steps.

Remove
Entry Point

(Available only if the basic path scenario
is displayed in the Scenarios view, to
delete a junction with the basic path. Not
available to delete any part of the basic
path scenario itself.)
Click on this option to delete the
relationship between the selected path
and the basic path, and remove the entry
from the 'Entry Points' tab.
A prompt displays to confirm the
deletion. Click on the Yes button to
delete the junction.

Notes

You can switch focus between the 'Entry Points' tab and·

the sequence of steps by pressing Alt+Q
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Scenarios View Floating Toolbar

Wherever a reference to another element exists in the 'Uses'
column of the Scenarios view (that is, where the text is
highlighted and underlined), if you move the cursor over the
element name a short floating toolbar displays. You can
select the icons on this toolbar to:

Display the element's 'Properties' dialog·

Locate the element in its parent diagram·

Locate the element in the Browser window·
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Import a Scenario File

Scenarios are often created as text descriptions in document
files. These might be simple paragraph descriptions or more
complex constructions with numbered and bulleted lists. As
a valuable time-saving facility, you can use the text of these
files as the source for new structured scenarios for elements
within the model. You might write a draft description in a
text file and then import it into the model as a template for
the structured scenario.

To create a scenario in this way, firstly access the Scenarios
View as described in the Scenarios View Help topic (for
instance, Start > Application > Design > Simple Scenarios).
Then:

In the 'Scenario' field, type a name for the new scenario.1.

Switch to the text or document file, and select and copy2.
the required text. (The text is stored on the clipboard.)

Switch back to the Scenarios View, right-click in the3.
center panel (below the first row of fields) and select the
'Create Structure From Clipboard Text' option. This
displays two sub-options:
     -  'New Line Delimited', which creates a new step after
each carriage return in the captured text
     -  'Sentence Delimited', which creates a new step after
each sentence in the text; that is, after
        each full stop/space combination

Select the appropriate option for your requirements. The4.
Scenarios View organizes the copied text into a series of
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numbered steps, alternating between non-system actor and
system actor roles.

Edit and add to the scenario as suggested by the Set Up5.
Scenario Specification Help topic, and using the facilities
described in the Scenarios View subtopics.

Notes

If the Scenarios View already contains scenario steps·

when you import text from a file, those steps are
overwritten, not merged or appended

By default, the steps begin with a user step (indicated by·

an 'Actor' icon) and alternate between user and system
(indicated by a 'Screen' icon) steps; however, the
responsible entity assigned to a new step might be
different if the new line or sentence contains a keyword -
'User' or 'Actor' for a user step, or 'System' for a system
step - within the first 15 characters of text

Once a step has been saved, you can change the·

responsible entity by either double-clicking on the icon or
right-clicking on the step, and selecting 'Set Step as
'System'' or 'Set Step as 'User'' as required
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Set Up Scenario Specification

You can create a specification for a scenario in one of a
number of ways:

Build the specification yourself, as described here,·

perhaps starting from a scenario created on the 'Scenarios'
tab of either the Responsibility window or the 'Properties'
dialog for the element

Generate a specification from an Activity diagram·

generated itself from a scenario - see the Generate
Scenario From Activity Diagram Help topic

Generate a specification from text held on the clipboard -·

see the Import a Scenario File Help topic

Access

On a diagram or in the Browser window, select an element
and open the Scenario View using one of these methods:

Ribbon Start > Application > Edit >
Responsibilities > Structured Scenarios

Context
Menu

Inspector window > Details | Scenarios
(right click) | New Scenario > Scenario
View
Inspector window > Details | Scenarios |
right-click on existing Scenario |
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Structured Scenario Editor

Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios

Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

Enter the specification basic path

Ste
p

Action

1 In the 'Type' field, click on the drop-down arrow and
select 'Basic Path' (the system will generally default
to this value).
In the 'Scenario' field type the name of the scenario
basic path.
(These fields will be completed already if you have
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selected to work on a scenario created on the
'Scenarios' tab of the Responsibility window or
'Properties' dialog.)

2 In the 'Action' column, overtype the new step text
with the name of the first step or action.

3 Tab to the 'Uses' column and, if appropriate, type the
name of each element used in this step. If the
elements are highlighted in blue and underlined, it
indicates that they are already listed in the 'Context
References' tab.
You can also manage the list of elements as context
references, and add to the list directly; see the Notes.

4 Tab to the 'Results' column and, if appropriate, type
the outcome of completing this step.

5 Tab to the 'State' column and, if appropriate, type the
name of the state into which the step moves the
action.

6 When you move out of the 'Action' column, the next
new step field displays underneath.
Repeat steps 2 to 5 as many times as is necessary.
The Scenarios view should now resemble this:
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7 Click on the  icon in the Scenarios View toolbar.

Notes
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By default, the steps begin with a user step (indicated by·

an 'Actor' icon) and alternate between user and system
(indicated by a 'Screen' icon) steps; however, you can
control the responsible entity assigned to a new step by
typing a keyword within the first 15 characters of the text
in the 'Action' column - either 'User' or 'Actor' for a user
step, or 'System' for a system step
Once a step has been saved, you can change the
responsible entity by either double-clicking on the icon or
right-clicking on the step, and selecting 'Set Step as
'System'' or 'Set Step as 'User'' as required

An entry for the basic path displays in the 'Entry Points'·

tab, as Step 0 with no value in the 'Join' column (the basic
path does not rejoin itself)

The values in the 'Uses', 'Results' and 'State' columns,·

whilst optional, are significant if you want to generate a
diagram from the specification; if you type the name of an
element linked to the current element (and listed in the
'Context References' tab), the element name is highlighted
and underlined

In the 'Uses' column, in edit mode, use the 'Manage Uses·

Context List' context menu option to enable and disable
'Uses' cells as linked element lists as well as text fields,
across the whole model; when the feature is enabled, the
column shows both context-linked elements and
manually-entered text, and when disabled only text entries
are listed (the context-linked entries are hidden and
deactivated, but not deleted - they are re-activated when
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the feature is enabled)

As you develop the scenario, you can move steps to·

different positions in the scenario, and insert new step
lines within the body of the scenario

You can also create constraints on the element that have·

an impact on the scenarios

Repeat this Set Up Scenario Specification procedure for·

each scenario you have created; you can now adapt,
enhance and interrelate the scenario specifications using
the facilities of the Scenarios View:
     -  Scenarios View Toolbar
     -  Item context menu
     -  Selected Text context menu
     -  Entry Points context menu
     -  Floating Toolbar
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Generate Diagrams

When you have created a structured scenario, you can
generate diagrams of any of these types from it:

Activity·

     -  Basic
     -  With ActivityParameter
     -  With Action
     -  With Action Pin

Rule Flow·

State·

Sequence·

Robustness·

Access

On a diagram or in the Browser window, click on the
element and:

Ribbon Start > Application > Edit >
Responsibilities > Structured Scenarios

Context
Menu

Inspector window > Details |Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
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Structured Scenario Editor

Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios

Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

Generate the required diagram

Ste
p

Action

1 Create the scenario structure in the Scenarios view.

2 Click on the  ('Generate Diagram') icon in the
toolbar on the tab.

3 Click on the type of diagram to generate.
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Enterprise Architect generates the diagram and
notifies you that generation is complete. Click on the
OK button and then close the 'Properties' dialog to
review the diagram.
If the diagram being generated already exists under
the selected element, a prompt displays to overwrite
or synchronize with that diagram.
Select the appropriate radio button to:

Overwrite the existing diagram (delete the existing·

diagram and elements, and create a new diagram
and elements) or
Synchronize the elements in the existing diagram·

with the scenario steps (however, Sequence and
Robustness diagrams cannot be synchronized)

Notes

The 'Synchronize elements in existing diagram' option·

enables the 'Preserve Diagram Layout' checkbox, which
you can select to preserve the existing arrangement of
elements and connectors on the diagram; any new
elements are added to the diagram in the default position,
and you manually position them in the diagram as
required; if you do not select the checkbox, the diagram is
recast in the default layout
It is recommended that you uncheck the 'Preserve
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Diagram Layout' checkbox if you are synchronizing
elements with scenario steps:
     -  When new steps have been added or existing steps
have been deleted or moved within the Use
        Case
     -  For the first time in a Use Case that has been
imported from XMI with the 'Strip GUIDs' option
        selected
     -  For the first time in a Use Case that has been copied
and pasted in the Browser window, or
     -  For the first time in a Use Case whose containing
Package has been copied and pasted in the
        Browser window
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Generate Activity Diagram

When you create a scenario on an element, and then
generate an Activity diagram from the scenario, an Activity
is generated as a child of the selected element to act as a
container for the diagram.

Each scenario step is modeled as a CallBehaviorAction·

that will have an Activity behavior

The values of the 'Uses', 'Results' and 'State' columns for·

each step are added as memo Tagged Values of the
corresponding Activity

Access

On a diagram or in the Browser window, click on the
element and select one of these access methods to display
the Scenarios view, then click on  and select 'Activity'.

Ribbon Start > Application > Design > Structured
Scenarios

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor
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Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios

Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

Example
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Diagram Types

There are three additional variations of the Activity diagram
that you can generate.

Diagram Detail

Activity with
ActivityPara
meter

The values of the 'Uses' and 'Results'·

columns are modeled as ActionPins
bound to ActivityParameters
The ActionPins and ActivityParameters·

are added to the Browser window and
not to the diagram
The value of the 'State' column is added·

as a Tagged Value of each Action only
The parent of the Activity will be the·

context element, not the container
element

Activity with
Action

The scenario steps are modeled as·

Actions
The values of the 'Uses', 'Results' and·

'State' columns are added as Tagged
Values of each Action

Activity with
ActionPin

The scenario steps are modeled as·

Actions
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The values of the 'Uses' and 'Results'·

columns are modeled as Input Pins and
Output Pins respectively
ActionPins are added to the Browser·

window and not to the diagram
The value of the 'State' column is added·

as a Tagged Value of each Action
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Generate RuleFlow Diagram

When you create a scenario on an element and then generate
a RuleFlow diagram, a Rule Flow Activity is created as a
child of the selected element, to act as a container for the
diagram.

The scenario steps are modeled as RuleTasks·

The values of the 'Uses', 'Results' and 'State' columns are·

added as Tagged Values of the RuleTasks

Access

On a diagram or in the Browser window, select an element
and use one of these access paths to display the Scenarios
view, then click on  and select 'RuleFlow'.

Ribbon Start > Application > Design > Structured
Scenarios

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor

Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios
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Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)
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Generate StateMachine Diagram

When you create a scenario on an element and then generate
a StateMachine diagram, a StateMachine is created as a
child of the selected element to act as a container for the
diagram.

Each value in the 'State' column is modeled as a State·

The scenario steps become the Transition connectors·

between the States

The values of the 'Uses' and 'Results' columns are added·

as Tagged Values of the Transition connectors

Access

On a diagram or in the Browser window, click on the
element and select one of these access methods to display
the Scenarios view, then click on  and select 'State'.

Ribbon Start > Application > Design > Structured
Scenarios

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor
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Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios

Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

Example
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Generate Sequence Diagram

When you create a scenario on an element and then generate
a Sequence diagram, an Interaction is created as a child of
the selected element to act as a container for the diagrams -
the Basic, Alternate and Exception paths are each modeled
as a separate Sequence diagram under the Interaction. There
are a number of points to note in this process:

All the elements involved in the scenario must be·

identified in the 'Context Reference' tab; that is,
relationships must already exist between the scenario
parent element and the other elements named in the
scenario (the Scenario is a Process, and the Sequence
diagram is showing the flow of messaging between
different Lifelines; for that to happen the lifeline/object
has to be defined, which is achieved using a Context
Reference)

So, each Context Reference element named in a scenario·

step is modeled as a Lifeline

The step itself becomes the Message between an·

originator and its destination(s)

The first Context Reference element in a step is treated as·

the originator

The subsequent Context Reference element(s) become the·

destination(s)

Because the diagram generator acts on element names in·

the step, you must not use the element names as normal
text; for example, in step 1 in the example dialog, the term
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ATM-Card is interpreted as a reference to the ATM
element, and two 'Customer inserts ATM-Card into ATM'
messages are generated for the step (to avoid confusion, in
the diagram the first Message has been deleted)

If you have not selected the 'Show Sequence Numbering'·

checkbox on the 'Diagram Sequence' page of the
'Preferences' dialog, the Message name on the Sequence
diagram is prefixed by the step number, as shown in the
example diagram in this topic; if you have selected the
checkbox, the message sequence number is shown instead
of the step number

The values of the 'Uses', 'Results' and 'State' columns are·

added as Tagged Values of the Message

Access

On a diagram or in the Browser window, click on the
element and select one of these access methods to display
the Scenarios View, then click on  and select 'Sequence'.

Ribbon Start > Application > Edit >
Responsibilities > Structured Scenarios

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor
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Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios

Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

Example
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Generate Robustness Diagram

When you create a scenario on an element and then generate
a Robustness diagram, a Collaboration is created as a child
of the selected element to act as a container for the
Robustness diagram.

Access

On a diagram or in the Browser window, click on the
element and select one of these access methods to display
the Scenarios view, then click on  and select
'Robustness'.

Ribbon Start > Application > Edit >
Responsibilities > Structured Scenarios

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor

Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios

Other On the 'Scenarios' tab of the
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Responsibility window, click on the Edit
button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

Example

Notes

(c) Sparx Systems 2022 Page  763 of 1974



Modeling Fundamentals 3 October, 2022

All the elements involved in the scenario should be·

identified in the 'Context Reference' tab; that is,
relationships must already exist between the scenario
parent element and the other elements named in the
scenario

Any values in the 'Uses', 'Results' and 'State' columns are·

ignored and not represented in the diagram

Each UI element in a step becomes a Boundary element; a·

Dependency relationship is created from this Boundary
element to the UI element (this connector is not shown on
the diagram)

Each Actor referenced in a step is dropped into the·

Robustness diagram as a simple link

Each Class referenced in a step is dropped into the·

Robustness diagram as a simple link, and is given the
stereotype entity

Each step with a System trigger becomes a Controller;·

alternate/exception path Controllers are displayed with a
red background color

Each step with a User trigger becomes the name of the·

Association between Controllers
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Generate Scenario From Activity
Diagram

You can generate a range of diagrams from a scenario in an
element. Conversely, you can also generate a structured
scenario within an element from an Activity diagram that
was previously generated from a scenario, effectively either
regenerating the scenario within the Use Case, or
transferring a scenario into another Use Case.

Access

On a diagram or in the Browser window, click on the
element and select one of these access methods to display
the Scenarios View, then right-click on a space and select
the 'Create Structure From Generated Activity Diagram'
option.

Ribbon Start > Application > Edit >
Responsibilities > Structured Scenarios

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor
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Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios

Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

Generate a scenario from an Activity
diagram

Ste
p

Action

1 On the 'Select an Activity (generated from a
UseCase Scenario) containing the Diagram' dialog,
search for and select the Activity containing the
required diagram.

2 Click on the OK button.
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A prompt displays to remind you that any existing
scenario steps will be deleted.

3 Click on the Yes button.
The system validates the diagram (displaying the
results in the 'Scenario Generation' tab of the System
Output window) and, if the diagram is valid,
generates the scenario steps in the Scenarios view.

Notes

The source Activity diagram must be generated from·

another Use Case scenario

This facility operates on the simple Activity diagrams·

generated from a Use Case, but not on enhanced Activity
diagrams - those generated with ActivityParameters,
Actions and Action Pins
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Generate Test Cases

When you have defined a scenario, you can generate one of
a number of Test Cases from it, including:

A Test Suite - Horizontal Layout·

A Test Suite - Vertical Layout·

An Internal Test Case or·

An External Test Case·

Access

On a diagram or in the Browser window, click on the
element and select one of these access methods to display
the Scenarios view, then click on  and select the TestCase
type.

Ribbon Start > Application > Edit >
Responsibilities > Structured Scenarios

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor

Keyboard Alt+2 > Responsibilities > Structured
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Shortcuts Scenarios

Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

Test Cases Generated

Test Case Detail

Test Suite -
Horizontal
Layout

A Test Case element is created, which
acts as a container for the created Test
Suite diagram and Test Case elements.
The basic path and each alternate and
exception path is represented by a Test
Case element. Each step in the basic,
alternate and exception paths is
represented by a Test element.
A diagram is created under the container
Test Case element, to which the Test
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Case and Test elements are added.
The elements are displayed on the
diagram in a matrix format, with the basic
path and its steps forming the first
column followed by the alternate and
exception paths as subsequent columns.

Note that the name of each created Test
Case and Test element is truncated to 25
characters.

Test Suite -
Vertical
Layout

A Test Case element is created, which
acts as a container for the created
diagram and Test Suite elements.
The basic path and each alternate and
exception path is represented using a Test
Case element. Each step in the basic,
alternate and exception paths is
represented by a Test element.
A diagram is created under the container
Test Case element, to which the Test
Case and Test elements are added.
The elements are displayed on the
diagram in a single column with the basic
path and its steps at the top followed by
each alternate and/or exception path and
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its steps.

Internal Test
Case

A test is generated for the basic path and
each alternate and exception path in the
scenario, and added to the selected
element.
In addition, for each step in the basic,
alternate and exception paths that has a
value in the 'Results' column, a test is
generated and added to the selected
element.
A diagram is created under the selected
element, to which that element and a
Note (showing the element's scenario
specification) is added.
The created tests are displayed in the Test
Scripts compartment of the selected
element on the diagram. Another way to
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view these tests is to click on the element
and display the Test Cases window.
These generated tests are written to the
Scenario Class Type of the Test Cases
window; you can change the tests to
another test-type if required.

External Test
Case

A Test Case element is created, linked to
the selected element using the Trace
connector.
A diagram is created under this Test Case
element, to which the selected element,
the Test Case element and a Note
(showing the element's scenario
specification) is added.
The created tests are displayed in the Test
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Scripts compartment of the Test Case
element on the diagram.
A test case is generated and added to the
Test Case element for the basic path, and
for each alternate and exception path.
In addition, for each step in the basic,
alternate and exception paths that has a
value in the 'Results' column, a test is
generated and added to the Test Case
element.
You can review the tests within the Test
Case element using the Test Cases
window, as for Internal Test Cases.
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Scenarios View - Context References

As you create a structured specification in the Scenarios
View for the element, you can use the 'Context References'
tab to create and display a list of all elements that are either:

Connected to the current element by any connector, on the·

current diagram or another, or

Defined as a cross reference (or custom reference) on the·

current element

Access

On a diagram or in the Browser window, select an element,
then use any of the methods outlined here to display the
'Select Element' dialog. Use the 'Select Element' dialog to
locate and select the required cross reference element or
elements. For each cross reference added through the 'Select
Element' dialog, you can also use context menu options to
delete the entry in the list, or to open the 'Comment' field so
that you can add or edit comment text. Those options are
grayed out for cross references added through the diagram.

For each element in the 'Context References' list, wherever
the name of that element appears in the structured
specification, the name is highlighted and underlined; press
the Ctrl key and click twice on the highlighted name to view
the 'Properties' dialog for that element.
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Ribbon Start > Application > Edit >
Responsibilities > Structured Scenarios >
Context References | Right-click in panel
| Add Context Reference

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario > Context
References | Right-click in panel | Add
Context Reference
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor > Context
References | Right-click in panel | Add
Context Reference

Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios > Context References |
Right-click in panel | Add Context
Reference

Other On the 'Scenarios' tab of the
Responsibility window, click on the Edit
button against a scenario > Context
References | Right-click in panel | Add
Context Reference (see the Scenarios Tab
- Responsibility Window Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button > Context References |
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Right-click in panel | Add Context
Reference (see the Scenarios Tab -
Properties Dialog Help topic)
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Scenarios View - Constraints

The Scenarios View 'Constraints' tab is a simple link to the
'Constraints' tab of the element's 'Properties' dialog. It lists
existing constraints; if you select the toolbar icons or
context menu options to add or edit a constraint, control
switches to the 'Properties' dialog 'Constraints' page.

Access

On a diagram or in the Browser window, click on the
element and select one of these access methods to display
the Scenarios View, then click on the 'Constraints' tab.

Ribbon Start > Application > Edit >
Responsibilities > Structured Scenarios

Context
Menu

Inspector window > Details | Right-click
on 'Scenarios' | New Scenario
Inspector window > Details | Scenarios |
right-click on existing scenario |
Structured Scenario Editor

Keyboard
Shortcuts

Alt+2 > Responsibilities > Structured
Scenarios

Other On the 'Scenarios' tab of the
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Responsibility window, click on the Edit
button against a scenario (see the
Scenarios Tab - Responsibility Window
Help topic)
On the 'Scenarios' tab of the element
'Properties' dialog, click on the Structure
Editor button (see the Scenarios Tab -
Properties Dialog Help topic)

(c) Sparx Systems 2022 Page  778 of 1974



Modeling Fundamentals 3 October, 2022

Associated Files

An element can be linked to one or more files external to the
repository, using the 'Responsibilities > Files' tab of the
element's 'Properties' dialog. Having created the link, you
can open the file and read its content from this tab.

Access

On a diagram or in the Browser, select an element and:

Ribbon Design > Element > Editors > Properties
Dialog > Files

Context
Menu

Right-click on the element > Properties >
Properties > Files
(In the 'Details' tab of the Inspector
window) Right-click on Files | New 'File'

Keyboard
Shortcuts

Ctrl+4 > Files (tab of the Responsibility
Window)
Shift+Enter > Files ('Properties' dialog)
Shift+Alt+F ('Properties' dialog)
Alt+9 > Files : Shift+Enter
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Manage File Links

Option Action

Path/URL Displays the URL or the directory path
and name of the file currently selected in
the 'Files' list.
To add a link to a file, click on the 
button to display the 'Locate Files'
browser and locate and click on the
appropriate file name. Then click on the
Open button.

Type Click on the drop-down arrow and select
the appropriate value to identify the file
path as a local directory path or a web
address.

Size Displays the size of the file.

Last Write Displays the date and time the file was
last updated.

Notes Type in any comments or notes on the
link to the file.

New Click on this button to clear the data entry
fields so that you can add a new file link.
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Save Click on this button to save any new or
changed details on a linked file.

Files Displays the list of linked files. Click on
a file to select it.

Launch Click on this button to open the selected
file.
Local files open in their default
application and web files open in the
default browser.

Delete Click on this button to remove the link to
the associated file.
The link is deleted from the list
immediately.

Notes

Linked files are a good way to link elements to additional·

documentation and/or source code

You can also insert hyperlinks to other files, in diagrams,·

and launch them directly from the diagram
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Dynamic Document View

The 'Dynamic Document' view in the main work area helps
you to instantly generate a document on a selected element,
using one of a range of templates to immediately display the
information you require in the most appropriate structure
and format. The document can be printed, but is not stored
electronically - it is dynamically generated for the current
element whenever you select the view and when you change
the template. You cannot edit the document contents in the
view.

The 'Dynamic Document' view is also the display screen for
Reading List Artifacts. These Artifacts define a list of
elements containing information that you should read
consecutively. When you open the 'Dynamic Document'
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view and select a Reading List Artifact, the view displays
the text of the first element in the list. You can then select a
'Next' (and 'Previous') option to work through the Reading
List of elements, displaying the text of each element in the
defined sequence.

Access

Ribbon Publish > Model Reports > Preview
Mode

Using the Dynamic Document View

Initially, when you open the 'Dynamic Document' View, it
displays the Notes text from the currently-selected element,
using the default Dynamic Document style sheet.

If you want to display information for a different aspect of
the element:

Click on the '[Reading] - <element name>' header1.

Click on the 'Select Dynamic Style' option. The 'Dynamic2.
Document Selector' dialog displays.
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Click on the drop-down arrow in the 'Style' field and3.
select one of the system-provided styles. These are
designed to display information for specific aspects of
relevant elements, such as Testing or Development.

Click on the OK button. The document is refreshed to4.
show the required information in an appropriate format.

If the system-provided style templates do not support your
requirements, you can quickly create your own style
templates. A style template consists of one or more
command lines, each of which defines an element type (or
all element types) and the document template to apply to the
generated document. The document template can be:

A system-provided template, or·

A system-provided fragment, or·

A user-defined template, or·

A user-defined fragment·

Information on setting up a style template is provided in the
Manage Dynamic Documents section.

Manage Dynamic Documents
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Task Description

Create
Document
Templates

Document templates are held in the
'Resources' tab of the Browser window
(Start > Application > Share >
Resources) in the Dynamic Documents
folder. Whilst you can select existing
system or user templates and template
fragments for your dynamic document
style template, you can also create new
document templates or fragments
specifically for dynamic documents. You
could create these in the Templates or
Fragments sub-folders of the Document
Publishing > Custom Templates folder,
or you could create a separate sub-folder
just for the dynamic document templates.
Whether you select existing templates or
create new ones, you must enable the
Elements section in each template or
fragment you use.
You would start to create the new
document templates by either:

Right-clicking on the Templates·

sub-folder (or other sub-folder) name
in the Custom Templates folder and
selecting the 'Create Template' option,
or
Opening the 'Generate Documentation '·
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dialog, clicking on the 'Templates' tab,
and then clicking on the New button

In either case, the 'New Document
Template' dialog displays, on which you
specify the template name, type, source
and group before going on to define the
template contents.

Create Style
Templates

Style templates are also held in the
'Resources' tab of the Browser window,
in the Dynamic Documents folder.
You can create a new style template:

Via the 'Dynamic Document Selector'·

dialog - click on the New button
Via the 'Resources' tab of the Browser·

window - right-click on the Dynamic
Documents folder name and select the
'Create Dynamic Document Style'
option

A prompt displays to enter the style
template name; type the name in and
click on the OK button. The 'Dynamic
Style' dialog displays, in which you type
the style definitions, in the format:
     <element
name>:<stereotype>:<document template
name>
If there is no stereotype, the format is:

(c) Sparx Systems 2022 Page  786 of 1974



Modeling Fundamentals 3 October, 2022

     <element name>::<document template
name>
The <element name> is an IF argument,
to state that if the 'Dynamic Document'
view is opened for an element of the
defined type, the specified document
template (or fragment) is used to format
its documentation. If you want to use a
specific template for information from an
element of unspecified type (that is, a
defined default) you would type:
     Default::<document template name>
You could also apply the system default
template for displaying information from
an element of unspecified type, by just
having the specified element statements
with no 'Default' statement at the end.
In this example, one template is defined
to display information when the selected
element is a Use Case, another for
information from elements used by
Project Support, a third for information
from elements used in Database
Engineering, and a fourth (a defined
default) for information from any other
kind of element.

     UseCase::DD-UseCase
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     Change::DD-Support
     Feature::DD-Support
     Issue::DD-Support
     Requirement::DD-Support
     Risk::DD-Support
     Task::DD-Support

     Class:Table:DD-DB Table
     Class:view:DD-DB SQL Element
     Class:dbsequence:DD-DB SQL
Element
     Class:function:DD-DB SQL Element
     Class:procedure:DD-DB SQL
Element
     Class:stored procedure:DD-DB SQL
Element
     Class:trigger function:DD-DB SQL
Element
     Class:functions:DD-DB SQL Element
as Ops
     Class:sequences:DD-DB SQL
Element as Ops
     Class:stored procedures:DD-DB SQL
Element as Ops
     Class:procedures:DD-DB SQL

(c) Sparx Systems 2022 Page  788 of 1974



Modeling Fundamentals 3 October, 2022

Element as Ops
     Class:package:DD-DB SQL Element
as Ops
     Artifact:sqlquery:DD-DB SQL Query

     Default::DD-Basic

Apply Style
Templates

Having created a style template in the
'Resources' tab of the Browser window,
you can immediately apply it to the
information you display in the 'Dynamic
Document' view.
As explained in the Using the Dynamic
Document View section, you click on the
[Reading] header and on the 'Select
Dynamic Style' option, and then click on
the drop-down arrow in the 'Style' field.
Your new style template will be listed
with the system templates and other
user-defined templates.
Click on the style template to apply in the
'Dynamic Document' view, and then on
the OK button.
The selected style will be applied to all
documents shown in the 'Dynamic
Document' view until you specifically
change it again.
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Increase or
reduce
magnification

By default, the 'Dynamic Document' view
displays text as if it were printed on an
A4 sheet. This is 100% zoom. If you
want to change the display magnification,
click on the [Reading] header and select
the 'Fixed Zoom' option. This provides a
small set of magnification options -
'75%', '100%', '125%', '150%' and '200%'.
It also provides a 'Custom' option; if you
select this, a small dialog displays in
which you type the percentage
magnification you prefer, between 10%
and 500%.
When you click on the option, or the OK
button on the small dialog, the selected
magnification is applied to the display.
The zoom factor remains set after you
close the 'Dynamic Document' view, and
is applied when you re-open the view
until you specifically change the zoom.

Display or
hide page
outline

The 'Dynamic Document' view defaults
to displaying information within the
framework of a page, but you can toggle
to a full-screen display by clicking on the
[Reading] header and selecting the
'Toggle Page Border' option.

Scroll In the 'Dynamic Document' view, you can
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through
elements

display the information from a set of
elements in sequence, using the 'Next'
and 'Previous' options from the [Reading]
header context menu. If you have
selected a:

Reading List Artifact element, the·

'Next' and 'Previous' options display the
information from the next or previous
element in the reading list, wherever
they might be in the model
Other type of element, the 'Next' and·

'Previous' options display the
information from the next or previous
element in the parent element or
Package, as listed in the Browser
window; the options cannot scroll
outside the containing object

Edit Style
Templates

You can edit a style template:
In the 'Resources' tab of the Browser·

window by right-clicking on the
template name and selecting the 'Edit
Dynamic style' option, or
In the 'Dynamic Document' view by·

displaying the 'Dynamic Document
Selector' dialog, selecting the style and
clicking on the Edit button

In either case, the 'Dynamic Style' dialog
displays, and you can delete or change
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the statements as necessary. Right-click
on a line of text to display a context menu
providing basic editing options.

Refresh the
Display

To update the display with any changes
made to the information within the
selected element, click on the [Reading]
header and select the 'Refresh' option.
The 'Dynamic Document' view with the
'Refresh' option is a useful tool for
developing a document. You review the
element's information in the view, make
any changes you think appropriate within
the element, then select the 'Refresh'
option to immediately update the
'Dynamic Document' view to show the
changes. You can therefore check how a
document generated from the element
would look, as you develop it.

Print the
document

If you want to print a hard copy of the
element's information, simply click on the
[Reading] header and select the 'Print'
option. The contents of the 'Dynamic
Document' view are sent to the system
default printer
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Select <Item> Dialog

The 'Select <Item>' dialog is a multi-purpose browser and
search tool for locating model items such as Classifier
elements, properties, attributes and behaviors. The <Item>
in the dialog title changes to represent the type of item the
original operation is working on.

The dialog is called in a range of operations; for example,
setting:

The base type or classifier for an Object, Swimlane or·

Lifeline

Classifiers for the return types for operations·

Classifiers for generalization sets·

The Composite diagram for an element·

The Information Item or classifier elements conveyed or·

realized on an Information Flow

The associated behavior for a behavior call·

The type and return type for operation parameters·

Activities for State transitions·

Use Case Scenarios·

Pattern element defaults·

Activities from which to generate code·

The values of Tagged Values·

Multiple Selection
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Where an operation permits the selection of multiple items,
the 'Select <Item>' dialog is automatically enabled to
support this; to select the items, press the Ctrl key as you
click on each item.

If you want to cancel a selected item, press the Ctrl key and
click on the item. If you want to cancel selection of all
items, just click on any item without pressing the Ctrl key

Having selected an item, you can continue to expand and
browse the hierarchy, and/or search for items; the dialog
retains the existing selections until you click on the OK
button.

Select a required item

Ste
p

Action

1 During an operation, when it is necessary to locate
an element or feature, click on the  button.
The 'Select <Item>' dialog displays.

2 If required, in the 'Go To Namespace' field select a
namespace to reduce the scope of the displayed
hierarchy.
The dialog opens the section of the hierarchy
associated with that namespace, and closes all
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previously-open sections associated with other
namespaces.

3 You can either:
Expand the selected area of the hierarchy on the·

'Browse' tab, or any other Package, and locate the
required item (go to step 5) or
Click on the 'Search' tab and, in the 'Find' field,·

type a partial or complete text string to search for
the item

4 On the 'Search' tab, you can filter the search further
by selecting the 'Whole Word' and 'Match Case'
checkboxes.
Each list entry shows the name of the item, the type,
any stereotype the item has, the immediate Package
in which the item is held, and any successive parent
Packages (the Package path).
You can either:

Select the item immediately on the 'Search' tab or·

Right-click on one item or a group of items and·

select the 'Locate item(s) in tree' option; this
redisplays the 'Browse' tab and highlights each
selected item in the <namespace> hierarchy

5 Click on the required item.

6 Click on the OK button.
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Notes

When you have selected an item, the 'Select <Item>'·

dialog retains the context and item; next time you display
the dialog, if the context is similar the dialog opens to the
same Namespace and item - for example, if you have
selected an activity for a State transition and you start to
do the same for another transition, the dialog opens to the
activity you previously selected

If the context is totally dissimilar, the dialog opens with·

the Namespace < any > and a collapsed model hierarchy

If the available items do not meet your requirements, you·

can create a new item and define the appropriate
properties - click on the Add New button; the appropriate
'Add <Item>' dialog displays, on which you define the
required item

The Add New button is not always available, depending·

on the context and the type of item being searched for

Elements can be searched by name or by alias on the·

'Search' tab
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Select Property Dialog

The 'Select Property' dialog is a specific instance of the
'Select <Item>' dialog; it is used to select Ports, Parts,
attributes and Association Ends as redefined or subsetted
properties, from a hierarchical list of Classes and their
contained properties in the model. As an example, consider
this section of the model:

Example
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This would be represented in the dialog as shown:
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Locate and click on the required object to select it, then
click on the OK button (to select several objects at once,
press and hold Ctrl while you click on each object).

Notes

AssociationEnds should be owned by the Class to be·

listed in the dialog
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Set Feature Dialog

The 'Set Feature' dialog is the 'Set Operation' dialog used to
change the operation represented by an Action on a diagram.

As the 'Set Operation' or 'Set Attribute' dialog, it is also used
to set the 'Value' operation or attribute for Tagged Values of
type RefGUID or for the target of a hyperlink in a diagram.

Locate and select a value operation or
attribute

Ste
p

Action

1 The 'Set Operation' (or 'Set Attribute') dialog
displays, with the model hierarchy opened at the
point at which you selected the original operation or
attribute.

2 If required, in the 'In Namespace' field, click on the
drop-down arrow and select another model that
contains the required operation or attribute.
The Package hierarchy for that model displays.

3 Browse through the hierarchy, or use the 'Search' tab
to locate the required operation or attribute, then
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double-click on the item to select it.
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Visual Representation

Each UML element has a default representation. However,
you can:

Change the shape of the element·

Display or hide various types of information held in the·

element, in compartments

Display the element in a simpler format, showing basic·

properties and notes but hiding features

You can also customize the appearance of single elements
or all elements on a diagram to a simpler, colorful drawing
style.
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Compartments

When you place an element on a diagram, you can display it
with a number of compartments that reveal not only the
attributes and operations of the element, but also several
other properties such as tags, requirements, constraints,
allocated resources, discussions and reviews.

This diagram shows some of the types of compartment that
you can show on an element in a diagram, as an illustration
of how compartments are displayed.  For a full list of
standard compartments, and information on custom
compartments, see the Feature Visibility and Define Element
Characteristics topics.
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Notes

Compartments cannot be show on elements where the·

appearance is defined by Shape Scripts, such as elements
specific to ArchiMate or BPMN

To set the display of each of the various compartments,·

see the Feature Visibility Help topic; the display of the
compartments is also controlled through the diagram
properties, on the 'Elements' tab - the specific element
settings take precedence over the more general diagram
settings

Elements that do not default to rectangle notation, such as·

Activities or Use Cases, must have the 'Appearance | Use
Rectangle Notation' context menu option turned on in
order to display compartments

Kanban diagrams do not automatically show element·

compartments, which contain useful and important
information; however, you can use the Kanban 'Native
Element Draw Style' option to show compartments on a
Kanban diagram and display the information they contain
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Rectangle Notation

You can display various 'shaped' elements, such as an
Interface, Use Case or Actor, using rectangle notation. This
notation shows on the diagram any attributes, operations or
constraints belonging to the element, in the same style as for
a Class.

To show an element using rectangle notation, either:

Click on the element in the diagram and on the  icon that·

displays on the right of the element, or

Right-click on the element on the diagram and select the·

'Appearance | Use Rectangle Notation' context menu
option

This displays the element as a rectangle, by default
displaying a UML keyword identifying the element type in
guillemets (« ») above the element name. However, certain
elements such as Activities and Use Cases by default define
an icon of the 'normal' shape instead of the keyword, and
display the icon in the top right-hand corner of the element.
On a Construction diagram, an Actor element also defaults
to rectangular notation.

The setting only applies to the selected element, and can be
toggled on and off either by:

Clicking on the  icon again, or·
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Deselecting the context menu option or·

Selecting the reciprocal context menu option such as 'Use·

Circle Notation' or 'Use Actor Notation'
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Info View Style

Info View is an alternative notation to display a simplified
view of an element that allows the name, description and
selected other properties to be displayed for an element
instead of the normal notation showing child features. This
view allows a diagram to be constructed for a non-technical
audience or any purpose where display of descriptions is
more important than the notations defined by the modeling
language.

For example, a database engineer will normally need to see
the columns and indexes of a Table, while a manager might
be more interested in seeing a high level description relating
to each table.

Access

Context
Menu

On diagram, right-click element |
Appearance | Enable Info View
On diagram, right-click element |
Appearance | Info View Properties

Description
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When you enable Info View on an element, the element is
rendered as a rounded rectangle, divided into two. In the:

Top half, on the left, the element name, type and·

stereotype display; on the right a small icon of the
element's native shape displays

Bottom half, at least some of the element's notes display·

If there are more notes than can show in the available space,
an ellipsis (...) displays at the end of the visible text, in
which case you can expose more of the notes text by
dragging the 'expansion handles' to resize the element.
(Under Linux, the Notes text displays outside the element
boundary.)

StockItem

- Author: string
- catalogNumber: string
- costPrice: number
- listPrice: number
- title: string

«property»
+ Author(): string
+ catalogNumber(): string
+ costPrice(): number
+ listPrice(): number
+ title(): string

tags
Maxstock = 20
Minstock = 5

Info View disabled

StockItem

Class

This element classifies the 
stock items in the Inwards 
Materials warehouse. 
Finished-product...

Info View enabled

STOCKITEM

Class
Proposed
Version: 1.0 Phase: 1.0
Author: Paulene Dean

Maxstock = 20
Minstock = 5

This element classifies the stock items in the 
Inwards Materials warehouse. Finished-product 
stock items are classified by the ProductItem 
Class.

Info View enabled, properties visible, expanded display

Notes might not be shown on the original rendering (as in
the illustration), but automatically show when Info View is
enabled. They display in italics but otherwise reflect any
formatting applied to the Notes in the element. You can
deselect an Info View Properties option to hide the notes.

The element has a minimum size; you cannot drag the
element any smaller than that. However, if you reduce the
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element to the minimum size in Info View, when you select
the 'Enable Info View' option again to turn Info View off,
the element returns to its original size to display all of its
visible content.

The properties listed in the top left of the element are
customizable. The list defaults to show the element type and
stereotype (where a stereotype exists) but you can chose to
hide one or both of those properties, and to show any or all
of the element Phase, Version, Status, Author and (for an
element in the Requirement group) Priority. Those five
properties are not shown on the element when Info View is
disabled. You can also hide the native-shape icon on the
element, display the element name in capitals, and display
the element's Tagged Values and/or Maintenance
compartments while in Info View (each compartment must
also be enabled in either the diagram 'Properties > Elements'
page or the element 'Compartment Visibility' dialog).

To customize the properties shown:

Right-click on the element and select the 'Appearance |1.
Info View Properties' option; the 'Visible Properties'
dialog displays.
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Select the checkbox against each property to display, and2.
clear the checkbox against each property to hide.

Click on the OK button.3.

Notes

The 'Info View' element icons reflect the fill and line·

colors of the original elements; if the 'Use Element Group
Style' option is selected on the 'Diagram > Appearances'
page of the 'Preferences' dialog (select the 'Start >
Appearance > Preferences > Preferences' ribbon option)
these will be the colors assigned to each element type,
otherwise they will be the standard element fill and line
colors; any default appearance colors assigned to the
native shape element can be applied to the Info View by
selecting the 'Apply Element Color' checkbox

The Info View style is not compatible with the Custom·

Diagram Style; you don't apply both styles to the same
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element
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Element Context Menu Operations

You can perform a wide range of operations on element
objects on a diagram, such as displaying an element's
structural components, displaying or hiding its features on
the diagram, and changing the element's appearance. You
access these operations through the element context menu.
If you are working under a technology such as SysML or
BPMN, the menu can also provide options that are specific
to that technology.

Access

Context
Menu

Right-click on element on diagram

Element Context Menu Options

Option Action

Specialize Select this option to access a submenu of
enabled Technologies on the system (for
example, ArcGIS or TOGAF), each of
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which provides options for performing
technology-specific operations on the
element.

Collaborate Select this option to display a short menu
of options to exchange electronic notes
with team colleagues, in the form of
formal Reviews, informal Discussions,
element Comments and, if User Security
is enabled, Chats and Model Mail
messages on the selected element.

Properties Select this option to display a submenu of
options for displaying different aspects of
the properties and features of the element,
including the:

Properties window·

A special dialog to define unique·

aspects of certain types of element (the
'Special Action' option); for State
Lifeline and Value Lifeline elements,
the 'Configure Timeline' dialog
displays, and for a Required Interface
element, the 'Exposed Interface' dialog
displays; if there is no special dialog,
the 'Properties' dialog displays
Notes window·

Responsibility window (for·

Requirements, Scenarios, Constraints
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and Files)
The Properties window, select the·

'Tags' tab to add or edit Tagged Values
in the element
Summary window·

Document window (for Linked·

Documents and Dynamic Documents)

Features Select this option to:
Display the appropriate page of the·

Features window to add attributes,
operations or interaction points
(structural elements such as Ports and
Parts) to the element; for a Classifier
that is the target of a Signal element,
you can also add Receptions
Override any inherited attribute values·

set on the element
For an Object or State element, add a·

new instance variable to the element
using the 'Define Run State' dialog
For elements that can have interfaces,·

show realized and/or dependent
interfaces
For Database Table elements, define·

columns and constraints/indexes

Appearance Select this option to display a short menu
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of options to change and reproduce the
appearance of the element.

Linked
Document

(Corporate, Unified and Ultimate
Editions) Select this option to create a
document linked to the element.
Shortcut: Ctrl+Alt+D

Compartment
Visibility

Select this option to define the visibility
of features and compartments on all
selected elements.
Shortcut: Ctrl+Shift+Y

Set
Bookmark
Value

Select this option to assign a bookmark to
the selected element, to be displayed on
the diagram.
The 'Set Bookmark' dialog displays.
Select the 'Enable Bookmark' checkbox
and type in a numerical or text value for
the bookmark, then click on the OK
button. The value is displayed in a red
circle or ellipse (depending on the length
of the bookmark value) just above the
element on the diagram.
If you decide that you do not want the
bookmark for a specific element to
display on the diagram, return to the
dialog and clear the 'Enable Bookmark'
checkbox. You can hide (and redisplay)
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all bookmarks on a diagram using the
'Hide All Bookmark Values' (and 'Show
all Bookmark Values') option on the
Diagram Context menu.

Insert
Related
Elements

Select this option to display the 'Insert
Related Elements' dialog, to add elements
related to the selected element to the
current diagram.

Clone
Element as
New Version

Select this option to copy the structure of
the selected element and paste it into the
Browser window as a new element and
contents; a prompt displays for you to
enter a version number for the new
element, followed by a browser on which
you select its parent Package or element.

Advanced Select this option to open the 'Advanced'
sub-menu, which provides options for
performing more complex or specialized
operations on the element.

New Child
Diagram

Select this option to display a submenu,
listing - in order:

Options for creating and displaying the·

child diagram for a Composite element
For classifier elements, options to·

create Activity, Interaction,
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StateMachine or Rule Flow elements
that encompass the appropriate type of
child diagram
Individual types of child diagram·

(often technology-specific) that you
might usually create for this type of
element
An option to display the 'New Diagram'·

dialog to add any other type of diagram
as the child diagram of this element

New Child
Element

Select this option to attach:
One of a number of types of structural·

element, such as a Port, Part or Activity
Parameter, to the selected element, or
A text element to the selected element,·

documenting a Note, Constraint,
Rationale or Problem

Simple
Decision
Table

This option displays for a selected
Activity or Action element. Select it to
display a sub-menu providing these
options:

Decision Table - Display, set up and·

edit the Decision Table for the element
Draw as Decision Table (Rules as·

Columns) - Replace the element shape
on the diagram with its Decision Table,
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showing the decision rules as columns
Draw as Decision Table (Rules as·

Rows) - Replace the element shape on
the diagram with its Decision Table,
showing the decision rules as rows
Draw as Activity / Action - Where an·

element is rendered as a Decision Table
on the diagram, re-display it as the
normal element shape

The element is automatically sized to
display the rule text; you cannot change
the element size manually.
If the selected element is a Rule Task
element, the submenu option is 'Rule
Composer', which invokes the Rule
Composer in Business Rule Modeling.

Create
Document to
Artifact

(On an Artifact element linked to a
Report Package or Model Document
element). Select this option to generate a
virtual document as the Linked
Document of the Artifact element. The
'Generate Documentation' dialog
displays.

Clear
Checklist

Select this option to clear any selected
checkboxes in the current Checklist
Artifact element.
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Checklist
Spacing

Select this option to change the spacing
between the items in the Checklist
Artifact. A short list of spacing options
displays, from which you select the
required spacing.

Find Select this option to display the 'Find'
submenu, which provides options for:

Locating the selected element in other·

diagrams and in the Browser window,
and
Setting up cross references (Custom·

References) to other elements

Copy/Paste Select this option to display a list offering
these options for copying the selected
element:

Copy - copy the element; you can·

select the 'Paste' option on the diagram
context menu to paste the element into
the diagram in a number of ways
Copy Image to Clipboard - copy the·

element image to the clipboard; you
can use the 'Apply Image from
Clipboard' option to recover and use
the image elsewhere
Apply Image from Clipboard - paste·

the element image current held in the
clipboard into the diagram as the image
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of the currently-selected element; the
image is shown as a labeled frame

Behavior Select this option to display a short
submenu, from which you:

Switch the element between Info View·

display style and 'normal' UML style
Set the element characteristics that are·

shown in Info View style
Toggle the Dockable, Selectable and·

Printable settings on the element
(Where an element has a structured·

element - such as a Port - shown in an
element compartment) bind the Port to
the compartment border rather than
allowing it to move to any point on the
parent element outline

Lock
Element

Select this option to lock the element so it
cannot be edited; to unlock the element,
select 'Lock Element' again.
This does not apply in the Corporate,
Unified and Ultimate Editions when
security is enabled; in that situation, use
the 'Lock' option for model elements.

Z-Order Select this option to display a short
submenu providing options to:
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Move the element further back in the·

diagram
Move the element further forward in·

the diagram
Put the element at the back of the·

diagram
Put the element at the front of the·

diagram

Type
Information

Select this option to display the Help
topic describing the type of element you
have selected.

Delete
<element
name>

Select this option to delete the element
from the diagram. The element still exists
within the model and can be accessed
from the Browser window.
Shortcut: Ctrl+D

Notes

If you select two or more elements at the same time, you·

can perform an operation on all of the selected elements at
once; the operations available for multiple selection are
provided on a separate context menu
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Selectable, Dockable and Printable
Options

The 'Selectable', 'Dockable' and 'Printable' options on the
element context menu control several aspects of an
element's behavior on a diagram.

The 'Behavior' option also provides access to the element
Info View facility.

Access

Context
menu

On a diagram, right-click on an element
and select the 'Behavior' option.

Behavior Options

Option Description

Selectable Select or deselect this option to toggle
whether the element is selectable or not:

If an element is selectable, you can·

move it around the diagram and

(c) Sparx Systems 2022 Page  823 of 1974



Modeling Fundamentals 3 October, 2022

perform right-click context menu
operations
If an element is unselectable, you·

cannot move it around the diagram and
the only right-click operation available
is to make the element selectable

This option has no effect on double-click
operations on the element, such as
displaying child diagrams or 'Properties'
dialogs.
An element on a locked diagram is also
unselectable - if you click on it, the
element outline displays in red.
In a diagram, you can filter the display to
show selectable or non-selectable
elements only.

Dockable Select this option to align and join two
elements either vertically or horizontally,
on the current diagram only.
Both elements must have the 'Dockable'
option selected, and must have the
joining edges parallel.
As the distance between the elements
narrows, the moving element snaps to the
edge of the other element.
For Activity Partitions, the option is
selected by default.
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Deselecting the 'Dockable' option does
not separate the elements; if necessary,
you can simply move the elements apart
again.

Printable Defaults to selected, so that the element is
depicted in any diagrams in reports
generated on its parent Package.
If you click on the option to deselect it,
the element and its connectors will not be
visible in any diagrams in reports. You
can, however, deselect a report option for
an instance of a report to force the display
of non-printable elements.
Deselecting this option also hides the
element and its connectors in the 'Print
Diagrams', 'Print to PDF' and 'Save
Diagram as Image' operations.
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Advanced Operations on Elements

You can perform a wide range of more specialized functions
on an element, specific to the element type and its
relationship to other modeling objects.

Access

Context
Menu

Right-click on element on diagram |
Advanced

Advanced Options

Option Action

Instance
Classifier

(For an instance or Object element)
Select this option to set the instance
classifier for the element, on the 'Select
<Item>' dialog.
Shortcut: Ctrl+L

Parent (For a classifier element that can be
generalized) Select this option to set the
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element's parent.
Shortcut: Ctrl+I

Show
element
classifier

Shows or hides the classifier names on
Port elements.

Classifier
Properties

(For an instance or Object element)
Select this option to open the 'Properties'
dialog for the classifier of the selected
element.
Shortcut: Ctrl+Alt+Enter

Change to
State (Value)
Lifeline

(For a State Lifeline or Value Lifeline
element) Select this option to switch one
type of Lifeline element to the other.

Set Property
Type

(For a Part element) Select this option to
browse for and select the element that
defines the Part type, using the 'Select
<Item>' dialog.

Multiplicity Select this option to define the
multiplicity for the element, using the
format defined on the 'Cardinality Values'
tab of the 'UML Types' dialog ('Settings >
Reference Data > UML Types').
This is the number of instances of the
element that can exist in a set; the value
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displays on the element in a diagram, in
the 'Name' compartment.

Port Size
Customizable

(For a Port element) Select this option to
allow users to resize the Port from the
default size. If the option is not set, the
element size cannot be changed.

Show
Element
Type

(For a Port or Part element) Select this
option to toggle between displaying and
hiding the element type, as set using the
'Set Property Type' option or on the
'Property' tab of the element's 'Properties'
dialog.

Set Property
Values

(For a Part element) Select this option to
set the property value for the Part, using
the 'Set Property Values' dialog.
Shortcut: Ctrl+Shift+R

Edit
Extension
Points

(For a Use Case element) Select this
option to display the 'Use Case Extension
Points' dialog, which you use to insert the
point at which the behavior should be
inserted.

Association
Class

(For a Class element) Select this option to
connect the Class to a new Association.
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Use
Rectangle
(Circle,
Actor)
Notation

(For an element that uses non-rectangular
notation) Select this option to apply
rectangle notation to the element (and
switch back again).

Partition
Activity

(For an Activity element) Select this
option to define an Activity Partition in
the element.

Set Object
State

(For an Object or instance element)
Select this option to set the state of the
element based on the child states of its
classifier.
Shortcut: Ctrl+Shift+S

Override
Attribute
Initializers

(For a Class element with attributes)
Select this option to pre-define initial
values for attributes that can be used to
override existing defaults.
Shortcut: Ctrl+Shift+R

Convert to
Instance
(Property/Inv
ocation)

Select this option to convert a classifier to
an instance, property or invocation,
depending on the type of classifier
selected (for example, SysML classifiers
are always converted to properties).

Convert Select this option to convert the
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Linked
Element To
Local Copy

occurrence of the element on the current
diagram from a link to the original
element to a local copy of the element. A
copy of the element is also added to the
diagram's parent Package in the Browser
window.

Make
Sender/Recei
ver

(For Send and Receive Event elements)
Select this option to toggle the element
from a sender to a receiver and vice
versa.

Accept Time
Event

(For a Receive element) Select this option
to change the notation from an Accept
Event action to an Accept Time Event
action.

Define
Concurrent
Substates

(For a State element) Select this option to
define the set of substates that can be held
simultaneously within that composite
State.

Use State
Label
Notation

(For a State object) Select this option to
switch to State Label Notation (the
element name is displayed on a box on
top of the element rather than inside it).

Deep History (For a History pseudostate) Select this
option to change the type of a shallow

(c) Sparx Systems 2022 Page  830 of 1974



Modeling Fundamentals 3 October, 2022

History pseudostate to a deep History
pseudostate.

Transform Select this option to transform the
selected element from one domain to
another.
Shortcut: Ctrl+H

Set Attached
Links

(For a Note element) Select this option to
attach the element to a connector, or
several connectors on the diagram.

Link to
Connector
Constraints

(For a Note element) Select this option to
display the connector type and to list the
constraints of the associated connector in
the Note element.

Link to
Connector
Notes

(For a Note element) Select this option to
display or hide the text assigned to a
connector's 'Notes' field.

Link to
Connector
Tagged
Values

(For a Note element) Select this option to
display the connector type and to list the
Tagged Values of the associated
connector in the Note element.

Link to
Diagram
Notes

(For a Note element) Select this option to
display the diagram notes as the text of
the Note element.
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Any current text is deleted and the Note
is blocked from being edited other than
through the 'Notes' field in the diagram
'Properties' dialog.

Hide (Show)
attached links

(For a 'Memo' style or 'Memo2' style
Note element) Select this option to hide
or show the Notelink connectors to the
elements to which the Note refers.

Vertical
Partition

(For an Activity Partition element) Select
this option to switch a horizontal Partition
to a vertical Partition.

Notes

Context menus vary between element types, and few of·

the menu options shown here are present on all element
context menus; 'Tagged Value' is often the only option
available

If an element appearance is overridden by a Shape Script,·

several of the appearance options are disabled; for
example, 'Use Rectangle (Circle) Notation'
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Finding Elements

When you have selected an element on a diagram, you
might want to find out where it is held in the model
structure, where else it is used in the model, and how to
locate it easily in the future. For these operations, you can
select the 'Find' submenu.

Access

Ribbon Design > Element > Manage > Find in
Diagrams
Design > Element > Manage > Find in
Project Browser

Context
Menu

Right-click on element | Find
(see Find Options for a description of the
sub-menu).

Keyboard
Shortcuts

Alt+G    (find in Browser window)
Ctrl+U    (find in all diagrams)

Find Options
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When 'Find' is selected from the context menu, a sub-menu
is displayed, providing options as described here.

Option Action

Locate in
State Table
Locate in
State Chart

For a State element, select this option to
switch from one diagram display format
to the other, and highlight the element.

In Project
Browser

Select this option to highlight the
currently selected element in the Browser
window.
Shortcut: Alt+G

Locate
Classifier In
Project
Browser

For an instance or Object, select this
option to highlight the classifier for that
element in the Browser window.
Shortcut: Ctrl+Alt+G

Locate
Operation in
Project
Browser

For an Action element, select this option
to highlight the call operation for that
element in the Browser window.
Shortcut: Ctrl+Alt+G

Find in all
Diagrams

Select this option to list the other
diagrams in which the element is also
used, on the 'Element Usage' dialog.
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Shortcut: Ctrl+U

Custom
References

Select this option to identify and, if
necessary, open the 'Properties' dialog for
any elements that are the target of a cross
reference from the selected element.
Shortcut: Ctrl+J

Add to
Favorites

Select this option to add the selected
element to the Favorites folder in the
'Resources' tab of the Browser window.
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Changing Element Appearance

If you want to modify the appearance of a specific element
on a diagram, you can use a range of facilities available
through the element context menu on the diagram.

Some of these facilities are also available via the Layout
ribbon's Style panel, or through the Format toolbar.

Access

Ribbon Layout > Style (changes the appearance
of the selected element on the current
diagram only)

Context
Menu

Right-click on the element on the
diagram and select the 'Appearance'
option; this displays the 'Element
Appearance' sub-menu, described here.

Keyboard
Shortcuts

F4 (displays the 'Default Appearance'
dialog, described here)

Other Right-click on the element on a diagram -
the Format toolbar is displayed above the
context menu.
(The Format toolbar changes the
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appearance of the selected element on the
current diagram only.)

Element Appearance Options

Option Action

Default
Appearance

Click on this option to override the global
default appearance of all elements (which
you set on the 'Standard Colors' and
'Diagram Appearance' pages of the
'Preferences' dialog) with a different
default for just the selected element on all
diagrams in which it is used.
To change the appearance of the selected
element on the current diagram only, use
the tools available in the 'Style' panel of
the 'Layout' ribbon.
Shortcut: F4

Apply Image
From
Clipboard

Click on this option to paste the image
held on the clipboard onto the selected
element, as an alternative image.
This image is added to the Image Library
under an automatically-assigned name.
The image can be accessed from and
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renamed in the Image Manager.

Select
Default
Image

Click on this option to change the
element's appearance to an alternative
image, using the Image Manager.
This appearance applies to the element on
all diagrams in which it is used.

Select
Alternate
Image

Click on this option to change the
element's appearance to an alternative
image, using the Image Manager.
This appearance applies to the element on
the current diagram only.
Shortcut: Ctrl+Shift+W

Select Image
Asset as
Alternate
Image

Click on this option to display the 'Select
Element' browser, and locate an Image
Asset element containing the image to
use for the selected element.

Hide/Show
Name Under
Image

For an element that has an alternative
image, click on this option to hide or
redisplay the name label under the
element.

Set Font Click on this option to change the font
type, size, color and effects for the text in
the element.
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Diagram
Frame
Appearance

For Diagram Frame elements; click on
this option to set the appearance of the
frame.

Show Labels For embedded elements, or those with an
alternative image that show element
properties as labels, click on this option
to reveal the hidden labels on the
element.
(The option is not listed if there are no
hidden labels.)

Standard
Memo
Memo (Style
2)
Pin
Sticky
Paperclip

For a Note element, click on one of these
options to apply the corresponding image
to the element.

Copy
Appearance
to Painter

Click on this option to copy the default
element appearance (set using the
'Default Appearance' option) to the
painter.
You then paste the default appearance
using the 'Paste Appearance' option on
the Diagram toolbar.
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Copy Image
to Clipboard

Click on this option to copy the element
image to the clipboard. You can use the
'Apply Image from Clipboard' option to
recover and use the image elsewhere.

Notes

You can also change the appearance (and other aspects) of·

several selected elements at once

Context menus vary between element types, and not all·

menu options shown here are present on all element
context menus; for example, the 'Select Alternate Image'
option does not display for a Lifeline element
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Operations on Multiple Elements

It is possible to perform various operations on two or more
elements on a diagram at once, either to add the same
feature or to standardize the size or orientation of the
selected elements. This makes it much faster to update the
diagram than if you had to modify each element separately.

To select the required elements, either click and drag the
cursor over the group to highlight them, or press Ctrl or
Shift as you click on each element separately. You can 'fix'
this selection permanently using the 'Group' elements option
on the context menu.

The selected element that is drawn with a hatched border is
the context element. The context element is used as the
'master' element when aligning or resizing elements as a set.

The Shift and Ctrl keys toggle selection, so if you want to
exclude a selected element from a group, again press the key
as you click on the element. The two keys have a slightly
different effect when you click on the intersection between
two overlapping elements:

Shift+click toggles selection of the element with the lower·

Z-order (the element behind or further back than the
others)

Ctrl+click toggles selection of the element with the higher·

Z-order (the element in front of or further forward than
the others)
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Access

Select a set of elements on a diagram, then right-click on
one of the selected elements to display a context menu (for
format/layout operations, right-click on the element against
which to standardize the others - this sets the right-clicked
element as the context element).  Just note that if you click
(not right-click) on an individual element, that element
becomes the only selected element; the multiple selection is
cleared and you are no longer working on multiple elements.

The 'Layout' ribbon's 'Style' panel also provides options for
changing appearance related properties for a set of selected
elements, while the 'Alignment' panel provides numerous
options for aligning and resizing elements.

Ribbon Layout > Style (changes the appearance
of the selected elements on the current
diagram only)
Layout > Alignment (changes the size or
position of the selected elements on the
current diagram only)

Context
Menu

Right-click on a selected element on a
diagram. The context menu for multiple
selections displays; this is described here.

Keyboard
Shortcuts

F4 (displays the 'Default Appearance'
dialog, described here)
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Other Right-click on a selected element on
diagram - the Format toolbar is displayed
above the context menu
(Changes the appearance of the selected
elements on the current diagram only)

Options

Option Detail

Specialize Select this option to access a submenu of
enabled Technologies on the system (for
example, ArcGIS or TOGAF), each of
which provides options for performing
technology-specific operations on the
elements.
This option is available in the
Professional, Corporate, Unified and
Ultimate Editions of Enterprise Architect.

Collaborate This option displays if User Security is
enabled. It offers the sub-options of:

'Send Message', which opens the·

'Create Message' dialog to create and
send a model message containing a
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hyperlink to each of the selected
objects
'Monitor Discussions', which sets a flag·

on the selected elements to notify you
if any of the selected elements are the
subject of a new discussion or a new
reply to an existing discussion

Align Select one of these 'Align <point>'
options to align elements against the
'master' element's:

left edge·

right edge·

top edge·

bottom edge·

center, vertically or·

center, horizontally·

You can also edge-align groups of
elements using the Diagram Toolbar; the
four alignment buttons are made
available when more than one element is
selected in a diagram.
Shortcut:
Ctrl+Alt+Left Arrow
Ctrl+Alt+Right Arrow
Ctrl+Alt+Up Arrow
Ctrl+Alt+Down Arrow
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Space Evenly (For three or more selected elements.)
Select this option to automatically even
out the spacing between the selected
elements, either horizontally or vertically.
Shortcut: Alt+-    Alt+=

Same
Height/Width

Select one of these options to make all
the selected elements match the 'master'
element's height or width, or both.
In Use Case diagrams, these options are
blocked if the 'Allow elongated Use
Cases' option is turned off on the
'Preferences' dialog 'Objects' page.

Group/UnGr
oup Elements

Select these items to either combine the
selected elements into a group for
common formatting, for a number of
work sessions, or to cancel an existing
group.

Compartment
Visibility

Select this option to define the visibility
of features and compartments on all
elements selected on a diagram.
Shortcut: Ctrl+Shift+Y

Set
Bookmark
Value

Displays the 'Set Bookmark' dialog, on
which you enable the display of
Bookmark icons above the selected
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elements, and set any value to display in
those bookmarks.

Show
Elements
Matrix

Displays a Relation Matrix for two
selected elements, identifying
relationships between the features of the
elements in the selected group.

Clone
Element(s) as
New Version

Select this option to copy the structure of
the selected elements and paste them into
the Browser window as new elements and
contents; a prompt displays for you to
enter a version number for the new
elements, followed by a browser on
which you select the parent Package or
element.

Add Tagged
Value

Select this option to add the same Tagged
Value to all selected elements.

Autosize Select this option to automatically resize
the selected elements to their default
minimum size (element content
permitting).
Shortcut: Alt+Z

Appearance Select this option to set the same default
appearance and font for all of the selected
elements at once.
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Shortcut: F4
You can also enable the Custom Diagram
Style on the grouped elements, enable
Info View style, and define the Info View
display options.

Behavior Select this option to display a short
submenu, from which you toggle the
Dockable, Selectable and Printable
settings on the elements

Copy Select this option to copy the selected
elements to the clipboard.

Save
Selected
Elements as
Pattern

Save the selected elements in a
DiagramPattern Artifact, to act as a
Pattern to reproduce those elements in
other diagrams.

Layout
Selected
Elements

Select this option to automatically adjust
the layout of the selected elements on the
diagram.

Delete
Selected
Elements

Select this option to delete the selected
elements from the diagram only.
Shortcut: Ctrl+D
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Element Facilities

Enterprise Architect provides a wide range of facilities for
creating, editing and working with the elements that
represent aspects of your models.

Facilities

Facility Description

Create
Elements

Creating elements is extremely versatile.
You can create entirely new elements or
elements derived from existing ones, on
diagrams or directly into Packages, from
the standard system-provided definitions
or from your own definitions in
templates, Patterns or MDG
Technologies.

Customize
Elements

If the standard elements provided do not
serve the purposes of your model, you
can give some elements different
appearances and/or define a set of
properties for them, or create completely
new types of element, and use these as
the bases for creating the elements in
your model.
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Name
Elements

As you create an element, you can either
provide the name yourself, manually, or
leave it for the system to provide from a
simple standard or a more advanced
automatic naming and numbering system
set up by your department.

Set Element
Parents

Once you have created an element, you
can assign it to a parent element or to an
interface that it realizes.

Trace
Element Use

As you develop your models and use
elements in several diagrams to represent
different views of the model, you can
track and list where the element is in use.

Move
Elements

You can easily move individual elements
or element structures around the model to
other Packages and/or diagrams, either
changing the parent Package or diagram,
or duplicating the elements in another
Package or diagram.
You also have a number of different ways
in which to change the position of an
element or a group of elements within a
diagram, either in relation to the diagram
or in relation to each other.
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Cross
Referencing
Elements

It is possible to set up a cross reference
(or Custom Reference) from one element
in Enterprise Architect to another. You
can also view existing cross references on
an element, using the 'Context
References' dialog or the Traceability
window.

Change
Element
Type

Sometimes, you might find that an object
that you have represented as one type of
element would be better represented as
another type. You can change the type
very quickly and simply.

Delete
Elements

Elements can be created in error, or used
on the wrong diagrams, or have a
temporary function that becomes
redundant. In such case you can easily
and safely delete the elements from the
diagram only or from both the diagram
and the model.

Change
Element
Visibility

Some elements are not shown in
Packages and in report documents, by
default. These include Events, Decisions,
Sequence elements and Associations.
You have the option of making these
elements visible in the documentation.
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Write
External
Descriptions
for Elements

One aspect of modeling is to describe and
document the purpose and use of an
element in the context of a particular
diagram. You can provide such
documentation in the form of Note or
Text elements displayed with and
connected to the elements they describe.
The Note text can be extra to anything
contained within the element, or can
expose the internal description of a
feature or property of the element.

Customize
Element
Appearance

You can set a number of standard default
features that are applied globally to all
elements, but you can also define a
different default appearance for one
element wherever it might be used.

Set Context
Element

Sometimes, when you are working on a
diagram, you might want to identify the
element against which you are comparing
or standardizing some or all of the other
elements on the diagram. You can
highlight the selected element as the
context element.

Use Element
Multiple
Times

When you are using an element in more
than one diagram, you can either create a
representation of the element linked to
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the original, or a copy of the element as a
separate object. If you create a link, you
can subsequently convert it to a separate
object.

Reuse
Element
Features

Many types of element have Features
(attributes and operations) that define the
properties and actions of the element.
You can duplicate selected Features of
one element in another, or take a Feature
out of one element and place it in
another.

Notes

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Update Element' permission to update element properties
or delete an element

If you select an element in a diagram, you can press the T·

key to display the Test Cases window for that element
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Element Grouping

There are several situations in which you might want to
operate on a number of elements at the same time, such as to
align them in a certain orientation or to move them whilst
maintaining that orientation, or to reformat the elements
with the same characteristics.  To group the elements you
can:

Click on specific elements while pressing the Ctrl key or·

Shift key, or

Click on a point on the diagram and drag diagonally·

across a number of adjacent elements to select all
elements within the dragged boundary

These two methods set a temporary grouping. You can also
fix the selection to group the elements permanently during a
sequence of work sessions, until such time as you
specifically ungroup them again.

Grouping Elements

With multiple elements selected on a diagram, right-click on
any of the elements and select the 'Group Elements' option.
Whenever you click on one of the grouped elements, the
others in the group are selected as well.

Ungrouping Elements
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Right-click on any of the grouped elements and select
'Ungroup Elements' to make all the elements in that group
individually selectable again

Notes

In a permanent grouping:

Right-click on an unselected group element to display·

context menu options for working on that element alone;
select the element and then right-click to display the
context menu for working on multiple elements

You can select another element either within the group or·

outside it using the keyboard arrow keys

You can temporarily remove an element from the group·

for an operation, by pressing the Ctrl key as you click on
it; when you click on the diagram background and back
on the group, the excluded element is again part of the
group

You can update the appropriate windows with the·

properties and features of different elements in the group
by double-clicking on the next element to investigate

The feature complements the facility for setting bookmark·

values, either to add bookmarks to every element at once,
or to set the same value to the bookmarks on the elements
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Template Classes

If you are working with Parameterized Classes or Binding
Classes, you can use the 'Templates' dialog to define:

The Parameterized Class template parameters and·

The Binding expressions on a Binding Class·

Access

Click on the appropriate Class element in the Browser
window or in a diagram.

(c) Sparx Systems 2022 Page  856 of 1974



Modeling Fundamentals 3 October, 2022

Ribbon Design > Element > Manage > Template
Parameters

Keyboard
Shortcuts

Alt+5 | Template Parameters

Use

In the 'Template Parameter(s)' panel, click on the Add
button to add a new parameter, or click on an existing
parameter and on the Edit button to edit the parameter; in
either case, the 'Template Parameter' dialog displays.

In the 'Binding(s)' panel, click on the Add button to add a
new binding expression or click on an existing expression
and on the Edit button to edit the expression. When you
click on the Add button, a short context menu displays from
which you select the type of relationship to generate, and
then you define the binding expressions.

If either a template parameter or a binding expression is no
longer required, click on it and then click on the
corresponding Delete button.
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Composite Elements

You might want to use one element to represent a structure
composed of other elements; for example, a general Use
Case representing a collection of more specific Use Cases.
To achieve this, you can make the 'general' element a
composite element, as a pointer to a child diagram
containing the 'detail' elements. The elements that you can
turn into composites include Classes, Objects, Activities and
Use Cases.

Access

Ribbon With an element selected in the Browser
window:
Design > Diagram > Add Diagram : Type
- UML | Structural | UML Structural |
Composite Structure | <one of the two
diagram types>
There are several Perspective groups and
Perspectives that lead you to the UML
Structural group; the one provided is an
example.

Context
Menu

Right-click element in diagram | New
Child Diagram | Composite Structure
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Diagram or
Right-click element in Browser window |
Add | Composite Structure Diagram

Make an Element Composite

Images Step / Action

When you select to make an element
composite, it displays in the diagram and
in the Browser window as illustrated on
the left.
Note:

The small icon in the bottom right hand·

corner of the element shape, indicating
that this is now a composite element
The icon against the child diagram·

name in the Browser window,
indicating that this diagram was created
as a child of the composite element

To access the child diagram that the
composite element points to, either:

Double-click on the composite element·

in the diagram, or
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Click on the composite element and·

press the = key
If you have selected the 'Enable Concise
Diagram Navigation' checkbox on the
'Application Look' (Visual Style) dialog,
the child diagram replaces the parent in
the Diagram View. Otherwise the child
diagram opens in a separate tab.
You can populate the child diagram with
elements and connectors to represent the
internal structure of the (parent)
composite element. In this process,
structural (embedded) elements cannot be
directly added to the child diagram.
However, you can add them using a
different, modified procedure.
If you have selected the 'Enable Concise
Diagram Navigation' checkbox, to return
to the parent diagram containing the
composite element click on the arrow in
the right hand end of the diagram tab. If
you accessed the child diagram by:

Double-clicking on the composite·

element, the parent diagram displays
Pressing the = key, the parent diagram·

displays with the composite element
selected

The composite element and its child
diagram are now represented in the
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Browser window as shown. ClassX,
ClassY and ClassZ are elements added to
the child diagram.

If you already have, or subsequently
create, another diagram that better
represents the content of your composite
element, you can select that diagram as
the child of the composite.
Right-click on the composite element in
its diagram and select the 'New Child
Diagram | Select Composite Diagram'
option. The 'Select Classifier' browser
displays, through which you can browse
the entire project to locate the alternative
diagram. Click on the diagram and on the
OK button to apply it as the child of the
composite element.
Neither the original nor the alternative
child diagram move location or change
icons in the Browser window (unless you
specifically make these changes as a
separate operation).

Alternative Notation
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You can display the contents (the child diagram) of a
Composite element in a number of other ways.

Display
Format

Detail

Display
Composite
Diagram in
Popup
window

On the parent diagram, click on the
composite element and then on the 'eye'
icon ( ) off the right hand side of the
element, or press the Backslash (\) key.
The child composite diagram displays in
a floating Popup window. To close the
pop-up window, press the Backslash key
again or click on a different point in the
work area.  Double-clicking on the
floating Popup window, will open the
previewed diagram in the work area.

Display
Composite
Element as
Frame

Composite elements can show their
contents in place of their usual notation.

Right-click on the composite element1.
in the diagram; the context menu
displays.
Select the 'New Child Diagram | Show2.
Composite Diagram in Frame' option.

The composite element is replaced by a
frame containing the child diagram. The
frame label shows the composite element
name. The element is resized to contain
the diagram; whilst it can be enlarged, it
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cannot be reduced to less than the
diagram size.
Some technologies, such as SysML,
qualify the frame label to show the
diagram type, element type, element
name and child diagram name. If you
design custom diagram profiles, you can
also qualify the frame label as required.

Display
Composite
Element
Content In
Compartment

Composite elements can also show their
contents in addition to their usual
notation, in a separate compartment of
the element.

Right-click on the composite element3.
in the diagram to open the context
menu.
Select the 'New Child Diagram | Show4.
Composite Diagram in Compartment'
option.

A compartment is added to the element,
containing the child diagram. The
element is resized to contain the diagram;
whilst it can be enlarged, it cannot be
reduced to less than the diagram size.
You can also display a Composite
diagram inside its parent element using a
Shape Script. The diagram is displayed in
a custom compartment in the center of
the element and not necessarily with the
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standard compartments (such as
attributes, tags).

Notes

If the 'Composite' option is not listed in the context menu,·

the option is not available for the type of element you
have selected

If you select either the frame or compartment options to·

display the child diagram on the composite element, and
then you select a different child diagram, the display
settings are cleared; reselect the appropriate option to
display the new diagram on the composite element

Automation support is available for Composite elements -·

Element has an Elements collection and a Diagrams
collection; additionally you can set the Composite
diagram with SetCompositeDiagram
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Show Structural Elements In
Composite Diagram

A Composite element shows the external relationships of the
element with other components of the model and, via a child
diagram, its own internal structure. You cannot normally
add structural elements to the representation of this internal
structure; however, this procedure describes a modified
process through which you can add structural elements to
the child diagram.

Structural elements include:

ActivityParameter·

RequiredInterface·

ActionPin·

Port·

EntryPoint·

ExpansionNode·

ObjectNode·

ProvidedInterface·

ExitPoint·

Part·

Include embedded elements in a child
composite diagram
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Images Step / Action

Create the element to set as a Composite
element. For example, a Class, Activity,
or SysML Block.

Right-click on the element in the diagram
and select the 'New Child Diagram |
Composite Structure Diagram' option.
The element redisplays with a small icon
in the bottom right hand corner,
indicating that this is now a Composite
element.

Double-click on the Composite element
to access the child diagram that it points
to.

From the Browser window, drag the
Composite element itself onto the child
Composite diagram, and paste it in as a
Link.

Right-click on the element in the
diagram, and select the 'New Child
Diagram | Show Composite Diagram in
Frame' option.
The element redisplays with a labeled
frame around it.
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Press Ctrl+S to save the diagram.
Right-click on the diagram tab and select
the 'Reload <diagram name>' option.
The diagram redisplays with just the
frame showing. This frame represents the
original composite element.

Populate the frame with the appropriate
internal elements, including the
structured elements that attach to the
frame itself.
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Set Element Parent

In the context of one element being generalized by one or
more other elements, those other elements are referred to as
the parent elements. You can define the parent element(s)
for a generalizable element, or an interface it realizes
(implements), using the 'Set Parents and Interfaces' dialog.
The parent elements do not necessarily have to exist in the
model; you can specify an element that you intend to create
later. You can also delete an existing parent/child
relationship using the dialog.

Access

Ribbon Design > Element > Manage > Parents
and Interfaces

Context
Menu

Right-click on element in diagram |
Advanced | Parent

Keyboard
Shortcuts

Ctrl+I

Set an element parent
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Option Action

Type Click on the drop-down arrow and select
the type of relationship to set
(Implements or Generalizes) from the list.
You select the relationship type first
because, if you use the Choose button,
the 'Select Classifier' dialog actually
creates the relationship based on this field
value, immediately when you select the
parent or interface element.

Class Name Either:
Type in the parent or interface name, or·

Click on the Choose button to browse·

or search for the element within the
current model (the relationship is
created immediately when you select
the classifier)

Accept
classifier
even if not in
model

If the parent element does not currently
exist in the model, select this checkbox to
protect the reference to a non-existent
element.

Add If you do not use the Choose button, click
on this button to add the relationship to
the 'Type Details' list, to the selected
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child element and to the model.

Prior to this:
If the parent element does not exist in·

the model and you have not selected
the 'Accept classifier even if not in
model' checkbox, an Unknown
Classifier error message displays
If you have specified an existing·

element with the same name as other
elements in the model, a dialog
displays listing the elements and their
parent Packages, prompting you to
select the correct classifier

Delete
selected

If you no longer want to keep the
relationship between a parent and child
element, click on it in the Type Details
panel and click on this button to remove
it.

Operations on the parent element
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If the parent name is shown in the element, you can select it
(click on the child element, then click on the parent element
name) and right-click to display a context menu of further
operations:

Apply the facilities of any relevant technology enabled in·

Enterprise Architect

Redisplay the 'Set Parents and Interfaces' dialog to, for·

example, delete the parent or add further parents

Display the parent element 'Properties' dialog·

Find the parent element in the Browser window·

Find the parent element in any diagram in which it exists·

If the parent element does not currently exist in the model,
but is shown on the child element in the diagram, you can
still access the first two of the context menu options for it.

Notes

On a diagram, the parent element name is displayed in the
top right corner of the child element if:

The parent element is not on the same diagram as the·

child element, and

The 'Show Hidden Parents' option is selected on the·

'Diagram > Behavior' page of the 'Preferences' dialog
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Manage Structural Elements

In UML Modeling, you can define certain constructs and
events with structural elements (also called Parts, Properties,
interaction points or - in the case of Entry and Exit Points on
a State element, connection points) that are added on to a
parent element. For example, you can add Ports to a Class
(as shown), Action Pins to an Action, or Activity Parameters
to an Activity. Structural elements become a component of
the parent element; certain structural elements (such as Parts
and Properties) can exist independent of a parent, but do not
have an independent role.

You manage structural elements through the Features
window, managing Parts and Properties on the 'Parts /
Properties' tab and Ports on the 'Interaction Points' tab. If the
parent element is a State, its connection points are shown on
the 'Connection Points' tab.  All three tabs have the same
options, described here.

Access
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Ribbon Start > All Windows > Properties >
Element Features > Features > Interaction
Points
Start > All Windows > Properties >
Element Features > Features > Parts /
Properties
(For a State element, select one of the
other options and then click on the
'Connection Points' tab)

Context
Menu

Right-click on element in diagram |
Features | Interaction Points
Right-click on element in diagram |
Features | Parts / Properties
(For a State element, select one of the
other options and then click on the
'Connection Points' tab)

Keyboard
Shortcuts

Ctrl+5 > Interaction Points    (for Ports)
Ctrl+5 > Parts / Properties    (for Parts
and Properties)
Ctrl+5 > Connection Points   (for State
elements)

Review Structural Elements
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Option Action

list of
elements

Review the definition of each structural
element currently associated with the
selected parent element. If you select the
'Show Owned/Inherited' checkbox, the
list will also include any structural
elements from any classifiers that the
parent element has.
If you want any structural element to be
visible on the parent element on the
current diagram, select the checkbox next
to that element's name. Notice that the
'Visible' column in this panel then shows
the value True against the selected
element.
To hide the structural element on the
diagram, clear the checkbox. The
structural element still exists on the
parent element, but is just not visible in
the diagram.
In the 'Type' field, you can change the
assigned type if necessary. Click on the

 icon and browse or search for and
select the required type from the 'Select
Type' dialog.

All
None

Click on these buttons to select (All) or
clear (None) the checkboxes against all
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listed elements.

Show
Owned/Inheri
ted

The tab lists the structural elements on
the selected parent element. If you want
to include inherited or owner properties
from any classifier that the parent
element might have, select this checkbox.

Context Menu options

The 'Parts/Properties' and 'Interaction Points' tabs have a
context menu providing options that help you to further
manage the structural elements on the parent element.

Option Description

Add New Select this option to add a new structure
element of the same kind (Port, Part or
Property) to the parent element. The
'Insert New Embedded Element' dialog
displays. In the:

Element Type field (if necessary) click·

on the drop-down arrow and select the
appropriate type of element (Port or
Property, for example)
Name field, type in an appropriate·

name for the element or, alternatively,
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click on the Auto button to apply the
automatic naming/numbering system
defined for the project
Stereotype field (if required) click on·

the drop-down arrow and select the
required stereotype from the list
Type field, click on the  icon and·

browse or search for and select the
required type from the 'Select Type'
dialog

Click on the OK button to add the
structural element to the parent.

Redefine Click on this option to create a clone of
the structure element, that you can
change the properties of.

Modify Click on this option to edit the properties
of the selected structure element in the
'Modify Embedded Element' dialog,
which has the same fields as the 'Insert
New Embedded Element' dialog
described in the earlier Add New table
entry.

Delete Click on this option to immediately
remove the structure element from the
model.
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Notes

The name of a structural element displays on the diagram·

as a label, which you can edit using the 'Labels' context
menu
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Show Element Use

An object can be used several times in a model; for
example, an image might be used for different elements on
different diagrams, or an element might be represented on
several diagrams depicting different concepts. You can
quickly locate where the object is used in the model, by
selecting a 'Find' menu option that displays the 'Element
Usage' dialog. This lists the occurrences of the object and,
when you select one, the diagram containing that occurrence
opens with the object selected.

You can locate occurrences of:

A Package·

An element·

An image·

You can also list the:

Extension Points of the target Use Case in an <<extend>>·

relationship

Triggers associated with a Transition·

Items conveyed on an Information Flow connector·

Objects derived from an Operation·

If the object:

Occurs once only (such as in one diagram only), the·

object is immediately highlighted in the diagram or
Browser window

Is not used in any diagram, the 'Element Usage' dialog·
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displays with no entries; click on the Close button to close
the dialog

Is used in more than one diagram, the 'Element Usage'·

dialog lists those diagrams; either:
     -  Double-click on a diagram name to open that
diagram (the 'Element Usage' dialog remains open), or
     -  Click on the diagram name and click on the Open
button to open that diagram (the 'Element Usage'
        dialog closes)

The 'Element Usage' dialog defaults to showing, in order,
the 'Usage Type' of the object, 'Diagram Type' and
'Diagram' columns. If you float the cursor over the right
edge of the 'Diagram' column header, so that it changes to ,
you can drag the column border right to expose the hidden
columns 'Diagram ID', 'Object ID' and 'Kind' (do this in
separate passes for each hidden column).

To make the display of information easier to read, you can
resize the 'Element Usage' dialog and drag the borders of the
column headers to the appropriate width for the listed items.
You can also click on a column header and re-sort the items
in the forward or reverse alphanumeric order of the selected
column content.

Locate Objects

This table provides the instructions for locating occurrences
- uses - of different types of object.

Object Type Action
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Element In the Browser window, right-click on the
element and select the 'Properties | Find
in all Diagrams' option.
On a diagram, right-click on the element
and select the 'Find | Find in all Diagrams'
option.
Alternatively, click on the element and
press Ctrl+U.

Package In the Browser window, right-click on the
Package and select the 'Properties | Find
in all Diagrams' option.
On a diagram, right-click on the Package
and select the 'Find | Find in all Diagrams'
option.
Alternatively, click on the Package and
press Ctrl+U.

Image On a diagram, right-click on the element
to which you want to assign an image and
select either the 'Appearance | Select
Default Image' option or the 'Appearance
| Select Alternate Image' option. In either
case, the Image Manager screen displays.
Click on the required image name and on
the Usage button. The 'Element Usage'
dialog displays showing, in this case:

The names of the elements to which the·

(c) Sparx Systems 2022 Page  880 of 1974



Modeling Fundamentals 3 October, 2022

image has already been applied
The name of the diagram on which·

each instance of the image has been
used
The Image Manager image ID for the·

image (a hidden column)
The Diagram ID (DID) for each·

diagram (a hidden column)
The Object ID for each element on·

which the image has been used (a
hidden column)

Click on an element name and on the
Open button to display the diagram on
which the image has been used, with that
instance of the image highlighted.

Use Case
Extension
Point

On a diagram, right-click on the
<<extend>> connector and select the
'Advanced | Extension Point | Set
Extension Point' option.
The 'Element Usage' dialog displays,
listing the Extension Points currently
assigned to the target Use Case element.
Click on the required Extension Point and
on the Open button; the dialog closes, and
the <<extend>> connector shows a small
circle attached to a Note element that
identifies which extension point it
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represents.
If the target Use Case has no extension
points, you are prompted to create them.

Objects
derived from
an operation

In the Browser window, right-click on the
operation and select the 'Properties | Find
in all Diagrams' option.
The 'Element Usage' dialog displays,
listing the Action elements and/or
Sequence Message types derived from
the operation in the model. For a
Sequence Message, in the 'Kind' column,
you can see the value of the 'Kind'
property of the message.
Double-click on an object to open its
parent diagram and show the location of
the object in the diagram.

Triggers
Associated
with a
Transition

On a StateMachine diagram, right-click
on the Transition connector between two
States and select the 'Find Triggers
Associated' option. The 'Element Usage'
dialog displays, listing the Triggers
assigned to the Transition. The 'hidden'
column in this instance is 'GUID',
showing the GUID of each Trigger
element. If you double-click on a Trigger
name, the system locates and highlights
the Trigger element in the Browser
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window.

(Information)
Items
Conveyed

You can also use the 'Element Usage'
dialog to identify and select items
conveyed and/or realized on an
Information Flow connector. On the
diagram, right-click on the connector and
select the 'Find Items Conveyed' menu
option. The 'Element Usage' dialog
displays, listing the items conveyed on
the connector. The 'hidden' column in this
instance is 'GUID', showing the GUID of
each conveyed element. If you
double-click on an element name, the
system locates and highlights the element
in the Browser window.
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Set Up Cross References

It is possible to set up a cross reference (or Custom
Reference) from one or more elements in a diagram to
another element selected in the Browser window. You can
also review the existing cross references on an element,
using the 'Context References' dialog or the Traceability
window.

Set up a cross reference

Ste
p

Action

1 Open the diagram that contains the elements that will
reference the target element.

2 In the Browser window, right-click on the target
element (the object of the cross reference) and select:

'Add | Add Custom Reference' (for a target·

element)
The 'Set up references' dialog displays.

3 Click on the checkbox against each element that is to
refer to the target element.

4 Optionally, in the 'Comment' field, type the purpose
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of the references.

5 Click on the OK button to set the references and
close the dialog.

Use the cross reference

Ste
p

Action

1 Click on the required element in the opened diagram.

2 Either:
Right-click on the element and select 'Find |·

Custom References' or
Press Ctrl+J·

The 'Custom References' dialog displays, showing a
list of elements that have been set as cross references
for the selected element.

3 Optionally, open the 'Properties' dialog for a
referenced element by clicking on it and clicking on
the Open button.
Similarly, open a referenced diagram by clicking on
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it and clicking on the Open button.

4 If you have opened a string of diagram links, click
on the Home button to return to the original diagram.

Notes

You can create cross references from an element on the·

diagram to a number of elements in the Browser window,
and from another element on the diagram to different
elements in the Browser window

You cannot create a commented cross reference from one·

element on the diagram to an element in the Browser
window, and a separate commented cross reference from
a different element on the diagram to the same element in
the Browser window

You can delete a cross reference by selecting it on the·

'Custom References' dialog and clicking on the Delete
button; cross references are also automatically deleted if
the source or target element in the reference is deleted

You can also add, review and delete cross references on·

the 'Cross References' tab of the 'Scenarios' page in an
element's 'Properties' dialog
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Customize Visibility of Elements

Some modeling objects are, by default, not listed in
Packages shown on diagrams, or in report documents. These
include Events, Decisions, Sequence elements, Activity
Endpoints and Association Classes. For example, in this
Event Test Package, the Events and Decisions contained in
the Package are not shown on the Package diagram.

You have the option of turning on display of the hidden
elements.

Access

Ribbon Start > Appearance > Preferences >
Preferences > Objects: Advanced

Display Hidden Elements

Ste Action
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p

1 On the 'Advanced Settings' dialog, select the
checkbox against each type of element to show in
Package diagrams and in report documents.

2 Click on the Close button on each dialog in turn.

3 Reload the current diagram if required.
The Package from the earlier example now shows
the Event and Decision elements it contains.
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Delete Elements from Diagram and
Model

An element might become inappropriate in a certain context,
so you would want to remove it from the diagram in which
that context is represented. It is also possible that the
element becomes unnecessary in the model as a whole, so
you would want to delete it altogether. You therefore have a
number of situations under which you would 'delete' an
element:

Just from a particular diagram·

As a member of a group of elements to be removed from a·

diagram

From a diagram and from the model at the same time·

Directly from the model, through the Browser window·

Delete an element just from a diagram

Ste
p

Action

1 In the diagram, click on the element to delete.

2 Either:
Press the Delete key or Ctrl+D, or·
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Right-click and select 'Delete <element name>'·

The element is immediately deleted from the
diagram, but not from the model. There is no prompt
to confirm the deletion.

Delete a group of elements from a diagram

Ste
p

Action

1 In the diagram, press Ctrl while you click on each
element to delete.

2 Either:
Press the Delete key or Ctrl+D, or·

Right-click and select 'Delete selected elements'·

The elements are immediately deleted from the
diagram, but not from the model. There is no prompt
to confirm the deletion.

Delete an element from the model
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Ste
p

Action

1 Either:
In the Browser window, right-click on the element·

to delete and select 'Delete <element name>', or
In the diagram or Browser window, click on the·

element to delete and press Ctrl+Delete
A confirmation prompt displays, also offering an
option to show the Traceability window so that you
can check the impact of deleting the element.

2 Click on the Yes button.
The element is completely removed from all
diagrams in which it has been used, and from the
model. If you delete an element in this way, you
delete all its properties, child objects and connectors
as well.

Delete multiple elements from the model

Ste
p

Action

1 On the diagram or in the Browser window, press Ctrl
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as you click on the elements to remove from the
model, to select them.

2 Press Ctrl+Delete to completely remove the elements
from the model.
Alternatively, in the Browser window, right-click on
one of the selected items and select the 'Delete
selected item(s)' option.
In either case, a confirmation prompt displays.

3 In the diagram, the prompt is to confirm deletion of
all elements from the model and all diagrams, at
once. Click on the Yes button.
In the Browser window, the prompt offers options to
confirm and delete:

Each element individually (click on the Yes·

button), or
All the elements together (click on the Yes to all·

button)
The elements are completely removed from all
diagrams in which they have been used, and from the
model. If you delete elements in this way, you delete
all their properties, child objects and connectors as
well.
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Create Notes and Text

One aspect of modeling is to describe and document the
purpose and use of an element in the context of a particular
diagram. You can provide such documentation in the form
of Note or Text elements displayed with and connected to
the elements they describe.

Both Note and Text elements display text on the diagram; a
Note element contains the text within a border with a
background color and a turned-down corner image, whilst a
Text element has no border or background color. Otherwise
they behave in the same way.

Access

Context
Menu

Right-click on element | New Child
Element | Attach Note

Other Diagram Toolbox : from the 'Common'·

page, drag the Note or Text icon onto
diagram - drag the Quick Linker arrow
from the Note element to connect to the
element being annotated
Drag the Quick Linker arrow from an·

element into an empty space on the
diagram > Common > Note
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Complete a Note or Text element

The element displays on the diagram.

If, on the 'Objects' page of the 'Preferences' dialog, the 'Edit
Object On New' checkbox is deselected, the Notes window
displays, and you can type the element text within it. To
display the text in the element, click on the element.

If the checkbox is selected, the 'Notes Properties' dialog
immediately displays; type your text in the dialog, and click
on the OK button to display the text in the element.

In either case, if you want to display the text in a more
readable layout, you can resize the Notes window or dialog,
and you can also format the text using the Notes toolbar.

Note element appearance

It is possible to change the appearance of a Note element, by
right-clicking on the element and selecting one of the
'Appearance' menu sub-options. The available images are:
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The two Memo-style images list all the elements that the
Note is linked to, in the 'Applies to:' field. You can hide the
actual Notelink connectors, so that the Note identifies the
elements it refers to without complicating the diagram
appearance by having the connectors visible. To hide (and
reveal) the connectors, click on the element and select the
'Advanced | Hide (Show) attached links' option.

You can also configure Enterprise Architect to display the
text in all Notes and Text elements in italics. Select the 'Start
> Appearance > Preferences > Preferences' ribbon option
and on the 'Diagram > Appearance' page select the 'Italic
Note Element text' checkbox. This has an immediate effect,
as does clearing the checkbox to show the text in normal
font.

Notes

You can also create a Note or Text element by clicking on·

the New Note or New Text Element icon on the UML
Elements toolbar and clicking on the diagram

When you have created your Note or Text element, you·

can leave it free-standing to display information on the
diagram, or you can connect it to the specific modeling
element or elements it describes using a Notelink
connector, which you also drag from the Common

(c) Sparx Systems 2022 Page  895 of 1974



Modeling Fundamentals 3 October, 2022

toolbox

Instead of typing in text for the element, you can reflect·

an element's internal documentation, such as the value of
a constraint or feature

(c) Sparx Systems 2022 Page  896 of 1974



Modeling Fundamentals 3 October, 2022

Link Note to Internal Documentation

Whilst a Note often contains information in addition to that
contained within other elements, you can also expose the
internal description of a feature or property of an element. In
this way you can externalize model documentation at the
diagram level, and as the system keeps the Note and the
internal text in synch, you do not have to update the Note; in
fact, you are blocked from editing the Note text, because it
is maintained automatically.

Similarly, it is also possible to expose the Notes text of the
diagram properties in a Note element.

In this example, two Notes are connected to an element's
internal structures. One Note is connected to an attribute and
displays the attribute name and notes. The other is
connected to a constraint, showing the constraint name and
documentation.

Connect a Note element to another
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element's feature

Ste
p

Action

1 Click on the target element and then click on the
feature itself, so that it is highlighted for inline
editing.

2 Right-click on the feature and select the menu option
'Create Linked Note'.
This creates a Note element linked to the selected
feature, reflecting the content of that feature.

Alternatively

Ste
p

Action

1 Insert or identify the target element in a diagram.

2 Drag the 'Note' icon from the 'Common' page of the
Diagram Toolbox onto the diagram, next to the
target element.
The 'Notes' dialog displays. Do not type any text,
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simply click on the OK button.

3 Click on the 'Note Link' icon from the 'Common'
page of the Toolbox, and drag the cursor from the
Note to the target element to create the connector.

4 Right-click on the Note Link to display the context
menu, and select 'Link this Note to an Element
Feature'.
The 'Link note to element feature' dialog displays.

5 In the 'Feature Type' field, click on the drop-down
arrow and select the type of feature to link to.
The 'Feature' list now shows the features of the
selected type in the element.

6 In the Feature list, click on the specific feature to
link to, and click on the OK button.
The Note now automatically shows the contents of
the feature's Notes or Description field, and is
automatically updated with any changes to this field.

Connect a Note element to the diagram
Notes text
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Ste
p

Action

1 Open the diagram and right-click on the background.

2 Select the 'Properties' menu option, type an
appropriate description in the 'Notes' field, then click
on the OK button.

3 Drag the 'Note' icon onto the diagram, from the
'Common' page of the Toolbox.
The 'Notes' dialog displays.
Simply click on the OK button.

4 Right-click on the Note element and select
'Advanced | Link to Diagram Note'.
The Note now automatically shows the contents of
the diagram's 'Notes' field, and is automatically
updated with any changes to this field.

Notes

You can unlink a Note linked to an element feature,·

leaving the Note text, which can be edited manually and
directly as normal; to unlink the Note from an element
feature, either:
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     -  Right-click on the Note and select the 'Advanced |
Unlink from Element Feature' option, or
     -  Right-click on the Notelink connector, select the
'Link this Note to an Element Feature' option and,
         on the 'Link note to element feature' dialog, set the
'Feature Type' field to 'None'
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Resize Elements

You can change the size of an element, or of several
elements in a group, using the cursor or various menu
options.

Resize using handles

Image Detail

Select an element or group of elements in
the diagram, then:

(Single element) With the mouse, drag·

the resize handles that appear at each
corner and side, to resize the element
(the cursor switches to the
double-ended arrow as shown in the
image)
If you have enabled the 'Layout >
Alignment > <grid options> Smart
Placement' and 'Show smart placement
guides' options, as you move the resize
handles the guide lines display to show
where the resizing top, bottom, sides or
edge center points are in relation to an
adjacent element, but note that the
objects must be contemporary - not at
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different hierarchical levels or in
different partitions of the diagram
Press and hold Ctrl and use the Arrow·

keys to resize elements by increments;
to make elements:
     -  Wider - press Ctrl+Right Arrow
     -  Narrower - press Ctrl+Left Arrow
     -  Taller - press Ctrl+Down Arrow
     -  Shorter - press Ctrl+Up Arrow
Autosize selected element(s) to their·

default size using 'Layout > Diagram >
Select > Autosize Selected Elements',
or by pressing Alt+Z

If you select multiple elements, 'Autosize'
is also available in the right-click context
menu for the elements.

Resize a Set of Objects to a Specific Size

Image Detail

If you right-click a selected set of objects,
you can resize them to the same
dimensions (height, width or both) using
context menu options.
When you select multiple elements using
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Ctrl+click, you can right-click and select
options that use the dimensions of the
last-selected (hatched) object to set the
dimensions of the other selected objects.
For example, in this diagram, the
Message Class height and width are used
to set the height and width of the Account
and Message Folder Classes.
The steps are:

Set one element to the required size1.
(for example, Message).
Select that element and the elements to2.
resize (for example, Account and
Message Folder).
Right-click on the pre-sized element3.
(Message).
Select the appropriate resizing option4.
('Same Height', 'Same Width', or 'Same
Height and Width').
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Align Elements

When you have created a number of elements on a diagram,
you might want to organize them in groups so that they form
a column or row with a uniform edge. You can do this
quickly and easily by selecting the group of elements and
aligning them all against the left, right, top or bottom edge
or center of one element in the group. You can also space
three or more elements evenly in a row or column, at an
average of their previous separations.

The selected elements are aligned with respect to the
'context' element, which is the element that has a hatched
border drawn around it. You can set a given element as the
'context' element by clicking on it or when you add it to the
current selection group using 'Ctrl+Click'.

Access

Ribbon Select a set of elements, then
Layout > Alignment > <alignment·

button>

Context
Menu

Select a set of elements, then right-click
on a selected element and choose:

Align Left·

Align Right·
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Align Top·

Align Bottom·

Align Centers |Vertically·

Align Centers | Horizontally·

Align Centers | Left to Center (left edge·

of elements align with center of
last-selected element)
Align Centers | Right to Center (right·

edge of elements align with center of
last-selected element)
Align Centers | Top to Center (top edge·

of elements align with center of
last-selected element)
Align Centers | Bottom to Center·

(bottom edge of elements align with
center of last-selected element)
Space Evenly | Across·

Space Evenly | Down·

Keyboard
Shortcuts

Select a set of elements (ensuring that the
'context' element is correctly set), then

Ctrl+Alt+Left Arrow (align left)·

Ctrl+Alt+Right Arrow (align right)·

Ctrl+Alt+Up Arrow (align top)·

Ctrl+Alt+Down Arrow (align bottom)·

Alt+'-'  (space evenly across)·

Alt+'=' (space evenly down)·
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Other Click on the context element in the
selection and on the  icon, then select
the appropriate alignment icon from the
toolbar.

Align multiple elements

Ste
p

Action

1 Select a group of elements.

2 Right-click on the element in the group to align
others to.
The context menu displays.

3 Select the alignment function you require.
All selected elements are aligned with the one
beneath the cursor.
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Notes

You can also use the first four buttons of the Diagram·

toolbar to align elements; these are made available when
more than one element is selected in a diagram

If you have a single element that you want to move into·

alignment with another, an alternative method is to use the
'smart placement guides' which indicate where the
navigation points (edges and center points of edges) on
the element are in relation to the adjacent element
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Set an Element's Default Appearance

All elements that you use have global default appearance
settings for:

The fill, border and font colors·

Font styles, including font face and size·

The border thickness·

You define these settings on the 'Preferences' dialog.
However, you can change the default appearance for a
specific element on all diagrams on which it is found, using
the 'Default Appearance' dialog.

Access

Context
Menu

Right-click on element | Appearance |
Default Appearance

Keyboard
Shortcuts

F4  or
Ctrl+Shift+E

Options
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Option Action

Background
Color

Click on the drop-down arrow and select
the fill - or background - color of the
element.
If you want to use a color that is not
available, click on the More Colors
button and define the required color.

Border Color Click on the drop-down arrow and select
the border color for the element.
If you want to use a color that is not
available, click on the More Colors
button and define the required color.

Border Width Type in the width of the border
surrounding the element, or use the
increment/decrement arrows to the right
of the field.
The minimum width setting is 1, the
maximum is 5.
If you set this value to the current model
default value, any updates to the default
value are immediately applied to this
local 'Border Width' field, until you
specifically reset the local field to a
non-default value. (The current model
default border width is set in the 'Default
Element Border Width' field; select the
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'Start> Appearance > Preferences >
Preferences' ribbon option and the
'Diagram > Appearance' page.)

Font Style Displays the current font typeface for the
element text. To change this, click on the

 button.
The 'Font' dialog displays, on which you
can select a different typeface, style (such
as bold/italic) and font size.
You can also select to use or cancel
underlines, and (if necessary) select a
different script classification.

Font Color Click on the drop-down arrow and select
the font color to apply to the text of the
element.
If you want to use a color that is not
available, click on the More Colors
button and define the required color.

Reset to
defaults

(Optional) Click on this button to reset all
appearance settings to the system default
values.

Preview Displays a representation of the colors,
border width and font styles, which
updates as you choose the new settings.
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OK Click on this button to close the dialog
and apply the appearance settings you
have defined.

Cancel Click on this button to close the dialog
and abort all the changes you have made
within the dialog.

Notes

You can adjust several elements at the same time; select·

all of the required elements, right-click on one of them
and select the 'Appearance | Default Appearance' option

You can also define for the element a default image that·

displays for all instances of the element in diagrams
across the model

If the 'Show Project Custom Colors in Color Combo·

Boxes' checkbox is selected on the 'Standard Colors' page
of the 'Preferences' dialog, the last 16 color squares in the
color selection palettes contain the project colors set on
that page

The 'Font Color' field affects only the element name text;·

it does not override the feature text colors as defined on
the 'Standard Colors' page of the 'Preferences' dialog

When called from the 'Default Appearance' dialog, the·

'Color' field on the 'Font' dialog is not available; font color
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is set in the 'Font Color' field on the 'Default Appearance'
dialog

The 'Font' and 'Font Style' fields on the 'Font' dialog affect·

all text except for the Note compartment text

The 'Size' field on the 'Font' dialog affects all text·

An alternative option for changing an element's·

appearance is to define a stereotype that has different fill,
border and font settings, or that has either a Shape Script
or an image file associated with it; you can then assign the
stereotype to the element to change the element's
appearance to that defined by the stereotype

The 'Default Appearance' options override all other styles·

except those set via a Shape Script (such as fill color and
line width) or those applied locally on a diagram (using
options in the Layout | Style panel of the ribbon, for
example)
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Change Element Type

You might find that an object that you have represented as
one type of element would be better represented as another
type. The 'Select Element Type' dialog allows you to change
the type very quickly and simply.

Access

Ribbon Design > Element > Manage > Change
Type
Explore > Portals > Windows >
Properties > Properties : In the Type field
of the Properties window, click on the 
button
Start > Application > Design > Properties
: In the Type field of the Properties
window, click on the  button

Change Type

On the 'Select Element Type' dialog, click on the 'Element
Type' drop-down arrow and select the new element type
from the list.
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Click on the OK button.

The target element is transformed into the required type.

Notes

This operation is effective on basic UML elements, but·

has limited use for profile-stereotyped elements such as
those used in BPMN or ArchiMate modeling
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Make Linked Element a Local Copy

When you use an element on more than one diagram, you
drag the element from the Browser window and drop it onto
the diagram either as a link to the original element or as a
separate instance or copy of the original element.
Subsequently, you might decide to change a link to the
element into a new object, as a local copy of the element in
the same Package as the diagram. You can do this very
quickly and simply by selecting a menu option.

Access

Context
Menu

On diagram, right-click element |
Advanced | Convert Linked Element to
Local Copy

Notes

'Convert Linked Element to Local Copy' will only be·

available if the element being converted and the diagram
it is on are in different Packages.
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Insert Related Elements

Elements can be used more than once in a model, either
individually or as a group. If you want to reproduce an
existing set of elements that have one element as the focus,
without copying and linking the elements individually in the
new diagram, you can use the Insert Related Elements
facility. With this facility, you drag the context element
from the Browser window onto your diagram, right-click on
it and select to add related elements. The 'Insert Related
Elements' dialog displays, on which you can specify:

Which types of relationship to filter on, and what·

direction these relationships have

Which types of element to filter on·

Which Package the related elements exist in·

How many levels of relationship to bring in; that is, just·

the elements immediately related to the focus element, or
also elements related through those elements

Whether to add all elements that satisfy the criteria you·

have specified, or just those you select

Whether or not to automatically re-organize the diagram·

when the related elements have been added

Access

First, select an element on the diagram, then:
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Ribbon Design > Element > Add Element >
Related Element

Context
Menu

Right-click on element | Insert Related
Elements

Define selection criteria to insert related
elements

Field/Button Action

Connector
types

Displays the types of relationship in
which the selected element and, if more
than one level of relationship is selected,
its related elements are currently
involved.
To limit the inserted elements to those
connected by specific relationship types,
select the checkbox against each of those
types of connector.
To deselect a selected checkbox, click on
it again.

Element
types

Display the types of element to which the
selected element and, if more than one
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level of relationship is selected, its related
elements are connected.
To limit the inserted elements to those of
specific types, select the checkbox
against each of those types.
To deselect a selected checkbox, click on
it again.

Link
Direction

Limit the inserted elements to those in
incoming or outgoing relationships with
the selected element; click on the
drop-down arrow and select the
appropriate direction, or <All> for either
direction.

Limit to
Namespace

Restrict the inserted elements to those
from a specific Package; select the
namespace from which the elements are
to come. Select <None> for elements in
any namespace.

Find
relationships
to: levels

Click on the drop-down arrow and select
the level down to which to insert
connected elements, between levels 1
(immediately related elements) and 5
(elements 5th in a chain from the focus
element).
You can select levels 4 or 5 to see how
far the element/relationship hierarchy

(c) Sparx Systems 2022 Page  919 of 1974



Modeling Fundamentals 3 October, 2022

extends, but as this can produce a
complicated and tangled diagram, it is
better to use level 1 or 2 on selected
elements in turn.

Refresh Click on this button to locate and list all
elements that satisfy the criteria you have
specified.
Each list item shows the depth at which
the related element exists in relation to
the focus element, the name of the
element, its parent Package, and whether
it is currently in the diagram.
If there are many entries, you can
re-organize them for clarity using the
'Drag a column header...' panel.
If you want to add an element to your
diagram, select the checkbox against that
element. Alternatively, to select all
elements, click on the All button.
To deselect all selected checkboxes, click
on the small Clear button.
To empty the list panel altogether, click
on the large Clear button.

Layout
Diagram
when
complete

Select the checkbox if you want the
system to layout the diagram after the
elements have been inserted; the layout
applied is the Digraph layout.
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If no elements have been added, this
option has no effect; elements have to be
added for the system to adjust the layout.

OK Click on this button to add the selected
elements to the diagram and close the
dialog.

Notes

If the selected element has a relationship to an·

edge-mounted structural element such as a Port or
Exposed Interface, adding the Port or Interface to the
diagram using the 'Insert Related Elements' dialog will
also add the associated parent elements onto the diagram,
if they are not already shown
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Highlight Context Element

When you click on an element on a diagram, it becomes the
context element; that is, all actions take effect on that
element. The context element has black rectangles on its
border, firstly to indicate that the element is selected and
secondly to act as 'handles' that you can click on and drag to
enlarge or shrink the element.

Many actions that you can take on an element involve
selecting menu options or working on windows and dialogs
that are separate from the element, and on a large or
complex diagram you can lose track of the context element.
To make every context element more visible, you can
configure the system to add a hatched border to the element.

Access

To add a hatched border to the context element, open the
'Preferences' dialog using one of the methods outlined here,
then select the 'Always Highlight Context Element'
checkbox on the 'Diagram Behavior' page.
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Ribbon Start > Application > Preferences >
Preferences > Diagram > Behavior:
Always Highlight Context Element

Multiple Selection

If you select multiple elements to work on at the same time,
the context element has a hatched border by default,
regardless of whether the 'Always Highlight Context
Element' checkbox is selected or not. The context element
here is the element against which other selected elements
are aligned, or through which the changes to properties are
made.

Notes

If you have selected multiple elements and you want to·

change which element is in context, simply click once on
the element that is to become the context element
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Move Features Between Elements

As well as moving elements between Packages in the
Browser window, you can also drag and drop features -
attributes and operations - between elements to move them
out of the source element and into the target element.

Move element features

Perform these actions in the order in which they are listed.

Images Action

In the Browser window, click on the
attribute or operation to move from the
source element.
If you are moving several features at
once, while you click on the features hold
down:

Ctrl (several individual features) or·

Shift (the first and last features in a·

range)

Holding down the mouse button, drag the
attributes and/or operations to the target
element.
A single feature symbol (and, under some
operating systems, the first feature name)
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displays under the cursor during the
move; however all of the selected
features are moved.

Release the mouse button.
The features that you selected and
drag/dropped are now features of the
target element, as seen in the Browser
window.
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Copy Features Between Elements

As well as copying elements between Packages using a
diagram, you can also copy features - attributes and/or
operations - between elements in a similar way, dragging the
features from an element in the 'Project' tab of the Browser
window or 'Details' tab of the Inspector window and
dropping them onto another element in a diagram.

Copy a single element feature

Open a diagram containing the target element. In the
'Project' tab of the Browser window or 'Details' tab of the
Inspector window, click on the attribute or operation and
drag it onto the element in the diagram.

In this example, the attribute Account is being dragged and
copied from the Customer element on the 'Project' tab into
the AccountItem element in a diagram. The process from the
'Details' tab is, visually, almost identical.

This image shows AccountItem after the attribute Account
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has been dropped on to it.

Notes

You can also select and copy multiple features at the same·

time; you simply press Ctrl or Shift as you select the
features in the element in the 'Project' tab of the Browser
window, drag them onto the diagram and drop them into
the target element (you cannot copy multiple features
from the 'Details' tab of the Inspector window)
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Copy Elements

You can quickly and easily duplicate one or more elements,
with their child elements and diagrams, under other
elements or Packages. You can insert a copy of an element
under one or more other elements or Packages, in the same
project file or any other project file.

It is not possible to duplicate an element on the same
diagram, but you can generate representations of the
element at the ends of connectors, called virtual connector
ends. See the Virtual Connector Ends - Represent One
Element Several Times on a Diagram Help topic.

Operations

Operation Actions

Copy the
Elements

In the Browser window, select the
elements to copy, right-click on one and
select:
     'Copy / Paste | Copy to Clipboard |
Full Structure for Duplication'
Alternatively, click on a selected element
and press Ctrl+Shift+C.
The 'Copying Selected Element(s) to
Clipboard' dialog briefly displays while
the copy operation completes.

(c) Sparx Systems 2022 Page  929 of 1974



Modeling Fundamentals 3 October, 2022

Paste the
Elements

In the Browser window, right-click on the
element or Package into which to paste
the copied elements, and select the 'Copy
/ Paste | Paste Element(s) from Clipboard'
option.
Alternatively, click on the Package and
press Ctrl+V.
The 'Pasting Element(s) from Clipboard'
dialog briefly displays while the paste
operation completes.
The target element or Package is
expanded and the pasted elements are
exposed in the Browser window. If you
are pasting the elements within the same
model as the copied source, the source
parent Package is also collapsed.
If the target element or Package already
contains:

An element of the same type with the·

same name as a pasted element, the
pasted element name has the suffix -
Copy
An element with the same type and·

name as the pasted element including
the - Copy suffix, the suffix becomes -
Copy1 (or - Copy2, - Copy3 and so on,
as copies of the element accumulate in
the target element or Package)
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You can keep the same element names as
the source, or you can rename each
element either by clicking twice on it and
editing the name in the Browser window,
or by double-clicking on it and editing the
name in the 'Properties' dialog.

Notes

If you want to copy any elements to paste under another·

element, the target element must be capable of receiving
the child elements; for example, you cannot paste a Class
element as a child of a Port

A copy of an element does not have the external cross·

references of the source element; that is:
     -  if one element is copied it has no connectors
     -  if more than one element is copied, only the
connectors between the copied elements are
        retained
     -  however, if those elements come from a Sequence or
Communication diagram and the diagram
        itself is not copied, the message connectors between
the copied elements are not retained

You cannot paste an element into an element or Package·

that is locked by another user or that is checked in; the
'Paste...' option is grayed out in the context menu
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Move Elements Between Packages

If an element or Package is not in the most appropriate part
of the model structure, you can move it to a different
location in the Browser window, either by:

Dragging and dropping the element to a target destination,·

or

Cutting and pasting the element or Package·

If you move a Package, all the subordinate Packages and
their contents are moved to the new location also.

Drag an element between Packages

Ste
p

Action

1 Click on the element in the Browser window.
See 'Customer' in the example diagram.

2 Drag the cursor so that it is over the target Package
icon.  The 'drop element' cursor is displayed while
dragging.
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3 Release the mouse button.
The element is moved into the target Package.

Cut and Paste the Element

Ste
p

Action

1 In the Browser window, right-click on the element to
be moved and select the 'Copy / Paste | Cut' option.
The selected element is highlighted.

2 Right-click on the Package or element under which
to move the cut element, and select the 'Copy / Paste
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| Paste' option.
The cut element is listed as a child of the selected
element or Package, in the Browser window.

Notes

You can also drag the element under a host element in the·

new Package; for example, drag an element under a Class

Moving an element has no effect on any relationships that·

the element might have

Moving an element in the Browser window has no effect·

on the use of that element in any diagram

Moving a diagram generally does not affect the location·

of elements in Packages - if you move a diagram out of
one Package into another, all the elements in the diagram
remain in the original Package; however, certain elements
(such as Decision, Initial and Final elements) are used
only within one diagram, have no meaning outside that
diagram, and are never re-used in any other diagram,
therefore, if you move a diagram containing these
elements they are moved to the new parent Package with
the diagram

In a multi-user environment, if one person moves or·

updates the Browser window structure, other users must
reload their project to see the latest changes in the
Browser window; although this is true of any addition or
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modification to the tree, it is most important when big
changes are made, such as dragging a Package to a
different location
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Set Element Font

When you display an element on a diagram, the text font
defaults to a global setting defined from the 'Diagram
Appearance' page of the 'Preferences' dialog. You can
change this global default setting if you need to. On the
diagram, however, you might want to change the font only
on a specific element or group of elements, to distinguish
them from other elements. You have several options for
doing this.

Access

Select the element in a diagram, then use one of these
options.

Ribbon Layout > Style >  (Set Font)

Diagram Click on an element |  (Format Toolbar) |
 (Set Font)

or
Right-click an element | click  (Set
Font)  in the toolbar above the context
menu

(c) Sparx Systems 2022 Page  937 of 1974



Modeling Fundamentals 3 October, 2022

Font Dialog Options

Option Action

Font Scroll through the list of font types and
click on the name of the appropriate font,
which is then displayed in the field at the
top of the list.
This setting affects all text in the selected
element except for the Note compartment
text.

Font Style In the list of font styles click on the name
of the appropriate style, which is then
displayed in the field at the top of the list.
This setting affects all text in the selected
element except for the Note compartment
text.

Size Scroll through the list of font sizes and
click on the appropriate size, which is
displayed in the field at the top of the list.
Alternatively, type the font size directly
into the field.
This setting affects all text in the selected
element.

Strikeout (This checkbox is not currently
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available.) Select this checkbox to show
the element text with a line through it.

Underline Select this checkbox to show the element
text with an underline.

Color Simply click on the drop-down arrow and
click on a color in the list.
Notes:

If you access the 'Font' dialog through·

the 'Font Style' field of the 'Default
Appearance' dialog, the 'Color' field
will be inactive
The color option at the top of the·

drop-down list is the 'Default' color set
on the 'Preferences' dialog (or, if this
has been overridden for this element,
the color set in the 'Default
Appearance' dialog)
If the current font color is a custom·

color applied through, for example, the
Format Toolbar in the diagram, that
color is second in the list, identified by
the 'Custom' option

Script If Western script is not appropriate for the
element text, click on the drop down
arrow and select a different script type.
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Sample Review the combined effects of the
settings you have selected.

OK Click on this button to save your changes.

Cancel Click on this button to close the dialog
without saving any changes.

Notes

If you set the element font through the 'Default·

Appearance' dialog (F4) the changes can be overridden by
any different values set through the other two access paths

The 'Font' dialog overrides the 'Default Appearance'·

dialog for all selected elements when the font is applied.
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Set Up Templates Package

In building up a model, you might want to represent or
emphasize certain characteristics of elements in the
appearance of those elements on a diagram, or select
particular display options as standard. For example, you
could make new Interface elements a different default color
to new Class elements, ensure all new Activity Partitions are
vertical rather than horizontal, or set a specific group of
display options for new Use Case diagrams.

To do this, you create an element or a diagram with all the
characteristics you require, and store it in a Templates
Package; the system then checks this Package:

Whenever you create a new diagram, or·

Whenever you start to create an element using the·

Diagram Toolbox

When you are creating a new diagram, the system checks
for the diagram type in the Templates Package and, if it
finds that diagram type, will copy the display options of the
template diagram into the new diagram.

When you are creating a new element, the system checks for
that element type in the Templates Package and, if it finds
that element type, will copy the template element as defined.
The definition includes any default display options of the
template element, so you can apply the template definition
and switch to the default appearance for the new element, if
you prefer.

In this image, a 'Class' element has been dropped onto the
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diagram in the Templates Package.  It is created with the
default appearance of the base element.

In the next image, the appearance of the element
'Template_Class' on the diagram 'Template Class Diagram'
has been updated, using the tools from the Style panel of the
Layout ribbon.  Note however, that the default appearance
of the element 'Template_Class' remains unchanged.
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When a new 'Class' element is created from the toolbox, it is
created with the same default appearance properties as the
underlying template element, however its appearance on the
diagram where it is created, replicates the appearance of the
template element on the template diagram.
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You can revert the element's appearance back to the default,
by selecting the element and applying the 'Default Style'
from the Layout ribbon, or by choosing the ribbon option
'Layout > Diagram > Appearance > Reset Local Element
Appearance'.
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Similarly, if 'Class1' was deleted from 'New Class Diagram'
(but not from the model) and then dropped back onto the
diagram from the Browser window, it would be created
using the default appearance copied from Template_Class,
not the appearance displayed on the template diagram.

You can create the Templates Package anywhere in your
model; however, it is better to create it in a location that is
not likely to be accidentally changed or lost in any project
development work.

Set up the Element Templates Package

Ste
p

Action

1 Create a new Package. 'Templates' is used as the
Package name in the illustration, but you can give
the Package any name you prefer.

2 Within the template Package create new diagrams,
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one for each type of diagram to template.
Give the diagrams easily recognized names; for
example Class Template for the template for Class
diagrams.

3 Add elements to the template Package (each element
must also appear on one, and only one, diagram),
and configure the size, appearance, notes, version
and other properties that you want new elements to
have. You can use a standard UML element or a
stereotyped element as the base for your template
definition.

4 To specify the Package to use as the Templates
Package, select the ribbon option 'Settings >
Reference Data > Settings > Project Template
Package'.
The Find Package window displays.

5 Locate and click on the Package you wish to set as
the Templates Package, then click on the OK button.
(You can set only one Package at a time as the
Templates Package.)
Now each new element or diagram you add to your
project is created with the settings from the
appropriate template element or diagram.
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Notes

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Manage Reference Data - Update' permission to set up or
access the Templates Package

The fill color for an element derived from the template·

can be overridden by the element fill color defined by a
Shape Script applied to the element via a stereotype, or
you can switch to or change the default appearance in the
'Default Appearance' dialog

If you decide not to use any templates, set the Templates·

Package to '<none>' in the Find Package window; the
'<none>' Package is at the bottom of the hierarchy shown
in the window

An alternative way in which you can modify the·

immediate appearance of elements as you create them in
diagrams is to redefine them, either under the same type
name or as new element types, in a UML Profile
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Apply Auto Naming to Existing
Elements

If you have set up auto-naming conventions for the names
and/or Aliases of specific types of element, you can apply
those conventions to all of the existing elements of those
types in a selected Package, in one operation.

You apply auto-naming through the 'Apply Auto Naming to
Elements' dialog. This groups the elements that have
auto-naming conventions by type, and shows the effects of
applying the conventions to the element names and/or
Aliases and stereotypes. You can change all the element
names in the Package, or select only certain elements to
update.

Access

Ribbon Click on Package: Design > Package >
Manage > Auto Naming

Apply Auto-naming to Elements

Option Action
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Current
Name

Initially displays a contracted group for
each element type that has auto-naming
conventions, showing the number of
elements of that type in the selected
Package.
Click on the expansion arrow to expand
the type group and list the elements
within it by their current name, with the
most recently created element first.
Select the checkbox against each element
to be renamed, or against the group name
to select all elements in the group.
Deselect the checkbox to leave the
element name and Alias at their current
values.

Name
Preview

Initially shows the current name of each
element.
When you select the checkbox against an
element, the name changes to show the
effect of applying the auto-naming
conventions to it.

Alias
Preview

Initially shows the current Alias of each
element.
When you select the checkbox against an
element, the Alias changes to show the
effect of applying the auto-naming
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conventions to it.

All Click on this button to select all elements
listed on the dialog.

Clear Click on this button to clear the
checkboxes of all selected elements.

Update Name
Panel

Prefix Auto
Name to
Current
Name

Click on this radio button to set the new
element names to the auto-name text
followed by the current name. That is, of
this structure:
     MyPrefix00001MySuffix Original
Name

Overwrite
current Name
with Auto
Name

Click on this radio button to set the new
element names to the auto-name text
only. That is, of this structure:
MyPrefix00001MySuffix

Move current
Name to
Notes
Apply Auto
Name

Click on this radio button to show the
current name in the 'Notes' field in the
element 'Properties' dialog (in front of
any existing notes) and overwrite the
element 'Name' field with the auto-name.
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No change Click on this radio button to leave the
current names unchanged. That is, review
what the auto-naming would look like but
do not apply it.

Update Alias
Panel

Prefix Auto
Alias to
Current Alias

Click on this radio button to set the new
element Aliases to the auto-Alias text
followed by the current Alias. That is, of
this structure:
     MyPrefix00001MySuffix Original
Alias

Overwrite
current Alias
with Auto
Alias

Click on this radio button to set the new
element Aliases to the auto-Alias text
only. That is, of this structure:
MyPrefix00001MySuffix

Move current
Alias to
Notes
Apply Auto
Alias

Click on this radio button to show the
current Alias in the 'Notes' field in the
element 'Properties' dialog (after any
replaced element name text, but in front
of any existing notes) and overwrite the
'Alias' field with the auto-Alias.

No change Click on this radio button to leave the
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current Aliases unchanged. That is,
review what the auto-Aliases would look
like but do not apply them.

Include sub
packages

Select this checkbox to include elements
in sub-Packages in this run of applying
auto-naming (the checkbox reverts to
deselected when the dialog is closed).

Configure
Auto Naming

Click on this button to immediately
define automatic naming conventions for
an element type if:

You want to change the conventions·

for the element type, or
The element type that you want to·

apply auto-naming to has no
conventions (and is therefore not listed
on the dialog)

The 'Auto Name Counters' dialog
displays, on which you define your
automatic element and/or Alias naming
convention. When you click on the Save
button on that dialog, any elements of
that type in the Package are listed on the
'Apply Auto Naming to Elements' dialog.

OK Click on this button to close the dialog
and put the naming changes into effect.
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Cancel Click on this button to close the dialog
and cancel any naming changes you have
defined.

Notes

If you select this facility and there have never been any·

auto-naming conventions defined in the model, the
message There are no configured auto naming elements
contained in the selected package is displayed; click on
the Configure Auto Naming button to define any
conventions for any element type you need

The contents of Packages that are locked under Version·

Control will not be auto-named

Because you are applying auto-naming to existing·

elements, the auto-naming set up 'Apply on Creation'
setting has no impact on this operation

The 'Apply Auto Naming to Elements' dialog is resizable;·

if you want to expand or reduce the dialog, drag its edges
to the size you want
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Add Elements Directly To Packages

You can quickly add new elements to a Package without
necessarily adding the element to a diagram at the same
time. This is particularly useful in defining a group of
Requirements, Changes, Issues, base Classes or other
element types that you might not need to represent on
diagrams in the model.

The fastest and simplest method is to just select an existing
element and then press Ctrl+Shift+N to create another
element of the same type in the same location, enabling you
to create several elements in quick succession. In that case
you would subsequently use the Properties window or
'Properties' dialog to enter the element names and any other
required details.

The other methods described here display the 'New Element'
dialog, on which you specify the element name and other
details to create identified elements individually. In this case
you also have the option of adding the element to the current
open diagram.

Access

Ribbon Design > Element > Add Element >
Element
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Context
Menu

Right-click on Package | Add Element

Keyboard
Shortcuts

In the Browser window, with an element
selected: Ctrl+Shift+N (to create another
element of the same type in the same
location)
With a Package selected in the Browser
window: Ctrl+M
In a diagram, press the M key

Other Browser window header bar menu | New
Element

Add an Element to a Package

Option Action

Toolset In the first field, click on the drop-down
arrow and select a Perspective to filter the
types of element offered for selection to
those available through the Perspective.
Note that selecting a Perspective from the
'Toolset' field list does not change the
current 'global' Perspective shown in the

<perspective name> icon. If you want
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to re-set the 'Toolset' Perspective to the
global Perspective, simply click on the
drop-down arrow and select 'Active'.
In the second field, click on the
drop-down arrow and select the UML
diagram type, Profile, Add-In or MDG
Technology to further filter the element
types to that diagram type, technology,
Profile or Add-In within the Perspective.

Name Type the name of the element.

Auto As an alternative to typing in the name,
click on this button to insert predefined
auto-counter text.
If you already have some text in the
'Name' field, it is over-written by the
auto-counter text.

Type Click on the drop-down arrow and select
the required element type from the list.
The list of element types is derived from
the diagram or technology shown in the
'Toolset' field.

Stereotype If required, either type the stereotype
name or click on the drop-down arrow
and select the stereotype.
This field is not available if the element
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you are creating is an extended element
that already has a stereotype.

Add Element
to Diagram

This checkbox is available if you have a
diagram open and you are working from
the Browser window.
The checkbox defaults to selected to add
the new element to the diagram also; if
you do not want the element in that
diagram, deselect the checkbox.
If you accessed this dialog by pressing
the M key on the open diagram, this
checkbox is not available. The element is
automatically added to the diagram, in
the center.

Show Name
Under Image

This checkbox is available if you have a
diagram open and you have dragged an
Image Artifact element onto the diagram
from the Browser window. It defaults to
selected to print the element name
underneath the image shown in the
Artifact element. If you clear the
checkbox, the element name is not
shown.

Save Click on this button to create the element
and close the dialog.
If you accessed this dialog by pressing
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the M key in an open diagram:
the element is created in the center of·

the diagram, and
the dialog remains open·

If you accessed the dialog by selecting
the 'New Element' option from the
Browser window header bar ('Hamburger'
icon), clicking on this button also leaves
the dialog open.

Save and
Close

Available if you have accessed this dialog
by pressing the M key on an open
diagram, or by selecting the 'New
Element' option from the Browser
window header bar ('Hamburger' icon).
Click on this button to create the element
and close the dialog.

Cancel Click on this button to abort the changes
and close the dialog without creating an
element.

Notes

The 'New Element' dialog also displays when you create·

an element in the Specification Manager, if the
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Specification Type is <Any>
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Auto Names and Counters

When you create a new element in your model, you have
different options for naming the element depending on how
you are creating it. If you create the element:

On a diagram, the system applies a default naming·

convention of the element type plus the increment of the
number of elements of that type in the same Package - for
example, Actor4; you can change this to any other name
by editing the 'Name' field on the element's 'Properties'
dialog

Within the Browser window, the system prompts you to·

type the element name into the 'New Element' dialog

You can also set up your own, automatic, naming and
numbering convention for elements of the same type, so
that:

On a diagram, it is your naming/numbering convention·

that is automatically applied to the new element (which
you can still change if you need to, as before)

Within the Browser window, the 'New Element' dialog·

Auto button applies the naming convention to your new
element

This is an example of the Auto Name Counter window
showing an example name and counter for new
Requirements.
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If you have existing elements in a Package, and you want to
apply the new naming convention to them, you can make
this change very easily to all elements of the same type in
the Package at once.

You define a naming convention for the element type as a
model setting. At the same time, you can also optionally
define a naming/numbering convention for the 'Alias' field
and/or for a stereotype for elements of that type.

Access

Ribbon Settings > Reference Data > Settings >
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Auto Names and Counters

Set up Auto Naming for an Element Type

Option Action

Type Click on the drop-down arrow and select
the element type to which to apply auto
naming/auto numbering.

Stereotype If you want to apply the naming
convention to a particular stereotype of
the element type, click on the  button to
the right of the field, and locate and select
the stereotype name using the Stereotype
Selector dialog.
Note that you can apply one naming
convention to the base element type (such
as a Class) and a different naming
convention to a stereotype of that element
(such as a SysML Block).

Name Prefix Type a prefix for the new names
(optional).

Name Type the counter value; use as many 0's
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Counter as required to pad the number.

Name Suffix Type a suffix for the new names
(optional).

Name Apply
on creation

Select the checkbox to apply auto naming
to each new element of the specified type,
on creation.
If you do not select the checkbox (but
click on Save), the autonaming details for
the specified element type remain defined
in the dialog, but are not applied to new
elements of that type. The default
element naming convention takes effect
(<element type><n>).

Alias Prefix Type a prefix for the new Aliases
(optional).

Alias
Counter

Type the counter value; use as many 0's
as required to pad the number.

Alias Suffix Type a suffix for the new Aliases
(optional).

Alias Apply
on creation

Select the checkbox to apply Alias auto
naming to each new element of the
specified type, on creation.
If you do not select the checkbox (but
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click on the Save button), the Alias
autonaming details for the specified
element type remain defined in the
dialog, but are not applied to new
elements of that type. The default
element naming convention takes effect
(<element type><n>).

Save (The default highlighted button.) Click on
this button to preserve the values you
have entered, and leave the dialog open
for further chabnges.
New elements of this type now have an
automatically-generated name and/or
Alias with an incrementing counter value.

If the user creates an element on a·

diagram, such as from the Diagram
Toolbox or Quick Linker, the element
is automatically assigned the defined
name and/or Alias
If the user creates an element outside a·

diagram (such as in the Browser
window) using the 'New Element'
dialog, they can click on the Auto
button next to the 'Name' and/or 'Alias'
field on the appropriate dialog to apply
the auto-generated text
If the user already has some text in the·

'Name' or 'Alias' field, it is over-written
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by the auto-counter text
If an Alias is active, to view the Alias in a
diagram requires that the option 'Use
Alias if Available' is selected in the
'Properties' dialog for the diagram.

Save & Close Click on this button to preserve the
values you have entered, and close the
dialog. The button has the same effects
on element names as the Save button.

Close Click on this button to close the dialog
and cancel the values you have entered,
leaving element auto-naming unchanged.

Notes

Automatic numbering - whether system default or·

user-defined - does not increment across Package levels;
if you have an element called Actor1 in Package A, and
you create an Actor element in a child Package of
Package A, that Actor will also be Actor1
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Create Elements

Enterprise Architect provides a number of ways to create
completely new elements and those derived from existing
elements. The simplest of the methods for creating a new
element is to drag the icon for the required type of element
from the Diagram Toolbox onto a diagram, as shown.

This method creates the element according to the system
standard for that element type. You can also provide
alternative element definitions that the Toolbox icons
reference (using the system 'Preferences' dialog, Patterns or
element Templates) and add further element definitions
using Profiles and MDG Technologies (either supplied with
the system or developed by your project team).

Notes

A quick way to apply the main facilities of the Toolbox is·

to press the Spacebar key or Insert key, displaying the
'Toolbox Shortcut' menu; using the mouse, you can also
display this menu by holding the left button and clicking
the right button
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If you are creating several elements of one type, after·

creating the first just press Shift+F3 or Ctrl+click to create
the next element of that type

Once you have created an element, you can re-use it by·

dragging it from the Browser window and dropping it
onto your diagrams

Sometimes it is useful to add elements directly to a·

Package, without adding them to a diagram; you can do
this within the Browser window
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Feature Visibility

When you set up the characteristics and features of an
element, you can set a collection of options to display or
hide the features of that element on a specific diagram. You
can also filter the attributes and operations that are shown by
scope - such as hiding all protected attributes - or select to
hide or show specific attributes and operations. The
visibility you set applies only to the current diagram, so a
Class can appear in one diagram with all features displayed,
and in another with features hidden.

It is possible to hide or show inherited attributes, operations,
responsibilities, constraints and Tagged Values for elements
that support those features. When the system displays
inherited features, it creates a merged list from all
generalized parents and from all realized interfaces. If a
child Class redefines something found in a parent, the parent
feature is omitted from the list.

Access

Context
Menu

Right-click element on diagram |
Compartment Visibility

Keyboard
Shortcuts

Ctrl+Shift+Y
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Customize Feature Visibility

Field/Button Action

Attribute
Visibility

Select the checkbox against each scope
that should be visible, and clear the
checkbox against each scope that should
not be visible.

Operation
Visibility

Select the checkbox against each scope
that should be visible, and clear the
checkbox against each scope that should
not be visible.

Custom Click on this button to show or hide
specific operations or attributes. The
'Show Features in Diagram' dialog
displays, on which you select the features
to show.
On the right of the dialog is a 'Show' field
with a drop-down arrow; if you click on
this and select the 'Hide' option, the
dialog alters slightly to become the
'Suppress Features in Diagram' dialog, on
which you select the features to hide.
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The two dialogs are identical. Select the
checkboxes of specific features to show
or hide on the element in the diagram.
You can specify both attributes and
operations on the same dialog, by
selecting the appropriate radio button for
the type of feature to work on.
You can also use the:

'Filter by' drop-down arrow to filter the·

list to show only features that have a
specific scope
All button to select all operations or·

attributes in the list
None button to clear the checkboxes·

against all selected operations or
attributes in the list

When
Resizing
Elements

Select the appropriate option for resizing
the Class, Object or Table to manage very
wide diagram objects. Select the:

'Resize to longest Feature' radio button,·

so that the minimum width for a
diagram object is determined by its
longest displayed attribute, operation or
other compartment value
'Wrap Features' radio button (so that·

any long features are wrapped onto
multiple lines) or
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'Truncate Features' radio button (the·

default - long features are not displayed
in full)

Runstate Select the checkbox if you want to hide
the object runstate of the element on the
diagram.

Hide
Stereotyped
Features

If you do not want to show attributes or
operations that have a particular
stereotype, type that stereotype name -
exactly as defined - in this field; the field
is case-sensitive.
If you want to specify more than one
stereotype, separate the stereotype names
with a comma.

Show
Element
Compartment
s

Select the checkbox against each
compartment to display in the element on
the diagram. If you want to display
inherited attributes, operations, tags,
requirements and/or constraints as well as
directly owned ones, select the checkbox
against each inherited feature as well as
against the general feature.
See also the Notes section later in this
topic.

Element Select the 'Notes' checkbox in the 'Show
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Notes Element Compartments' list to display, in
a compartment on the element in the
diagram, the text that has been typed into
the 'Notes' field of the element
'Properties' dialog.  This compartment
does not have a 'Notes' heading.
You can display full notes for the
selected element whilst the other
elements on the diagram have no notes
text.
This checkbox also enables the
'Maximum' field, which defaults to 1000
as the number of characters of Notes text
that can be displayed. Overtype this value
to display less text or more text, as you
need.

OK Click on this button to save your settings.
The diagram redisplays with the
appropriate level of feature visibility.

Notes

To show features for element types that - by default - do·

not have visible compartments, such as Use Cases and
Actors, right-click on the diagram object to display the
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context menu and select the 'Appearance | Use Rectangle
Notation' option

You can configure Enterprise Architect to display the text·

in all Notes compartments in italics -  select the 'Start >
Appearance > Preferences > Preferences' ribbon option
and on the 'Diagram > Appearance' page select the 'Italic
Note Element text' checkbox; this has an immediate
effect, as does clearing the checkbox to show the text in
normal font

If you select to display the Resources compartment, note·

that this shows both currently-active and complete
resource allocations

The Discussions and Reviews compartments display the·

first two lines of each open topic on the element; they do
not include closed discussions or reviews

Some technologies such as SysML define additional·

compartments in the element, such as for Ports, Parts and
Flow Ports; visibility of these compartments will also be
controlled by a checkbox matching the name of the
compartment

The Tags compartment lists all Tagged Values for an·

element as entered in the 'Tags' tab of the element
Properties window that do not have an empty value

If you select the 'Fully Qualified Tags' checkbox, the Tags·

compartment will contain the full provenance of each
Tagged Value (if created in Enterprise Architect release
7.1 or later) where the same Tagged Value is used several
times in different contexts with different values; the
description in the Tags compartment reads:
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      <Profile>::<Stereotype>::<Tagged Value
name>=<Value>
For example:
     BPMN::Activity::Activity Type = Task

A Structure Compartment displays on the element by·

default when you add child elements such as Parts and
Classes; the Structure Compartment acts as a container for
the child elements, which are normally fixed within the
compartment
To move child elements out of the compartment, press the
Ctrl or Shift key while dragging the child element;
Parts/Properties cannot be dragged out of the parent
element
Any element that supports Rectangular Notation can
support a Structure Compartment
An option on the 'Manage Model Options' dialog enables
and disables Structure Compartments for the whole model

Ports and other edge-mounted elements normally bind to·

any part of the parent element border, but can be confined
to the borders of the Structure Compartment by
right-clicking on the parent element and selecting the
'Behavior > Bind Port to Compartment' option

If you want to apply a structure and formal relationships·

to the child elements, create a proper Composite Structure
diagram containing the elements and select the 'Show
Composite Diagram in Compartment' context menu
option
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Model Diagrams

Diagrams are one of the most expressive views of the
repository. They show a number of elements connected to
each other by relationships, creating a narrative that
describes a part of the repository in a visual language. Quite
commonly the elements in a diagram exist in the same
Package in the Browser window; however, the most
expressive diagrams typically contain elements of different
types from different Packages.

Creating a diagram is one of the most common ways for a
modeler to add elements or relationships to the repository.
As new elements are dropped onto the diagram canvas from
the Toolbox, they are added to the same Package (or
element) that contains the diagram. These same elements
can participate in other diagrams; in fact, the more diagrams
the elements appear in, the richer the model.

Diagrams are displayed in the Browser window as a child of
either a Package or another element. While they often reside
in the same Package (or element) as the elements they
contain, they can be freely moved around the Browser
window to any location.

Like learners of natural languages, newcomers to modeling
often create basic diagrams that lack expression, but with a
little practice and some time spent examining the diagrams
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of experienced modelers their diagrams will soon become
rich and expressive.

Enterprise Architect supports a wide range of modeling
languages, each of which has a set of diagrams; these
include the UML, BPMN, SysML and many other
languages and technologies.

Developing Diagrams

As you create your diagrams and add modeling elements to
them, you can use a number of helpful facilities to add extra
meaning and expression, such as:

Partition the diagram, whatever the type, either vertically·

into columns or horizontally into rows, using Swimlanes

Partition the diagram into a grid of cells, using a·

Swimlanes Matrix

Create a Kanban diagram, sectioned and color-coded to·

organize the elements' project management properties

Add Legend elements, which both provide and can·

automatically apply a key to the colors and styles you
have used for the modeling elements on the diagram

Depict the more elements on the diagram as the objects·

that they represent, using graphical images from the
Image Manager

Automatically apply one of a range of layout formats to·

the diagram
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Notes

If the diagram display is too small to read comfortably,·

click on the diagram, press and hold Ctrl and use the
mouse wheel to temporarily expand or reduce the display
magnification

Diagrams can be the subjects of informal discussions and·

formal reviews; to add a diagram to a:
     -  Discussion, simply click on it when the Discuss &
Review window is open
     -  Review, encapsulate it in a Navigation Cell on the
Review diagram
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Diagram View

If you have created diagrams in the Browser window, you
can select to open them and then add elements and
connectors to them within the Diagram View. This is the
main workspace for developing the structure of your model
components, dragging new objects onto the diagram from
the Diagram Toolbox and existing objects from the Browser
window. You can also add elements and connectors using
the Quick Linker and other context menus within the
Diagram View, and move, format and edit them.

Most work on elements and connectors is carried out in the
Diagram View, so understanding how it works and how to
manipulate elements is essential. You can use the
EAExample project supplied with the system, or your own
'sandpit' models, to explore the capabilities and behavior of
the Diagram View.

Access

Browser
Window

Double-click on the diagram name, or·

Select the diagram node and press the·

Enter key

(c) Sparx Systems 2022 Page  978 of 1974



Modeling Fundamentals 3 October, 2022

Diagram sections

Section Description

Caption Bar Across the top of a diagram is the
diagram caption bar, which includes:

A horizontal 'chevron' icon to display·

or hide the Diagram Toolbox docked
on the left of the Diagram View, from
which point you can drag it and dock it
elsewhere; if you then hide the toolbox
and show it again, it is placed back on
the left of the Diagram View
Whichever diagram you have
displayed, the Toolbox pages are
appropriate to that diagram type
Icon and text label for the diagram type·

Diagram name·

A second 'chevron' icon that toggles·

display of the inline specification panel
for the diagram (see the later table
entry on this view).
A drop-down arrow that lists the·

currently-open diagrams and views;
click on:
     -  A diagram or view name to switch
to that diagram or view
     -  Options to redisplay the hidden
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Start Page and (if defined) the Model
Default
        diagram, Model Default Kanban
chart, User Default diagram or User
Default
        Kanban chart
The window 'close cross'; click on this·

to close the displayed diagram

The Diagram
Toolbar

This is the fixed Toolbar that displays at
the top of every diagram if the 'Show
Diagram Toolbar' option is selected on
the 'Window Behavior' page of the
Preferences window. It provides a wide
range of options to help you lay out,
format, view and filter the contents of
diagram.

Diagram
View

The larger area underneath the Caption
bar is the work area within which you can
create and view the diagram structures.
The borders of the printable diagram page
are represented by pale broken lines;
structures created beyond these borders
will print on separate pages.
The Diagram View area is also where the
diagram and object context menus
operate, and where the representation of
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the model structure can be changed to a
Specification Manager view, Relation
Matrix View, Construct View (Resource
Management), Gantt chart or Diagram
List format.

Inline
Specification
Panel

This panel presents a textual specification
of each element in the diagram, the
elements being listed initially in
alphabetical order. This helps you to
visualize and read, at the same time, the
section of the model represented by the
diagram, giving a comprehensive view of
the model. It is also useful when you are
creating Package structures using
templates (with the Model Wizard); you
can quickly update your elements without
having to open another docked window.
As you click on an element in either the
diagram or panel, it is also selected in the
other.
The panel does not display separately
from the diagram; you toggle it on or off
for each diagram individually.
You can double-click on the element
name or notes in the panel and edit the
text directly. You can also right-click on
an element and select from these context
menu options:
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Properties - to display the 'Properties'·

dialog for the element
Edit Selection - to immediately put the·

element name in edit mode, to change
it
Edit Notes - to immediately put the·

element notes in edit mode, to change
them
Find in Project Browser - to locate and·

highlight the selected element in the
Browser window
Properties Window - to display the·

Properties window for the element
Extended Properties - also displays the·

Properties window; view the 'Tags' tab
and/or the <<stereotype>> segment of
the 'Element' tab
Apply Sort - to change the order in·

which the elements are listed, to the
sequence of elements either left to right
across the diagram, or top to bottom
down the diagram
Reload View - to refresh the display in·

the Inline Specification View

Notes
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Diagrams can contain hyperlinks to other diagrams, which·

are opened when you click on the links

It is possible to open several diagrams at once, but within·

the Diagram View you can only view one at a time

You can view and work on several diagrams at once by·

making each tab containing a diagram into a floating
window, using the tab context menu; the docked Toolbar
remains on the left of the Diagram View frame

You can also work on elements using the Diagram List·

Additional information on the diagram, or a selected·

element within the diagram, is displayed in the system
Status bar
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Working In Diagrams

Enterprise Architect provides a wide range of facilities for
creating, editing and managing the diagrams that represent
aspects of your models.

Facilities

Facility

Create a UML diagram, Extended diagram or MDG
Technology diagram in your model, through the Browser
window.

Set or change various properties of a diagram, such as the
diagram name, through the diagram 'Properties' dialog.
Some properties influence the display of the diagram and
some are logical attributes that appear in the
documentation.

Display a Diagram Properties Note on the diagram. A
Diagram Properties Note is a simple fixed-text box
containing the diagram name, author, version, creation
date and modification date. You can move this text box to
any point on the diagram.

Add new elements and connectors to a diagram using
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the Diagram Toolbox pages specific to the diagram type,
or other Toolbox pages as you need.

Add new elements and connectors to a diagram using the
Quick Linker facilities.

Drop existing elements from the Browser window into the
diagram.

Drop elements copied from a diagram into another
diagram.

Change the Z-order of selected elements on the diagram,
to define which elements might lie over or underneath
other elements.

You can convert a tabbed diagram in the Diagram View
into a floating diagram. In this case, you can move or
copy elements between that diagram and another floating
diagram or tabbed diagram.

Move sections of the diagram independent of the rest of
the diagram.

Automatically resize the selected elements on the diagram
to the default size for the element type, or as close to it as
the element contents allow.

Identify which other elements are related to a selected
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element on the diagram and, if necessary, add one or
more of those other elements to the diagram.

Generate virtual images of connector end elements, to
simplify complex and extended relationships on a
diagram.

Control the display of labels around elements and
connectors on the diagram.

More precisely represent realized interfaces of a Class on
your diagram.

Expand the contents of a Package element within a
diagram.

Manage the visibility of a range of element features on
the diagram.

Undo and redo the immediately previous changes to the
diagram.

Pan across and down a large diagram, and zoom into or
out of the diagram display.

Select and move elements on the diagram using keyboard
keys ('hotkeys').

Switch between the currently-open diagrams and views in
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the Diagram View.

Change a diagram from one type (such as Class) to
another (such as Data Modeling).

Flag a selected diagram as the Model Default diagram for
your project, or your User Default diagram.

Scale down the Printable image of the diagram to fit the
size of paper it is being printed on.

Set the scrollable/printable area of the diagram display
area.

Present a set of diagrams in a Model Views slideshow.

Lock the current diagram so that it cannot be updated.

Create a duplicate copy of an existing diagram.

Save an image of the diagram to a file, in a range of
graphic file formats.

Copy an image of the diagram to the MS Windows
clipboard.

Delete one or more diagrams from the model.
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Notes

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Update Element' permission to update or delete items on
a diagram, and 'Manage Diagram' permission to create,
copy or delete diagrams
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Add New Diagrams

Enterprise Architect provides a number of ways in which to
create a new UML diagram, Extended diagram or MDG
Technology diagram in your model. The principal method is
to select the Package or element under which to create the
diagram and select a menu option to add it, as explained
here.

Add a New Diagram to the Model

Ste
p

Action

1 In the Browser window, click on the Package or
element under which to place the diagram.

2 Either:

In the Browser window header bar, click on the ·

button, or
Right-click on the object to open the context menu·

and select the 'Add Diagram' (Package) or 'Add |
Add Diagram' (element) option, or
Press the Insert key and select the 'Add Diagram'·

menu option
The 'New Diagram' dialog displays.
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3 The 'Package' field defaults to the name of the
Package selected in the Browser window or, if the
parent is an element, the name of the Package
containing that element.
If you are adding a diagram directly to a Package
and notice that it is not the correct Package, click on
the  button and browse for the correct Package.
(The  button is disabled when you are creating a
diagram under an element, and the 'Parent' field
shows the name of the element under which you are
creating the diagram.)

4 The 'Diagram' field defaults to the name of the
selected Package or element; if necessary, type a
different name for the new diagram.

5 Click on the <perspective name> button underneath
the 'Type' header, and select the Perspective Group
and Perspective most appropriate to the area you are
working in. If you want to examine diagram types
across the model from any Perspective, click on the
button and select 'All'.
The panel underneath the header displays a list of
diagram groups; click on the required group.
When you initially open the 'New Diagram' dialog,
the Perspective name on the button is the Perspective
shown in the <perspective name> icon at the top
right of the application screen. Changing the
Perspective in the 'New Diagram' dialog does not
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change the 'global' perspective on the icon. If you
want to re-set the 'New Diagram' dialog Perspective
to the global Perspective, simply click on the
<perspective name> button and select 'Active'.

6 In the 'Diagram Types' panel, click on the type of
diagram to create and, where listed, the view to
create. The view is a refinement of the type to further
tailor the diagram to a purpose, and restricts the
elements and connectors provided in the Toolbox
pages to those appropriate to the purpose.
A description of the selected diagram type displays
in the field underneath this pane.

7 Click on the OK button to create your new diagram.

Notes

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Manage Diagrams' permission to create new diagrams

The diagram type determines the default Toolbox pages·

associated with the diagram and whether the diagram can
be moved as a child of another element in the Browser
window (for example, a Sequence diagram under a Use
Case)
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Insert Diagram Properties Note

On a diagram, it is possible to display a customized text box
called the Diagram Properties Note, which automatically
shows the diagram properties:

Name·

Author·

Version·

Creation date and·

Modification date·

You can move this Note around the diagram and change its
appearance, and you can create several instances of it to, for
example, put the property information on each page of the
diagram. You cannot change the content.

Access

Ribbon Layout > Diagram > Appearance > Show
Diagram Property Note

Other Drag the 'Diagram Notes' icon from the
'Common' page of the Toolbox onto the
diagram
Click on the 'Diagram Properties Note'
icon in the UML Elements toolbar and
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click on the diagram

Notes

The Diagram Properties Note is not the same as the·

Diagram Details Note, which displays if the 'Show
Diagram Details' checkbox is selected on the 'Properties'
dialog for the diagram; this always displays in the top left
corner of the diagram - you cannot move it, change its
appearance or have more than one instance of it on the
diagram
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Drop Package From Browser Window

You can drag a Package element from the Browser window
and drop it onto the current diagram, to show a
representation of the Package in one of several formats. You
select the format from a short context menu. This is a useful
feature to help organize the display, reporting and
documentation of models.

Access

Other Drag existing Package(s) from the
Browser window onto the diagram.

Select Drop options

Option Action

Package
element

Select this option to generate a Package
element on the diagram, containing a list
of the Package contents. In this
illustration, note the child Actor and Use
Case icons.
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You can hide the contents of the element
if necessary. See the Show or Hide
Package Contents Help topic. The
diagram element is a simple link to the
Package in the Browser window; any
changes to the Package are reflected in all
diagrams in which it is shown.

Report
Specification
linked to
package

Select this option to generate a Report
Specification Artifact element linked to
the Package, which immediately opens to
the 'Generate Documentation' dialog on
which you enter the parameters for
generating the report. Thereafter, you can
simply double-click on the element and
click on the Generate button to generate
the same report on the Package,
whenever necessary. The report can be
read as a Linked Document on the
element.
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Graph based
on Package
contents

Select this option to create a Standard
Chart Artifact. The Standard Chart
'Properties' dialog displays at the 'Chart
Detail' pages, on which you can configure
the generation of a Pie Chart or Bar Chart
to graphically represent an aspect of the
Package content.

Matrix
profile

Select this option to create a Matrix
Specification Artifact. The 'Matrix
Specification' dialog displays.

Package as
List

Drop the Package as a Model View chart
element that lists the elements within the
Package and shows the type (by icon),
name, Scope, Status and Author of each
element.

Notes

If you drop several Packages onto a diagram together, the·
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'drop type' context menu displays once; the option you
select applies to all Packages you have dropped on the
diagram
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Show or Hide Package Contents

If you have Package elements displayed in an open diagram,
you can toggle between showing the Package contents
within the elements, or leaving them clear.

Access

Ribbon Design > Diagram > Manage > Properties
> Elements

Context
Menu

Browser window or open diagram |
Right-click on diagram | Properties >
Elements

Steps

Ste
p

Instruction

1 Select the 'Package Contents' checkbox to list the
content of each Package within its element.
Clear the 'Package Contents' checkbox to hide the
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content of each Package within its element.

2 Click on the OK button.
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Drop Elements from Browser Window

As well as creating new elements in the current diagram,
you can drag existing elements (individually or as a group)
from the Browser window into the diagram. To select
multiple elements, click on the element names in the
Browser window while pressing and holding:

Ctrl to add single items to the selection of multiple·

elements, or

Shift to select all the elements between the first and last·

selected items

When you drag an element onto a diagram from the Browser
window, the system response depends on whether you are
dragging a Package element or any other type of element.
For information on dragging a Package element onto a
diagram, see the Drop Package From Browser Window
topic.

It is not possible to duplicate an element on the same
diagram, but you can generate representations of the
element at the ends of connectors, called virtual connector
ends. See the Virtual Connector Ends - Represent One
Element Several Times on a Diagram Help topic.

Access

Other Drag existing element(s) from the
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Browser window onto the diagram
(If the 'Drop <element> from Project
Browser' dialog does not display, press
Ctrl while dragging the elements)

Select Paste options

Option Action

Drop as Click on the drop-down arrow and select
one of the drop types:

Link - Drop the element as a simple·

link: in this case the one element is
represented in the Browser window and
in any diagram to which it has been
added; changes to the element are
reflected in all diagrams in which it is
shown
Lifeline - (On Sequence diagrams)·

Drop a copy of the element as a
separate Lifeline element, classified by
the original element
Instance - (On diagrams other than·

Sequence) Drop a copy of the element
as a separate instance of the original
element, classified by the original
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element
Invocation - Drop a copy of a·

StateMachine or Activity element as an
invocation of the source element; the
resulting element is a State object or
Action - respectively - with the source
element as its classifier
Property - Drop a copy of the element·

as a separate Object instance
Attribute - (Available when dragging a·

classifier onto an element that supports
attributes) Create a new attribute
classified by the dragged classifier; the
attribute is automatically selected in
in-place editing so that you can add the
attribute name
Child - Drop the element as a child of·

the copied element - that is, as a new
element with a Generalization
connector back to the copied element;
this is very useful when you have a
Class library or framework from which
you inherit new forms - for example,
you can drop a Hashtable as
'MyHashtable', which automatically
becomes a child of the original
Hashtable

Used with the 'Override Parent
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Operations' feature, this is a quick way
to create new structures based on
frameworks such as the Java SDK and
the .NET SDK

Name If the dropped element is being added as
a new element (that is, a Lifeline,
Instance, Child, or Property), this field is
active; type a name for the new element.

Structural
Elements

If the original element has any structural
elements (for example, Ports and Parts)
this field contains the value 'Select'.
Either:

Leave this value as is, so that when you·

click on the OK button the Features
window displays, from which you can
select the child elements to reproduce
with the pasted element (on the 'Parts /
Properties' tab, 'Interaction Points' tab
or 'Connection Points' tab, depending
on the element type) or
Click on the drop-down arrow and·

select:
     -  'None' to not reproduce any child
elements
     -  'All' to reproduce all child
elements on the original element, or
     -  '<diagram name>' to reproduce
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the configuration of child
        elements on an instance of the
original element on another
        diagram (if there are any other
instances); there can be more
        than one diagram name, if the
original element is found on
        several diagrams

The resulting Object element is created
large enough to display the selected child
elements laid out neatly within the Object
border.
(If the element has no structural elements,
the field contains the text 'No Embedded
Elements'.)

Copy
Connectors

This checkbox is enabled when you select
to drop the copied element as an Instance,
Property or Invocation.
Select the checkbox to reproduce on the
diagram any connectors between the
original element and any other elements
that have also been dropped into this
diagram, as connectors between the
instances.

Select for all (If dragging multiple elements onto the
diagram at once.)
Select the checkbox to apply the dialog
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settings to all multiple-selected elements
being dragged onto the diagram, and to
add the elements together.
Leave the checkbox unselected to add the
elements to the diagram one at a time,
with the opportunity to change the dialog
settings for each element.

Save
selection as
default

Select this checkbox to make the current
settings on this dialog the default for all
drag and drop operations from the
Browser window.
This option also deselects the 'Auto
Instance' checkbox on the 'Diagram >
Behavior' page of the 'Preferences' dialog.
The automatic drop operation becomes
whatever you have set on the 'Drop ...
from Project Browser' dialog, and is not
overridden by the drop-as-Instance
imposed by the 'Auto Instance' checkbox.
The default setting you apply on
Sequence diagrams is separate from the
default for other types of diagram.
Therefore, you can set the default to
'Lifeline' (if you prefer) and this does not
affect or get changed by the default you
might set for other types of diagram.

Hold Ctrl to Select this checkbox to display this dialog
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Show this
dialog

for drag and drop operations only if you
press and hold Ctrl as you drag the
element onto the diagram.
If you select this option, you can drag
elements from the Browser window
without displaying the dialog; the paste
operation complies with whatever
settings you used the last time you
opened the dialog. To change these
settings, hold Ctrl as you drag an
element, and edit the field values on the
dialog.

OK Click on this button to complete the drop
operation and close the dialog.

Cancel Click on this button to cancel the drop
operation and close the dialog.
If you have selected multiple elements,
the first-selected element is not dropped,
but the remainder are.

Cancel All (If dragging multiple elements onto the
diagram at once.)
Click on this button to cancel the
insertion of all the multiple-selected
elements being dragged onto the diagram.

(c) Sparx Systems 2022 Page 1007 of 1974



Modeling Fundamentals 3 October, 2022

Notes

Not all drop options apply to all element types; for many·

types, the only option available is 'Link'

When an element dragged from the Browser window is·

dropped into the diagram, its default style and size is
applied rather than any alternative styles and sizes used
for instances of the element in other diagrams

If an element is dropped onto a diagram as a Link, any·

attached Boundary, Note, Text or Constraint elements are
duplicated on the diagram

When using the 'Drop as - Instance' option, if the Instance·

is the same element type as the Classifier, then any
stereotype that has been applied to the Classifier will be
propagated to the Instance also
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Z Order Elements

Z Order refers to the sequence in which elements are layered
through the depth of the diagram; each element on the
diagram has a specific Z-order number that - when elements
overlap - determines which elements the selected element
displays in front of, and which behind. You can move an
element:

One place further back, deeper into the diagram·

One place further forward, towards the front of the·

diagram

To the bottom of the diagram (deeper in than all other·

elements in the diagram)

To the top of the diagram (further forward than all other·

elements in the diagram)

You have options to change the Z order of a single element
approximately in relation to the rest of the diagram; you can
also select the 'Configure Z Order' option from the diagram
context menu, to review and adjust the Z Order of each
element on the diagram precisely relative to every other
element

Access

Ribbon Layout > Alignment > choose either
'Bring to Front' icon (top of the Z order)
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or 'Send to Back' icon (bottom of the Z
order)
Design > Diagram > Manage > Configure
Z Order

Context
Menu

Right-click on element in a diagram |
Z-Order : Select the appropriate option to
reposition the selected element.

Notes

On a diagram, you can move the focus from element to·

element according to Z Order, by pressing Shift+Tab;
each time you press these keys, the element with the
next-lowest Z Order number is selected
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Move Elements Within Diagrams

As you add new elements to a diagram, you might want to
move the existing elements to create more space, make a
structure more apparent, or create a nesting relationship
between two elements. There are several ways in which you
can move the elements within the diagram.

Move Elements

Image Action
Change
Position Select an element or group of elements in

the diagram, then:
Use the mouse to drag the element or·

group of elements to the required
position (the cursor switches to the
four-arrow icon as shown)
Hold down Shift and press the·

appropriate arrow keys to move the
element or group of elements by small
increments in the arrow direction

If you are moving a single element and
you have selected the 'Layout >
Alignment >  > Smart Placement' and
'Show smart placement guide' options, as
you move the element colored lines will
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display around the element. These
indicate the positions of the edges and
edge-centers as they align with an
adjacent element or connector. Note that
the objects must be contemporary - not at
different hierarchical levels and not in
different partitions of the diagram.

Align
Elements Select a group of elements in the diagram

and align them on the last-selected
element using:

The 'Align...' options in the right-click·

context menu or
The Alignment buttons on the Diagram·

toolbar

Confirm
Possible Nest
Elements

If you want to nest one element within
another, you can drag that element onto
the 'nest' element; the nesting element is
then always encapsulated by the nest and
moved within the nest.
Not all element combinations are valid.
For example:

Drag a Signal element over a Class;·

because a Class element can nest a
Signal, the Signal element is
encapsulated
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Drag a Class element over a Signal·

element; because a Signal cannot nest a
Class, the Class element is not
encapsulated

To confirm that the proposed nest
element is able to accept the selected
nesting element, observe the nest element
border as you drag the nesting element
over it:

If the nest element can accept the·

selected element, the nest element
border changes to a dashed line
If the border does not change, the·

selected element cannot be
encapsulated within the nest element

Notes (on Adding nesting element to nest)

The 'Support for Composite Objects' checkbox must be·

selected on the 'Objects' page of the 'Preferences' dialog
(select the 'Start > Appearance > Preferences >
Preferences' ribbon option and click on the 'Objects'
page); if this option is not selected, the dashed border
does not show and the nesting element cannot be
embedded on the nest element in the diagram

Both elements must already exist on the diagram; the nest·
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element border does not change if you drag a potential
nesting element over it from the Toolbox or Browser
window

The nesting element must be dragged right over the nest·

element, so that its borders are completely within the nest
element borders

The Z-order of the nesting element is automatically·

adjusted so that it is not hidden by the nest element

When you embed a nesting element on its nest element,·

the nesting element becomes part of the nest element
hierarchy in the Browser window; if you drag the nesting
element out of the nest element, the nesting element
becomes independent and is no longer embedded in the
nest element hierarchy
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Move Elements In Diagram Sections

As you build up a diagram, you might find that you have to
move all elements within a part of the diagram up, down or
to one side. You can do this in a number of ways.

Fine Movement

You can nudge the position of a single element or a selected
group of elements in 1 pixel increments. Press Shift and
then the arrow key for the direction of movement (Right,
Left, Up or Down).

Drag Selected Groups of Elements

If you want to reposition a certain group of elements, hold
down the left mouse button and drag the cursor over the
elements to move (creating an outline around the elements),
then click on an element within the outline and drag the
group as required.

Move Sections of the Diagram

You might need to create some space in the diagram.
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Selecting and moving even groups of elements around in a
large diagram can be difficult, so it is possible to just move
everything beyond a certain point further away from the rest
of the diagram, without having to select the elements you
are moving. To do this:

Select the 'Layout > Helpers > Sweeper' ribbon option,·

click on the diagram at an appropriate point and drag the
cursor to move everything beyond the cursor in the
direction of the movement

or

Hold down Alt, click on the diagram at an appropriate·

point and drag the cursor to move everything beyond the
cursor in the direction of the movement

Depending on whether you drag the cursor vertically,
horizontally or diagonally, either a horizontal or vertical line
or both displays on the diagram just behind the cursor. If
you are moving the cursor left, everything to the left of the
line moves with the cursor. If you move the cursor up,
everything above the line moves upwards. If you move the
cursor diagonally, everything within the quadrant formed by
the lines moves. For example, if you move the cursor left
and down, everything below and left of the cursor is moved.
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Move Elements Between Diagrams

If an element is present in one diagram but actually belongs
in another, you can simply move the element from the first
diagram into the second. You can also cut multiple elements
from one diagram and paste them into another. When you
cut elements from a diagram, the elements are held on the
clipboard but are not cleared from the source diagram until
they are specifically pasted into the target diagram. A
moved element is not affected in any other way.

Access

Open the diagrams:

Containing the element(s) to be moved, and·

Into which the elements(s) will be moved·

Keyboard
Shortcuts

With the element selected in the source
diagram:

Ctrl+X·

With the cursor in the target diagram:
Ctrl+V or Shift+Insert·

Other Display the 'Default Tools' Toolbar
(Explore > Portals > Show Toolbar >
Default Tools) and:

On the source diagram, click on the·
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element to be moved and on the 
icon in the Toolbar
Click on the target diagram and on the·

 icon in the Toolbar

Notes

By selecting more than one element at a time, you can·

move multiple elements in the same operation
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Copy Elements Between Diagrams

As you develop a diagram, it is not uncommon to find that
some of the elements and structures of elements could also
be used on another diagram. You can copy those elements
and structures onto another diagram as a new set of elements
without losing the element composition or the organization
of the structure. In doing this, you can change any of the
element names within the structure and preserve the relative
nesting of the elements.

Access

Ribbon With element(s) selected in source
diagram:

Layout > Diagram > Select > Copy·

Selected Elements
With input focus on target diagram:

Layout > Diagram > Select > Paste as·

Reference or
Layout > Diagram > Select > Paste as·

New

Keyboard
Shortcuts

With element(s) selected in source
diagram:

Ctrl+C·
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With input focus on target diagram:
Shift+Insert (Paste as Link)·

Ctrl+Shift+V (Paste as New)·

Paste Element(s) as Reference

If you select to paste the copied elements as references (or
links) to the source element(s), the elements are added to the
diagram as instances of the source element(s) on the target
diagram, with any connectors between them. Notes, Text,
Boundary and Constraint elements attached to the pasted
element are duplicated on the target diagram.

Complete the Paste Element(s) as New
Dialog

If you select to paste the copied elements as new elements,
the 'Paste Element(s) as New' dialog displays.

Option Action

Original
Element
Name

Each element name defaults to selected,
to be inserted in the target diagram.
If you want to omit an element from the
copied structure, clear the checkbox
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against it.

New Element
Name

If you want to give a copied element a
new name, delete the current name
(highlight it and press the Delete key) and
type in the new name.

Include
Connectors

This checkbox defaults to selected, to
make copies of the original connectors
where both source and target elements in
the relationship have been copied. This
maintains the relationships between and
organization of the copied elements.
If you do not want to copy the
connectors, clear the checkbox.

Paste Click on this button to add the copied
elements and connectors to the target
diagram as new elements.

Don't show
this again

Select this checkbox if you want to hide
this dialog next time you paste an
element as new (the pasted element has
the same name as the original element).
You can set the dialog to display again by
clearing the 'Hide diagram element paste
as new dialog' checkbox on the 'Objects'
page of the Preferences window (select
the 'Start > Application > Preferences >
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Preferences' ribbon option).

Notes

Package elements cannot be copied as structured elements·

The 'Date Created' and 'Time Created' parameters of a·

pasted-as-new element are set to the current date and
time; the parameters for a linked element remain the same
as the copied element

Elements - including special embedded elements such as·

SysML Properties - do not have to have a parent element
when pasting as new, although normal embedded
elements such as Ports must have a parent

Elements in State regions cannot be pasted as new outside·

the parent element

Parenting is still applied when copying and pasting as new·

using Ctrl+click-and-drag between (floating) diagrams

You can also use the 'Cut', 'Copy' and 'Paste' icons in the·

Default Tools toolbar
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Move/Copy Elements To & From
Floating Diagrams

If you have converted a tabbed diagram in the Diagram
View into a floating diagram, you have a number of context
menu options to move or copy elements between that
diagram and another floating or tabbed diagram.

Access

Other Drag element(s) from one diagram to
another and release mouse button

Move or copy selected elements

Option Action

Move to this
diagram

Select this option to cut the selected
element or elements from the source
diagram and paste them into the target
diagram.
If the moved elements are held in a
different Package, when the elements are
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pasted each has a label underneath
identifying the parent Package.
Function Keys: Drag+Shift

Create link
on this
diagram

Select this option to create an element or
elements on the target diagram, each as
an instance of a selected element on the
source diagram.
Function Keys: Drag+Alt

Copy as New
Object(s)

Select this option to create an element or
elements on the target diagram, each as a
copy of a selected element on the source
diagram.
The 'Paste Element(s) as New' dialog
displays, on which you enter a new name
for each element to identify it as a new,
separate element. Click on the Paste
button to complete the create task.
Function Keys: Drag+Ctrl

Instance
(Object)

Select this option to create an element or
elements on the target diagram, each as
an object instance or invocation of an
element on the source diagram. The
source element is the classifier for the
new object element.
Function Keys:
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as New Child
(Generalizati
on)

Select this option to create a new child
element on the target diagram, as a
generalization of the element of the
source diagram.
The 'Element Name' dialog displays for
each copied element, on which you enter
a new name for the element to identify it
as a new, separate element.
Click on the OK button to complete the
create task.
Function Keys:

Notes

Multiple elements are processed individually, so if one·

element is 'illegal' the other elements are still copied
and/or transferred

If you select multiple elements to copy as instances or·

generalizations, those elements must be of the same type
and stereotype

Embedded elements are moved or copied only if they are·

specifically selected with the parent element
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Autosize Elements

You can autosize an element or group of elements in a
diagram to the default size for the element type (for a Class,
90 x 70 pixels at 100% zoom). However, if the element
contains more information than the default size can show
(such as a long name, long attributes or additional
compartments) the autosize option resizes the element to the
minimum size for displaying the information.

The size change effectively operates around the mid point of
each element, so the layout and size of the diagram do not
change. Automatically changing the layout of a diagram is a
different process.

Access

Context
Menu

Right-click on selected elements |
Autosize (available only when multiple
elements are selected)

Keyboard
Shortcuts

Alt+Z

Notes
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Not all elements resize: elements such as Events remain·

the same; Timing and Sequence diagrams (where position
is crucial) are unchanged; and elements added from a
profile or Shape Script maintain any size definitions
imposed by the profile

With an element image created with a Shape Script that·

contains a defSize command, Autosize returns the element
to the defSize value and not the element default size
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Annotations

An Annotation node is a special feature of a Package that
represents the diagrammatic elements in diagrams within
that Package. Diagrammatic elements are non-model
elements that have no purpose outside a diagram. Such
elements include:

Notes·

Text·

Hyperlinks·

Diagram Links·

Image elements·

Boundary elements·

Navigation Cells·

The system automatically creates the Annotation when you
open a diagram and add diagrammatic elements. One
Annotation is created for each parent Package, so if the
Package has several diagrams all the diagrammatic elements
are held in the one Annotation.

The Annotation does not have any properties (including not
having a name), and is simply a container for the
diagrammatic elements, allowing them to be listed in the
Browser window and - if necessary - re-used in multiple
diagrams. This also protects the elements from being deleted
if any diagram that contains them is deleted. Note that if you
delete all diagrams that contain the diagrammatic elements,
the Annotation and its contents persists.
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The Annotation is represented in the Browser window by
three blue dots followed by brackets.
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Virtual Connector Ends - Represent
One Element Several Times on a
Diagram

Virtual connector ends assist you to simplify complex
diagrams containing many elements with multiple
connectors, supporting good layout strategies that minimize
crossed relationship lines and group related elements
accordingly. They are highly effective when the element of
interest is:

The focus of a large number of relationships, or·

A member of two or more groups of elements that are a·

distance apart on the diagram, or

Simply used in several contexts when you currently want·

to focus attention on one of those contexts

While Enterprise Architect does not support placing an
element on the diagram more than once, using this strategy
you can create any number of virtual representations of
the element on the diagram, so that you can show the full
image of the element in one context and have separate,
simpler images of it on the same diagram in other contexts.
This reduces the number of visible connectors crossing the
diagram without you having to hide the connectors
individually, and helps you create cleaner, more readable
diagrams on which you can place linked elements closer
together.

To achieve this, you right-click on the connector that you
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want to keep the element on, and select to virtualize the
appropriate connector end (source or target). The system
adds a simple rectangle containing the element name and
with the element fill color to the connector end, with no
other connectors on it.

Consider this example:

The diagram is relatively simple but still quite large, and the
connector between the ShoppingBasket and LineItem
elements crosses another connector. You might want to
simplify the diagram for any of several reasons, such as
avoiding the crossover or temporarily bringing the LineItem
element more closely into the
Account/Order/ShoppingBasket group as a simple
participant. So, you create a virtualization of LineItem as the
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target of the Association connector to ShoppingBasket.

Access

Context
Menu

On diagram | Right-click on connector |
Virtualize Connector End | Target (or
Source)

Notes
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A 'Virtual Element' is an extension of a connector that·

provides access to some of the properties of the element it
represents

Virtualization operates on waypoints in a connector line,·

and therefore requires the connector line style to be set to
Custom Line

If no waypoints exist on the connector, the operation·

creates one

If you virtualize the target element on a connector, the·

virtual connector end displays on the last waypoint of the
connector line

If you virtualize the source element on a connector, the·

virtual connector end displays on the first waypoint of the
connector line

You cannot virtualize both ends of a connector·

The original connector still exists, and if you click on the·

'Virtualize Connector End' option again, the full connector
redisplays and the virtual element disappears

If you click on one virtual element, the original element·

and all its other virtual elements are selected and
highlighted; any changes to properties made through the
'Properties' dialog of a virtual element affect the original
element

Changes to an element's appearance (other than fill·

color) do not affect its virtual elements

Virtual elements appear on prints, reports and copies of·

diagrams; they do not appear in lists or reports on the
model structure
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Virtual elements are specific to the diagram they are·

created on; if you copy a diagram (with or without virtual
elements) and add virtual elements to the copy, those
changes are not reflected in the original diagram
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Locate Related Elements

When you are reviewing an existing element on a diagram,
it is possible that the diagram does not show all of the
relationships between that element and others. The related
elements might be:

On the diagram, but with the relationships hidden, or·

Depicted on a different diagram·

You can quickly check what other elements have
relationships with the selected element, using the
Relationships window. The right-click context menu for
each relationship listed in the window also indicates if the
corresponding related element is not shown on the same
diagram, by providing the 'Place Related Element in
Diagram' option to add the related element to the diagram.
This is useful when you are building up a picture of what an
element interacts with, especially when reverse engineering
an existing code base. To put the element in a specific
position on the diagram, click on that point.

Access

Ribbon Explore > Portals > Windows > Trace >
Relationships
Start > All Windows > Properties >
Responsibilities > Relations
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Keyboard
Shortcuts

Ctrl+Shift+2
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Manage Object Labels

When you create certain elements or connectors, some of
the properties of the created object are displayed on the
diagram as labels offset from the object. For example, these
properties display as labels:

Embedded element name·

Run state, attributes and operations (if they exist) of an·

element that has an alternative image

Connector name, stereotype, constraints and/or source and·

target role names

You can format and hide these labels using the 'Labels'
context menu.

Access

Context
Menu

Right-click on a label

Options

Option Action
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Edit Label (Connector Labels only.)
Select this option to display the text
within a small editing box, with the
cursor within the text. Delete or add text
as appropriate.
Shortcut: F2

Set Label
Color

Select this option to display the 'Color'
dialog, on which you select a standard
color or define a custom color in which to
display the label text.

Hide Label Select this option to hide the label on the
diagram; to reveal the label again:

For an element label, right-click on the·

element and select the 'Appearance |
Show labels' option
For a connector label, right-click on the·

connector and select the 'Visibility | Set
Label Visibility' option; select the
checkbox against each label to
redisplay

You can also hide all connector labels on
a diagram using the 'Suppress All
Connector Labels' option on the
'Connectors' tab of the 'Properties' dialog
for the diagram.

Select this option to display the label text
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Bold in bold.

Label
Rotation

(For embedded elements and connectors.)
Select this option to orient the label in the
horizontal (default) or vertical planes.
You can rotate the text in the vertical
plane either clockwise or anti-clockwise
from horizontal.

Text
Alignment

Select this option to align the text to the
left, center or right of the label text area.
This is more apparent where there are
several items of text in the label, of
different lengths.

Direction (Connector name labels only - ensure that
the connector has a name.)
Select this option to set or clear a small
arrow on the name label. You can choose
to set the arrow pointing to the label
source or destination.

This arrow is part of the label, so if there
is no label text (or if the label consists
only of spaces) there is no direction
indicator.

Default Select this option to move the label to the
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Position position it was initially created in,
relative to the parent element or
connector.

Default Color Select this option to set the label color to
the default color in which it was first
created.

Notes

As labels can be concentrated on and around the element·

or connector, try to click on a section of the required label
that is clear of any other label or structure

The 'Label Rotation' option is not currently available for·

stereotyped elements and connectors
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Hide/Show Labels

A connector can have a number of different labels along its
length and at each end. It is possible to selectively hide or
display these labels to reduce the volume of text around the
connector or to focus attention on specific properties.

Access

Context
Menu

Right-click on connector | Visibility | Set
Label Visibility

Hide or display labels on a connector

Ste
p

Action

1 On the 'Label Visibility' dialog:
Select the checkbox against each label to show,·

and
Clear the checkbox against each label to hide·

2 Click on the OK button.
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The diagram displays the connector with the selected
labels shown.
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Show Realized Interfaces of Class

If you are modeling interfaces that are directly realized by a
Class, you can render each of those interfaces as a 'lollipop'
style interface node, which protrudes from the left-hand side
of the Class.

Consider this example:

Class1

Class2

InterfaceA

InterfaceB
«interface»
InterfaceB

{abstract}

«interface»
InterfaceA

{abstract}

The Bank Class realizes (or provides) the Internet Banking
Interface. The diagram would be a useful depiction of this
simple relationship if you wanted to populate the elements
with visible features and properties. However, in more
complex diagrams with more detailed realized (and
dependent) interfaces, you might not want to show all the
information defining each element. Therefore you can
represent the realized interface as the 'lollipop' node, and
remove the original Interface element from the diagram (but
not from the model).

Bank

Internet Banking

«interface»
Internet Banking

{abstract}
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and then
Bank

Internet Banking

To depict the interfaces that a Class realizes as nodes,
right-click on the Class and select 'Features | Show Realized
Interfaces'. This setting only applies to the selected Class,
and can be changed at any time. If you turn the option off, in
the scenario here, neither the node nor the Interface element
are shown. If you turn the option back on, the node
redisplays.

Notes

There are various mechanisms for showing that an·

interface is realized by one object and required by
another, including using the Expose Interface element;
however, the simplest method of representing such
interactions is to create an Assembly connector between
the 'realizing' object and the 'using' object
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Open Package From Diagram

As you develop your model, you might create diagrams that
show the organization and/or content of some or all of the
Packages in the model. From a Package element shown in
one of these diagrams, you can quickly locate and expand
the Package in the Browser window and open the Package
default diagram in the Diagram View.

The default diagram is the first available diagram in the
Package, selected in alphabetical order - for example, a
diagram called Alpha in a child Package or element several
levels down opens before a diagram called Beta
immediately under the selected Package.

Access

Double click on the Package.

Keyboard
Shortcuts

Ctrl+K
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Undo Last Action

When you are editing diagrams, moving, re-sizing and
deleting elements and deleting connectors, and you make a
mistake, you can work back through multiple levels of undo
to roll back the error.

Access

Ribbon Layout > Diagram >  Undo

Keyboard
Shortcuts

Ctrl+Z

Other Click on the Undo button in the Default
Tools toolbar - 

Notes

Currently you cannot undo element additions or connector·

moves

If an undo action is itself in error, you can reverse it with·

a redo action
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Redo Last Action

When you are editing diagrams, moving, re-sizing and
deleting elements and deleting connectors, and you make a
mistake, you can work back through multiple levels of undo
to roll back the error. If the undo actions are themselves in
error, you can reverse them with the equivalent number of
redo actions.

Access

Ribbon Layout > Diagram >  Redo

Keyboard
Shortcuts

Ctrl+Y

Other Click on the Redo button in the Default
Tools toolbar - 
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Add Diagram Links to Diagrams

Whilst a diagram usually represents a structure of modeling
objects, it can also act as a portal through which you can
access related diagrams that provide more detail on an
aspect, or alternative views of the structure, or views of
other structures. Where there are many diagrams (or, indeed,
other objects and features) to move on to, the initial diagram
can become a home page for a part of the project, or even
the entire project.

Several options for linking to another diagram are provided
by the 'Select Type' dialog, which displays when you drag
the target diagram from the Browser window onto the host
diagram.

Drop Diagram Options

Select the appropriate option to set up the required type of

(c) Sparx Systems 2022 Page 1049 of 1974



Modeling Fundamentals 3 October, 2022

link to the target diagram, and then click on the OK button.

Option Description

Diagram
Frame

This option creates a Diagram Frame
element containing an image of the
dropped diagram, with the name of the
dropped diagram in the frame label. Any
user looking at the host diagram can
double-click on the Diagram Frame and
open the target diagram for review and -
if they have the access permissions - for
edit.

Diagram
Reference

This option creates an empty Diagram
Frame element with the name of the
dropped diagram in the frame label. Any
user looking at the host diagram can
double-click on the Diagram Frame and
open the target diagram for review and -
if they have the access permissions - for
edit.
You can also open the referenced
diagram from the Browser window, by
double-clicking on the Diagram Frame
name.

Hyperlink This option adds a Hyperlink element to
the diagram, containing a diagram icon
with no frame, followed by the names of
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the parent Package and target diagram.
Double-clicking on this hyperlink will
open the target diagram.
You can edit the hyperlink to point to
another diagram, or to not display the
diagram icon, by right-clicking on the
element and selecting the 'Properties'
option.
You can also create an identical
Hyperlink element by dragging the
Hyperlink icon onto the host diagram
from the 'Common' Toolbox page,
right-clicking on the element and
selecting 'Properties', and then selecting
'Diagram' from the 'Type' drop-down list.

Navigation
Cell

This option creates a Navigation Cell (a
UML Diagram element) that contains the
name of the target diagram and, in the top
right corner, an icon representing the
diagram type. Just after you click on the
OK button, the 'Select Image' dialog
displays, from which you can select a
graphic that represents the nature of the
diagram. You can also select a diagram
Theme for the image, from the 'Image
List' field. If you do not want to add an
image to the element, click on the Cancel
button.

(c) Sparx Systems 2022 Page 1051 of 1974



Modeling Fundamentals 3 October, 2022

List This option creates a Model View chart
that lists the elements within the target
diagram. When you select the option and
click on the OK button, the Model View
element 'Properties' dialog displays at the
'Chart Details > Source' page, showing
the SQL statement that populates the list.
Click on the OK button to execute the
search and generate the List of Elements
Chart.

Other Links to Diagrams from Diagrams

There are additional ways to link to and access one diagram
from another. These include:

From the Browser window, drag a Package containing the·

target diagram (as the first diagram listed in the Package)
onto the host diagram, and select the 'Package Element'
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option; when a user double-clicks on the Package element
on the host diagram, the target diagram displays

Right-click on a suitable element in the host diagram and·

select the 'New Child Diagram | Composite Structure
Diagram' option, then double-click on the element to
display the first diagram underneath the element; if that is
not the required diagram, right-click on the element and
select the 'New Child Diagram | Select Composite
Diagram' option, then choose the target diagram from the
'Select Classifier' dialog
     -  You can display the target Composite diagram
instead of the parent element on the host
        diagram; right-click and select the 'New Child
Diagram | Show Composite Diagram in Frame'
        option
     -  Alternatively, you can display the target diagram in a
compartment within the parent element
        outline; right-click and select the 'New Child
Diagram | Show Composite Diagram in
        Compartment' option

For most types of diagram link, when a user clicks on the·

link the target diagram opens; the diagram name tab has a
small arrow on it which, when you double-click on it,
returns you to the original diagram ( ), closing
the linked diagram
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Hyperlinks Between Diagrams

Create a hyperlink between diagrams

Ste
p

Action

1 Open the diagram in which to display the hyperlink
to another diagram.
From the Browser window select the diagram you
want to create a hyperlink to:

2 Drag the diagram on to the current diagram.
The 'Select Type' dialog displays.

3 Select the 'Hyperlink' option and click on the OK
button.
The final hyperlinked diagram should resemble this
diagram, where the 'Class' diagram is the diagram to
which the 'Product Order' diagram hyperlinks (notice
that the hyperlink icon is different).
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Example

Order

Payment

Product

Customer

AccountAccount Details

Sample Diagrams :
Class Diagram

Customer Details

Item Code

Notes

If the hyperlink appears as a Sub Activity, select the 'Start·

> Appearance > Preferences > Preferences > Diagram >
Behavior' option and deselect the 'Use Automatic
SubActivities' checkbox

When a user clicks on the hyperlink, the linked diagram·

opens (in the example, Class); the diagram name tab has a
small arrow on it which, when you double-click on it,
returns you to the original diagram ( ), closing
the linked diagram

(c) Sparx Systems 2022 Page 1055 of 1974



Modeling Fundamentals 3 October, 2022

(c) Sparx Systems 2022 Page 1056 of 1974



Modeling Fundamentals 3 October, 2022

Pan and Zoom a Diagram

When you are viewing a diagram, you can pan across, up
and down the whole diagram in a low magnification to
locate a particular section, and then zoom into that section in
a higher magnification.

Pan over diagram

You can pan over the Diagram View using the:

Left, Right, Up, Down, Page Up, Page Down, Home and·

End keys when the Diagram View is selected

Diagram scrollbars·

Middle mouse button·

Pan & Zoom window (Ctrl+Shift+N)·

Zoom into and out of diagram

You can zoom into and out from the diagram using the:

'Layout > Diagram > Zoom' options or·

The Zoom + and - icons and slider bar in the Status bar at·

the bottom of the screen, or

Zoom buttons on the Diagram toolbar or Pan & Zoom·

window toolbar
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Change the zoom level by clicking on either the Zoom In
(+) button or Zoom Out (-) button; each click changes the
magnification by 10%.

You can return the diagram to 100% in one of these ways:

Click on the  ('Zoom to 100%') button·

Press Ctrl and click on the middle button of the mouse·

Notes

You can zoom in and out of the main window·

dynamically by holding Ctrl and rolling the mouse wheel

Changes in diagram magnification through the zoom·

options can be saved as permanent changes to the diagram

At high levels of zoom, element features cease to display;·

this is because the Windows font mapper cannot easily
select a font for extreme conditions, and the result can
look odd
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Diagram Navigation Hotkeys

Whilst you are working on a diagram, a number of facilities
are also available to you through the keyboard keys. Some
of these facilities are exclusively provided by keyboard keys
- the diagram navigation hotkeys - which you can use to
quickly move or operate on elements within a diagram.

Keys

Key
Combination

Facility

Shift+Arrow Move the selected element(s) by
increments (in the direction of the arrow).

Arrow key Scroll the diagram (in the direction of the
arrow).

Esc Clear the current selection.
(Alternatively, simply click on the
diagram background.)

Tab key (If no element is selected) Select the
element with the lowest Z-Order number
- the furthest back in the diagram.
(If an element is selected) Move focus to
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the element with the next-lowest Z Order
number (coming forward out of the
diagram).

Shift+Tab (If no element is selected) Select the
element with the highest Z-Order number
- the furthest forward in the diagram.
(If an element is selected) Move focus to
the element with the next-highest Z Order
number (moving back into the diagram).

Shift+click or
Ctrl+click

Toggle the addition of the clicked
element to the current selection. If you
are clicking on the area of overlap
between elements:

Shift+click toggles selection of the·

element with the lower Z-order (the
element behind or further back than the
others)
Ctrl+click toggles selection of the·

element with the higher Z-order (the
element in front of or further forward
than the others)

Alt+G Locate the item in the Browser window
and highlight it.

T When you have selected an element in
the diagram, you can press the T key to
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open the Test Cases window for that
element.
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View Previous and Next Diagram

If you are working on more than one diagram at a time, and
have the diagrams open on separate tabs, you can step
backwards and forwards through them. You will also step
through any other views that are open, such as the Model
Search, Project Gantt chart and Start Page.

You move between views using buttons on the floating
Diagram Toolbar:

To access

The previous diagram or view, click on the Previous·

Diagram button or press Alt+Left

The next diagram or view, click on the Next Diagram·

button or press Alt+Right

The default model diagram (if one has been defined) click·

on the Home Diagram button
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Change Diagram Type

If necessary, you can change the type of a diagram to
another type. This is useful if you have either made a
mistake in selecting the diagram type to begin with, or if the
purpose and nature of a diagram changes during analysis.

Access

Ribbon Design > Diagram > Options > Change
Type

Change a Diagram Type

Ste
p

Action

1 On the 'Change Diagram Type' dialog, click on the
'Select From' header and select the appropriate
Perspective group, and then select the Perspective
from the panel beneath the header.
The 'Diagram Types' panel displays a list of the
diagram types for the selected Perspective; click on

(c) Sparx Systems 2022 Page 1063 of 1974



Modeling Fundamentals 3 October, 2022

the diagram type to change the diagram to.

2 In the 'Diagram Types' panel, click on the diagram
type to change to.

3 Click on the OK button to change the diagram type.
The system checks whether there is a template
diagram for this diagram type in the Templates
Package and, if so, applies the display characteristics
defined in that template.

Notes

Some diagram types do not switch to others - for example,·

you cannot change a Class diagram into a Sequence
diagram; you can change, say, a Sequence diagram from
one technology into a Sequence diagram from a different
technology
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Grid-Style Diagrams

Grid-style diagrams allow you to manage and organize
diagrams, by sorting diagram elements into cells within a
grid. The grid functionality integrates with the new scripting
API to facilitate setting the appearance of diagram elements
dynamically, as the diagram is loaded.

Access

Properties
Window

Select 'Enable' from the drop-down list
for the option 'Grid-style' under the
heading 'Appearance'.
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This action turns on the 'grid-style' setting
and opens the 'Grid Properties' dialog,
where you can specify the Grid settings.

Context
Menu

For diagrams that are displayed with
Grid-Style enabled, the context menu
option 'Grid' offers a number of
commands specific to grid-style
diagrams.
They are:

Show Grid Lines·

Show Grid Headers·

Edit Grid·
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Compact Grid·

Setting the Grid Style Properties

Enabling 'Grid-Style' on a diagram creates a number of
columns on the diagram, according the values specified in
the 'Grid Properties' dialog. The rows are laid out
dynamically according to the number of columns and the
number of elements on the diagram.

The 'Grid Properties' dialog is displayed at the time of
enabling grid-style for a diagram.

The dialog can also be displayed at any time after grid-style
has been enabled, by selecting the context menu option 'Grid
> Edit Grid'.

On the dialog you set a number of properties:

The number of columns·

Whether to show the grid lines·
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Whether to show the column headings·

The width of the cells·

The height of the cells·

How to add new elements to the diagram - if the cell the·

element is being added to is already occupied, this option
determines if the system searches for the first free cell by
row (searching left to right/top to bottom) or by column
(top  to bottom/left to right)

Altering the Grid Cells Using Scriptlets

Scriptlet artifacts can be used to run JavaScript code to
access elements in a grid-style diagram and set the
appearance of those elements.  For example, to set the font
and background color, or to alter the text that is displayed.

Each Scriptlet has access to three global objects in addition
to the standard automation environment. They are:

theDiagram - an automation Diagram interface to the·

diagram on which the Scriptlet resides

theElement - an automation Element interface to the·

Scriptlet artifact itself

theInstance - an automation DiagramObject interface to·

the Scriptlet artifact itself

When a diagram is viewed as a grid, we can use automation
functions to retrieve elements at specified grid locations.
The location format is the same as one sees in a spreadsheet,
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with columns labeled 'A', 'B', 'C', ..., 'AA', 'AB', etc. and the
rows numbered in sequence.

To alter the appearance of a grid element, retrieve its
underlying Object, using the function GetObjectByGrid.

To alter the value of a grid element, retrieve its underlying
Element, using the function GetElementByGrid.

For example;

object = theDiagram.GetObjectByGrid("A", "2");

element = theDiagram.GetElementByGrid("A", "2");

A diagram can contain any number of Scriptlet artifacts.
The Scriptlets will run before the diagram is displayed, and
whenever the diagram is reloaded.  When there are multiple
Scriptlets on a diagram, the order in which they are executed
is determined by their Z-order on the diagram.
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Scriptlets

Scriptlet elements contain JavaScript that lets you tap into
the underlying diagram and element API for customizing the
element's appearance, text, Tagged Values and other
properties on the fly. Scriptlets run whenever the diagram is
loaded, or can be run manually on demand, providing
diagrams with more than a single static view.

Each Scriptlet has access to three global objects in addition
to the standard automation environment. They are:

theDiagram - an automation Diagram interface to the·

diagram on which the Scriptlet resides

theElement - an automation Element interface to the·

Scriptlet artifact itself

theInstance - an automation DiagramObject interface to·

the Scriptlet artifact itself

For references to Help topics related to these objects see the
Learn More links.

Access

Scriptlets can be placed on any diagram. You can place any
number of Scriptlets on a  diagram and you can place a
given Scriptlet on more than one diagram.

Perspective Construction > Scriplets
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Diagram
Toolbox

To create a Scriptlet:
Open the Toolbox·

Select the Scriptlet artifact from the·

'Dynamic Viewpoints' page of the
diagram toolbox
Drag it onto an open diagram·

Scriptlet Permissions

Code in Scriptlets cannot alter or update elements in the
model database.  It can, however, read and update copies of
the elements that are displayed on a diagram. Updates to
elements made by Scriptlets are NOT written back into the
model database.
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Editing Scriptlet Code

To add code to a Scriptlet, or to edit existing code for a
Scriptlet, either double-click on the Scriptlet on a diagram,
or right-click and select the 'Edit Script' menu option. The
Code Editor window opens, showing the code for the
selected Scriptlet.  Edit the JavaScript code for the Scriptlet,
as you would in any code editor.  Press the Ctrl+S keys to
save your changes.

An Example of a Scriptlet

This example comes from the model pattern 'Scriptlets >
Simple', available through the Model Wizard
(Ctrl+Shift+M).

//---   Example Scriptlet  ---

function Scriptlet1()

{

var object as EA.DiagramObject;

object = theDiagram.GetObjectByGrid("A","2");

if(object)

{

Session.Output("Scriptlet1 for " +
theDiagram.Name);
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object.BackgroundColor =
parseInt("0x554444",16);

object.FontColor = parseInt("0xeeeeee",16);

object.Update();

}

}

Scriptlet1();

Running a Scriptlet

Scriptlets are run whenever the diagram containing them is
loaded or reloaded, prior to the diagram being displayed. If a
diagram contains multiple Scriptlets, the order in which they
are run is determined by the Z-order of the Scriptlets on the
diagram.  Scriptlets can also be run manually at any time, by
right-clicking on the Scriptlet and choosing the option 'Run
Script' from the context menu.

Debugging a Scriptlet

You can debug a Scriplet as for any other section of code.
Right-click on the Scriptlet and select the 'Debug Script'
menu option. The Scriptlet is displayed in the Debug View.
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Scriptlets on Grid Style Diagrams

The automation API has some specialized functions that
Scriptlets can use when acting on diagrams displayed in a
Grid style. When a diagram is viewed as a grid, we can use
automation functions to retrieve elements at specified grid
locations. The location format is the same as one sees in a
spreadsheet, with columns labeled 'A', 'B', 'C', ..., 'AA', 'AB',
etc. and the rows numbered in sequence.

To alter the appearance of a grid element, retrieve its
underlying Object, using the function GetObjectByGrid.

To alter the value of a grid element, retrieve its underlying
Element, using the function GetElementByGrid.

For example;

object = theDiagram.GetObjectByGrid("A", "2");

element = theDiagram.GetElementByGrid("A", "2");
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Entry points and Multiple Scriplets

When using a single Scriplet it requires an entrypoint for the
execution of the Scriptlet. As this invocation is in the global
scope, the Scriptlet will execute when it is loaded. For
example the line:    Scriplet3()  is the entry point for:

Class

function Scriptlet3()

{

var element as EA.Element;

var object  as EA.DiagramObject;

element = FindDiagramElement("Discussion1");

if(element)

{

object = FindDiagramObject(element.ElementID);

object.BackgroundColor =
parseInt("0xc0c0c0",16);

object.Update();

}

}

Scriptlet3();
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Class

It is possible to have Scriptlets that simply define functions
that are called by other Scriptlets. One could have a single
Scriptlet with an entry point, for example, and several other
Scriplets that simply define a library of functions or set
some data.

There should, however, be at least one entrypoint defined in
one of the diagram's Scriptlets.  Where there are multiple
Scriptlets and only one entrypoint, the Scriptlet with the
entrypoint should be the last to run.

To set the ordering, in which these are compiled and
executed, use the z-ordering and set the main Scriplet with
the entry point to higher than the others and hence the last to
run.
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Using Scriptlets in MDG Technologies

Scriptlets can be incorporated into the definition of an
element stereotype, as part of a Profile in an MDG
Technology. In this way, Scriptlets can be used to perform
on-the-fly changes to an element's properties and
presentation.

To add a Scriptlet to an element stereotype, within the
element used to define the stereotype create an attribute
named '_scriptlet' and place the script code into the 'Initial
Value' field of that attribute's properties.  The JavaScript
language is used to write the Scriptlet code.

For more detail see _scriptlet  in the Special Attributes Help
topic.

Example Use of a Scriptlet in a Stereotype

In this example, the element that defines the stereotype
'Person', defines (among other things) three attributes,
'Height', 'Weight' and 'BMI'. It also defines the special
attribute '_scriptlet', that assigns a value to 'BMI', that is
calculated as 'Weight' divided by the square of 'Height'.
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Here is an example of an element created using the 'Person'
stereotype, that includes the BMI Scriptlet.

Note that the attributes of the stereotype, become Tagged
Values in elements created with that stereotype.
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Scale Image to Page Size

When you print a diagram, the default setting is to scale the
image to fit the size of the printer paper you have defined in
the page set-up. The image is not scaled up to fill the page,
but it is scaled down if it exceeds the current page boundary.
The image retains its current proportions; that is, it is scaled
down equally in the X and Y dimensions. For a large
diagram, this can mean that the components of the diagram
are small and hard to read.

Alternatively, you can print a multi-page image; that is:

allow the diagram image to print on as many printer pages·

as it naturally occupies, (no scaling), or

scale the diagram image to exactly fit a specified number·

of pages

In all three cases you also define the paper size and
orientation.

Access

Ribbon Design > Diagram > Manage > Properties
> Diagram: Advanced

Context
Menu

Right-click on background of open
diagram | Properties > Diagram:
Advanced
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Right-click on diagram in Browser
window | Properties > Diagram:
Advanced

Turn off or customize image scaling options

Ste
p

Action

1 Select from these options as required:
'None': select to print on as many pages as the·

diagram image requires
'Scale to 1 page': select to scale the diagram image·

to fit on the currently selected page
'Custom': select to specify the width and height of·

the diagram images in terms of the number of
pages in height and width; specify the number of
pages for each dimension
'Page Setup': click to select the page size and·

alignment

Notes
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Before printing, make sure you have selected the required·

page layout using the Page Setup button
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Set Up Diagram Page

You can change the size of the diagram area (or
scrollable/printable area) using the 'Properties' dialog for the
diagram.

Access

Ribbon Design > Diagram > Manage > Properties
> Diagram

Context
Menu

Right-click on background of open
diagram | Properties > Diagram
Right-click on diagram in Browser
window | Properties > Diagram

Set the page size

Ste
p

Action

1 Select the 'Show Page Border' checkbox.
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2 On the 'Page Setup' panel, click on the Advanced
button.
The 'Print Advanced' dialog displays.

3 Click on the Page Setup button.
The 'Page Setup' dialog displays.
As you adjust the settings on this dialog, the page
icon at the top illustrates the effects of your changes.

4 In the 'Size' field, click on the drop-down arrow and
select an appropriate page size.

5 In the Orientation panel click on the radio button for
the orientation of the page to print.

6 In the Margins panel, type the required left, right, top
and bottom page margins for the diagram, in inches.

7 Click on the OK button on the 'Page Setup' dialog,
the 'Print Advanced' dialog, and the 'Properties'
dialog for the diagram, in turn.
The area within the page boundary lines on your
diagram is expanded or reduced accordingly. When
you print or print preview, the output is cropped to
these boundary lines and the diagram divided
between the necessary number of pages.
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Notes

You can set the default paper size for new diagrams on·

the 'Diagram' page of the 'Preferences' dialog (select the
'Start > Appearance > Preferences > Preferences >
Diagram' ribbon option); once the paper size is set there,
all new diagrams have that as the default size

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Update Diagrams' permission to change diagram page set
up
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Lock Diagram

If User Security is not enabled, to protect a diagram against
inadvertent changes such as moving or resizing elements,
you can lock the diagram. If you or any other users select
any object on a locked diagram, the object's border or
outline displays in red.

Access

Context
Menu

Right-click on the background of open
diagram | Lock Diagram

Notes

This does not apply in the Corporate, Unified and·

Ultimate Editions if User Security is enabled; in this case,
see the Lock Model Elements topic

To unlock the diagram, select the 'Lock Diagram' menu·

option again
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Copy (Duplicate) or Move Diagram

As you develop the diagrams in your model, you might find
that some of the diagrams use many of the same elements
and have a similar format. You can copy and replicate the
complete diagrams for minor modification, resulting in a
duplicate diagram with either:

Links back to the original diagram elements, unless those·

elements are Text, Note, Hyperlink, Lifeline or Object
elements, or embedded elements on Objects, that are
specific to the diagram and that are copied (shallow
mode) or

Complete copies of all elements in the diagram, other than·

Packages (deep mode) or

Complete copies of all elements in the diagram that have·

the same parent as the diagram, and links back to the
original diagram elements for all other elements on the
diagram (smart mode)

You might find that a diagram is better held in a different
Package - such as a diagram library - and you need to move
it. To do this you simply open the parent and target
Packages in the Browser window, click on the diagram and
drag it from the parent to the target. Note that some
diagrams - particularly those in Systems Engineering - show
diagram frames that are renderings of the element that
currently holds the diagram. As you are moving the diagram
to a new owner, you are breaking that relationship between
the parent element and the diagram, so you need to turn off
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the display of the diagram frame before moving the
diagram. See the Diagram Context Menu Help topic.

Access

Context
Menu

Right-click on diagram in Browser
window | Copy/Paste | Copy Diagram
then:
Right-click on Package | Copy/Paste |
Paste Diagram  or
Right-click on element | Copy/Paste |
Paste Diagram

Keyboard
Shortcuts

Copy the diagram then:
Select Package > Ctrl+V  or·

Select element > Ctrl+V·

Duplicate a diagram

Option Action

Name Type the name for the new diagram.

Click on the radio button for the type of
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Type of copy copy you require; either:
Shallow·

Deep, or·

Smart·

OK Click on this button to initiate the copy.
The new diagram is automatically created
with linked or new elements arranged as
in the original diagram.
All connectors are also copied between
diagram elements where appropriate.

Notes

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Manage Diagrams' permission to copy diagrams

For a diagram copied in shallow mode, any changes to the·

properties of the original elements are reflected only in
those elements that are copied as simple links in the
pasted diagram

For a diagram copied in deep mode, any changes to the·

properties of the original elements are not reflected in the
elements in the pasted diagram

For a diagram copied in deep mode, Package elements are·
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copied as simple links only; you cannot paste as new

For a diagram copied in smart mode, any changes to the·

properties of the original elements are reflected only in
those elements that are copied as simple links in the
pasted diagram

Element position and size are independent in all copy·

modes
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Save Diagram Image to File

It is possible to capture a modeling diagram as an image file
in your file management system, for later use in - for
example - external documents and presentations. You can
capture the image in a number of different file formats,
including:

Windows bitmap·

GIF image·

Windows Enhanced Metafile (standard metafile)·

Windows Placeable Metafile (older style metafile)·

PNG format·

JPG·

TGA·

Access

Ribbon Publish > Diagram Image > Save > Save
to File

Keyboard
Shortcuts

Ctrl+T
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Capture a diagram as an image file

Ste
p

Action

1 On the 'Save As Image' dialog, select the appropriate
folder location for the file.

2 In the 'File name' field, type the file name to save the
image under.

3 In the 'Save as type' field, click on the drop-down
arrow and select the appropriate graphic format.

4 Click on the Save button.

Notes

The system clips the image size to the smallest bounding·

rectangle that encompasses all diagram elements

You can scale the size of the saved (bitmap) image·

upwards or downwards, using the option on the 'Diagram'
page of the 'Preferences' dialog ('Start > Appearance >
Preferences > Preferences > Diagram')

You can also enable and disable Diagram Frames on the·
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images that you capture of a diagram, on the same page of
the 'Preferences' dialog

By deselecting the 'Printable' option on an element on a·

diagram, you can omit that element from the diagram
image copied to file
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Copy Image to Clipboard

It is possible to capture a modeling diagram as an image on
the MS Windows clipboard for immediate use in - for
example - external documents and presentations in MS
WordTM or other applications, or in another diagram within
Enterprise Architect.

You can set the format of the clipboard images - bitmap or
metafile - on the 'Preferences' dialog ('Start > Appearance >
Preferences > Preferences' ribbon option; the dialog opens at
the 'General' page).

Access

Ribbon Open diagram, then:
Publish > Diagram Image > Save > Save
to Clipboard

Keyboard
Shortcuts

Open diagram, then press Ctrl+B.

Notes
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You can scale the size of the saved (bitmap, or·

non-metafile) image upwards or downwards, using the
option on the 'Diagram' page of the 'Preferences' dialog
('Start > Appearance > Preferences > Preferences >
Diagram')

You can also enable and disable Diagram Frames on the·

images that you capture of a diagram, on the same page of
the 'Preferences' dialog
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Delete Diagrams

Diagrams are representations of the ways in which model
element structures are organized. If you no longer want to
depict an arrangement of model elements, you can quickly
delete the diagram from your model. This has no effect on
the elements shown in the diagram - they and their
relationships remain unchanged within the model, and
accessible through the Browser window and several other
views and windows.

Access

Context
Menu

Browser window | Right-click on diagram
name | Delete '<diagram name>'
A confirmation prompt displays. Click on
the Yes button to confirm the deletion.

Keyboard
Shortcuts

Select diagram in Browser window |
Ctrl+Del
A confirmation prompt displays. Click on
the Yes button to confirm the deletion.

Notes
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In Enterprise Architect there is no 'Undo' feature for·

deleting diagrams, so be certain that you want to delete a
diagram before you do so

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Manage Diagrams' permission to delete diagrams

You can also delete multiple diagrams from the Browser·

window, by holding Ctrl or Shift while you select them,
then right-clicking on one of them and selecting the
'Delete selected items' option
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Diagram Tabs

Diagram tabs indicate which diagrams and views (such as
the Start Page, document reports, code editors and the
Model Search) are currently open in the work area, by
showing the view name and icon. The currently displayed
view is indicated by the name being in bold on a white tab.
An asterisk against the tab name indicates that the diagram
or view contains unsaved changes.

To open the view that you want, click on its tab. You can
select options for saving, reloading, moving and closing the
views from the tab context menu. You can also review the
tabs and select one using the View Tab Switcher window.
The tabs are located, by default, at the top of the Diagram
View; if you prefer, you can move them to the bottom of the
Diagram View using the 'Application Look' dialog (the
'Main View Tabs at bottom' checkbox).

Access

Context
Menu

Right-click on the 'Diagram' tab

Other The View Tab Switcher window can be
accessed by pressing and holding the Ctrl
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key, while pressing the Tab key.

Diagram tabs context menu options

Option Action

Save
Changes to
'<tab name>'

Select this option to save changes made
to the diagram or view.

Save All Select this option to save changes made
to the model.

Reload '<tab
name>'

Select this option to reopen the diagram
or view without the unsaved changes; that
is, revert to the state before any of your
changes were made.
This also refreshes the diagram or view
from the repository, to show any changes
made by other users in a shared model.

Float Select this option to convert the diagram
or view into a floating window that you
can move around your screen(s).
An alternative is to simply click on the
selected tab and drag it off the 'Diagram
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Tabs' row.
You could use this option to display and
work on several diagrams at the same
time, provided that you have not enabled
the 'Open Diagrams in Single Window'
option in the 'Application Look' dialog.
To restore a floating view to a tab in the
Diagram View, right-click on its Caption
Bar and select the 'Tabbed Document'
option.

Close '<tab
name>'

Select this option to close the selected
diagram or view; the system prompts you
to save any changes.
You can also close the tab by clicking the
middle mouse button/scroller.

Close All Select this option to close all open
diagrams and views; the system prompts
you to save any unsaved changes.

Close All
Except '<tab
name>'

Select this option to close all diagrams
and views except for '<tab name>'; the
system prompts you to save any unsaved
changes.

Close All
<view type>

(Where several views of the same type
can be opened at the same time, such as
diagrams, report documents, or text
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editors.)
Select this option to close all views of the
same type as the selected tab, leaving
views of other types still open.

Hide (Start Page only) Select this option to
hide the Start Page.
To redisplay the Start Page, use the
drop-down menu at the top right of the
Diagram View, or select the 'Start >
Application > Workspace > Show Start
Page' ribbon option.

Notes

You can change the sequence of tabs by clicking on each·

tab and dragging it to a different position, as required;
however, you cannot change the position of the 'Start
Page' tab - when displayed, it always sits at the left-hand
end of the sequence

If you have enabled the 'Open Diagrams in Single·

Window' option on the 'Application Look' dialog, you can
open only one diagram at a time; however, you can scroll
back through previously opened diagrams by clicking on
the diagram tab and pressing the Backspace key

One of the strengths of Enterprise Architect is that you·
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can work in one of the central views (the 'active' view)
and instantly display and edit aspects of your model in
one or more of the windows surrounding the view; having
completed your review in a window, however, you can
quickly switch focus back to the object you were working
on in the active view by pressing Ctrl+Shift+`
(effectively Ctrl+~)

The only context menu option available for the 'Start·

Page' tab is the 'Hide' option
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Switch Between Views

When there are a number of open views available in the
Diagram View (such as separate diagrams, editors and the
Model Search screen), you can review them and switch
between them using the View Tab Switcher.

Access

Other Click on a view tab, press and hold Ctrl
while you press the Tab key.

Switching between views

Action Detail

Selecting a
different
view
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The View Tab Switcher lists the currently
open views, in order of most recently
activated to least recently activated; the
selection cursor is on the name of the
view that was activated just before the
currently active one.
Details of the selected view are displayed
on the right hand side of the screen, and
include:

A preview thumbnail of the view, and·

A description of the view and its·

contents
Continue holding the Ctrl key to keep the
window open; to move the selection
cursor:

Down the list of views, press the Tab·

key
Up the list, press the Shift+Tab keys·
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Alternatively, use the arrow keys.

Activating a
view

To activate a view in the Diagram View,
either release the Ctrl key or press the
Enter key; alternatively, click on the
required view.
Activating a view moves it to the top of
the 'Active Views' list, whereas closing a
view removes it from the list completely.

Notes

One of the strengths of Enterprise Architect is that you·

can work in one of the central views (the 'active' view)
and instantly display and edit aspects of your model in
one or more of the windows surrounding the view; having
completed your review in a window, however, you can
quickly switch focus back to the object you were working
on in the active view by pressing Ctrl+Shift+`
(effectively Ctrl+~)
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Diagram Toolbox

The Diagram Toolbox is a panel of icons that you can use to
create elements and connectors on a diagram. You can also
use the Toolbox to add elements to:

A Package through the Specification Manager and·

A Package or an element in the Browser window·

Within the Toolbox, related elements and connectors are
organized into pages, each page containing the elements or
connectors used for a particular type of diagram. The
diagrams include standard UML diagrams, Enterprise
Architect Extended diagrams, and diagrams customized for
any MDG Technologies and Profiles that you have added to
the system.

When you open a diagram, the Toolbox automatically
provides the element and relationship pages corresponding
to the diagram type. This does not prevent you using
elements and connectors from other pages in a given
diagram, although some combinations might not represent
valid UML.

The Toolbox provides a number of mechanisms for locating
the page or object you want to use.

Access

Ribbon Design > Diagram > Toolbox
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Keyboard
Shortcuts

Ctrl+Shift+3

Other You can display or hide the Diagram
Toolbox by clicking on the  or  icons
at the left-hand end of the Caption Bar at
the top of the Diagram View.

Example

For any given diagram a number of Toolbox pages might
display, but these generally include:

<type> Elements·

<type> Relationships·

<type> Patterns·

Common Elements·

Common Relationships and·

Several groups of Artifacts·

This is illustrated in the example:
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Locating Diagram Toolbox Pages or Icons

These options help you to locate and display particular
pages or icons in the Diagram Toolbox

Option Detail

Search for a
Toolbox page
or icon

The easiest way to locate a Toolbox page
or specific icon that you require is to use
the 'Find Toolbox Item' dialog, which you
display by clicking on the  button at the
top of the Toolbox. The 'Find Toolbox
Item' dialog displays every Toolbox page,
listed by Technology name and page
name, in alphabetical order.

The columns that display on this dialog
can be added to using the 'Field Chooser'
dialog (right-click on the column
headings and select the 'Field Chooser'
option), and dragged into a different
sequence. You can also select options to
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use the 'Group Box' to reorganize the
display of information in the dialog, and
to expand or hide the contents of every
Diagram Toolbox page. You can expand
the Toolbox pages individually by
clicking on the white arrowhead to the
left of the page name.
To locate a Toolbox page or icon, you
can type some or all of the characters in
the name or property of the object you are
searching for in either:

The 'Search Term' field or·

The appropriate Filter bar field·

underneath each column header
(right-click on the column headers and
select the 'Toggle Filter Bar' option) or
'Search Term' and Filter bar fields in·

combination to further refine the search
As you type, the list immediately reduces
to show only the objects that have those
characters in their name or property text.
Be aware that if you have the list
collapsed, showing only the Toolbox
page name, the list might show page
names that do not include the characters.
Those pages do contain objects that have
those characters. The search
automatically selects the first object in
the list; to move to the next object, press

(c) Sparx Systems 2022 Page 1110 of 1974



Modeling Fundamentals 3 October, 2022

the Down Arrow key.
To confirm what the object is that you
have positioned the cursor on (especially
if you do not want to use all the columns
available in the 'Field Chooser' dialog)
the stereotype and page name for the
object display in the bottom left corner of
the dialog.
Having located the Toolbox page or
object you require in the dialog, you click
on the Add to Diagram button or drag the
objects onto an open diagram to generate
elements or connectors. You can also
drag element icons into the Specification
Manager to generate elements there.
If you want to refresh the Diagram
Toolbox to display the Toolbox page you
have selected, so that you can use all the
icons in it during this session, either:

Click on the Activate Toolbox button,·

or
Double-click on a page name or an·

object in the 'Find Toolbox Item'
dialog, or
Right-click on an object in the list and·

select the 'Show Toolbox' option
The context menu also provides options
to
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Pin the Toolbox page to the Diagram·

Toolbox so that it is always included
there until it is specifically unpinned
Move the cursor to the first Filter Bar·

field ('Name') to edit it
Hide the Filter Bar·

Expand or collapse all the Toolbox·

pages displayed in the dialog

Search for an
icon on the
current
Toolbox page

To locate an element or link on the
currently-displayed Toolbox pages,
simply overtype the Search field at the
top of the Toolbox with some or all of the
characters of the object name. The field
filters the pages to show only those
objects that have those characters in their
names.
To clear the field, click on the  icon or
press the Delete key or Backspace key.
This facility is very useful if you have
long pages of elements or several pages
pinned in the Toolbox (see the Customize
the Toolbox section).

Filter Pages
by
Perspective

Click on the  icon at the right of the
Toolbox toolbar. This displays a list of
Toolbox pages, filtered for the
currently-selected Perspective. To set or
change the Perspective, select the
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'Change Perspective' option at the top of
the menu. This displays the list of
Perspective Groups; click on these to
show a submenu of Perspectives, and
select the required Perspective.
In some cases the list of Toolbox pages
might be of page groups that you select to
list the pages themselves. Scroll through
the lists to find the name of the pages you
want. If the list is very long, you can
scroll using the mouse wheel or up arrow
and down arrow keyboard keys, or by
clicking on the small black arrows at the
top and bottom of the list window. Click
on the required name to display the pages
in the Toolbox.
If you select the <default> option, at the
top of the list, you display only the
'Common' and 'Artifact' pages.
You can pin various pages in the Toolbox
to customize it, showing the elements and
relationships you most commonly use for
the types of diagram you model with, and
you can add MDG Technologies and
UML Profiles to the Toolbox under their
own Perspectives.
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Create elements and connectors on the
diagram from the Toolbox

Ste
p

Instruction

1 In the Browser window, double-click on the icon
against the required diagram.
The diagram opens with the appropriate Toolbox
pages for that diagram type.
If you want a different set of elements and
connectors, select the appropriate Toolbox pages as
explained previously.

2 Click on the icon for the required item; for example,
the Class element or Associate relationship.

3 For element items, click anywhere on the diagram to
place the new element at the cursor position.

4 For connector items, drag the cursor between the
source and target elements on the diagram; as you
pass the cursor over the elements, a hatched border
displays inside each element's solid border,
indicating the source and potential target elements.
To add bends to the connector, press Shift as you
change the drag direction of the cursor.
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Alternatively, drag from the source element to an
empty area of the diagram; the Quick Linker
suggests common target element types and connector
types to create.

5 Edit the element properties or connector properties,
as required.

Create elements in the Browser Window

Click on the element icon in the Diagram Toolbox, then
click on the parent Package or element in the Browser
window to select it, and click again to drop the element
under the parent.

You cannot add objects that do not display in the Browser
window, such as Note elements, Text elements, connectors
or Boundaries.

If an element is of a type that cannot be added as a child of
the object in the Browser window, an error message
displays.

Notes

Dropping a Package icon from the Toolbox into a diagram·
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creates a new Package in the Browser window, and a
default diagram of the same type as the current diagram

If you are creating several elements of one type, after·

creating the first just press Shift+F3 or Ctrl+click to create
the next element of that type; for connectors, click on the
source element and press F3 to create another connector
of the same type

You can change an unstereotyped element to one of its·

stereotyped elements by dragging the stereotyped element
icon from the Toolbox onto the unstereotyped element in
the diagram; for example, you can stereotype a Class by
dragging a Table icon or a Profiled Class icon onto it

As you drag the stereotyped element icon, you can press·

Ctrl to apply the element stereotype to the unstereotyped
element, or Shift to add the stereotyped element as a new
element; otherwise a small context menu displays offering
these actions as options

If the diagram element already has the stereotype, you can·

also drag the Toolbox icon onto it to synchronize the
element's stereotype Tagged Values

The Toolbox can be docked on either side of the diagram,·

or free floated on top of the diagram to expose more
surface for editing; you can also hide and redisplay the
Toolbox by clicking on the horizontal 'chevron' icon at the
left of the diagram header bar

Enterprise Architect provides Toolbox pages for a wide·

range of MDG Technologies, such as ArchiMate, BPEL,
BPMN, Data Flow diagrams, ICONIX and Mind
Mapping, as part of the initial install

(c) Sparx Systems 2022 Page 1116 of 1974



Modeling Fundamentals 3 October, 2022

(c) Sparx Systems 2022 Page 1117 of 1974



Modeling Fundamentals 3 October, 2022

Toolbox Appearance Options

You can modify the appearance of the Diagram Toolbox
pages in several ways, through the Toolbox context menu.

Access

Other Right-click on a Toolbox page
background

Options

Option Detail

Hide or Show
Element or
Relationship
Name Labels

Select the 'Hide Labels' (or 'Show
Labels') context menu option.
The icons in the page then 'wrap' within
the page, without text labels.

When you hide the labels, you can
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display the label of an individual element
or relationship by moving the cursor over
the icon.

Pinning
Individual
Pages to
Display All
the Time

Select the 'Pin in Toolbox' context menu
option.
For example, if you 'pinned' the expanded
'Class' page, and switched to the
'Communication' pages, the Toolbox
would include a collapsed 'Class
elements' page below the
'Communication' pages.
You can also pin a 'SysML Common'
page to the Toolbox, simply by making
the SysML 1.4 Technology the Active
technology for your work login.
These Toolbox pages are automatically
pinned and cannot be unpinned:

Common Elements·

Common Relationships·

Documents·

Governance·

Dynamic Viewpoints·

Charts·

Simulation·

Unpinning
Pages

To unpin the expanded page so that it
displays only in its own Toolbox group,
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select the 'Unpin from Toolbox' context
menu option. This applies to pages
pinned from the context menu or through
the 'Pinned Toolbox Pages' dialog (see
the Tailor Toolbox to List all Required
Pages at Once table).

Collapsing
Pages

To collapse a page to just show the
heading (such as 'Class', 'Documents' or
'UML Standard Profile'), select the
'Collapse the current branch' option.
Alternatively, click on the page name.
To expand the page again, click on the
page name.

Setting a
Toolbox
Page as the
Package
Default

You can set a Toolbox page to be shown
whenever a specific Package is selected
in a view such as the Specification
Manager.
Click on the Package in the Browser
window, then locate and select the
required page in the Diagram Toolbox.
Either:

Right-click on the Toolbox page or·

Click on the page header and click on·

the Hamburger icon
Now click on the 'Set as Package Default'
menu option. An SSDefaultToolbox tag
is added to the current Package, with the
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fully qualified name of the current
Toolbox page as its value.
The Toolbox page will now be loaded
into the Toolbox as the default whenever
the Package is selected in the
Specification Manager or other view.

Tailor Toolbox to List All Required Pages at
Once

Ste
p

Instruction

1 On the context menu, click on the 'Set Toolbox
Visibility' context menu option. (This option is also
displayed in the  drop-down menu.)
The 'Pinned Toolbox Pages' dialog displays, showing
all the Toolbox pages available under the
currently-selected Perspective.
Initially, the currently-selected Perspective is the
global perspective identified on the <perspective
name> icon at the top right of the application screen.
Click on the <perspective name> button at the top of
the dialog and select the Perspective Group and
Perspective most appropriate to the area you are
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working in. If you want to examine diagrams across
the model from any Perspective, select the 'All'
option.
Changing the Perspective in the 'Pinned Toolbox
Pages' dialog does not change the 'global' perspective
on the icon. If you want to re-set the 'Pinned
Toolbox Pages' dialog Perspective to the global
Perspective, simply click on the <perspective name>
button and select 'Active'.

2 By default, the dialog lists the element pages only, in
alphabetical order.
To include the corresponding relationship pages,
select the 'Show Relationship Pages' checkbox at the
bottom of the dialog.

3 For each page to display on the Toolbox, select the
'Pinned' checkbox.
Deselect the checkbox if you no longer require a
page to be displayed.

4 When you have defined the list of pages to display,
click on the OK button.
The pages you have selected are pinned to the
Toolbox in a collapsed state, underneath the current
diagram-type pages.
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5 To expand a page, click on the heading.
To remove an individual page, expand it, right-click
on it, and select the 'Unpin from Toolbox' option.

Notes

On a Toolbox page for an MDG Technology or UML·

Profile, if you right-click directly on a Profile element an
additional option - 'Synchronize Stereotype' - is available
at the end of the context menu; this enables you to
synchronize the Tagged Values and constraints for all
elements created from the selected Profile element

MDG Technologies can impose their own Toolbox page·

visibility; for example, if ICONIX is the active
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technology, all six ICONIX pages are automatically
exposed in the Toolbox

If the active Technology pages duplicate UML or·

Extended pages (as the ICONIX pages do), the pinned
Technology pages override and replace the pinned UML
and Extended pages; for example, if ICONIX is active and
you have pinned the 'Extended | Analysis' page, the
'Analysis' page in the list is the ICONIX-defined page, not
the 'Extended | Analysis' page
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Toolbox Shortcut Menu

When you add elements and connectors to a diagram, you
can do so using the 'Toolbox Shortcut' menu as an
alternative to employing the full graphical Toolbox.

The menu resembles this example:

It provides options to add to the diagram:

Multiple elements at once, of types appropriate to the·

diagram or selected Toolbox page

Elements and connectors from Toolbox pages assigned to·

other diagram types (the 'Other' option)

Elements and relationships specific to the current diagram·

type (in the example, the Database elements)

Elements and relationships from any pages pinned in the·

Toolbox (in the example, the 'Use Case' and 'Class'
options)
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Common elements and relationships·

Artifacts of any type·

The advantage of using the shortcut menu is that it provides
an increased amount of the workspace to be used for
diagramming rather than displaying fixed (instead of
pop-up) menus.

Use the Toolbox Shortcut Menu

Ste
p

Action

1 Open a diagram.

2 Click on the diagram background and press the
Insert key or Spacebar or, using the mouse, hold the
left button and click the right button.
The 'Toolbox Shortcut' menu displays.

3 If you want to:
Create a group of elements in one go, select the·

'Create Multiple Elements' option to display the
'Create Multiple Elements' dialog, or
List elements and connectors for a different·

diagram type, either:
     -  Select a pinned Toolbox page option, or
     -  Select the 'Other' option to display the 'Find
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Toolbox Item' dialog and search for the
appropriate element or toolbox page
Add a common element or an Artifact element,·

expand the appropriate option

4 Click on the element or connector to include in the
diagram; the element is added to the diagram, or you
can drag from one element to another to create the
connector.
If you select the 'Other' context menu option, the
'Find Toolbox Item' dialog offers the 'Activate
<Type> Toolbox' option; this opens and activates the
corresponding page in the Toolbox.

Notes

As with the Toolbox itself, if an MDG Technology:·

     -  Is active
     -  Automatically pins Toolbox pages, and
     -  Duplicates UML or Extended pages
then the pinned Technology pages override and replace
the pinned UML or Extended pages in the 'Toolbox
Shortcut' menu

(c) Sparx Systems 2022 Page 1127 of 1974



Modeling Fundamentals 3 October, 2022

Add Multiple Elements

Enterprise Architect provides a facility for quickly creating
a number of elements to be added to a diagram in one go.
This helps you to organize a set of elements - all the same
type or a mixture of types - and review them, renaming or
deleting some if necessary, before committing them to the
diagram and model. One of the very useful features of this
facility is that you can import a block of lines of text and
automatically create a new element from each line. You can
use this to generate a large number of, say, Requirement or
Business Rule elements with meaningful names, from a
source document such as a spreadsheet or specification in an
instant.

You set up the group of new elements using the 'Create
Multiple Elements' dialog.
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There are two variants of this dialog. You can create:

Separate elements through one of a number of keyboard·

commands, in which case the dialog shows the 'Name' and
'Type' columns, or

Elements related to one selected element using the Quick·

Linker arrow, in which case the dialog also provides a
'Link' column (as shown) through which you specify what
the relationships are between the selected element and the
new elements

Access

On an open diagram:

Ribbon Design > Element > Add Element >
Multiple Elements

Keyboard
Shortcuts

Insert key > Create Multiple Elements
Space Bar > Create Multiple Elements
Ctrl+right-click > Create Multiple
Elements
Shift+right-click > Create Multiple
Elements

Other Drag an element's Quick Linker arrow to
an open space on the diagram and release
the mouse button > Create Multiple
Elements
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Create the group of elements

On the 'Create Multiple Elements' dialog:

Ste
p

Action

1 In the 'Name' column, overtype the Create new
element text with the name of the new element.

2 In the 'Type' column, click on the drop-down arrow
at the right of the field and select the required
element type.
The types offered in the drop-down list are those
currently listed in the Toolbox selected for the
diagram (or, if you selected the option with the
Quick LInker arrow, the types are the same as those
in the Quick Linker list).

3 Selecting the type positions the cursor on the next
line, with the 'Type' field set to the same element
type as you selected from the previous element.
You can simply type in the next element name and
press the Enter key to create another element of the
same type, or type in the name and repeat Step 2 to
add an element of a different type.
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4 If you have displayed the 'Create Multiple Elements'
dialog from the Quick Linker arrow menu, the dialog
displays a 'Link' column for the type of relationship
between the selected element and each new element.
Click on the drop-down arrow and select the
relationship type from the list; the list is the same as
that provided by the Quick Linker, and consists of
the appropriate common relationships for the source
and element types.
The first selected relationship sets the default for the
next relationship you create on the dialog, and you
can either leave that as it is or select a different type.

5 When you have specified a complete set of elements
and relationships, you can quickly review and - if
necessary - modify them using a context menu
within the dialog (see the Review New Elements
table) before you commit them to the diagram and
model.
When you are satisfied that you have defined the
objects you require, click on the OK button to add
them to the diagram and model.
If the linked elements need to have other structures
(such as the Object Flow link between an Activity
and an Action) these are also added (in this case, an
ObjectNode on the Activity and an ActionPin on the
Action).
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6 If you decide not to create elements from the names
you have entered, press the Cancel button to delete
them all and to close the dialog.

Review New Elements

Right-click on an item in the list, to display the context
menu.

Op
tio
n

Action

A
dd
N
e
w
El
e
m
en
t

Position the cursor in the next empty 'Name' field,
ready for you to type in an element name. The 'Type'
and 'Link fields' default to the values from the
previous entry.
Shortcut: Ctrl+N

E
dit
Ite

Place the selected element name in Edit mode, to be
typed over with a different name.
You can also change the name, element Type and
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m Link type by clicking on the field and overtyping or
selecting a new value from the drop-down list.
Shortcut: Enter key

D
el
et
e
ite
m

Immediately remove the selected item from the
dialog. The element does not and will not exist in the
diagram and model, and therefore will not have any
links to other elements, Packages or diagrams to
check. There is no validation to establish whether to
delete the element from the diagram only, or from
the diagram and model.
Shortcut: Ctrl+D

I
m
po
rt
N
a
m
es
fr
o
m
Cl
ip
bo
ar
d

Insert a number of lines of text from the Windows
clipboard, each line becoming the name of a new
element. The element Type and Link type default to
the last-defined types, which you can leave as is or
change as required. If the dialog is too narrow to
display the element names, you can resize it.
The imported text can come from an internal or
external file. The system takes any line break (Enter,
Shift+Enter, Ctrl+Enter) as the end of the text string
and hence the end of the element name.
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Common Pages

The 'Common' pages of the Diagram Toolbox provide the
elements and relationships that can be used on any diagram.
They are displayed at the bottom of every other set of pages
in the Toolbox.

    

Common Elements

Element Description

A Note element is a textual annotation
that can be attached to a set of elements
of any other type.

A Constraint is a form of Note,
identifying a constraint on other
elements.
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A Text element is a textual annotation
that is similar to a Note, however has no
border or background color.

A Legend element provides a key to the
colors and line thicknesses you have used
to distinguish between element and/or
connector groupings on the diagram.

On a diagram, it is possible to display a
customized text box called the Diagram
Properties Note, which automatically
shows the diagram properties.

A Hyperlink element is a special kind of
Text element that, when double-clicked,
opens the configured target object such as
a document, web page or diagram.

An Artifact is any physical piece of
information used or produced by a
system. This icon generates a generalized
Artifact that you can define as one of a
number of types. There are also Toolbox
pages providing specialized types of
Artifact, for specific purposes. See the
Artifact Toolbox Pages Help topic.

An Information Item element represents
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an abstraction of data, which data can be
conveyed between two objects.

A System Boundary element is a
non-UML element used to define
conceptual boundaries.

An Image is a System Boundary element
that automatically has an Alternate Image
defined.

An Image Asset is a specialized Artifact
element for holding an image that can be
called into a number of diagrams to show
a captured document or screen, a graphic,
or an object.

Common Connectors

Connectors Description

Dependency relationships are used to
model a wide range of dependent
relationships between model elements.

A source object implements or Realizes

(c) Sparx Systems 2022 Page 1137 of 1974



Modeling Fundamentals 3 October, 2022

its destination object.

The Trace relationship is a specialization
of an Abstraction, connecting model
elements or sets of elements that
represent the same concept across
models.

An Information Flow represents the flow
of Information Items (either Information
Item elements or classifiers) between two
elements in any diagram.

An Abstraction is a relationship between
two elements that represent the same
concept, either at different levels of
abstraction or from different viewpoints.

A Substitution is a relationship between
two Classifiers, signifying that the
substituting Classifier complies with the
contract specified by the contract
Classifier.

A Usage is a Class diagram relationship
in which one element requires another
element for its full implementation or
operation.
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A Derive relationship connects two
elements when the value of one is derived
from the value of the other. This type of
relationship is appropriate to link
Requirements on different levels of
abstraction; for example, a solution
Requirement derived from a business or a
stakeholder Requirement.

A Refine relationship connects a
Requirement and another model element
that adds refinement or additional
information that helps clarify the
Requirement so that its meaning is more
apparent.

A Responsibility connector is a UML
standard stereotype that defines a contract
or an obligation of an element in its
relationship to other elements.

A Notelink connector connects a Note to
one or more other elements of any other
type.
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Artifact Toolbox Pages

An Artifact is any physical piece of information used or
produced by a system. In Enterprise Architect these are
represented by the Artifact element, which can have one of a
number of stereotypes to tailor it to a specific purpose,
including internal operations and structures within the
model as indicated in the examples. Artifacts can have
associated properties or operations, and can be instantiated
or associated with other Artifacts according to the object
they represent. You can create an Artifact element by
dragging an Artifact icon from one of several Diagram
Toolbox pages, according to type.

The 'Common Elements' page of the Toolbox also has a
generic Artifact icon that - when you drag it onto a diagram
- offers a choice of types of Artifact to create.
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Documents Toolbox

The 'Documents' page of the Diagram Toolbox provides a
variety of model elements to use for documenting various
aspects of the system you are modeling. The different types
of document artifact are detailed in the Types of Document
Artifact table.

Types of Document Artifact

Type Description

Document
Artifact

A Document Artifact is an Artifact having
a stereotype of «document». You can
create the Document Artifact using the
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Documentation, SysML or Zachman
Framework pages of the Diagram
Toolbox, and associate it with an RTF
document or CSV file.
Double-click on the element to display
the Linked Document Editor. When you
have created the Linked Document, the
Document Artifact element on the
diagram shows an 'A' symbol in the
bottom right corner.

Custom
Document
Artifact

A Custom Document is a form of Linked
Document, and therefore is associated
with an element in the model. However,
Linked Documents usually contain static
information specific to the host element,
whereas the main feature of a Custom
Document is that it contains
automatically refreshed information on
several objects from anywhere in the
model. Therefore, the main method of
creating a Custom Document also
generates a Document Artifact element to
host the document, in a selected Package.
A Custom Document Artifact represents
a document that is made up of a range of
model elements and their properties,
where every time you open the document
the content is dynamically refreshed from
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the model objects you have included and
from the template instructions.
A custom document can have three types
of content:

Content contained in the document·

template - including a title page, table
of contents and paragraph text
Dynamic Content that is dragged into·

the document from the Browser -
including Packages, diagrams,
elements and features
Static Content that a user types or·

pastes into the document
For example, at any point in the
document where a diagram is needed or a
list of items is required that exist in the
model, these can simply be dragged in
from the Browser window. How these
items are rendered is determined by the
selection of an appropriate document
template.

Encrypted
Document
Artifact

An Encrypted Document Artifact is used
to create and hold a Linked Document
that is automatically encrypted, and that
cannot be opened and automatically
decrypted within Enterprise Architect
without entering a password. You can
therefore use the generated Artifact
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element to record sensitive information,
which you protect from general access by
assigning a password.
When you drag the 'Encrypted Document'
icon onto the diagram from the
'Documentation' page of the Toolbox, a
prompt displays to type in a password.
When you enter the password, you can
create the Linked Document. Thereafter,
if any user attempts to open the
document, the same password prompt
displays. If the user does not provide the
password that you originally specified,
the document will not open. If the correct
password is provided, the document is
decrypted and opened.
The Encrypted Document Artifact is
indicated in the Toolbox page, diagram
and Browser window by a red 'document'
icon - .

Report
Specification
Artifact

A Report Specification Artifact
encapsulates a report definition. When
you have created the element on the
diagram, you double-click on it to display
the 'Generate Documentation' dialog, on
which you enter the report parameters
and, if required, generate the report.
After you create the Report Specification,
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each time you double-click on the
Artifact element the 'Generate
Documentation' dialog again displays
with the same report parameters. You can
continue to generate the same report, or
alter the parameters if necessary. If you
change the parameters, they are
re-presented until such time as you
change them again.

Reading List
Artifact

The Reading List Artifact provides a list
of elements that contain information of
particular significance to a task or
process. The intention is for the
information from each element to be
displayed in the 'Dynamic Document'
view, in the sequence in which the
elements are organized in the Reading
List.

User Story
Artifact

A User Story Artifact provides a means
of documenting a business Use Case, in
the context of Agile methodologies such
as Extreme Programming (XP). In the
Linked Document, you define the
functions a business system must
provide; it captures the 'who', 'what' and
'why' of a requirement in a simple,
concise format. The User Story Artifact
behaves as a Document Artifact,
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prompting you to select a Linked
Document template to base the document
on.

Model
Document
Artifact

A Model Document Artifact provides a
template for developing a Model
Document element to generate either a
stand-alone virtual document or a section
of a virtual document.
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Governance Toolbox

The 'Governance' Toolbox page provides icons to create
project management elements and Artifacts, to generate
Requirement, Maintenance and Review elements and
documents and structures to show what development either
should be performed or has been performed.

Types of Governance Artifact
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Type Description

Requirement A Requirement element captures the
details of a system requirement.

Change A Change element represents a change in
the defined requirements for the current
system and can be used to request and
manage the change process.

Issue An Issue element represents an item of
concern that might or might not arise, or a
failure to meet a defined requirement in
the current system.

Review A Review element enables you to define
a formal review of a part of the model, in
particular a small number of elements
and/or diagrams. Each Review element
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enables you to define when the review
should start and end, and which members
of the team are responsible for
performing the review.

Discussion
Artifact

The Discussion Artifact provides a place
to host a discussion about a particular
part of a model, rather than discussing a
specific element.
Drag the Discussion Artifact onto a
diagram where you want to discuss some
aspect of the model, and give the Artifact
a name. You might want to outline the
purpose and scope of the discussion in
the Notes and perhaps even add a Linked
Document where you record decisions
resulting from the discussion.

Checklist
Artifact

A Checklist Artifact provides the facility
for generating a list of items, each with a
checkbox, to be used as a checklist. You
can set each checkbox to default to being
selected or unselected, and set all selected
options to be grayed out or struck
through, so that the unselected options
are more prominent. The end users can
then work with the element to tick off
items that have been obtained or activities
that have been completed.
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A version of this Artifact - the
Requirements Checklist - is available in
the 'Extended Requirements' Toolbox
page. This automatically contains ten
characteristics of a good Requirement, for
a Requirement author to tick off as they
check that their Requirement has been set
up to show those characteristics.

Audited
Checklist
Artifact

The Audited Checklist is an extension of
the Checklist Artifact, having an
associated 'Audit Records' page. It is a
useful tool for Project Management,
providing the facility to monitor
accountability and track completion of
tasks.

Matrix
Specification
Artifact

A Matrix Specification Artifact
encapsulates a Relationship Matrix
Profile definition. When you have created
the element on the diagram, you
double-click on it to display the 'Matrix
Specification' dialog, in which you create
the Profile definition. The Profile takes
the name of the element. The Profile
defined in the Artifact is independent of
the Package that contains the Artifact
element, and therefore could specify
source and target Packages other than the
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parent Package.
After you create the Profile definition,
each time you double-click on the
Artifact element the Relationship Matrix
displays with the Profile applied.
To edit the Profile, right-click on the
Artifact and select the 'Documentation |
Edit Matrix Profile' option.

Feature
Mapping
Artifact

The Feature Mapping Artifact saves a
profile that represents a particular
combination of field values specified in a
Feature Matrix.
The Artifact is usually created by clicking
the Options button on a Feature Matrix
view, then choosing the option 'Profiles |
Save as new Profile'. The Artifact is
added to the diagram's parent Package as
an <<EAFeatureMapping>> Artifact, and
the profile name displays at the end of the
'Profiles' sub-menu.
If you drag the icon from the Toolbox
page onto a diagram, a Feature Matrix
template displays and you can adjust the
field values to create the profile. Note
that in this context you drag the source
and target elements from the Browser
window into the 'Source' and 'Target'
fields, ensuring that they have
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relationships between attributes,
operations or receptions..
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Charts Toolbox

The 'Charts' Toolbox page provides a variety of Chart
artifacts to simplify the creation of Charts within your
model. Each type of Chart artifact is described in the Types
of Chart Artifact table.

You can create a new Chart by dragging a Chart artifact
from the Toolbox page onto a diagram.  Double-click on the
new Artifact to open a dialog where you can specify
parameters and the data source for the Chart.

Types of Chart Artifact
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Type Description

Standard
Chart
Artifact

A Standard Chart Artifact provides the
facilities for generating a Pie Chart or Bar
Chart on an aspect of the data in your
model. It adds three 'Chart Details' tabs to
the standard tabs of the element
'Properties' dialog.
After you have added the element to your
diagram, double-click on it. The element
'Properties' dialog automatically opens at
the 'Chart Details - Source' tab. Define
the Chart type and data source, then go
on to define any filters you want to apply,
and how the Chart should display.
Once you have defined the Chart, it
automatically displays with the latest
information whenever you open the
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parent diagram.

Time Series
Chart
Artifact

A Time Series Chart Artifact provides the
facilities for generating a linear graph of a
model property over time.
After you have added the element to your
diagram, double-click on it. The element
'Properties' dialog automatically opens at
the 'Chart Details - Source' tab. Define
the Package from which the data is to be
extracted, and the time interval over
which the data is to be sampled. Then go
on to define the appearance of the Chart.
Once you have defined the Chart, it
automatically displays with the latest
information whenever you open the
parent diagram.

Dynamic
Chart
Artifact

Dynamic Chart Artifacts are Chart
elements that can be styled and rendered
dynamically when the diagram opens.
Dynamic Charts rely completely on code
to define their series, style and content
and are managed entirely through the
Automation Interface by clients -
typically Plug-ins and scripts.

BPSim
Result Chart

The BPSim Result Chart Artifact appears
in the 'Charts' page of the Toolbox when
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Artifact the BPSim Simulation Engine has been
installed and registered on your system.
This Artifact generates a Chart that
reflects selected results from a series of
standard BPSim Simulations.

BPSim
Custom
Result Chart
Artifact

The BPSim Custom Result Chart Artifact
appears in the 'Charts' page of the
Toolbox when the BPSim Simulation
Engine has been installed and registered
on your system. This Artifact generates a
Chart that reflects selected results from a
series of customized BPSim Simulations.
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Dynamic Viewpoints Toolbox

The Dynamic Viewpoints page of the Diagram Toolbox
provides a number of elements that actively refresh the
interface to Enterprise Architect and the information it
displays within various contexts. For example, Working
Sets apply a required combination of dialogs and screens,
whilst Scriptlets execute JavaScript code to update element
displays and properties according to the latest changes to the
model data.

Types of Dynamic ViewPoint Artifact
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Type Description

Scriptlet
Artifact

A Scriptlet Artifact provides access to
Enterprise Architect's API to help you:

Update Grid style diagrams using the·

cell reference (A:1, A:2 and so on)
through the API
Automate updates to dynamic·

properties
Apply visual changes to elements,·

name and Tagged Values
Validate model elements in a diagram·

Populate a table·

Render graph elements in a dashboard·

Dynamically color code elements based·

on your rules
You can have multiple Scriptlets on a
diagram and you can use the same
Scriptlet on multiple diagrams.
Simply drag and drop the Scriptlet icon
onto a diagram, then double-click on the
element to open the Code Editor. The
JavaScript code attached to the Scriptlet
is run whenever the diagram is opened.
You can also run the Scriptlet code
manually as required.

Model View A Model View Artifact provides the
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Artifact facilities for generating a tabular Model
View Chart on a segment of the data in
your model, extracted using a custom
SQL search.
After you have added the element to your
diagram, double-click on it. The element
'Properties' dialog automatically opens at
the 'Chart Details - Source' tab. Define
the SQL Search to extract and tabulate
the information.
Once you have defined the Chart, it
automatically displays with the latest
information whenever you open the
parent diagram.

Custom
Table
Artifact

A Custom Table Artifact generates a
diagram object that displays custom data
in a grid format similar to a spreadsheet,
providing extra 'non-modeled'
information on elements, diagrams or
project management exactly where it is
applicable.

Working Set
Artifact

A Working Set Artifact defines a
Working Set that opens various windows,
diagrams and views, recreating a work
environment that you frequently use.

To create or modify the Working Set,·

right-click on the element and select
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the 'Edit Working Set' option
To execute the Working Set to open the·

defined windows and views and
execute any commands, double-click
on the element
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Simulation Toolbox

The 'Simulation' page of the Diagram Toolbox provides a
range of Simulation Artifacts that can be easily created by
simply dragging them onto a diagram. Each of the different
Artifacts encapsulates specifications or parameters that are
required to run the simulation represented by the Artifact.

Each of the Artifact types is described in the Types of
Simulation Artifact table.

Types of Simulation Artifact

Type Description
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Business
Process
Simulation
Artifact

A Business Process Simulation Artifact
represents and contains the configuration
data for a Business Process Simulation.
BPSim Artifacts can be created on a
diagram in any Package in the same
project as the BPMN model that you are
working with.
You can specify 'base' and 'variation'
Artifacts using Generalization
connectors, so that the variations inherit
the data you have defined in the 'base'
Artifact. This way, you do not have to
keep re-defining the whole configuration
in every Artifact you create.

SysMLSim
Configuratio
n Artifact

The SysMLSim Configuration Artifact
encapsulates the run-time parameters for
executing the simulation of a SysML
model.
Double-click the Artifact to display the
Configure SysML Simulation window.
This window is the interface through
which you specify the parameters for the
simulation.

Executable
StateMachine
Artifact

An Executable StateMachine Artifact is
the vehicle through which you can
generate, build (compile) and execute -
via simulation - code for a StateMachine
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or complex of StateMachines.
Each StateMachine is the child of a Class
element; when you drag the Class from
the Browser window onto the Artifact
element, it is pasted inside the Artifact as
a Part. You can paste several Classes -
and, therefore, Parts - into a single
Artifact.
Having set up the Executable
StateMachine Artifact, you use simple
context menu options on the Artifact to
perform the code generation, build and
execution operations on all
StateMachines bound within the Artifact.

DMN
Simulation
Configuratio
n Artifact

A DMN Simulation Configuration
Artifact contains information that defines
the simulation of a DMN model depicted
by Decision Requirement diagrams.
Double-clicking on the Artifact opens the
DMN Simulation window, from which
you can run simulations of the Decision
Model, perform validation, generate code
and generate test modules.
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Use Case Toolbox

The Use Case Toolbox pages are used to model system
functionality from the perspective of a system user. Use
Case objects are used to build the Use Case models, which
describe the functionality of the system to be built, the
requirements, the constraints and how the user interacts with
the system.

Sequence diagrams can be associated with Use Cases to
capture workflow and system behavior.

Use Case Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and UML
Connectors sections of the Help.
These two relationships are stereotyped
Dependency relationships defined by the
OPEN Modeling Language (OML -
Object-oriented Process, Environment
and Notation Modeling Language - is an
international de facto standard
object-oriented development method
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developed and maintained by the OPEN
Consortium). They have been
incorporated into the Use Case modeling
elements.

Invokes indicates that Use Case A, at·

some point, causes Use Case B to
happen
Precedes indicates that Use Case C·

must complete before Use Case D can
begin

The 'Basic Use Case' icon adds the Basic
Use Case Pattern to your diagram as a
starting point for developing the diagram
(drag the icon onto the diagram to open
the 'Add Pattern <name> to Diagram'
dialog and click on the OK button).

Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Class Toolbox

The Class Toolbox can be used for creating Class models
and Data models. Such models contain Package diagrams,
Class diagrams and Object diagrams - those diagrams that
usually display elements concerned with the logical
structure of the system, such as Objects, Classes and
Interfaces.

Logical models can include domain models (high level
business driven object models) through to strict
development Class models (defining inheritance, attributes
and operations).

Class Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and UML
Connectors sections of the Help.
You use the Table element to insert a
stereotyped Class for use in data
modeling.
The Association element is an n-ary
Association, which is used to model
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complex relationships between three or
more elements.

Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Object Toolbox

The Object Toolbox is used to create Object diagrams,
which reflect multiplicity and the roles that instantiated
Classes could serve. They are useful in creating different
cases in which relationships and Classes are applied.

Object Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and
UML Connectors sections of the Help.
A Boundary is a stereotyped Object that
models some system boundary, typically
a user interface screen.
A Control is a stereotyped Object that
models a controlling entity or manager.
An Entity is a stereotyped Object that
models a store or persistence mechanism
that captures the information or
knowledge in a system.
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Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Composite Toolbox

The Composite Toolbox is used to create Composite
Structure diagrams. These reflect the internal collaboration
of Classes, Interfaces or Components to describe a
functionality or to express run-time architectures, usage
patterns and the participating elements' relationships, which
static diagrams might not show. The Class elements form
the basic structure of the diagram, with Interface, Part, Port
and Collaboration elements defining the functionality or use
of the Classes.

Composite Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and
UML Connectors sections of the Help.
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Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Communication Toolbox

The Communication Toolbox is used to develop
Communication diagrams, in which you model dynamic
interactions between elements at run-time. These diagrams
are used to model workflow and sequential passing of
messages between elements in real time; they are often
placed beneath Use Case elements to further expand on Use
Case behavior over time.

The Actor element models a user of the system, while the
other elements model things within the system, including
standard elements (Object) and the user interface component
(Boundary), Controller and Entity.

Communication Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and
UML Connectors sections of the Help.
A Boundary is a stereotyped Object that
models some system boundary, typically
a user interface screen.
A Control is a stereotyped Object that
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models a controlling entity or manager.
An Entity is a stereotyped Object that
models a store or persistence mechanism
that captures the information or
knowledge in a system.

Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Interaction Toolbox

The Interaction Toolbox is used to develop Sequence
diagrams. You use Sequence diagrams to model dynamic
interactions - workflow and the sequential passing of
messages - between elements in real time. Sequence
diagrams are often placed beneath Use Case elements to
further expand on Use Case behavior over time.

Interaction Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and
UML Connectors sections of the Help.

A Boundary is a stereotyped Object that
models some system boundary, typically
a user interface screen.
A Control is a stereotyped Object that
models a controlling entity or manager.
An Entity is a stereotyped Object that
models a store or persistence mechanism
that captures the information or
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knowledge in a system.

Notes

The Interaction element supports the capture of·

Interaction diagrams through the Browser window and
diagram context menus; you cannot capture these
diagrams by dragging the element onto a diagram

The 'Fragment' icon creates Combined Fragment elements·

Message, Self Message and Call are described as·

Sequence diagram messages

Messages can be simple or recursive calls·

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Timing Toolbox

The Timing Toolbox provides the modeling elements for
creating Timing diagrams, which define the behavior of
objects along a time-scale to visualize how the objects
change state and interact over time.

Timing diagrams can be used for defining hardware-driven
or embedded software components, and time-driven
business processes.

Timing Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and
UML Connectors sections of the Help.

The Message relationship is specifically
described for Timing diagrams.

Notes
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To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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State Toolbox

The State Toolbox is used to develop StateMachine
diagrams, to show the enableable states a Class or other
element might be in and the transitions from one state to
another. These diagrams are often placed under a Class
element in the Browser window to illustrate how a particular
element changes over time. States can have substates; for
example, Accelerate and Brake might be substates of
Active.

State Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and UML
Connectors sections of the Help.

Event is used to create a basic Send
element (the default) or Receive element
on the StateMachine diagram.

(c) Sparx Systems 2022 Page 1180 of 1974



Modeling Fundamentals 3 October, 2022

Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Activity Toolbox

The Activity Toolbox is used to model system dynamics
from a number of viewpoints (represented by activities and
the flows between them) in Activity diagrams and
Interaction Overview diagrams. Both types of diagram are
usually created under Activity elements.

Activities can be stereotyped as a process to display a
business process icon; the Activity represents some work
that is carried out, which might overlap several Use Cases or
form only a part of one Use Case.

Activity Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and UML
Connectors sections of the Help.
The 'Basic Activity' icon adds the Basic
Activity Pattern to your diagram as a
starting point for developing the diagram
(drag the icon onto the diagram to open
the 'Add Pattern <name> to Diagram'
dialog and click on the OK button).
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Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Component Toolbox

The 'Component' pages of the Diagram Toolbox provide
model elements that you can use to model the physical
components of your system in a Component diagram. The
'Component' pages contain elements and connectors related
to the actual building of the system - the components that
make up the system (such as ActiveX DLLs or Java beans),
the Interfaces they expose and the dependencies between
those elements.

A component is a piece of hardware or software that makes
up the system; for example, a DLL or a Web Server are
components that might be deployed on a Windows 2000
Server (Node).

Component Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and UML
Connectors sections of the Help.
A Packaging Component is an element
that appears very similar to a Component
in a diagram but behaves as a Package in
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the Browser window.

Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Deployment Toolbox

The Deployment Toolbox provides model elements that you
can use to model the physical components and deployment
structure of your system in a Deployment diagram. The
Deployment group contains elements related to the actual
building of the system - the hardware or software
Components that make up the system (such as ActiveX
DLLs or Web Servers) and the physical platforms (Nodes)
those Components run on (such as a Windows 2000 Server),
including the physical connections between Nodes.

Deployment Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and UML
Connectors sections of the Help.
The 'Basic Deployment' icon adds the
Basic Deployment Pattern to your
diagram as a starting point for developing
the diagram (drag the icon onto the
diagram to open the 'Add Pattern <name>
to Diagram' dialog and click on the OK
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button).

Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Profile Toolbox

The Profile Toolbox is used in creating Profiles, a generic
mechanism for extending UML models. Profiles can define
custom Stereotypes, Tagged Values, Diagram Types and
Toolboxes.

The Toolbox also contains a set of Profile Helpers that
provide templates and dialogs to help you create Stereotype
Profiles, Toolbox Profiles and Diagram Profiles within an
MDG Technology.

Profile Toolbox Pages

Image Detail

The Profile Package element acts as the
container for the diagrams, elements and
connectors that define the Profile itself.
The Stereotype element provides a
mechanism for varying the behavior and
type of a base UML model element.
A Metaclass element represents the base
UML element or connector type that you
are extending.
An Enumeration element is used to define
an enumeration Tagged Value, which can
be attached to one or more Stereotype
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elements that have been defined in the
Profile.
A Data Type element is used to represent
types of data, such as programming
language primitive types, CORBA basic
types, and Tagged Value types. For
example, integer and string types are
often treated as Data Types.
Profile Helpers are templates and dialogs
that help you create, respectively:

An MDG Technology Package to·

contain Profile definitions
Stereotypes and Metaclasses within a·

UML Profile
A customized Toolbox Profile·

Toolbox pages within the customized·

Toolbox
A Diagram Profile to define an·

extended diagram type
An Extension relationship shows that a
Stereotype extends a Metaclass; all
Stereotypes must extend either:

One or more Metaclasses, or·

Another Stereotype that extends a·

Metaclass; you can create a chain of
extending Stereotypes that ultimately
extend the Metaclass (however, in
practice you are unlikely to have more
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than two Stereotypes in the chain)
A Generalize relationship shows that one
Stereotype specializes a more general
Stereotype; the more general Stereotype
must still extend a Metaclass.
A Tagged Value relationship defines a
reference-type (that is, RefGUID) Tagged
Value owned by the source Stereotype;
the Tagged Value is named for the target
role of this association, and is limited to
referencing elements with the stereotype
by the association target element

Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Metamodel Toolbox

The Metamodel Toolbox provides model elements for
creating Metamodel diagrams.

Metamodel Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and
UML Connectors sections of the Help.
The Metamodel Primitive element that
supports the MOF specification, which
you create using the Primitive icon, is
deprecated. Use the Primitive element
from the Class Toolbox.

Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
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diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the source element in the diagram and drag to the
target element
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Analysis Toolbox

Analysis-type elements are used early in modeling to
capture business processes, activities, collaborations and
general domain information. They are generally used in
Analysis diagrams.

Analysis Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and UML
Connectors sections of the Help.
A Process is a stereotyped Activity, used
to model business processes.
A Boundary is a stereotyped Object that
models some system boundary, typically
a user interface screen.
A Control is a stereotyped Object that
models a controlling entity or manager.
An Entity is a stereotyped Object that
models a store or persistence mechanism
that captures the information or
knowledge in a system.
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You can also use a number of stereotyped
elements from the 'Business Modeling'
pages of the Toolbox, to capture UML
business process modeling extensions
such as worker, case worker, entity and
controller.

Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Custom Toolbox

The Custom Toolbox contains extended UML elements that
can be of use in modeling or designing your system in a
Custom diagram.

Custom Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and
UML Connectors sections of the Help.

A Requirement is a custom element used
to capture requirements external  to
standard UML elements; a Requirement
expresses required system behavior that
can cross several Use Cases.
You can connect Requirements to other
elements using the Realize connector to
express the implementation of a
requirement and hence the traceability
from user requirements to what is being
built.
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An Issue element is a structured comment
that contains information about defects
and issues relating to the system/model;
affected elements are connected by Trace
connectors.
A Change element is a structured
comment that contains information about
changes requested to the system/model;
affected elements are connected by Trace
connectors.
A Screen provides a stereotyped Class
element that displays a GUI type screen;
this can be used to express application
GUI elements and flows between them.
A UI Control likewise can be used to
express GUI controls.
A Test Case element defines what must
be set up in order to test a particular
feature; you can use it to define a set of
tests once for a number of elements. As
an element rather than a property, it
provides greater visibility for tests.
Entity - use of this element is deprecated
- it was originally intended to take the
role now supplied by the Table element.
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Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Requirements Toolbox

As an analysis step, often it is desirable to capture simple
system requirements. These are eventually realized by Use
Cases.

Requirements Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and UML
Connectors sections of the Help.
A Requirement is a custom element used
to capture system requirements external
to individual UML elements; a
Requirement expresses required system
behavior that can cross several Use
Cases. You can create a number of
specific types of stereotyped Requirement
from their own element icons.
Requirements Checklist is a stereotyped
Checklist, and is rendered as this
element:
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A Feature is a small client-valued
function expressed as a requirement.
Features are the primary
requirements-gathering Artifact of the
Feature-Driven Design (FDD)
methodology.
A Risk element represents an identified
risk to the project.
You can also add structures of Functional
and Non-Functional Requirements to
your diagram, each with a Checklist,
using the two Requirements Patterns.

Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted
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To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Maintenance Toolbox

The Maintenance Toolbox provides the elements and
connector for defining and monitoring Issues, Defects,
Changes, work Tasks and Tests for project management.

Maintenance Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and UML
Connectors sections of the Help.
An Issue element is a structured comment
that contains information about issues
relating to the system or model; affected
elements are linked by Trace connectors.
A Change element is a structured
comment that contains information about
changes requested to the system/model;
affected elements are connected by Trace
connectors.
A Task element defines a task attached to
an element; you can assign resources
specifically to the task rather than just to
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the parent element, and monitor the tasks
on diagram Gantt charts.
A Test Case element defines what must
be set up in order to test a particular
feature; you can use it to define a set of
tests once for a number of elements. As
an element rather than a property, it
provides greater visibility for tests.
An Entity is an abstract type that is often
used in analysis to record that something
is of interest to the system, without
necessarily defining how it will be
represented in the system.
A Test element represents a step in any of
the Basic, Alternate or Exception Paths of
a Scenario, created within a Use Case or
other element.
A Defect element is a structured
comment that contains information about
defects relating to the system or model;
affected elements are linked by Trace
connectors.

Notes

To add an element to the currently-open diagram, click on·
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the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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User Interface Toolbox

The User Interface Toolbox provides a wide range of icons
that you can use to create User Interface diagrams.

User Interface Toolbox pages

Image Detail

Except where discussed here, each
element and relationship that you can
create using these Toolbox pages is
described in the UML Elements and UML
Connectors sections of the Help.
The Screen element represents the screen
or dialog frame in a graphical user
interface. You can identify fields,
delimiters and buttons on the screen using
the different UI Control elements.
UI Control elements are different
stereotyped elements defining controls
such as buttons, fields and combo boxes.
You arrange these on the Screen element,
as part of a User Interface diagram, to
define a screen or dialog in a user
interface.
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This diagram illustrates each type of UI
Control element from the Toolbox, within
a Screen element.

Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element

To place one UI Control object inside another (for·

example, adding fields or options to a Panel or Form),
press Shift as you drag the object into place

You can add objects to the diagram and move them·

around, but once the object is within the boundary of a
Screen element (or another UI Control element) you
cannot move it out of that boundary on the diagram; you
can move child elements between parents on the Browser
window

If you delete a Screen (or other parent element) on the·

diagram, all the UI Control elements it contains are also
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deleted from the diagram
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WSDL Toolbox

The WSDL Toolbox provides elements you can use to
rapidly develop a W3C Web Service Definition Language
(WSDL) model, from which you can automatically generate
WSDL documents.

WSDL Toolbox page

Image Detail

A Namespace represents the top-level
container for the WSDL model. Drag this
element onto an open diagram to create
the necessary model structure for WSDL
documents.
A physical WSDL document is
represented as a UML Component. Its
interfaces represent the WSDL Services.
A WSDL Port Type is modeled as a
UML Interface. Its Port Type Operations
are realized by Binding elements.

Each of the operation parameters is
derived from the Message elements
defined in the Messages Package.
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Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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XML Schema Toolbox

The XML Schema Toolbox provides model elements that
you can use to model W3C XSD schema files. This Toolbox
implements the constructs provided by the UML Profile for
XML Schema. Having created your model, you can
automatically generate the W3C XSD schema files from it.

XML Schema Toolbox pages

Image Detail

A Schema corresponds to a UML
Package, which contains the type and
element definitions for a particular
targetNamespace. Drag this item onto an
open diagram to create the Package to
contain your schema model elements.
The Package is stereotyped as
XSDschema.
Open the logical diagram created under
the XSDschema Package and add
additional schema elements to define the
model.
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Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Data Modeling Toolbox

The Data Modeling Toolbox provides a basic set of
elements for database modeling and database design, in
conjunction with the UML Data Modeling Profile.

Data Modeling Toolbox page

Image Detail

In the data model, a:
Table defines a database table·

View represents a database view·

Procedure represents database (or·

Stored) procedures
Sequence represents a database·

Sequence
Function represents a database·

Function
Database Connection helps you to·

configure a connection to the database
you are modeling, for testing, import
and export of schema, and comparison
of differences between database and
model using the Database Builder
When you drop this icon onto the
diagram the system prompts you to
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indicate whether to create the
connection for an Access database, a
Firebird database or an ODBC database
For the first two options, when you
click on the OK button the system
prompts you to select the file to create
the connection to
If you select the 'ODBC database'
option, the 'Select Data Source' dialog
displays; click on the 'Machine Data
Source' tab and select the data source
(project on a database)
After you have defined the data source,
when you double-click on the element
the Database Builder view opens for
the current database model
SQL Query is an Artifact element that·

provides a convenient mechanism for
storing an SQL Statement in the
repository, for repeated execution on
live database(s)

Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
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prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Test Domain Toolbox

The Test Domain Toolbox provides a basic set of elements
that you can use to create Test Domain diagrams, used in the
Testpoint facility. A Test Domain diagram provides specific
elements that can aid in the logical composition of tests into
Test Sets and Test Suites.

Test Domain Toolbox page

Image Detail

A Test Cut is a group of operations that
represent a specific behavior (such as
Print) defined for a Class, separate from
other constraints defined for the Class.
A Test Set aggregates one or more groups
of methods (Test Cuts) that perhaps span
multiple Classes, into a single task.
A Test Suite aggregates one or more
groups of tasks (Test Sets).

Notes
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To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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XML Transformation Toolbox

The XML Transformation Toolbox page provides elements
for modeling and executing the transformation of an input
document into XML or other document formats under the
control of an XSL Stylesheet. You can model and execute
the transformation on an XML Transform diagram.

XML Transformation Toolbox page

Image Detail

XML File generates a File Artifact
element, through which you identify the
location of the input file to be
transformed.
XSLT generates a File Artifact element,
through which you identify the XSLT
Stylesheet to apply to the transformation.
XSD generates a File Artifact that
identifies the schema against which the
output of the transformation (as directed
in the Output Artifact element) is
validated. The results of the validation
are written to the 'XSL' tab of the System
Output window.
XML Transform generates a stereotyped
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Activity that performs the transformation.
Output Artifact generates a File Artifact
element, through which you specify the
location of the output file generated by
the transformation, on the 'Files' property
page of the element. Output from the
transformation will be written to this file.
The elements can be connected to each
other using Trace connectors.

Notes

To add an element to the currently-open diagram, click on·

the appropriate icon and drag it into position on the
diagram; set an element name and other properties as
prompted

To add a relationship, click on the appropriate icon, then·

click on the start element in the diagram and drag to the
end element
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Diagram Properties

You can set several properties of a diagram using either the:

'Properties' dialog or the·

Properties window·

This topic discusses the 'Properties' dialog. For information
of the Properties window, see the Help topic Properties
Window for Diagrams.

There are several options for opening the 'Properties' dialog
for a given diagram:

Double-click in the background of the open diagram·

Right-click on the background of the open diagram and·

select the 'Properties' option

Select the 'Design > Diagram > Manage > Properties'·

ribbon option to open the 'Properties' dialog for the
currently open diagram

In the 'Properties' dialog you can set properties including
name, author and version information, zoom factor, paper
size and layout, diagram notes and various appearance
attributes. Some properties influence the display of the
diagram and some are logical attributes that appear in the
documentation.

Notes

In the Corporate, Unified and Ultimate Editions of·
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Enterprise Architect, if security is enabled you must have
'Update Diagrams' permission to change diagram
properties

Using the 'Diagram - Gradients and Background' page of·

the 'Preferences' dialog, you can define the default
diagram background color and color gradients for all your
diagrams; these settings are also applied to any Diagram
Theme you apply across your model
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Diagram Properties - General

You use the 'General' tab of the diagram 'Properties' dialog
to record facts concerning the diagram as an object, such as
its title, version and modification date.

Access

Ribbon Design > Diagram > Manage > Properties
> General

Context
Menu

Right-click diagram in Browser window |
Properties | General
Right-click background of open diagram |
Properties | General

Other On the Properties window for a diagram,
click on the  icon

Set Diagram Properties

Option Action
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Name Defaults to the name of the parent
Package, as the name of the diagram.
If necessary, overtype the field with a
different diagram name. You can change
the diagram name in this field whenever
necessary.

Author Defaults to the name of the person who
created the diagram.
If necessary, overtype the field with a
different author name, or click on the
drop-down arrow and select a name from
the list. You might do this if the diagram
becomes the responsibility of another
person.

View Shows the specialization or viewpoint of
the diagram within its type, initially set
when you create the diagram through the
'New Diagram' dialog. For example, each
of the UML Behavioral diagrams can be
a Simple (Default) diagram or a more
complex Behavioral (Complete) diagram;
each UML Structural diagram could be a
Simple diagram or a more complex
Structural (Complete) diagram, whilst a
Class diagram can additionally be a
Domain Modeling, Hierarchy or
Metamodel diagram. The View
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determines what elements and connectors
are provided through the Diagram
Toolbox, the Simple diagram types
having the most basic set of toolbox
items.
You can change the View within the
diagram type; click on the drop-down
arrow and select the preferred View.

Version Displays the version number (or other
version reference) that has been manually
set for the diagram. If this is a cloned
diagram, the version number will have
been defined as part of the cloning
process. If no number has been set, the
field defaults to 1.0.
To update the version number, overtype
the field.

Filter to
Version

Select this checkbox to filter the elements
on the diagram and mute those that do not
have the same version number as the
diagram. This is of particular value when
you are working on the elements of a
cloned diagram and want to distinguish
between elements that have been cloned
to match the diagram and Package
structure, and elements that are still the
same version as the source.
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You can use the facility to check more
generally which elements are not of the
same version as the diagram, such as
when you drag elements from the
Browser window as links to local or,
more especially, external elements.
The filter takes effect when you click on
the OK button.

Set new
elements to
Version

Select this checkbox to set the version of
every new element added to the diagram
to the same version as the diagram.
Elements dragged and dropped from the
Diagram Toolbox or added using the
'New Element' dialog will have the same
version as the diagram. The version value
of elements dragged and dropped from
the Browser window will not be updated.

Stereotype (Optional) Type in the name of a diagram
stereotype to apply, or click on the
drop-down arrow and select a stereotype
from the list.
You can define stereotypes to select here
using the 'Settings > Reference Data >
UML Types' ribbon option, selecting the
'Stereotypes' page and creating
stereotypes with a 'Base Class' of
'Diagram'.
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Created Automatically displays the date on which
the diagram was created.
If necessary, overtype the field with an
amended creation data, or click on the
drop-down arrow and select the date.

Modified Automatically displays the date and time
when the diagram was last modified.

GUID Read-only field, displaying the GUID of
the selected diagram.

Notes Type in any additional information on the
diagram. You can format the notes using
the Notes toolbar at the top of the field.

OK If you have finished updating the diagram
properties, click on this button to save the
changes and close the 'Properties' dialog.

Cancel If you do not want to save the changes
you have made, click on this button to
discard the changes and close the dialog.

Help Click on this button to display this Help
topic.
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Notes

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Update Diagrams' permission to update diagram
properties
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Diagram Properties - Detail

A diagram can show or hide information, and represent it in
different ways depending on how you configure the display
characteristics. You can maintain your display configuration
using the diagram 'Properties' dialog ('Diagram' tab).

Access

Ribbon Design > Diagram > Manage> Properties
> Diagram

Context
Menu

Right-click diagram in Browser window |
Properties | Diagram
Right-click background of open diagram |
Properties | Diagram

Set the diagram display options

Option Action

Use Alias if
Available

Select this checkbox to display the
element alias as the element's name,
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wherever the alias is specified.

Show
Additional
Parents

Select this checkbox to display the names
of all parent elements not in the current
diagram, for all Classes and Interfaces.

Hide Page
Border (All
Diagrams)

Select this checkbox to disable the
display of page borders on all diagrams in
the model.

Hide Page
Border
(Current
Diagram)

Select this checkbox to disable the
display of the page border on the current
diagram only. (Disabled if 'Hide Page
Border (All Diagrams)' is selected.)

Show
Diagram
Details

Select this checkbox to show diagram
details in a note in the top left corner of
the diagram.

Deselect the option to hide the diagram
details.

Show
Sequence
Notes

(On a Sequence diagram) Select this
checkbox to display the internal Notes for
each Message down the left-hand edge of
the diagram. Each note has the same
number as the Message it comes from.
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Disable fully
scoped object
names

Select this checkbox to disable the use of
fully scoped object names for elements in
this diagram. This automatically deselects
the 'Show Namespace' option and hides
the 'Namespace::element Name' in each
element, but does not hide the '(from
'Namespace')' label.
The effect of this option is disabled if
'Fully Qualified Namespace' is also
selected.

Display
Element
Lock Status

Select this checkbox to add a locking
indicator (  or ) outside the top left
corner of each locked element on the
diagram.
If the element is:

Fully locked or locked by another user,·

the indicator is red
Locked by you or by another user in·

the same user group as you, the
indicator is blue
Not locked, no indicator displays·

Show
Namespace

Select this checkbox to show the
namespace of each element on the
diagram.
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For Class, Interface, Enumeration,
Component, Node and Artifact elements,
the namespace is shown as part of the
element name; that is,
'Namespace::element Name'.
For elements of other types, the
namespace is shown as a '(from
'Namespace')' label beneath the element.

Fully
Qualified
Namespace

(Enabled when 'Show Namespace' is
selected) Select this checkbox to show
the fully qualified namespace of each
element on the diagram, as a '(from
'Namespace')' label under the element.

Always Open
as Element
List

Select this checkbox to always display
the diagram contents as a Diagram List
rather than as a diagram.

Always Open
as Gantt

Select this checkbox to always display
the diagram contents as a Gantt chart.
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Always Open
as
Specification

Select this checkbox to always display
the diagram contents as a list of text
descriptions in the Specification
Manager.

Page Setup Adjust the scaling of the diagram image
according to the size of the page it is to
be printed on.

Print Page
Header and
Page Footer

Select this checkbox to add page headers
and footers to a print-out of the diagram.
The headers and footers are generated
from the diagram characteristics, such as
the name of the creator and the date of
modification.

Background
Tile

Click on the  button and select a
background tile design to apply just to
this diagram. The filename of the
background design file displays in the
left-hand field.
If you no longer want to apply a
background tile to the diagram, click on
the Clear button.

Document
Generation
Options

These are options for generating
document reports that include the
selected diagram.
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Exclude
image from
Documentati
on

Select this checkbox to exclude this
diagram image from any document report
generated on the parent Package or
element.

Add each
contained
element in
Documentati
on

Select this checkbox to include
documentation on each element in this
diagram, in any document report
generated on the parent Package or
element.

Divide
Diagram into
Multiple
Pages

Select this checkbox to divide each large
diagram into separate pages in the
document report.

Rotate
Images

Select this checkbox to rotate each
diagram image by 90 degrees in the
document report.

Default
Zoom

This facility is enabled when the selected
diagram in the 'Properties' dialog is open
and available for editing in the Diagram
View (that is, open and not locked).
Zoom in or out of the diagram to achieve
the required magnification using either
Ctrl+mouse wheel before you open the
'Properties' dialog, or the slider control on
this 'Diagram' page. Click on the Set as

(c) Sparx Systems 2022 Page 1233 of 1974



Modeling Fundamentals 3 October, 2022

Default button. Now, each time the
diagram is opened, it will default to this
zoom level.
This diagram-local default zoom
overrides any global zoom setting you
have imposed for your user ID, using the
slider in the Status bar.

Make all
elements
dockable

Select this checkbox to set all elements
on the diagram as dockable.
Setting elements as dockable allows you
to align and join the elements either
vertically or horizontally, on the current
diagram only.
Elements that you dock must have the
joining edges parallel. As the distance
between the elements narrows, the
moving element snaps to the edge of the
stationary element. Deselecting the
'Dockable' option does not separate the
elements; if necessary, you can simply
move the elements apart again.
Activity Partitions already have the
option selected by default.

Set Layout
Style

Click on this button to define the layout
of the diagram, to be applied
automatically when you select the
'Layout Diagram' options.
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OK If you have finished updating the diagram
properties, click on this button to save the
changes and close the 'Properties' dialog.

Cancel If you do not want to save the changes
you have made, click on this button to
discard the changes and close the dialog.

Help Click on this button to display this Help
topic.

Notes

The 'Divide Diagrams into Multiple Pages' option is only·

effective when the 'Scaled Printing' option on the 'Print
Advanced' dialog is set to 'None'

'Rotate Images' is only available for bitmap (.bmp) images·
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Diagram Properties - Elements

It is possible to show a number of element characteristics on
a selected diagram. You can define which of these
characteristics to show, by selecting the corresponding
checkboxes on the 'Elements' tab of the diagram 'Properties'
dialog (and, conversely, which to hide by clearing their
checkboxes). You can also override the model default
coding language and set a different language for the
elements in the context of this diagram.

Access

Ribbon Design > Diagram > Manage > Properties
> Elements

Context
Menu

Right-click background of open diagram |
Properties | Elements

Set Component Display Options

Option Action

(c) Sparx Systems 2022 Page 1236 of 1974



Modeling Fundamentals 3 October, 2022

Use
Stereotype
Icons

For elements that have whole shapes
drawn by Enterprise Architect (such as
Analysis stereotypes), select this
checkbox to draw the alternative shape (if
defined).
For elements that have an icon displayed
in the top right corner (such as an Artifact
element), if 'Show Element Stereotypes'
is selected, select this checkbox to
display the stereotype icon instead of the
stereotype text.

Show
Element
Stereotypes

For elements that have whole shapes
drawn by Enterprise Architect, if 'Use
Stereotype Icons' is deselected, select this
checkbox to display any stereotype and
keyword on the element.
For elements that have an icon displayed
in the top right corner, select this
checkbox to indicate that a stereotype is
present (icon if 'Use Stereotype Icons' is
selected, text if not).

Show Port
Classifiers

Select this checkbox to show the
classifier of each Port on the diagram.

Show
Property
Type

Select the checkbox to show Port and
Part types on the diagram by default.
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Show Data
Model
Owner

Select this checkbox to display the owner
of each Table element in the diagram.
This is defined in the Owner Tagged
Value on the table or, for PostgreSQL,
Owner To.

Show
Element
Property
String

Select this checkbox to show the
advanced property string for all elements;
for example, {leaf}.

Group Tags
by Stereotype

Select this checkbox to organize the
Tagged Values shown on the element on
the diagram into groups according to
stereotype.

Hand Drawn Select this checkbox to display the
diagram contents as if they had been
roughly drawn by hand.

Whiteboard
Mode

Select this checkbox to display the
diagram as if it had been drawn on a
whiteboard, with white fill and
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background.

(This illustration also has 'Hand Drawn'
mode enabled.)

Custom
Draw

Select this checkbox to turn on diagram
custom style. Clear the checkbox to
revert to normal notation. Changes to this
checkbox are reflected in the 'Custom
Style' checkbox in the diagram Properties
window, and vice versa.

Show Shape
Scripts

Defaults to selected to show elements and
connectors with their Shape Scripts, on
the diagram. Clear the checkbox to show
elements and connectors in their native
shapes.
This option does not affect Custom
Compartments. To hide those, deselect
the appropriate checkboxes in the 'Show
Compartments' panel, or on the element
'Compartment Visibility' dialog.

Show
Compartment

Select each checkbox to show the
corresponding feature or property
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s compartment for all elements using
Rectangle Notation on the diagram:

Attributes·

Inherited attributes·

Operations·

Inherited operations·

Requirements·

Inherited requirements·

Testing (Testing Scripts)·

Discussions·

Resources (including 100% complete·

resources allocated to the element)
Notes·

Tags (Tagged Values)·

Inherited tags·

Fully Qualified tags·

Receptions·

Constraints·

Inherited constraints·

Maintenance (Maintenance Scripts)·

Reviews·

Project·

Package contents·

Deselect the checkbox for each
compartment you want to hide.
If you have added custom compartments
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to your model display, such as Related
Elements, Flow Ports or Parts, 'Show
Compartments' checkboxes are also listed
for each of them. These checkboxes
default to selected to show the
compartments on the diagram; deselect
the checkboxes to hide the compartments.
If the checkboxes do not seem to operate
for an element on a diagram, also check
the 'Compartment Visibility' settings for
that element.

Language Click on the drop-down arrow and select
the programming language that elements
created on this diagram receive,
overriding the model default language.
If you do not want to override the model
default, select the value <none> from the
drop-down list.

Support
Collaboration

Select a value to flag elements on this
diagram where monitoring for new
messages has been turned on for:

Elements that are the subject of·

Discussions
Chat messages to specific user groups·

(Chat messages to individual users are
automatically monitored)

If an element is the subject of a
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monitored Discussion, and an unread
message is in the 'Discuss' tab of the
Discuss & Review window, the  icon
displays against the element on the
diagram.
Each monitored Chat group or user
should be represented by an Actor
element on the diagram. If a user or a
member of a group sends a Chat message,
the  icon displays against the
appropriate Actor element on the
diagram.
There are four options:

None - to turn Collaboration support·

off so that no notification icons display
(any other option turns Collaboration
support on for Discussions)
With Alias - for Chat messages, to·

check the Actor elements to locate the
one that has the poster's user ID or
group ID in the 'Alias' field
With Locking User - for Chat·

messages, to check the Actor elements
for the one that has been locked under
the poster's user ID or group ID
With Both - for Chat messages, to·

check firstly for the user ID that locked
the element and, if that is not found, for
the 'Alias' field containing the poster's
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user ID

OK If you have finished updating the diagram
properties, click on this button to save the
changes and close the 'Properties' dialog.

Cancel If you do not want to save the changes
you have made, click on this button to
discard the changes and close the dialog.

Help Click on this button to display this Help
topic.
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Diagram Properties - Features

The features - attributes and operations - of an element have
a number of properties that you can show or hide on a
diagram, or use to show or hide the features themselves.
You control how the features are displayed using the
'Features' tab of the diagram 'Properties' dialog.

Access

Ribbon Design > Diagram > Manage > Properties
> Features

Context
Menu

Right-click diagram in Browser window |
Properties > Features
Right-click background of open diagram |
Properties > Features

Define the display of features on the
diagram

Option Action
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Show
Qualifiers
and Visibility
Indicators

Select this checkbox to show the
qualifiers and visibility indicators of each
feature on the diagram.
Qualifiers include such things as the
'derived' symbol (/) and the public key
symbol (PK).
Visibility indicators include such things
as +, -, # and ~, which indicate the scope
of access of the item (such as an attribute,
operation or role).

Show
Stereotypes

Select this checkbox to show the
stereotypes of all features that have them.
Deselect the checkbox to hide the
stereotypes.

Show
Operation
Return Type

Select this checkbox to display the return
data type of each operation.

Show
Property
String

Select this checkbox to show the
advanced property string for all element
features, for example, {readOnly}.

Suppress
Brackets for
Operations
Without
Parameters

Select this checkbox to suppress brackets
on operations that have no parameters;
that is, Opn; rather than Opn();.
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Always
Show Linked
Features

Select this checkbox to force display of
linked attributes and operations,
regardless of the setting of any other
option that might hide them.

Visible Class
Members

Select the appropriate checkboxes to
show Class members according to their
scope and methods that specify
properties.

Show
Attribute
Detail

Click on the drop-down arrow and select
whether to show both the attribute name
and type, or the attribute name only.

Show
Parameter
Detail

Click on the drop-down arrow and select
how to display method parameters:

None - No details shown·

Type Only - Show the type of·

parameter only
Full Details - Show all details of each·

parameter
Name Only - Show the name of the·

parameter only

Supress
Compartment
Items

These three edit control fields each
suppress the display of the feature names
listed in the field, in the corresponding
feature-type compartment of an element
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depicted on the diagram.
In the 'Attributes' field, list the·

attributes to suppress in the Attributes
compartment of the element
In the 'Operations' field, list the·

operations to suppress in the
Operations compartment of the element
In the 'Tag Names' field, list the tags to·

suppress in the Tagged Values
compartment of the element

You can type the feature names separated
by commas or by carriage returns.

OK If you have finished updating the diagram
properties, click on this button to save the
changes and close the 'Properties' dialog.

Cancel If you do not want to save the changes
you have made, click on this button to
discard the changes and close the dialog.

Help Click on this button to display this Help
topic.
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Diagram Properties - Connectors

It is possible to control a number of aspects of how
connectors are shown on a diagram, using the 'Connectors'
tab of the diagram 'Properties' dialog.

Access

Ribbon Design > Diagram > Manage > Properties
> Connectors

Context
Menu

Right-click diagram in Browser window |
Properties | Connectors
Right-click background of open diagram |
Properties | Connectors

Define Connector Appearance

Option Action

Show
Relationships

Select this checkbox to show connectors
between elements in the current diagram.
Deselect the checkbox to hide all

(c) Sparx Systems 2022 Page 1248 of 1974



Modeling Fundamentals 3 October, 2022

connectors on the diagram.

Freeze
Visible

Click on the checkbox to select it, to
freeze the diagram to show only the
connectors that are visible on this
diagram at this point. Connectors that are
subsequently created on other diagrams
between the same elements are not added
to this diagram until the option is
deselected and the diagram is refreshed.

Show
Collaboration
Numbers

(In Communication diagrams) Select the
checkbox to show the group numbering
on Communication Messages.
Messages are added to Association
connectors in the Communication
diagram.

Show
Non-Navigab
le Ends

Select this checkbox to indicate when
Association ends are not navigable; a
cross is shown on each non-navigable end
of an Association connector.

Show
Connector
Property
String

Select this checkbox to show the property
strings (constraint text) for connectors.

Suppress All Select this checkbox to hide all connector
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Connector
Labels

labels on the diagram.

Show
Stereotype
Labels

Select this checkbox to show a label on
each connector indicating the connectors'
stereotype.
Deselect the checkbox to hide these
stereotype labels.

Connector
Notation

Click on the drop-down arrow and select
the required connector notation:

UML 2.1 - use the standard UML 2.1·

notation for connectors
Information Engineering - use the·

Information Engineering (IE)
connection style
IDEFX1 - use the Integrated Definition·

Methods IDEFX1 connection style
Note that Information Engineering style
does not work on Associations that are
defined with Shape Scripts, so take care
in using it. The option is blocked for use
on ArchiMate diagrams for this reason.

OK If you have finished updating the diagram
properties, click on this button to save the
changes and close the 'Properties' dialog.
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Cancel If you do not want to save the changes
you have made, click on this button to
discard the changes and close the dialog.

Help Click on this button to display this Help
topic.
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Diagram Properties - Theme

A Theme is a definition of the display characteristics for a
diagram, such as the text font used or the background colors
of the elements and diagram. You generally create and/or
select a theme to apply to all diagrams across the model, but
you can apply a different (existing) theme to a selected
diagram, using the 'Theme' page of the diagram's 'Properties'
dialog.

Themes applied to diagrams are model-based rather than
user-based. If the diagram is imported into a model without
an applied theme, the global theme will be used instead.

Access

Ribbon Design > Diagram > Manage > Properties
> Theme

Context
Menu

Right-click diagram in Browser window |
Properties | Theme
Right-click background of open diagram |
Properties | Theme

Select Theme
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Option Description

Theme Click on the drop-down arrow and select
the theme to apply to the current diagram.
The field defaults to the value 'Use global
theme', which applies the theme selected
on the 'Diagram > Themes' page of the
model 'Preferences' dialog.

Font Select the checkbox to apply the 'User
Font Face' and 'Font Size' settings
assigned to the selected theme on the
'Appearance' page of the model
'Preferences' dialog.
Deselect the checkbox to apply the font
from the global theme on the 'Preferences'
dialog.

Color Select the checkbox to apply the element,
connector and diagram colors assigned to
the selected theme on the 'Gradients and
Background' page and the 'Standard
Colors' page of the model 'Preferences'
dialog.
Deselect the checkbox to apply the colors
from the global theme on the 'Preferences'
dialog.
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Line
Thickness

Select the checkbox to apply the default
element border width and connector line
thickness assigned to the selected theme
on the 'Appearance' page and 'Link' page
of the model 'Preferences' dialog.
Deselect the checkbox to apply the line
widths from the global theme on the
'Preferences' dialog.

Gradient Select the checkbox to apply the gradient
of the diagram background color and
element fill color, as assigned to the
selected theme on the 'Gradients and
Background' page of the model
'Preferences' dialog.
Deselect the checkbox to apply the
gradients from the global theme on the
'Preferences' dialog.

Background
Image

Select the checkbox to apply the diagram
background image assigned to the
selected theme on the model 'Preferences'
dialog.
Deselect the checkbox to apply the image
from the global theme on the 'Preferences'
dialog.

Element
Shadows

Select the checkbox to apply the element
shadow setting ('on' or 'off') and color
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assigned to the selected theme on the
model 'Preferences' dialog.
Deselect the checkbox to apply the
shadow setting and color from the global
theme on the 'Preferences' dialog.

OK Click on this button to apply the theme
aspects you have defined on this tab, and
to close the 'Properties' dialog.

Cancel Click on this button to abort the changes
you have made and close the 'Properties'
dialog.

Help Click on this button to display this Help
topic.
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The Quick Linker

If you want to create new elements and connectors quickly
on a diagram, you can use the Quick Linker on an initial
element to guide you in creating related elements and
connectors of the appropriate types, without having to weigh
up the full range of options from the Diagram Toolbox.

The Quick Linker consists of paired menus that list the
commonest objects appropriate to the context of the selected
element. You simply choose the type of element you need
from the first menu, and that displays the second menu
offering a choice of appropriate types of connector between
the original and new elements. When you select the
connector, you create a new element connected to your
initial element, complete with any subordinate objects such
as Object Nodes and Action Pins.

If you drag the Quick Linker arrow onto an existing element
on the diagram, only the connector menu displays, so that
you select the type of connector to create between the two
existing elements.

Display the Quick Linker Menus

There are two methods of accessing the Quick Linker
menus.

Action Detail
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Click on
Quick Linker
Arrow

When you click on an element in a
diagram, the Quick Linker arrow is
displayed at the upper right corner of the
element:

Click on this arrow and drag it in the
direction in which you want to create the
new connector and element. When you
release the mouse button, the element
menu displays. When you select an
element type, the connector menu
displays.
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When you select the connector type, the
element and connector are added to the
diagram in the location in which you
displayed the menus.

Press
Ctrl+Shift+A
rrow key

After selecting the element, press
Ctrl+Shift and the keyboard arrow key
for the direction in which you want to
create the new connector and element
(Right, Left, Up or Down).
The element and connector menus
display. When you select the type of
connector, the new element and
connector are created off the edge of the
element appropriate to the arrow key you
pressed. For example, if you press the
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Right Arrow key, the new element is
created to the right of the original
element.

Notes

On the initial (element) menu, the 'Create Multiple·

Elements' option displays the 'Create Multiple Elements'
dialog, on which you specify a number of elements to
create; the default entry is the base element and connector
for the diagram type, but you can click on the drop-down
arrow in each field and select other types of element and
connector appropriate to the diagram type

Also, the 'Filter to Toolbox' option, which defaults to·

selected, filters the list of elements and connectors to only
those also available through the Toolbox page for the
current diagram type; deselecting the option allows the
full range of types of relationship and target element for
the type of source element to be listed

The 'Filter to Toolbox' option is not displayed if you are·

working on a diagram with an applied metamodel or view,
such as an ArchiMate 3 Business Layer Application
Usage diagram; such diagrams have a fixed
element/connection set that cannot be altered

When using the Ctrl+Shift+<arrow key> method on a·

Sequence diagram, you cannot use the Up or Down keys;
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the Right and Left keys create a connector to a Lifeline
element

When using the Ctrl+Shift+<arrow key> method on a·

Timing diagram, you cannot use the Right or Left keys

If the connectors and elements suggested by the Quick·

Linker do not include the types you need, you can also
create them from the Diagram Toolbox pages

A Technology Developer can create new or different lists·

and combinations of elements and connectors
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Create Connectors

The connector list does not actually display until you release
the mouse button over the target element; however, a dotted
line shows where the connector would be at any point, and a
hatched outline displays within the border of an element as
you move the cursor onto it - this helps you identify where
the connector should connector to, if there are many
closely-arranged elements, Parts, Ports or other extensions.

The list contains the most appropriate, commonly-used
types of connector for the source and target element types. If
you want to use a different type of connector, select the
appropriate Toolbox page, click on the required connector
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and then on the source element, and drag across to the target
element.

Notes

You can quickly create a Notelink to attach a Note or·

Constraint to a connector, simply by dragging the Quick
Linker arrow on the Note element onto the connector
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Create New Elements

The connectors and elements listed on the two menus
depend on the type of the element you initially selected; for
example, if you click on the Quick Linker arrow for a Class,
the options are not the same as if you clicked on the arrow
for an Actor. However, in either case the menus show the
most appropriate, commonly used connectors and target
elements for that initial element; you can create other
connectors and target elements by selecting them from the
appropriate Toolbox page.

Certain types of element - such as Action and Artifact - are
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available in a range of subtypes. You can select which
subtype to create by holding down the Ctrl key as you select
the main element type. For an:

Action element, the 'New Action' dialog displays from·

which you select the Action subtype, such as
CallOperation or SendObject

Artifact element, a submenu displays from which you·

select the Artifact subtype, such as Report Specification
or Checklist

Notes

You can create a connector to an existing classifier from·

the Browser window, by pressing Shift while clicking on
the type of connector; the 'Select existing element' dialog
displays on which you browse for and select the element,
then the connector and element are added to the diagram
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The Context Buttons

When you select an element on a diagram, or add a new
element, a number of small icons display off the right hand
side of the element underneath the Quick Linker arrow ( );
for example:

These icons display context menus and/or toolbars of
diagramming options or perform specific actions, to help
you quickly edit the element you have highlighted. If you do
not want to show or use these icons, you can prevent their
display by deselecting the 'Show buttons for selected Object
on diagram' checkbox on the 'Objects' page of the
'Preferences' dialog.

Also, if an element shown in the diagram is locked, and the
'Display Element Lock Status' option is selected in the
'Properties' dialog for the diagram, a locking indicator is
displayed outside the top left hand corner of the element.
The indicator is the same as the exclamation mark (!)
against a locked element in the Browser window:

Red if the element is under a full lock or locked by·

another user

Blue if the element is under a lock set by yourself or by a·

user in the same User Group as yourself

You might also see, on the left hand side of the element,
another floating icon ( ). This displays when:
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In the 'Diagram' tab of the Properties window for the·

diagram, in the 'Connectors' section, the 'Show Feature
Linker' checkbox is selected, and

The element name or an operation, attribute or reception·

within the element is selected and highlighted

The icon helps you to create a relationship between the
selected feature in one element and another element or a
feature within it. See the Feature Quick Linker Help topic.

Icon Use

Icon Action

Click on this icon to display a context
menu of options for operating on the
selected element or elements. The
common set of options are as shown:

You can use these options to:
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Set a lock on the selected element·

Display details of the element's·

properties and characteristics on the
'Details' tab of the Inspector window
Open the Design, Collaborate and·

Execute Window Selectors, to select
windows and dialogs to edit the
element's properties and features
Open the Discuss & Review window at·

the 'Journal', 'Discuss' or 'Review' tabs,
or the 'Model Message' dialog; if
appropriate, an option is also provided
to access the 'Chat' tab of the Chat &
Mail window
Locate the element in the 'Project' tab·

of the Browser window, or in any other
diagrams in which it is used
Display the Help topic describing the·

element type

Click on this icon to display a toolbar and
context menu of options for operating on
the element appearance, to change the
appearance of the element. If you select
the icon for a single element , the toolbar
and options appear as shown:

(c) Sparx Systems 2022 Page 1267 of 1974



Modeling Fundamentals 3 October, 2022

The toolbar icons, in order of display,
enable you to set the element's text font,
text color, fill color, border color, and
border line width, or to set the element
fill color to a previously-sampled color,
or to sample (copy and store) the current
element fill color.
The context menu options enable you to:

Define the border, font and background·

colors and the border thickness for the
selected element, as its default
appearance wherever it is used
Reapply the appearance of the element·

as specifically defined for that element
on this diagram
Reapply the defined default appearance·

of the element
Change the element's appearance to·

either a new default image or an
alternative image, using the Image
Manager; this appearance applies to the
element on all diagrams in which it is
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used
Display the 'Select Element' browser,·

and locate an Image Asset element
containing the required image to use
for the selected element
Define which features and·

characteristics of the selected element
are shown in compartments of the
element on the diagram, using the
'Compartment Visibility' dialog
For elements that do not have the·

default rectangle/compartment
rendition, such as Use Cases and
Actors, toggle display of the element
between their default shape and
rectangular notation

If you select this icon on an element
within a group of selected elements,
further options are listed, as shown:

The additional options on the toolbar
enable you to:

Align the left, right, bottom or top·
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borders of the elements in the group
with the appropriate edge of the
selected element
Bring the selected elements further·

forward or further back in the diagram
relative to the unselected elements
Make all elements in the group the·

same height as the selected element,
the same width, or both

An additional context menu option -
'Layout Selected' - enables you to apply
one of the ten diagram layout styles
(other than Fan Relations), or to apply a
style with finer control through the
Layout Tools window.

If an element has a linked diagram, such
as child composite diagram, click on this
icon off the right hand side of the element
- an image of the linked diagram is shown
in a floating Diagram pop-up window;
click off the diagram or press the
Backslash key to close the window again
or double-click in the Diagram pop-up
window to open the diagram in the main
view area.

(Displays if the diagram has the 'Custom
Styles' option selected.) Click on this icon
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to display a toolbar for applying custom
diagram style options to the selected
element or elements. The toolbar enables
you to set the element:

Shape·

Fill opacity·

Name and Notes text position and·

orientation
Icon size, position and padding·

Border line style·

Outline stacking direction and the·

number of outlines in the stack

Click on this icon to rotate a Fork/Join
element from vertical to horizontal or
vice-versa.

On a Package element, displays two
further icons to generate:

A document file using the 'Generate·

Documentation' dialog, or a
Web page document using the 'Publish·

as HTML' dialog

(Or ) Click on this icon to toggle an
Activity Partition between vertical and
horizontal.
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Indicates that the Interaction Fragment
currently contains messages; in this state
you can:

Move the fragment vertically, but not·

horizontally; all elements and messages
below the fragment move up or down
by the same amount
Resize the fragment to larger than the·

contained messages/elements, but not
smaller

This is the default condition when you
open or reload a diagram containing a
fragment. You can click on the icon to
toggle to 'move freely' mode.

Indicates that the Interaction Fragment
can be moved independently of the
Messages or other elements contained
within the fragment.
This is the default condition when you
first create the fragment. You can click
on the icon to toggle to 'contains
messages' mode (earlier).

(c) Sparx Systems 2022 Page 1272 of 1974



Modeling Fundamentals 3 October, 2022

The Context Menu

You can perform a wide range of tasks and operations on a
diagram and its contents. To access and initiate these
operations, you select options from the diagram's context
menu.

Access

Context
Menu

Right-click on the diagram background

Options

Option Action

Specialize Provides two sets of functions:
Scripts - scripts created using the·

Scripting facility, to be executed on
diagrams; click on a script name to
execute it (this option is not shown if
no appropriate scripts have been
created)
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Extensions - a list of the enabled·

technologies on the system, each of
which provides options for performing
technology-specific operations on the
diagram

Collaborate Select this option to display a short menu
of options to exchange electronic notes
on the selected diagram with team
colleagues, in the form of Reviews,
Discussions and, if User Security is
enabled, Chats and Model Mail
messages.
Options for setting automatic refresh
intervals can also be found here.

Switch View Provides options to display the diagram
contents in a number of alternative
formats:

Graphical View - the standard·

graphical display format
List View - a tabular, editable list of·

elements
Gantt View - shows the Project·

Resources assigned to each element
Specification View - each element is·

represented by a text description in the
Specification Manager
Relation Matrix View - a table showing·
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the relationships between the diagram
elements
Construct View - displays the resources·

and progress of work on the diagram
elements
Inline Specification view - when in the·

graphical display format, select
between displaying and hiding a
Specification view of the diagram
elements in the right half of the
diagram

Show All
Bookmark
Values / Hide
All
Bookmark
Values

It is possible to assign bookmarks with
numerical or text values to elements on a
diagram. Each bookmark is displayed as
a red circle containing the bookmark
value, just above the parent element.
These two menu options reveal or hide all
the assigned bookmarks on the diagram.

Properties Displays the diagram 'Properties' dialog,
through which you can define properties
including name, author and version
information, zoom factor, paper size and
layout, diagram notes and various
appearance attributes. Some properties
influence the display of the diagram and
some are logical attributes that appear in
the documentation.
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Validate
Diagram

(In a Business Process diagram)
Validates the diagram, and the elements
and connectors within the diagram, for
correctness.
The results of the validation are displayed
in a tab of the System Output window.

Insert Displays a short menu of options for
adding objects to the diagram:

Other Element - displays the Select·

Element browser, through which you
locate and select an existing element to
add to the diagram as a linked element
Store Document(s) in Model - displays·

the default file browser, through which
you locate a file to store as a File
Artifact element in the model and in
the diagram; double-click on the
Artifact to show the file contents
Link to Document(s) in File System -·

again displays the default file browser,
but when you select a file the system
creates a hyperlink to that file
Show Toolbox - Select this option to·

display the Diagram Toolbox at the
appropriate pages for the type of
diagram, if the Toolbox is not already
displayed
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Paste Displays a short menu of options for
pasting copied elements or images into
the diagram.

Element(s) as Link - paste copied·

elements into the diagram as links to
the original element(s)
Element(s) as New - paste copied·

elements into the diagram as new
elements
Image from Clipboard - paste an image·

held on the clipboard into the diagram
(shortcut: Ctrl+Shift+Insert)
Image Asset - paste an image held on·

the clipboard into the diagram as a new
Image Asset Artifact

Hide
Diagram
Frame /
Show
Diagram
Frame

This option applies to these diagram
types when the diagram is a composite
diagram:

Any SysML type·

UML StateMachine·

The elements on the diagram are
automatically enclosed in a Diagram
Frame representing the element that owns
the diagram. Click on the options to hide
and redisplay this Diagram Frame.
On a SysML diagram, the frame will:
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Auto-resize to fit the bounds of the·

diagram if the frame is non-selectable,
expanding from its default size but not
shrinking smaller

Note that diagrams showing Diagram
Frames applied using release 14.0 or later
of Enterprise Architect will draw the
parent object on the diagram when
opened using a release of Enterprise
Architect earlier than release 14.0.

Interaction
Parameters

(On an Interaction diagram.) Displays the
'Interaction Occurrence' dialog, on which
you define the arguments, return value
and attribute to create an Interaction
Occurrence.

Supress
Activations

(On a Sequence diagram.) Hides or
redisplays the activation rectangles on the
Lifeline elements of the diagram.

Set Top
Margin

(On a Sequence diagram.) Displays the
'Top Margin' dialog, through which you
change the space above the Lifeline
elements on the diagram to between 30
and 250 units.

Sequence
Communicati

(On a Communication diagram.) Displays
the 'Communication Messages' dialog,
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on Messages through which you can change the order
of the communication messages in the
current diagram.

Synchronize
Structural
Elements

Applies to a SysML Internal Block
diagram or a SysML Parametric diagram,
where it shows all structural elements
(such as Ports and Parts) relating to the
Block that owns this diagram.
This command will also generate
Properties defined by existing
Association connectors.

Swimlanes
and Matrix

Displays the 'Swimlanes and Matrix'
dialog for diagrams, through which you
can add or modify Swimlanes or a
Swimlanes Matrix on the diagram.

Roadmap Displays the 'Roadmap options' dialog,
which you use to define a Roadmap
Timeline on the diagram.

Kanban Displays the 'Kanban' dialog, through
which you can define the structure,
content and appearance of a new or
existing Kanban diagram, or to convert a
different type of diagram to a Kanban
diagram.
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Clear all
Checklists

Clears all selected checkboxes within
every Checklist Artifact element in the
current diagram.

Set diagram
flow
direction

(On a Business Process diagram)
Displays a short menu of options to set
the flow orientation of the diagram. Click
on:

None (the default, no specific·

orientation set)
Horizontal (diagram flows across the·

page, Pool and Lane elements occupy
the full width of the diagram), or
Vertical (diagram flows down the page,·

Pool and Lane elements occupy the full
height of the diagram)

Statechart
Editor

(For a StateMachine diagram.) Displays a
short list of options to switch the current
format of the diagram to:

Diagram·

Table (State-Next State)·

Table (State-Trigger) or·

Table (Trigger-State)·

Lock
Diagram

Select this option to lock the diagram to
protect it from inadvertent changes.
This does not apply in the Corporate,
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Unified and Ultimate Editions if security
is enabled, in which case you lock the
model elements.

Find in
Project
Browser

Locates and highlights the current
diagram in the Browser window.
Shortcut: Shift+Alt+G

Execute
Simulation

(On a behavioral diagram.) Displays a
short menu of options for performing a
model simulation:

Interpreted simulation - perform·

dynamic execution of a simulation
(Corporate and extended Editions)
Manual simulation - step through a·

simulation manually (the only option
available in the Professional Edition)
Using Script - if simulation scripts exist·

for the diagram, list the scripts
available; if no scripts exist, the option
does not display

Save Current
Changes

Saves any changes to the current
diagram.
Shortcut: Ctrl+S

Help Displays the Help topic on this type of
diagram.
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Notes

Not all the menu options described appear on the context·

menu of every diagram
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Diagram Layers

Diagram Layers provide a way of creating and viewing
segments of a diagram to represent any concept that is the
basis for separating or grouping the elements on that
diagram. The layers can be compared to transparencies laid
on top of one another in a stack, as in paper-based
encyclopedias where, for example, a base image of a human
skeleton would have a transparent sheet showing the arteries
laid on top, then one for veins and another for nerves. The
analogous process with Enterprise Architect's Diagram
Layers is to reveal parts of any diagram, including Business
Process Models, Architecture diagrams, Kanban diagrams or
Roadmap diagrams. The tool has the added flexibility of
being able to selectively apply any subset of the layers,
which can't, of course, be done with the encyclopedia
transparencies. The tool also has the ability to bring a
selected layer to the foreground while showing the other
layers with reduced opacity. Diagram Layers will be a
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welcomed tool for people who need to present complex
models to an audience, creating an easy-to-understand
narrative built up in stages rather than confusing the
audience with the complete diagram from the start.

Diagram Layers - like the related Diagram Filters - can be
used to hide or expose parts of any diagram. Filters are
applied using element metadata such as status or
complexity, whereas Layers are applied using any ad hoc
criterion for the separation of the elements; for example,
items to be focused on in a workshop or elements of a
particular architectural style. Layers can be used to separate
elements in architecture diagrams to show strategic, tactical
or implementation intent, or to show particular sequences of
activations in a Sequence diagram, or to show a
time-ordered sequence in a Business Process model, and
much more.

An important difference between Filters and Layers is that
Filters are defined at a meta-level and so can be applied to
any diagram in the repository. So, for example, a Filter that
hides all elements except critical requirements can work on
a business level diagram in Project A and a technical level
diagram in Project B. Layers, on the other hand, are
intentionally defined on and for a specific diagram and
cannot be applied to other diagrams. Advanced modelers
might want to use Layers and Filters together to create
visualizations of the underlying diagrams, remembering that
the definitions of Filters apply at the level of the repository
but their usage and application with Layers apply to a user's
view of a diagram. Diagram legends can also be used in
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conjunction with both Layers and Filters to assist in
improving the narrative of the diagram.

Access

Ribbon Layout > Tools > Filters & Layers >
Layers   or
Explore > Portals > Windows > Diagram
> Diagram Filters > Layers

Keyboard
Shortcuts

A+1 > Diagram Layers > Layers

Options

The icons in this table are described in order of use, not in
order of display in the toolbar.

Option Action
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Create New
Layer

Simply click on this icon to display a
selected checkbox and the text 'Layer n'.

Overtype the text with whatever name
you want to apply to this layer of
elements.
The checkbox is selected so that the
elements in the layer are shown on the
diagram. If you clear the checkbox the
layer is not active and the elements
within it are not shown.
You now select elements to add to the
new layer.

Add elements
to layer

On the diagram, select the element or
elements to show or hide using a layer.
Then click on the name of the layer, and
on this icon. The icon is enabled when
the elements and layer are selected.
If you now clear the layer checkbox, the
elements assigned to it are hidden on the
diagram. If you select the checkbox,
those elements are shown again.

Filter by
layer

With a layer checkbox selected, click on
this icon to fade all elements NOT in the
layer, leaving the selected layer displayed
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in clear. Click on the icon again to restore
all elements to full display.

Remove
selected
elements
from layer

In the diagram, select the elements that
you no longer want to include in the
layer. Then click on the layer name and
click on this icon.
When you clear the checkbox against the
layer name the selected elements are no
longer hidden on the diagram, and when
you select the layer and click on the Filter
icon, those elements are faded.

Clear all
elements
from layer

Simply click on the layer name and click
on this icon. All elements assigned to the
layer are cleared from it. If the layer has
no assigned elements, the icon is not
enabled.

Delete layer Click on the layer name and on this icon
to remove the layer from the window.
Any assigned elements display as normal.

Layer Select this check box to set the filter state
for all filters in the list.

Help Display this Help topic.
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Notes

Layers operate on elements; connectors between elements·

are hidden or filtered in if the target and/or source element
is assigned to the selected layer

If a diagram layer is selected, it will remain selected as·

you click out of and into the diagram

If a layer is hidden, the elements in it cannot be selected·
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Diagram Filters

Using Diagram Filters (Dynamic Visual filters), you can
modify the display of diagram components so that the
required items are immediately identified, without damaging
the structure and integrity of the model. The filters operate
on elements, connectors or Tagged Values according to
properties such as Author, Status, Date Created or
Stereotype Value and, for connectors, whether the connector
is hidden or visible. Filters are stored against the model, so a
filter you create is available to other users of the model;
however, use of a filter is specific to the user, so your use of
a filter does not affect another user's view of the diagram.

Access

When you first display the Filters & Layers window at the
'Filters' tab, the filter groups are collapsed.  Click on the
white arrow head to show the defined filters.
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Ribbon Layout > Tools > Filters and Layers >
Filters  or
Explore > Portals > Windows > Diagram
> Diagram Filters > Filters

Keyboard
Shortcuts

A+1 > Diagram Filters > Filters

Applying Diagram Filters

You can use Diagram Filters singly, in sequence, or in
combination to tailor the display of diagrams to show:

Information for different users, so that - for example -·
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technical staff and stakeholders each can apply filters that
highlight the information pertinent to them

What elements have been recently developed or changed·

Which part of a model was developed by a particular·

person

Which parts of a diagram are at a particular phase, status·

or version

Examples of ways in which you might apply filtering
include:

Setting up a filter for immediate use on a diagram, and·

modifying that filter as you review the diagram so that
you highlight elements with different values for the same
properties - perhaps, by filtering on Phase, to compare
'As-Is' and 'To-Be' elements

Setting up a filter and leaving it active so that all diagrams·

you display are automatically filtered the same way

Setting up a series of filters to use:·

     -  in one or more sequences to progressively highlight
a diminishing set of items, or
     -  alternately, to highlight contrasting views of the
diagram

Grouping filters so that their combined results identify·

objects that meet the characteristics of each filter and
indicate an 'overview' status as well; for example, 'Work
In Progress' plus 'Work Not Started' show objects in each
category at the same time, under the group filter 'Work
Not Completed'

Filters for elements can also be applied to the Package
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Browser and Diagram List.

The 'Diagram Filters' context menu (right-click on the body
of the window) provides an option for toggling between the
filters and simple context filtering of diagrams; if you select
the 'Context Filtering' option, the Diagram Filters are
disabled and the contents of the diagram are grayed-out,
except for a selected element and those elements directly
related to it.

Facilities

Facility Detail

Developing
Filters

You create and define as many filters as
you require, setting up each filter by
defining which element, connector or
Tagged Value properties to specifically
check for and (depending on how you set
up the filter parameters) whether to
include or exclude elements or
connectors having particular property
values.
You cannot combine element, connector
and/or Tagged Value properties in one
filter, but you can apply any combination
of element filter, connector filter and/or
Tagged Value filter to a diagram at the
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same time, individually or as a grouped
filter.
You can select to:

Mute the excluded items in Gray Scale,·

or Fade the display color
Hide the excluded items completely, or·

Select and highlight (with a hashed·

line) the included items

Filter Effect -
Gray Scale,
Fade or Hide

If you select 'Gray Scale', 'Fade' or 'Hide',
the action of the filters is to exclude items
that do not match the parameters rather
than include items that do.
If, for example, you selected to filter on
element name, looking for elements with
the word 'Class' in the name, the filter
would apply this logic:
     Does 'Name' contain string 'Class'? If
'No', apply effect; if 'Yes', take no action.
The elements you want are therefore what
is left on the diagram, rather than what
was operated on.
The filter effect remains in force while
you do other work on the diagram, until
such time as you disable the filter.

Filter Effect -
Highlight

If you click on 'Select', the logic is
reversed:
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     Does 'Name' contain string 'Class'? If
'No', take no action. If 'Yes', apply effect.
In this case, the filter effect is not
permanent, and clicking off the items
deselects them.
This effect is excellent for selecting items
having the same characteristics across a
large diagram, to be processed in a single
task; instead of having to locate the items
and select them with Shift+click
individually, you can apply the filter.
If you inadvertently lose the selection by
clicking off the items, you can get it back
again almost immediately by re-applying
the filter.
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Work With Diagram Filters

You can modify the display of objects on a diagram using
Diagram Filters, which you create and use through the
Filters & Layers window. This window is dockable, so you
can move it around or 'fix' it next to the Diagram View
while you activate, deactivate and edit the filters.

Access

Ribbon Layout > Tools > Filters and Layers >
Filters   or
Explore > Portals > Windows > Diagram
> Diagram Filters > Filters

Keyboard
Shortcuts

A+1 > Diagram Filters > Filters

Create a single filter to be applied to your
diagrams

Ste
p

Action

(c) Sparx Systems 2022 Page 1295 of 1974



Modeling Fundamentals 3 October, 2022

1 Perform one of these actions:
On the Diagram Filter toolbar, click on the 'New·

Filter' icon - the first on the left
Right-click on the list panel and select the 'New·

Filter' option
The 'Create New Diagram Filter' dialog displays.

2 In the 'Enter Filter Name' field, type a name for the
filter, then click on the OK button.
The 'Diagram Filter' dialog displays.

3 In the 'Active Filter Set' field, either:
Use the default value of 'Element' or·

Click on the drop-down arrow and select·
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'Connector' or 'TagValue'
The body of the dialog displays a list of properties of
elements, connectors or Tagged Values.

4 Scroll through the properties to filter on, and select
the checkbox against each property you require.

5 For each property, click on the 'Condition' field and
select, from the drop-down list, the comparison
condition to be applied.
Consider how the combination of 'Condition - Equal
To / Not Equal To' and 'Filter Effect' might affect the
results on the diagram.

6 For each property, double-click on the 'Value' field
and type or select any specific value to filter on.

7 Click on the OK button to save the filter and return
to the Filters & Layers window.
Unless you have specifically created the filter in a
Filter Group, the filter is listed underneath the
default Model group at the top of the window.

Create a Filter Group
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Ste
p

Action

1 In the Filters & Layers window toolbar, click on the
drop-down arrow next to the Filter icon and select
the 'New Filter Grouping' option.
The 'Create New Diagram Filter Grouping' dialog
displays.

2 In the 'Enter Filter Name' field, type the name of the
filter group, and click on the OK button.
The filter group is added to the end of the list in the
Filters & Layers window, and the 'Create New
Diagram Filter' dialog displays for you to add a new
filter to the filter group.

3 Define the new filter in the group as described in the
Create a single filter to be applied to your diagrams
table. You can apply that procedure to define the
other filters for the group, clicking on the group
name and then on the 'New Filter' option to start.
Alternatively, you can copy or cut an existing filter
from the Model list or from another filter group, and
paste that filter into the new group. Right-click on
the source filter and select the 'Cut' or 'Copy' option,
then right-click on the target group and select the
'Paste' option.
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Other Operations

Operation Detail

Edit a Filter To edit an existing filter on the Filters &
Layers window, either:

Double-click on the filter name·

Click on the filter name and select the·

'Properties' icon from the toolbar (the
second icon from the left), or
Right-click on the name and select the·

'Properties' option
The 'Diagram Filter' dialog displays;
adjust the filtered fields as described in
the Create a single filter to be applied to
your diagrams table.

Change the
name of the
Filter or
Filter Group

Right-click on the name and select the
'Change Name' option.
The appropriate 'Create New Diagram
Filter ...' dialog displays.
Type over the existing name with the new
name, and click on the OK button.

Define how
filters in a

When you define two or more filters in a
filter group, they default to operating in
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group
combine

combination, with an AND relationship.
That is, an object must satisfy the criteria
of all the selected filters in the group
before being operated on.
You can change this to an OR
relationship, where the object must
satisfy the criteria of any of the filters
before being operated on. To set the
relationship of the group filters to OR (or
change it back from OR to AND):

Right-click on the filter group name1.
and select the 'Properties' option. The
'Set logical operator for Filter
Grouping' dialog displays.
In the 'Operator' field, click on the2.
drop-down arrow and select the
required value - OR or AND.
Click on the OK button.3.

Set Effect of
Filters

The filter effect applies to all filters in the
Filters & Layers window. To set how
your filters identify selected items on
your diagrams, click on the drop-down
arrow of the toolbar 'Filter Effect' field,
and select one of these options:

Fade - display all items that do not·

match the filter criteria in a pale
version of the diagram background
color
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Gray Scale - display all items that do·

not match the filter criteria in pale gray
Hide - conceal all items that do not·

match the filter criteria
Select - select and highlight (with a·

hashed line) all those items that do
match the filter criteria

If the filter is for elements in the Package
Browser or Diagram List, note that the
'Select' filter effect cannot show up in this
context.

Enable
Filters

To enable a filter so that it takes
immediate effect on your diagrams, select
the checkbox against the filter name.
You can select more than one filter at a
time, to combine their effects.
For a Filter Group, if you select the group
checkbox all filters in the group are
selected. You can then, if necessary,
disable individual filters in the group.

Disable/Clear
Filters

To disable a filter and clear the effect of
the filter on the diagram so that it
displays in full, clear the checkbox.
To disable all filters, either:

Click on the 'Reload Filters' icon in the·

toolbar (third option from the left), or
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Right-click on the list panel and select·

the 'Reload Filters' option

Copy or
Move a Filter
between
Filter Groups

To add an existing filter to another Filter
Group, right-click on the filter and select
the 'Copy' or 'Move' option as
appropriate. Then right-click on the target
Filter Group and select the 'Paste' option.
If you are moving a filter, it is not
removed from the source group until it
has been pasted to the target group.
You cannot move a Filter Group or add
one group to another.

Toggle
between
Diagram
Filters and
Context
Filtering

To disable the filters you have defined
and simply highlight a selected element
and its immediate relatives, right-click on
the Filters & Layers window background
itself and select the 'Context Filtering'
option.
To re-enable the Diagram Filter effects,
display the Filters & Layers window
again and deselect the 'Context Filtering'
option.

Delete a
Filter

To remove a filter or filter group from the
Filters & Layers window, either:

Click on the filter name and click on·

the Delete icon in the toolbar, or
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Right-click on the filter name and·

select the 'Delete Filter' option
A prompt displays to confirm the
deletion.
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Context Filter a Diagram

As you review a modeling diagram, it is possible to click on
any element on the diagram and show only those elements
that are directly related to the selected element. All other
elements are grayed out until you click on the diagram
background.

Access

Ribbon Layout > Filter : Choose 'Relationships'
from the drop-down list
Layout > Tools > Filters and Layers :
Right-click dialog background > Context
Filtering
Explore > Portals > Windows > Diagram
> Filters and Layers : Right-click dialog
background > Context Filtering

Notes

When you set the option and click on an element, any·

elements on the diagram that are not directly related to the
selected element are grayed out
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Setting the context filter applies to all diagrams that are·

open; you can select an element on each opened (floating)
diagram and examine their relationships together

To clear the filtering (but not turn Context Filtering off)·

press the Esc key

To select the next element in a direct chain or group of·

relationships on a diagram, press the Tab key; the Tab key
does not take you out of the element group

To select the next element on the diagram, and display·

that element's related elements, use the arrow keys to
move up, down, left or right to the next element in that
direction; when moving left or right, the selection tends to
be upwards rather than downwards

When you enable the option on the Filters & Layers·

window, it overrides the Diagram Filters settings; to use
the Diagram Filters again, toggle the 'Context Filtering'
option off

Context filtering can be made even more useful by·

highlighting the incoming and outgoing relationships in
different colors, by pressing and holding the L key on the
selected element
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Diagram Legends

A Diagram Legend is an element that you can add to your
diagram to provide information about the colors and/or line
thicknesses and styles that have been used in the current
diagram, where those colors and other styles have some
particular meaning. For example, it is common to have a
Legend that indicates a particular color represents a
particular element status or version. Connectors might be
colored according to whether they are of a particular type or
direction. Element borders might be thicker or thinner
according to some other property or condition.

Legends have additional capabilities, including the ability to
auto color elements in different ways and according to
different rules and filters. Legends are classified as elements
and will be listed in the Browser window; however, they are
not shown in contents of a Package displayed on a diagram.
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The Help  topics Create Legends, Legend Properties and
Legend Key detail the mechanics of setting up your Legend,
but first a quick overview.

Simple Legend

Simple Legends provide a manually configured key set that
references the various styles used in the diagram. For
example, an element might be manually set to fill with the
color red, and the Legend can be configured to indicate that
red means 'Overdue'. This is a very useful way of providing
information about the conventions and styles used and the
meanings that they represent. You can create and add as
many Simple Legends as you need to your diagram.

Auto Legend

An Auto Legend is one that has the 'Auto Color' checkbox
ticked. This puts the Legend into a more 'active' mode, and
will automatically adjust the diagram to apply a color or
characteristic according to the object's defined  feature or
status.

For example, it is possible to set up a Legend that will set all
Requirement elements that have a Status of 'Validated' on a
diagram to a specific fill color. The color will be applied
automatically to the filtered element set with no manual
intervention. This is a very useful mechanism for providing
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a dynamic view of a diagram and exposing inner attributes,
properties or statuses in real-time. This technique can be
applied to element fill, element border color, element line
thickness, connector line thickness and connector color.

It is important to remember that when the auto-color
property is set, the change in element appearance is only
dynamically applied on the Legend's diagram, and is not a
permanent change. If you de-activate the Legend, all
elements affected will return to their base appearance.

Stacked (Multiple) Legend

What is even more helpful is the ability to 'Stack' multiple
auto-color Legends on a diagram and let Enterprise
Architect dynamically color according to the union of all the
different Legend conditions. For example, this approach lets
you dynamically color or affect the appearance of
Requirements according to Status, Components according to
Phase, Use Cases according to Version, and so on. By
stacking multiple Legends you have the ability to create a
very rich and detailed diagram that conveys a huge amount
of information in its dynamically applied styles.

Getting Started with Legends

These topics provide the necessary information for creating
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and configuring Legends on diagrams. Keep in mind that
you can use Legends at any level, from the Simple type to
the more dynamic Auto-Coloring and Stacked styles.
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Create Legends

A Legend element on a diagram provides a visual key to the
colors and line thicknesses you have used to identify
elements and/or connectors that have particular meaning.
The Legend can reflect a simple, manually-applied
convention such as all elements concerned with a
management system being shaded in blue, or all outgoing
connectors colored red. However, the Auto-Color Legends
can also automatically apply the style to elements or
connectors having a chosen property, such as a specific
phase, stereotype or type.

The Legend lists the element appearance conventions first,
and the connector appearance conventions underneath.

You work on a Legend element in two stages: first create
and define the Legend element itself, then define the
appearance styles as displayed on the diagram.

Access
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Toolbox Drag the Diagram Legend icon ( ) from
the 'Common' page of the Toolbox onto
the diagram

Toolbar Click the 'New Diagram Legend' icon
( ) on the UML Elements toolbar

Multiple Legends

In many cases a single Legend will be sufficient to define
the styles and their meanings within the current diagram. In
some situations though, it is much more interesting and
effective to use multiple Legends, especially if the Legends
are Auto-Coloring. Situations where multiple Legends are
useful include:

If you want to use more than one automatically-applied·

style (Stacked Legends)

If you have used several manually-applied styles, and you·

want to identify them in small groups

Where the diagram is large, and you want to reproduce·

the same key where it can be referred to in different
sections of the diagram

Because a single Legend is limited to a single filter per
element type (or all types), such as a range of Status values
for Requirements, multiple Legends are a good way of
addressing different filters on different element types. A
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second Legend, for example, might indicate that all
Components are colored according to a Version or Phase
number.

You can have conditions that operate on different properties,
by defining those conditions in separate Legend elements.
However, check that the conventions in the two Legends
operate on different display characteristics; for example, one
Legend setting Class fill color whilst the other sets Class
border width. They cannot both act on the same property,
such as Class fill color. If they do, the most recently-created
Legend (or the one with the highest Z-order) over-rides the
previous Legend.
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Legend Properties

The 'Legend Properties' dialog defines the appearance of the
Legend element itself, such as its background color, title
text color and size, and border color. If you choose to use
default colors, these are derived from the 'Preferences'
dialog, 'Standard Colors' page.

Access

The 'Style Options' dialog for a Legend element can be
displayed using any of the methods outlined here.

Ribbon Design > Element > Editors > Properties
Dialog : Style Options
Design > Element > Editors > Properties
> Legend : Style Options

Other Double-click Legend element: Style
Options

Define properties of a Legend

Option Action

(c) Sparx Systems 2022 Page 1313 of 1974



Modeling Fundamentals 3 October, 2022

Heading Size Either:
Overtype the font size of the Legend·

Title text with a different value, or
Click on the 'spinner' arrows to·

increase or decrease the font size

Font Color Click on the drop-down arrow and select
one of the standard font colors for the
Legend Title text.
If you want to use a non-standard color,
click on the More Colors button and
either select from the larger pallet or
define a custom color.

Background Click on the down arrow and select one
of the standard colors as the background
fill color of the Legend element.
If you want to use a non-standard color,
click on the More Colors button and
either select from the larger pallet or
define a custom color.

Border Color Click on the down arrow and select one
of the standard colors as the color of the
border lines of the Legend element.
If you want to use a non-standard color,
click on the More Colors button and
either select from the larger pallet or
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define a custom color.

OK button Click on this button to save your changes
and close the dialog.

Cancel
button

Click on this button to abandon any
changes and close the dialog.

Notes

As you define the properties of the element, the changes·

are reflected in the preview window to the right of the
value fields
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Legend Key

A Legend element on a diagram provides a key to the
element and connector appearance conventions used on that
diagram. Each element or connector convention is
separately defined within the Legend element, using the
'Legend' dialog and the 'Element' and 'Connector' tabs. If
you want to present the Legend items in a specific sequence,
you can adjust the order in which the items are listed on the
element.

You can create more than one Legend on a diagram, to
represent particular combinations of conditions.

Access

The 'Properties' dialog for a selected Legend element can be
displayed using any of the methods outlined here.
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Ribbon Design > Element > Editors > Element >
Properties Dialog
Design > Element > Editors > Element >
Properties > Legend

Context
Menu

Right-click on Legend element |
Properties

Other Double-click on the Legend element
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Add a Legend to a diagram

Option Action

Name This field defaults to the name 'Legend';
overtype or edit the name if necessary. If
you are using the 'Apply auto color'
facility, you might use the Legend title to
state which object property you are
filtering for.

Apply auto
color

Select this checkbox if you intend to
apply an appearance convention
automatically, according to a property of
the objects as identified in the 'Filter'
field.

Filter Click on the  button and, firstly, select
whether the convention is to apply to an
element (or connector) property or to a
Tagged Value.
For an element or connector, a list of
properties displays from which you select
the appropriate type.
For a Tagged Value, select whether to use
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a customized tag or select a standard one.
In either case, the 'Select Tagged Value'
dialog displays. This dialog has a
drop-down field from which you select
the tag to apply the appearance
convention to. The drop-down list is
populated according to the options you
select:

Global Tagged Values - populates the·

drop-down list with all global tags in
the project, including profile Tagged
Values; you can therefore select a tag
that is applicable to a large number of
elements
Tagged Values from the selected·

element - click on the Select Element
button and locate and select the
required element; this populates the
drop-down list with the Tagged Values
from that element, so you can select
from a specific set of tags

Note that the tag does not have to exist
already; you can type in the name of a
new tag if necessary.
Click on the OK button to apply your
selection.

Applies to Click on the drop-down arrow and select
the type of element or connector to apply
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the filter and, hence, appearance
convention to. If you want to apply the
convention to all types of element or
connector, select <All>.

Use numeric
evaluation

Select this checkbox if automatic
application of the convention has to
evaluate the numeric value of the
property. For example, if a color is to be
applied to elements with a Phase of 3.0,
the value can be simply matched; no
evaluation is necessary. If a color is to be
applied to elements with a Phase value of
less than 4, the Phase values have to be
evaluated to see if they are less than 4
(and not equal to 4).
The 'Apply auto color' checkbox must be
selected for this checkbox to take effect.

Value Type the actual value of the tag or
property that must be satisfied for the
appearance convention to be applied. You
can use any of these operators with the
value:

.. (inclusive range); for example, 3..6·

colors objects with the property having
a value of 3, 4, 5 or 6
< (less than); for example, <4 colors·

objects with the property having a
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value of 1, 2 or 3
> (greater than); for example, >4 colors·

objects with the property having a
value of 5 or greater
= (equal to); for example, =5 colors·

objects with the property having a
value of 5 and only 5
n (single number on its own, same as·

equal to)
n:y:x:z (matches on any number equal·

to one of the values); for example,
2:4:6:8 colors objects with the property
having a value of 2, 4, 6 or 8

The value that you enter becomes the
name of the convention item in the
Legend, unless overridden by the
'Display' value.

Display Whilst the Legend will operate on the
property value you have specified, you
might prefer a different text string to
actually display on the Legend element to
provide a clearer indication of what is
being indicated. In this case, type in the
text string to show on the Legend
element.
For example, the Legend will auto-color
elements on the basis of high, medium or
low priority, but you might want to put
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this into the context of the diagram and
use text such as 'Daily Reporting',
'Weekly Reporting' and 'Monthly
Reporting'.

Fill Color Click on the down arrow and select the
standard color used as the fill or
background color of the elements that
match the selection criteria.
If you have manually applied a
non-standard color on the diagram, it
should be available from the bottom of
the pallet. If not, click on the More
Colors button and either select from the
larger pallet or define it as a custom
color.

Apply Fill (Defaults to selected; disabled if 'Apply
auto color' is not selected.)
Deselect the checkbox if you do not want
the fill color to be automatically applied
(that is, you only want the line color
and/or line width automatically applied).
This setting applies to the Legend as a
whole, not just to a key on the Legend.

Line Color Click on the down arrow and select the
standard color used for the connector line
or element border.
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If you have manually applied a
non-standard color on the diagram, it
should be available from the bottom of
the pallet. If not, click on the More
Colors button and either select from the
larger pallet or define it as a custom
color.

Apply Line (Defaults to selected; disabled if 'Apply
auto color' is not selected.)
Deselect the checkbox if you do not want
the line color to be automatically applied
(that is, you only want the fill color
and/or line width automatically applied).
This setting applies to the Legend as a
whole, not just to a key on the Legend.

Line Width Either:
Overtype the line width value with a·

different value (between 1 for thinnest
and 5 for thickest), or
Click on the 'spinner' arrows to·

increase or decrease the thickness

Apply width (Defaults to selected; disabled if 'Apply
auto color' is not selected.)
Deselect the checkbox if you do not want
the line width to be automatically applied
(that is, you only want the fill color
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and/or line color automatically applied).
This setting applies to the Legend as a
whole, not just to a key on the Legend.

New Click on this button to clear the fields in
preparation for defining a new
appearance convention in the Legend.
Take into account the points concerning
multiple conventions and multiple
Legend elements.

Save Click on this button to save any changes
you have made to an appearance
convention.

Delete Click on this button to delete the
appearance convention you have selected
in the current list.

Value |
Display
Value

Shows the appearance conventions
defined for objects in the diagram.

Hand (Up) If more than one definition is listed, click
on this button to move the selected item
closer to the start of the list.

Hand (Down) If more than one definition is listed, click
on this button to move the selected item
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closer to the end of the list.

Style Options Click on this button to define or edit the
appearance of the Legend element itself.

OK Click on this button to save any current
changes and close the dialog.

Cancel Click on this button to abort any unsaved
changes you have made, and close the
dialog.

Notes

When you close the dialog, the Legend element is·

displayed showing all the appearance conventions
defined; element conventions are listed first with
connector conventions underneath, separated by a line
across the Legend element
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Navigation Cells

Enterprise Architect makes it easy for users to navigate
through a repository by providing a handy diagram
mechanism to hyperlink to any other diagram in the
repository. This is the Navigation Cell, which you use to
provide a simple or more ornamental direction and link to a
diagram of significance to the user. You can add several
Navigation Cells to a diagram to create a top-level home
page, directing users to areas of the model they are
interested in or responsible for. You can add Navigation
Cells to a hierarchy of diagrams, further directing the user to
more and more specific aspects of the model. An excellent
illustration of this is the 'Getting Started' diagram of the
Enterprise Architect EAExample model.
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Basic Modeling Business Modeling Software Modeling Systems Modeling

Database Modeling Requirements Model Simulation

Project Management

Publishing

Profile Extensions

Getting Started

Pro Cloud Server

Enterprise
Architecture

Geospatial ModelingSchema Modeling

EA 16 Examples

Data Miner Examples Model Based Add-Ins

Diagram Features User Interface
Features

Charts

Collaboration

The diagrams containing Navigation Cells are viewable
through the Internet browser and Cloud products, and
provide a compelling experience for casual users and
non-modelers, as well as more technical and experienced
users. The navigation diagrams can be used as a Marketing
tool, Customer information tool, or quick introduction to a
model's composition. Navigation Cells are also the vehicle
for identifying and providing access to diagrams that are to
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be reviewed in a Formal Review.

Creating Navigation Cells

To create a Navigation Cell, open the diagram you are
developing as the Home Page and, from the Browser
window, drag a target diagram onto that Home Page. The
'Select Type' dialog displays. Select the 'Navigation Cell'
radio button.

This option creates the Navigation Cell,  containing the
name of the target diagram and, in the top right corner, an
icon representing the diagram type. Just after you click on
the OK button, the 'Select Image' dialog displays, from
which you can select a graphic that represents the nature of
the diagram. You can also select a diagram Theme for the
image, from the 'Image List' field. If you do not want to add
an image to the element, click on the Cancel button.

If you are using an image, it displays in the center of the
element with the target diagram name at the top, as shown in
the EAExample illustration. If you are not using an image,
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the name displays in the center of the element.

If you subsequently decide to change or remove the image
in a Navigation Cell, right-click on the element and select
the 'Appearance > Select Navigation Image' option. The
'Select Image' dialog displays, and you can simply click on a
different image or - to just remove the existing image - click
on the Cancel button.

Selecting the 'Navigation Cell' option also enables the 'Run
auto layout' checkbox, which you can select to automatically
adjust the layout of the Navigation Cells to form a grid with
10 units of separation between cells. (The unit is defined in
the diagram 'Properties' dialog). If you do not want to adjust
the layout of the cells, clear the checkbox before clicking on
the OK button.

If you use Navigation Cells in a model, they add the
stereotype <<NavigationCell>> and its associated Shape
Script to the model. Users opening the model in builds of
Enterprise Architect earlier than 13.5 can then use this
stereotype to create more Navigation Cells that are
functionally the same as the Cells under Release 13.5,
though a little more rudimentary.

Using Navigation Cells

When a Navigation Cell is displayed on a diagram, it
provides a number of options for opening and displaying its
linked diagram.
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Double-click on the Navigation Cell element in the·

diagram - the linked diagram opens in a separate tab in the
Diagram View

Click on the icon in the top right corner of the cell - the·

linked diagram is shown in a floating Diagram Pop-up
window; click off the diagram to close the window

If the Navigation Cell element is selectable (right-click on
the element and select the 'Behavior | Selectable' option) you
can also:

Press the = key to display the linked diagram on a·

separate tab in the Diagram View

Click on the  icon off the right side of the element - the·

linked diagram is shown in the floating Diagram Pop-up
window; click off the diagram to close the window or
double-click to open the previewed diagram for editing in
the main work area.

If the 'Enable Concise Diagram Navigation' checkbox is
selected on the 'Application Look' (Visual Style) dialog, and
you double click on the Navigation Cell or press the = key,
the linked diagram replaces the parent diagram in the same
tab. To return to the parent diagram (or, in a chain of
diagrams, the next up in the chain) either:

Press the Backspace key  or·

Click on the arrow at the right-hand end of the diagram·

tab

If you have used the = key to display the linked diagram,
when the parent diagram redisplays the Navigation Cell
element is also selected and given focus.
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Swimlanes

Swimlanes are vertical or horizontal bands in a diagram that
divide the diagram into logical areas or partitions. You can
apply them to all Enterprise Architect diagram types.
Activities relating to particular entities within the model
(such as the User, or the back end Repository) can be placed
within the same Swimlane to indicate their association. You
set up the Swimlanes for a diagram using the 'Swimlanes
and Matrix' dialog .
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Having created a Swimlane, you can divide it into sub-lanes
using context menu options.

Access

Ribbon Design > Diagram > Manage >
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Swimlanes > Swimlanes
Layout > Diagram > Swimlanes >
Swimlanes

Context
Menu

Right-click on diagram background |
Swimlanes and Matrix > Swimlanes

Options

Option Action

Active Select this checkbox to make the
Swimlane facilities active on the diagram,
as opposed to the Matrix facilities.

New Click on this button to begin defining a
new Swimlane for the diagram.
The 'Swimlane Details' dialog displays,
on which you provide the name, classifier
and background color of the Swimlane.

Orientation Click on the drop-down arrow and select
the orientation of the Swimlanes: Vertical
or Horizontal.

Click on the drop-down arrow and select
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Line Color the color in which to display all
Swimlane borders.
If the color you require is not shown,
click on the More Colors button and
either select from a wider range of
standard colors or define a custom color.

Font Color Click on the drop-down arrow and select
the color in which to display all
Swimlane text.
If the color you require is not shown,
click on the More Colors button and
either select from a wider range of
standard colors or define a custom color.

A Click on this button to display the 'Font'
dialog, on which you can define the type,
style, size and effects of the font used for
text on all Swimlanes in the diagram.
If you also change the text color here, it
overrides the setting of the 'Font Color'
field.

Line Width Click on the drop-down arrow and select
the line width of all Swimlane borders -
either 1 (thinnest), 2 or 3 (thickest).

Locked Select this checkbox to prevent the
Swimlanes in the diagram from being
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made narrower or wider.

Show Names
in Title Bar

(If the 'Orientation' field is set to
'Vertical'.)  Select this checkbox to
display each Swimlane name in the title
bar, above the Swimlane.

Bind Width
to Lane

Select this checkbox to bind the width of
the elements in the diagram to the width
of the swimlane or sub-lane holding
them, so that if you change the width of
any lane you do not have to manually
adjust the width of each element it
contains. If non-rectangular elements
(such as Use Cases) are not bound to the
lane width, make sure that the 'Allow
elongated Use Cases' option is selected
on the 'Preferences' dialog 'Objects' page.

Bold Font Select this checkbox to display all
Swimlane text in bold.

Hide
Classifier

Select this checkbox to block all
Swimlane classifier names from being
shown on the diagram.

Hide Lines If the 'Bind Width to Lane' checkbox is
selected, you can select this checkbox to
hide the body of each swimlane (and, if
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the Swimlane has them, sub-lane), so that
only the header cell is shown on the
diagram. The element width and lane
width remain bound

Hide Names Select this checkbox to block all
Swimlanes names from being displayed
on the diagram.

Swimlanes This panel lists the currently defined
Swimlanes, in the sequence (top to
bottom) in which they are displayed on
the diagram (left to right, or top to
bottom).
To create sub-lanes within a Swimlane,
right-click on the Swimlane name and
select the 'Create sub lane' option. You
can also copy sub-lanes from another
Swimlane and paste them into the current
Swimlane.
The context menu also provides options
to:

Edit the Swimlane properties - displays·

the 'Swimlane Details' dialog, on which
you can change the Swimlane name,
Classifier and fill color
Delete the Swimlane - prompts you to·

confirm deletion of the Swimlane
before removing it from the list
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Modify Click on this button to change the name,
classifier or background color of a
selected Swimlane.
The 'Swimlane Details' dialog displays.

Hand (Up) Click on this button to move a selected
Swimlane one position up in the
Swimlanes list.

Hand (Down) Click on this button to move a selected
Swimlane one position down in the
Swimlanes list.

Delete Click on this button to delete a selected
Swimlane from the Swimlanes list and
from the diagram. A prompt displays for
you to confirm the deletion.

Notes

All changes you make on or through the 'Swimlanes and·

Matrix' dialog must be saved by clicking on the OK 
button in order to render those changes on the diagram

If you set a background color for a Swimlane, it takes on·

the same shading profile as the main diagram background

(c) Sparx Systems 2022 Page 1338 of 1974



Modeling Fundamentals 3 October, 2022

You can adjust the width or height of a Swimlane by·

dragging the border, whilst sub-lanes are automatically
adjusted to take up the appropriate fraction of the
Swimlane; for example, two sub-lanes take up half of the
Swimlane each, three take up a third of the Swimlane
each, and so on
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Creating Sub-lanes

When you add elements to a diagram, you can position them
in horizontal or vertical Swimlanes to indicate the presence
or absence of a particular feature or property.

Within each Swimlane you can further group or separate the
elements into sub-lanes, which are a useful device for
defining another level in the organization of the diagram.
For example, you might want to divide a 'Process' lane into
two sub-lanes representing input and output, or 'In-Progress'
and 'Complete'. The 'Sub-lanes' page helps you to quickly
and easily create any number of new sub-lanes for a
Swimlane on a diagram.

Access

Ribbon Design > Diagram > Manage >
Swimlanes >  Swimlanes > Right-click
on a Swimlane
Layout > Diagram > Swimlanes >
Swimlanes > Right-click on a Swimlane

Context
Menu

Right-click on diagram background |
Swimlanes and Matrix > Swimlanes >
Right-click on a Swimlane
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Swimlane Context Menu Options

Right-click on the name of a Swimlane in the 'Swimlanes'
panel.

Create sub
lane

Displays the 'Create sub lane' dialog, on
which you enter the title of the sub-lane.
Click on the OK button to save the name
and add it to the 'Swimlanes' panel.

Copy sub
lanes

Copies all the sub-lanes underneath the
selected Swimlane.

Paste lane(s) Adds the sub-lanes held in the clipboard
to the currently-selected Swimlane.

Sub-lane Context Menu Options

Right-click on the name of a sub-lane in the 'Swimlanes'
panel.
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Edit name Displays the 'Edit sub lane name' dialog,
on which you overtype the existing name
with a new name. Click on the OK button
to effect the change and close the dialog.
The Modify button on the 'Swimlanes' tab
has the same effect.

Delete lane Removes the sub-lane from the list. There
is no confirmatory prompt.
The Delete button on the 'Swimlanes' tab
has the same effect.

Copy Lane Copies the sub-lane to the clipboard. Use
the 'Paste lane(s)' option on the Swimlane
context menu to add the copied lane to
another Swimlane

Notes

If you want to re-organize the sub-lanes, click on a·

sub-lane name and use the 'Hand Up' and 'Hand Down'
buttons, as for the Swimlanes

Whilst you can adjust the width or height of a Swimlane·

by dragging the border, sub-lanes are automatically
adjusted to take up the appropriate fraction of the
Swimlane; for example, two sub-lanes take up half of the
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Swimlane each, three take up a third of the Swimlane
each, and so on
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Swimlane Details

To define a vertical or horizontal Swimlane on a diagram,
you use the 'Swimlane Details' dialog.

Access

Ribbon Design > Diagram > Manage >
Swimlanes > Swimlanes : New or Modify
Layout > Diagram > Swimlanes >
Swimlanes : New or Modify

Context
Menu

Right-click on diagram background |
Swimlanes and Matrix > Swimlanes :
New or Modify

Options

Options Action

Name Type a name for the Swimlane.

Classifier (Optional) Click on the  button to
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browse for and select a classifier for the
Swimlane.
To delete a previously-assigned classifier,
click on the  button and select the
'<none>' option.

Back Color Click on the drop-down arrow and select
the color in which to display the
Swimlane background.
If the color you require is not shown,
click on the More Colors button and
either select from a wider range of
standard colors or define a custom color.

OK Click on this button to save and apply
your changes, and close the dialog.

Cancel Click on this button to abort your
changes, and close the dialog.
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Swimlanes Matrix

On any type of Enterprise Architect diagram, you can
develop a Swimlanes Matrix to divide your diagram into
cells at the intersections of columns and rows. This Matrix
is based on the Zachman Framework. The top left cell of the
Matrix contains the heading text, the cell at the top of each
column contains the column title text and the cell at the left
of each row contains the row title text.

You can define only one Matrix Heading cell, but you can
create as many row and column headings as you need. You
can also leave the column width and row height adjustable
on the diagram, or fix the positions so that the cell borders
cannot be moved.

The Matrix is defined on the 'Swimlanes and Matrix' dialog.

Access

Ribbon Design > Diagram > Manage >
Swimlanes > Matrix
Layout > Diagram > Swimlanes > Matrix

Context
Menu

Right-click on diagram background |
Swimlanes and Matrix > Matrix
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Options

Option Action

Active Click on this checkbox to set the diagram
to use the defined Matrix facilities, as
opposed to any Swimlanes that have also
been defined.

New Click on this button to clear the dialog
fields so that you can add a new column
or row item to the Matrix.

Title # Type in a title name. You can provide
one, two or three title names per heading
to, for example, group a set of columns or
rows.
There is no effective limit on the length
of the text string but it does not wrap, so
to display the full text you might have to
drag the cell borders out to create a wide
cell. Alternatively, you can divide the text
string between the 'Title' fields to reduce
the overall cell width.

Color Click on the drop-down arrow and select
the color in which to display the text in
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the heading, row or column title.
If the color you require is not shown,
click on the More Colors button and
either select from a wider range of
standard colors or define a custom color.

Font Click on this button to display the 'Font'
dialog, through which you define the font
and style, size and effects of the text in
the Matrix header, column and row titles.
If you also change the text color here, it
overrides the setting of the 'Color' field.

Hidden Select this checkbox to hide the
corresponding Matrix header, row or
column Title text on the diagram.

Type Click on the drop-down arrow and select
'Heading', 'Column' or 'Row' to apply
your field settings to the Matrix heading
cell, a column heading or a row title,
respectively.

Back Color Click on the drop-down arrow and select
the color in which to display the heading
cell, row or column background.
If the color you require is not shown,
click on the More Colors button and
either select from a wider range of
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standard colors or define a custom color.

Hide Item Select this checkbox to hide the Matrix
heading cell, row or column on the
diagram.

Model
Profiles

Click on the drop-down arrow and select:
An existing Profile to override the·

current contents of the dialog
'Empty Profile' to clear the fields so·

that you can define a matrix to save as
a new Profile (see Model Profiles:
Save)

Model
Profiles:
Save

Click on this button to save the current
dialog contents as a new Profile.
A prompt displays for you to assign a
name to the Profile.

Model
Profiles:
Delete

Click on this button to delete the
currently-displayed user-defined Matrix
Profile from the drop-down list.

Line Widths Click on the drop-down arrow and select
the line width of all row and column
borders - either 1 (thinnest), 2 or 3
(thickest).

Click on the drop-down arrow and select
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Line Color the color in which to display all lines in
the matrix.

Lock Select this checkbox to prevent the
Matrix rows and columns in the diagram
from being resized.

Matrix list Lists the components of the current
Matrix Profile, starting with the Heading
and followed by the columns and then the
rows. For each item, the list shows the
first title (Title 1) whether it is visible on
the diagram, and what type it is.
The columns are listed in the order in
which they are displayed, left to right, on
the diagram.
The rows are listed in the order in which
they are displayed, top to bottom, on the
diagram.

Hand (Up) Click on this button to move a selected
column or row one position up in the
Matrix list. You cannot move a Column
item above the Heading item, or a Row
item above a Column item.
When you save the changes, on the
diagram the selected column or row is
moved left or up one place.
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Hand (Down) Click on this button to move a selected
column or row one position down in the
Matrix list. You cannot move the
Heading item below a Column item, or a
Column item below a Row item.
When you save the changes, on the
diagram the selected column or row is
moved right or down one place.

Save Click on this button to save the contents
of the dialog, but not close the dialog, so
that you can define or edit columns and
rows individually and save them before
defining the next item.

Copy Click on this button to copy a selected
item from the list so that you can give it a
new Title 1 and edit it as a new item.
If you change the item, it is added to the
list when you click on the Save button.

Delete Click on this button to delete a selected
item from the list. The column or row is
removed from the list and diagram, which
both close up.

OK Click on this button to save and apply
your changes, and close the dialog.
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Cancel Click on this button to abort your
changes, and close the dialog.

Notes

When you define columns and rows, you define the·

header or title cells; the properties of these cells do not
reflect on the matrix cells themselves - for example, the
intersection cell of a column and row has a transparent
background and therefore takes the color and shading
effect of the diagram background

You can transport the Swimlanes Matrix Profiles between·

models (as Diagram Matrix Profiles), using the 'Settings >
Model > Transfer > Export Reference Data' and 'Import
Reference Data' ribbon options

By applying a Matrix Profile to a diagram, you replace the·

current profile; save the current profile to avoid losing it

To size the rows and columns, drag the row and column·

borders on the diagram - elements placed inside each cell
are shifted when sizing; to prevent the elements shifting,
press and hold Ctrl while sizing
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Diagram Relation Matrix

The Diagram Relation Matrix View presents the contents of
the current diagram in the form of a simple grid, identifying
the relationships between the named elements on that
diagram. Objects that have an empty name field are not
included in the matrix.

Access

Ribbon Design > Diagram > Views > Relation
Matrix View

Context
Menu

Right-click on diagram background |
Switch View | Switch to Relation Matrix
View   or
Right-click on diagram tab | Switch to
Relation Matrix View
In the Browser window, right-click on the
name of the open diagram | Switch View |
Switch to Relation Matrix View

The Relation Matrix View
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The Relation Matrix view is similar to the project-level
Relationship Matrix, but it is a diagram view and as such
displays only those elements contained in the selected
diagram and has fewer fields to define where those
relationships are detected.

Each row and each column of the Relation Matrix view
represents a diagram element. There is small italic number
on the top-left corner of each row and column cell, which is
the row/column index. The cell at the intersection of a row
and a column shows the details of any relationships between
the corresponding diagram elements.

The Relation Matrix view provides a means to quickly
identify elements that are not yet connected to other
elements, such as Requirements elements that are not yet
realized.  You can also create new relationships or delete
existing relationships directly in the matrix.

Selecting a cell in the matrix shows additional relationship
properties where they exist, such as cardinality values and
roles. Where relationships exist between features of the
source and target elements, this is represented on the matrix

(c) Sparx Systems 2022 Page 1354 of 1974



Modeling Fundamentals 3 October, 2022

as well.

Viewing Options

You can refine the display to show only:

Relationship connectors of a specific type·

Source elements of a specific type and/or·

Target elements of a specific type·

Click on the drop-down arrow for the appropriate field at the
top of the matrix, and select the required type. Note that the
element and connector types in the lists are only for those
objects that are already in the diagram.

You can further restrict the display to show only elements
that already have connectors, by selecting the 'Limit to
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Connected Elements' checkbox.

Format

By default, the Relation Matrix View displays elements in a
hierarchy, as for Requirement A1 in the earlier example.
You can change this to display the elements in flat lists by
right-clicking in the top left cell and deselecting the 'Show
Element Hierarchy' option.

Navigate the Relation Matrix

You can navigate through the Relation Matrix using either
the scroll bars or the arrow keys.

Scroll Bars:

If the matrix is bigger than the display area of the screen,·

and some of the element/relation cells cannot be seen, a
vertical and/or a horizontal scroll bar is displayed so that
you can scroll to the hidden area of the matrix

If you scroll the matrix up, the column headers remain·

visible whilst the rows appear to roll beneath them and are
hidden; in this case, the top edge of the first visible row
header becomes a dashed line to indicate there are hidden
rows above it (and you will notice that the italic number
in the top left corner of the cell will be a number greater
than 1)
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Similarly, if you scroll the matrix left, the row headers·

remain visible while the columns appear to roll beneath
them and are hidden; the left edge of the first visible
column header becomes a dashed line to indicate there are
hidden columns to the left of it (and the italic number in
the top left corner of the cell will be a number greater than
1)

Arrow Keys:

From a selected cell of the matrix, you can press the arrow·

keys to move to a neighboring cell of the same type (that
is, column header to column header, row header to row
header or grid cell to grid cell)

To move between cells of different types, such as from a·

grid cell to a column header cell or vice versa, press Ctrl
as you press the arrow keys

If the neighboring cell is hidden or outside the display·

area, pressing the appropriate arrow key will  scroll the
Relation Matrix to show the row or column containing
that cell
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Add / Delete Element

You can add elements to the Relation Matrix by:

Dragging the appropriate element icon from the Toolbox·

onto the 'Target' triangle or 'Source' triangle (to add a peer
element) or onto an element in the Target row or Source
column (to add the new element as a child of the selected
element)

Dragging an element from the Browser window on to the·

Target row or Source column

Right-clicking on an element name in the Target row or·

Source column, and selecting the 'New Child Element'
option to add a new child element of a type listed in the
submenu

Right-clicking on an element name in the Target row or·

Source column, and selecting the  'Insert Related
Elements...' option to insert a related element of the
selected element, using the Insert Related Elements dialog

Right-clicking on the diagram background outside the·

Relation Matrix and choosing the 'Insert Other Element...'
option to insert an element from any Package, located and
selected using the 'Select Element' browser

You can delete an element from Relation Matrix by
selecting the element-name cell and either:

Pressing Ctrl+Delete, which deletes the element and its·

connectors from the model; you are prompted to confirm
the deletion, or

Right-clicking on the cell and selecting the 'Delete·
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<element name>' option (the element is immediately
removed from the matrix and diagram), or

Pressing the Delete key·

Add / Delete Connector

The Diagram Relation Matrix greatly simplifies the process
of creating and removing relationship connectors between
elements.

To add a connector, click on the cell at the intersection of
the source element row and target element column and:

Right-click and select the 'Create new relationship' option,·

and then select the type of connector from the sub-menu,
or

If there is currently no connector between the source and·

target element, press the Spacebar and then select the type
of connector from the submenu, or

If there is a connector and you want to add another one,·

press the Spacebar, select the 'Create new relationship'
option and then select the type of connector from the
submenu

To delete a connector:

Click on the cell containing the connector to delete, and
either:

Press Ctrl+Delete,  which prompts you to confirm the·

action before deleting the connector from model, or
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Right-click and select the 'Delete Connector' option,·

which prompts you to specify whether to simply hide the
connector or to delete the connector from the model, or

Press the Delete Key, which again prompts you to select·

between hiding and deleting the connector

Display Element / Connector Properties

You can display the properties of any element or a
connector in the matrix, either in the object's 'Properties'
dialog or in the docked Properties window.

To display the 'Properties' dialog, double-click on the·

name of the element or connector in a cell

To display the docked Properties window, click on the·

name of the element or connector in a cell and press
Ctrl+Enter; if the window is already displayed, simply
click on the element or connector name to make it the
focus of the window

Certain features are shown on the cell itself. For example,
the cell for an Information Flow on a SysML diagram also
shows the conveyed items. You can locate the conveyed
items in the Browser window by right-clicking on the name
and selecting the 'Find Conveyed Items' option.

In-Place Editing Element Names
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If you should need to correct the name of an element in the
Relation Matrix, you can easily do so using the in-place
editor; click on the element cell and either press F2 or click
on the element name twice (not double click). Type in the
correct text and press the Enter key.

Hide/Show Relationships

If you want to simplify your diagram and its various
representations, you can hide connectors that are not
immediately relevant to the view, and recall them when your
purpose requires them. Hiding or showing a connector in
one view of the diagram affects all the other views.

Before attempting to hide connectors, make sure the 'Prompt
on connector deletes' checkbox is selected in the 'Links'
page of the 'Preferences' dialog ('Start > Appearance >
Preferences > Preferences > Links').

To hide a connector:

Click on the cell showing the connector you want to hide,
then either:

Right-click and select the 'Visibility | Hide Connector'·

option, or

Right-click and select the 'Delete Connector' option, then·

on the 'Remove Connector' dialog select the 'Hide the
connector' radio button and click on the OK button, or

Press the Delete key, and again on the 'Remove·

(c) Sparx Systems 2022 Page 1361 of 1974



Modeling Fundamentals 3 October, 2022

Connector' dialog select the 'Hide the connector' radio
button and click on the OK button,

To show a hidden connector:

Click on the cell containing the connector you want to
reveal, then:

Right-click and, if the cell does contain any hidden·

connectors, click on the option 'Show Relation' (the option
is not provided if there are no hidden connectors)

From the sub-menu listing all the hidden connectors by·

type and (if set) name, select the connector to show

Navigate between Graphical view and
Relation Matrix view

You can easily switch from the Relation Matrix View to the
graphical representation or any of the other diagram views,
using the right-click context menu option 'Switch View |
Switch to Graphical View' (or 'Switch to <other> View').

If you select the option after clicking on a:

General area of the matrix, the diagram displays from the·

top left corner, and other views display from the starting
point

Relation cell that shows a specific connector, the diagram·

or other view displays with that connector or its
information visible and selected

If you are in the diagram in its graphical view, you can
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select a connector and specifically focus on it in the
Diagram Relation Matrix, by right-clicking on the selected
connector and clicking on the 'Switch to Relation Matrix
View' option. The matrix displays with the cell for that
connector in the center of the display.

Publish the Relation Matrix

When you render the diagram as a Relation Matrix, you can
capture the appearance of the matrix in a:

Printed hard copy - 'Publish > Diagram Image > Print >·

Print'

PDF file - 'Publish > Diagram Image > Print > Print to·

PDF

Image file - 'Publish > Diagram Image > Save > Save to·

File

Clipboard capture - 'Publish > Diagram Image > Save >·

Save to Clipboard
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Roadmap Diagrams

Roadmap diagrams help you to map existing elements
against a timeline. This is useful for visualizing how a
system changes over time, planning a migration of
responsibility between two teams, documenting the
concurrent support for multiple platforms or representing
just about any time based data. To ensure the modeler and
viewer always have appropriate context, the timeline is
always displayed on screen, on any saved images and when
printed.

Changes of phase or state of each element can be
represented in Roadmap diagrams using a dedicated
notation of a bar divided into colored segments representing
each state. The states available, the order they appear in and
the colors used are controlled by a Diagram Legend. Each
element displayed then shows the length of each segment
(and hence duration of each state), and also provides the
ability to hide individual segments on that element.

Creating a Roadmap Diagram

This diagram shows an example Roadmap that documents
the planned lifecycle for two products through development,
release, support and retirement, by quarter over a period of
one and a half years.
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Developing / Testing

Fully Supporting

Reduced Support

Beyond EOL

Legend

Pluto 2

Pluto 1

Q4'20 Q1'21 Q2'21 Q3'21 Q4'21 Q1'22

Unit: Quarterly Product Lifecycle

You can develop this diagram as the example for the guided
procedure in the Setting up a Roadmap Diagram table. To
create the initial, basic diagram:

Right-click on its parent Package and select the 'Add1.
Diagram' option.

On the 'New Diagram' dialog, in the 'Diagram' field type2.
in the diagram name, such as 'Example Roadmap'.

Click on the drop-down arrow in the 'Type' header and3.
select the 'Construction > Project Management'
Perspective group, and then click on 'Project
Management' in the panel beneath the header.

The 'Diagram Types' panel lists the diagram types -4.
Project Management, Roadmap and Backlog. Click on the
Roadmap diagram type.

Click on the OK button. The system opens the diagram in5.
the central work area.

You can also generate one of the pre-designed Roadmap
diagrams from the Patterns provided by Enterprise
Architect, to tailor the Roadmap for any of a range of areas
of work. To access these Patterns, select the 'Design >
Package > Model Wizard' ribbon option, then on the 'Create
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from Pattern' tab (Model Wizard) select the 'Construction >
Project Management' Perspective. If necessary, expand the
'Roadmaps' group.

Select the required Roadmap(s) and click on the Create
Model(s) button. Each Roadmap is automatically created
within its own Package.

Access

To begin setting up the diagram you have just generated, on
the open diagram display the 'Roadmap Options' dialog
using one of the methods described here.
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Ribbon Design > Diagram > Manage > Roadmap

Context
Menu

In the diagram, right-click on the
background | Roadmap

Setting up a Roadmap Diagram

Starting with the 'Roadmap options' dialog, follow these
steps to set up the Roadmap diagram. The fields are
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described in greater detail in the Roadmap Diagram Options
topic. This procedure includes using a Diagram Legend to
automatically divide an element into phase segments in
different colors. The steps lead you to create the diagram
shown at the start of this topic.

Ste
p

Action

1 Select the 'Enabled' checkbox, to enable the timeline
on the diagram.

2 In the 'Roadmap Title' field, type a title for the
diagram such as 'Product Lifecycle'. (The title is
optional, and you can leave the field blank if you
prefer.)

3 In the 'Units' field, click on the drop-down arrow and
select 'Quarterly'. The major sections are displayed
in alternating light/dark shades to make it easy to
distinguish between adjacent sections.
The 'Units' field offers a wide range of pre-defined
units for the scale of the Timeline, and you can
define your own customized units. You can also
change the section display color using the 'Timeline
color' field in the 'Timeline Appearance' panel.

4 Click on the 'Tick Spacing' slider and drag it left or
right to scale the timeline to a size that is appropriate
for your diagram.
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5 In the 'Timeline Start' field, click on the drop-down
arrow and click on the date on which the Roadmap
Timeline is to start. (For the example, select October
10th 2020; the exact value doesn't matter, as long as
it is within the quarter you want to start in.)
The 'Timeline End' field is disabled for date unit
scales (that is, years, quarterly, months and days).

6 Adjust the appearance settings:
In the 'Roadmap Position' field, select the 'Top'·

option to position the roadmap timeline headers at
the top of the diagram
Drag the 'Timeline Height' slider about half way·

across the bar
In the 'Line Color' field click on the drop-down·

arrow and select a dark color such as charcoal
Select the 'Lines at major intervals' checkbox·

Select the 'Use legend for phase colors' checkbox·

7 Click on the OK button to save the settings and close
the dialog.

8 In the Diagram Toolbox, switch to the Class pages
and drag two Class elements onto the diagram. Give
them the names 'Pluto 1' and 'Pluto 2'.
Move and resize 'Pluto 1' so that its left edge is on
the Q4'20 major marker line (the start of October
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2020), and its right edge is just under the second
Q1'22 minor marker (the end of February 2022).
Move and resize 'Pluto 2' so that its left edge is under
the first Q4'20 minor marker (November 2020) and
its right edge is under the first Q1'22 minor marker
(the end of January 2022).

(Note: The diagram has been annotated to show the
element positions; this text is not generated on the
actual diagram.)

9 (This step is a 'placeholder' to show where in the
process you add a Diagram Legend and roughly
what you do. The actual procedures are in the linked
Help topics in the 'See also' column.)
From the 'Common' page of the Diagram Toolbox,
drag a 'Diagram Legend' icon onto the diagram.
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You will use this to add and format the phase
segments on the two elements.
Double-click on the Diagram Legend to display its
'Properties' dialog, and define how the Legend
element itself will be displayed and how the phase
segments will be applied. In the example, you will
define these four phases:

Developing/Testing·

Fully Supporting·

Reduced Support·

Beyond EOL·

For each phase, type the name in the 'Value' field,
select a display color in the 'Fill color' field and click
on the Save button to save the phase definition.
Select the 'Apply auto color' and 'Apply Fill'
checkboxes, and then click on the OK button to save
the settings and close the dialog.

10 You now have two elements on the Timeline, each
with four colored segments of equal length that
represent the product lifecycle phases as indicated in
the Diagram Legend.
To set the duration of each phase, click on the
dividing line between two phases and drag it to the
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appropriate point relative to the scale on the
Timeline.
You have now created a Roadmap diagram
resembling the example shown at the start of this
topic.

Hide and Show Segments

When you set up a Legend to apply segments to the
elements on a Roadmap, every element on the Roadmap has
all the defined segments. However, certain segments might
not be relevant to particular elements, in which case you can
hide those segments on those elements. Should a hidden
segment be relevant to an element, you can show it.

A new element added to the diagram will show all the
segments. However, if you add a new segment to an existing
element, that segment is automatically hidden and - if it is to
be displayed - should be set as described here.

To hide or redisplay segments on an element:

Right-click on the element and select the 'Hide/Show6.
Roadmap Segments' option. The 'Hide/Show Roadmap
Segments' dialog displays, listing the segments defined in
the Legend. Each segment has a checkbox.
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For each segment to show on the element, select the7.
checkbox. For each segment to hide on the element,
deselect the checkbox.

Click on the OK button. The selected segments on the8.
element display on the diagram.

When a segment is hidden, the most directly-affected visible
segment automatically occupies the space of the hidden
segment. This is generally the segment immediately to the
right (the chronologically later segment) except where the
final segment in the element is hidden, when the segment to
the left extends to fill the space. The overall length of the
element does not change, and neither do the lengths of the
remaining segments in the element; if they do need to be
adjusted, drag the separator lines to the appropriate time
line.

When a hidden segment is made visible, it occupies the first
time unit of the next segment in the chronological sequence
(or, if it has been added to the end of the element, the final
time unit of the previous segment). Again, the total length of
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the element is not affected, not are the lengths of the other
segments in the element. You can make manual adjustments
to set the length of the new segment and any other segments
that need to be adjusted to accommodate it.

Notes

The Timeline and the text displayed on it are always·

shown, as you scroll the diagram up or down

You can apply further grouping or categorization of the·

elements on the Roadmap, by defining horizontal
Swimlanes for the diagram
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Roadmap Diagram Options

This topic describes each of the options available on the
'Roadmap options' dialog, which you use to define a
Roadmap Timeline on a diagram. The process of creating a
Roadmap diagram is described in the Roadmap Diagrams
topic.

Roadmap Options

Option Description
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Enabled Select this checkbox to show the
Roadmap Timeline and associated
features on the diagram. Clear the
checkbox to hide the Roadmap on the
diagram (which will hide Roadmap
features derived from a Legend, but not
element features applied by a Legend
independent of the Roadmap).

Roadmap
Title

Type in an appropriate name or title for
the Roadmap, or leave blank if no title is
required.

Units Click on the drop-down arrow and select
the appropriate unit of time for the
Timeline.

You can also select 'Custom' and define
your own scale of measurement; see
Setting up a Custom Scale at the end of
this topic.
The selected unit is automatically
identified in the top left corner of the
Timeline, and the appropriate sequence of
units displays along the width of the
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Timeline.
Each standard time unit is automatically
divided into the appropriate number of
smaller divisions by separators (or
'ticks'); each Quarter is divided into three
months, each year has twelve divisions,
each day has 24 divisions, and so-on. To
see some of the finer divisions (such as
seconds in a minute) you might have to
set the 'Tick spacing' slider to the left
hand end, which minimizes the width of
the labeled units so that you can see more
of them on the screen.

Tick spacing Click on the slider and drag it left or right
to decrease or increase the width of the
scale divisions in the Timeline.
If you change this setting after
positioning elements on the diagram,
those elements are shortened or
lengthened automatically to maintain
their relationship to the scale divisions.

Timeline
Start

If the 'Units' field is set to 'Years',
'Quarterly', 'Months' or 'Days', this field
defaults to today's date. To change this
either click on the section of the date and
overtype it, or click on the drop-down
arrow and select another date from the
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calendar.
For smaller units of time and for the
'Custom' setting, the field is blank and
you can set a start value. If you do not set
a start value, the first marker on the
diagram defaults to 0.
The start date or value is shown as the
label of the first major section on the
Timeline.

Timeline End If the 'Units' field is set to 'Years',
'Quarterly', 'Months' or 'Days', this field is
disabled and the Timeline is indefinite.
For smaller units of time and for the
'Custom' setting, the field is blank and
you can set an end value. If you do not
define an end value, the unit count
increments up to the marker containing
the right edge of the rightmost element.
When an end value is defined and that
end is reached, the timeline loops back to
the 'Timeline Start' value. This allows the
single timeline to be extended using the
diagram width instead of the height,
documenting a different set of elements
against the same timeline.

Scale This field is enabled when you select
'Custom' in the 'Units' field. Type in the
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appropriate scale unit; the value is
displayed in the top left corner of the
Timeline as the Unit. See Setting up a
Custom Scale at the end of this topic.

Marker offset This field is enabled when you select
'Custom' in the 'Units' field. Type in the
number of units that each major segment
of the scale represents. See Setting up a
Custom Scale at the end of this topic.

Ticks This field is enabled when you select
'Custom' in the 'Units' field. Type in the
number of 'ticks' to subdivide each major
segment of the Timeline. See Setting up a
Custom Scale at the end of this topic.

Roadmap
Position

Click on the drop-down arrow and select
whether to show the Timeline at the top
of the Diagram View or the bottom, or in
both places. ('Top & Bottom' is
particularly useful if your diagram fills
the screen height.)

Timeline
Height

Click on the slider and drag it to the left
or right to decrease or increase the depth
of the Timeline ribbon. The optimum
depth keeps all the Timeline text separate
and distinct without hiding too much of
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the diagram itself.

Timeline
Color

Click on the drop-down arrow and select
from the standard palette the color in
which to display the Timeline. The
display alternates between a lighter and
darker shade of the color to help
distinguish between the individual
segments. This shading is less clear with
dark or vibrant colors.
If you want to select a color other than
those in the standard palette, click on the
More Colors button and select or define
the required color.

Line Color It is possible to display vertical guidelines
to the diagram, issuing from the main
segment boundaries (see the 'Lines at
major intervals' option). Click on the
drop-down arrow and select from the
standard palette the color in which to
display these lines.
If you want to select a color other than
those in the standard palette, click on the
More Colors button and select or define
the required color.

Font Click on the A icon to display the 'Font'
dialog, and select the font type, style,
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size, color and effects to apply to the text
of the Timeline.

Lines at
major
intervals

Select the checkbox to display vertical
lines across the diagram, to mark the
major segments of the Timeline. Deselect
the checkbox to hide the lines.
On the example diagram, the lines
separate the quarters and are shown in
black.

Center
marker labels

Select this checkbox to display the
segment labels in the center of the
segment. Clear the checkbox to display
the segment labels straddling the left edge
of the segment.

Use legend
for phase
colors

Select this checkbox to apply the
roadmap notation of a bar divided into
colored segments representing phases to
all elements. This requires a legend with
'Apply auto color' enabled to exist on the
diagram. Each property color you define
in the Legend is represented by a color
band in each element in the Roadmap.
When you have set up the Legend and the
Roadmap, resize the elements to span the
appropriate number of unit segments that
they map to. Within each element, drag
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the left and/or right boundary of each
color segment so that they also span the
number of unit segments that they align
to, as illustrated in the example Roadmap.

OK Click on this button to close the dialog
and apply any changes you made to the
settings.

Cancel Click on this button to close the dialog
and abort any changes you made to the
settings.

Setting up a Custom Scale

A Custom scale gives you the ability to create a Roadmap
diagram for a process that is not mapped against time, or to
give a different scale to a unit of time. For example, you
might want to show the consumption of raw materials in
tons over several stages, or the progress of a step taking two
minutes where the changes in flow are better mapped at 10
second intervals than at 1 second intervals.

To set up a Custom scale on a Roadmap diagram, set the
fields on the 'Roadmap Options' dialog as described in the
previous Roadmap Options table, but provide specific
values for the fields described in this table.
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Field Action

Units Click on the drop-down arrow and select
'Custom'. This setting enables the 'Scale',
'Marker offset' and 'Ticks' fields, and
clears the 'Timeline Start' and 'Timeline
End' fields for free-text input.

Timeline End In the blank field, type the end, cut-off or
target value for the scale. For example, a
target revenue or a maximum cost, period
or capacity.
When an end value is defined and that
end is reached, the timeline shows the
'Timeline Start' value again and
increments from there. You can use this
repeated scale to set up a different group
of elements under the same timeline.
If you do not define an end value, the unit
count increments up to the marker
containing the right edge of the rightmost
element.

Scale Type in the required unit of measurement,
in numerals, text or both; you might
specify, for example, units of distance,
weight or monetary value, or a
percentage. The value is displayed in the
top left corner of the Timeline as the

(c) Sparx Systems 2022 Page 1383 of 1974



Modeling Fundamentals 3 October, 2022

Unit.

Timeline
Start

In the blank field, type the start value for
the scale. For example, any wait period at
the start of the process, or minimum
balance or brought-forward balance for
accounting scenarios. The Timeline then
increments from that value. If you do not
specify a value, the Timeline starts at 0.

Marker offset Type in the number of units that each
major segment of the scale represents.
You set this value in combination with
the 'Scale' field; you might, for example,
set the scale to '$US 1000' and the offset
to '1', or the scale to simply '$US' and the
offset to '1000'.
The offset can also represent the natural
unit of progression, so if one output
delivers two units you might set the offset
to 2 and the scale reads '2, 4, 6, 8' and so
on, or if the delivery is 3 units set an
offset of 3 and the scale reads '3, 6, 9, 12'
and so on.

Ticks Type in the number of separators (or
'ticks') you want to display to subdivide
each major segment of the Timeline. The
number of ticks is 1 less than the number
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of subdivisions. For example, in the
'Year' unit there are 11 ticks giving 12
subdivisions, one for each month of the
year.
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Custom Diagram Styles

Enterprise Architect provides a diagram drawing style that
helps you to create new diagrams or cast existing diagrams
as simple, colorful and direct illustrations of modeling and
project management concepts, similar to the style of
drawings created in Visio or Powerpoint. Elements are
rendered with a border color, fill color, no gradients and a
simplified appearance. They can also be rendered in a range
of different shapes.

This minimalist drawing style is much used by architects,
business users, CEOs and many others as a preferred means
of conveying ad-hoc information concerning a business
capability, architecture, system interaction or any of several
other scenarios. In providing this capability, Enterprise
Architect dramatically increases the reach and audience for
its range of diagrams. Coupled with WebEA and
Prolaborate, the facility offers end users instant access to
attractive and familiar diagrams that avoid the formal,
technical appearance and complexity of UML and
technology diagrams.

The custom drawing style can be applied to any UML
diagram, so that a user can still use the correct modeling
element types (and can toggle back to the formal rendering
of these elements) but they can give them a completely
novel rendering style and appearance.

Custom Diagram Style is available in the Corporate, Unified
and Ultimate Editions of Enterprise Architect from release
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15.0 onwards.

Access

Working
from a
template or
Pattern

Display the Model Wizard (right-click on
a Package and select the 'Add a Model
using Wizard' option), click on the
<perspective name> button and select
'Analysis > Custom Diagram Style'.
Select one of the three templates or six
examples, and work on those to develop
your own diagrams. Note that these
templates are intended to illustrate the
feature rather than provide a framework
for modeling - customizing is, after all,
doing things your way! We recommend
generating a model from the Custom
Drawing Styles template (the diagram is
shown in the Examples of Style
Rendering section of this topic) and
experimenting with the shapes and
features to help you develop your own
rendering of elements.

Apply the
style to an
existing

Open the Properties window (Ctrl+2) and
the required diagram, and click on the
diagram background. On the 'Diagram'
tab of the Properties window, expand the
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diagram 'Appearance' segment and select the
'Custom Style' checkbox. Alternatively,
double-click on the diagram background
to display the 'Properties' dialog, select
the 'Elements' tab and select the 'Custom
Draw' checkbox.
All elements on the diagram are rendered
as white rectangles with the element
name and stereotype in the center.
However, structural elements (such as a
Ports) are not rendered differently in
Custom Style.

If the element has Notes, these are also
displayed in parentheses. No other
element properties or characteristics are
shown.
Connectors on the diagram are simplified
to a solid line and basic arrowhead,
except for stereotyped connectors which
are also not rendered differently in
Custom Style.
You now click on each element in turn
and click on the  icon to define the
rendering as described in the rest of this
topic. You can equally apply each feature
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to a selection of multiple elements.

Enable the
style for an
individual
element

If the 'Custom Style' option on the
diagram is not selected, you can apply the
style to an individual element on the
diagram. Right-click on the element and
select the 'Appearance | Enable Custom
Draw Style' context menu option. The
element - alone on the diagram - is shown
as a white rectangle as shown in the
earlier example.
When either of the 'Enable Custom Draw
Style' or diagram 'Custom Style' options
are selected, when you click on the
element and on the  this Format toolbar
displays next to the element:

Examples of Style Rendering

In the descriptions provided in this topic, refer to this
diagram as an illustration of the options and their effects.
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Border Style

Rotation

Alignment

Opacity

Shape

Rectangle Round Rectangle Ellipse Diamond

0% 25% 50% 75% 100%

Top Left Top Center Top Right

Left Center Center Right Center

Bottom Left Bottom Center Bottom Right

Vertical
(Clockw

ise)

Ve
rti

ca
l

(A
nti

cl
oc

kw
is

e)

Solid Dash

Dot Dash-Dot

None

Triangle

Stack

Stack = 2 Stack = 3

Stack Direction

NW NE

SW SE

Stack = 4

Polygon (6 sides)

Apply Styles

Style Options

Set the Shape On the Format toolbar click on the 
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icon at the right-hand end of the row of
icons. In the drop-down menu, click on
the appropriate shape option to render the
element as a:

Rectangle (the default)·

Rounded-corner rectangle·

Ellipse (which you can drag into the·

shape of a circle)
Diamond·

Polygon, with a submenu to define the·

shape as having 5, 6, 7, 8, 9 or 10 sides,
or
Triangle·

See the 'Shape' panel of the example
diagram. The 'None' option here turns
custom styles off for the element and
returns it to 'normal' model notation
rendering.
Regardless of its visible shape, each
element has a rectangular operation
boundary and the positioning options
described in this table work within that
rectangle.  You might find, therefore, that
some of the position options on
non-rectangular shapes can place the
element text and icons outside the visible
shape.
Note that the icon in the toolbar updates
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to reflect the current shape of the
element.

Set the
Opacity of
the Element
Fill

You can set the element shape to be
transparent (so that the diagram
background and any overlapped elements
show through) or various degrees of
opacity that overshadow the overlapped
elements. If you set 100% opacity, the
element fill is solid and totally hides the
background and any overlapped
elements.
To set the opacity, on the Format toolbar
click on the  icon and select from:

0%·

25%·

50%·

75% and·

100%·

See the 'Opacity' panel of the example
diagram.
Note that the element boundary, text and
icon (if set) are not affected when setting
the Opacity.

Set the Text
Position

On the element, display of the name,
stereotype and notes defaults to the center
of the element. You can reposition the
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text to eight other points in the element
shape, or place the text in a custom
position.
To position the text, on the Format
toolbar click on the  icon and select
from these options:

Top Left·

Top Center·

Top Right·

Left Center·

Center·

Right Center·

Bottom Left·

Bottom Center·

Bottom Right·

Custom·

If you select the 'Custom' option, the
element text is displayed as a label just
beneath the element, and you can drag it
to whatever position inside or outside the
element you prefer. You can also use any
of the standard label formatting facilities.
See the 'Alignment' panel of the example
diagram. Note that the icon in the toolbar
reflects the current position of the text in
the selected element.
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Set the Text
Orientation

The text in the element defaults to
horizontal, reading left to right. If you
prefer, you can set the element name to a
vertical orientation with characters in the
same plane, reading either top to bottom
or bottom to top.  Stereotype and Notes
text are hidden in these vertical settings.
To set the orientation, on the Format
toolbar click on the  icon and select
from these options:

None (leave horizontal)·

Vertical (clockwise)·

Vertical (anticlockwise)·

See the 'Rotation' panel of the example
diagram. Note that the icon in the toolbar
reflects the current orientation of the
name of the selected element.

Add an Icon
to an Element

While the diagram has Custom Style
enabled, you can add icons to either the
existing elements or to new elements
generated as part of the process. The
default position of the icon is in the top
right corner of the element boundary, but
you can move the icon to other points.
To set the icon on an element in the
diagram, select an Image Asset in the
Browser window and drag it onto the
diagram, either onto the existing element
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or into a space in which to create a new
element. A short menu displays:

If you are adding the image to an·

existing element, select the 'Set as Icon'
option
If you are creating an element that·

contains the icon, select the 'Add as
element with icon' option

After adding the icon, click on the
element and on the , then in the Format
toolbar click on the  icon and on
'Position', and select from these options:

Top Left·

Top Center·

Top Right·

Bottom Left·

Bottom Center·

Bottom Right·

Note that the toolbar icon reflects the
current position of the icon in the selected
element.
Any size of image can be set into the
Image Asset when it is used as an icon,
but you can control its display size in the
element. Click again on the  icon and
on 'Size', and select from these options:

16x16 pixels·
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24x24 pixels·

32x32 pixels (the default)·

Image Size (the size of the image in the·

Image Asset; do not select this option
unless the image is already small
enough to act as an icon)

Apply Border
Style

To change the border line style, on the
Format toolbar click on the  icon
(second from the right) and select a line
style of:

Solid·

Dashed·

Dotted·

Dashed-and-Dotted·

None·

See the 'Border Style' panel of the
example diagram.

Apply
Stacked
Image

On the diagram or element with Custom
Style enabled, you can make an element
represent several iterations of its object
by adding a set of between 1 and 4
'stacked' element edges off one of the
corners of the element.
To add 'stacking', click on the  icon
and select 'Stacks' and the number of
edges to add.
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Click on the  icon again (notice that it
now represents the number of 'stacks' you
set) and select 'Direction' and one of these
options:

NW (top left corner)·

NE (top right corner; the default)·

SW (bottom left corner)·

SE (bottom right corner)·

See the 'Stack' and 'Stack Direction'
panels of the example diagram. Note that
the icon in the toolbar also reflects the
direction of stacking in the selected
element.

Set the Font,
Border Width
and Colors

These are standard options on the
Diagram and Element floating toolbars,
and apply to the Custom Styles as well as
to normally rendered elements.
Click on the element and on the  icon to
the right of the element to display the
Element toolbar, then:

To show the element text in a different·

font, click on the  icon; the 'Font'
dialog displays, on which you can set
the font type, style, size, color, effects
and script type from the lists in each
field
To apply different colors, click on one·
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or more of the  icons to set
the color of the text, element fill and/or
element border respectively; select the
appropriate color from the color palette
in each case or, if necessary, click on
the More Colors button to define a
custom color to use
To change the width of the element·

borders, click on the 'spinner' arrows to
set the border width to a value between
1 (the thinnest, default width) and 5
(the thickest width)

Subordinate Text

In Custom Diagram Style, if the element name does not
provide a sufficiently specific visual reference, you can use
the 'Description' Tagged Value to display a secondary text
string on the element. Apply these simple steps:

Click on the element and, if necessary, press Ctrl+2 to1.
display the Properties window for the element.

Click on the 'Tags' tab in the Properties window, and click2.
on the  icon in the toolbar to create a new Tagged
Value.

In the 'Tagged Value' dialog, in the 'Tag' field type3.
Description, and in the 'Value' field type <memo>. Click
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on the OK button.

On the 'Tags' tab, click on the  icon at the right-hand4.
end of the 'Description' field, and in the 'Tagged Value
Note' dialog type the text string to display. Click on the
OK button.

The element on the diagram now has a line across it5.
underneath the name (depending on the other Custom
Styles you have applied) with the text string below it.

Notes

Having applied custom styles to a diagram, you can toggle·

between the custom format and the formal notation simply
by enabling and disabling the 'Custom Style' option.

Be aware that manual changes to colors, border width and·

element position and size are reflected in both formats,
but the system can automatically resize elements to
accommodate text and compartment content, and that will
then be reflected in the custom appearance of the diagram
when you switch to it; therefore diagram layout might be
altered as you toggle between the formats

Similarly, if you reduce an element to the minimum size·

in Custom Style, when you deselect the 'Custom Style'
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option to turn it off, the element returns to its original size
to display all of its visible content

Custom Style and Info View Style are mutually exclusive;·

you do not apply both styles to the same element
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The Pan & Zoom Window

The Pan & Zoom window provides a 'birds-eye' view of
diagrams. It enables you to navigate quickly around large
diagrams.

Note that Dashboard diagrams are designed to automatically
size to the display screen, so the Pan & Zoom facilities are
grayed out when these diagrams are opened.

Access

Ribbon Layout > Tools > Pan and Zoom

Keyboard
Shortcuts

Ctrl+Shift+N
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Reference

Topic Detail

View The window shows a reduced image of
the whole diagram.
The shaded box represents the viewed
area, displayed on the open diagram.

Toolbar The toolbar provides these functions (in
order):

Zoom In·

Zoom Out·

Zoom to fit diagram·

Zoom to fit page·

Zoom to 100%·

Zoom Slider·

Use Open the required diagram.
Move the cursor onto the shaded box
inside the Pan & Zoom window.
Hold down the mouse button as you
move the cursor to move the shaded box
over the open diagram. As you do this,
the corresponding area is brought into
view on the open diagram.
To zoom, use either the Zoom Slider
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(drag the rectangle along the line) or the
buttons located on the tool bar (click on
the appropriate button).
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Auto Refresh

When working in a team environment, the Auto Refresh
feature assists in collaborative diagram design, by providing
improved support for multiple people giving input on the
same diagram and allowing users to monitor changes on a
specific diagram.

The automatic refresh mode is enabled when a user selects a
refresh interval on a diagram. This effectively prevents all
users from editing the diagram. The model database is
polled to check for changes to the diagram and the diagram
is reloaded from the database when changes are detected. To
make changes to the diagram, you must choose the 'Pause &
Edit' option, which allows you to make updates to the
diagram. Once you have finished making changes, you
select the 'Resume' option, whereupon diagram updates are
automatically saved to the database.

As a best practice, it is recommended that you lock the
diagram before enabling 'Pause & edit', and press Ctrl+S at
appropriate times so that the updated diagram is visible to
other users.

This feature is available in Enterprise Architect version 16.0
and later.

Access
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Ribbon Layout > Auto Refresh > Auto Refresh

Context
Menu

Right-click on diagram background |
Collaborate > Auto Refresh

Menu Options

These options are used to enable or disable the functionality,
to set the diagram refresh interval and to 'pause' the
auto-refresh setting to allow editing of the diagram. When
enabled a clock icon  is shown in the diagram icon panel.
When Pause & Edit is selected the pause icon  is shown.

Option Action

Disabled This is the default setting for all
diagrams. Click on the option if Auto
Refresh has been put into operation on
the diagram and you want to turn it off.
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Clicking on this option will also save any
pending changes to the diagram.

7 Enable automatic refresh mode for the
current diagram and set the refresh
interval to 7 seconds.

15 Enable automatic refresh mode for the
current diagram and set the refresh
interval to 15 seconds.

30 Enable automatic refresh mode for the
current diagram and set the refresh
interval to 30 seconds.

60 Enable automatic refresh mode for the
current diagram and set the refresh
interval to 60 seconds.

Pause & Edit Pause automatic refreshing of the
diagram and allow you, the current user,
to edit the diagram.

Resume Save any outstanding changes to the
diagram and resume automatic refresh of
the diagram, preventing any further
modification to it until either the
'Disabled' or 'Pause & Refresh' option is
applied.
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Layout Diagrams

As you develop a model diagram and add more elements
and connectors to it, you can apply one of a number of
formats to automatically lay out specific areas or sets of
elements in the diagram in a structured arrangement. If the
diagram is very simple, you could even use this facility to
lay out the entire diagram.

Additionally, you can provide filters and parameters for two
or three types of layout and then 'chain' the layouts so that
they are executed in sequence to result in a more refined
layout. You can select a system-defined chain, or one that
you have created yourself.

Access

Ribbon Layout > Tools > Diagram Layout >
Open Diagram Layout Tools

Context
Menu

Right-click a selected element on a
diagram | Layout Selected Elements
(available only when multiple elements
are selected)

Other Right-click on any toolbar | Diagram
Layout Tool : Select a Layout | Apply
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Layout

Lay out elements on a diagram

Ste
p

Action

1 Select the elements to lay out on the currently-active
diagram - hold Shift or Ctrl while you click on each
required element, or hold the mouse button down
while you sweep over the area containing the
required elements.
If no elements are selected on the active diagram,
then all elements on the diagram are laid out (except
where otherwise documented).

2 Click on the drop-down arrow on the top left field of
the Layout Tools window, and select the required
layout type:

Circle/Ellipse·

Box·

Per Page·

Digraph·

Spring·

Neaten·
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Converge/Diverge·

Fan Relations·

Auto Route·

The layout type determines the fields presented in
the window, therefore the appropriate fields are
described separately for each layout type.
If you want to apply a sequence or chain of diagram
layouts to a diagram, select either:

The appropriate system-defined chain name, or·

The name of a chain you have created yourself·

You can create and modify a 'Layout Chain' by
clicking on the  button in the dialog toolbar.

3 When you have completed the fields, click on the 
button.
The selected elements are reorganized into the
pattern format you have selected and according to
the options you have chosen.

4 If you do not want to work with the new layout, click
on the Undo button in the toolbar ( ).

Notes

If you have adjusted the settings for a layout, you can·
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automatically apply those settings to another diagram by
selecting the 'Layout > Tools > Diagram Layout > <layout
name>' ribbon option when you have opened the diagram

You can also automatically lay out an entire diagram,·

without specifying any format or filters, using the
alternative Layout Diagram facility

Nested elements will remain within their parent element·

when applying a layout
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Circular/Elliptical Layout

The Circle and Ellipse layouts arrange the selected elements
in a circle or elliptical pattern, using the largest horizontal
and vertical element edge in the set of elements when
calculating the radius of the layout arc.
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Invoke the Circular or Ellipse layout

Diagram A - Top To Bottom Layout

Ste
p

Action

1 Follow the general Layout Diagrams procedure, and
at step 2 select either 'Circle' or 'Ellipse' as required.

2 Click on the drop-down arrow in the 'Sort By' field
and select the required sort parameter:

None - elements are passed to the specified layout·

in the order in which they appear on the original
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diagram (left to right, top to bottom)
Area (Ascending) - elements are passed to the·

specified layout in order of the screen space they
occupy, smallest to largest
Area (Descending) - elements are passed to the·

specified layout in order of the screen space they
occupy, largest to smallest
Name (Ascending) - elements are passed to the·

specified layout in alphanumeric order, based on
the element name
Name (Descending) - elements are passed to the·

specified layout in reverse alphanumeric order,
based on the element name
Element Type - elements are grouped by type (for·

example, Class, Use Case) and in alphanumeric
order within the group by name

3 Under the 'Placement' option, select either:
Top to Bottom - the elements are positioned in the·

required order, zig-zagged across the perimeter of
the circle or ellipse, as in Diagram A
Circular - the elements are placed in the required·

order, clockwise around the perimeter of the circle
or ellipse, as in Diagram B

4 Select the 'Center focused element' checkbox to put
the last-selected element (the one with the hashed
border) in the center of the circle or ellipse, as in
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Diagram C.

Diagram B - Circular Layout

Diagram C - Center Focused Element
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Box Layout

The Box layout arranges the set of selected elements into a
square grid.

The dimensions of the box are determined by the number of
columns that either:

You set manually or·

The system automatically sets to a value that results in the·

same number of columns and rows (for example, 5, 6, 7, 8
or 9 elements would all be arranged in a three-column
rectangle).

Invoke the Box layout

Ste
p

Action
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1 Follow the general Layout Diagrams procedure, and
at step 2 select 'Box'.

2 Click on the drop-down arrow in the 'Sort By' field
and select the required sort parameter:

None - elements are passed to the specified layout·

in the order in which they appear on the original
diagram (left to right, top to bottom)
Area (Ascending) - elements are passed to the·

specified layout in order of the screen space they
occupy, smallest to largest
Area (Descending) - elements are passed to the·

specified layout in order of the screen space they
occupy, largest to smallest
Name (Ascending) - elements are passed to the·

specified layout in alphanumeric order, based on
the element name
Name (Descending) - elements are passed to the·

specified layout in reverse alphanumeric order,
based on the element name
Element Type - elements are grouped by type (for·

example, Class, Use Case) and in alphanumeric
order within the group by name

3 In the 'Padding (px)' field, type the vertical and
horizontal distance between elements, in pixels.

4 Select the appropriate element distribution option:

(c) Sparx Systems 2022 Page 1418 of 1974



Modeling Fundamentals 3 October, 2022

Automatically distribute: Automatically calculate·

the dimensions of the box (the square root of the
number of selected elements; for example, 16
elements create a 4x4 box)
Specify distribution: Manually define the width of·

the box, in columns

5 If you selected 'Specify Distribution', in the
'Columns' field type the required number of columns.
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Per Page Layout

The Per Page layout divides each diagram page into a
number of cells, which house the selected elements. The
number of cells per page is determined by the page
distribution parameter.

Invoke the Per Page layout

Ste
p

Action
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1 Follow the general Layout Diagrams procedure, and
at step 2 select 'Per Page'.

2 Click on the drop-down arrow in the 'Sort By' field
and select the required sort parameter:

None - elements are passed to the specified layout·

in the order in which they appear on the original
diagram (left to right, top to bottom)
Area (Ascending) - elements are passed to the·

specified layout in order of the screen space they
occupy, smallest to largest
Area (Descending) - elements are passed to the·

specified layout in order of the screen space they
occupy, largest to smallest
Name (Ascending) - elements are passed to the·

specified layout in alphanumeric order, based on
the element name
Name (Descending) - elements are passed to the·

specified layout in reverse alphanumeric order,
based on the element name
Element Type - elements are grouped by type (for·

example, Class, Use Case) and in alphanumeric
order within the group by name

3 In the 'Padding (px)' field, type the vertical and
horizontal distance between cells, in pixels.

4 Select the appropriate page distribution option:
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Automatically distribute: automatically calculate·

the optimum number of cells, taking into
consideration the largest horizontal and vertical
element edges
Specify distribution: manually enter the per page·

grid dimensions

5 If you selected 'Specify Distribution', in the 'Rows'
and 'Columns' fields type the required number of
rows and columns.

6 Select the 'Center Elements' checkbox to place each
element in the center of its cell; otherwise the
element placement defaults to the top left corner of
the cell.

7 In the 'Start Page' field, type the number from which
to start the page numbering; pages begin at the top
left and continue horizontally to the right.
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Digraph Layout

The Digraph layout arranges the selected elements into a
directed graph ('digraph' for short). The Digraph attempts to
highlight the hierarchy of the elements while keeping the
direction of all connectors pointing to the same edge of the
diagram.

The Digraph layout provides the same behavior as the
Automatic Diagram Layout.
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Spring Layout

The Spring layout uses a force-directed approach to arrange
the selected elements organically. It employs a physical
analogy to lay out elements; each element is treated as a
particle with a like electrical charge that repels other
elements. Connectors act as springs (hence the name Spring
layout) that draw connected elements back together. The
layout is good for highlighting clusters of related objects
and identifying symmetry in the graph.
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Invoke the Spring layout

Ste
p

Action

1 Follow the general Layout Diagrams procedure, and
at step 2 select 'Spring'.

2 In the 'Iterations' field, type the number of iterations,
or rounds, to perform to reach the final layout.
The layout is developed over several iterations;
depending on the complexity of the graph, increasing
the number of iterations produces a better result but
takes longer to calculate.

3 If the diagram contains elements that significantly
vary in size, and that might overlap in the final
layout, select the 'Scale to prevent overlap' checkbox
to scale up the positions of the selected elements
(preserving size) until no elements overlap.
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Neaten Layout

The Neaten layout attempts to pull the selected elements
into a grid based on their horizontal and vertical proximity
to each other. That is, the layout pulls elements that are
roughly aligned into a neater arrangement. Elements that
share the same row or column are aligned based on the
'Column' and 'Row Snap' parameters. The arrangement
shown for the Spring layout, when the Neaten layout is
applied, might resemble this:

Invoke the Neaten layout
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Ste
p

Action

1 Follow the general Layout Diagrams procedure, and
at step 2 select 'Neaten'.

2 In the 'Threshold (px)' field type the separation, in
pixels, up to which elements are considered to be in
the same row or column.
A higher threshold value produces a tighter result,
pulling elements that are far distant into the same
row or column. A lower threshold value provides for
a larger number of rows and columns.

3 In the 'Column Snap' field, click on the drop-down
arrow and select the appropriate alignment for
elements in the same column:

Left - elements are aligned with the left edge of·

the left-most element in the column
Center - elements are aligned with the vertical·

center of the center-most element in the column
Right - elements are aligned with the right edge of·

the right-most element in the column

4 In the 'Row Snap' field, click on the drop-down
arrow and select the appropriate alignment for
elements in the same row:

(c) Sparx Systems 2022 Page 1427 of 1974



Modeling Fundamentals 3 October, 2022

Top - elements are aligned with the top edge of the·

highest element in the row
Center - elements are aligned with the horizontal·

center of the center-most element in the row
Bottom - elements are aligned with the bottom·

edge of the lowest element in the column

Notes

To prevent elements from overlapping in the neatened·

layout, check that the appropriate left, right, top, bottom,
vertical center or horizontal center values of the elements
(as dictated by the 'Column Snap' and 'Row Snap' options
you select) are greater than the value in the 'Threshold'
field
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Converge/Diverge Layout

The Converge layout attracts the set of selected elements
towards the center of their bounding rectangle. Conversely,
the Diverge layout repels the set of selected elements away
from the center of their bounding rectangle. The
Converge/Diverge layout also tries to maintain connector
angles if an element in the set contains a connector with
waypoints.

Invoke the Converge/Diverge layout
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Ste
p

Action

1 Follow the general Layout Diagrams procedure, and
at step 2 select 'Converge/Diverge'.

2 Select the radio button for the required direction of
the layout:

Converge - attracts the set of selected elements to·

the center point
Diverge - repels the set of selected elements from·

the center point

3 Set the 'Amount (%)' slider to the required
percentage. A smaller percentage provides finer
control of the change in layout.
The slider determines how far the elements are
moved towards or away from the center point; the
movement is the element's current distance from the
center point multiplied by the percentage value set
on the slider.
In the Converge layout, the element moves towards
the center point; in the Diverge layout the element
moves further away from the center point.
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Fan Relations Layout

The Fan Relations layout arranges the immediate relations
of an element around a specified edge. This layout requires
a single element to be selected on the diagram, to be used as
the context for the layout.

Invoke the Fan Relations layout

Ste
p

Action

1 Open the Layout Tools window; either:
Select the 'Layout > Tools > Diagram Layout'·

ribbon option, or
Right-click on the main toolbar and select the·
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'Diagram Layout Tools' option

2 Select the single element around which to lay out
related elements on the currently-active diagram.

3 Click on the drop-down arrow on the top left button
of the Layout Tools window, and select Fan
'Relations'.

4 Click on the drop-down arrow in the 'Sort By' field
and select the required sort parameter.
The options are:

'None' - elements are passed to the specified layout·

in the order in which they appear on the original
diagram (left to right, top to bottom)
'Area (Ascending)' - elements are passed to the·

specified layout in order of the screen space they
occupy, smallest to largest
'Area (Descending)' - elements are passed to the·

specified layout in order of the screen space they
occupy, largest to smallest
'Name (Ascending)' - elements are passed to the·

specified layout in alphanumeric order, based on
the element name
'Name (Descending)' - elements are passed to the·

specified layout in reverse alphanumeric order,
based on the element name
'Element Type' - elements are grouped by type (for·
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example, Class, Use Case) and in alphanumeric
order within the group by name

5 In the 'Padding (px)' field, type the separation
required between the selected element and its related
elements, in pixels.

6 Select the connector direction to use in determining
the related elements to lay out; either:

Incoming Nodes - to lay out related elements that·

have the selected element as the target
Outgoing Nodes - to lay out related elements that·

have the selected element as the source

7 In the 'Fan Edge' field, click on the drop-down arrow
and specify the edge of the selected element from
which to lay out the related elements:

Left - to arrange related elements to the left of the·

selected element
Right - to arrange related elements to the right of·

the selected element
Top - to arrange related elements from the top of·

the selected element
Bottom - to arrange related elements from the·

bottom of the selected element
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Auto Route Layout

The Auto Route layout orthogonally routes connectors
between the selected elements. The layout attempts to find
the shortest path between the two connected elements while
minimizing crossings. In this illustration, the original
connectors are shown in red.

Invoke the Autoroute layout

Ste
p

Action

1 Follow the general Layout Diagrams procedure, and
at step 2 select 'Auto Route'.
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2 In the 'Cell Size (px)' field, type the effective
connector separation in pixels.
When calculating connector routes, the algorithm
divides the diagram into cells of a size determined
by this field value; a smaller cell size results in
connectors being placed closer together.

3 In the 'Element Margin' field, type the separation
between connector segments and element borders, in
pixels.
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Lay Out a Diagram Automatically

As you develop a diagram, it can become difficult to
position the elements and connectors so that the layout and
organization remain clear. Rather than continually moving
structures around manually, you can simply select a 'Layout
Diagram' option to automatically reposition all the structures
on the diagram in a logical, tree-based structure. If your
diagram is complex, you can then do some manual
'tweaking' to draw out particular elements and relationships.

Generally the default layout parameters provide adequate
layouts for a wide range of diagrams, but for a fine degree
of control you can also set layout parameters using the
'Diagram Layout Options' dialog.

Access

Ribbon To configure settings:
Design > Diagram > Manage >·

Properties > Diagram: Set Layout Style
or
Layout > Diagram > Options >·

Properties > Diagram: Set Layout Style
(on an open diagram)

Context To configure settings:
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Menu Right-click on diagram | Properties >·

Diagram: Set Layout Style

Other To configure settings:
Double-click background of diagram >·

Diagram : Set Layout Style

To apply layout:
diagram toolbar :  Auto Layout·

Apply Layout Configurations

Option Action

Cycle
Remove
Options

These settings remove cycles in the
element organization (where element X is
the source of a path but also becomes the
target of a branch of the path), by
reversing the connectors that impose the
cycling and then reorganizing the
diagram and reinstating the reversed
relationships; this identifies the primary
source element in the diagram. Select:

Greedy - to use the Greedy Cycle·

Removal algorithm, which minimizes
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the number of connectors reversed
Depth First Search - to use the Depth·

First Search Cycle Removal algorithm,
which establishes the longest linear
sequence possible before establishing
parallel sequences and branches; this
algorithm is less effective in large
and/or complex diagrams, but produces
a more natural layout than the Greedy
algorithm

Crossing
Reduction
Options

These options determine the length of
time the routine searches for ways of
reorganizing the layout to avoid crossed
relationships:

Iterations - Type the number of·

iterations to be used during cycle
removal (more than 8 does not usually
provide any improvement)
Aggressive - Select this checkbox to·

use an aggressive (detailed and
time-consuming) crossing reduction
step

Layering
Options

These settings determine how elements
are organized in layers during layout.
Select:

Longest Path Sink - to use the Longest·

Path Sink Layering algorithm, where

(c) Sparx Systems 2022 Page 1438 of 1974



Modeling Fundamentals 3 October, 2022

the final target elements (sinks, which
have no relationships issuing from
them) are arranged in a layer at the top
of the diagram, and the relationship
paths built downwards from there in as
many layers as there are nodes in the
longest path
Longest Path Source - to use the·

Longest Path Source Layering
algorithm, where the original source
elements (those with no relationships
entering them) are arranged in a layer
at the bottom of the diagram and the
relationship paths built up from there in
as many layers as there are nodes in the
longest path
Optimal Link Length - to use the·

Optimal Link Length Layering
algorithm, which organizes the
elements into the number of layers that
minimizes the total source-to-sink
relationship chain; in this layout you
can have both source elements and sink
elements at various levels of the
diagram

Layout
Options

These settings define how far apart the
element layers and columns are in the
layout.
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Layer Spacing - Type the default·

number of logical units between layers
of elements (vertical spacing)
Column Spacing - Type the default·

number of logical units between
elements within a layer (horizontal
spacing)

Initialize
Options

The autolayout routine inserts line
waypoints and connectors into
relationship paths to help plot the
direction of the relationships; the routine
then assigns an index number to every
node, such that nodes in the same layer
are numbered left to right. These settings
determine how those index numbers are
assigned. Select:

Naive - to use the Naive Initialize·

Indices algorithm, which assigns index
numbers to nodes as they are
encountered in a sweep and tends to
place all waypoints to the right of real
nodes (and therefore long relationships
between a small number of elements to
the right of chains of short relationships
between several elements)
Depth First Search Outward - to use the·

Depth First Out Initialize Indices
algorithm, which assigns index
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numbers to nodes as they are
encountered in a depth first search from
source nodes outwards (and would
therefore place longer relationship
chains to the left of shorter chains, with
the primary source node at the start of
the diagram flow)
Depth First Search Inward - to use the·

Depth First In Initialize Indices
algorithm, which also assigns index
numbers to nodes as they are
encountered in a depth first search, but
from sink nodes inwards (and would
therefore place longer relationship
chains to the left of shorter chains, with
the ultimate target node at the end of
the diagram flow)

Direction Select the direction in which all directed
connectors should point, to set the
position of the primary source element
and the overall flow of the diagram. That
is, Up, Down, Left, or Right.

Set as Project
Default

Select this checkbox to apply the diagram
layout settings to all diagrams in the
project.
If you later define different settings and
select this checkbox, the new settings
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override all those saved previously.

OK Click on this button to save your settings.

Example

This illustration shows an automatically laid out diagram
with these options set:

'Depth First Search'·

'Optimal Link Length'·

'Depth First Search Outward'·

'Direction - Up'·
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Notes

This facility is available for all types of diagram other·

than Timing and Interaction Overview diagrams

If you decide that the autolayout is not appropriate, you·

can reverse it before saving the diagram; click Ctrl+Z
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Chain Diagram Layouts

Each of the diagram layout formats has a specific effect on
the layout and appearance of a diagram. These effects can
be combined by chaining certain layouts in a sequence, to
further improve the final appearance of the diagram.
Enterprise Architect provides a selection of standard 'chains'
for your use, and you can quickly and easily set up chains of
your own.

The system does not restrict the way in which you combine
the layouts, but in practice some layouts complement each
other better than others, or are more logically executed in a
certain order. You therefore need to consider the effect of
each layout on the diagram - or part of the diagram - as you
develop the chain. You also provide parameters for each
layout, so you would set the parameters for each format to
complement those for the other formats in the chain, using
the 'Layout Chains' dialog.

The available formats could be grouped by impact on the
diagram:

Circle, Ellipse, Box, Per Page, Digraph and Spring each·

adjust element positions completely, so would destroy the
effects of any other layout if used after it in a chain; one
of these would therefore be the first layout to apply in the
chain

Fan Relations operates on a specific element, so you·

might not want to further adjust the diagram layout; if you
did, you would only use these next layouts
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Converge/Diverge could be used after some of the·

preceding layouts, to broaden or narrow the final layout

Neaten is a logical successor to the previous types,·

adjusting positions to provide more uniform separation

Auto-route is the best final layout, to adjust connectors to·

the clearest routes without changing element positions

In creating a chain of layouts, you might consider these
suggestions in selecting which layouts to use and in which
sequence.

Access

Ribbon Layout > Tools > Diagram Layout >
Open Diagram Layout Tools: 

Other Right-click on any toolbar | Diagram
Layout Tools: 

Set up a chain

On the 'Layout Chains' dialog:

Ste
p

Action
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1 Either:
Click on the New Chain button and type in a new·

chain name (and click on the OK button) or
Click on the drop-down arrow and select the name·

of an existing chain to edit
If you want to delete the existing chain you have
selected, click on the Delete Chain button.
If you want to rename the existing chain, click on the

 button and overtype the existing name with the
new name (and click on the OK button).

2 In the 'Existing Layouts' field, click on the first
layout to execute in the chain, then click on the 
button to add it to the chain.
Repeat this step to add further layouts to the chain.

3 If you do not want to include a layout that is
currently in the chain, click on it and click on the

 button.
If you want to move a layout in the chain to a
different point in the sequence, click on it and click
on the  or  button as appropriate.

4 If you want to change the name of a layout, click
once on the name in the chain list and overtype it.
To set the parameters of each layout, double-click on
the layout name in the chain list. The appropriate
parameter dialog for the layout displays; complete
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the fields as appropriate and click on the OK button.
These are the parameters that will be applied
whenever you execute this layout chain, regardless
of the settings in any other use of the layout.

5 Click on the Save Chains button to save your
changes, then click on the OK button.
(If you have not saved your changes, an error
message displays; click on the Yes button.)
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Image Assets

Image Assets are model elements that are used to store
images in the model.

To create an Image Asset element, simply drag an 'Image
Asset' icon onto a diagram from the 'Artifact' page of the
Diagram Toolbox. A prompt displays to choose an image
file.

Alternatively, you can drag an image file from your file
system straight onto a diagram. Enterprise Architect creates
a new Image Asset Artifact, then stores the image from the
file in the Artifact, as the 'owned image'.

The Image Asset images can then be used as alternative
images in place of the standard UML notation for elements
on diagrams. They can also be used in documentation by
inserting hyperlinks to the Image Asset element. When a
report is generated, the hyperlinked Image Asset element is
rendered using its 'owned image'.

Access

Diagram
Toolbox

Select the 'Common Elements' page |
select 'Image Asset' | click on the
diagram, or
Drag an 'Image Asset' Artifact from the
Toolbox onto a diagram.
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Other Select an image file in your file system
(say, on the desktop) then drag and drop
it onto a diagram in Enterprise Architect.
A context menu will display; select the
option 'Image Asset'.

Using Image Assets in Documentation

Step Action

1 While editing the Notes of an element, or
editing a Linked Document, and if you
have located the Image Asset in the
Browser window, you can drag the Image
Asset element into the document. The
'Add Content to Document' dialog
displays with the 'Insert As' field set to
'Insert as Hyperlink(s)'. Click on the OK
button to insert the element as a hyperlink
that will be rendered as the image.
If you need to search for the Image Asset,
go to step 2.

2 Right-click in the document and choose
'Create | Hyperlink'. The 'Hyperlink

(c) Sparx Systems 2022 Page 1450 of 1974



Modeling Fundamentals 3 October, 2022

Details' dialog displays.
Select 'Element Image' from the drop
down list. The 'Select Element' dialog
displays, showing only Image Assets.

3 Browse through the model and select the
required Image Asset.

4 Click on the OK button, and on the
second OK button.

Select an Image Asset as an Element's
Alternative Image

You can use one of two methods for adding an Image Asset
to an element as an alternative image.

Method Action

1 Right-click an element on a diagram1.
and choose the option 'Appearance |
Select an Image Asset' from the context
menu. The 'Select Element' dialog
displays, showing only Image Asset
elements in Packages.
Browse through the model and select2.
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the required Image Asset.
Click on the OK button.3.

2 Display the diagram containing the4.
model element.
Locate the Image Asset in the Browser5.
window.
Drag the Image Asset over the top of6.
the model element.
Select the 'Set as Alternate Image'7.
option.

Viewing the Image

When initially placed on the diagram the Image Asset can
be rendered either as a simple Artifact element, or as the
owned image. The display can be toggled from one to the
other, by right-clicking the element and selecting 'Show
Owned Image' from the context menu.

When the Image Asset is displayed on a diagram as a UML
Artifact element, either:

Click on the  icon off the right side of the element; the·

linked image is shown in a floating Diagram Pop-up
window - you can pan across large images in the pop-up
window by 'click + dragging' the mouse and you can close
the window by clicking off the diagram image,  or
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Double-click on the Image Asset to launch the default·

external viewer for images and load the Artifact's owned
image

You can also press Ctrl+click on a hyperlink to an Image
Asset to display the image in the default external viewer.

When hovering over the hyperlink, the standard hyperlink
element buttons will also be displayed, allowing you to
display the 'Properties' dialog, find the element in diagrams,
find the element in the Browser window, or open the Linked
Document attached to the element.

Properties

To display the Properties window for the Image Asset:

Select the element and press Ctrl+Enter, or·

If the Image Asset is displayed on a diagram as the image,·

double-click on it, or

If the Image Asset is referenced by a hyperlink, hover the·

mouse over the hyperlink to display a floating toolbar and
click on the View Properties button
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Using the Image Manager

When you add an element to a diagram, it is rendered
according to the standard UML notation. However, you can
replace that representation with an image. For example, you
could add a custom background image to a diagram, or
display an image of a Router or PC on a UML element. You
import, store and select these alternative images using the
Image Manager. You can apply the image either as a:

Default image, which displays on all instances of the·

element in diagrams across the model, or

An alternative image, which displays only for the specific·

instance of the element to which it is applied, and which
overrides the default image for that instance

To locate and display images within the Image Manager,
click on individual image filenames, or press the Up arrow
and Down arrow keys to scroll through the list of images.
As you highlight each image filename, the 'Preview' panel
changes to reflect the image. Double-click on the required
image filename to display the image in full size.

Another option for displaying an image on a diagram is to
simply drag an image file onto a diagram from the operating
system file manager. For more details see the Create File
Artifacts Help topic.

Access
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Ribbon Settings > Reference Data > Images

Context
Menu

Right-click on an element within a
diagram | Appearance | Select Alternate
Image or
Right-click on an element within a
diagram | Appearance | Select Default
Image

Keyboard
Shortcuts

Click on an element within a diagram :
Ctrl+Shift+W

Image Manager Options

On the Image Manager, these buttons are available:

Button Action

View Click on this button to display the
selected image in full size.
Shortcut: Alt+V

Usage Click on this button to display the
'Element Usage' dialog, which lists the
diagrams in which the selected image is
used.
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Rename Click on this button to change the
filename of the selected image.
The option first warns you that the
change would impact the other elements
that use this image, and prompts you to
confirm that you want to go ahead with
the name change.
If you continue, a prompt displays for
you to enter the new filename.

Add New Click on this button to display options for
importing images from a file system or
from the clipboard.

From File - select this option to display·

a browser through which you can
search appropriate directories to locate
and import new images
You can import images in .bmp, .png,
.emf, .wmf, .tga, .pcx or .jpg format
From Clipboard - select this option to·

download the image from the clipboard
into the Image Manager (not via a
diagram)

Internally, the images are stored in .png
or metafile format to conserve space.
You can also add images by:

Importing a library of alternative·

images from the Sparx Systems
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website
Copying the Image Library from·

another model using the 'Export
Reference Data' and 'Import Reference
Data' facilities, and
Capturing images from other sources·

into the clipboard and applying them to
an element in a diagram, which
automatically adds the image as an
autonamed file to the Image Library

If necessary, you can change the file
name using the 'Rename' option.
Shortcut: Alt+A

Update
Selected

Click on this button to refresh the
selected image; for example, after it has
been modified.
A browser screen displays for you to
select the updated image file from its
parent directory.
Shortcut: Alt+U

Add
Description

Displays the 'Image Description' dialog,
in which you enter a title for the image
and a brief description to identify any
significant facts about the image, such as
its purpose, of the version it represents.
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Convert to
Image Asset

Displays a message warning that the
image will be converted to an Image
Asset Artifact in the currently-selected
Package. The image will be removed
from the Image Manager and can no
longer be applied to another element, but
the Image Asset element itself can be
added to diagrams and called into
documentation via a hyperlink.

Delete (Not available for an image from a
deployed MDG Technology.)
Click on this button to delete the selected
image.
A message displays to indicate how many
elements use the image. Click on the Yes
button to delete information about the
image from those elements, which then
revert to their previous appearance.
Shortcut: Alt+D

Cancel Click on this button to close the Image
Manager.

OK Click on this button to confirm selection
of the alternative image for the element
selected in the diagram.
Shortcut: Alt+O
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Notes

If you do not want an element to continue to have a·

default image or an alternative image, assign it the
'--NONE--' option in the image list

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Configure Images' permission to configure alternative
element images

If you are connected to a SQL Server repository, you·

require ALTER permission on the t_image table in
Enterprise Architect, to be able to import model images

For elements with Lifelines, such as those used on·

Sequence diagrams, the Lifeline must remain intact so
that messages can be created between the elements;
therefore such elements cannot have alternative images

There are two categories of image available through the·

Image Manager:
     -  Images that have been imported into the model and
are stored in the model
     -  Images that are incorporated into a deployed MDG
Technology, which are not copied into the
        current model but are held in memory; the
technology images can be identified by the Technology
        name followed by the image file name, such as
'MDGFrame::ovalshape.emf', but can also be
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        accessed by their short form (the name minus the
technology name)

If you are creating many elements of the same type that·

have a particular image, you should use a custom
stereotype with an associated metafile

If an element has an image, the element name is likely to·

be hidden; you can display the name underneath the
image by right-clicking on the element and selecting
'Appearance | Show Name Under Image', and hide it again
by selecting 'Appearance | Hide Name Under Image'

You can transport image files between models, using the·

'Settings > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options

(c) Sparx Systems 2022 Page 1460 of 1974



Modeling Fundamentals 3 October, 2022

Create Custom Diagram Background

Enterprise Architect provides a number of options for
setting the background of a diagram - a Theme, a
system-defined tile background, a single-color flat
background or a fading color gradient down the screen.

Alternatively, using the Image Manager, you can create a
customized tiled or non-tiled background for your diagrams.

Create a customized background

Ste
p

Action

1 Check that a suitable image is available in the Image
Manager. If the image you require is held elsewhere,
import the file or the library containing the file.

2 Open a diagram and create a Boundary object from
the 'Use Case Elements' page of the Toolbox (do not
use the Boundary element from any other section of
the Toolbox).

3 Stretch the Boundary to a size that can contain all of
the elements you intend to place on the diagram, and
drag it to the edges of the diagram workspace.
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4 Right-click on the Boundary element and select the
'Z-Order | Send to Bottom' option.
This places the Boundary behind all other elements
on the diagram.

5 Either:
Press Ctrl+Shift+W, or·

Right-click on the Boundary and select the·

'Appearance | Alternate Image' option

6 On the Image Manager window, select the required
image for the diagram background and check that the
image size is large enough to span the required size
of the diagram background.

7 Click on the OK button.

Notes

As an alternative method: after you have added the·

Boundary element to the diagram, copy an image from
another source onto the Windows clipboard, right-click on
the Boundary element, and select the 'Appearance | Apply
Image From Clipboard' option
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Import Image Library

Using the Image Manager, you can create attractive
diagrams with custom images. You can quickly extend the
range of images available through the Image Manager, by
importing a bundled clip art collection of UML-based
images as an Image Library file downloaded from the Sparx
Systems website.

Import the Image Library file

Ste
p

Action

1 Download the Image Library from the Sparx
Systems website onto your system.

2 In Enterprise Architect, open the project into which
to import the Image Library.

3 Select the ribbon option 'Settings > Model >
Transfer > Import Reference Data'. The 'Import
Reference Data' dialog displays.

4 Click on the Select File button and locate the
ImageLibrary.xml file to import, in the directory to
which you downloaded the file.
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Click on the Open button.

5 On the 'Import Reference Data' dialog, select the
'Model Images' data set that now contains the Image
Library.
Click on the Import button and, when the import is
complete, the OK button.

Use the images contained within the Image
Library

Ste
p

Action

1 Create and/or open a diagram in which to use images
from the Image Library.

2 Click on the element to which to apply one of the
images contained within the library.

3 Either:
Press Ctrl+Shift+W, or·

Right-click on the selected element and select the·

'Appearance | Select Alternate Image' option

(c) Sparx Systems 2022 Page 1464 of 1974



Modeling Fundamentals 3 October, 2022

4 On the 'Image Manager' dialog, in the 'Loaded
Images' panel, click on the appropriate image name
and then on the OK button.
The element appearance changes to the selected
image.

Notes

Images contained within the Image Library are the·

copyright of Sparx Systems, are only available for use in
conjunction with Enterprise Architect, and are supplied on
the understanding that they are not used under any other
circumstances

If you are connected to a SQL Server repository, you·

require ALTER permission on the t_image table in
Enterprise Architect, to be able to import model images
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Diagram List

The Diagram List is a tabular, editable view of elements in a
selected diagram, which can be displayed in the main
workspace. You can use the Diagram List to:

Streamline the process of creating and updating elements·

in a diagram selected from the Browser window; this can
be particularly useful for analysts to create and maintain
formal requirement definitions within the model

Print the list or generate a document report directly from·

the entries on the list

Access

Ribbon Design > Diagram > Views > List View

Context
Menu

Right-click on diagram background |
Switch View | Switch to List View   or
Right-click on diagram tab | Switch to
List View

Keyboard
Shortcuts

Ctrl+Alt+R (opens a new view, as a list)
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Aspects

Aspect Description

The Diagram
List

The Diagram List is related to the
Package Browser, which lists the
elements in a selected Package; however,
the Package Browser has a wider range of
options.

Formats The Diagram List is displayed in 'User
Defined' format, where you can change
how the element information is structured
on the screen using the value-grouping
band below the toolbar.

Change
display

Sort the items by any column value in·

ascending or descending order, by
clicking on the column header; initially
the elements are listed in numerical
order (if level numbering is turned on
in the Browser window) or alphabetical
order within type
Apply a diagram filter for elements (the·

Fade, Gray Scale and Hide modes
reduce the number of elements listed;
Select mode has no effect)
Change the sequence of columns, by·
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dragging column headers left or right

Display
Element
Properties

Double-click on the element entry.

Select Items Select:
an element by clicking on it·

a specific value by clicking twice on it·

(not double-clicking); either the value
becomes directly editable or the
'Properties' dialog displays in which
you can edit the value
several individual elements by holding·

Ctrl as you click on them
a range of elements by holding Shift as·

you click on the first and last in the
range

Add new
items to the
diagram

Create new elements on the Diagram
List, using the toolbar or context menu
options; these elements are automatically
added to the diagram.

Delete
elements
from the list

Select the item and press Ctrl+D.

Include each
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element's
notes
(documentati
on)

Notes are shown underneath the element.
To add or edit notes, click on the item
and press Ctrl+Space to transfer control
to the Quick Notes window, in which you
create or edit the note text.

Review the
element's
custom
(advanced)
properties

Right-click on the item and select the
'Properties' option, then select the
'Advanced' page.

Further
Options

You can do further work on the Diagram
List using the same toolbar and context
menu options as for the Package
Browser, except that the Diagram List
does not have:

The Model Hierarchy format and hence·

does not have the  button in the
toolbar

The  toggle button·

The  toggle button·

The Diagram List does have these
additional context menu options:

Switch to Diagram View - show the·

elements of the selected diagram in
graphical format instead of as the
Diagram List
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Switch to View as Gantt - list the·

diagram elements as bars of a Gantt
chart, representing the elements'
resource allocations
Switch to Specification Manager - list·

the diagram elements with their notes
and various other properties in the
Specification Manager
Switch to Traceability View - list the·

elements on the diagram as entries in
the Traceability window, which you
can expand to show the connectors and
related elements of each element on the
diagram
Diagram Properties - display the·

'Properties' dialog for the diagram
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Alternative Views of Diagram Content

By default, a diagram always opens in graphical view.
Enterprise Architect supports several alternative ways of
viewing the content of the diagram after it has been opened.
From the graphical view, you can switch the diagram
content to display in:

List view·

Gantt view·

Specification view·

Relation Matrix view or·

Construct view·

It is also possible to change the default view on opening of a
specific diagram, to List View, Specification View or Gantt
View, through the diagram's 'Properties' dialog.

Access

You can switch an open diagram to an alternative view
using any of these methods:

Ribbon Design > Diagram > Views >  <type>
View

Context
menu

Right-click on diagram background |
Switch View | Switch to  <type> View
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or
Right-click on diagram tab | Switch to
<type> View
In Browser window, right-click on the
diagram name | Switch View | Switch to
<type> View

Properties
window

Diagram > Appearance > Display As :
Select <type> from drop down.

Diagram View Types

View Type Description

Graphical
View

The traditional view of a diagram.  Model
elements are depicted as shapes, with
relationships between elements
represented as lines drawn between the
elements.  New elements and connectors
can be created by dragging the
appropriate type from the Diagram
Toolbox onto the diagram.
After you switch from the graphical view
to another view, you can immediately
return to the graphical view by clicking
on the black back-arrow in the diagram
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name tab, even if you have worked
through a chain of views.

List View The Diagram List is a tabular, editable
view of elements in a selected diagram.
It can be used to streamline the process of
creating and updating elements in a
diagram.

Gantt View The Gantt view presents the elements of
the selected diagram, in the form of a
Gantt Chart.  This allows you to review
the allocation of work to elements in just
the selected diagram, focusing on either
the elements that require work or the
resources required to perform the work.

Specification
View

The Specification View displays the
contents of the selected diagram, in the
form of a document.  It is ideal for
creating and updating Requirements
elements, or any elements that involve
extended textual descriptions.

Relation
Matrix View

The Relation Matrix view is a grid that
identifies the relationships between the
diagram elements.  There is both a row
and a column corresponding to each
diagram element - the cell at the
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intersection of a row and a column shows
the relationship details between the
corresponding diagram elements.  This
view provides a means to quickly find
elements that are not yet connected to
other elements, such as Requirements that
are not yet realized.  You can also create
new relationships directly in the matrix.

Construct
View

The Construct View is an aid to Project
Management, that facilitates easy review
of the Resources and Maintenance items
associated with elements appearing on
the selected diagram.  You can filter the
view to show resources, or a single
category or all categories of Maintenance
items.

Learn more

Diagram View (check Inline Specification)·

Diagram Properties - Detail·
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User and Model Default Diagrams

As you develop your model, you might create a central
diagram that represents the current area of work or the
direction of development, with hyperlinks to other diagrams
and resources, thus creating a Home Page for your model.
You could set this diagram to open automatically when you
access the model at the start of a work session. You have
two options for configuring such a diagram:

As your user default, so that the diagram opens when you·

(or, if appropriate, members of your log-in group) access
the model but not when any other user opens the model

As your model default, so that the diagram opens when·

any user opens the model

You can have separate diagrams defined as a user default
and as a model default, in which case the user default
diagram takes precedence and is the diagram that opens
automatically. However, both diagrams are overridden by
any project shortcut that defines displays to present on
opening the model.

The options to set default diagrams are available in the
Corporate, Unified and Ultimate Editions of Enterprise
Architect; User Security must be enabled and you must have
'Manage Project Settings' permission to set a diagram as a
user or model default.

Set User Default Diagram
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Make the current diagram the default diagram displayed
when you re-open this model.

Start > Personal > My Diagram > Manage > Set Current·

as Default (if the required diagram is open and active)

Start > Personal > My Diagram > Manage > Choose·

Default (to browse for the required diagram)

Once you select this diagram, it will display automatically
when you open the model.

Set Model Default Diagram

Make the current diagram the default diagram displayed
when any user re-opens this model.

Start > Collaborate > Model Home > Manage > Set·

Current as Default (if the required diagram is open and
active)

Start > Collaborate > Model Home > Manage > Choose·

Default (to browse for the required diagram)

Once you select this diagram, it will display automatically
when any user opens the model.

Managing Default Diagrams

If you have closed a default diagram and want to return to it,
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use one of these options:

Start > Personal > My Diagram > Open My Diagram·

Start > Collaborate > Model Home > Open Model·

Diagram

In the Diagram Status Bar, click on the drop-down arrow·

on the right and select the 'User Default Diagram' or
'Model Default Diagram' option as appropriate, or

If you want to change either the user default diagram or the
model default diagram, use the 'Set' options as described
previously, and select a different diagram.

If you want to clear a default diagram, so that you no longer
have a default, select one or both of these options:

Start > Personal > My Diagram > Manage > Clear·

Start > Collaborate > Model Home > Manage > Clear·
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Print Diagram

The 'Print Diagram' facility allows you to print any open
model diagram to any available printer.

Firstly, open the diagram in the main work area, then choose
the 'Print Diagram' command.  The 'Print' dialog is
displayed.  Use the dialog to select a suitable printer, specify
printer settings and choose the number of print copies you
require.  Click 'OK' to print the diagram.

Access

The 'Print Diagram' command is available for the currently
open diagram.

Ribbon Publish > Diagram Image > Print > Print

Window
Selector

Publish > Report Generator > Print
Diagram
"Alt+6":  Report Generator > Print
Diagram

Learn more
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Print Preview·

 

(c) Sparx Systems 2022 Page 1479 of 1974

https://sparxsystems.com/enterprise_architect_user_guide/16.0/print_preview.htm
https://sparxsystems.com/enterprise_architect_user_guide/16.0/print_preview.htm


Modeling Fundamentals 3 October, 2022

Print Preview

Before you print an Enterprise Architect diagram or
document, you can display a preview of its output
appearance.

Access

Ribbon  > Print Preview
Publish > Diagram Image > Print >
Preview
Document-Edit > File > Print Preview

Notes

The display initially shows the first two pages on one·

screen, with no scroll bar

To toggle between the two-page display and a single-page·

display, click on the  button in the preview screen
toolbar; in either mode, you can use the  and  buttons in
the toolbar to scroll through the pages of the diagram or
document

To display more than two pages on one screen, up to a·
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maximum of ten pages, click on the  button in the
Preview screen toolbar; the screen now includes the
vertical scroll bar, which you can also use to scroll
through the pages of the diagram

Having checked the preview, you can immediately print·

the diagram or document by clicking on the  button;
otherwise click on the Close button
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Model Packages

A Package is a grouping element that acts as a container for
other modeling elements (including other Packages) and
diagrams; Packages are represented in the Browser window
as a familiar folder icon. Using the Package element, you
can construct hierarchical models, allowing complex
systems to be decomposed and categorized. Packages and
their contents can be moved around freely in the Browser
window, so that you can easily refactor the repository.
Packages can be copied and pasted between model
branches, renamed or viewed as a list.

Packages are important in Enterprise Architect because a
number of functions can be applied at Package level, such as
Baselining, Version Control, Transformation and more.
Formally, the Package is a Namespace for the members it
contains, and a model element can be a member of one and
only one Package. In software engineering and other formal
modeling disciplines a Package can be set as a Namespace
Root, which acts as the starting point of a given namespace.

Notes

In the Corporate, Unified and Ultimate Editions of·
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Enterprise Architect, if security is enabled you must have
'Update Element' permission to update or delete a Package

Annotation

An Annotation Package is a specialized form of Package
that is automatically created when a parent Package has one
or more diagrams that contain diagrammatic elements -
non-model elements that have no purpose outside a diagram.
Such elements include Notes, Text, Boundary elements and
Navigation Cells. The Package does not have any properties
(including not having a name), and is simply a container for
those diagrammatic elements, allowing them to be listed in
the Browser window and - if necessary - re-used in multiple
diagrams. This also protects the elements from being deleted
if the diagram that contains them is deleted. The Annotation
Package is represented in the Browser Window by a blue
Package icon followed by brackets.
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Add a Package

Adding a Package to a model is a simple but versatile
process. It is possible to add a new Package to a View,
Model Package or lower-level Package. In the process you
can automatically:

Create a Package using a specific Model Pattern·

Create a child diagram for the Package·

Add the new Package to the Version Control system that·

its parent object is under

Access

Ribbon Design > Package > Add Package

Context
Menu

Browser window | Right-click on
Package | Add a Package

Keyboard
Shortcuts

Ctrl+W

Other Browser window caption bar menu | New
Package ( )
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Add a Package to the model hierarchy

Option Instruction

Owner Displays the name of the
currently-selected Package or View, to
which you are adding the new Package.
If this is not the required owner Package,
click on the  button and select the
correct Package.

Name Defaults to the automatic name, either
'Package n' or, if you have an autonaming
scheme turned on, the defined name. If
necessary, overtype this name with the
preferred name of the new Package.

Select and
Apply Model
Pattern

Select this radio button to create the new
Package from a Model Pattern.

Create
diagram

Select this radio button if you want to
immediately create a child diagram for
the Package.

Package
Only

Select this radio button if you want to just
create a Package.
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Add to
Version
Control

(Available if you are adding this Package
to a parent object that is under Version
Control.) Select this checkbox to add the
new Package to the same Version Control
system, deselect the checkbox to exclude
the Package from Version Control.

OK Click on this button to create the Package
in the Browser window.
If you selected the 'Select and Apply
Model Pattern' radio button, the Start
Page 'Create from Pattern' tab (Model
Wizard) displays. Select the appropriate
Perspective and Pattern to import.
If you selected the 'Create diagram' radio
button, the 'New Diagram' dialog
displays. Provide a name for the diagram
and select the Technology and type.
The new Package is inserted into the
Browser window under the selected
parent Package or View.

Cancel Click on this button to abort the changes
you have made and close the dialog.
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Notes

You can also add a new Package element by dragging the·

Package icon from the Toolbox into a diagram; in this
case the Package is created under the diagram's owning
Package

If the change is not immediately visible in the Browser·

window, click on the parent Package and press the F5 key
to refresh it

In a multi-user environment, other users do not see the·

change until they also press the F5 key or reload their
project
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Open Package in the Browser Window

When you access a model in Enterprise Architect, you can
explore the contents of any Package in the Browser window
by clicking on the white arrow to the left of the Package
name, to expand the Package structure. You can, in an
analogous way, collapse an expanded Package by clicking
the black triangle to the left of the Package name. If the
model has a default diagram (which displays automatically
when you open a repository) the diagram's parent Package
will already be expanded.

To display the Package's properties, select the Package
name and view the docked Properties window.
Alternatively, right-click on the Package name and select
the 'Properties | Properties' menu option; the Properties
window displays for the Package.

Notes

Package contents are arranged alphabetically, and·

elements can be dragged from one Package to another
using the computer mouse

To collapse the Package structure again, click on the black·

arrow to the left of the Package name in the Browser
window

To refresh the view of the Package contents, click on the·

Package in the Browser window and press the F5 key
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Rename a Package

If you want to correct or change a Package name, it is very
simple to do so using the 'Properties' dialog for the Package.

Access

In the Browser window, select a Package and:

Ribbon Design > Package > Manage > Properties

Context
Menu

Right-click on Package | Properties

Keyboard
Shortcuts

F2
Alt+Enter

Other Double-click on Package

Rename a Package

Ste
p

Action
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1 In the 'Name' field, type the new name.

2 Click on the OK button.

Notes

In a multi-user environment, other users do not see the·

change until they reload their project
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Copy a Package

In developing your model, you might want to duplicate the
structure and organization of a section so that, for example,
you can replicate that part of the model in another model, or
make it easier to cross-refer the contents of duplicate
sections. You can quickly do this by copying a complete
Package, including its child Packages, elements and
diagrams, and then pasting it under:

The same parent Package·

One or more other Packages in the same model or project,·

or

One or more other Packages in another model or project·

You would tend to use this procedure for copying sections
of a model within the project rather than reproducing an
entire model or project, although copying these larger
structures is equally feasible.

Duplicate a Package

Action Detail

Copy the
Package

In the Browser window, right-click on the
Package and select the 'Copy / Paste |
Copy to Clipboard | Full Structure for
Duplication' option (or click on the
Package and press Ctrl+Shift+C).

(c) Sparx Systems 2022 Page 1492 of 1974



Modeling Fundamentals 3 October, 2022

The 'Copy selected Package to Clipboard'
dialog briefly displays until the copy
operation completes.

Paste the
Package

In the Browser window, right-click on the
target Package into which to paste the
copied Package, and select the 'Copy /
Paste | Paste Package from Clipboard'
context menu option (or click on the
Package and press Ctrl+V).
The 'Paste Package from Clipboard'
dialog briefly displays until the paste
operation completes.
In the Browser window, the target
Package is expanded to show the pasted
Package; if you are pasting the Package
within the same model as the copied
source, the source parent Package is also
collapsed. Note that any Version Control
settings on the initial Package are
removed from the pasted version.
If the target Package already contains:

A Package with the same name as the·

pasted Package, the pasted Package
name has the suffix - Copy
A Package with the same name as the·

pasted Package including the - Copy
suffix, the suffix becomes - Copy1 (or -
Copy2, - Copy3 and so on, as copies of

(c) Sparx Systems 2022 Page 1493 of 1974



Modeling Fundamentals 3 October, 2022

the Package accumulate in the target
parent Package)

You can keep the same Package name as
the source, or you can rename the
Package by either:

Clicking twice on it and editing the·

name in the Browser window, or
Double-clicking on it and editing the·

name in the 'Properties' dialog

Notes

You cannot paste a Package into a parent Package that is·

locked by another user or that is checked in; the 'Paste...'
option is grayed out in the context menu

This procedure is effectively the same as exporting and·

importing the Package Native/XMI file, with the 'Strip
GUIDs' checkbox selected

The paste operation can be a single transaction or a series·

of transactions to paste each data item separately,
depending on the setting of the 'Import using single
transaction' checkbox in the 'XML Specifications' page of
the 'Preferences' dialog

You can also move a Package to a different part of the·

model, in the same way as moving an element
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Delete a Package

If you do not want to keep a particular Package in the
model, it is very simple to remove it.

Access

Context
Menu

Right-click on Package | Delete
'<package name>'

Keyboard
Shortcuts

Ctrl+Del

Notes

Deleting a Package also deletes all contents of the·

Package, including sub-Packages and elements; make
very sure that you really want to do this before proceeding

In a multi-user environment, other users do not see the·

change until they reload their project
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Model Views

The top-level Packages in a model (below the Model Root
nodes) can be created as Views, which are simply used to
structurally partition and extend the model according to
specific requirements and modeling techniques, such as
Component View or Dynamic View. These Views have the
same concept as the Simple UML Views generated as
Model Packages; however, unlike the Model Package views,
basic Views:

Do not have any automatically-generated components·

Can be created only under a Model Root node·

Are top-level Packages with different Package icons·

Are not directly available for Requirements, Analysis or·

Testing, although you can develop these Views from
Simple Views or within Use Case Views

Types of View

There are seven main types of View, as listed here, each
identified by a specific Package icon; the types of diagram
we mention are suggested content for each View type, but
you can add any structures you want to any View.

Use Case View - containing Use Case diagrams and·

Analysis diagrams

Dynamic View -containing Activity diagrams,·

Communication diagrams, Sequence diagrams and
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StateMachine diagrams

Class View - containing Class diagrams, Code·

Engineering and Data Models

Component View - containing Component diagrams·

Deployment View - containing Deployment diagrams·

Package View - containing either Package diagrams·

specifically, or any other Package content raised up to the
highest level in the hierarchy; this View has the standard
Package icon as used across the model

Simple View - to customize your own type of view·

You can work within the first six standard View types, or
devise your own type based on the Simple View.

You can create Views, change the View icon (see the
Rename Views Help topic), and perform any operation
available for other types of Package, by right-clicking on the
selected View and choosing the appropriate context menu
option.

Note that if you drag a Package from lower down in the
hierarchy to just below the Model Root node, you can treat
that Package as a View and change the View icon.
Conversely, if you drag a View to a position lower in the
hierarchy, the View icon automatically changes to the
standard Package icon.
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Add Views

This example shows a customized view called Java Code
View, which has been added to the end of the list of Views
in the Browser window.

Access

In the Browser window, select a model root node, then:

Ribbon Design > Package > Add Package

Context
Menu

Right-click on root node | Add View

Other Package Browser caption bar menu | New
Package
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Create a View

These fields are on the 'Create Package' dialog, which has a
'Set View Type' icon that is only active for View-level
Packages.

Option Action
Name

Type the name of the View (in the
example, this is 'Java Code View').

Class
Click on this icon and select the
appropriate menu option to set the icon to
display next to the View name (the Java
Code View has a Class icon).

OK
Click on this button to add the View to
the Browser window.
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Rename Views

If you decide to change the name of a View, you can do so
very easily.

In renaming the View, you might want to change the icon
next to the View name as well; this is equally easy to do.

Rename a View

Ste
p

Action

1 Right-click on the View in the Browser window, and
select the 'Properties | Properties' option.
Alternatively, click on the View name and press F2.
The 'Package <name>' Properties dialog displays.

2 In the 'Name' field, type the new name and click on
the OK button.

Change a View Icon

Ste Action
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p

1 In the Browser window, right click on the View
name and select the 'Set View Icon' menu option.
The 'Set View Icon' dialog displays.

2 Click on the radio button for the type of icon you
want to apply, then click on the OK button.
The selected type of Package icon displays against
the View name in the Browser window.
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Delete Views

You can use Views as the main divisions of your project, or
as temporary holding structures that you delete after you
have redistributed any content you want to keep.

Delete a View

Ste
p

Action

1 In the Browser window, right-click on the View to
delete and select the 'Delete <viewname>' option.

2 If you have selected the 'Confirm Deletes' checkbox
in the Project Browser section of the 'Start >
Appearance > Preferences > Preferences > General'
dialog page, the system displays a warning that child
elements are to be deleted.

To delete the View and its contents, click on the·

Yes button.
To cancel the deletion, click on the No button.·

Notes
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If you delete a View, its contents are deleted at the same·

time; they cannot be restored
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The Model Wizard

The Model Wizard (Start Page 'Create from Pattern' tab)
provides Patterns from a wide range of technologies, which
you can use to quickly generate new models in your project
both when you first create the project and over time. From
the Model Patterns you can create basic models that you can
develop further as components of your project. You click on
the <perspective name> button at the top of the left-hand
panel and select a Perspective Set from the list, which then
shows a list of Pattern groups and the Patterns they contain.
If you click on a Pattern, a description displays in the
right-hand panel of the window, showing a type diagram
(where appropriate) and an explanation of what the Pattern
is and what it does. This description is drawn from an RTF
file paired with the Pattern's source XML file.

Access

(c) Sparx Systems 2022 Page 1506 of 1974



Modeling Fundamentals 3 October, 2022

The Model Wizard automatically displays when creating a
new project; otherwise use these options to access it:

Ribbon Design > Package > Model Wizard

Context
Menu

Right-click on Package | Add a Model
using Wizard

Keyboard
Shortcuts

Ctrl+Shift+M

Other Browser window caption bar : 

Browser window caption bar :  > New
Model from Pattern

Generate a New Model

Field/Button Action

Perspective When you open the Start Page 'Create
from Pattern' tab (Model Wizard), the
Pattern groups and Patterns available for
the current Perspective are listed. The
display defaults to showing the groups
expanded. Initially, the current
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Perspective is the one shown in the
<perspective name> icon at the top

right of the application screen.
If you click on the <perspective name>
button, a list of all the Perspective groups
displays. As you mouse-over an option in
the list, the Perspectives available in that
group also display. When you click on a
Perspective to select it, the panel is
updated with the Pattern groups and
Patterns provided by the selected
Perspective. As you click on a Pattern in
the list, a description is provided in the
right-hand panel.
Note that selecting a Perspective from the
<perspective name> button list does not
change the current 'global' Perspective
shown in the <perspective name> icon.
If you want to re-set the Model Wizard
Perspective to the global Perspective,
simply click on the <perspective name>
button and select 'Active'.
It is possible to make available every
Pattern Group and Pattern available in the
model; click on the button and select the
'All' option.
Conversely, you can restrict the list of
Patterns shown by typing a text string in
the Filter Bar underneath the button. Only
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Patterns that have that text string in their
name are listed. This is also a useful tool
for locating specific Patterns when you
are not sure where they are held - select
'All' Perspectives and type the Pattern
name in the Filter Bar field. The panel
lists each Pattern that has the text string
in its name
If you are a Technology Developer you
can create and import your own MDG
Technology, and distribute one or more
custom Model Patterns from that
Technology through the Model Wizard;
the name of your Technology (or
Technology categories) is added to the
selection list under 'Specialized' for your
users to access the Technology Patterns.
To select a Model Pattern, simply click
on it. If you want to select more than one
Pattern, hold the Ctrl key down while you
click on each Pattern.

Create
Model(s)

Click on this button to import a model
structure derived from the Pattern(s) you
have selected. The 'Importing Model
Templates' dialog displays whilst the
import is in progress, and any problems
with the import are reported in the
System Output window. The generated
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model structure displays under your
selected Package in the Browser window.

Add To Displays the name of the Package you
have selected in the Browser window.
If you are using the Model Wizard by
default on a newly-opened project, this
field shows the Model root, 'Model'.
If you need to change the Package to
generate the model under, click on the 
icon and browse for the correct Package
on the 'Navigator' browser.

Customize
Pattern on
import

A Pattern can contain several Packages;
select this checkbox to indicate that you
will import only some of these Packages
from the Pattern into your model. After
you click on the Create Model(s) button,
the 'Select Packages' dialog displays on
which you specify which of the Packages
to import.
If you select more than one Pattern, the
'Select Packages' dialog displays for each
Pattern in turn.
If you do not select the checkbox, all
Packages in each Pattern will be imported
into the model.
The option is disabled if there are too few
Packages to select from, or if it is not
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logical to import only some of the
Packages.

Combine
with selected
Package

Select this option to import the contents
of the Pattern into the selected Package.
When creating a Pattern, Enterprise
Architect will normally create a new
Package to represent the Pattern, as a
child of the selected Package. If you
select this checkbox, no new Package is
created and instead the contents of the
Pattern are added to the selected Package
(provided that the selected Package is not
a root node).

Notes

The 'Select Package(s)' dialog does not display for some·

of the Simple Template and Basic Template Patterns,
even if the 'Customize Pattern on import' option is
selected
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Customize Model Content

When you set up a project by importing models using the
Model Wizard (Start Page 'Create from Pattern' tab), you
can generate the model structures from Patterns that you
select in the Wizard. Each Pattern can contain a number of
Packages and sub-Packages, and it is possible to select
which of these Packages to add to your model and which to
omit, using the 'Select Packages' dialog.

This is especially useful when setting up a new model with a
reasonably complex structure, such as the TOGAF
framework model. Being able to select which Packages are
included and which are omitted is a good way to customize
the level of implementation necessary for the current
project.

Access

Ribbon Design > Package > Model Wizard >
Select 'Customize Pattern on import'
checkbox : Create Model(s) button

Context
Menu

Browser window | Right-click on a
Package node | Add a Model using
Wizard | Select 'Customize Pattern on
import' : Create Model(s) button

(c) Sparx Systems 2022 Page 1512 of 1974



Modeling Fundamentals 3 October, 2022

Keyboard
Shortcuts

Ctrl+Shift+M | Select 'Customize Pattern
on import' : Create Model(s) button

Other Browser window caption bar menu | New
Model from Pattern | Select 'Customize
Pattern on import' : Create Model(s)
button

Select Package(s) dialog

Option Description

Select
Package(s) to
import from
<pattern>

Shows the hierarchy of Packages
contained in the Pattern, with a checkbox
to the left of each item. The checkboxes
are selected by default.
Deselect the checkbox against each
Package that you do not want to import.

Deselecting a Package automatically·

deselects all its child Packages
Re-selecting a Package automatically·

selects all its ancestor Packages

OK Click on this button to import the selected
Packages from the current Pattern.
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Cancel Click on this button to abort the creation
of model structures from the current
Pattern.
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Models

An Enterprise Architect model is a top level (root) Package
in a repository. It is possible to have more than one root
Package in a repository and hence more than one model.
Each model is the root node of a hierarchy of Packages,
elements, features and diagrams that are nested under the
Package. The Browser window is used to manage the model
and the hierarchy of elements, features and diagrams,
showing how the models are structured and helping you to
reorganize a model by dragging and dropping objects to new
locations in the hierarchy.

Enterprise Architect has a handy Model Wizard that helps
you to create models and a hierarchy of Packages under
each root, from a wide selection of model Patterns. The
Wizard is displayed automatically when a new model is
added to a repository, but can be invoked manually (Start
Page 'Create from Pattern' tab). Using the Wizard simplifies
the process of setting up repositories and models for the
novice modeler. More experienced modelers are free to add
a single Model Package and build up the structure as they
see fit, or to create a model from a base (template)
repository.

As your model develops, you can use the Model Wizard to
inject fine-grained content into your overall model structure.
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A Package configured to manage Requirements, or one for
Decision modeling, or Simulation of States or one of
hundreds of other pre-built patterns that help you develop
and refine your model for your domain and your project.

As the repository is developed and during the lifetime of a
project or program of work, new models might have to be
added and existing ones refactored.
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Model Options

The 'Manage Model Options' dialog provides facilities for
configuring various actions of Enterprise Architect for the
current model or project, affecting all users of that model.
When you open the dialog it defaults to the 'General' page,
which helps you to set the system behavior options such as
the required release of Enterprise Architect, diagram text
appearance, Sequence message spacing and SysML Control
Flows format.

The dialog also has pages for identifying MDG
Technologies; the Cloud configuration; Reusable Asset
Service Registry configuration for Baselines; the central
connection for managing Collaboration text such as Model
Diary entries, Model Mail and Chats; the element status that
locks elements against review comments, and Code
Engineering options and code language options that are
specific to the model.

Access

Ribbon Settings > Model > Options

Control System Behavior
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Field/Button Action

File
Directory

Type in the default directory name for the
shared files you define on the 'Files' tab
of an element's 'Properties' dialog
(maximum 50 characters).

Minimum
Version

Click on the drop-down arrow and select
the minimum release of Enterprise
Architect required to open this model.

Minimum
Build

Type in the number of the earliest build
required to open this model.
Alternatively, click on the Select Current
button to select the build of the system
that the model is currently open in.

Font Face Click on the drop-down arrow and select
the font in which to display all element
text in diagram renditions of elements.

Font Size Click on the drop-down arrow and select
the font size in which to display all
element text in diagram renditions of
elements.

Clear Click on this button to clear the 'Font
Face' and 'Font Size' fields.
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Notes Font Click on the drop-down arrow and select
the default font of all text displayed in
Notes elements and fields on diagrams.

Clear Click on this button to clear the 'Notes
Font' field.

Ignore image
transparency

Select this checkbox to ignore
transparency for all images in the model,
effectively rendering them as 24 bit
images.
Deselect the checkbox to show the
transparency for all (32 bit) images on
which it has been used.
If you change the selection, you must
restart Enterprise Architect to bring that
change into effect.

Message
Spacing

Type in the vertical gap (in points,
between 15 and 45) to maintain between
Sequence Messages on a Sequence
diagram.
This spacing can be overridden manually
by dragging a Message up or down.

Enable
Structure
Compartment

Defaults to selected to automatically
display Structure compartments on
elements in rectangular notation on
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s diagrams across the model. Clear the
checkbox if you do not want to display
Structure compartments on elements.

XMI/VC
Import Policy
for
Discussions

Click on the drop-down arrow and select
an option that determines how to import
Discussions from XMI:

Always Merge - select this option to·

retain the existing Discussions in the
model and merge those in XMI
Always Restore - select this option to·

delete the existing Discussions in the
model and import those in XMI

Notes :
The selected option determines how·

Discussions are imported during these
imports: XMI 1.1, XMI 2.1, Native
XML, Package Control, Version
Control and Baselines
The selected option can be overridden·

in the 'Import Package from
Native/XMI File' dialog if the
checkbox 'Allow user to override if
prompted' is selected
In Corporate, Unified and Ultimate·

Editions of Enterprise Architect, if
security is enabled then only the Admin
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administrator or a user in the
Administrators group can select these
options

Allow user to
override if
prompted

Select the checkbox to override the
option selected for 'XMI/VC Import
Policy for Discussions' in the 'Import
Package from Native/XMI File' dialog.

SysML Options

Field/Button Action

Dashed Line
for Control
Flow

Select this option to draw all control
flows on SysML diagrams as dashed
lines. Deselect this option to draw all
control flows on SysML diagrams as
solid lines.
This option does not affect control flows
on non-SysML diagrams, which will
always be drawn as solid lines.

Notes
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In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Manage Project Settings' permission to set, change or
clear the 'Font Face' and 'Font Size' fields, and to
enable/disable diagram image-maps

Similarly, if security is enabled you must have 'Configure·

Project Prerequisites' permission to update the 'Minimum
Version' and 'Minimum Build' settings

You can also define User fonts on the 'Preferences' dialog·

that apply to any diagram you display in any model; the
User font is overridden by the Model font, to ensure that
all members of the project team have a consistent and
coherent view of the model

Model fonts are themselves overridden by·

specifically-defined element fonts, so that the element is
viewed as designed regardless of the model defaults; to
define the font for a specific element, right-click on the
element in a diagram and select the 'Appearance | Set
Font' option

It is recommended that a project authority sets the Model·

font, and all project members abide by it and do not
change it without project approval; in editions where
security is enabled, changes can be restricted by allocating
permission only to the project authority
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Baseline Page

Package Baselines in Enterprise Architect can be stored
either within the model or in a Reusable Asset Service
(RAS) Registry. The 'Baseline' page of the 'Manage Model
Options' dialog provides the option to specify which storage
method to use.

If a Project or Model Administrator decides to store Package
Baselines in a Registry, the 'Baseline' page also provides
options to:

Configure the Cloud Connection to the Registry·

Select an existing Storage or create a new Storage in the·

Registry in which to store the Baselines

Configure Registry-specific Baseline options·
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The information to define the repository and model will be
provided by the Project Administrator for the user to enter.
Depending on the access granted to the user, the
administrator might identify the Storage and Password to
use, or the user might define their own Storage.

Access

Ribbon Settings > Model > Options > Baseline

Configuration Options

Option Description

Store
Package
Baselines in a
Reusable
Asset Service
Registry

By default, Package Baselines are stored
within the model. If you leave this
checkbox empty and ignore the
remaining fields on this page, when a
user in the model selects to create or
review a Baseline the 'Baseline' dialog
displays. See the Manage Baselines in
Model Help topic.
To store Package Baselines in a Registry,
click on and enable this checkbox. Once
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the checkbox is enabled you can
configure the Registry Cloud Connection
and Registry-specific Baseline options on
the rest of the page.
When the connection has been
established and when a user selects to
create or review a Baseline the 'Reusable
Asset Service - Baseline' view displays.
See the Manage Baselines in Reusable
Asset Service Registry Help topic.

Name Type the name by which to refer to the
Reusable Asset Service (RAS) Registry.
The name does not have to match any
values on the server; it will appear in the
'Registry' field in the 'Reusable Asset
Service - Baseline' view.

Protocol Click on the drop-down arrow and select
a secure (https) or insecure (http)
connection, as supported by the server
you are connecting to. When you select
the protocol, the Port will automatically
be set to match the default for that
protocol.

Server Type in the machine name (for example,
'sparxcloud.com') or IP address (for
example, '192.168.0.20') of your server.
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Port If necessary, click on the drop-down
arrow and select the Port number the
service is listening on. This should match
the settings in the configuration file on
the server.
Note: For a server, the default settings
will use Port 80 for http and Port 443 for
https.

Model Name Type in the name of the model available
on the server.

Storage Once the 'Name', 'Protocol', 'Server', 'Port'
and 'Model Name' fields have been
completed, click on the 'Storage' field to
select the Storage in which to store the
Package Baselines.
If Enterprise Architect is unable to
connect to the Reusable Asset Service
(RAS) Registry using the provided
connection details, an 'Unable to connect
to the specified Registry' message will be
displayed.
If connection is successful, then the
'Storage' field drop-down list will display
all available Storages in the Registry that
can store Package Baselines. You can
select one of these existing Storages to
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store the Baselines for this Model.
Alternatively, you can create a new
Storage by selecting the 'Create New
Storage' option in the list. This displays
the 'New Storage' dialog; use this dialog
to create a new Storage in the Registry.
Once saved, the newly-created Storage
will be selected in this field.
Note : The connected Reusable Asset
Service (RAS) Registry could be
password-protected to prevent users from
modifying the Registry. In such a
scenario will be prompted to enter a valid
Administrator password before you can
create a new Storage using the 'New
Storage' dialog.

Password If the selected Storage is
password-protected against user changes,
the 'Password' field will become enabled.
Enter a valid password to store Package
Baselines from the selected Storage.
Notes:
Storages can be protected by a 'Complete
Access' and/or 'Read-Only Access'
password. Depending on the type of
password entered, Enterprise Architect
will allow these operations on a Storage:

'Complete Access' password - allows·
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the user to create and retrieve Package
Baselines from the Storage
'Read-Only Access' password - allows·

the user to retrieve Package Baselines
but not create new ones in the Storage

Save Click on this button to save the Registry
Cloud Connection details.

Modify Once the Registry Cloud Connection
details have been successfully saved, the
Save button will become a Modify
button. Click on this button to modify or
update the saved Registry Cloud
Connection details.

Check
Package
dependency
when
creating
Baseline

Select this option to check whether the
Package being baselined is dependent on
any external content; that is, whether it
links to any modeling component (such
as an element or diagram) held in another
Package in the model.
If the Package is dependent on external
modeling components, the name and
Global Unique Identifier (GUID) of each
Package holding those modeling
components will be recorded along with
the Baseline. This information will be
displayed in the 'Dependency' tab of the
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'Reusable Asset Service - Baseline' view.
Note : Enterprise Architect will perform a
'Complete' type of dependency check
when creating a baseline of a Package.

Set Baseline
Version as
Package
Tagged
Value after
restoring
Baseline

Select this option to set the Baseline
Version as a Tagged Value on the
Package after completely restoring the
Package from a Baseline.

Notes

The Baseline facility is available in the Corporate, Unified·

and Ultimate Editions of Enterprise Architect

If security is enabled, you must have 'Baselines - Manage'·

permission to store Package Baselines in a Reusable Asset
Service Registry
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Cloud Page

The 'Cloud' page is generally maintained by a model or
project administrator, with 'Administration' permissions. It
provides options to:

Configure the Properties window for each element and·

diagram to provide a WebEA URL that can be copied and
sent to a user (by, for example, email) so that they can
directly link to that object in WebEA

Enable HTML pages for Linked Documents, and Diagram·

Images and Image Maps for all Enterprise Architect
diagrams, to be generated and updated in cache for access
from WebEA

Configuration Options

Option Description

Maximum
Query Time

You use this option to set the length of
time that the Enterprise Architect client
will wait for a response from the Pro
Cloud Server. For example, if a user is
running a custom search or other data
request and Enterprise Architect times
out before the PCS response arrives, you
can extend the time the Enterprise
Architect client will wait for the

(c) Sparx Systems 2022 Page 1530 of 1974



Modeling Fundamentals 3 October, 2022

response.
Click on the drop-down arrow and select
from the time options - 60, 120, 180 or
300 seconds.
Note that for this option to work you
must be using PCS 4.2.65 or later and be
a member of the Administrators User
Group.

Disable XMI
Import over a
Cloud
Connection
for this
Model

You select this option to prevent users
from being able to import XMI files into
the model through a Cloud connection.
This avoids the potential of large import
transactions being affected by connection
problems. When this option is set, users
can still perform XMI imports using a
direct connection.
Note that this option disables not only
XMI Import (XMI 1.1/2.1) but also any
Native file (Native XEA/XML) import,
effectively also disabling:

Restoring baselines that are stored in·

the model
Restoring baselines that are stored in·

RAS (see the Manage Baselines Help
topic)
Importing Packages from RAS·

Loading and batch-importing·
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controlled Packages (see the Using
Controlled Packages Help topic)
importing Version Controlled Packages·

URL Type the fully qualified URL (including
protocol, server name or IP and port) of
the site hosting this model in WebEA.
For example:
     https://localcloud:1443

Model
Number

Type the position number of this model in
the list of models presented in the
WebEA 'Login' page. (As in the
[model_list] section of the WebEA config
file.)

Use this
Theme on
Images

Click on the drop-down arrow and select
the diagram theme to apply to diagram
images in WebEA.

Use this
Scale on
Images

Overtype the field with a value between
100 and 120 to define the scale of the
WebEA images.

Auto create
Diagram
Image and
Image Map
(each time a

(In the Corporate, Unified and Ultimate
Editions) Select this checkbox to create
Diagram Images and image-maps for all
diagrams. These images and image-maps
will be automatically updated whenever
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Diagram is
saved)

the diagram content changes.
This option is necessary for publishing
the model via the Pro Cloud in WebEA.
Deselect the checkbox to stop creating
images and image-maps for diagrams. A
prompt displays through which you
specify whether to retain or delete the
existing images and image-maps in the
model.

Auto create
HTML Page
(each time a
Linked
Document is
saved)

(In the Corporate, Unified and Ultimate
Editions) Select this checkbox to create
HTML pages for all Linked Documents
in the model. These HTML pages will be
automatically updated whenever the
Linked Document content changes.
This option is necessary for publishing
the model via the Pro Cloud in WebEA.
Deselect the checkbox to stop creating
HTML pages for Linked Documents. A
prompt displays through which you
specify whether to retain or delete the
existing HTML pages in the model.

Batch create
Diagrams
and/or
Linked
Documents

(Only if you have selected the 'Auto
create Diagram Image and Image Map'
and/or 'Auto create HTML Page' options.)
Click on the 'Create' button to page
through the diagrams and Linked
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cache Documents of the model, creating an
initial diagram image and image map for
each diagram and an initial HTML page
for each Linked Document.
You should only need to do this
occasionally, to force a wholesale update
of the cache; normally the individual
diagram images and Linked Document
pages are updated automatically when the
original object is changed.

Integrations It is possible to connect a non-Cloud
model to the Integration Plug-ins
provided by Pro Cloud Server.

To enable this feature:
Tick the 'Enable' check -box·

Enter a connection string to a Pro·

Cloud Server (it is not necessary to
include a 'Data Source'  or 'DNS')
Click on the Fill Providers button to·

populate the list of available external
data providers
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Tick any providers that should be made·

available to this model
Note: The connection string for a Cloud
connection can be obtained via the
Manage Project window, by
right-clicking on a recent connection and
selecting 'Edit connection string'.

Notes

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Manage Project Settings' permission to set 'Auto create
Diagram Image and Image Map' and the WebEA URL
and model number
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Translate Page

Enterprise Architect provides a number of facilities to
translate text that has been entered into the Notes window
by users. To set up the parameters for translating Notes text
from its current language to another, you use the
'Translations' page of the 'Manage Model Options' dialog.
This page allows you to enable the Translation facility and
identifies the automatic Translator tool, whether to translate
text automatically and whether the translated text can be
edited or not.

When you have finished configuring the Translation
parameters, restart Enterprise Architect to put them into
effect. You can then begin translating text as explained in
the Translation Facilities and Text Translation Help topics.

Access

Ribbon Settings > Model > Options > Translate

Configure Translation Options

Option Description
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Enable Select this checkbox to enable the
automatic translation facilities and open
the fields for data entry. If you are
restricted to performing manual
translations (in the Professional Edition)
or if the translation Plug-in is otherwise
not installed or turned on, this checkbox
is unavailable, as are the next five fields.

Translator Select (from the drop-down list) the
internet translation facility you are
subscribing to, either Microsoft or
Google. If you intend to only perform
manual translations, select the 'Manual'
option.

Auto
translate
notes

Select this checkbox if you want to
translate the Notes text immediately and
automatically whenever the 'Translation'
tab of the Notes window is accessed.
Deselect the checkbox to perform the
translation only when you specifically
select the 'Force Translate' option in the
Notes window.
Bear in mind that your translator
subscription might impose restrictions on
the number or size of requested
translations, so you might prefer to
deselect this option until you have seen
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how much translation you actually
perform.

Allow editing
of translated
notes

Select this checkbox to enable you to
make changes to the translated text in the
Notes window. Deselect the checkbox to
block manual changes to the translated
text.
If you make manual changes to the
translated text, the local Notes text is
protected against automatic translation
but can be force-translated.

Registration
tag

Type in the registration tag for the
internet translator subscription (if
necessary).

Registration
key

Type in the registration key for the
internet translator subscription.

Primary
Language

Click on the drop-down arrow and select
the source language, in which you
normally type text into the Notes
window. This is passed to the translation
facility as the defined source language.

Supported
Languages

Select the checkbox against each
language that you want to be available for
selection in the Notes window, into
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which to translate the text from the
source language. These languages will be
presented in a drop-down list on the
'Translation' tab of the Notes window.

Close Click on this button to save your changes,
if you have finished setting project
options.

Notes

You can perform manual translations in any Edition of·

Enterprise Architect; to perform automatic translations
you require Pro Cloud Server release 4.1, in a Corporate,
Unified or Ultimate Edition of Enterprise Architect

You can create a translation model to define terms (as·

elements) that either should not be translated or should
only be translated as a specific text string; the model is
checked and the element-defined terms protected before
the text is passed to the translator

(c) Sparx Systems 2022 Page 1539 of 1974



Modeling Fundamentals 3 October, 2022

Collaboration Page

This page helps the Database Administrator to link the
current model to a common model for communicating
information amongst project members who are working in
different projects. In the 'Model Connection' field, you enter
the connection string for the model that is providing the
central Collaboration facilities (Model Mail, Calendar, Chat
and Diary) for users of the current model.

Access

Ribbon Settings > Model > Options >
Collaboration

The Model Connection Field

Click on the  button to display options to connect to the
Cloud or remove the current value from the field.

If you click on 'Define Connection' the 'Cloud Connection'·

dialog displays with the fields defaulted to the first
Cloud-connected model in the 'Pinned' or 'Recent' list; if
necessary, select or overtype with the appropriate
replacement values, and click on the OK button to display
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the model name in the 'Model Connection' field
The current model will then link to the Collaboration
facilities of the connected model

If you click on 'Remove', any connection string is·

removed from the 'Model Connection' field; once the
current model is reloaded, the model users will then revert
to the Collaboration facilities of that model - all the
original Collaboration content is available

Notes

You must have 'Administer Database' access permissions·

to set the central model

The end users must have the same user credentials in both·

the 'work' model and the 'Collaboration' model (and
therefore User Security has to be enabled in both models)

You can set up the user credentials the same way in each·

model, but if you are using a MySQL, SQL Server or
Oracle repository it is far more convenient for you as
Database Administrator to set up a shared repository for
both models so that they refer to the same secusers table
(the secusers table is one of those listed for selection
when setting up a shared repository)
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Review Status Locks Page

When a review is being performed on an element, a point
will be reached when input and comments have been made,
perhaps changes also made, and the Reviewer Managers
need to consider the current situation before asking for more
comment. Alternatively, the review of that element is
complete and no further input is required. In either case, you
can lock the element under review against the posting of any
further discussion topics or responses. To do this, you
identify one or more element status values that, if an
element has that status, will lock the review.

Access
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Ribbon Settings > Model > Options | Review
Status Locks
Start > Collaborate > Review | Manage
Reviews | Right-click on a Review (left
hand side) or element (right hand side) |
Review Status Locks
Start > Collaborate > Review | Review :

 | Review Status Locks

Set Locking Status

Simply select the checkbox against each status that will lock
the element against any further review postings, then click
on the Close button.

The status values offered are drawn from the list defined on
the 'Status' page of the 'General Types' dialog (Settings >
Reference Data > Model Types > General Types > Status).
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Bookmarks

A bookmark is a visual cue to to the modeler, to monitor or
pay particular attention to an Element.  Bookmarks can be
attributed any meaning you wish, so they can be used for a
variety of purposes to highlight particular aspects of your
model.

There are two type of bookmarks:

Standard·

Annotated·

In this example the Element on the left has a standard
bookmark and the Elements on the right have annotated
bookmarks.

Bookmark Types

Option Action

Standard A Standard Bookmark is represented by a
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Bookmarks small red triangle (or red Del symbol)
that displays above the element in the
diagram or Model Search. It includes
features for bookmarking elements based
on their maintenance item status and their
test case status.

Annotated
Bookmarks

The Annotated Bookmarks can be
defined with a numerical or text value
that is displayed in the bookmark in a
diagram. The diagram view of these can
be enabled or disabled for that diagram.
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Standard Bookmarks

Standard Bookmarks can be used to clearly highlight
specific Elements in a diagram and can be quickly applied
with a single keystroke (Shift+Space). Using the standard
bookmarks you can bookmark:

Single elements manually, or·

All elements in a Package automatically when they·

assume a defined status

Bookmark Options

Option Action

Bookmark a
selected
element in a
diagram

Either:
Press Shift+Space, or·

Select the 'Design > Element > Manage·

> Bookmark' ribbon option

Clear a
bookmark on
a selected
element

Use either of the two options again.
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Bookmark
Multiple
Elements in a
Package

Browser window | Right-click on
Package | Contents | Bookmarks
The 'Manage Bookmarks' dialog displays,
which you can use to automatically
bookmark any elements (and, if required,
their children) in the Package that have:

New changes defined in the·

Maintenance window
New defects defined in the·

Maintenance window, and/or
Test scripts defined in the Test Cases·

window
This is useful to highlight elements that
have additional project information.

Clear all
elements of
bookmarks

To clear all bookmarks:
Throughout the current Package, click·

on the Clear All button on the 'Manage
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Bookmarks' dialog
In the current diagram, select the·

bookmarked elements (or Ctrl+A for
all elements) and then press
Shift+Space.

Notes

You should reload the project to update it with the new or·

cleared bookmarks

The Find in Project window provides the facility to search·

based on Standard Bookmarked elements.
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Annotated Bookmarks

Annotated Bookmarks can be used to clearly highlight
specific Elements in a diagram with a marker showing
simple text or numbers. Annotated Bookmarks provide a
means of identifying Elements that need to be brought to the
foreground when displaying a model or for highlighting
Elements that require further work.

Bookmark Options

Option Description

Bookmark a
selected
element in a
diagram

To set an annotated Bookmark:
Select an Element·

Select 'Set Bookmark Value' from the·

context menu
Tick the 'Enable Bookmark' checkbox·

Type in a numerical or text value for·

the bookmark
Click on the OK button.·
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Clear a
bookmark on
a selected
element

To clear an annotated Bookmark:
Select an Element·

Select 'Set Bookmark Value' from the·

context menu
Un-tick the 'Enable Bookmark'·

checkbox
Click on the OK button.·

Hide/Show
Annotated
Bookmarks
in a Diagram

You can hide or show all bookmarks on a
diagram using the 'Hide All Bookmark
Values' or 'Show all Bookmark Values'
options on the Diagram Context menu.
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Model Glossary

Glossaries can be modeled in a number of different ways
depending on the formality of your modeling approach; each
method allows you to create a lexicon of important project
terms and their meanings. You can model the terms as a
simple list with the terms, their categories and their meaning
entered in rows in a table, using a dialog or window.
Alternatively, the terms can be created as modeled elements,
which provides more flexibility and a number of additional
features. Both of these approaches has its uses and either
will assist in reducing the ambiguity and uncertainty that
arises in project work. Regardless of the method chosen, the
defined terms will appear in the Glossary View.
Importantly, when the terms are included in textual
descriptions such as the notes of other elements, they can be
de-referenced to clarify the meaning, with both the category
and meaning being displayed in a tool-tip when you
roll-over the term in the text.

Using the list approach, where terms are entered through the
Glossary dialog, the important terms can be easily defined
along with their meaning.  A user can set up any number of
Types that can be used to group the terms into lexical sets
which can be defined for any purpose; for example, types
could be defined for each project, program, department,
discipline or any user defined group.

Using the modeled approach Glossary terms can be modeled
as first class citizens, allowing rich models of terms and
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their definitions to be created. Packages stereotyped as
Glossary Category are used to group Glossary Entries into
lexical sets. The glossary category Packages and the terms -
like any other modeled element - will appear in the Browser
window and can be included in diagrams.

Rich networks of interrelated terms can be created
describing the semantic and lexical relationships between
terms, and each term can have descriptive properties
defined. These properties can be built-in or user defined
using Tagged Values. For example, you might be working
on projects in the health sector and define a term 'Admission
Process' and relate it to another term 'Health Facility', each
term could have a status (built-in) or a business owner or
custodian (user-defined).  When publications are generated
from the repository, the terms that form part of a specific
Glossary Category can be styled (marked up) allowing them
to be identified in the publication as belonging to the same
lexical set.

This method allows any number of glossaries and categories
to be created for different purposes, such as the terms that
belong to a particular discipline - say, 'Regional Health
Care' terms - or that are part of a specific standard - say,
'Business Process Modeling terms  - or are from a given
business or technical domain such as 'Foreign Exchange',
'Agile Development' or 'Artificial Intelligence'.

The glossaries, their categories and the terms they contain
can be conveniently shared or exchanged between any
repositories.
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Access

Ribbon Design > Dictionary > Glossary

Project Glossary functionality

Tasks

Add, delete and modify the Project Glossary entries
through either the:

Glossary View, or·

'Glossary' dialog·

Separate glossary items by type; for example, Business
terms and Technical terms.

Create a Glossary as a Model Package Structure.

Define Markup Styles to apply to terms of specific types
where they occur in generated document reports.

Save the glossary in Rich Text format for inclusion as
part of a larger project document.
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Create glossary terms and definitions from text in the
Notes window, or from any 'Notes' or 'Description' fields
that have the Notes toolbar.

Insert existing glossary terms into any other 'Notes' fields.

Notes

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Manage Glossary' permission in order to create, update or
delete Glossary items; if security is not enabled, you can
manage Glossary items without any permissions

You might include a Glossary Report in your project·

requirements or functional specifications documents

You can transport glossary definitions and glossary style·

mark-ups between models, using the 'Settings > Model >
Transfer > Export Reference Data' and 'Import Reference
Data' ribbon options
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Project Glossary View

The Model, or Project, Glossary consists of a list of defined
terms for your project, as displayed in the Project Glossary
View.

You can create Glossary items to define terms in two ways:

Through the 'Glossary' dialog as text-based entries or·

As elements in a model structure, grouped under Glossary·

Category Packages

The Project Glossary View provides options to review the
terms of different types already defined for a model. It
identifies which Glossary items are defined as model
elements, and therefore those that are not will be entries
created in the 'Glossary' dialog. You can use the Project
Glossary View to:

Add glossary terms (via the 'Glossary Detail' dialog, not·

as a model element)

Assign a Markup Style to a glossary term Type or·

Category, to print in a documentation report any terms of
that Type/Category in that style

Modify glossary terms·

Filter the display to show terms of a specific Type or·

Category only

Change a definition Type for all terms of that Type·

Print the displayed list of terms·

Delete glossary terms (those defined via the 'Glossary'·
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dialog, not those created as model elements)

From the View you can also select, copy and paste (Ctrl+C
and Ctrl+V) some or all of your Glossary entries to an
external text editor or spreadsheet tool. The text is copied in
CSV format.

Access

Use one of the methods described in the table, to display the
Glossary view.

Ribbon Design > Dictionary > Glossary >
Glossary View

Glossary View Options

Within the Glossary view, right-click on an entry and select
the appropriate option for the operation you intend to
perform (as listed); if you select the:

'Add New' option, the 'Glossary Detail' dialog displays;·

complete the fields as indicated in the Glossary Detail
Dialog Fields table

'Assign Markup Styles' option, the 'Glossary Markup'·

dialog displays on which you assign display styles to
terms of each existing term Type or Category; the style is
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applied when you generate an RTF report containing the
glossary terms (see the Glossary Styles Help topic)

'Modify Selected' option, either the element 'Properties'·

dialog (for model element terms) or 'Glossary Detail'
dialog displays, in which you can edit the name and/or
definition of the term

'Field Chooser' option, the 'Field Chooser' dialog displays,·

from which you can drag any column headings not
currently displayed into position in the heading row; to
return a header to the dialog, simply drag it out of the
heading row (see the List Header Help topic)

'Enable Group Box' option, the Group Box is displayed·

above the header row, in which you reorganize the list to
group the entries according to one or more properties (see
the List Header Help topic)

'Toggle Filter Bar' - a row of fields displays below the·

header row, in which you can type values to display only
those items that contain that value in the property shown
in that column (see the List Header Help topic)

'Rename Type' option (not available for model element·

glossary terms), the 'Rename Glossary Type' dialog
displays on which you type in or select the alternative
Type name (either another of the existing Types or a new
Type); when you click on the OK button, all entries of the
original Type are changed to the new Type

'Set term filter' option, the 'Term Type Filter' dialog·

displays on which you enter the Type or Category of
glossary term to list; when you click on the OK button,
only items of that Type are shown on the Glossary view
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'Remove term filter' option, the Glossary view refreshes to·

show glossary items of all Types

'Print List' option, the 'Print' dialog displays on which you·

define the printing parameters; when you click on the OK
button, the currently-displayed list prints out

'Find in Project Browser' option (only for model element·

glossary terms) the system locates and highlights the
element that defines the term in the Browser window

'Reload' option, the Glossary view refreshes to capture·

any new glossary elements that might have been created
since the view was displayed

'Delete' option (not available for model element glossary·

entries), a prompt displays to confirm the deletion; click
on the Yes button to remove the term from the Glossary

Glossary Detail Dialog Fields

Field Action

Term (Mandatory) Type the term to include in
the glossary.

Type (Mandatory) Select the required Type.
If you require a different glossary Type,
click on the  button and specify the
name of the new Type.
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This field applies the Type only to the
selected term; you can rename a Type for
all terms of that Type, using the context
menu.
Further discussion of the 'Type' field is
provided in The Glossary Dialog Help
topic.

Meaning Type the definition or description of the
term.
If necessary, format the text of this
description using the Notes toolbar at the
top of the field.

New Clear the dialog fields so that you can
define a new Glossary term.

Apply Save the new or updated glossary entry.

Delete Delete the entry.
A prompt displays to confirm the
deletion; click on the Yes button to
remove the term from the glossary.

Notes
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In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Manage Glossary' permission in order to create, update or
delete Glossary items; if security is not enabled, you can
manage Glossary items without any permissions
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The Glossary Dialog

Using the 'Glossary' dialog, you can create, maintain and
delete definitions of terms used in your project, as a
Glossary. When reviewing the Glossary terms, you can filter
the list to display terms of a specific Type.

The term Type also acts as a key for substituting the
description of any term of that Type for the term itself, so
that in a report the terms 'Corp', 'Uni' and 'Ult' would be
replaced by the descriptions 'Corporate', 'Unified' and
'Ultimate', respectively.

Access

Ribbon Design > Dictionary > Glossary > Edit

Maintain Glossary Terms

Field Action

Glossary
Term

Type the term to include in the glossary.
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Glossary
Type

(Mandatory) Every Glossary term must
be assigned to a Type, so that you can:

Filter terms by Type·

Search for terms of specific Type·

Assign a format and style to terms of a·

Type to indicate that a glossary
definition has been attached to a word
in the text; terms of different Types
would be distinguished by their
respective styles
Replace all terms of a specific Type·

with the text string in their 'Description'
field (see the Substituting Descriptions
for Terms section later in this topic)

When you first start to create a Glossary,
there are no Types defined in your model.
You create the Types that are most
appropriate to your work environment, by
clicking on the  button and, on the
'New Glossary Type' prompt, entering the
name of the new Type. The names that
you invent for the Types would be
whatever is meaningful to the people
compiling and using the Glossary.
In the simplest of Glossaries you might
have just one Type, simply to assign a
style to it so that terms are identified as
being defined in the Glossary. In larger,
more complex Glossaries you might have
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different Types to group - for example -
Business terms, System terms and
Project-Specific terms.
When the Types you require have been
created, and you are defining a term,
click on the drop-down arrow and select
the appropriate Type.
This field applies the Type only to the
selected term; you can rename a Type for
all terms of that Type using the Glossary
view.

Description (Mandatory) Type the definition or
description of the term.
If necessary, format the text of this
description using the Notes toolbar at the
top of the field.

Limit
Display To

Click on the drop-down arrow and select
the appropriate glossary type to filter the
'Type | Term' list and show entries of that
type only.
Select the '<All>' option to display all
glossary entries.

New Click on this button to clear the dialog
fields so that you can define a new
Glossary term.
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Type | Term Review the list of defined glossary terms;
click on an entry to edit it in the dialog
fields.

Save Click on this button to save the new or
updated glossary entry.

Delete Click on this button to delete the entry
selected from the 'Type | Term' list.

Report Click on this button to generate and print
a Glossary Report.

Substituting Descriptions for Terms

You can use the Type of Glossary entries to replace all
terms of that Type in a report with the text string in the
'Description' field for each term.  For example, you might
define a Type of 'Abbreviation' and use that Type for a
number of terms such as Co, Bus and Corp, with the
respective descriptions of Company, Business and
Corporation; when you generate a report, the text Co, Bus
and Corp will be replaced with the corresponding
description.

You apply the glossary term substitution through the
'Generate Documentation' dialog - select the 'Publish >
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Model Reports > Report Builder > Generate Documentation'
ribbon option - as described in the Generate Documentation
Help topic. (This is separate from generating a report on the
Glossary itself.)

On the 'Generate' page, select the 'Markup Glossary1.
Terms' checkbox

In the 'Use Glossary Substitution' field, click on the2.
drop-down arrow and select the term Type. (You can only
substitute for terms of one Type at a time.)

When you generate the report, for all glossary terms of the
specified Type, wherever a term occurs in the report it will
be replaced by its description.

You should not set up term substitution in a model from
which you generate only HTML reports; the HTML report
generator does not substitute descriptions.

Notes

In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Manage Glossary' permission in order to create, update or
delete Glossary items; if security is not enabled, you can
manage Glossary items without any permissions
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Create a Glossary as a Package
Structure

Using the modeling approach to defining glossaries provides
great flexibility and additional features not available in the
dialog-list approach. In this approach the glossary, the
categories and the terms themselves are modeled as
first-class citizens. This allows the categories and the terms
to be located in the Browser window and visualized in
diagrams, and for the terms to participate in relationships
that model their semantic and lexical connections. The terms
can have additional properties defined, such as an alias or
status, or any user-defined property such as Custodian.
Hyperlinks can also be added that target an online resource
used to define or clarify the term, and discussions can be
posted to facilitate the collaboration needed to ensure all
stakeholders agree on the term's name and meaning.
Governance and fine-grained control of the creation and
update of the Glossary content can be added down to a term
level, using the Package and element locking feature in
conjunction with model security.

You can define your Project Glossary using a model
structure in which the Glossary itself is represented by a
Package, and each type of term (such as Business terms or
Technical terms) is represented by a child Glossary
Category Package containing Glossary Entry elements that
define the terms. The structure resembles this illustration:
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Business Terms

GlossaryCategory

Technical Terms

GlossaryCategory

A Business Term

GlossaryEntry

A Technical Term

GlossaryEntry

Another Type of Term

GlossaryCategory

The Glossary Package is an optional convenience to collate
Glossary content - the Glossary loader searches for and acts
on the Category Packages which, with their Entry elements,
can actually live anywhere in the model.

Anything you create or edit in the structure becomes active
after you reload the Glossary. That is, a term defined in the
Glossary is underlined and, when you move the cursor over
it, the term, category and definition display in either a
pop-up text box beside the term or at the bottom left of the
screen in the Status Bar (depending on which location you
have set in the 'Window Behavior' page of the 'Preferences'
dialog).

The advantages of using this method are:

You can set up the structure to create a functional·

Glossary very quickly

It is extremely easy to add, change and remove categories·

of term, either on a diagram or in the Browser window
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You have great versatility in categorizing and changing·

the categories of defined terms

The ease and speed with which you can add and edit term·

descriptions and definitions

Glossary terms can be connected together to define·

semantic and lexical relationships

Security can be set at any level to apply governance and·

federated control on the terms

Discussions can be posted to assist with definition and·

clarification of the terms' meanings

Built-in or user-defined Properties can be added to the·

terms used to define meta-level information such as
status, alias, the business or technical custodian and more

The same modeling principles are used to manage
translation of the text you enter in Enterprise Architect; see
the Create a Translation Glossary Model Help topic.

This feature is available in Enterprise Architect from
Release 15.1 onwards.

Set up the Glossary Model

The first stage in setting up your Glossary model is to locate
or create the parent Package for the Glossary. This could be
directly as a Root Node, a View, a Model Package (created
from the Model Wizard) or one or more simple Packages.
Your choice depends on how you want the Glossary
structure to sit within your overall Project.
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The simplest and most structured method is to create a
model using the Model Wizard.

In the Browser window, click on the host Root Node,3.
View or Package for the Glossary (perhaps within an
Administration or Resources section of your project).

Click on the  icon in the Browser window toolbar. The4.
Start Page displays at the 'Create from Pattern' tab.

Click on the <perspective name> button just underneath5.
the tab name, and select 'Publishing | Glossary'. The
Glossary Perspective patterns list displays, providing a
number of options that are described later in this topic; for
this process click on 'Structured Model Glossary
Template'.

Click on the Create Model(s) button. A Glossary Package6.
is added to the Browser window under the host Package,
containing a Glossary diagram and a
<<GlossaryCategory>> Package, which in turn contains a
Category diagram and a <<GlossaryEntry>> element.
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In the Browser window, click on the7.
<<GlossaryCategory> Package and, using the Properties
window (press Ctrl+2 if it is not open), change the name
to represent the first of your glossary categories, such as
'Business Terms'. Do the same thing with the name of the
diagram in the <<GlossaryCategory>> Package.

In the Browser window, click on the <<GlossaryEntry>>8.
element and change the name to the first of the glossary
terms in the current Glossary Category; for example,
'BPMN'.

In the Notes window for the element (press Ctrl+3 if the9.
window is not open) type the description or definition of
the term.

You now have the structure of the Glossary model with one
term definition in one of the term categories.

Right-click on the name of any GlossaryCategory Package
or GlossaryEntry element in the Browser window and select
the 'Reload Glossary' option. Choose an object in the model
and type your term in the Notes window, then move the
cursor over that term.  You will see the term description or
definition in either a pop-up text box or the Status Bar, as
defined in the 'Preferences' dialog.

If the description is too long to display in the initial location,
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press Ctrl and click the left mouse button to display the
Project Glossary View. This shows the details of all
Glossary items, including the definition of each item.

If a term has more than one definition (as might occur with
multiple technologies and/or pre-defined text translations)
all definitions are shown in the tool-tip, although they are
listed as separate items in the Project Glossary View.

Add Categories and Terms to the Model

Having set up the basic structure of the Glossary model, you
can create further categories and add terms to each category.

Your first step is to double-click on the Glossary diagram
name in the Browser window, to open it. You will see that it
contains the initial <<GlossaryCategory>> Package
element, itself listing the first <<GlossaryEntry> element.
The Diagram Toolbox will also open at the 'Glossary' page,
containing the Glossary Category icon.

For each Glossary Category you want to group terms10.
and definitions under, drag the Glossary Category icon
from the Toolbox onto the diagram and provide a name
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for it, such as 'Technical', 'HR' or 'Management'. A
<<GlossaryCategory>> Package is created on the diagram
and in the model.

Save the diagram.11.
«GlossaryCategory»
Business

«GlossaryCategory»
HR

«GlossaryCategory»
Technical

+ BPEL

+ BPMN

+ Business Rule

«GlossaryCategory»
Management

You can now add Glossary Terms to each of the categories.
This is one method - you can also add the Glossary Entry
elements via other windows and views, and directly through
the Browser window. See the Create Elements Help topic.

Double-click on the first Category Package under which1.
to define some terms. A new diagram opens with the same
name as the Category, and the Toolbox displays the
'Category' page, containing the Glossary Entry icon.

For each term you want to define in this category, drag2.
the Glossary Entry icon onto the diagram. A
<<GlossaryEntry>> element is created on the diagram
and in the model.

Double-click on the element and, in the 'Properties'3.
dialog, type the term being defined in the 'Name' field and
the definition of the term in the 'Notes' panel. Click on the
OK button. You begin to build up the set of Glossary
terms relevant to the category.
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«GlossaryEntry»
BPEL

Business Process 
Execution Language 
(BPEL), short for Web 
Services Business 
Process Execution 
Language (WS-BPEL), 
is an executable 
language for 
specifying interactions 
with Web Services.

«GlossaryEntry»
BPMN

Business Process 
Model and Notation 
(BPMN) is a standard 
for business process 
modeling that 
provides graphical 
notation for specifying 
business processes.

«GlossaryEntry»
Business Rule

Business Rule 
modeling captures the 
rules that govern a 
business, and their 
relationships with the 
entities and specific 
tasks within the 
organization or 
system.

«GlossaryCategory»
Technical

+ BPEL

+ BPMN

+ Business Rule

(from Glossary Model)

Again, save the diagrams, right-click on the name of any
GlossaryCategory Package or GlossaryEntry element and
select the 'Reload Glossary' option to activate the new
terms in the Glossary of the model.

Create a Domain-Specific Glossary

You can create a number of types of Glossary to suit your
requirements, either under one overall Glossary Package or
dispersed under separate context-Glossary Packages, or
even as individual GlossaryCategory Packages. One
example of a glossary type is the natural language
Translation model, which is discussed in the Create a
Translation Glossary Model Help topic. Others include
Glossaries specific to, say, individual modeling languages or
development domains.
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You can create domain-specific glossaries from scratch.
However, Enterprise Architect provides patterns to help you
load a number of ready-made domain glossaries. To see
those available, on the Start Page 'Create from Pattern' tab
(Model Wizard) click on the <perspective name> button,
select 'All Perspectives' and set the filter field directly
underneath it to 'Glossary'.

Amongst the patterns listed you will see those for glossaries
of BPMN terms, SysML terms, BABOK terms and TOGAF
terms. You can simply create glossaries directly from these
patterns and - if necessary - add to or edit the term
definitions. If a pattern does not exist for your required
modeling language or domain, you could use one of the
listed patterns and more radically edit the resulting glossary
to adapt it to your language or domain.

Create an Ad-Hoc Glossary
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Whether you have a structured glossary model or not, you
might find that you need to define or capture a set of terms
quickly, or without any real consideration for what specific
category they might belong to. For example, you might have
a solid glossary for SysML but decide to define a number of
more general MBSE terms or more localized company
jargon terms.

In these contexts, you can use the Glossary Definition
Diagram pattern to create an empty diagram in which you
can create GlossaryEntry elements or into which you can
drag any other type of existing element from the Browser
window.  The only things to consider are:

The diagram name should indicate some relationship with·

the glossary, such as 'Unassigned Glossary Terms'

The element name should represent the term and·

The element notes should provide an appropriate·

definition or description of the term

Once the elements are on the diagram, just right-click on the
name of any GlossaryCategory Package or GlossaryEntry
element and select the 'Reload Glossary' option. The
element names and notes text are added to the glossary, and
when you mouse-over the term in text, the definition
displays preceded by the diagram name, identifying where
the definition is held.

Notes
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In the Corporate, Unified and Ultimate Editions of·

Enterprise Architect, if security is enabled you must have
'Manage Glossary' permission in order to create, update or
delete Glossary Categories and Entries; if security is not
enabled, you can manage Glossary items without any
permissions

Glossary Categories defined as Packages in the model are·

not offered as 'Type' options in the 'Glossary Detail'
dialog; to assign dialog items to the same category as
model items, you have to specify the category as a new
type in the dialog (click on the  icon at the end of the
'Type' field)

In the Project Glossary View the items created as model·

elements (Model Item = True) have different context
menu options to those generated though the 'Glossary
Detail' dialog; for example, you cannot add or delete
Model Items in the Project Glossary View
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Create a Translation Glossary Model

A Translation Glossary model is a variant of your overall
Glossary model. If you are not yet familiar with the
structure of a Glossary model, see the Create a Glossary as
a Package Structure Help topic.

The Translation model is a reference for the automatic
Translation facilities. The model defines terms that should
not be translated (such as product names) or terms that
should be translated to a specific word or phrase, either
whenever it is encountered or when a specific instance of
the term is flagged. The automatic Translation facilities
check the model and substitute and protect the defined terms
in the Notes text before calling the Google, Windows or
custom translator to freely translate the rest of the Notes
content.

Like the elements of the overall Glossary, the Translation
model elements also show the 'meaning' of the term - any
specific translation of the term in each configured language,
or a block against translation - in the in-text pop-up
messages, Status bar messages and Project Glossary View
entries. You can therefore check what is defined for a term
by moving the cursor over it.

The Translation GlossaryCategory Packages can be children
of a top-level Glossary Package, their own
<language>-Glossary Packages or any other convenient
Package in the model. You would typically have a global
translation category (primarily for terms that are not to be
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translated), a category for each configured language, such as
French, German and Chinese, and one or more categories
for 'special use' terms that have defined translations only in
certain contexts - such as when used in a menu path. The
translation facilities are already configured to check the
language-specific categories, but when you flag a 'special
use' term a prompt displays for you to specify which
category contains the translation to use.

An overall Glossary model with translation categories might
have this organization:

tx-chinese

GlossaryCategory

tx-french

GlossaryCategory

tx-global

GlossaryCategory

tx-german

GlossaryCategory

Groups of Term Definitions

GlossaryCategory

Context Translation
Categories

GlossaryCategory

Glossary Model

Term Definition

GlossaryEntry

Term Translation
Blocked

GlossaryEntry

Translation into
Specific French

GlossaryEntry

Translation into
Specific German

GlossaryEntry

Translation into
Specific Chinese

GlossaryEntry

Translation of
Term in Specific

Context

GlossaryEntry

(The standard Model Glossary, defining 
business, technical and other terms in use.)
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Set up the Translation Model

Locate or create the parent Package for the translation
GlossaryCategory Packages (such as an overall Glossary
Package -  see the Create a Glossary as a Package Structure
Help topic.)

The Glossary diagram for translations will contain
GlossaryCategory elements for the global translation
process, for each language your project team will translate
text into, and at least one 'special case' where words in one
context must be translated differently from the same words
in a different context. You therefore need to plan what
categories you require, especially the types of special case
you might need to prepare for.  For each language
translation Package, give the Package the name
tx-<language>; for example, tx-french. An overall Glossary
model content, as it is being developed, might resemble this
example:
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«GlossaryCategory»
Language 3 Text

«GlossaryCategory»
Language 2 Text

«GlossaryCategory»
Other P Defs«GlossaryCategory»

Project Definitions

+ Activation

+ Boundary

+ Delegate

«GlossaryCategory»
tx-global

+ Add-In

+ Amazon Web Services

+ Cloud

+ ORACLE

+ Unified Modeling Language

+ Wide Area Network

«GlossaryCategory»
tx-french

+ Business Process

+ Business Process Execution Language

+ Model Guidance

+ National Information Exchange Model

«GlossaryCategory»
tx-<language2>

«GlossaryCategory»
tx-<language3>

«GlossaryCategory»
Language 1 text«GlossaryCategory»

French Context

+ C:\Program Files (x86)\Sparx Systems\Cloud Services\Service\Models\

+ C:\Program Files (x86)\Sparx Systems\Pro Cloud Server\

«GlossaryCategory»
Language 2 Context

«GlossaryCategory»
Language 3 Context

Each GlossaryCategory Package will have its own
GlossaryCategory diagram, to which you add GlossaryEntry
elements. A GlossaryEntry element defines how a text string
or term (the name of the element) is processed in translation
- whether it is blocked against translation or whether it is
pre-set with a specific translation in the corresponding
language and/or under a certain condition. You therefore
also need to consider what terms you will use that require
special treatment in the translation process. A
GlossaryCategory diagram might resemble this example:
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«GlossaryEntry»
Business Process

Processus Métier

«GlossaryEntry»
Model Guidance

Guidage de Modèle

«GlossaryEntry»
National Information

Exchange Model

Modèle National 
d’Échange de 
l’Information 
(NIEM)

«GlossaryEntry»
Business Process

Execution Language

#

If you want to block the translation of a term, type a hash (#)
as the complete notes text for the element, as shown for the
Business Process Execution Language element in the
diagram. If you want to provide a specific translation of the
term, type that translation into the notes text as shown for
the other elements in the diagram.
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Glossary Styles

When you are defining your Glossary terms, you can also
define a documentation style to apply to terms of a specific
Term Type. When you generate RTF, PDF or DOCX
documents those terms are shown in the defined color, font
and/or emphasis. This applies a visual key to the Glossary
terms of each Type, and makes it easier for the reader to
recognize all the terms for which they can obtain a
definition or explanation.

You apply the glossary styles through the 'Generate
Documentation' dialog (as described in the Generate
Documentation Help topic). You should not set up glossary
styles in a model from which you generate only HTML
reports; the HTML report generator does not apply glossary
styles.

Configure Glossary Styles

You configure Glossary styles within a Glossary Style
Sheet, using the 'Glossary Markup' dialog; you display this
dialog from the Glossary View. For each Glossary Term
Type, you define one style in the Style Sheet, using the
standard CSS style definition language. This is an example
of two style definitions in a style sheet:

.paragraph {
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       font-family: courier;

       font-size: 16px;

       font-weight: italic;

       color: #FF0000;

       background: none;

       text-transform: capitalize;

}

.language-term {

       font-family: arial;

       font-size: 14px;

       font-weight: bold;

       color: #800000;

       background: none;

       text-transform: capitalize;

}

Access

Ribbon Design > Dictionary > Glossary >
Glossary View > Right-click > Assign
Markup Styles
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Define Styles

Assign one style to each of the Glossary Term Types, which
have been defined on the 'Glossary' dialog.

Option Action

Term This column lists the existing Term
Types in the Glossary.

Style Name This column identifies the style assigned
to each Term Type. If no style has been
assigned, the field is blank.
To assign or switch the style,
double-click on the row, type the style
name on the 'Input' prompt and click on
the OK button. If the name contains more
than one word, link the words with
hyphens.
The new style name is added to the top of
the 'CSS' panel.

CSS Between the parentheses under the style
name, type in or copy/paste the new style
definition, or edit an existing definition.
The styles are created one after another
within the single style sheet for the
Glossary.
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OK Click on this button to save changes to
the style definitions and close the dialog.

Using Glossary Styles

You use Glossary Styles to identify and highlight Glossary
terms in your printable reports, and to indicate what kinds of
term they might be. You can also use the terms as
place-holders for more complex text strings in the term
definitions, so that the report generator substitutes the text
string for the place-holder term. Both text formatting and
text substitution are enabled by selecting options on the
'Generate Documentation' dialog (click on a Package or
element and press F8).

Configure Reporting for Glossary Styles

You can apply glossary styles to your RTF, PDF or DOCX
documentation through the 'Generate Documentation' dialog
(select 'Publish > Model Reports > Report Builder >
Generate Documentation').

Task Action

Using the Select the Markup Glossary Terms
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Markup Style checkbox to apply, in the generated
report, any styles applied to any Glossary
terms through the 'Notes' text of an
element.
A style is applied to a Glossary term
according to its Glossary Term Type.

Notes

You can copy the Glossary Style Sheet between models as·

reference data, using the 'Settings > Model > Transfer >
Export Reference Data' and 'Import Reference Data'
ribbon options
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Generate a Report

You can generate a rich text format (RTF) file of your
model's glossary, which you can either print or attach to any
other appropriate document file.

The file can contain all glossary entries, or just those of
selected Types.

Access

Ribbon Design > Dictionary > Glossary > Edit :
Report

Generate an RTF report of the Project
Glossary

Ste
p

Action

1 In the 'Filename' field, type or select a filename for
the glossary.

2 In the 'Heading' field, type a suitable heading for the
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glossary.

3 In the 'Include Glossary Items' panel, select the
checkbox for each type of glossary entry to include.
To select all types of entry, click on the Select All
button.

4 If necessary, to define the page setup for the report,
click on the Page Setup button and complete the
'Page Setup' dialog.

5 If you want to substitute certain system-defined
words for others that might be more meaningful to
your readers, or print the whole report in another
language, click on the Language button and define
your output on the 'Customize RTF Language'
dialog.

6 To include page breaks, select the 'Page break
between sections' checkbox.

7 Click on the Generate button to generate the report.

8 Click on the View button to open the report.
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Glossary Report Output Sample

An example of the output from a Glossary report is shown
here:

Glossary

Business Terms

Accounting Periods

A defined period of time whereby performance reports can
be extracted (normally 4 week periods).

Customer

A person or a company that requests an entity to transport
goods on their behalf.

Technical Terms

Association

A relationship between two or more entities. Implies a
connection of some type - for example, one entity uses the
services of another, or one entity is connected to another
over a network link.
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Component Model

The component model provides a detailed view of the
various hardware and software components that make up the
proposed system. It shows both where these components
reside and how they inter-relate with other components.
Component requirements detail what responsibilities a
component has to supply functionality or behavior within
the system.

Deployment Model

A model of the system as it is physically deployed.

Extends Relationship

A relationship between two Use Cases in which one Use
Case 'extends' the behavior of another. Typically this
represents optional behavior in a Use Case scenario - for
example a user might optionally request a list or report at
some point in a performing a business Use Case.
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Manage Model Change

As users contribute new content and change existing
content, a repository will become a valuable data store of
organizational information assets. It is imperative that this
asset is protected and changes are managed and controlled
including being able to revert models back to previous
versions or states. Enterprise Architect has a number of
sophisticated tools to ensure the information is protected,
including full integration with all the leading Version
Control Systems, Baselines that are snapshots of your model
that can be taken at important milestones, and Auditing that
can track the finest changes to a model. A Project Transfer
function helps you to make backups of models without
involving information technology personnel. There are also
Model Validation and Project Integrity Checkers to ensure
the repository is maintained with a clean bill of health, and
an effective role based Security System to ensure users can
collaborate easily and sections of the model can be locked to
users or groups.

Facilities

Facility Detail
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Baselines Baselines create snapshots of model
content; a changed model can then be
compared to the snapshot and changes
can be reverted to the Baseline content if
required.

Baselines are created at the Package·

level providing snapshots of an entire
Package including elements, features
and diagrams  and optionally also the
Packages it contains
As a model is altered the changed·

Package can be compared with a
baseline, including visual diagram
changes and, if required, the current
model can be reverted to the content
stored in the Baseline
Baselines require no setup and provide·

an easy way for business and technical
users to  restore models to previous
states at any level of granularity
Baselines created for Package-trees can·

be published for external use via the
Reusable Asset Service (RAS)

Reusable
Asset Service

The RAS portion of the Pro Cloud Server
helps you to define Packages that can be
used in any model. A registered
Package-tree includes:
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Version of the Package held in the·

registry
Diagrams and elements (including·

child Package elements) contained by
the Asset Package
Dependencies on parent Packages of·

any external elements that the Asset
Package references
Dependencies on MDG Technologies.·

This makes everything required by that
Package available to any repository that
has access to that RAS, as well as
features for comparing that RAS Package
against a Package in the current model.
The RAS service can also host Baselines.

Auditing Auditing records changes to the content
in a repository and provides a practical
view that can be used to drill down into
changes from the Package level down to
changes to element features.

Auditing is typically used by librarians·

and administrators to investigate who
made a change to the model and the
date and time it was changed
It can be used to locate problems in·

model development or for contractual
reasons where third parties have been
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given access to manage model content
and the source of a change needs to be
identified
Auditing can be enabled and disabled·

at any time and the audit logs can be
saved and reload as needed

Version
Control

Version Control allows model content to
be versioned allowing check-out and
check-in of Packages to facilitate keeping
track of different versions of parts of the
model and allowing rollback to prior
versions.

Coordinate sharing of Packages·

between users, with either read-only
access or update access, ensuring that
work on different areas of the model is
coordinated and synchronous rather
than conflicting
Allow check-out and check-in of·

Packages to and from working storage
including users working offline.
Save and retrieve a history of changes·

to Packages
To use Version Control in Enterprise
Architect, you require a third-party
source-code control application such as:

Subversion·

(c) Sparx Systems 2022 Page 1594 of 1974



Modeling Fundamentals 3 October, 2022

CVS·

MS Team Foundation Server (TFS), or·

Any other Version Control product that·

complies with the Microsoft Common
Source Code Control standard

Compare
Projects

The Compare Project facility, compares a
Source and Target Repository for
differences and provides a summary of
the changes to a repository, as a
comparison of the number of rows in
each table in the source and the target
repositories.

Project Data
Transfer

Enterprise Architect enables you to
transfer project data between project data
repositories either for:

Sections of the project (XMI and CSV)·

or
The whole project, row by row, table·

by table (in the Corporate, Unified and
Ultimate Editions of Enterprise
Architect)
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Tracking Change

If you want to track changes to data across your project, you
can use two separate but complementary facilities - Auditing
and Baselines.

Facilities

Facility Detail

Auditing of
model
changes

Auditing is a project-level feature,
available in the Corporate, Unified and
Ultimate Editions, that enables you to
record model changes in Enterprise
Architect.
By enabling this feature, model
administrators can view a range of
information regarding changes, such as:

Who changed an element·

How many elements they changed·

When they changed the data·

What the previous values were, and·

What type of elements they changed·

Baselining
and

The Enterprise Architect Corporate,
Unified and Ultimate Editions provide a
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differencing
to capture
and roll back
changes

facility to ' baseline ' or snapshot a model
branch in XMI format at a particular
point in time, and store it within the
model in compressed format.
More than one baseline can be stored
against a single Enterprise Architect
Package; using baselines, you can
compare Packages at the current and
earlier stages of development, using the
Compare (Diff) utility.
The Compare utility is available in the
Professional, Corporate, Unified and
Ultimate Editions of Enterprise Architect;
it enables you to compare the current
model with:

A Baseline·

An exported Enterprise Architect XMI·

file in the file management system
A version-controlled Enterprise·

Architect XMI file in the file
management system
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Baselines

Baselines are snapshots of parts of the repository at a given
point in time, that can be used for later comparison and
restoration, if required.

A Baseline creates a snapshot of a model Package and its
contents at a point in time and, as the model changes, allows
you to compare the current state and the snapshot; if
required you can revert to the previous (baselined) state.
Baselines are created at the Package level and can include
child Packages; any number of Packages can be baselined,
and a Package can be baselined any number of times,
typically at important project milestones. Baselines are by
default conveniently stored within the repository making
them available to any model user who has the security
privileges to work with them. Alternatively, a Baseline can
be stored in a Cloud-based Reusable Asset Service. These
options will be explored in a later topic.

This diagram illustrates the Baseline comparison tool,
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showing model and Baseline properties; Status and Version
have changed.

Baselines are a type of insurance policy that ensures you can
always revert to a previously captured state. In this topic
you will learn how to create Baselines, and some of the
common business and technical purposes of the technique.
You will also learn to use the comparison tool, which allows
you to identify what has changed in the model since a
Baseline (snapshot) was created. You can reverse changes
back to the Baseline state at any level of granularity. This
will be indispensable when working with Project Teams
using conventional or agile techniques, or, where there are
important governance or contractual requirements to
manage change.

Current Repository or Reusable Asset Service

Baselines can be stored in the same repository in which the
source Packages are located. They can also be stored in a
Reusable Asset Service (RAS), and made accessible to users
working on other repositories that have access, via a Pro
Cloud Service, to the RAS repository.

These topics discuss the management of Baselines,
including exploring the options and benefits of storing them
in the repository or, alternatively, in a Reusable Asset
Service (RAS).
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Brief Introduction

Baselines are easy to set up and require only a small amount
of meta-data, such as the Version Number and some Notes
that are pre-filled with the time and date the Baseline was
created. You can add your own comments such as 'After
Requirements Sign-Off' to indicate the significance of a
milestone or reason for the Baseline.

The basic steps in working with Baselines are:

Create a Baseline - this will be for a selected Package and1.
optionally its child Packages.

Compare the model to the selected Baseline - there can be2.
multiple Baselines of the same Package.

Revert the model to one or more Baseline items - or3.
choose to ignore the differences.

It is important to understand a fundamental difference
between Baselines and Version Control. Baselines are
user-initiated, so if a user has not created a Baseline for a
given Package at a previous time it is not possible to
compare the model to an earlier 'version'. However, once
Version Control is set up for a Package, any changes that are
made to the Package will be automatically versioned and
will be available at a later time. These two facilities can be
used in conjunction and it would be the responsibility of a
Librarian or Administrator to determine how best to use
them together.

Baselines are stored in the same XML format as is used for
Version Control, but are stored in compressed format either
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within the project or in a Reusable Asset Service Registry.
By default, Baselines are stored within the model; you can
save a Baseline to an external XML file for storage or
archive, or for distributing to other users working on models
derived from a master project.

Creating Baseline

With a Package selected in the Browser window, choose the
'Create Baseline' option to create a new Baseline of the
selected Package. You will be required to complete some
details for the Baseline, as indicated:

New Baseline window showing details entered when
creating a Baseline, including the version number.

Version - a user defined version number used to identify·

the Baseline when running comparisons

Include sub-packages - choose whether to Baseline·

subordinate Packages as well as the main Package

Notes - used to describe the Baseline; e.g. 'Requirements·

Sign-Off' pre-filled with the Baseline time and date
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Comparing to the Model

The management of baselines makes use of the comparison
tool and presents a tabular presentation of the differences.
The comparison tool shows the differences between the
elements, their properties and features, relationships or
visual changes in diagrams at the current time and the time
of the baseline or model export. A tree view presents the
comparison items and can be used to navigate through the
changes which are presented on the panel on the right hand
side.

Reverting to Baselines

Once the comparison (differencing) is complete, you can
revert changes by merging information from the Baseline
into the current project; it is not possible to go the other
way.

You can:

Merge information manually, change by change·

Merge information automatically by electing to merge in·

all changes in one batch procedure

Revert completely to the original Baseline by importing·

the stored XMI directly

Merge information and elements from a Baseline in a·

different project, making it possible to keep multiple
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versions of a single model in synch

The merge options are available through the toolbar, context
menus and the keyboard on the 'Compare Utility' view,
which shows the results of a comparison.

Visual Differencing

Changes to a model might include:

Adding or removing or changing elements and connectors·

on a diagram, or

Changing the position of elements or the overall layout of·

a diagram

You might believe that a diagram has changed, and select to
compare it with a baseline using a ribbon option.
Alternatively, you might perform a baseline comparison on
a Package or a model and select from the comparison output
any diagrams that are flagged as changed.

Visual (diagram) differences for a number of existing and
new requirement elements.
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Creating Baselines

This topic details the basics of creating new Baselines of
model Packages. You can create Baselines in the model
(using the 'Baselines' dialog) or in a Reusable Asset Service
Registry (using the 'Reusable Asset Service - Baseline'
view). The appropriate screen displays by default according
to whether the 'Store Package Baselines in a Reusable Asset
Service Registry' checkbox is selected on the 'Baselines'
page of the 'Manage Model Options' dialog.

Access

Select a Package in the Browser window, then open the
appropriate screen for the storage system using one of the
methods outlined here.

Ribbon Design > Package > Manage > Manage
Baselines : 'Baselines' dialog : New
Baseline (or)
Design > Package > Manage > Manage
Baselines : 'Reusable Asset Service -
Baseline' view : New

Keyboard
Shortcuts

Ctrl+Alt+B : 'Baselines' dialog > New
Baseline (or)
Ctrl+Alt+B : 'Reusable Asset Service -
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Baseline' view : New

Create a new baseline

Field Action

Name Display the Package name of the
currently selected model branch.

Version Type a unique version reference for this
Baseline, which can consist of any
alphanumeric characters.
The 'Package Baselines' dialog sorts the
Baselines according to the value of this
field.

Include
sub-Packages

Include the entire sub-Package hierarchy
of this branch in the Baseline; this option
defaults to selected.
If you deselect the checkbox, only the
immediate contents (XMI stubs) of the
Package are included in the Baseline.

Note Edit the default current time and date to
any other value.
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The field is a single-line entry, for display
on the 'Package Baselines' dialog (a
one-line-per-entry list).

OK Click to create a new Baseline and return
to the 'Package Baselines' dialog.
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Compare a Model to Baselines

A Baseline is created with an intention that it could be
required as a backup or point of reference at some time in
the future, so that a model that has changed can be
compared with the snapshot and differences determined.
This might be required just to identify that differences exist,
or so that the entire Package or individual changes can be
rolled back to the state contained in the Baseline (snapshot).

The first step in this process is to locate the required
Baseline and then to identify the differences. The Baseline
Comparison tool can be used to visualize the changes that
have occurred between the time of the Baseline and the
current time. Individual changes are not recorded as they are
in the auditing facility, but rather the accumulative results of
the changes are presented.

Find Baselines

You can locate the Baselines for a model by selecting a
Package in the Browser and then opening the Manage
Baselines window. In the event that you have forgotten or
are unsure of the location of one or more Baselines you can
use the Model Search utility to locate all Packages that have
Baselines. The window conveniently displays the name of
the Package and the Baseline Version, Date and Notes.
From this window you can locate the Package in the
Browser window and then launch the Manage Baselines
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window.
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The Compare Utility (Diff)

Enterprise Architect has a comprehensive built-in Compare
(diff) utility, which enables you to:

Explore what has changed within a model over time·

Explore how previous versions of a model branch differ·

from what is currently in the model

Perform a full model comparison by exporting all of·

Model A to XMI, then using 'Compare Model to File'
from within the current model (Model B)

Comparing and checking model development at various
points in the process is an important aspect of managing
change and development, monitoring what is being modified
and ensuring the development and design process is on
track.

Using the Compare Utility you can Compare a model
branch in Enterprise Architect with:

A Baseline created using the Baseline functionality·

(Corporate, Unified and Ultimate Editions)

A  Baseline stored in a different model·

An XML 1.1 file created previously using the Enterprise·

Architect XML export facility (user selects file)

The current version-controlled XMI 1.1 file as created·

when using Version Control in Enterprise Architect (file
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automatically selected)

Access

Select a Package in the Browser window, then open the
'Baselines' dialog or 'Reusable Asset Service - Baseline'
view (depending on whether Baselines are stored in model
or in a Registry) using one of the methods outlined here.

Ribbon Publish > Model Exchange > Package
Control > Compare Package to XMI
Design > Package > Manage > Manage
Baselines : Show Differences ('Baselines'
dialog)
Design > Package > Manage > Manage
Baselines : Compare ('Reusable Asset
Service - Baseline' view)

Keyboard
Shortcuts

Ctrl+Alt+B : Show Differences
('Baselines' dialog)
Ctrl+Alt+B  : Compare ('Reusable Asset
Service - Baseline' view)

Differencing With Baselines
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As a Baseline contains all information about elements and
connections for a Package at a point in time, it can be used
within Enterprise Architect to track changes to model
elements over time.

The Differencing engine first builds a representation of the
current Package in memory, based on what is currently in
the model.

It then compares this with the stored Baseline, highlighting
changes, new elements, missing elements and elements that
have been moved to other Packages.

It is possible to filter the resultant output to display only one
particular kind of change: for example, additions to the
model.

If a Baseline has been created to ignore child Package
content, a comparison between that Baseline and the model
does not include any child Package content in the model.

See the example provided in the Example Comparison Help
topic.

Notes

This utility is available in the Professional, Corporate,·

Unified and Ultimate Editions of Enterprise Architect

You cannot compare the current model with an XMI 2.1·

file; the utility can only compare with an XMI 1.1 file
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Compare Options

You use the 'Baseline Compare Options' dialog to refine the
output of the Compare utility when it compares the current
model with a Baseline.

To display the dialog, either:

Click on the Options button on the 'Package Baselines'·

dialog, or

Click on the 'Compare Options' icon in the 'Compare·

Utility' view toolbar

If the 'Compare Utility' view shows the results of a Baseline
comparison, when you click on the OK button the display
refreshes to refine the information according to the options
you have selected.

Options

Option Action

Always
Expand to
Differences

Always display the list of elements fully
expanded to show changes.
If you deselect the checkbox, when the
'Compare Utility' view is first opened it
lists the Package contents to element
level, and you expand each element as
required to show the changed items.
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For large branches of the model, it is
better to leave the checkbox unselected.

Show
Elements that
are

List elements that:
Have been changed since the Baseline·

was created
Are in the Baseline only (that is, have·

been deleted from the model since the
Baseline was created)
Are in the model only (that is, have·

been created since the Baseline was
created)
Have not changed since the Baseline·

was created (you might generally leave
this checkbox unselected)

Suppress
these
Changes

Exclude:
Changes to diagrams·

Changes to the 'Date Modified' field for·

an item
Changes to the 'Date Created' field for·

an item
Child items of a deleted item·

Changes to advanced properties·

(defaults to selected)

Baseline
Diagram

Select the checkbox to always open the
first parent Package for which there is a
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Compare
Option

Baseline, when you select the diagram for
comparison from the Browser window.

Notes

Package Baseline facilities are available in the Corporate,·

Unified and Ultimate Editions of Enterprise Architect
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Example Comparison

This diagram shows the result of a comparison between a
Package (Log in/out Use Cases) in the current project and
that Package in a Baseline captured at an earlier date.

The results of the comparison are displayed on the
'Comparison Utility' view.

Review Changes

Aspect Description

Interpretation A hierarchy of model elements is
displayed in the left-hand pane.
From the triangle-based icons and the
highlighted lines on the report, it is
clearly visible which items in the
hierarchy have, since the Baseline was
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captured, been:
Changed·

Deleted from the model (in the·

Baseline only)
Added to the model (in the Model·

only) or
Switched to different Packages·

(changes in the Parent Package
property)

If you click on an item in the left hand
pane, the right-hand pane displays a table
of properties showing the values of those
properties in the current model and in the
Baseline.
For each property where there is a
difference between the model and the
Baseline, the row is highlighted.
The 'Compare Utility' view enables you
to perform operations (such as merging or
rolling back changes) on the reported
information, using the toolbar, context
menu and keyboard.

Increase
Level of
Detail

The right panel of the 'Compare Utility'
view might, for some fields, display only
part of the value.
It might also not be immediately obvious
what a change is.
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In either case, you can double-click on
the property to display full details and to
highlight the exact differences; this
example shows the highlighted changes
to the 'Name' property.

Notes

The Compare utility is available in the Professional,·

Corporate, Unified and Ultimate Editions of Enterprise
Architect
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Compare Utility View Options

The 'Comparison Utility' view enables you to perform
operations on the reported information, using the toolbar,
context menu, 'Merge' dialog and certain keyboard keys.

The toolbar is at the top of the left-hand panel; the icons·

operate either on the comparison as a whole or on the
currently-selected item in the left hand panel of the
'Comparison Utility' view

Each item in the hierarchy has a context menu, which you·

display by right-clicking on the item; the options
displayed depend on the level of the item in the hierarchy

The 'Merge' dialog enables you to specify which changes·

to roll back in the model from the baseline

You can use a selection of keyboard keys to move up and·

down the hierarchy, or to roll back changes

Toolbar Options

Option Action

Refresh Re-run the comparison to refresh the
current display.

Merge To Merge the values of the
currently-selected item in the Baseline
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Model back into the model.

Next Change Highlight the next changed item (this
skips Moved items).

Previous
Change

Highlight the previously-changed item.

Expand All Fully expand the selected item.

Collapse All Collapse the changed items in the
selected item.

Expand To
Changed
Items

Expand the selected item to show
changed items only (in the event that you
have selected to also show unchanged
items in the comparison).

Find in
Project
Browser

Highlight the item in the Browser
window.

Log To XML Log the changes to an XML file.
A browser displays, on which you specify
the file name and location.

Compare
Options

Display the 'Baseline Compare Options'
dialog.
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Manage
Package
Baselines

Re-display the 'Package Baselines' dialog
or 'Reusable Asset Service - Baseline'
view, as appropriate.

Help Display the Help topic Package
Baselines.

Context Menu Options

Option Action

Merge from
Baseline
Add from
Baseline

Restore the item in the model to the
Baseline state, or restore a deleted item
from the Baseline.

Delete from
Model

Remove a recently-created item from the
model.

Merge From
Baseline
(with
Options)

(For the root node of the hierarchy on the
'Compare Utility' view.)
Display the 'Merge' dialog, which you
can use to specify options for rolling back
the whole model branch to the Baseline
state.
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Refresh (Object-level items.)
Re-run the comparison to refresh the
current display.

Find in
Project
Browser

Locate and highlight the item in the
Browser window.

Open
Baseline
Diagram
Compare

(For a diagram listed in the comparison.)
Display the Baseline Diagram Compare
window, showing differences in diagram
content and layout.

Expand All Fully expand the selected item.

Expand To
Changed
Items

Expand the selected item to show
changed items only.

Collapse All Collapse the changed items in the
selected item.

Log To XML Log the changes to an XML file.
A browser displays, on which you specify
the file name and location.

Baseline
Compare

Display the 'Baseline Compare Options'
dialog.

(c) Sparx Systems 2022 Page 1622 of 1974



Modeling Fundamentals 3 October, 2022

Options

Merge Dialog Options

Option Action

Changed Restore all changed items in the model
branch to the Baseline state.

In Baseline
Only

Restore all deleted items to the model
branch from the Baseline.

In Model
Only

Remove all recently-created items from
the model branch.

Moved Restore all moved items to their original
locations, as identified in the Baseline.

Full Restore
from XMI

Completely restore the model branch to
the version held in the Baseline XMI 1.1
file, (using the 'XMI Import' function).
(This option automatically selects all the
other options)
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Keyboard Keys

Ctrl+ ↓ - expand and highlight the next changed item·

Ctrl+ ↑ - expand and highlight the previous changed item·

Ctrl+ ← - undo the changes for a selected item (roll back·

to the Baseline values)
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Visual Diagram Changes

The Baseline Diagram Compare feature is a quick and easy
way to visually compare a current diagram with an earlier
version from a saved Baseline, and highlight any elements
in the diagram that have been added, deleted, resized or
moved.

You can then review these changes and optionally roll back
individual changes if needed to their previous state from the
Baseline.

The changes are identified on the 'Baseline Diagram
Compare' dialog and on the diagram itself.

Access

Select the diagram to be checked, then apply one of these
access methods:

Ribbon Design > Diagram > Manage > Compare
to Baseline (on an open diagram)

Other Perform a comparison of a Package1.
and Baseline (see The Compare Utility
(Diff) Help topic).
Locate the diagram in the results on the2.
'Baseline Comparison' view.
Right-click on the diagram name and3.
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select the 'Compare to Baseline' option
to display the 'Baseline Diagram
Compare' dialog and to open the
diagram (refer to the Results section).

Multiple Owner Packages

When you create a Baseline, it can be for a Package that
contains one or more levels of child Package, and you might
create Baselines for the Package(s) at each level. If the
diagram you are checking is at a lower level in the
hierarchy, there might therefore be a number of Baselines
that contain information on the diagram, perhaps taken at
different times and capturing different changes to the
diagram.

When you open the diagram before performing the check,
and select one of the direct ribbon access paths, if the
diagram is referenced in multiple Baselines you might be
required to select the Package from which to use a Baseline,
on the 'Load Baselines from Package' dialog.
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The 'Load Baselines from Package' dialog provides the
facility to compare the diagram with one of a broader range
of Baselines than just those from the diagram's immediate
parent.

This dialog displays if you have NOT selected the 'Always
open first parent with a Baseline' checkbox on either:

The 'Load Baselines from Package' dialog itself or·

The 'Baseline Compare Options' dialog·

Selecting or deselecting the option in one location also
selects or deselects it in the other.

Click on the required Package, and click on the OK button.
In this case, or if the dialog did not display at all (the
checkboxes were selected), the 'Baselines dialog displays.
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Processing

Click on the required Baseline and on the Show Differences
button. The 'Baseline Diagram Compare' dialog displays.
Refer to the Results section and the Options table.

Results

The 'Baseline Diagram Compare' dialog shows the elements
that have been changed on the diagram, and what kind of
change was made (examine the 'Status' field).

As you select elements on the dialog, images are shown on
the diagram itself to indicate where the changed element
was and what kind of change it underwent.

Options
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Option Detail

Select (click
on) name of
element

The 'Status' column indicates whether the
element has been:

Moved or re-sized (Changed)·

Deleted from the diagram (Baseline·

only)
Added to the diagram since the·

Baseline was captured (Model only), or
Deleted from its parent external·

Package, and there is no record in the
current Baseline (because the Baseline
is only for the current diagram's parent
Package)
This diagram-linked element has been
deleted from the model. The element
might be found in a different baseline
either in a parent Package baseline or a
different Package baseline outside of
the current Package. If the external
referenced element is restored to the
model, the visual comparison will be
able to resolve the missing diagram
object in the current baseline.

When an item is selected, the
corresponding element on the diagram is
highlighted as shown:
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Deleted from the diagram·

Added to the diagram·

Resized or moved to a new position·

A deleted external element on the·

diagram

The highlighted element on the diagram
is marked with a colored dot, as shown,
to indicate that it is in focus.

Position the
diagram to
show the
selected
element

To scroll the diagram so that you can see
the original (Baseline) position of an
element, double-click on the item in the
list.
To scroll the diagram so that you can see
the current (model) position of the
element, press and hold Ctrl while you
double-click on the item.
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Leave the
changes in
the item as
they are

Ensure that the checkbox against the item
is not selected.
Click on the OK button.

Roll the
changes back
to the
Baseline
position

Click on the checkbox against each
required item (or click on the Check All
button to select every item).
The 'Action' column displays the action
required to roll each element's
relationship to the diagram back to the
Baseline relationship, and on the diagram
the selected elements are represented as
shown:

This deleted element will be restored·

This added element will be removed·

This resized/repositioned element will·

be put back in its original position

This element from another Package,·

deleted from the diagram, cannot be
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restored from this Baseline

The comparison automatically shows a
blue direction arrow for each reposition
or resize that has been checked. For a
heavily edited diagram this might be
confusing. However, you can hide the
arrow for all elements except the one
currently in focus; to do this:

Deselect the 'Visually link new and old·

position for checked items' checkbox
To roll back the changes for all items for
which a checkbox is selected:

Click on the Apply button·

Notes

Diagram Baseline facilities are available in the Corporate,·

Unified and Ultimate Editions of Enterprise Architect
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Revert Model to a Baseline

You can return any part of a model to the content stored in
the Baseline. This is a simple process of selecting the item
in the Baseline comparison tool and using the 'Merge to
Model' toolbar icon.

The 'Merge to Model' option for a selected Requirement
element.

The 'Merge to Model' option is useful when you or your
team identify unwanted changes that have been made to the
model since the Baseline was created. There could be items
such as elements, Features, Tagged Values, connectors and
diagram objects that have been:

Deleted·

Modified, or·

Created·

You will be warned that this option is not reversible, and if
changes are merged from the Baseline to the model the
changes to the model will be lost. Note that it is not possible
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to merge model changes to a Baseline, as the Baseline is a
snapshot and cannot be altered.

(c) Sparx Systems 2022 Page 1634 of 1974



Modeling Fundamentals 3 October, 2022

Manage Baselines

Baselines are snapshots of a repository Package taken at a
point in time. These snapshots are stored in a format called
XMI, which is an XML format. These files must be stored
so that they can be recalled and used for comparisons at a
future time. There are two primary places to store Baselines:

In the current repository - this is the default location·

In a Reusable Asset Service - a Reusable Asset Service·

needs to be nominated as the location

Baselines are by default stored in the repository so when, for
example, you create a Baseline of a Requirements Package
at a given milestone, the 'snapshot' would by default be
stored in the same model as the Requirements. This type of
storage is practical and sufficient for small, isolated project
teams, but for larger teams and endeavors, Enterprise
Architect provides some mechanisms to store the Baselines
as reusable and universally accessible snapshots available to
any project or organizational team, anywhere in the world.
This reusable storage is particularly useful in this age of
innovation and agility, where geographically independent
teams need to share information and reuse existing assets at
Internet speed. The facility uses the Reusable Asset Server
(RAS), which is Cloud-based (including on the home
premises) and provides sophisticated mechanisms to manage
these valuable corporate assets.

Management of the Baselines differs depending on the
option selected. A librarian or administrator typically
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decides which option is most appropriate for a given
repository and team. Factors such as whether the Baselines
need to be made available to a distributed audience and
whether dependency analysis is required would be
considerations in this decision.

Access

Ribbon Settings > Model > Options > Baseline

Specify Reusable Assert Server for Baselines

To store baselines in a Reusable Asset Server, you need to
define this on the 'Baseline' page of the 'Manage Model
Options' dialog, where you specify Cloud connection and
storage details and options.
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Manage Baselines in Model

When you manage baselines in the model, all of the
Baseline features are available through the Manage
Baselines window. As discussed in a prior topic, this is the
default way to work with baselines and the files themselves
are stored in compressed format inside the repository. This
ensures these baseline snapshots are available to all model
users who have the requisite permissions to manage the
baselines where security has been enabled.

Storing the baselines in the repository is much more
immediate and convenient, and is suitable for small teams
and situations where baselines are used in a cohesive team
environment. If these baselines are important assets that
need to be shared or managed by wider communities of
users, the Reusable Asset Server can be used to provide
access to distributed users.

Access

Ribbon Design > Package > Manage > Manage
Baselines

Keyboard
Shortcuts

Ctrl+Alt+B
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Baseline Management

Create, select and process Baselines using the 'Package
Baselines' dialog.

Option Action

Current
Baselines For
Package:
<Name>

Review the Baselines for the current
model branch, listed by version reference
with the highest alphabetical/numerical
value at the top.
If an entry is longer than the display area,
a horizontal scroll bar displays at the
bottom of the panel; use this to scroll to
the text that is not shown.

Show
Differences

Run the Compare utility on the selected
Baseline and the current model branch or
diagram, to display the differences
between the two.

Restore to
Baseline

Completely restore the model branch
from the selected Baseline.

New
Baseline

Create a new Baseline.
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Delete
Selected

Delete the selected Baseline.

Load Other
Baselines

Display a drop-down menu that enables
you to load Baselines from another
model, in either a project file or a DBMS
repository.

For project files, a browser displays;·

locate the required project file
For DBMS repositories, the Windows·

'Data Link Properties' dialog displays;
select the data provider and click on the
OK button to display the 'Select Data
Source' dialog, from which you select
the required project

In either case, the Connected To:
message at the bottom of the 'Package
Baselines' dialog changes to the name of
the alternative model.
To return the dialog to the original
project, select the third option on the drop
down list: 'Load From Selected Package'.

Import File Import an XML 1.1 file from the file
system as a new Baseline for this current
model branch.

Export File Export the selected Baseline to an XML
file.

(c) Sparx Systems 2022 Page 1639 of 1974



Modeling Fundamentals 3 October, 2022

Compare
Model to File

Compare the selected model branch with
an XML 1.1 file in the file management
system; a browser displays, which you
use to locate the file.

Options Set filters to make the comparison more
specific.

Notes

Package Baseline facilities are available in the Corporate,·

Unified and Ultimate Editions of Enterprise Architect
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Manage Baselines in Reusable Asset
Service

When you manage Baselines through the Reusable Asset
Server (RAS) all of the Baseline features are available but in
addition there are a range of other features only available
when using RAS baselines. As discussed in a prior topic the
baselines are available to a much wider audience, including
other teams and departments, customers, standards
authorities, partners, consultants, testers and more, all
protected by robust industry standard security. Baselines
stored in the RAS are more transparent and searchable,
making it easier to understand and work with the content
they contain.

Enterprise Architect provides a range of facilities for
working with and managing Baselines stored in a Reusable
Asset Service Registry, using the 'Reusable Asset Service -
Baseline' view. When you open this view, the 'Baseline
Browser' tab immediately displays a list of the Baselines
available for the Package that is currently selected in the
Browser window. You can review and use these Baselines
using the context menu and buttons on the tab.
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You can review the contents of the selected Baseline using
the tabs in the lower half of the 'Reusable Asset Service -
Baseline' view, underneath the 'Baseline Browser' tab.

If you have left the 'Baseline Browser' open for a while,
there is a possibility that the contents of the Storage in
Registry might have changed. Click on the  icon in the
'Reusable Asset Service - Baseline' toolbar to refresh the
Browser with the latest contents of the Storage.

Note: To store Baselines in a Reusable Asset Service
Registry, select the 'Baseline' page in the 'Manage Model
Options' dialog and configure the Cloud connection to the
Registry, then select or create the Storage in which to store
all the Baselines for the Packages in the model.
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Access

Ribbon Design > Package > Manage > Manage
Baselines

Keyboard
Shortcuts

Ctrl+Alt+B

Baseline Management

Create, select and process Baselines using the 'Reusable
Asset Service - Baseline' view.

Option Action

Registry Displays the Registry name, as specified
on the 'Baseline' page of the 'Manage
Model Options' dialog.

Storage Displays the Storage name, as defined on
the 'Baseline' page of the 'Manage Model
Options' dialog.

Package Displays the name of the Package
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currently selected in the Browser
window.

Find Other
Packages

Click on this button to open the 'Reusable
Asset Services' view, displaying the
Storage and its full contents; that is, all
Packages with Baselines, and any other
Packages held in the Storage.

Baseline
Browser

Lists the Baselines, if any, for the current
Package. The Baselines are listed by
version - with the highest alphabetical or
numerical value at the top.
When you select a Baseline in the
Browser, details of the Baseline are
displayed in the tabs beneath the
'Baseline Browser' tab.
Note: You can right-click on the column
headings and select the 'Toggle Filter Bar'
option to show or hide the Filter Bar on
the display. If you show the Filter Bar,
type in the appropriate characters to list
only those Baselines that have that string
of characters in the value in the
corresponding column.

New Click on this button to create a new
Baseline.
Note: You can also click on the  icon in
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the 'Reusable Asset Service - Baseline'
toolbar to create a new Baseline.

Compare Click on this button to run the Compare
utility on the selected Baseline and the
current Package, to display any
differences between the two. The results
of the comparison are displayed on the
'Comparison Utility' view.
Note:
You can also run the Compare utility by:

Clicking on the  icon in the 'Reusable·

Asset Service - Baseline' toolbar or
Right-clicking on the Baseline name·

and selecting the 'Compare' context
menu option

Restore Click on this button to completely restore
the Package in the model from the
selected Baseline.
Note:
You can also restore the Package from
the selected Baseline by:

Clicking on the  icon in the 'Reusable·

Asset Service - Baseline' toolbar
Right-clicking on the Baseline name·

and selecting the 'Restore' context
menu option
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Run
Compare
after Restore

Check this option to automatically run the
Compare utility once the Package is
completely restored from the selected
Baseline.

Notes

The Package Baseline facilities are available in the·

Corporate, Unified and Ultimate Editions of Enterprise
Architect

Reusable Asset Service Registry details must be·

configured in the 'Baseline' page of the 'Manage Model
Options' dialog

If a 'Read-Only Access' password is entered for the·

Storage in the 'Baseline' page of the 'Manage Model
Options' dialog, you will not be able to create new
Baselines in the 'Reusable Asset Service - Baseline' view
as the 'New' button will be disabled

If security is enabled, you must have 'Baselines - Restore·

model' permission to restore a Package from the selected
Baseline
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Baseline Contents

In the 'Reusable Asset Service - Baseline' view, when you
select a Baseline in the 'Baseline Browser' tab, the three tabs
in the lower half of the view are updated with information
on the Baseline. The 'Contents' tab lists the diagrams and
elements (including any child Packages) held in the selected
Baseline, listing the two types of object separately. You can
organize the information within a column into alphabetical
or reverse-alphabetical order for ease of reference, and use
the Filter bar to filter the display to show only items with
values containing specific characters or digits.

Access

Open the 'Reusable Asset Service - Baseline' view using one
of the methods outlined here.

Select a Baseline in the 'Baseline Browser' tab, then click on
the 'Contents' tab to display the contents of that Baseline.

Ribbon Design > Package > Manage > Manage
Baselines

Keyboard
Shortcuts

Ctrl+Alt+B
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Review Baseline Contents

Option Detail

Content Type Click on this button to toggle between
listing the Baseline diagrams first and
listing the Baseline elements first.

Toggle Filter
Bar

Right-click on the column headings and
select this option to show or hide the
Filter Bar on the display.

(filter bar
fields)

Type in the appropriate characters to list
only elements and diagrams that have that
string of characters in the values in the
corresponding column.

Content
Type:
Diagram
Content
Type:
Element

These are the headers for the two types of
object listed in this tab.
Click on the appropriate white or black
arrow head to hide or show the list of
diagrams or elements under the heading.

Name Displays the name of the element or
diagram available in the Baseline.
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Type Displays the type of the element or
diagram, such as Use Case or Use Case
diagram.

GUID Displays the Global Unique Identifier of
the element or diagram.

Content Type Displays the object type of the item -
Element or Diagram.

Find in
Project
Browser

Right-click on an element or diagram line
and select this option to see if the element
or diagram also exists in your model and,
if it does, to highlight it in the Browser
window.

View
Diagram

Right-click on a diagram name and select
this option to display the diagram within
a labeled frame, as an image.
Alternatively, double-click on the
diagram name.
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Baseline Dependencies

When you select a Baseline on the 'Baseline Browser' tab,
the three tabs in the lower half of the 'Reusable Asset
Service - Baseline' view are updated with information from
the Baseline. A Package might contain elements and
diagrams that have relationships with objects in other
Packages. When you generate a Baseline for that Package,
the name and Global Unique Identifier (GUID) of each
Package containing these 'external' objects will be stored
along with the Baseline and displayed in the 'Dependency'
tab.

Note that Package A depends on Package B if any of these
constructs (or their Tagged Values) in Package A reference
elements in Package B:

Elements·

Attributes·

Operations·

Operation Parameters·

Diagrams·

Connectors·

Access

Open the 'Reusable Asset Service - Baseline' view using one
of the methods outlined here.
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Select a Baseline on the 'Baseline Browser' tab, then click
on the 'Dependency' tab to display a list of dependencies for
that Baseline.

Ribbon Design > Package > Manage > Manage
Baselines

Keyboard
Shortcuts

Ctrl+Alt+B

Check Baseline Dependencies

Option Detail

Package Displays the name of the related Package.

GUID Displays the Global Unique Identifier of
the related Package.

Find in
Registry

Right-click on the 'Package' line and
select this option to see if the Package
exists in the Registry.
Selecting this option will :

Open the 'Reusable Asset Service' view·

Connect to the Registry and load the·
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Storage that is currently selected in the
'Reusable Asset Service - Baseline'
view
Open the 'Search Registry' dialog·

Search for the selected Package using·

its GUID and display the results of the
search, if any

Find in
Project
Browser

Right-click on the 'Package' line and
select this option to see if the Package
also exists in your model and, if it does,
to highlight it in the Browser window.

Copy
Package
Name to
Clipboard

Right-click on the 'Package' line and
select this option to copy the Package
name to the clipboard.

Copy
Package
GUID to
Clipboard

Right-click on the 'Package' line and
select this option to copy the Package
GUID to the clipboard.

Notes

The Name and Global Unique Identifier (GUID) of a·
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Package containing 'external' objects will not be stored
with the Baselines if the option 'Check Package
dependency when creating Baseline' is disabled on the
'Baseline' page of the 'Manage Model Options' dialog
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Add Review Comments

When you select a Baseline on the 'Baseline Browser' tab,
the three tabs in the lower half of the 'Reusable Asset
Service - Baseline' view are updated with information from
the Baseline. For any Baseline, you can add individual
review comments on any aspect of the Baseline. These
comments provide a permanent record on the Baseline -
once they have been saved they cannot be edited or deleted.
Each comment is attributed to the ID of the user who
entered it, and is date stamped.

Access

Open the 'Reusable Asset Service - Baseline' view using one
of the methods outlined here.

Select a Baseline on the 'Baseline Browser' tab, then click
on the 'Review' tab to display the review comments of that
Baseline.

Ribbon Design > Package > Manage > Manage
Baselines

Keyboard
Shortcuts

Ctrl+Alt+B
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Actions

Action Detail

Review
Existing
Comments

If there appears to be a longer comment
than can be shown in the 'Review' tab,
click on it. The full text displays in the
'Comments' field in the lower panel.

Create
Comments

Click on the New button and start typing
your comment on the Package in the
'Comments' field. You can delete and edit
text as you type.
When you have finished writing your
comment, click on the Save button. Your
comment, preceded by your user ID and
the current date, is displayed in the
'Review' panel.
Once you have saved your comment, you
cannot edit or delete it.
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More Information

Edition Information

Package Baseline facilities are available in the Corporate,·

Unified and Ultimate Editions of Enterprise Architect

The Compare utility (used to compare an exported·

Package with a model Package) is available in the
Professional Edition of Enterprise Architect, as well as in
the Corporate, Unified and Ultimate Editions

The Enterprise Architect Corporate, Unified and Ultimate·

Editions provide another facility, Auditing, which you can
switch on to perform continuous monitoring of changes
across the project; you can dovetail your use of each
facility to meet the range of your change management
requirements

Considerations

Baselines are based on the Global Unique Identifier (GUID)
of a particular Package:

Enterprise Architect checks for that GUID as the root·

element within the XML document being used as a
Baseline

When you export a Package to XML, the Package you·

export is the root element; likewise when you create a
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Baseline, the current Package is the root Package of the
XML Baseline

When you save information in a Version Control system,·

the current Version Controlled Package is again the root
Package of the document

It is not useful to create a Baseline by importing an XMI·

Package file created by Version Controlling a Package
that itself contains Version Controlled child Packages;
that type of XMI Package file contains stubs for the child
Packages, not full information on the child Packages and
elements

If a Package under Version Control forms part of a·

Baseline, and that Package is checked in to the model, you
cannot merge the original data from the Baseline into that
Package

XML files must be in the same format used by the Baseline
engine - currently the UML 1.3 XMI 1.1 format (plus
Enterprise Architect extensions), which contains all the
information necessary to reconstruct a UML model, even a
UML 2.x model.

Notes

If a Package under Version Control forms part of a·

Baseline, and that Package is checked in to the model, you
cannot merge the original data from the Baseline into that
Package
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You can also obtain a snapshot of selected items in the·

model, using the Model Views facility; this facility
enables you to automatically generate the snapshot at
intervals and, if there are changes in the items collected
by the defined search, to trigger a notification to you of
such changes, which enables you to monitor workflow
and other events of concern to you

If security is enabled you must have 'Baselines - Manage'·

permission to create, import and delete Baselines, and
'Baselines - Restore' permission to merge data from a
Baseline; security permissions are not required to select
an existing Baseline and perform a comparison with the
model
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Reuseable Asset Service (RAS)

Within a large organization, groups of users can be
separated by geographical distance and be on different
networks. This can make it difficult to share common data,
standards and modeling structures, without the complexity
of using external Version Control tools or manually
distributing XMI files between projects. Enterprise
Architect supports a Reusable Asset Service (RAS) that
provides a simple and convenient mechanism for modelers
to distribute or download reusable model structures,
information, as well as corporate directives and standards.
The shared repository is accessible via a Pro Cloud Server
connection, making it accessible for distributed teams. The
person who sets up the reusable data can retain governance
of the resource or asset, whilst users of the service can easily
review the currency of the information and download the
latest versions into their models or file folders.

The RAS gives distributed teams convenient access to a
single 'source of truth' for shared data, including project
milestones, architectural frameworks and industry standards.

Reusable Assets

A Reusable Asset Storage is contained in a Pro Cloud
Server repository.

Reusable Assets can consist of:
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Packages containing elements, diagrams and structures (as·

drawn from any point within the Browser window), and

Learning Center topics·

Files in a range of text, code and graphic formats,·

including .qea and .eap files

An asset can be, for example:

A common Class library or framework·

The Baselines for a set of Packages or of the whole model·

A set of common Requirements or Use Cases·

A draft specification document·

Marketing collateral·

Storage Structure and Use

A Reusable Assets registry contains any number of
Storages, which can either be left unprotected for any user
to create, or change-restricted by an Administrator
password. Each Storage can contain any number of Asset
Packages holding modeling structures, and files containing
textual or graphical information and data. When a user
creates a Storage, they can protect the contents from being
updated in the Registry or downloaded into a model, using
password protection defined by that user.

For each Package, the RAS automatically identifies the:

Version of the Package held in the registry·

Diagrams and elements (including child Package·
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elements) contained by the Asset Package

Dependencies on parent Packages of any external·

elements that the Asset Package references

Dependencies on MDG Technologies·

Features

Here is an overview of the features available in the RAS.

Feature Description

Register
Assets

The assets that can be created include:
Packages - including diagrams and·

subordinate Packages
Baseline Packages·

Files·

Learning Center contents.·

Browse
Assets

Any user, regardless of password
protection, can freely browse and identify
the contents of a Package held in a
Storage - including displaying the
diagrams - without importing the material
into a model.

Import
Content

Any user with access to the Pro Cloud
Server repository and a password (if
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required), can import an Asset into their
repository.

Dependencie
s

Any dependencies within a stored
Package are viewable, providing a quick
means to visually see what the Asset
requires.

View
Diagrams

Any diagrams set in an Asset are logged
and can be viewed providing a quick
means to check and visually compare the
Asset diagrams against updates to
diagrams in the current model.

Compare Where a user that has imported an Asset
Package into their model, they can
compare their model Package against any
version of the Asset Package, to check for
and assess any differences between them.

Required
Technologies

For a Package Asset that has specific
Technologies these are displayed for
clarification of what is required on
importing the Asset.

Reviews Reviews and comments can be posted
against a Package.
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Set Up the Asset Service

The process of setting up assets and files in the Reusable
Asset Service has a number of simple stages, typically:

Identify the Registry·

Create the Storages, including copying an existing Storage·

as a template for a new one

Set password protection on each Storage·

Register the Asset Packages and Storage Files, and update·

them as necessary

Prerequisites

As a Reusable Asset Service is stored in a Pro Cloud Server
repository, there must be a Pro Cloud Server (PCS)
operating and a repository configured and enabled on this
PCS.

Access

Ribbon Publish > Model Exchange > Reusable
Assets
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Identify the Repository

A Reusable Asset Registry is contained in a PCS based
repository that is typically configured by a System
Administrator. If you have access to an existing PCS
repository then the connection details for that can used for
creating Reusable Asset Storage. Otherwise, if a new
repository needs to be created by a System Administrator,
they will provide the repository connection details for you to
use.

Ste
p

Action

1 If a new repository is required, then the System
Administrator creates a PCS based Repository to act
as the Reusable Asset Registry and then provides
you with the connection details like server and
model name.
If a PCS repository already exists and you have
access to it, then proceed to step 2.

2 In the Reusable Asset Service view, click on the 
button to the right of the 'Registry' field.
The 'Cloud Connection' dialog displays.
In the Cloud Connection dialog, type in the
connection details of the PCS repository:
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3 Click on the OK button.
The 'Registry' field now shows the Cloud
Connection name.

4 If required for security, set up a Registry Password.

Toolbar Options

Option Description

Option for creating a new storage as a
container within the Registry for holding
related assets and files.
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Used for copying a Storage as the basis
for creating another Storage.

Option for updating the Storage details.

Option for deleting a storage's entire
contents.
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Set Up Registry Password

As a System Administrator, you can password-protect the
Registry to prevent users from modifying the Registry; that
is, restrict users from performing top-level activities such as
creating, modifying and deleting Storages. Once you have
set password protection, only those users who have a valid
Administrator password can modify the Registry.

You can also change the password at regular intervals, for
added security.

Access

In order to set the Registry Administrator password:

In Enterprise Architect, open the Cloud model that is·

designated as the RAS Registry

Open the RAS window (Publish > Model Exchange >·

Reusable Assets)

The Set Administrator Password button is displayed next·

to the 'Registry' field
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Click on this button to display the 'Set Administrator·

Password' dialog

Set the Administrator Password

Option Detail
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Enter old
password

Disabled if no password exists for the
Registry.
If Registry has a current password, type it
in to this field.

New
password

Type in the new Administrator password.

Retype new Type in the new Administrator password,
for confirmation.

OK Click on this button to set the password
and close the dialog.

Cancel Click on this button to abort the changes
and close the dialog.

Notes

To remove password protection from the Registry,·

complete the 'Enter old password' field but leave the 'New
password' and 'Retype new' fields blank

If a Storage has a 'Complete Access' password, then you·

can use either the Administrator password or the
'Complete Access' password to modify the Storage
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Creating Asset Storages

A Storage is a container within the Registry, holding related
assets and files. There can be several Storages in the
Registry, to support the different areas of work or purposes
that your organization might define.

Create Storages

When creating a new Storage you have the option to set
what type of storage this is to be. The Storage types
available include:

Model Package -  contains Asset Packages and/or Files·

Learning Center Library - Learning Center Library·

content

Reference Data Library -  Enterprise Architect Reference·

Data Library

Source Code Library -  can be populated with any zipped·

files.

Ste
p

Action

1 Click on the  icon in the Reusable Asset Service
toolbar.

2 If necessary, enter the Administration password that
enables update access to the Registry. Click on the
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OK button.
The 'New Storage' dialog displays.

3 In the 'Name' field, type a name that indicates the
purpose or content of the Storage.

4 In the 'Content' field, select:
'Model Package' if the Storage should contain·

Asset Packages and/or Files
'Learning Center Library' if the Storage should·

contain only Enterprise Architect Learning Center
Library files - this Storage can be populated only
with Library files and not with Asset Packages
'Reference Data Library' if the Storage should·

contain only Enterprise Architect Reference Data
Library files - this Storage can be populated only
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with Library files and not with Asset Packages
'Source Code Library' if the Storage should·

contain only Source Code Library files - this
Storage can be populated only with Library files
and not with Asset Packages

5 If you have selected 'Model Package' in the 'Content'
field, then in the 'Status' field select:

'Draft' if you intend to make significant changes to·

the content of the Storage, such as populating it
with assets and/or files; you can also overwrite
existing Packages or files in the Storage
'Complete' if the Storage is ready for use; you·

cannot overwrite any Packages or files in the
Storage, although you can delete Packages and
files and add new ones

You can modify a 'Model Package' Storage at a later
time, and change this 'Status' setting (see the Change
Storage Details section in this topic).
Storage whose Content is 'Learning Center Library',
'Reference Data Library' or 'Source Code Library'
will always be of 'Draft' Status - you can overwrite
existing Library files in these Storages.

6 If you want to set Storage Access passwords on this
Storage, click on the checkbox against one or both
password types, and provide and confirm the
'Complete Access' and/or 'Read-Only Access'
passwords.
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For more details, see the Storage Access Passwords
section in this topic.

7 Click on the OK button.
A prompt displays for you to confirm the creation of
the Storage, with the type of access you have set on
the Storage.

8 Click on the Yes button.
A confirmation message displays; click on the OK
button.
The name of the new Storage displays in the
'Storage' field.

Storage Access Passwords

The Registry can be protected by a Registry password, so
that only the Administrator can create and modify Storages.
If no Registry password is set, a second level of password
protection can be applied.

The owner of a Storage can apply password protection to
restrict users in processing and modifying the contents of
the Storage either intentionally or unintentionally. Password
protection can be applied at two levels:

Complete Access - users enter their password and can·

modify or delete the Storage itself, and within the Storage
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can register, update and delete Packages and files in the
Registry, view Packages and import assets into their
models

Read-Only Access - users enter their password and can·

import assets into their models

You set the 'Complete Access' password before you set the
'Read-Only Access' password.

If password protection is set and a user has no password,
they can only view the contents of the Storage. If no
password protection is set, all users can freely access and
modify the Storage and its contents.

You set the passwords on each Storage as you create that
Storage, using the 'New Storage' dialog. Once the Storage
has been created, you can change or remove an existing
password using the 'Modify Storage Access' dialog, but you
cannot add a password.

If a Storage is password protected, the system displays a
prompt for the password when the user begins to:

Change or delete a password on the Storage·

Copy the Storage to create a new Storage·

Delete the Storage·

Register a Package or file in the Storage·

Import a Package, file or Technology from the Storage·

Delete a Package or file from the Storage·

Compare an Asset Package with a Package in the model·

The system displays the password prompt when any of those
operations is performed for the first time after the user:
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Connects to a Registry·

Reloads the Registry Browser·

Selects a Storage in the 'Storage' field in the Reusable·

Asset Services view

If the user enters the correct password and therefore
establishes their credentials, the system does not display a
password prompt again for any valid operation that user
performs until they:

Select a different Storage in the 'Storage' field in the·

Reusable Asset Services view or

Reload the Registry Browser from the Registry·

Register Assets and Files

Whilst a Storage exists and, if the Storage is under password
protection, and you have the 'Complete Access' password,
you can register Packages from a model and files from your
system as assets in that Storage. If the Asset Package was
developed using one or more MDG Technologies, you can
optionally register those technologies in the Storage as well.

See the Register New Assets Help topic.
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Copying Asset Storages

It is possible to copy a Storage as the basis for creating
another Storage, for example if you want to use the same set
of assets in the context of a larger set for a different
department, work area or development phase.

Note: It is not possible to change the 'Content' of a Storage
nor is it possible to change 'Status' of a 'Learning Center
Library', 'Reference Data Library' or 'Source Code Library'
Storage.

Copy Storages

To copy a Storage, follow these steps.

Ste
p

Action

1 In the 'Storage' field, select the Storage to be copied.

2 Click on the  icon in the Reusable Asset Service
toolbar.

3 If necessary, enter the Administrator password or
your 'Complete Access' password and click on the
OK button.
The 'Save Storage As' dialog displays.
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4 In the 'Name' field, type a name that indicates the
purpose or content of the new Storage.

5 If 'Model Package' is selected in the 'Content' field,
then in the 'Status' field select:

'Draft' if you intend to make significant changes to·

the content of the Storage, such as populating it
with assets and/or files; you can overwrite existing
Packages or files in the Storage
'Complete' if the Storage is ready for use; you·

cannot overwrite any Packages or files in the
Storage, although you can delete Packages and
files and add new ones

You can modify a 'Model Package' Storage at a later
time, and change this 'Status' setting (see the Change
Storage Details section in this topic).

6 If you want to set Storage Access Passwords on this
Storage, click on the checkbox against one or both
password types, and provide and confirm the
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'Complete Access' and/or 'Read-Only Access'
passwords.

7 Click on the OK button.
A prompt displays for you to confirm the creation of
the Storage, with the type of access you have set on
the Storage.

8 Click on the Yes button.
A confirmation message displays; click on the OK
button.
The name of the new Storage displays in the
'Storage' field.
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Change Storage Details

After you have set up a Storage, you can update it at a later
stage to:

Change the status of a 'Model Package' Storage·

Change one or both of the existing 'Complete Access' and·

'Read-Only' Access passwords

Delete one or both of the passwords·

Note: there are restrictions in that:

It is not possible to add a password where one has not·

previously been set.

You cannot change or delete passwords unless you have·

the 'Complete Access' password yourself.

It is not possible to change the 'Content' of a Storage nor·

is it possible to change 'Status' of a 'Learning Center
Library', 'Reference Data Library' or 'Source Code
Library' Storage.

Process

Ste
p

Action

1 On the Reusable Asset Service view, in the 'Storage'
field click on the drop-down arrow and select the
Storage to update.
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2 Click on the  icon in the Reusable Asset Service
view toolbar.

3 If necessary, enter the Administrator password or
your 'Complete Access' password and click on the
OK button.
The 'Modify Storage Access' dialog displays.

4 If 'Model Package' is selected in the 'Content' field,
then in the 'Status' field select:

'Complete' if the Storage has now been set up and·

is ready for use; you cannot overwrite any
Packages or files in the Storage, although you can
delete them and add new Packages and files
'Draft' if you intend to make significant changes to·

the content of the Storage; you can overwrite
existing Packages or files

5 The 'Action' field defaults to 'None', to indicate no

(c) Sparx Systems 2022 Page 1682 of 1974



Modeling Fundamentals 3 October, 2022

changes to the passwords. If you are changing or
deleting the passwords, click on the drop-down field
and select:

'Change Password' to enable both password type·

fields ready for editing
'Remove Storage Access Password' to simply·

delete the 'Complete Access' password altogether
'Remove Read-Only Access Password' to simply·

delete the 'Read-Only Access' password altogether

6 If you have selected the 'Change Password' option,
select the appropriate password checkbox or both
checkboxes, and type in the new password(s).
Re-type the password(s) in the 'Confirm Password'
field(s).
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7 Click on the OK button to save your changes and
close the 'Modify Storage Access' dialog.
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Delete a Storage

If a Storage has been created by mistake, or is no longer
necessary in the Registry, you can delete it and its entire
contents of Package and files in one action.

Process

Ste
p

Action

1 On the Reusable Asset Service view, in the 'Storage'
field click on the drop-down arrow and select the
Storage to delete.

2 Click on the  icon in the Reusable Asset Service
view toolbar.
A prompt displays to confirm the deletion.

3 Click on the Yes button.
If necessary, enter the Adminstrator password or
your 'Complete Access' password and click on the
OK button.
A message displays to confirm that the Storage has
been deleted.

4 Click on the OK button to clear the message.
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The Storage and its contents are cleared from the
Registry.
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Connect to the Asset Service

The Reusable Asset Service provides model structures and
documents to you from one or more registries on remote
systems. You access these registries through a Pro Cloud
Server connection to the appropriate server. The connection
details should be provided to you by your System
Administrator or Reusable Asset Service Administrator.

Access

Ribbon Publish > Model Exchange > Reusable
Assets

Connect to Assets
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Option Detail

Registry This field normally defaults to the
last-used registry name. If the field is
empty, or if you want to switch to a
different registry, click on the  button
to the right of the field.
The 'Cloud Connection' dialog displays.
Using the information provided by your
administrator, type in the Protocol, the
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server name, the Port and the name of the
model hosting the registry data.

For example, if you wanted to download
the UBL Frameworks into your model,
you would specify the server
'sparxcloud.com' and the model name
'modelpatterns'.

If advised by your Administrator, type in
the user name and password for the
server.
Click on the OK button; the 'Registry'
field now shows the server name.
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Note:
If no Registry is available,·

Administrator can create a Cloud-based
Repository to act as the Reusable Asset
Registry

Storage If there is more than one Storage
available in the Registry, this field
defaults to the first listed in the Registry.
To check for or select other Storages,
click on the drop-down arrow at the right
of the field. Click on the Storage to
review. For example, if you were
downloading UBL frameworks, you
would select 'UBL' in the list.
The 'Registry Browser' tab displays the
Packages registered in the selected
Storage.

Notes

The Reusable Asset Service is available in the Corporate,·

Unified and Ultimate Editions of Enterprise Architect
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Browse Assets

When you select a Storage in the Reusable Asset Service,
the 'Registry Browser' tab immediately displays a list of the
Packages registered in that Storage. You can review and use
these Packages using the context menu and buttons on the
tab.

You can review the properties and contents of the selected
Package in the Storage, and access any files in the Storage,
using the tabs in the lower half of the Reusable Asset
Service view, underneath the 'Registry Browser' tab.

If you have left the Registry Browser open for a while and
there is a possibility that the Registry has been changed, you
can click on the  icon in the Reusable Asset Service
toolbar to refresh the Browser with the latest contents of the
Registry.

Access

Ribbon Publish > Model Exchange > Reusable
Assets > Registry Browser

Review Assets
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Option Detail

Toggle Filter
Bar

Right-click on the column headings and
select this option to show or hide the
Filter Bar on the display.

(filter bar
fields)

Type in the appropriate characters to list
only Packages that have that string of
characters in the values in the
corresponding column.

Package This column shows the name of the
Packages held in the selected Storage.

Version This column defaults to the most recent
version of each Package held in the
selected Storage.
You can click on the drop-down arrow at
the end of a field and select a different
version of the corresponding Package, if
any have been registered.

Last
Registered

This column shows the date and time at
which the currently-listed version of each
Package was registered.

Registered This column shows the user name of the
person who registered the currently-listed
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By version of each Package.

Import Click on a Package name and click on
this button to begin to import either the
Package alone or the Package and its
dependent structures into your model.
You can perform the same action by
right-clicking on the Package name and
selecting the 'Import from Registry' menu
option.
If the Package from the Registry already
exists in your model, it is deleted and
replaced by this import.
For a:

'Learning Center Library' Storage, the·

'Download Library' dialog displays
'Reference Data Library' Storage, the·

'Import Reference Data' dialog displays
'Source Code Library' Storage, the·

'Save As' dialog displays

Compare
with Package
in Model

If you have previously imported a
Package from the Registry into your
model, you can right-click on the
Package name in the 'Registry Browser'
tab and select this option to compare the
imported Package with the Registry
version, and show any differences.
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The system automatically selects the
model Package from the Browser
window.

Find in
Project
Browser

If you have previously imported a
Package from the Registry into your
model, you can right-click on the
Package name in the Registry Browser
and select this option to highlight the
corresponding Package in the Browser
window.

Notes

Some of the other options available on the Registry·

Browser are used to set up assets in the Registry

If the Storage is password-protected, a prompt for you to·

enter a password displays when you select to perform an
operation on the data; in this situation, you need the
'Read-only' password to process the information from the
Storage, and the 'All-access' password to change the
information in the Storage

The 'Registry Browser' tab will be empty for a 'Learning·

Center Library', 'Reference Data Library' or 'Source Code
Library' type Storage - the contents of these types of
Storage will be available in the 'Storage Files' tab of the
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Reusable Asset Service view
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Asset Properties

When you select a Storage and a Package in the 'Registry
Browser' tab, the first four tabs in the lower half of the
Reusable Asset Service view are updated with information
from the Package. The 'Asset Properties' tab is a read-only
view of the properties of the selected Package itself.

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then click on the 'Asset Properties' tab to
display properties for that Package.

Ribbon Publish > Model Exchange > Reusable
Assets

Review Package Properties

Field Detail

Package Displays the name of the selected
Package.
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GUID Displays the Global Unique Identifier of
the Package.

Version Displays the version reference (such as
1.1 or Beta) of the Package.

Author Displays the user ID of the person who
created the Package (the Package
Author).

Created Displays the date and time at which the
selected version of the Package was
created (that is, registered) in the
Registry.

Modified Displays the date and time at which the
selected version of the Package was last
modified (that is, re-registered) in the
Registry.

Comments Displays any comment recorded against
the Package when it was registered in the
Storage.

Notes Displays the notes recorded against the
Package when it was registered in the
Storage.
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Notes

The 'Asset Properties' tab will be empty for a 'Learning·

Center Library', 'Reference Data Library' and 'Source
Code Library' type Storage
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Package Contents

When you select a Storage and a Package in the 'Registry
Browser', the first four tabs in the lower half of the Reusable
Asset Service view are updated with information from the
Package. The 'Contents' tab lists the diagrams and elements
(including child Packages) held in the selected Package,
listing the two types of object separately. You can organize
the information within a column into alphabetical or
reverse-alphabetical order for ease of reference, and use the
Filter bar to filter the display to show only items with values
containing specific characters or digits.

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then click on the 'Contents' tab, to display
the contents of that Package.

Ribbon Publish > Model Exchange > Reusable
Assets

Review Package Contents
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Option Detail

Content Type Click on this button to toggle between
listing the Package diagrams first and
listing the Package elements first.

Toggle Filter
Bar

Right-click on the column headings and
select this option to show or hide the
Filter Bar on the display.

<filter bar
fields>

Type in the appropriate characters to list
only elements and diagrams that have that
string of characters in the values in the
corresponding column.

Content
Type:
Diagram
Content
Type:
Element

These are the headers for the two types of
object listed in this tab.
Click on the appropriate expansion box to
hide or show the list of diagrams or
elements under the heading.

Name Displays the name of the element or
diagram available in the Package.

Type Displays the type of the element or
diagram, such as UseCase or Use Case
diagram.
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GUID Displays the Global Unique Identifier of
the element or diagram.

Content Type Displays the object type of the item -
Element or Diagram.

Find in
Project
Browser

Right-click on an element or diagram line
and select this option to see if the element
or diagram also exists in your model and,
if it does, to highlight it in the Browser
window.

View
Diagram

Right-click on a diagram name and select
this option to display the diagram within
a labeled frame, as an image in a separate
window. The image is displayed at the
default zoom level for the model.
Alternatively, to view the diagram,
double-click on the diagram name.

Notes

The 'Contents' tab will be empty for a 'Learning Center·

Library', 'Reference Data Library' or 'Source Code
Library' type Storage
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Package Dependencies

A Package held as an asset in the Reusable Asset Service
registry might contain elements and diagrams that have
relationships with objects in other Packages. The Packages
containing these 'external' objects will also have been added
to the Registry to support the first Package, and will be
listed in the 'Registry Browser' tab along with other
(unrelated) Packages. You can establish whether the
selected Package in the 'Registry Browser' tab has links to
other Packages in the Registry, and which they are, by
reviewing the 'Dependency' tab.

Package A depends on Package B if any of these constructs
(or their Tagged Values) in Package A references elements
in Package B:

Elements·

Attributes·

Operations·

Operation Parameters·

Diagrams·

Connectors·

Access

Open the Reusable Asset Service window using one of the
methods outlined here.
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Select a Package, then click on the 'Dependency' tab, to
display a list of Dependencies for that Package.

Ribbon Publish > Model Exchange > Reusable
Assets

Check Package Dependencies

Option Detail

Package Displays the name of the related Package.

Version Displays the latest registered version of
the related Package that has links to the
selected Package.

GUID Displays the Global Unique Identifier of
the related Package.

Find in
Project
Browser

Right-click on the 'Package' line and
select this option to see if the Package
also exists in your model and, if it does,
to highlight it in the Browser window.
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Notes

If one Package depends on another, and that second·

Package itself depends on another Package, both the
second and third Packages are shown in the 'Dependency'
tab

The 'Dependency' tab will be empty for a 'Learning·

Center Library', 'Reference Data Library' or 'Source Code
Library' type Storage
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Package Technologies

It is possible that the asset Package in the Registry is
associated with one or more Technologies, especially if the
Package comes from a model developed as an extension or
customization of the UML. You can check whether an asset
Package has any associated Technologies, and what they
are, by viewing the 'Technology' tab of the Reusable Asset
Service view.

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then click on the 'Technology' tab, to
display a list of Technologies required to support that
Package.

Ribbon Publish > Model Exchange > Reusable
Assets

Review Technologies

Option Detail
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Name Displays the name of the Technology as
recorded in the Registry.

Version Displays the required version of the
Technology to support the asset Package,
available through the Registry.

ID Displays the unique identifier of the
Technology.

Type Identifies whether the Technology is
system-supplied and built in to Enterprise
Architect (such as BPMN 2.0 or ArcGIS),
or user-defined.
A user-defined technology can be
introduced from an external source or
developed by a user within the system.

Registry
Status

Indicates whether the Technology file is:
Available - the Technology file is·

registered in the current Storage, or
Unavailable:·

     -  The Technology file is not
registered in the Storage, or
     -  The Technology is a built-in
Technology and is already integrated
         with your system, or must be
purchased under license, or
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     -  The Technology is available from
a URL and can be downloaded
         from that URL

Import
Technology

If your local system does not have one of
the Available Technologies, you can
quickly import it from the Registry.

Right-click on the Technology name4.
and select the 'Import Technology'
option.
A prompt displays for you to confirm5.
the import to your system; click on the
Yes button.
A message displays to confirm that the6.
Technology has been imported; click
on the OK button.

You might have to restart Enterprise
Architect to activate the Technology.
Other than the remote Technologies, you
cannot import a Technology flagged as
'Unavailable'. You can import a remote
Technology from its URL site.

Notes

You can also import Available Technologies from the·
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registry as part of the process of importing the asset
Package

If the Storage is password protected, a prompt to enter·

your password displays (this can be a Read-Only or a
Complete Access password) after you confirm that you
want to import the Technology; you cannot import the
Technology without this password

The 'Technology' tab will be empty for a 'Learning Center·

Library', 'Reference Data Library' or 'Source Code
Library' type Storage
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Storage Files

The 'Storage Files' tab of the Reusable Asset Service view
simply lists the files that have been uploaded to the specified
Storage. The files can be of any type, uploaded from any
directory on any system connected to the registry. Typically
they would be document or graphics files that provide
standards, guidelines or design information on a model
structure. The tab displays the file name and extension, and
a comment on the nature or purpose of the file.

Files held in the Registry are compressed, so to view the
contents you download them onto your local system.

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Package, then click on the 'Storage Files' tab to
display a list of files associated with the Package, that are
available for download.

Ribbon Publish > Model Exchange > Reusable
Assets

Review files in Model Package type Storage
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On the 'Storage Files' tab, check the 'Comments' field
against each file that interests you.

To view the contents of a file, right-click on the file name
and select the 'Import From Registry' option. The 'Save As'
browser displays, through which you select the directory
into which to copy the file.

Click on the Open button. The file is copied into the selected
location, from which you can open it.

Notes

If the Storage is password-protected, the system prompts·

you to enter a password before you begin importing a file
from the Storage; in this case you require either a
'Read-Only' or a 'Complete Access' password
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Add Review Comments

For any Model Package in the Storage, you can add
individual review comments on any aspect of the Package.
These comments provide a permanent record on the Package
- once they have been saved they cannot be edited or
deleted.  Each comment is attributed to the ID of the user
who entered it, and is date stamped.

Note that the Review tab is present for a Learning Center
Library Storage, Reference Data Library Storage, and
Source Code Library Storage; however, the tab and panel
are disabled and review comments cannot be entered for
these storage types

Access

Open the Reusable Asset Service window using one of the
methods outlined here.

Select a Registry, Model Storage and Package, then click on
the 'Review' tab to display a list of comments associated
with the Package, and a panel for entering further
comments.

Ribbon Publish > Model Exchange > Reusable
Assets
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Actions

Action Description

Review
Existing
Comments

If there appears to be a longer comment
than can be shown in the 'Review' tab,
click on it. The full text displays in the
'Comments' field in the lower panel.

Add a New
Comment

Click on the New button and start typing
your comment on the Package in the
'Comments' field. You can delete and edit
text as you type.
When you have finished writing your
comment, click on the Save button. Your
comment, preceded by your user ID and
the current date, is displayed in the
'Review' panel.
Once you have saved your comment, you
cannot edit or delete it.
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Compare an Asset to the Model

If you are developing a Package in your model against a
standard structure, or using common elements from the
Reusable Asset Service, you can check that your model
conforms to the standard or incorporates any changes to the
common elements, by performing a comparison between the
Asset Package and your model.

Access

Open the Reusable Asset Service view using one of the
methods outlined here.

Select a Package, then right-click on the Package and
choose 'Compare with Package in Model'.

Ribbon Publish > Model Exchange > Reusable
Assets

Compare Asset Package and Model

A prompt displays for you to confirm the comparison. Click
on the Yes button.

The Baseline Comparison view displays, showing the
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element hierarchy in which differences have been detected
between the Package in the model and the asset Package in
the Registry (as the Baseline).

All facilities of the standard Baseline Comparison are
available, including the ability to 'roll back' differences so
that the element or Package in the model matches the
Registry.

Notes

If the Storage is password-protected, the system prompts·

you to enter a password before you begin comparing
information in the Storage and in the model; in this case
you require either a Read-Only or a Complete Access
password
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Register Assets

After you have set up your Storages in the Reusable Asset
Service Registry, you can register assets in them. The assets
include:

Packages of modeling structures of your model, shown in·

the Browser window; these Packages can include
diagrams and subordinate Packages

Any Packages containing model components on which the·

primary Asset Packages depend

Any MDG Technologies that you used in developing the·

Asset Packages, and that you decide to register with the
Packages

Any text or graphics files you want to make available to·

your corporate community; these files are compressed
before being added to the Storage

You register the first three items together. You can register
files in the Storage during that same process, or separately.

You can register separate versions of the same Package. If
you register a Package that already exists in the Registry
under the same version reference, and the Storage has 'Draft'
status, the existing version is overwritten. If you register the
same Package with a different version number or reference,
it is registered separately and users can access both versions
of the Package from the Registry.

'Learning Center Library', 'Reference Data Library' and
'Source Code Library' type Storages cannot contain
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Packages of modeling structures - they can contain only
Library files, which will appear in the 'Storage Files' tab. A
Library file is:

A zipped file containing Enterprise Architect-specific·

Learning Center files for the 'Learning Center Library'
Storage type

An XML file containing Enterprise Architect-specific·

reference data XML files for the 'Reference Data Library'
Storage type

A zipped file containing source code files for the 'Source·

Code Library' Storage type

Once registered, the Library file will be available in the
'Storage Files' tab of the Reusable Asset Service view.

Access

Ribbon Publish > Model Exchange > Reusable
Assets

Storage Types

Option Description

Register Registering Package-trees including
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Packages and
Files as
Assets

diagrams, as well as files.

Register
Learning
Center
Library

Register Learning Center files for use in
other repositories.

Register
Reference
Data Library

Register the current model's  Reference
Data Library for use in other repositories.

 Register
Source Code
Library

Register Zipped files of source code
libraries for distribution.
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Register Packages and Files as Assets

Having set up your Storages in the Reusable Asset Service
Registry, you can register Packages of modeling structures
as selected in the Browser window in your current model.
These Packages can include diagrams and subordinate
Packages, as well as files.

You can also create an Asset that purely contains files, by
not selecting a Package, but just selecting a file. See the
section Register File as Asset in this topic.

Register Packages and Files as Assets

Ste
p

Action

1 In the Reusable Asset Service view, select the
appropriate Registry and Storage.

2 In the Browser window, click on the Package to
register as an Asset.

3 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.
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4 The 'Register Package(s)' dialog displays, showing
the:

Name and type of the Storage·

Name and status of the selected Package (the·

status at this point being 'Pending')
The name, GUID and current version of the·

selected Package; you can type a different version
number or text string if necessary

If there is a version of the Package already in the
Registry, and the Storage has 'Draft' status, you can
either:

Overwrite the registered Package with an update·

of that version, or
Add the updated Package as another Asset under a·

different version number; in this case, the
'Packages to Register' panel shows the version
number, registration date and comments on the
latest version of the Asset Package

You cannot overwrite an existing Package if the
Storage has 'Complete' status. In this case, add the
Package under a different version number.

5 In the 'Comments' field type a short comment and, in
the 'Notes' field, a longer explanation of the Package
being registered.

6 Click on the Check Dependency button and resolve
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the dependencies of the Package.
At the end of this process, the selected Package has
the status 'Ready' (for registration).

7 You can, at this point, also register files as assets of
the Storage. See Step 4 of the next table, Register
File as Asset.
However, if you prefer you can follow the complete
procedure separate from registering Packages.

8 Click on the Register button.
A prompt displays to confirm registering the
Package. Click on the Yes button.
If the same version of the selected Package already
exists in the Registry (if the Storage is a 'Draft') a
prompt displays to confirm overwriting it. Click on
the Yes button.
A progress dialog displays. If the Package does not
have any associated MDG Technologies, a message
displays confirming that Package registration is
complete. Go to step 10.

9 If the Package has one or more associated MDG
Technologies, the 'Register MDG Technology'
dialog displays, listing the Technologies and
prompting you to register (OK) or ignore all of them.
If you want to register some Technologies but not
others, click on those you do not want to register,
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and click on the Remove button for each one in turn.
Click on the OK button or Ignore button.
A message displays confirming that Package and
Technology registration is complete.
Notes:

If a remote Technology is removed from·

registration (that is, the Technology is not
registered along with the Package), the registered
Package will refer to this Technology at its URL
When importing the Package from Registry, the
system will import this remote Technology from
its URL (if the remote Technology is not already
available in the importing model)
If a remote Technology is registered with the·

Package being registered, the system will store a
copy of the Technology file in the Registry
When importing the Package from Registry, the
system will import the Technology stored in the
Registry and will not import it from its URL (if the
remote Technology is not already available in the
importing model)

10 Click on the OK button.
The 'Registry Browser' tab is updated with the
newly-added details of the Package and any
dependent Packages. You can review the details on
the tabs on the lower half of the Reusable Asset
Service view.
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Register File as Asset

Ste
p

Action

1 In the Reusable Asset Service view, select the
appropriate Registry and Storage.

2 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password-protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.
The 'Register Package(s)' dialog displays.

3 If any Packages are listed in the 'Packages to
Register' panel, and you do not want to re-register
them, clear the checkbox against each Package
name.

4 Click on the Additional Files button.
The 'Select Additional Files' dialog displays.

5 Click on the Add button.
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A 'Select' screen displays, on which you browse for
and click on the required file. You can only select
one file at a time on this browser.

6 Click on the Open button.
The 'Add Comment' dialog displays.

7 Type a brief comment on the nature or purpose of
the file in the Registry, and click on the OK button.
Focus returns to the 'Select Additional Files' dialog,
which now lists the selected file.

8 Repeat steps 5-7 for each Asset file to register.
When you have finished, click on the OK button.
The 'Register Package(s)' dialog redisplays.

9 Click on the Register button.
A prompt displays to confirm registration of the
files.

10 Click on the Yes button.
A 'Progress' dialog displays while the files are
registered, followed by a message confirming that
the (Package and) File registration is complete.

11 Click on the OK button to clear the message, and to
return focus to the Reusable Asset Service view.
You can review the files on the 'Storage Files' tab in
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the lower half of the view.
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Register Learning Center Library

Here is a walk through for registering a  Learning Center
Library file. This Storage can be populated only with
Library files, not with Asset Packages.

Register Learning Center Library

Ste
p

Action

1 In the Reusable Asset Service view, select the
appropriate Registry and 'Learning Center Library'
Storage.

2 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.

3 The 'Register Learning Center Library' dialog
displays.
Click on the  button next to the 'File' field and
select the Library file.
Type in a short comment on the Library being
registered, in the 'Comments' field.
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4 Click on the Register button.
A prompt displays to confirm registering the Library
file. Click on the Yes button.
If the same Library file already exists in the
Registry, a prompt displays to confirm overwriting
it. Click on the Yes button.
A progress dialog displays followed by a message
confirming that Library registration is complete.

5 Click on the OK button.
The 'Storage Files' tab in the lower half of the
Reusable Asset Server view is updated with the
newly-added Library file.
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Register Reference Data Library

When you have a complete project set up, with fully defined
reference data, it is possible to transfer the reference data via
the RAS by setting an Asset that you can import into
another repository. The exported data includes all instances
of the selected data type in the project; for example, all
defined cardinality values, or all Document Style Templates.

Process

Ste
p

Action

1 In the Reusable Asset Service view, select the
appropriate Registry and 'Reference Data Library'
Storage.

2 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.

3 The 'Register Reference Data Library' dialog
displays.
Press the  button next to the 'File' field and select :
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From File System – to select an existing Reference·

Data XML file from the file system
From Model – to open the 'Export Reference Data'·

dialog for selecting categories that will be
registered as the Reference Data Library once the
Register button is clicked and a name is entered in
the 'Enter Reference Data File Name 'dialog

Type in a short comment for the Library being
registered in the 'Comments' field.

4 Click on the Register button.
A prompt displays to confirm registering the Library
file. Click on the Yes button.
If the same Library file already exists in the
Registry, a prompt displays to confirm overwriting
it. Click on the Yes button.
A progress dialog displays followed by a message
confirming that Library registration is complete.

5 Click on the OK button.
The 'Storage Files' tab in the lower half of the
Reusable Asset Server view is updated with the
newly-added Library file.

(c) Sparx Systems 2022 Page 1729 of 1974



Modeling Fundamentals 3 October, 2022

Register Source Code Library

These steps outline the process for registering a source code
library.

Process

Ste
p

Action

1 In the Reusable Asset Service view, select the
appropriate Registry and 'Source Code Library'
Storage.

2 On the 'Registry Browser' tab, click on the Register
button.
If the Storage is password protected, a prompt
displays for your 'Complete Access' password. Type
this in and click on the OK button.

3 The 'Register Source Code Library' dialog displays.
Select the Library file by pressing the  button next
to the 'File' field.
Type in a short comment for the Library being
registered, in the 'Comments' field.

4 Click on the Register button.
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A prompt displays to confirm registering the Library
file. Click on the Yes button.
If the same Library file already exists in the Registry
a prompt displays to confirm overwriting it. Click on
the Yes button.
A progress dialog displays, followed by a message
confirming that Library registration is complete.

5 Click on the OK button.
The 'Storage Files' tab in the lower half of the
Reusable Asset Server view is updated with the
newly-added Library file.
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Check Package Dependencies

As you register a Package in the Reusable Asset Service, the
system provides a check on whether that Package is
dependent on any external content; that is, whether it links
to any modeling component held in Packages other than its
own child Packages. You can perform three types of
dependency check:

Complete, which will consider Package A to be dependent·

on Package B if Package A contains any element,
attribute, operation, operation parameter, diagram or
connector (or their Tagged Values) that references
elements in Package B

Normative, which is the same as a Complete Dependency·

Check except that it will not treat as a dependency for
Package A any element from Package B that is added as a
link on a diagram in Package A

Package Dependency/Import, where only those Packages·

that are the target of a Dependency/Package Import
connector from Package A will be treated as dependent
Packages for Package A

You perform this dependency check as an integral part of
the Asset Registration process (specifically, at step 6 of the
Register Package as Asset process). The check
automatically identifies, firstly, the Packages directly
needed by the Asset Package, and then any Packages needed
by those initial Packages, and so on until the needed
Packages are not dependent on any other.
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In practice, such dependency chains are likely to be quite
short. If you know that the original Asset Package is
dependent on two other Packages, one of which is
subordinate to the other, you can simplify the process
further by selecting the Parent or Ancestor Package first and
thus avoid the extra steps of selecting the two Packages
separately.

Access

Open the Reusable Asset Service window, using one of the
methods outlined here.

Ribbon Publish > Model Exchange > Reusable
Assets : Register

Check Package Dependencies

Ste
p

Action

1 Select the appropriate Registry, Storage and version
of the model Package to register, and provide any
appropriate comments or notes.
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2 Click on the Check Dependency button.
If there are no Packages on which the Asset Package
depends, the system sets that Package to 'Ready'. Go
to step 6.
The 'Select Needed Package: <dependent package
name>' dialog displays, showing the model hierarchy
containing the Packages needed by the Asset
Package. Each needed Package has a selected
checkbox against it.
If you know that a needed Package is a child or
grandchild of another needed Package, click on the
checkbox next to the 'higher' Package name so that
the child is validated as part of the parent. In this
example, if the Asset Package has dependencies on
both External factors and Location, click on the
'External factors' checkbox to register both
dependencies as External factors.

If the needed Package is already registered in the
Registry, it is indicated by a globe icon:

In this case, select the 'Use latest version of selected
package in Registry (if available)' checkbox to link
to the registered version. For such Packages, no
further dependency check is performed and, on the
'Register Package(s)' dialog, the Package's Status is
set to 'Ready'.
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3 Click on the OK button.
The 'Register Package(s)' dialog updates to show the
initial 'Asset Package status' as 'Ready', and to list
the needed Packages each with the status of
'Pending'.

4 Click on the Check Dependency button again.
If there are no Packages on which the needed
Package depends, the system sets that Package to
'Ready' and sets the focus on the next Pending
Package. If there are no more Pending Packages, go
to step 6.
If the needed Package is dependent on other
Packages, the 'Select Needed Package: <dependent
package name>' dialog displays again, showing the
model hierarchy containing those Packages, each
with a selected checkbox next to it. As in step 2, you
can select a 'higher' Package if appropriate.

5 Click on the OK button.
The 'Register Package(s)' dialog updates to show the
first needed Package status as 'Ready', and to list any
further needed Packages with the status of 'Pending.

6 If there are further needed Packages in the chain,
repeat step 4. The system automatically identifies
them and lists them for validation as in step 5.
Otherwise the system sets the final needed Package
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status to 'Ready' and you can continue to register
files and MDG Technologies.

Notes

A Package with status 'Pending' cannot be registered; only·

Packages with status 'Ready' can be registered

If you are certain that there are no parent-child·

relationships between the needed Packages, you can work
through these steps quickly by just clicking on the Check
Dependency button and OK button alternately until all
Packages in the Package to Register list have the status
Ready

The system does not allow you to register an Asset·

Package that has dependencies on its own parent or
grandparent Package; such dependencies would cause the
Asset Package to be registered twice - by itself and as part
of the parent Package - creating the risk of differences
developing between the two instances
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Update an Asset

Over time, you might need to revise the contents of the
Registry. Such updates can include:

Registering additional Asset Packages and files·

Registering a new version of an Asset Package·

Registering a new edition of a Storage file·

Registering new Libraries·

Deleting an Asset Package·

Deleting a Storage file·

Deleting a Library·

Changing the details of a Storage·

Deleting an entire Storage and the assets and files within·

it

Access

Ribbon Publish > Model Exchange > Reusable
Assets > Registry Browser

Update Tasks
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Task Detail

Register new
Asset
Packages and
Storage files

You can add further Asset Packages and
files to a Storage at any time.

Register a
new version
of an Asset
Package

You register a new version of an Asset
Package as if it were a new Asset. In the
'Current Version' field on the 'Register
Package(s)' dialog, you type a different
number or reference to that assigned to
the currently-registered Asset.
You can overwrite an existing Asset
Package under the same version number
only if the Storage has 'Draft' status. If
the Storage has 'Complete' status, you
cannot overwrite the existing Asset
Package under the same version number.
To replace the current version, you must
delete the Asset from the Storage and
register the Package again.

Delete Asset
Package from
Storage

Click on the Package name in the
'Registry Browser' tab and either:

Click on the Delete button or·

Right-click and select the 'Delete From·

Registry' menu option
In either case a short submenu displays,
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prompting you to select to delete:
The Asset Package only, or·

The Asset Package and the Packages·

on which it is directly or indirectly
dependant

When you select the appropriate option, a
prompt displays for you to confirm the
deletion.
Click on the Yes button. A message
displays to confirm that the Package has
been deleted from the Registry, and the
name of the Package is removed from the
'Registry Browser' tab.
If the Storage is password-protected, the
system prompts you to enter a 'Complete
Access' password before it begins
deleting the Package(s).
If any of the registered Packages depend
on the Package being deleted, the system
displays the names of these Packages and
prompts for confirmation before deleting
each Package.

Register a
new version
of a Storage
File

You register a new version of a Storage
file as if it were a new file under a
different file name.
You can overwrite an existing file under
the same file name only if the Storage has
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'Draft' status. If the Storage has
'Complete' status, you cannot overwrite
the existing file. To replace the current
version, you must delete the file from the
Storage and register the file again.

Delete
Storage Files
from Storage

On the 'Storage Files' tab, right-click on
the file name and select the 'Delete From
Registry' option. A prompt displays for
you to confirm the deletion.
Click on the Yes button. A status
message confirms the deletion, the file is
removed from the Registry and the file
name is removed from the 'Storage Files'
tab.
If the Storage is password-protected, the
system prompts you to enter a 'Complete
Access' password before it begins
deleting the file.

Register a
new Library
File

You can add further Library files to a
Storage at any time.
When you register a Library file, the file
name and location will be used as the
unique identifier for the file. You can
overwrite this Library file in the Registry
by registering a file with the same name
and from the same file system location.

(c) Sparx Systems 2022 Page 1740 of 1974



Modeling Fundamentals 3 October, 2022

Delete
Library Files
from Storage

To delete all Library files in Storage,
click on the Delete button in the 'Registry
Browser' tab.
To delete a particular Library file,
right-click on the Library file name in the
'Storage Files' tab and select the 'Delete
From Registry' option.
A prompt displays for you to confirm the
deletion. Click on the Yes button. A
status message confirms the deletion,
each Library file is removed from the
Registry and each Library file name is
removed from the 'Storage Files' tab.
If the Storage is password-protected, the
system prompts you to enter a 'Complete
Access' password before it begins
deleting the Library file(s).

Change
Storage
Details

This task is as documented for setting up
the Registry. Note that whilst you can
copy a Storage as a new Storage, you
cannot transfer assets directly between
existing Storages.

Delete a
Storage and
its contents

This task is as documented for setting up
the Registry. Note that whilst you can
copy a Storage as a new Storage, you
cannot transfer assets directly between
existing Storages.

(c) Sparx Systems 2022 Page 1741 of 1974



Modeling Fundamentals 3 October, 2022

Refresh
Registry
Browser

If there is a possibility that another user
has updated the Registry while you have
had it open, click on the  icon in the
Reusable Asset Service toolbar to refresh
your display from the latest updates to the
Registry.
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Import an Asset into the Model

The Reusable Asset Service provides common or standard
information and data that you can import into your local
model. The unit that you import is a selected version of the
Asset Package; you can also, optionally, import:

Other Packages on which the selected Asset Package·

depends, and/or

Available Technologies that support full use of the model·

structures in the Asset Package

The Asset Package (with, if selected, any needed Packages)
is imported into the currently-selected model Package in the
Browser window, unless the Asset Package already exists
anywhere else in the Project. In this case, the system locates
the existing Package and overwrites it with the imported
Asset Package.

Access

Open the Reusable Asset Service window, using one of the
methods outlined here.

On the 'Registry Browser' tab, either;

Select an Asset Package and click on the Import button, or·

Right-click on an Asset Package and select the 'Import·

from Registry' option

Publish > Model Exchange > Reusable
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Ribbon Assets

Import Asset Package

Before selecting an Asset Package to import into your
model, click on the 'Version' drop-down arrow and select
the appropriate version of the Package to import.

When you select to import an Asset Package into your
model, a short menu displays from which you select to
import:

The Package alone or·

The Package with the related Packages on which it is·

dependent

A prompt then displays for you to confirm the import, and to
warn you that if the Package already exists in the model, it
will be overwritten by the import. Click on the Yes button to
continue, or the No button to cancel the import.

If the Storage is password protected, after you confirm the
import a prompt displays for your 'Read-Only' or
'Complete-Access' password; enter this and click on the OK
button.

The 'Import from Registry' dialog displays, followed by
confirmation that the import of the Package or Packages is
complete. Click on the OK button.

(c) Sparx Systems 2022 Page 1744 of 1974



Modeling Fundamentals 3 October, 2022

If the Package depends on Technologies

If the Technologies associated with an Asset Package are
not already on your system and/or enabled in your model,
during the display of the 'Import from Registry' dialog the
'Import Technology From Registry' dialog also displays.
Process this dialog as described.

Option Detail

Name Displays the name of the Technology as
recorded in the Registry.
The checkbox against each name is
selected by default. If you want to import
one technology but not another, deselect
the checkbox of the technology to ignore.

Version Displays the required version of the
Technology to support the Asset Package,
available through the Registry.

Registry
Status

Indicates whether the Technology file is:
Available - the Technology file is·

registered in the current Storage, or
Unavailable - for one of these reasons:·

     -  The Technology file is not
registered in the Storage, or
     -  The Technology is a built-in

(c) Sparx Systems 2022 Page 1745 of 1974



Modeling Fundamentals 3 October, 2022

Technology and is already integrated
with your system, or must
         be purchased under license, or
     -  The Technology is available from
a URL and can be downloaded from
that URL

Model Status Indicates whether the Technology is
already in your model and disabled.
(If the Technology is in your model and
enabled, there is no need to import it and
it is not listed in the dialog.)

OK Click on this button to import and/or
enable the selected Technology or
Technologies in your system.
A status message displays to indicate that
the Package and Technologies have been
imported and the Technologies enabled.
You might have to restart Enterprise
Architect for the Technologies to take full
effect.
Click on the OK button to clear the
message.
In the Browser window, the Package has
been added to the model with (if selected)
the Packages on which it is dependent.
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Notes

You can also import Technologies separately from the·

Package that is dependent on them, using the 'Technology'
tab of the Reusable Asset Service view

'Learning Center Library', 'Reference Data Library' and·

'Source Code Library' type Storages do not contain any
Asset Packages
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Search Registry

After you have set up your Storages in the Reusable Asset
Service Registry and registered Asset Packages in them, you
can search the Registry to locate modeling items such as
Packages, elements and diagrams using their names or
Global Unique Identifiers (GUIDs).

Access

Ribbon Publish > Model Exchange > Reusable
Assets

Search Registry for Asset Package Contents

Ste
p

Action

1 Click on the  icon in the Reusable Asset Service
toolbar.
The 'Search Registry' dialog displays.
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2 In the 'Property' field, select:
'GUID' if you intend to search the Registry for a·

modeling item based on its Global Unique
Identifier
'Name' if you intend to search the Registry for a·

modeling item based on its name

3 In the 'Term' field, type in the GUID or name of the
modeling item.
Note the interpretation of this field is case-sensitive.

4 In the 'Item' section, select the modeling item to
search for; that is, Package, element and/or diagram.

5 Click on the Search button to search the Registry for
the selected modeling item(s) and to display the
results, if any, in the 'Results' section.

6 The 'Results' section displays the results of the
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search, showing these details:
Storage - the name of the Storage in the Registry·

that has the modeling item
Owner - the name of the Asset Package that·

contains the modeling item
Name - the name of the modeling item·

Type - the Enterprise Architect type of the·

modeling item
GUID - the Global Unique Identifier of the·

modeling item
Notes :

The search results will be grouped by modeling·

item
The group Nested Package represents all those·

Packages (that satisfy the search criteria and) that
are a part of another registered Package

7 Select an entry in the 'Results' section and click on
the OK button to open the Storage (containing the
modeling item) in the Registry Browser and close
this dialog.
You will be prompted for a password if the Storage
is password protected; enter the 'Complete Access' or
'Read-Only Access' password and click on the OK
button to view the Storage contents.
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Auditing

Enable a Transcript of Model Changes Over Time

Auditing records model changes, including when the change
occurred and who made it. It records changes to Packages,
elements, features, connectors and diagrams, detailing the
creation, modification and deletion of these items. A
Repository Administrator or Librarian typically enables
auditing during selected project phases, or continuously
during the lifetime of the repository. An Enterprise
Architect repository contains important organization
information and ensuring that changes to the models are
consistent with an organization's intention and governance
principles is critical to the success of this important
information asset.

Audit View window showing the creation and change of a
'Driver' Actor element and its properties.

Audits are a practical model management mechanism
ensuring that changes to models are well understood and
governed. In this topic You will learn how to enable
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auditing, and using the Settings window define the level of
detail to record in the audit, the elements to be audited and
how batch imports are handled. You can simply enable
auditing and it will silently record the changes the users
make to the model. You will also learn how to manage audit
logs to ensure there are minimal impacts to performance as
logs are stored. Auditing can be used for a variety purposes
beyond governance for example arresting sub-standard
modeling practices by identifying the user and providing
them with training and guidance of how to model in a given
context.
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Brief Introduction

The Auditing facility in Enterprise Architect allows changes
to the repository to be recorded to an Audit log. This
governance tool can be profoundly useful in finding out who
changed a model and when it was changed. It is also useful
to see the complete list of changes made by a given user or
the list of changes made to a given element. The Audit View
is a dashboard that allows you to display the before and after
values of item properties and to drill down from Package
level through elements, features and connectors to diagram
objects.

Audit View showing the creation of, and two subsequent
changes to, the Diagram Object for a Driver Actor.

The basic steps to record Audit logs of the changes to a
repository are:

Enable Auditing - this initiates the process of changes1.
being written to the Audit log.

Configure Audit Settings - set the Audit Level and the2.
Audit Options that define which elements will be audited,
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and set options for importing and reverse engineering.

Allow models to be changed - users perform their normal3.
modeling, creating, modifying, and deleting  elements,
features and diagrams.

View the Audit log - to visualize the changes that have4.
been made since the last log clearance.

Save and Clear logs - logs can be cleared to increase5.
performance that degrades as the logs fill up.

Disable Auditing - optionally Auditing can be disabled if6.
no longer required, and re-enabled when required.

Audit View showing changes made to a Requirement's
'Status' property, from 'In Progress' to 'Approved'.

It is important to point out a fundamental difference
between Auditing and Baselines and Version Control. While
all three of these facilities are concerned with changes to a
repository over time, with Auditing it is not possible to
revert the model to a previous state, which is possible with
Version Control and Baselines. In contrast with a Baseline
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Compare, which only displays the original value and the
current values of an item property, the Auditing View can
display all the incremental changes over time, including
when they were made and who made them.

Setting up Auditing is a simple process, and once set up it
will begin recording information about what is changed in
the repository based on the settings that you have specified.
The next few sections provide the basic steps so that you
and your teams can get started with Auditing and controlling
changes to your repository.

Enabling Auditing

You can, as a Librarian or Administrator, enable Auditing,
which initiates the process of model changes being written
to the Audit log. You might choose to only enable Auditing
for a period of time, such as when a new modeler joins the
team or when contractors have access to the model, or in the
final stages of a sprint or iteration.

Audit Settings window, allowing Auditing to be enabled or
disabled.

Auditing can be disabled at any time and enabled again at a
later time. The logs, if not cleared, will simply be added to
once Auditing is re-enabled.
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Configuring Settings

The configuration of the Audit facility is an important step
in setting up the tool, to ensure that the changes that you
want to be able to visualize will be recorded in the Audit log
and will be available when the time comes to view them.
There are three main parts to the configuration:

Audit Settings window, showing Auditing Level, Options,
and Batch import and Log settings.

Import and Reverse Engineering options - allow you to·

specify whether these bulk items should be recorded in
the Audit log

Auditing Level - You can specify the extent of the·

information recorded

Auditing Options - You can specify which elements will·

be audited
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Viewing Audits

As a Librarian or Administrator, you can view the content of
the Audit either through the View Audit window or in the
System Output window. The Audit View provides a number
of options for changing the display and provides a
convenient Tree View control for navigating through the
changes.

Audit View window showing the tree of items and their
changes.

Changes are listed in time order, with an icon that indicates
if the change was a creation, modification or deletion. A
panel on the right displays the change itself, while the
header section at the top describes who made the change,
when it was made and the nature of the changes.
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Audit View window showing changes to a Requirement's
properties

Disabling Auditing

As a Librarian or Administrator your can disable auditing,
which terminates the process of model changes being
written to the audit log.

Audit Settings window allowing Auditing to be enabled or
disabled.

Auditing can be enabled again at any point in time when
required. The logs, if not cleared, will simply be added to
once auditing is re-enabled.
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Managing Logs

When Auditing has been enabled, changes to the elements
specified in the audit options are recorded in an audit log.
The management of logs is critical to the performance of the
Auditing facility. When the logs fill up, the time it takes to
write a change will increase, subtly degrading the
performance experienced by modelers as they work in the
repository. The management of logs can ensure that users
don't notice any perceivable change in their save times.  As
the Administrator or Librarian you can save the logs to a
network file and then clear the logs. It is recommended that
this process is managed to ensure an optimal user
experience. The logs can be managed from the left hand
panel of the Audit Settings window.

Audit Settings options to Clear, Save and Load Logs.
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Audit Settings

The Audit Settings window allows you to enable or disable
auditing, but in addition there are a number of options that
you can use to manage what is recorded by the Auditing
facility. These can be altered during different sessions of
auditing; for example, you might only want to record limited
information about requirements during a phase of the
project. Subsequently you might required detailed
information about all element types, and you could adjust
the settings to specify this. The important options are
summarized here:

Define whether bulk operations should be included in the·

audit

Administer your audit records such as saving and clearing·

logs

Specify the detail of the recorded audit by specifying the·

audit level

Specify the types of object to be included in the audit·

Access

Ribbon Settings > Model > Auditing : Audit
Settings
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Configure Settings

Option Action

Enable
Auditing

Select this checkbox to turn the Auditing
facility on. (Clear the checkbox to turn
Auditing off again.)

Audit XMI
Import

Select this checkbox to audit changes
arising from XMI importing.
As Version Control uses XMI, you must
select this option to record changes from
checking out Packages.

Audit XMI
Export

Select this checkbox to audit changes
arising from XMI exporting.
As Version Control uses XMI, you must
select this option to record changes from
checking out Packages.

Audit
Reverse
Engineering

Select this checkbox to audit changes
arising from reverse engineering.

Use Database
Timestamp

Select this checkbox to use the database
server's timestamp instead of each user's
local timestamp; this improves security.
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This option is not available for file-based
repositories.

Clear Logs Click on this button to permanently delete
all log data from the current project; use
the Save Logs button first, to save the
audit records outside the project.
The system prompts you to specify
whether to clear items logged over a
specific period of time.

Click on the No button to clear all log·

items currently held in the database
Click on the Yes button to display the·

'Time Filter' dialog, on which you
select a standard time period or define
your own

This function can be accessed through the
Automation Interface.

Save Logs Click on this button to save a copy of the
logged audit items currently held in the
project. These items remain in the
project; you can use the Clear Logs
button to remove them.
The system prompts you to specify
whether to save items logged over a
specific period of time.

Click on the No button to save all log·
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items currently held in the database
Click on the Yes button to display the·

'Time Filter' dialog, on which you
select a standard time period or define
your own

This function can be accessed through the
Automation Interface.

Load Logs Click on this button to load a previously
saved set of logs back into the project. A
browser displays through which you
select the log file to reload.
If the same record exists in both project
and log file, that record is not reloaded.

Core Select this radio button to record changes
to elements (including attributes and
operations), Packages, connectors and
some model-level information.

Standard Select this radio button to record the
same changes as for the Core option, plus
changes to some of the 'housekeeping'
data for diagrams - Name, Author,
Version, Stereotype, Notes and Date
Modified.
You can check for changes to diagram
content and structure using the Baseline
facility for reviewing visual changes to
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diagrams.

Extended Select this radio button to record the
same changes as for the 'Standard' option,
plus changes to project security.

Debug Select this radio button to record the
same changes as for the 'Extended' option
plus changes to any database tables.
Some of the auditing information will not
be visible unless the Audit View mode is
set to 'Raw'.

Maintenance Select this radio button to audit changes
to maintenance elements only; that is:

Package (element)·

Requirement·

Feature·

Use Case·

Actor·

Note·

Issue and·

Change·

Core
Structural

Select this radio button to audit changes
to maintenance elements plus certain
structural elements; that is:

Package (structure)·
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Class·

Interface·

Signal·

Node·

Component·

Artifact·

Part·

Port and·

Device·

All Select this radio button to audit changes
to all types of element.

Custom Select this radio button to audit changes
to element types that you specify.
The Customize button is made available;
click on this button to display a list of
element types, and select the checkbox
against each element type to include in
the audit (or click on the Select All button
to select every element type).
Click on the OK button to save the
selection.

Notes
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As the number of records increases, the performance of·

the Audit View reduces; it is recommended that audit
records that are not regularly required are saved to file,
then cleared from the project, to help ensure high
performance

Connectors are audited when they are connected to an·

element that is included under the Audit Options

If security is enabled, you must have 'Audit View'·

permission to turn Auditing on, and 'Audit Settings'
permission to change the audit settings
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View the Audits

As an Administrator or Librarian you can view the changes
that have been made to the items in the repository. The
changes that are recorded depend on three main settings:

Import and Reverse Engineering options - allow you to·

specify whether these bulk items should be recorded in
the audit log

Auditing Level - You can specify the extent of the·

information recorded

Auditing Options - You can specify which elements will·

be audited

There are two different views of the changes that are
available to you:

The Audit View - a fully featured window that allows you·

to navigate through the changes and change the display

The System Output window, 'Audit History' tab - a textual·

display that changes as the element context changes

(c) Sparx Systems 2022 Page 1767 of 1974



Modeling Fundamentals 3 October, 2022

Audit View

The Audit View provides a convenient dashboard of
information that allows an administrator or librarian to view
and manage the changes to the information that have been
recorded by Auditing. A tree view control provides a quick
way to navigate through a branch of the repository, showing
all the items that have been changed. Colored icons provide
a quick visual queue as to whether a particular item has been
created, changed or deleted. When a change is selected in
the tree view, the panel to the right displays the properties
that have been created, modified or deleted, and the top
panel shows the user responsible, the time and date of the
change and a summary of the change.

Access

Ribbon Settings > Model > Audit

Sections of the Audit View

The Audit View is divided into three main areas:

Section Description
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View
controls

The view controls provide a variety of
settings for controlling auditing and the
display of audit records.

Audit tree The audit tree displays the log items that
have been recorded by auditing.
What is displayed in the tree is affected
by the view controls, such as:

Sorting·

Filter (by time)·

Mode·

Auditing settings (what was actually·

recorded)
If synchronizing with the Browser
window, it is also affected by the
Package, diagram or element you have
selected.

In the audit tree:
The green tick indicates a creation·
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The yellow pencil indicates an edit·

The red cross indicates a deletion·

Right-clicking an element in the audit
tree (such as ObjectB) displays a context
menu that enables you to locate the
selected element in:

The Browser window·

Any diagrams in which it exists·

Record
display

The record display is in two parts: the
identity of the selected change, and the
actual change made.
The data in the record display is
determined by the view controls and
mode and, if synchronizing with the
Browser window, by the Package,
diagram or element you have selected.
Identity

The identity of a change consists of:
The Windows username of the user·

who made the change; if security is
enabled, the name is of the format
WindowsUsername(SecurityUser)
When the change was made·
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The path of the change; for example:·

Class Class1 - Attribute Att1 - Attribute
Constraint Constraint

Changes
Changes are displayed in a table format,
showing the:

Property (or data item) name·

Its original value before the change and·

Its value after the change·

If you double-click on an item in the list
of changes (or right-click and select the
'Show Differences' option) the Difference
window displays:

This shows the specific changes that have
been made, highlighting the edited,
created, deleted or formatted characters.
Changes to the format of text in the
element, made through the element
'Properties' dialog, are not apparent in the
initial table; they are visible in the
Difference window, identified by HTML
formatting tags.
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Notes

If security is enabled, you must have 'Audit View'·

permission to display data in the Audit View
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Audit View Controls

The Audit View controls provide a variety of settings for
controlling auditing and the display of audit records.

Options

Option Action

Configure Click to open the 'Audit Settings' dialog.

Load Click to reload the Audit Tree, updated
with any new audit results.

Mode Click to display a menu of options to
change the mode of the Audit View.
Select:

'Default View' - to load large sets of·

log items independent of the Browser
window; in this mode, a special Audit
Settings group can be displayed in the
Audit Tree, which records:
     -  When Auditing has been enabled
and disabled
     -  Who made the change
     -  The date and time of the change
     -  Changes to the Audit Settings
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     -  When Audit Operations are
executed
     -  Security changes (which can be
browsed in the same way as
        other changes)
'Filtered to Browser' - to automatically·

synchronize with the Browser window;
where changes have been made, the
Audit View reflects your selection
from the Browser window - if you click
on:
     -  An element, the Audit View
displays the history for that element
     -  A Package, the Audit View
displays the history for that Package
        and its immediate children (but
not the contents of nested Packages)
     -  A diagram, the Audit View
displays the history for that diagram
and
        its contents (which could be
drawn from a wide area of the Browser
        window)
'Sequential Event Log' - to display all·

audit records in chronological order
without sorting, enabling you to see a
progression of changes; this can be
especially useful in determining
date-time inconsistencies
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Any search and filtering you define still
apply, enabling you to view all of
today’s changes in order, or all changes
for a particular element in order, or
both
Additional database information is
displayed; this additional information
might be insignificant or only in
machine-readable format
'Deleted' - to display only deleted·

records, but otherwise data is shown as
in 'Default' mode; records can be sorted
by element type or by user as required

Search Click to search through log items for a
particular area - you can search by Name,
Type or GUID.
The items are loaded and filtered with the
current Group By, Time Period and Mode
settings.
If you refresh the Audit View, you must
run the search again.

Time Period Click to display the 'Time Filter' dialog,
to set the filter time period:

Today - to display changes occurring·

today
Previous Hour - to display changes·

occurring in the last 60 minutes
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Previous 24 Hours - to display changes·

occurring in the last 24 hours
Previous Week - to display changes·

occurring in the last 7 days
Previous 30 Days - to display changes·

occurring in the last 30 days
Previous Year - to display changes·

occurring in the last 365 days
Custom - to define your own time·

period, using the From and To fields
The six pre-configured time periods
automatically update when you click on
the Refresh button; custom periods are
static and do not automatically update.

Group By Select the appropriate radio button for the
required display setting:

Type - changes are grouped under·

element type (such as Class or
Requirement), and then grouped under
the changed element
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User - changes are grouped under user·

name, each with the number of changes
for that user
Under each user name, changes are
grouped as for the Type sort

Status Text (Displayed to the right of the 'Group By'
panel) Read to see which:

Mode has been selected and·

Time filter is being applied to the data·
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System Output - Audit History

When Auditing is turned on, an 'Audit History' tab is added
to the System Output window. The tab shows a history of
changes to whichever element or connector you have
selected in the:

Current diagram·

Browser window·

Audit View, or·

Package Browser·

System Output window 'Audit History' tab showing changes
to the elements in the repository.

As you select different elements or connectors, the 'Audit
History' tab automatically updates to reflect your current
selection. For each change made to the element or
connector, the tab shows:

Who made the change·

When the change was made·

Where the change was made·

The value of the characteristic before the change·

The value of the characteristic after the change·
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Access

Ribbon Start > All Windows > Design > Explore
> System > Audit History

Notes

To see this tab, you must first have the Audit View open;·

the tab continues to display if you subsequently close the
Audit View

If security is enabled, you must have 'Audit View'·

permission to display data on the 'Audit History' tab
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Performance Considerations

Auditing is a tool for determining who made changes to the
model and when the changes were made. When auditing has
been enabled, every time a change is made to the model the
Enterprise Architect auditing engine records the change.
These changes will naturally, as for any transaction system,
take some to be written to the audit log. When the logs are
small this write time will be imperceptible but when the logs
grow in size the time taken to write to the log will increase
and could delay the saving of changes. The tool provides a
number of ways to reduce theses delays in saving changes.
The delays can be experienced in two different parts of the
auditing process:

When making changes to the repository - As described·

earlier, saving model changes could be delayed, affecting
you or any other user who is updating an aspect of the
model that is being audited; for example, a change to an
element's name, changing the position of an object on a
diagram or - if configured - the creation of tables or code
classes resulting from reverse engineering a database or
code package, will all result in a write to the audit logs

When accessing the Audit View - The Audit View that is·

typically accessed by a Librarian or Administrator can
become slow due to the volume of audit records that have
to be sorted and displayed

The performance of both these aspects of the auditing
process is discussed in these topics:
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Auditing Performance·

Audit View Performance·
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Auditing Performance

Enabling auditing on a project increases the time taken for
many actions, such as insertion, change and deletion of
objects and changes to properties of elements, connectors
and diagrams, including moving objects in diagrams. When
auditing is initially enabled, the time required to write to the
audit logs will be almost imperceptible, but as the logs grow
in size the log write time will become longer and could
cause some frustration to you or your colleagues, whose
main focus is creating useful models. Fortunately there are
some simple housekeeping and administration procedures
that can reduce this time, typically performed by a Librarian
or Administrator.

Operation Delays

Operation Detail

Large
Deletions

Deleting large Packages or Package
structures, or large numbers of elements,
takes significantly longer with auditing
on.
You might disable auditing before
performing such a deletion.

XMI Imports Importing XMI takes longer with auditing
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enabled.
A project-level option is provided for
disabling auditing of XMI Imports.

Reverse
Engineering

Reverse engineering code takes longer
with auditing enabled.
A project-level option is provided for
disabling auditing of reverse engineering.

Replication You cannot remove replication from a
model with Auditing enabled.
If you have to remove replication, disable
Auditing and - if prompted to do so -
allow Enterprise Architect to roll back the
database version; you can then remove
replication.
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Audit View Performance

As the logs become larger, the Audit View can exhibit slow
performance simply because of the volume of records it has
to process to create the visualizations used by the Librarian
or Administrator. Fortunately there are ways to reduce the
delay in the presentation of changed items, and these only
require a small amount of housekeeping.

Considerations and Responses

Consideratio
n

Detail

Navigating
the Browser
Window
Within
Auditing is
Slow

Try setting the time period to a period in
the immediate past, such as 'Today',
'Previous 24 Hours' or 'Previous Week';
this time period updates each time you
open or refresh the Audit View.
Save log items outside the project with
the Save Logs button; if you then clear
the logs you have just saved, the load
time of the Audit View is reduced.
You can reload logs into the project at
any time, using the Load Logs button.

The Audit As for 'Navigating the Browser Window
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View is Slow
in Loading
and
Changing
Modes

Within Auditing is Slow'.

Navigating
the Audit
Tree is Slow

Close the 'Audit History' tab in the
System Output window.
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More Information

Edition Information

The Auditing facility is available in the Corporate,·

Unified and Ultimate editions

Warning - If your site uses the Professional edition of·

Enterprise Architect (in which Auditing is not available)
as well as the Corporate, Unified and/or Ultimate editions,
when Auditing is turned on in a project any users of the
Professional edition are locked out of that project; to
restore access, turn Auditing off

Related Tools

Version Control·

Baselines·

The Compare Utility (Diff)·
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Version Control

Stores Versions of parts of a Repository for Comparison
and Rollback

Version Control provides a mechanism to store previous
versions of any section of a model and later compare them
to a current state. Version Control is a useful team feature
that allows models to be developed in a coordinated way
within a team environment.  Sections of the model can be
placed under Version Control  and you can manage changes
to and revisions of your model content by placing individual
model Packages, view nodes or root nodes under Version
Control. The information stored within the repository is a
valuable corporate asset and needs to be managed as such.

Browser window showing one Checked-Out Package
(Context) and four Checked-In Packages under Version
Control.

Version Control provides a safeguard against losing
previous model changes. In this topic you as the Librarian
will learn how to configure a Version Control product for
use within Enterprise Architect and to apply the
configuration to control Packages, individually or in groups.
You will also learn how to use Version Control to
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Check-Out and Check-In Packages, how to view previous
versions, and compare a current version to a previous
version.
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Brief Introduction

The Version Control feature allows you to check-out a
Package, which then locks it so that no other user can
modify it until you have checked it back in again. You can
then modify the Package, adding new elements and
diagrams, changing others and deleting still others.  When
you have completed your changes and are ready for other
modelers to see your work, you can check-in the Package.
Other modelers would then need to do a Get Latest to pull
the new changes down from the Version Control Server.

Enterprise Architect does not version the Packages
internally; instead it integrates with industry standard
Version Control servers, which an administrator must install
and configure for use by Enterprise Architect. The files that
Enterprise Architect uses are industry standard XMI files,
which are best seen as 'binary' from the point of view of
Version Control. This means that it is not possible for two
modelers to be working on the same file, as it would not be
possible to merge the files as is possible with source code or
text files.

The basic steps to use Version Control are:

Select and set up a Version Control Server and Client side1.
Software.

Place the required Packages under Version Control.2.

Check Out a Package.3.

Make modifications to the contents of the Checked Out4.
Package.
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Check In the Package, entering comments that describe5.
the changes.

Compare the Repository Package with the Version6.
Controlled Package.

Retrieve (rollback to) a previous version.7.

Enterprise Architect's Version Control integration provides
several key facilities, including:

Saving a history of changes made to your model's·

Packages

Retrieving previous revisions of Packages·

Propagating model updates between team members·

Coordinating the sharing of Packages between team·

members

Commissioning a Version Control System

You apply Version Control through a third-party
source-code control application that manages access to and
stores revisions of the controlled Packages. Once the
Version Control software has been installed and configured,
you or a librarian must define a Version Control
Configuration within your project. You can then use
Version Control to manage changes to the Packages of your
model.
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Configuring Packages

Before you can Check Out a Package and begin making
changes, you or the librarian must first configure the
Package for Version Control. You simply select the 'Add
Branch to Version Control' option and choose an existing
configuration. This adds the Package to the Version Control
System and places it in a Checked-In state.

Context menu showing the 'Add Branch to Version Control'
option.

Packages under Version Control are identified in the
Browser window by icons that indicate the current status of
the Package. When a Package is initially added to the
Version Control System it will have a locked icon, as shown
in this diagram.

Browser Window showing the Design Package with a Lock
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icon after Check-In.

Checking Out Packages

Once Version Control has been set up and configured you
can start checking out Packages. When you want to work on
a Package that is Version Controlled, you need first to
Check Out that Package. This will change the Package icon
in the Browser window from locked to unlocked. While you
have the Package checked-out no other user will be able to
work on the Package and they will in turn see a locked
Package icon.

Context menu showing the Check Out option.

Make Modifications to Package Content

Once a Package has been checked out you are free to make
modification to the content, just as you would in a
repository that doesn't have any Version Control
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implemented. You will be the only one able to edit the
content, as other users that attempt this will receive a
message saying the Package is checked out.

Browser window showing the Context Package that has
been checked out, with the Checked-Out Package icon

Checking In Packages

Once you have finished making changes to the contents of a
Checked-Out Package, you can Check In that Package. This
will change the Package icon in the Browser window from
unlocked to locked. As soon as you Check-In the Package it
will display a locked Package icon and the Version Control
system will be updated. You can also enter a comment that
describes the changes that you made while the Package was
under your control, which will be useful when looking back
at version changes. Once the Check-In is complete, other
users will be able to Check-Out the Package.
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Context menu showing the Check In option.

Getting Latest Changes

If you are working in a single shared model any changes
that your colleagues have made will be available by simply
reloading the Package. If, however, you are working in
private models then you will need to periodically get the
latest changes that your colleagues have checked in to the
Version Control system. You can use 'Get Latest' for a
single Package or for the entire model depending on
whether you are interested in just one change or all of the
changes.
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Context menu showing the 'Get Latest' option.

Comparing to Previous Version

At any stage of a model's evolution you can compare the
current version of a Package to the version stored in the
Version Control system. This option launches the
Comparison window that displays the differences between
the model's current state and the latest revision held in the
Version Control system.

Context menu showing the 'Compare with Controlled
Version' option.

Reverting to a Prior Version

(c) Sparx Systems 2022 Page 1796 of 1974



Modeling Fundamentals 3 October, 2022

As your model evolves you might want to revert to a
previous version of a Package. By using the 'File History'
dialog you can select any prior version. By viewing the
Check-In comments and the Date and Time of the Check-In
the required version can be selected. The Retrieve option
will restore the current model to the selected version without
the need to check-out the Package.

File Version History window showing a number of versions
(revisions) with Comments.
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Setup Options

There are a number of options that can be chosen when
setting up Version Control for one or more teams in your
organization. There are also some fundamentals about the
way that Enterprise Architect integrates with the Version
Control software with respect to locking that you should
review before setting up Version Control.
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Version Control Locking Overview

Enterprise Architect implements Version Control of your
model by exporting Package data from the project database
to XMI Package files, which are placed under Version
Control in the source-code control application. The XMI file
format cannot be merged in the same way as ordinary text
files can be merged, which is why Enterprise Architect must
enforce serialized editing of Version Controlled Packages,
as discussed here.

The Lock-Modify-Unlock Solution

Many Version Control systems use a lock-modify-unlock
model to address the problem of different authors in a
shared source overwriting each other's work. In this model,
the Version Control repository allows only one person to
change a file at a time, and access is managed using locks.

Harry must lock a file before he can begin making changes
to it. If Harry has locked a file, Sally cannot also lock it, and
therefore cannot make any changes to that file. All she can
do is read the file, and wait for Harry to finish his changes
and release the lock. After Harry unlocks the file, Sally can
take her turn in locking and editing the file.

The Copy-Modify-Merge Solution
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Subversion, CVS and a number of other Version Control
systems use a copy-modify-merge model as an alternative to
locking. In this model, each user's client contacts the project
repository and creates a personal working copy - a local
reflection of the repository's files and directories. Users then
work simultaneously and independently, modifying their
private copies. In due course, the private copies are merged
together into a new, final version. The Version Control
system often assists with the merging, but ultimately a
person is responsible for making it happen correctly.

When Locking is Necessary

While the lock-modify-unlock model is generally
considered a hindrance to collaboration, there are still times
when locking is necessary.

The copy-modify-merge model is based on the assumption
that files are contextually merge-able: that is, that the files in
the repository are line-based text files (such as program
source code). However, for files with binary formats, such
as artwork or sound, it is often impossible to merge
conflicting changes. In these situations, it really is necessary
for users to take strict turns in changing the file. Without
serialized access, some users end up wasting time on
changes that are ultimately overwritten.
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Repository Options

The Version Control facility can be used in many different
ways, although these roughly fall into one of four types of
use as discussed in this table.

Usage

Type Details

Single
Shared model

Users share a model stored in a central
project file or DBMS repository. In this
configuration you can view changes to
other users' Packages without explicitly
having to check them out, by simply
refreshing your view of the model.
Version Control is used to:

Archive successive versions of your·

work to date
Maintain Package revision history·

Recover from unwanted changes or·

accidental deletions, through an 'Undo'
facility
Regulate access to Packages·

Multiple
Private

One model is created by a single user
who configures it for Version Control.
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models The model file is then distributed to other
users, with each user storing their own
private copy of the model.
Version Control is used to:

Propagate changes to the model,·

throughout the team
Archive successive versions of your·

work to date
Maintain Package revision history·

Recover from unwanted changes or·

accidental deletions, through an 'undo'
facility
Regulate access to Packages·

Shared
Packages

Individual users create separate models
but share one or more Packages:

Users share Packages through Version·

Control

Standard
Packages

A company might have a standard set of
read-only Packages that are broadly
shared:

Individual users retrieve Packages with·

the Get Package menu option
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Factors to consider

Factor Detail

System
Requirements
and
Configuratio
n

You apply Version Control through a
third-party source-code control
application that manages access to and
stores revisions of the controlled
Packages.
Typically the configuration consists of:

A server component that manages a·

Version Control repository, and
Client components on the workstations,·

that manage local working copies of
controlled files

Enterprise Architect uses the client
component to communicate with the
server. A Version Control client must be
installed on every machine where you run
Enterprise Architect and want to access
your Version Control system.

Version
Control
Usage

There are two main ways in which
projects can be deployed:

Centralized Shared Model·

Distributed Private Models·

Version Control is employed in the same
way for both scenarios; however, when
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using Private Model deployment you
have the additional facility of propagating
model updates throughout the team.
Version Control can also be used to share
standard Packages between different
projects.

Team
Deployment

Consider the process of setting up a
Version Control environment and
applying Version Control to a project to
be accessed by a number of users.

Version
Control
Basics

Enterprise Architect enforces serialized
editing of Version Controlled Packages,
using the lock-modify-unlock mode of
operation.

Applying
Version
Control to
Models

Using Version Control consists of placing
individual model Packages under Version
Control, rather than Version Controlling
the project as a whole.

Version
Control and
Project
Reference
Data

To share changes in reference data
between users in a version-controlled
project deployed as multiple private
models, you periodically export the
reference data from the model where the
changes were made, and import it into the
other models maintained by the team.
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Offline
Version
Control

You can prevent the system from
attempting to make any Version Control
connections by choosing to Work Offline
before loading a model.
If Enterprise Architect is unable to
connect a Version Control Configuration
for any reason, it displays warning
messages to notify you and provides
'offline' Version Control functionality for
all Packages associated with the failed
connection.
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Version Control of Model Data

When applying Version Control in Enterprise Architect, you
place individual model Packages under Version Control, and
not the project as a whole.

All Enterprise Architect models are stored in databases -
even the .eap file is an MS Jet database. In simple terms, the
project file is a single entity of binary data. Being binary
data, the project file would require the use of the
lock-modify-unlock model of Version Control, which would
mean that only a single user at a time could work on any
given (Version Controlled) model. Therefore, it is not
practical to apply Version Control to the database (.eap file)
as a whole; this can also create problems for you in that:

Most Version Control systems mark their controlled files·

as read only, unless they are specifically checked-out to
you

The .eap file is an MS Jet database, and Enterprise·

Architect must be able to open this file for read/write
access when you load your model; if the model is
read-only, the system displays an error message and fails
to load the model

Version Controlling Packages in your Model

To overcome these limitations, Enterprise Architect exports
discrete units of the model - the Packages - as XMI Package
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files, and it is these XMI files, not the project file, that are
placed under Version Control. The XMI file format used by
Enterprise Architect dictates that they too be treated as
binary files - therefore it is not possible to merge the XMI
files either; however, by splitting the model into much
smaller parts, many users can work on separate parts of the
model simultaneously.

Version Controlled Nested Packages

Version Controlled nested Packages result in much smaller
XMI files being exported, as the parent Packages' XMI files
do not contain any content for the Version Controlled child
Packages.

Version Control of nested Packages, together with a model
structure of small individual Packages, provides greater
scope for multiple users to work concurrently, as individual
users are locking much smaller parts of the model.
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Version Control Nested Packages

When you save a Package to the Version Control system,
only stub information is exported for any nested Packages.
This protects information in a nested Package from being
inadvertently over-written by a top level Package.

Operations on Nested Packages

Operation Detail

Checking
Out

When you check out a Package, you do
not modify or delete nested Packages;
only the top level Package is modified.
As a consequence of this behavior, if you
check out or get a Version Controlled
Package with nested Packages that are
not already in your model, you see stubs
in the model for the nested Packages
only.

Get All
Latest

If you select the 'Get All Latest' option
from the Version Control menu, any new
stubs are populated from the Version
Control system.

Importing You can populate a large and complex
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Models model, by 'getting' only the root
Packages, then using 'Get All Latest' to
recursively iterate through the attached
and nested Packages.
This is a practical and efficient means of
managing your project and simplifies
handling very large models, even in a
distributed environment.
The 'Import a Model Branch' option
combines the procedure steps into a
single operation.

Notes

It is recommended that, when sharing a Version·

Controlled model, you do not mix versions of Enterprise
Architect later than version 4.5 with earlier versions; if
this is necessary it is best to go to the 'Version Control
Settings' dialog and deselect the 'Save nested version
controlled packages to stubs only' checkbox, setting
Enterprise Architect to the pre-version 4.5 behavior (for
the current model only)
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Version Control and Reference Data

Reference data is data that is used across a model or project;
it is not Package-specific. Version Control operates at
Package level, and therefore does not capture changes in
reference data. Where Version Control is used in a multiple
private model set up, changes in reference data are not
brought into the model when Packages are updated from
Version Control.

In a Shared Model environment, all users are accessing the
same project reference data. Changes in reference data can
be shared between users in a Version Controlled project
deployed as multiple private models, by periodically
exporting the reference data from the model where the
changes were made, and importing it into the other models
maintained by the team.

Reference data is exported and imported as an XMI file,
which contains whatever types of reference data you want to
transfer. You can place your project reference data under
Version Control by exporting the data as an XMI file and
apply Version Control to that file using your Version
Control software external to Enterprise Architect.
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Version Control and Teams

This is a summary of the process of setting up a Version
Control environment and applying Version Control to a
project to be accessed by a number of users.

Version Control - Process Overview

Ste
p

Action

1 Install your Version Control product.

2 Create a Version Control repository.

3 Create a Version Control project to be used with
your Enterprise Architect project.

4 Check-out a working copy of the Version Control
project (a module, project or folder within the
Version Control system) into a local folder.
You must do this for every team member that is
accessing the Version Controlled Packages, whether
you are using a single shared model or each team
member stores his own private copy of the model.

5 Before attempting to access the new Version Control

(c) Sparx Systems 2022 Page 1811 of 1974



Modeling Fundamentals 3 October, 2022

environment from within Enterprise Architect, you
should first verify that it functions correctly when
used outside of Enterprise Architect.

6 Within Enterprise Architect, define a Version
Control configuration to provide access to the
working copy files.
The name of the Version Control configuration must
be the same across all machines throughout a team.
That is, all Version Control access to a given
Package must be through Version Control
configurations with the same name, across all
models and all users.
The easiest way to perform this step (throughout the
team) is to have one user set up Version Control on
the model and then share that model with the rest of
the team.

In Shared Model deployment, all users connect to·

a single instance of the model database, so the
model is shared automatically
In Private Model deployment, it is easiest to·

distribute copies of the original model (after
Version Control has been set up) to all other
members of the team

Whenever you open a model (Private or Shared) that
uses a Version Control configuration that is not yet
defined on your workstation, a prompt displays to
complete the definition for that configuration. This
typically means specifying the local working copy
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directory and perhaps choosing the Version Control
project associated with this Enterprise Architect
project.
Once this has been done, the Version Controlled
Packages that already exist in the model are ready
for use.

7 Configure Packages within the Enterprise Architect
model for Version Control. That is, apply Version
Control to individual Packages.

8 Check-out and check-in Packages as required.

Notes

It is possible to use multiple Version Control·

Configurations within the same model; different Packages
can still use different Version Control Configurations
within the model, as long as any given Package is always
accessed via the same Version Control Configuration
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Offline Version Control

When loading a model that uses Version Control, Enterprise
Architect normally initializes a connection to the Version
Control system for each Version Control configuration
defined in the model. If Enterprise Architect is unable to
connect a Version Control configuration for any reason, it
displays warning messages to notify you and provides
offline Version Control functionality for all Packages
associated with the failed connection.

You can prevent Enterprise Architect from starting to make
any Version Control connections, by selecting to work
offline before loading your model.

Access

Ribbon Settings > Version Control > Work
Offline

Working Offline

Concept Discussion
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Choosing to
Work Offline

Selecting to work offline is useful if you
know beforehand that Enterprise
Architect cannot connect to your Version
Control system. For example: If you are
working on a laptop computer that is
disconnected from your network, on an
Enterprise Architect model that uses a
large number of Version Control
configurations, you can select to work
offline before you load the model to
avoid all the error messages that the
system would normally display as each
Version Control connection attempt
failed.
You can switch between working offline
and working online at any time, either
before or after a model is loaded, by
toggling the 'Work Offline' menu option.
Enterprise Architect disconnects or
reconnects Version Control (depending
on the connection availability) according
to your selection.

Using
Version
Control
Whilst
Disconnected
From the
Version

Enterprise Architect 'remembers' the
status of a model’s Version Controlled
Packages. Packages that were checked
out to you prior to disconnecting from the
server are still shown as checked out to
you, even though you are no longer
connected to the server. You can still edit
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Control
Server

these Packages as you normally would.
Packages that were not checked out to
you prior to disconnecting from the
server are shown as Version Controlled
and locked. You cannot edit these
Packages until you check them out.

Offline
Check Out

You can 'check-out' and edit a Version
Controlled Package even when your
machine is disconnected from the
Version Control server. In this example,
the colored 'figure 8' icon for DFD
indicates that you have checked it out
whilst off line.

(The gray 'figure 8' icon shown against
Logical View indicates that you have
checked out a Version Controlled
Package on line.)
You should be aware that the Version
Control system, and therefore other users,
have no way of knowing that you have
'checked-out' a Package whilst offline. It
is not possible to merge changes to an
XMI file that result from two users
editing the same Package at the same
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time. If an offline checkout leads to two
people editing the same Package at the
same time, when the changes are brought
back online the first-saved set of changes
is lost.

Checking In
a Package
That Was
Checked Out
Offline

Once you reconnect your system to the
Version Control server, if the Package
you checked out offline is not currently
checked out by another user, you can
check in that Package. However, before
Enterprise Architect checks in the
Package, it compares the local working
copy of the Package file with the latest
revision in the repository. (These Package
files remain unchanged in your work area
until Enterprise Architect exports the
Package again before checking in.) If the
repository version remains unchanged
from when you last updated your local
copy, Enterprise Architect exports and
checks in your Package without further
prompting.
On the other hand, if the repository now
contains a file that has changed since you
last updated your local copy, checking in
your Package would overwrite those
changes. Enterprise Architect displays a
message warning you of the pending data
loss and giving you the opportunity to
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abort the check in. At this point, you must
decide whether to discard your own
changes, using the 'Undo Check Out'
command, or continue with your check in
and overwrite the changes that have been
committed to the repository since you last
updated your local copy from the
repository.
You can use the 'File Properties'
command to determine who checked in
the last changes to this Package. This
might help you to discover what changes
have been uploaded and decide whose
changes take precedence.

Update
Before You
Disconnect

Whenever you are connected to the
Version Control server, you are always
working with the latest version of a
Package. This is because you cannot
modify a Package until you check it out
from Version Control, and checking it out
loads the latest revision from the
repository into your model.
This cannot happen when you are
disconnected from the Version Control
server. You are working on whatever
versions you have on your machine,
dating back to the last time you updated
your local copy of each Version
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Controlled Package. So, if you are
planning to work on a model whilst
disconnected from Version Control, it is a
very good idea to make sure that you
have the latest versions of all Packages
before you disconnect. The 'Get All
Latest' option makes this a simple task.
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Version Control Branching

Currently, Enterprise Architect does not support Version
Control Branching.

Work-arounds to achieve similar results might be possible
for certain version-control products; contact Sparx Support
for advice.

Contacts

User Type Contact via

Registered
users

https://sparxsystems.com/registered/reg_s
upport.html

Trial users support@sparxsystems.com
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Version Control Product Setup

To control and maintain the different revisions of your
project Packages, Enterprise Architect uses third-party
Version Control products. Once your Version Control
product is installed and a suitable environment has been
created, Enterprise Architect can use that environment to
control your project's Packages.

Typically, Version Control products consist of:

A server component·

A client component·

Enterprise Architect integrates with the Version Control
client components for Subversion, CVS and MS Team
Foundation Server command line clients, as well as for
products having API clients that comply with the MS SCCI
specification.

Version Control System Components

Component Detail

Version
Control
Server

The server component maintains the
controlled files in their many revisions, in
a central repository.
The server component is usually located
on a server machine that is accessible to
all team members who are using Version
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Control.

Server
Configuratio
n

The steps for configuring a Version
Control server are, broadly:

Install the software·

Create a repository·

Create Version Control projects (or·

modules or folders for use with specific
projects)
Configure user IDs and passwords·

For details on configuring any particular
Version Control server, consult the
appropriate documentation provided with
the Version Control product.

Version
Control
Client

The client component manages the
working copies of the controlled files,
submitting files to or retrieving files from
the server as required.
A Version Control client must be
installed on every machine on which you
run Enterprise Architect and want to
access your Version Control system.

Client
Configuratio
n

The steps for configuring a Version
Control client are, broadly:

Install the software·

Create a new directory for use as a·
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local working copy folder
Log in to the Version Control server·

Associate the working copy folder with·

its corresponding server repository
folder

For details on setting up a
product-specific Version Control
environment for use with Enterprise
Architect, click on the appropriate link in
the next column.
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System Requirements

Enterprise Architect is a Windows-based application and
requires a Windows-based Version Control client for
integration. It is independent of the Version Control server
component and the platform on which that runs.

Version Control Product Requirements

Product Detail

Subversion Subversion is free, open source software.
Subversion server components are
available to run on a wide range of
different hardware and operating systems.
Enterprise Architect is not affected by
your choice of server components, but
requires Subversion's Windows-based
command line client for integration.
There are many graphical user interface
clients available for use with Subversion,
such as TortoiseSVN; this type of client
cannot be used directly for integration
with Enterprise Architect, but can be very
useful in preparing a working Subversion
environment for use by Enterprise
Architect.
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Binary Packages are available for
download from:

http://subversion.apache.org/packages.·

html
Subversion documentation is available
from:

http://svnbook.red-bean.com/nightly/en·

/index.html

Concurrent
Versions
System
(CVS)

CVS is free, open source software.
CVS server components are available to
run on a wide range of different hardware
and operating systems.
Enterprise Architect is not affected by
your choice of server components, but
requires CVS's Windows-based
command line client for integration.
There are many graphical user interface
clients available for use with CVS, such
as TortoiseCVS; this type of client cannot
be used directly for integration with
Enterprise Architect, but can be very
useful in preparing a working CVS
environment for use by Enterprise
Architect.
The software is available for download
from:

http://www.nongnu.org/cvs/·
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CVS documentation is available from:
http://cvsbook.red-bean.com/cvsbook.h·

tml

Microsoft
Team
Foundation
Server

Enterprise Architect is able to use either
the:

Command line client for TFS, or·

MS TFS-SCC client·

Your choice of client affects how you
specify your Version Control
Configuration.
MS TFS-SCC clients are available for
download from Microsoft's web pages.
(Run an Internet search for 'TFS
MSSCCI'.)

Common
Source Code
Control
(SCC)-compa
tible products

Any Version Control product that
provides a client that complies with the
Microsoft Common Source Code Control
standard, version 1.1 or higher, can be
integrated with Enterprise Architect.
These products are SCC-compatible and
are known to successfully integrate with
Enterprise Architect:

Accurev·

ClearCase·

MS Visual Source Safe·

MS TFS-SCC·

(c) Sparx Systems 2022 Page 1826 of 1974

http://cvsbook.red-bean.com/cvsbook.html
http://cvsbook.red-bean.com/cvsbook.html


Modeling Fundamentals 3 October, 2022

MKS Source Integrity·

Perforce·

Source Offsite·

Snapshot CM·

Products that do not appear in this list
should still integrate successfully with
Enterprise Architect, if there is a client
available for that product that complies
with the MS SCC API specification.
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Create a Subversion Environment

You can use Subversion as a Version Control provider for
Enterprise Architect. The first step in doing this is for a
Subversion administrator to install and configure the
appropriate software. A number of basic tasks are performed
in creating an operational Subversion environment, and
useful tools are available for performing some of these
tasks.

Tasks in Creating a Subversion Environment

Task Detail

Install server
components

Executable files for Subversion can be
obtained from the Apache Software
Foundation.
Subversion server components are
available to run on a wide range of
different hardware and operating systems;
Enterprise Architect is not affected by
your choice of server components.
VisualSVN is an application that can
greatly simplify the installation,
configuration and management of your
Subversion server.
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Create a
repository

Please consult the official Subversion
documentation.

Create
Subversion
users

Please consult the official Subversion
documentation.

Create a new
repository
sub-tree

It is good practice to create a new
repository sub-tree in Subversion for each
new Enterprise Architect model being
added to Version Control with
Subversion. Users should create a new
local working copy from the sub-tree to
be used with that model.
TortoiseSVN can greatly simplify the
process of creating new repository
sub-trees.

Install client
components

Executable files for Subversion can be
obtained from the Apache Software
Foundation.

Create a
working copy
folder

A working copy folder must exist on each
users' machine, for Enterprise Architect
to use when exporting and importing the
Version Controlled Package files. It is
this folder that is specified as the Local
Project Path, when defining your Version
Control Configurations.
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The working copy folder is the 'sandbox'
where you modify the controlled files.
The working copy folder is usually
associated with a folder that exists within
the Version Control repository. In
Subversion, to create a local working
copy you perform an initial check-out of
a folder from the Subversion repository;
this downloads a copy of the folder and
its contents, to create your local working
copy.
TortoiseSVN can greatly simplify the
initial check out of a working copy
folder.

Setting up
Subversion
under
Wine/CrossO
ver

The process of setting up and using
Subversion with Enterprise Architect
under Wine is almost identical to the
process when running natively under
Windows, apart from minor differences
in installing the Subversion client and
performing the initial check out of the
working copy folder.

Notes

Enterprise Architect relies on exclusive file locking when·
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applying Version Control to its Packages; file locking was
not introduced into Subversion until version 1.2, therefore
Enterprise Architect does not work with Subversion
releases earlier than Subversion 1.2

Enterprise Architect can only communicate with the·

Subversion server using the Subversion command line
client svn.exe
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Create a new Repository Sub-tree

When you set up Subversion as your Version Control tool, it
is good practice to create a new repository sub-tree in
Subversion for each new Enterprise Architect model. The
sub-tree can be used to control the Package files for your
model.

Create a new sub-tree in the Subversion
Repository

Ste
p

Action

1 Use Windows Explorer to create a temporary
directory on your PC file system, to be imported into
the Subversion repository as a new repository
sub-tree. The directory would have this structure:

2 Open a Windows command prompt, navigate to
tempDir and issue the Subversion command import.
For example:
     C:\Documents and Settings\user> cd \tempDir
     C:\tempDir> svn import .
https://host.example.com:8443/repos/
     --message "Repository Initialization"
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3 On your PC, delete the temporary directory structure
(tempDir) and all its contents.

Notes

After the import is finished, the original tree is not·

converted into a Subversion working copy; you should
delete the temporary structure and check out a fresh
working copy of the tree

The process can also be performed using TortoiseSVN's·

Repository Browser, which provides commands for
simply creating new folders directly in the repository
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Create a Local Working Copy

In order to use Subversion to provide Version Control of the
Packages in a model, you need to prepare a functional SVN
working copy folder that can be accessed through an
Enterprise Architect Version Control configuration within
that model.

Create a Subversion working copy folder

Ste
p

Action

1 Choose or create a suitable directory on your system
in which to create your Subversion working copy.

2 Open a command prompt window and navigate to
the directory you have selected. For example:
     C:\> mkdir mySVNWorkSpace
     C:\> mkdir
mySVNWorkSpace/myEAModelName
     C:\> cd mySVNWorkSpace/myEAModelName

3 Perform the initial check out from the Subversion
repository, specifying the repository folder and local
working copy folder, as well as your user name and
password. For example:
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     C:\> svn checkout
"https://myserver:8443/svn/repos_folder
     "C:\mySVNWorkSpace/myEAModelName"
     --username myUserName
     --password myPassword
(By specifying your Subversion username and
password, you ensure that they are correctly cached
by Subversion and available for use by Enterprise
Architect.)
If you specify the HTTPS protocol when performing
the initial Subversion check out, a prompt displays to
accept a security certificate; in this instance, press
the P key to permanently accept the certificate.
The nominated local folder is configured as a
Subversion working copy folder.
Any files already existing in the repository folder are
downloaded to the working copy folder as working
copy files.

4 Verify that your Subversion environment functions
correctly.

Notes

It is important that Subversion caches your username and·
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password, so that it never has to prompt for user input; a
check-out operation might not request authentication, and
if it does not you should perform an action that does
request authentication, such as adding and committing a
dummy test file

The process can also be performed using TortoiseSVN's·

Checkout command (which provides options to browse
when specifying both your repository folder and your
local folder); when prompted for authentication details by
TortoiseSVN, make sure you place a check against the
'Save Authentication Data' option
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Verify the SVN Workspace

After creating the Subversion local working copy to hold the
working copies of your Package files, you can verify that it
functions correctly before attempting to use it with
Enterprise Architect. You need to be able to add files to
Subversion, lock the files and commit changes to those files.

Verify correct operation of a Subversion
working copy folder

Ste
p

Action

1 Use Windows to open a command prompt window.

2 Select the directory you specified as the working
copy, in the Subversion checkout command when
preparing the SVN workspace. For example:
     C:\> cd mySVNWorkSpace

3 Create a test file, such as Test.txt, containing the text
Subversion Test. For example:
     C:\> echo Subversion Test > Test.txt

4 Execute each of these Subversion commands:
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svn add Test.txt·

svn commit -m"Commit comment" Test.txt·

svn update Test.txt·

svn lock Test.txt·

Use your preferred editor to modify the file and·

save the changes
svn commit -m"Second commit comment" Test.txt·

The commands should execute without any errors
and without prompting the user for any extra input.

Notes

Your environment must be set up such that you can·

perform these operations without ever being prompted for
user ID or password; for further information, please see
the Caching Client Credentials topic in the official
Subversion documentation
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Subversion Under Wine-Crossover

If you want to set up and use Subversion with Enterprise
Architect under Wine, the process is almost identical to the
process for setting up and using the systems under
Windows. When running Enterprise Architect under Wine
or CrossOver, you still use a Windows-based Subversion
command line client.

There are some minor differences in the way you prepare
the Subversion working environment, specifically in the
way you install your Subversion client and the way you
check out a working copy folder from the Subversion
repository.

System Requirements

Sparx Systems has tested the use of Enterprise Architect
with Subversion under Wine 1.2, on macOS 10.4 and
10.6.2, and on Ubuntu 10.04. All tests were passed.

When using Wine 1.2 on the Ubuntu 9.10 platform, Sparx
Systems was able to use the svn: and file: protocols to
communicate with the SVN server; but not the https:
protocol.

Installing a Subversion Client
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Wine is able to install applications from either a Windows
.exe file, or a .msi installer file.

Place the installer for your Windows Subversion client in a
convenient location on the native file system, then open a
Wine console window from within Enterprise Architect and
run the installer from within the Wine console. Your
Subversion installation can then access the same C: drive
and folders that Enterprise Architect is accessing.
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Preparing a Subversion Environment
Under Wine

Under Wine, you can install Subversion from either a
Windows .exe file, or a .msi file. By performing your
Subversion installation and initial check out from a Wine
console window opened from within Enterprise Architect,
you have access to the same C: drive and folders that
Enterprise Architect is accessing.

Set up Subversion for use with Enterprise
Architect, running under Wine

Ste
p

Action

1 Start Enterprise Architect.
You do not have to load a project at this point.

2 From the 'Start' ribbon, select 'Appearance >
Preferences > Toolbars...
The 'Customize' dialog is opened.
Select the 'Tools' tab, then click on the  icon.
A new, blank entry is opened on the 'Tools' tab of
the 'Customize' dialog.
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3 Define the new menu item entry:
In the newly-opened 'Menu contents' field, type·

the name 'Wine Console'
In the 'Command' field, type 'wineconsole'·

In the 'Arguments' field, type 'cmd'·

Leave the 'Initial directory' field blank·

4 Click on the Close button.
The 'Customize' dialog closes.

5 Select the ribbon option: 'Settings > User Tools >
Wine Console'.
A Wine console window opens.

6 Type 'C:' and press the Enter key.
The Wine console switches to the C: drive.

7 Issue the command to install your Subversion client.
For example:
     C:\>/Installers/Subversion-client-1.9.5.win32.exe
To install from a .msi file, use Wine's msiexec
utility. For example:
     C:\>msiexec /i
"Installers\Slik-Subversion-1.9.7-win32.msi"
Installation of the Subversion command line client
begins.
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8 Create a folder to serve as the working copy folder to
be used by Enterprise Architect. For example:
     C:\>mkdir C:\VC_workspaces\SVN_workcopy

9 Issue the command to perform the initial checkout
from the Subversion repository, specifying the
repository folder, working copy folder, username
and password. For example:
     C:\>svn checkout
"https://myServer:8443/svn/repos_folder"
            "C:\VC_workspaces\SVN_workcopy "
            --username myUserName
            --password myPassword
(After you specify your Subversion username and
password, they are correctly cached by Subversion
and are available for use by Enterprise Architect.)
If the HTTPS protocol is specified when performing
the initial Subversion check out, you are prompted to
accept a security certificate; in this instance, press
the P key to permanently accept the certificate.
The nominated local folder is configured as a
Subversion working copy folder. Any files already
existing in the repository folder are downloaded to
the working copy folder as working copy files.

10 Type 'Exit' and press the Enter key.
The Wine console window closes.
You are now ready to load a project in Enterprise
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Architect and apply Version Control to it, using the
normal Windows-based procedures.

Notes

You should copy the installer for your Windows·

Subversion client to a convenient location on the native
file system, so that you can easily refer to it from within
the Wine console window in step 7
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TortoiseSVN

TortoiseSVN is a Windows shell extension for Subversion;
it provides icon overlays in Windows Explorer that are
useful as a tool for observing the status of your Subversion
controlled files. You can also use it to create your repository
sub-trees and check out local working copies from within
Windows Explorer, using simple menu commands.

You can download TortoiseSVN from
http://tortoisesvn.net/downloads.html.

Notes

Enterprise Architect can only communicate with the·

Subversion server using the Subversion command line
client svn.exe
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Create a TFS Environment

You can use Microsoft Team Foundation Server (TFS) as a
Version Control provider for Enterprise Architect. The first
step in doing this is for a TFS administrator to install and
configure the TFS server and client applications. A number
of basic tasks are performed in creating an operational TFS
environment.

Tasks in Creating a TFS Environment

Task Detail

Obtain and
install TFS

Enterprise Architect uses the TFS
command line client to integrate TFS
Version Control.
The TFS command line client is normally
available as part of your Visual Studio
installation.

Choose a
TFS project

It is good practice to create a new TFS
project, or least a new Source Control
Folder within a project, for each
Enterprise Architect project being added
to Version Control with TFS.
If you have a single Enterprise Architect
project that contains many different

(c) Sparx Systems 2022 Page 1846 of 1974



Modeling Fundamentals 3 October, 2022

models (for example, a DBMS hosted
project with multiple model root nodes),
you might choose to create a new TFS
project for each separate model.
For further information, please consult
your TFS product documentation.

Create a TFS
workspace

A working copy folder must exist on each
users' machine, for Enterprise Architect
to use when exporting and importing the
Version Controlled Package files. It is
this folder that is specified as the Local
Project Path, when defining your Version
Control Configurations.
The working copy folder is the 'sandbox'
where you modify the controlled files.
The working copy folder is usually
associated with a folder that exists within
the Version Control repository. In TFS,
the TFS workspace is used to map a local
working folder on your PC to a Source
Control Folder within a TFS project.
TFS 2012 and VS 2012 (and later
versions) feature a new type of
workspace called 'local' workspaces. Do
not attempt to use TFS 'local' workspaces
with Enterprise Architect. You must use
only 'server' workspaces for Enterprise
Architect Version Control, as 'local'
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workspaces do not support the
application of checkout locks to files.
Enterprise Architect relies on the
presence of checkout locks to ensure that
Packages can only be checked out
exclusively and that a given Package is
not already checked-out in some other
project (for instance, in a Private Model
deployment). This is necessary because it
is not practical to merge the XMI
Package files that Enterprise Architect
uses for Version Control.
A single TFS workspace can map many
different local folders, each one to a
separate Source Control Folder. In this
case, TFS can take a long time to work
through and update the files in all of
those folders, and the system might
appear to 'freeze' whilst it waits for TFS
to hand back program control.
You can avoid this if you keep your
Version Controlled Package files in a
folder that is separate from other
Artifacts, such as source code files,
creating a separate work space to use just
for your Package files, or creating and
mapping a separate folder for Package
files within an existing workspace.
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Configure
exclusive
check-outs

The XMI format files used for the
Version Control of Enterprise Architect's
Packages can not be merged as if they
were ordinary text files. Therefore,
Enterprise Architect must enforce
serialized editing of its Version
Controlled Packages. As a consequence,
it is important that TFS is configured to
use 'exclusive checkouts' for XML files.

Verify the
TFS
Workspace

Enterprise Architect uses the TFS
command line client to checkin and
checkout files from the TFS repository.
After creating the TFS workspace, it is
important to verify that the command line
client can be used to add, check-in and
check-out files residing in the working
copy folder that is mapped through this
workspace.

Notes

TFS can also be used with an SCC client; the MS·

TFS-SCC client is available for download from
Microsoft's web site

MDG Integration for Visual Studio 2005 or 2008·
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enhances TFS support by providing access to, for
example, work items and bugs within both Enterprise
Architect and the MDG Integration product
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TFS Workspaces

In order to use TFS to provide Version Control of the
Packages in a model, you prepare a functional TFS
workspace that can be accessed through an Enterprise
Architect Version Control configuration within that model.
You use the TFS workspace to map a local working folder
on your PC to a Source Control Folder within a TFS project
repository.

It is assumed that have TFS 2013 open and a TFS Team
Project already exists for you to use in Version Control of
the Packages of your Enterprise Architect project. You can
create the TFS workspace through MS Visual Studio.

TFS 2013 and later versions support the use of Local
workspaces. However, Local workspaces do not support the
application of checkout locks. For this reason, Sparx
Systems strongly advises against the use of Local
workspaces when Version Controlling your Enterprise
Architect Package files. Using Local workspaces carries a
high risk of merge conflicts when checking in, which would
almost certainly result in loss of data or a corrupted model
database.

Map a local folder to a TFS Source Control
Folder

Ste Action
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p

1 Connect to your TFS server.
From the TFS main menu, choose 'View | Team
Explorer'.
In the Team Explorer toolbar, click on the Connect
to Team Projects button (fourth from left, with a
power plug icon).
The 'Team Explorer Connect' page displays.

2 Click on the link 'Select Team Projects...'
The 'Connect to Team Foundation Server' dialog
displays.

3 Click on the appropriate Team Foundation Server,
Team Project Collection and Team Project, then
click on the Connect button.

4 Click on the Home page of the Team Explorer, and
then on the Source Control Explorer button.
The Source Control Explorer view displays.

5 In the Source Control Explorer, click on the
drop-down arrow in the 'Workspace' field in the
toolbar, then click on 'Workspaces' at the bottom of
the list.
The 'Manage Workspaces' dialog displays.
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6 Click on the Add button.
The 'Add Workspace' dialog displays.

7 Click on the Advanced button.
A number of new fields display on the dialog.

8 Type in an appropriate name for the new workspace
and, if required, type in a comment.

9 Set the 'Location' field to 'Server'. This setting is
important.
This setting is not available in TFS 2010 and earlier
releases, where all workspaces are Server based.

10 Click in the Source Control Folder column, then
click on the Browse button to select a Source
Control Folder.
Select the Source Control folder (in the Team
Project) to use for controlling Enterprise Architect
Packages.

11 Click on the Browse button in the 'Local Folder'
column and create a new local folder.
This is the working copy folder into which
Enterprise Architect exports the Package files.

12 Click on the OK button.
The new workspace is created and saved.
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The 'Add Workspace' dialog closes.

13 Click on the OK button.
The 'Manage Workspaces' dialog closes.

Notes

The local folder referenced in step 11 is the Working·

Copy Path that should be specified when defining an
Enterprise Architect Version Control Configuration to use
this TFS workspace
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TFS Exclusive Check Outs

The XMI format files used for the Version Control of
Enterprise Architect's Packages can not be merged as
ordinary text files can. Therefore Enterprise Architect must
enforce serialized editing of its Version Controlled
Packages, and it is important that Team Foundation Server
is configured to use 'exclusive checkouts' for XML files.
Otherwise, TFS can return file statuses that make it look as
if the Package file is not checked-out by another user when
indeed it is.

You set exclusive checkouts in the TFS workspace through
MS Visual Studio.

Configure TFS to enforce exclusive check
outs for XML files

Ste
p

Action

1 Using Visual Studio, from the main menu select
'View | Team Explorer'.

2 In the 'Team Explorer' pane, right-click on the TFS
Server name that is controlling the Enterprise
Architect Package files, then from the context menu
select 'Team Foundation Server Settings | Source
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Control File Types'.

3 Select the entry for XML files (or create an entry if
necessary) then click on the Edit button.

4 Deselect the 'Enable file merging and multiple check
out' checkbox.
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Verify the TFS Workspace

Enterprise Architect will be using the TFS command line
client to commit file updates from the local working copy
folder into the TFS repository. After creating the TFS
workspace that maps your local working copy folder to a
TFS repository folder, it is good practice to verify that the
TFS workspace functions correctly before attempting to use
it with Enterprise Architect. You need to be able to add files
to TFS, place a check-out lock on the files and check-in
changes to those files.

Verify correct operation of a TFS Workspace

Ste
p

Action

1 Use Windows to open a command prompt window.

2 Select the directory you specified as the local
working copy folder when creating the TFS
workspace.
For example:
     C:\> cd  myTFSWorkingCopyFolder

3 Create a test file, such as Test.xml, containing the
text 'my TFS Test'. For example:
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     C:\> echo my TFS Test > Test.xml
(The filename extension '.xml' is used because the
TFS server should have been configured to allow
exclusive checkouts for XML files.)

4 Using the command line client, execute each of these
TFS commands:

tf.exe add Test.xml·

tf.exe checkin Test.xml /override:"Manual check·

in." /comment:"a message"
tf.exe checkout /lock:checkout Test.xml·

Use your preferred editor to modify the file and save
the changes.

tf.exe checkin Test.xml /override:"Manual check·

in."  /comment:"a message"
tf.exe get . /recursive·

Notes

All of the commands in step 4 should execute without any·

errors; in particular, you should be able to apply a
checkout lock when checking out the file

If the checkout command reports any errors, you might·

have to reconfigure the TFS workspace as a server based
workspace, or you might have to configure the TFS
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Server to use 'exclusive checkouts' for XML files
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Create a CVS Environment

You can use Concurrent Versions System (CVS) as a
Version Control provider for Enterprise Architect. The first
step in doing this is for a CVS administrator to install and
configure the appropriate software. A number of basic tasks
are performed in creating an operational CVS environment,
and useful tools are available for performing some of these
tasks.

Tasks in Creating a CVS Environment

Task Detail

Install server
components

Executable files for CVS can be obtained
from March Hare Software.
CVS server components are available to
run on a wide range of different hardware
and operating systems; Enterprise
Architect is not affected by your choice
of server components.

Create a
repository

Please consult the official CVS
documentation.

Create CVS
users

Please consult the official CVS
documentation.
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Create a new
repository
module

It is recommended good practice to create
a new repository module in CVS for each
new Enterprise Architect model being
added to Version Control with CVS.
Users should create a new local working
copy folder from the module to be used
with that model.
A repository module represents a project,
or a set of related files in the repository.
TortoiseCVS can greatly simplify the
process of creating new repository
sub-trees.

Install client
components

Executable files for CVS can be obtained
from March Hare Software.
Enterprise Architect is a Windows based
application - it requires a Windows based
CVS command line client for integration.

Create a
working copy
folder

A working copy folder must exist on each
users' machine, for Enterprise Architect
to use when exporting and importing the
Version Controlled Package files. It is
this folder that is specified as the Local
Project Path, when defining your Version
Control Configurations.
The working copy folder is the 'sandbox'
where you modify the controlled files.
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The working copy folder is usually
associated with a folder that exists within
the Version Control repository. In CVS,
to create a local working copy you
perform an initial check-out of a folder
from the CVS repository; this downloads
a copy of the folder and its contents, to
create your local working copy.
TortoiseCVS can greatly simplify the
initial check out of a working copy
folder.

Setting up
CVS under
Wine/CrossO
ver

The process of setting up and using CVS
with Enterprise Architect under Wine is
almost identical to the process when
running natively under Windows, apart
from minor differences in installing the
CVS client and performing the initial
checkout of the working copy folder.

Notes

If you do not already use CVS for Version Control, you·

should consider using Subversion instead; Subversion's
client-server protocols provide a broader range of
possibilities for connecting to remote servers, with easier
set up of secure connections
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TortoiseCVS is a Windows shell extension; Enterprise·

Architect cannot use TortoiseCVS as its client, it must use
the CVS command line client
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Prepare a CVS Local Workspace

In order to use CVS to provide Version Control of the
Packages in a model, you need to prepare a functional CVS
working copy folder that can be accessed through an
Enterprise Architect Version Control configuration within
that model.

Prepare a CVS Working Copy Folder

Ste
p

Action

1 Ask your System Administrator to install CVS and
create a remote repository, with a module that you
can use to control your Enterprise Architect Package
files.
Your administrator must create a username and
password for you before you can make a connection.

2 Select or create a suitable directory to use as your
CVS working copy directory.

3 Open a command prompt window and navigate to
your CVS working copy directory. For example:
     C:\> mkdir myCVSWorkSpace
     C:\> cd myCVSWorkSpace
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4 Log in to the remote CVS repository. For example:
     C:\myCVSWorkSpace> cvs
-d:pserver:myUserID@ServerName:/reposPath login
Replace myUserID with your CVS username,
replace ServerName with the name of your CVS
server and replace reposPath with the path to the
repository on the server.
A prompt for a password displays.

5 Enter your password.
You are logged in to the CVS server.

6 Perform the initial checkout of the CVS repository
module, into the local working copy directory. For
example:
     C:\myCVSWorkSpace> cvs
-d:pserver:myUserID@ServerName:/reposPath
checkout moduleName
(Replace moduleName with the name of the
repository module that you want to check out.)
A subdirectory is created in your current working
directory, with the same name as the module being
checked out.
Any files already existing in the repository module
are downloaded to the working copy folder as
working copy files.
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7 Verify that your CVS environment functions
correctly.

Notes

Much of the process can also be performed (more simply)·

using the TortoiseCVS command 'Make New Module'
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Verify the CVS Workspace

After creating the CVS local working copy to hold the
working copies of your Package files, you can verify that it
functions correctly before attempting to use it with
Enterprise Architect. You need to be able to add files to
CVS, and commit changes to those files. You also need to
be able to register as an editor of the file and retrieve the list
of currently registered editors.

Verify correct operation of a CVS working
copy folder

Ste
p

Action

1 Use Windows to open a command prompt window.

2 Select the directory you specified as the working
copy in the cvs checkout command, when preparing
the CVS workspace. For example:
     C:\> cd myCVSWorkSpace

3 Create a test file, such as Test.txt, containing the text
CVS Test. For example:
     C:\> echo CVS Test > Test.txt
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4 Execute these CVS commands:
cvs add Test.txt·

cvs commit -m"Commit comment" Test.txt·

cvs update Test.txt·

cvs edit Test.txt·

cvs editors Test.txt·

The commands should execute without any errors
and without prompting the user for any extra input.
The editors command should produce output that
resembles this:
     Test1.txt myUserID Tue Aug 9 10:08:43 2009
GMT myComputer
     C:\myCVSWorkSpace\moduleName

5 Take note of the userID that follows the filename.
Enterprise Architect must find and use this user ID
when you create your Version Control configuration.

Notes

Your environment must be set up such that you can·

perform these operations without ever being prompted for
input, such as user ID or password
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TortoiseCVS

TortoiseCVS is a Windows shell extension for CVS; it
provides icon overlays in Windows Explorer that are useful
as a tool for observing the status of your CVS controlled
files. You can also use it to create your repository modules
and check out local working copies from within Windows
Explorer using simple menu commands.

You can download TortoiseCVS from:
http://www.tortoisecvs.org.

Notes

Enterprise Architect must use the CVS command line·

client to communicate with the CVS server; it cannot use
TortoiseCVS
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Create an SCC Environment

You can use a Microsoft Common Source Code Control
(SCC) compatible product as a Version Control provider for
Enterprise Architect. The first step in doing this is for an
administrator to install and configure the server and client
applications. A number of basic tasks are performed in
creating an operational SCC-based environment.

Tasks in Creating an SCC Environment

Task Detail

Install and
configure
your chosen
Version
Control
product

A Version Control server component is
typically installed on a dedicated server
machine. All Enterprise Architect users
who require access to Version Control
must be able to connect to the server
machine.
After installing the Version Control
software, the administrator should also
create Version Control user IDs for all
users who require access to Version
Control.
For further information, consult the
product documentation for your particular
Version Control product.
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Create a new
SCC project

It is good practice to create a new SCC
Version Control project, or least a new
folder within a project, for each
Enterprise Architect project being added
to Version Control with SCC.
If you have a single Enterprise Architect
project that contains many different
models (for example, a DBMS hosted
project with multiple model root nodes),
you might choose to create a new SCC
Version Control project for each separate
model.
For further information, consult the
product documentation for your particular
Version Control product.

Configure
your SCC
project to
support
exclusive
check-outs
for .XML
files

The XMI-format files used for the
Version Control of Enterprise Architect
Packages can not be merged in the same
way as ordinary text files can. Therefore,
Enterprise Architect must enforce
serialized editing of its Version
Controlled Packages. As a consequence,
it is important that your Version Control
application is configured to use 'exclusive
checkouts' for XML files.

Create a local A working copy folder must exist on each
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working copy
folder

users' machine, for Enterprise Architect
to use when exporting and importing the
Version Controlled Package files. It is
this folder that is specified as the Local
Project Path, when defining your Version
Control Configurations.
The working copy folder is the 'sandbox'
where you modify the controlled files.
The working copy folder is usually
associated with a folder that exists within
the Version Control repository. Your
Version Control product provides some
means by which you associate a working
copy folder with a repository folder.
For further information, consult the
documentation for your particular
Version Control product.

Notes

When installing the client component software on users'·

PCs, check that the SCC client is also installed, as it might
not be a part of the default installation
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Upgrade at Enterprise Architect
Version 4.5, Under SCC Version Control

If you are working in Enterprise Architect release 4.5 or
later and you open an SCC Version Controlled project that
was created under a release earlier than 4.5, you must
identify the SCC connection with a new unique ID. You can
assign a name to the existing SCC configuration or associate
the project with another configuration that has previously
been assigned a unique ID.

By having a unique ID for each Version Control
configuration, you can assign a configuration quickly and
efficiently using configurations that have been created
previously for other Version Controlled repositories. This
enables you to configure the many Packages to use an
existing Version Control repository; this can apply to
Packages created for more than just one model enabling a
great deal of flexibility.

Upgrade an existing SCC Version Controlled
project created before release 4.5, in
Enterprise Architect release 4.5 or later

Ste
p

Action
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1 Open the project that has an SCC Version Control
configuration created in Enterprise Architect earlier
than version 4.5.
The 'Select or Create Unique ID for Version Control'
dialog automatically displays.

2 On the dialog, either create an ID for an existing
configuration or choose a previously created one
from the 'Unique ID' drop-down list.

3 The existing SCC configuration is the initial value,
represented by SCC-XXXXX; this number is not
especially meaningful, therefore it is recommended
that the configuration be given a meaningful name.

4 You can associate the Version Controlled Package
with a previously-defined configuration by selecting
an existing configuration from the 'Unique ID'
drop-down list (if one exists).

5 After you have assigned the unique ID, click on the
OK button to load the model.
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Version Control Configuration

Once you or an Administrator have installed and configured
the Version Control product software, to start using Version
Control you must first define a Version Control
configuration within your project in Enterprise Architect, to
be used to control the Packages in the project. You can
define any number of Version Control configurations in a
single model, but any given Package is associated with only
one configuration.

Access

Ribbon Settings > Version Control > Project-VC

Context
Menu

Right-click on Package > Package
Control > Version Control Settings

Define Version Control Configuration

Ste
p

Action
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1 On the 'Version Control Settings' dialog, click on the
New button.

2 In the 'Unique ID' field, type a suitable configuration
name.

3 Select the Type of Version Control product you are
connecting to, by clicking on the corresponding
radio button.

4 At this point, the middle section of the dialog
changes to display a collection of fields specific to
the type of Version Control configuration you are
defining.
Enter details relating to the Version Control
workspace that this configuration is to use.

5 Click on the Save button. The new configuration is
added to the Defined Configurations list.

6 If you want to create another Version Control
configuration, return to step 1.
When you have finished defining your Version
Control configurations, click on the Close button.

Notes
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Version Control Configuration details are stored in the·

user's Windows Registry settings, but each project stores a
list of the configurations it uses, so that Version Control
connections can be initialized as the project is being
loaded

If you are using the Corporate or extended editions of·

Enterprise Architect with security enabled, the
administrator must also set up access permissions to
configure and use Version Control
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Version Control Settings

Defining Version Control settings within Enterprise
Architect should only be performed after you have
successfully created the Version Control environment that
you intend to use to control your Package files. If you have
not yet done so, please refer to the Help topic Applying
Version Control in a Team Environment for a summary of
what is required.

To set up a Version Control configuration on your model, or
update an existing Version Control configuration, you
define a number of settings that control how the status of
your model is communicated to your Version Control
system. You define these settings using the 'Version Control
Settings' dialog.

Access

Ribbon Settings > Version Control > Project-VC

Context
Menu

Right-click on Package > Package
Control > Version Control Settings

Configuration Options
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Option Action

This model is
private

Select to specify that this model database
is to be accessed by just a single user
(Private Model).
Leave unselected (the default) or deselect
to specify that the database is to be
accessed by multiple concurrent users
(Shared Model).
If in doubt, use the default setting.

Save nested
Version
Controlled
Packages to
stubs only

Select to specify that the exported XMI
file for a Version Controlled Package will
contain Package stubs (place holders) for
nested Version Controlled child Packages
(recommended).
Deselect to specify that the exported XMI
file will contain the full content of nested
Version Controlled child Packages.

For all
Packages,
create
placeholders
for external
references

Select to force all XMI 1.1 imports across
the model to exclude incoming
relationships and instead create external
references.
If the 'Create placeholders for missing
External References during XMI 1.1/2.1
and Native File Import' checkbox is not
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selected in the XML Specifications
options for a user, this field overrides that
setting.
The XML Specifications Help topic
provides an example of the benefits of
selecting this option.

Unique ID Specify a name that uniquely identifies
the configuration. Either:

Type a name to identify a new·

configuration, or
Click on the drop-down arrow and·

select the name of a configuration
previously defined in a different project
(if any exist)

Type Click on the appropriate radio button for
the type of Version Control system you
are associating with this configuration.
The middle section of the dialog changes
to display a collection of fields relating to
the type of Version Control configuration
you are defining.
Set the type to SCC for:

MS Visual Source Safe·

Rational Clear Case·

Perforce·

AccuRev·
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Any other SCC-compatible clients·

For any other product that you are using,
select the type that matches the product -
CVS, Subversion or TFS.

New Click on this button to clear the fields and
create a new Version Control
configuration.

Save Click on this button to save the details of
a new or updated configuration.

Delete Click on an entry in the Defined
Configurations list and click this button
to remove the definition of the selected
configuration from this model.

Defined
Configuratio
ns

Review a list of configurations that are in
use in the current model.

In future, do
not prompt
for
incomplete
configuration
s

Select to specify that the user is not
prompted to complete the definition of
configurations that are not fully specified
(the default).
Deselect to prompt the user to complete
configurations that are not fully defined.

Close Close the 'Version Control Settings'
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dialog.

Help Display this Help topic.

Notes

It is important that, for any given Version Controlled·

Package file, any user accessing that file from any model
uses Version Control configurations having the same
Unique ID

When you first open a model that was created by another·

user and that uses Version Control, the Version Control
configuration(s) used by that model do not yet exist in
your Windows registry settings; you have to complete the
definitions of those configurations before you can use
Version Control in that project

If User Security is enabled, you must have 'Configure·

Version Control' permission to set up Version Control
options for the current model

It is possible to use multiple Version Control·

configurations in the same model
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SCC Settings

When you are setting up your Version Control
configurations on the 'Version Control Settings' dialog, and
you set the configuration type to 'SCC', the dialog presents a
set of fields specific to SCC-based configurations. You can
then define details such as:

The working copy folder to be used with the configuration·

The details necessary to connect to the SCC Version·

Control system

You set the Version Control configuration type to SCC for
version Control providers such as:

MS Visual Source Safe·

Rational Clear Case·

Perforce·

AccuRev·

Any other SCC-compatible clients·

Access

Ribbon Settings > Version Control > Project-VC
: Type: SCC

Context
Menu

Right-click on Package > Package
Control > Version Control Settings:
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Type: SCC

Settings

Option Action

Local Project
Path

Displays the full path of the folder that
contains the local (working) copies of the
XMI Package files.
This field is read-only; its value can only
be set through use of the Select Path
button.

Select Path Click on this button to choose the Local
Project Path, by opening a file browser
dialog and navigating through the file
system to the appropriate folder.

After you choose the appropriate folder·

path, the 'Select SCC Provider' dialog
displays, listing all SCC providers that
are installed on the current workstation;
choose the SCC provider to use and
click on the OK button
At this point, the SCC client opens its·

own dialog to prompt you for
information; SCC products implement
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this functionality in varied ways, but
typically you are prompted to log in to
the Version Control system, then
prompted to choose the SCC project to
use and possibly a (server) folder
contained within that project
At the conclusion of this process, all of·

the SCC details should be filled in; you
can then save the definition by clicking
on the Save button on the 'Version
Control Settings' dialog

Current User Displays the user name used to log on to
the Version Control system that is
accessed through this configuration.
This field is read-only; the value it
displays is retrieved from the SCC client.

SCC
Provider

Displays the name of the SCC provider.
This field is read-only; the value it
displays is retrieved from the SCC client.

SCC Project Displays the name of the SCC Project
that this configuration attaches to.
This field is read-only; the value it
displays is retrieved from the SCC client.
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Notes

You define the SCC-specific details as part of the broader·

process of setting up a Version Control Configuration on
the 'Version Control Settings' dialog
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CVS Settings

When you are setting up your Version Control
configurations on the 'Version Control Settings' dialog, and
you set the configuration type to CVS, the dialog presents a
set of fields specific to CVS-based configurations. You can
then define details such as:

The working copy folder to be used with the configuration·

The path to the CVS command line client·

Access

Ribbon Settings > Version Control > Project-VC
: Type: CVS

Context
Menu

Right-click on Package > Package
Control > Version Control Settings:
Type: CVS

Settings

Option Action
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Working
Copy Path

Displays the full path of the folder that
contains the local (working) copies of the
XMI Package files.
This field is read-only; its value can only
be set through use of the Select Path
button.

Select Path Click on this button to choose the
working copy path, by opening a file
browser dialog and navigating through
the file system to the appropriate folder.

Current User This field is read-only; its value is
retrieved from a file named CVS\Root,
located in the folder selected using the
Select Path button.

CVS Exe
Path

Displays the full path of the CVS
command line client executable file.
This field is read-only; its value can only
be set through use of the Select Path
button.

Select Path Click on this button to specify the path to
the CVS command line client, by opening
a file browser dialog and navigating
through the file system to locate the
appropriate file.
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VC
Time-Out
Value

Specify the amount of time that
Enterprise Architect waits for a CVS
command to complete; if the command
does not complete within the allowed
time, the system displays a Time-out
error message, detailing the command
that failed to complete.
This single time-out value is applied to
all Version Control Configurations (of
types SVN, TFS and CVS) that the user
accesses from this workstation.

Notes

When connecting to a remote CVS repository, the·

'Current User' field should display the user name used to
log into that repository; if this does not happen, it
indicates that Enterprise Architect cannot extract the user
name from the file ...\WorkingCopyPath\CVS\Root and
the configuration does not work correctly

You define the CVS-specific details as part of the broader·

process of setting up a Version Control configuration on
the 'Version Control Settings' dialog
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SVN Settings

When you are setting up your Version Control
configurations on the 'Version Control Settings' dialog, and
you set the configuration type to 'Subversion', the dialog
presents a set of fields specific to Subversion-based
configurations. You can then define details such as:

The working copy folder to be used with the configuration·

The path to the Subversion command line client·

Access

Ribbon Settings > Version Control > Project-VC
: Type: Subversion

Context
Menu

Right-click on Package > Package
Control > Version Control Settings:
Type: Subversion

Settings

Option Action
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Working
Copy Path

Displays the full path of the folder that
contains the local (working) copies of the
XMI Package files.
This field is read-only; its value can only
be set through use of the Select Path
button.

Select Path Click on this button to choose the
Working Copy Path, by opening a file
browser dialog and navigating through
the file system to the appropriate folder.

Subversion
Exe Path

Displays the full path of the Subversion
command line client executable file.
This field is read-only; its value can only
be set through use of the associated
Select Path button.

Select Path Click on this button to specify the path to
the Subversion command line client, by
opening a file browser dialog and
navigating through the file system to
locate the appropriate file.

VC
Time-Out
Value

Specify the amount of time that
Enterprise Architect should wait for a
Subversion command to complete; if the
command does not complete within the
allowed time, the system displays a
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Time-out error message, detailing the
command that failed to complete.
This single time-out value is applied to
all Version Control Configurations (of
types SVN, TFS and CVS) that the user
accesses from this workstation.

Notes

You define the Subversion-specific details as part of the·

broader process of setting up a Version Control
configuration on the 'Version Control Settings' dialog
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TFS Settings

When you are setting up your Version Control
configurations on the 'Version Control Settings' dialog, and
you set the configuration type to 'TFS', the dialog presents a
set of fields specific to TFS-based configurations. You can
then define details such as:

The working copy folder to be used with the configuration·

The user name and password to log in to the TFS server·

The path to the TFS command line client·

Access

Ribbon Settings > Version Control > Project-VC:
Type: TFS

Context
Menu

Right-click on Package > Package
Control > Version Control Settings:
Type: TFS

Settings

Option Action
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Working
Copy Path

Displays the full path of the folder that
contains the local (working) copies of the
XMI Package files.
This field is read-only; its value can only
be set through use of the associated
Select Path button.

Select Path Click on this button to choose the
Working Copy Path. The file browser
dialog opens, through which you navigate
through the file system to the appropriate
folder.

Server Name Displays the name of the TFS Server that
is associated with the working copy
folder specified in the 'Working Copy
Path' field.
This field is read-only; Enterprise
Architect retrieves the value it displays
by querying the TFS client.

Workspace
Name

Displays the name of the TFS Workspace
that is associated with the working copy
folder specified in the 'Working Copy
Path' field.
This field is read-only; Enterprise
Architect retrieves the value it displays
by querying the TFS client.
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User Name Type in the user name with which to log
into the TFS Server.

Password Type in the password with which to log
into the TFS Server.

Display
Name

TFS 2013 and later releases use a Display
Name to report on who owns a checkout
lock on a file. TFS 2010 uses AccountID
when reporting lock owners and so does
not require a Display Name.
If using TFS 2013, type in your TFS
Display Name as shown in the User
column of the Visual Studio Source
Control Explorer when you checkout a
file.

Checkout
Locks
Required

This checkbox defaults to selected.
TFS 2013 supports the use of Local
workspaces, but these do not support
checkout locks. If you want to use TFS
Local workspaces (not recommended),
you must deselect this checkbox.
Otherwise, leave the checkbox selected.
It is recommended that all workspaces
used for Version Controlling Enterprise
Architect Package files are set as 'Server'
workspaces.
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TFS Exe Path Displays the full path of the TFS
command line client executable file.
This field is read-only; its value can only
be set through use of the associated
Select Path button.

Select Path Click on this button to specify the path to
the TFS command line client.
The file browser dialog opens, through
which you navigate through the file
system to the appropriate folder.

VC
Time-Out
Value

Type in the number of seconds that
Enterprise Architect should wait for a
TFS command to complete; if a
command does not complete within this
allowed time, the system displays a
Time-out error message, detailing the
command that failed to complete.
This single time-out value is applied to
all Version Control configurations (of
types SVN, TFS and CVS) that the user
accesses from this workstation.

Notes
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If you automatically log in to TFS through a path external·

to Enterprise Architect (for example, through MS
Integrated Security), you can leave the 'User Name' and
'Password' fields blank

If the 'Password' field is blank, Enterprise Architect·

retrieves your Windows username and uses that value
when determining whether a Package file is checked out
to you or to another user

TFS Version Control can also be accessed using the TFS·

MSSCCI client; to make use of the TFS MSSCCI client,
please define an SCC based Version Control
configuration

You define the TFS-specific details as part of the broader·

process of setting up a Version Control configuration on
the 'Version Control Settings' dialog
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Re-use an Existing Configuration

Once a Version Control configuration has been defined for
use in one project, it is possible to re-use that configuration
in other projects to provide access to:

An already existing Version Control environment (a·

working copy directory and its associated repository that
is already in use)

Version Controlled Packages that were created (and·

Version Controlled) in another project

Access

Ribbon Settings > Version Control > Project-VC

Context
Menu

Browser window | right-click on Package
| Package Control | Version Control
Settings

Select existing configuration

Ste
p

Action
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1 On the 'Version Control Settings' dialog, click on the
New button.
The various fields on the dialog are cleared, ready
for data entry.

2 In the 'Unique ID' field, click on the drop-down
arrow and select one of the previously-defined
Version Control configurations.
The details of the selected configuration are
displayed in the dialog.

3 Click on the Save button.
The configuration details are saved and are ready for
use in the current project.
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Applying to Packages

Version Control in Enterprise Architect operates at a
Package level. Any Package in the repository can be put
under Version Control and assigned to any Version Control
Configuration. This means that different Packages can be
controlled by different Version Control systems.

The Package Control Options window showing the setting
for the selected Package.
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Configure Controlled Package

Once your Version Control application is set up and you
have Version Control configurations in place, you can place
the individual Packages in your model under Version
Control. To put a Package under Version Control, you:

Flag the Package as a controlled Package·

Specify the Version Control configuration to control it·

and

Associate an XMI file with the Package·

You can then export and import the Package data to and
from the file and issue commands to the Version Control
system.

Access

Ribbon Settings > Version Control >
Package-VC

Keyboard
Shortcuts

Ctrl+Alt+P

Apply Version Control to a single Package
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Ste
p

Action

1 Click on the 'Control Package' checkbox to select it,
indicating that this Package is to be controlled.

2 Click on the 'Version Control' drop-down arrow and
select the Version Control configuration to be used
to control this Package.

3 The 'XMI Filename' field displays a default filename
for the Package export file, based on the Package
name.
Optionally, modify the filename. Either:

Type a new name, or·

Click on the  button to open a file selection·

dialog
The target file must be located within the working
copy folder of the selected Version Control
configuration, or one of its sub-folders.

4 The 'Version ID' field defaults to '1.0'.
Optionally, change this to a different version
number.

5 The 'Owner' field defaults to your user name.
Optionally, type or select the name of the user who
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actually owns the Package.

6 Click on the OK button.
The 'Add Package to Version Control' dialog
displays.

7 Optionally, clear the 'Keep checked out' checkbox.
After applying Version Control, the Package either
remains checked-out for editing, or is checked-in and
locked against editing, depending on this setting.

8 Click on the OK button.
The 'Add Comment' dialog displays.

9 Optionally, add any further comments to the default
comment.
Enterprise Architect provides a default comment that
includes the current date & time.

10 Click on the OK button.
The current Package is exported to the nominated
XMI file, which is then committed to Version
Control. The Package icon in the Browser window is
updated to reflect the Package's Version Control
status.
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Notes

If you are using the Corporate or extended editions of·

Enterprise Architect with security enabled, these features
are only available to users who have been granted
permission to configure and use Version Control
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Browser Window Indicators

Packages under Version Control are identified in the
Browser window by icons that indicate the current status of
the Package.

Indicators

Icon Indicates that

This Package is Version Controlled and
not checked out to you.
You cannot edit the Package (until you
check out the Package yourself).

This Package is Version Controlled and
checked out to you.
You can edit the Package.

This Package is Version Controlled, but
you checked it out whilst not connected
to the Version Control server.
You can edit the Package but there could
be version conflicts when you check the
Package in again.

This Package is controlled and is
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represented by an XMI file in the file
management system, but it is not under
Version Control.
You can edit this Package.
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Apply Version Control To Branches

It is possible to apply Version Control to all Packages within
a selected model branch, in a single operation. In this
context, a model branch is a Package that is currently
selected in the Browser window, and all of the Packages
contained within it.

Access

Context
Menu

Browser window | right-click on Package
| Package Control | Add Branch to
Version Control

Apply Version Control to all Packages within
a selected model branch

Ste
p

Action

1 On the 'Apply VC to Branch' dialog, click on the
drop-down arrow in the 'Version Control
Configuration' field and select the configuration to
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use.

2 Optionally, tick the checkbox 'Export as Model
Branch'.
Once the Version Control operation is complete a
Model Branch file (.EAB file) is created for this
branch.

3 Click on the OK button.
The system creates a number of sub-folders within
the Version Control working copy folder, then
exports all of the Packages within the selected model
branch. The system generates filenames for the XMI
files, based on the Package GUIDs.

Notes

The Version Control configuration to be used in this·

operation must be defined within the model before
selecting this command

When invoked on the model root node, this command·

applies Version Control to every Package within the
model
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Fundamental Usage

Once your Version Control product is installed and you
have created a suitable environment, Enterprise Architect
can make use of that environment to control the Packages in
your project. The fundamental Version Control functions are
outlined in this table.

Fundamental Functions

Facility Detail

Define
Version
Control
Settings

Version Control Configurations are used
by Enterprise Architect to communicate
with your Version Control system.
You define one or more Version Control
configurations in your project and then
use those configurations to control the
Packages in your project.

Configure a
Package

To put a Package under Version Control
you mark the Package as a controlled
Package, specify the Version Control
configuration to control it, and associate
an XMI file with the Package.

Check Out a Checks out the Version Controlled
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Package Package currently selected in the Browser
window, so that you can update modeling
objects within it.

Undo Check
Out of a
Package

Reverses the check-out of a Package,
discarding any modifications that have
been made by restoring the Package
content to the latest revision held in
Version Control.

Check In a
Package

Checks in the Package currently selected
in the Browser window.
Checking-in updates the reference
version of a Package or group of
Packages in the model.

Check In a
Model
Branch

Checks in all Packages involved in a
particular unit of work, as a single
operation.
Checking-in updates the reference
version of a Package or group of
Packages in the model.

Check Out a
Model
Branch

Checks out all Packages within a selected
model branch as a single operation, so
that you can update modeling objects
within them.

Import a Retrieves Packages from Version Control
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Package
From
Version
Control

that have been created by other users, or
by you in another model, and imports
them into your current model.

Apply
Version
Control to a
Model
Branch

Applies Version Control to all Packages
within the selected model branch, in a
single operation.
In this context, a model branch is a
Package in the Browser window, and all
of the Packages contained within it.

View
Package
Revision
History

Displays the change history of Version
Controlled Packages.
You can also check out a prior revision of
the Package for editing, effectively
rolling-back to a prior revision of the
Package.
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Package Version Control Options

When you have set up a Package for Version Control, you
gain access to a range of Version Control operations that can
be performed on that Package, such as:

Open the dialog for working with baselines of the·

Package

Check-in and check-out single Packages or a selected·

hierarchy of Packages

Update Packages to the latest revision from the Version·

Control repository

Inspect the revision history or properties of the XMI file·

associated with a Package

Revert a Package to a previous revision·

Compare the current model content of a Package, against·

the latest revision of the Package in Version Control

Import and export hierarchies of Packages (model·

branches) to and from the model, through the Version
Control system

Synchronize the status of a Package, with the Version·

Control system

Access

Context Right-click on Version Controlled

(c) Sparx Systems 2022 Page 1912 of 1974



Modeling Fundamentals 3 October, 2022

Menu Package > Package Control

Options

Option Action

Check In
Branch

Check-in Packages contained in the
currently selected model branch (that is,
the selected Package and all of its child
Packages).
The 'Select Packages to Check In' dialog
lists all Version Controlled Packages
within that branch that are checked out to
you; you can then select Packages in the
displayed list, to be submitted for
check-in.
You can also choose to keep the
Packages checked-out after committing a
new revision to Version Control.

Check Out
Branch

Recursively check out all Packages
contained within the currently selected
model branch (that is, the selected
Package and all of its child Packages)
that are Version Controlled and
checked-in.
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Check In Commit a new revision of the currently
selected Package to the Version Control
repository and lock the Package against
further editing.
Only available for Packages that you
have checked-out yourself.

Check Out Synchronize the currently selected
Package with the latest revision from the
Version Control repository and unlock
the Package to allow editing.
Only available for Packages that are not
already checked-out (and whose
associated Package file is not
checked-out).

Undo Check
Out

Restore the selected Package to the latest
revision in the Version Control repository
and lock the Package against further
editing.

Put Latest Commit a new revision of the currently
selected Package to the Version Control
system, while keeping the Package
checked-out.
This is equivalent to checking a Package
in and immediately checking it back out
again.
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Only available for Packages that you
have checked-out yourself.

Get Latest Synchronize the currently selected
Package with the latest revision from the
Version Control repository.
Available only for Packages that are
checked in.

Get All
Latest

Updates all of the Version Controlled
Packages in the project, to the latest
revision retrieved from Version Control.
Only updates Packages that are currently
checked in.
Once the latest revisions are retrieved, the
system scans all the controlled Packages
and fixes any missing cross-references by
comparing the Package with its XMI 1.1
file.
If the cross-reference information in the
XMI does not match the model, the
system updates the model with the
information from the XMI and records
this update in the System Output window.
You can roll back such updates by
selecting the entry in the System Output
window and using the context menu
option 'Rollback Update' (or 'Rollback
Selected Updates' if multiple entries are
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selected).
Closing the model clears the entries in·

the System Output window
An entry in the System Output window·

is also cleared as and when you
roll-back the update for it

Scan XMI
and
Reconcile
Model

Scan the Package XMI files associated
with each of the project's controlled
Packages and restore any diagram objects
or cross-references that are detected as
missing from the project.
This function is useful in team
environments where each user maintains
their own private copy of the model
database (that is, multiple private project
files) and model updates are propagated
through the use of controlled Packages. It
provides no benefit when the model is
hosted in a single shared database that is
accessed by all team members.
Each controlled Package is compared
with its associated XMI file and, if the
cross-reference information in the model
does not match the XMI, the system
updates the model with the information
from the XMI and records the update in
the System Output window.
You can roll back such updates by
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right-clicking on the entry in the System
Output window and selecting the
'Rollback Update' option (or 'Rollback
Selected Updates' if multiple entries are
selected).
Closing the model clears the entries in the
System Output window; an entry in the
window is also cleared as and when you
roll-back the update for it.
This functionality is invoked
automatically as part of the 'Get All
Latest' operation.
When working in an environment that
uses a Private Model deployment and
your model contains a significant number
of cross-Package references, it is
recommended that you invoke 'Scan XMI
and Reconcile Model' from time to time,
following the re-importation of controlled
Packages - for example, after using 'Get
Latest' to update a number of Packages -
or after performing a number of Package
check-outs.
As a general rule, avoid running 'Scan
XMI and Reconcile Model' while you
have uncommitted changes in your
model; generally, you:

Check-out a number of Packages·

Invoke 'Scan XMI and Reconcile·
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Model'
Make your modifications·

Commit any outstanding changes·

before you check-out more Packages
and run 'Scan XMI and Reconcile
Model' again

File
Properties

Display Version Control properties
pertaining to the XMI export file
associated with the currently selected
Package; this also identifies who has
checked out the Package.

File History Display change history information for
the currently selected Package.
Revert to or check-out a prior revision of
the Package.

Compare
with
Controlled
Version

Compare the currently selected Package
with the latest revision of its associated
XMI file retrieved from Version Control.

Add Branch
to Version
Control

Apply Version Control to all Packages
within a selected model branch, in a
single operation.
In this context, a model branch is a
Package that is currently selected in the
Browser window, and all of the Packages
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contained within it.

Export as
Model
Branch

Export a newly created model branch
from your own private copy of a model.

Import a
Model
Branch

Retrieve a model branch and import it
into either the source model or another
model.

Get Package Access Packages in the Version Control
repository that are not currently available
in your model.

Re-synch
Status With
VC Provider

Update the Version Control status value
recorded for the selected Package in the
project to match the value reported by the
Version Control provider, without
performing an XMI import or export.
Use this function when the Package's
Version Control status recorded in your
project is out of synchrony with the
Version Control status reported by your
Version Control provider.

Version
Control
Settings

Display the 'Version Control Settings'
dialog.

(c) Sparx Systems 2022 Page 1919 of 1974



Modeling Fundamentals 3 October, 2022

Notes

You set up Version Control using options from the project·

'Version Control' submenu

If the selected Package is not under Version Control, a·

different set of options is available

If a Version Control configuration has not been defined·

for the model, no options for using Version Control are
available, only the options for configuring Version
Control
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Check Out a Package

When you need to work on a Version Controlled Package,
you check it out. The local XMI file associated with the
Package is then checked-out from Version Control. No other
user can check out the Package to make changes to it until it
has been checked in again.

Access

Context
Menu

Right-click on Package > Package
Control > Check Out

Keyboard
Shortcuts

Ctrl+Alt+L

Check out a single Package

The Package file is imported into your model, and the
'Package' icon is updated to reflect the change in the
Package's Version Control status.

When working in a Private Model, if the system detects that
the Package content in the model is already up to date with
the latest revision of the Package file retrieved from Version
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Control, then the 'Import Package' dialog displays first. This
dialog is not displayed for a Shared Model.

These options are available:

Force Reload From XMI - reload the Package from XMI·

regardless of whether it is up to date or not

Accept current Package - select to skip the process of·

re-importing the Package from XMI

Refresh model view - select to refresh the Browser·

window and diagrams, by reloading the Package content
from the project database

Always use these settings - when selected, if you·

subsequently check out a Package that is found to be up to
date, the same settings are applied again without
displaying the dialog

Notes

If you check out a Version Controlled Package whilst·

offline, the 'Package' icon has a red figure 8 in front of it

If you have selected the 'Always use these settings'·

checkbox and you want to reconfigure the 'Import
Package' dialog, press the Ctrl key whilst you select the
'Package Control | Check Out' context menu option; the
dialog displays and you can change the settings
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Undo Check Out of a Package

If you check out a Package and then decide not to proceed,
you can undo the check-out and discard any modifications
that have been made, by restoring the Package content to the
latest revision held in Version Control. The Package returns
to a checked-in state and subsequently can be checked out
by any user, including yourself if, for example, you need to
reverse incorrect changes before checking the Package out
and starting again.

Access

Context
Menu

Right-click on Package > Package
Control > Undo Check Out

Undo check out of a selected Package

A confirmation dialog displays; click on the OK button.

The latest revision of the Package is retrieved from Version
Control and re-imported into your model. The icon against
the Package in the Browser window is updated to reflect the
change in the Package's Version Control status.
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Check In a Package

When you have finished working on the contents of a
Package under Version Control, and you want to return it to
the model for other users to see, you check it in.

Access

Context
Menu

Right-click on Package > Package
Control > Check In

Keyboard
Shortcuts

Ctrl+Alt+S

Check in a single Package

Ste
p

Action

1 The selected Package is exported and the 'Add
Comment' dialog displays. A default comment is
provided that contains the current date and time.
Optionally, modify the default check-in comment
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2 Click OK.
The Package file is checked-in to Version Control
and the Package icon is updated to reflect the change
in Version Control status.
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Check Out a Model Branch

If you need to check out a number of related Packages
involved in a particular unit of work, to update the contents,
you can do so in a single operation by checking out the
whole model branch that contains them.

Access

Context
Menu

Right-click on Package > Package
Control > Check Out Branch

Check out a sub-tree of model Packages

Ste
p

Action

1 The selected root-node Package and all of its
contained sub-Packages are recursively checked out.
Any Packages that cannot be checked-out are listed
in a message box, with a brief description of the
problem; for example: The Package is already
checked out by user 'Fred'.
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2 When Project Security is enabled in Lock to Edit
mode, Enterprise Architect prompts you to apply a
User Lock throughout the selected model branch
before proceeding.

(c) Sparx Systems 2022 Page 1928 of 1974



Modeling Fundamentals 3 October, 2022

Check In a Model Branch

If you need to check in a number of related Packages
involved in a particular unit of work, and that you have
updated, you can do so in a single operation by checking in
the whole model branch that contains them. You can also
commit new revisions of the affected Packages as you
complete milestones, whilst keeping the Packages
checked-out for further editing.

Access

Context
Menu

Right-click on Package > Package
Control > Check In Branch

Check in Packages from within a model
branch

Ste
p

Action

1 The 'Select Packages to Check-in' dialog lists all
Version Controlled and checked-out Packages within
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the selected model branch. By default, the entire list
is selected.
Optionally:

Click an individual Package to select just that·

Package
Ctrl+click on an individual Package to add or·

remove it from the selection
Shift+click on a range of Packages to select them·

Click on the All button to select all listed Packages·

Click on the None button to clear the selection·

2 Optionally, you can commit into Version Control a
new revision of all selected Packages, while keeping
those Packages checked out for further editing. To
do this, select the 'Keep packages checked-out after
committing new revision' checkbox.

3 Click on the OK button.
The 'Add Comment' dialog displays. A default
comment is provided that contains the current date
and time. This comment is applied to all Packages
that are checked in.

4 Optionally, modify the default check-in comment.

5 Click on the OK button.
The selected Packages are exported and checked-in.
The Package icons are updated to reflect any change
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in Version Control status. If you opted to keep
Packages checked out, there is no change in status.
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Update to the Latest Revision of
Selected Package

When you are part of a team working in a Distributed Model
environment, you will want to periodically update your
model with the changes that other team members have
committed into Version Control. You can transfer the other
users' updates from Version Control into the selected
Package in the Browser window.

Access

Context
Menu

Right-click on Package > Package
Control > Get Latest

Update Package to latest revision

The local XMI file associated with the Package is updated to
the latest revision from Version Control. The XMI file is
imported into your model database, updating the Package in
your model.

When working in a Private Model, if the system detects that
the Package content in the model is already up to date with
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the latest revision of the Package file retrieved from Version
Control, then the 'Import Package' dialog displays first. This
dialog is not displayed for a Shared Model.

These options are available:

'Force Reload From XMI' - reload the Package from XMI·

regardless of whether it is up to date or not

'Accept current Package' - select to skip the process of·

re-importing the Package from XMI

'Refresh model view' - select to refresh the Browser·

window and diagrams, by reloading the Package content
from the project database

'Always use these settings' - when selected, if you·

subsequently check out a Package that is found to be up to
date, the same settings are applied again without
displaying the dialog

Notes

The 'Get Latest' command is disabled for any Package that·

is checked-out (to anybody) in the currently loaded
project

When using a Shared Model environment, where all users·

are connected to a single model database, you should
reload the Package from the database, rather than using
the 'Get Latest' command

If you have selected the 'Always use these settings'·

checkbox and you want to reconfigure the 'Import
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Package' dialog, press the Ctrl key whilst you select the
'Package Control | Get Latest' context menu option; the
dialog displays and you can change the settings
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Update to the Latest Revision of All
Packages

When you are part of a team working in a Distributed Model
environment, you will want to periodically update your
model with the changes that other team members have
committed into Version Control. You can transfer the other
users' updates to all Version Controlled Packages into the
currently loaded project.

Access

Context
Menu

Right-click on Package > Package
Control > Get All Latest

Update all Packages in project to latest
revision retrieved from Version Control

All the local XMI files for all the Version Control
configurations used in the project are updated to the latest
revision from Version Control. The system then scans the
Packages in the model, to determine which ones are up to
date and which are not, compared to the latest revisions of
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the associated Package files.

A prompt displays, providing these import options for
Packages that are up to date:

Import changed files only·

Always import·

Prompt for each file·

Click on the OK button. The Version Controlled Packages
in your project are updated according to the option you
selected; if you chose the 'Prompt for each file' option, a
prompt displays to confirm import of each file.

Notes

There is no need to re-import Packages that are already up·

to date - re-importing Packages first deletes them from the
project and then re-imports them from the XMI file,
which is time consuming as well as unnecessary; we
strongly recommend using the default option 'Import
changed files only'

The 'Get All Latest' command does not update any·

Package that is checked-out (to anybody) in the currently
loaded project; otherwise, any changes not yet committed
to Version Control would be discarded

When using a Shared Model environment, where all users·

are connected to a single model database, the information
in the model database is always the same as, or ahead of,
what is committed into Version Control; in this situation,
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the Get All Latest command will simply refresh your view
of the model database, by reloading diagrams or reloading
Package content in the Browser window
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Review Package History

It is possible to review the change history of Version
Controlled Packages by examining previous revisions. If
necessary, you can check out one of these earlier revisions
of a Package for editing, effectively rolling-back to that
prior revision of the Package.

Access

Context
Menu

Right-click on Package > Package
Control > File History

Review change history of a
version-controlled Package

Ste
p

Action

1 For Version Control environments using Subversion,
CVS or TFS command line clients, the 'File Version
History' dialog displays.
Click on a revision number in the 'Revisions' field, to
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select that revision and view its log entry.
For Version Control environments using SCC based
clients, your particular product opens its own 'File
Version History' dialog.

2 On the 'File Version History' dialog, you can
optionally click on either:

Check Out - the selected revision of the Package·

file is retrieved from Version Control and
imported into your model as a Package that is
checked out for editing; you can subsequently
check in this revision as a new HEAD revision,
effectively allowing you to revert the Package to a
prior revision
or
Retrieve - the selected revision of the Package file·

is retrieved from Version Control and imported
into your model, but the Package remains flagged
as checked-in and cannot be modified;
subsequently checking out the Package updates it
to the latest revision before it is unlocked for
editing

Notes

If the selected Package was already checked out in the·
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current model, the Retrieve and Check Out buttons are
disabled

If the selected Package contains any sub-Package that is·

already checked-out in the current model, a warning will
be displayed and the retrieval or check-out will not go
ahead

If you check out a prior revision of a Package, but do not·

want to commit it as a new revision, right-click on the
Package and select Package Control | Undo Check Out
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Review Package History - SCC Client

It is possible to review the change history of Version
Controlled Packages by examining previous revisions. If
necessary, you can check out one of these earlier revisions
of a Package for editing, effectively rolling-back to that
prior revision of the Package. The process for reviewing the
change history of Packages configured for Version Control
with an SCC client (including products such as Visual
Source Safe, TFS-SCC, ClearCase, Perforce, AccuRev and
MKS Source Integrity) differs from that for Subversion,
CVS or TFS command line clients.

Access

Context
Menu

Right-click on Package > Package
Control > File History

Review change history of a
version-controlled Package (SCC client)

Ste
p

Action
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1 The change history mechanism offered by the third
party SCC provider displays.
To import a prior revision of the Package into your
model, use the 'SCC History' dialog to retrieve the
revision, then close the dialog.

2 The SCC client notifies Enterprise Architect that a
different revision has been retrieved. A prompt then
displays, asking whether you want to check-out the
prior revision.

3 Optionally, click on either:
Yes, to check out the prior revision - the selected·

revision of the Package file is retrieved from
Version Control and imported into your model as a
Package that is checked out for editing; you can
subsequently check in this revision as a new
HEAD revision, effectively reverting the Package
to the prior revision
OR
No, to import the prior revision as read-only - the·

selected revision of the Package file is retrieved
from Version Control and imported into your
model, but the Package remains flagged as
checked-in and cannot be modified; subsequently
checking out the Package updates it to the latest
revision before it is unlocked for editing
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Notes

If the selected Package was already checked out in the·

current model, the system does not proceed with
retrieving a prior revision

If you check out a prior revision of the Package, but do·

not want to commit it as a new revision, right-click on the
Package and select 'Package Control | Undo Check Out'
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Retrieve Prior Revision - SCC Client

Depending on your Version Control product, retrieving a
prior revision of a controlled Package can involve a number
of prompts regarding overwriting the current local copy.

This example details retrieval of a prior revision from a
TFS-SCC Version Control configuration.

Access

Context
Menu

Right-click on Package > Package
Control > File History

Example Procedure - retrieve prior revision,
TFS-SCC client

Ste
p

Action

1 Display the 'TFS File History' dialog.

2 Click on the Get button.
The TFS-SCC client displays the 'Resolve Conflicts'
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dialog.
This dialog offers the 'Automerge All XML Package
files' option. DO NOT select this option.
It is important to prevent any merging of Enterprise
Architect's XML Package files.

3 Click on the Resolve button.
The TFS-SCC client displays the 'Resolve writeable
file conflict' dialog.

4 Select the 'Overwrite local file/folder' option.
The existing working copy of the Package file is
overwritten by the prior revision retrieved from
Version Control.

5 Click the OK button.
The TFS-SCC client redisplays the 'Resolve
writeable file conflict' dialog; it should now show no
conflicts.

6 Click on the Close button.
The TFS-SCC client redisplays the 'File History'
dialog.

7 Click on the Close button.
Enterprise Architect displays a prompt, asking
whether to check-out the prior revision.
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8 Click on the:
Yes button to check-out the prior revision·

No button to retrieve a read-only version of the·

Package, that is NOT checked-out and is NOT
editable
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Advanced Usage

Once you get familiar with using the fundamental functions
of Version Control there are a number of more advanced
functions that you might want to use in working with your
models. The advanced Version Control functions are
outlined in this table.

Advanced Functions

Export a
Version
Controlled
Model
Branch

Exports Version Control information
about the root Package of a model
Branch, that is used to simplify the
process of exporting and importing a
hierarchy of Packages from one model to
another.

Include Other
Users'
Packages

Other users might be developing
Packages in their own models that you
could use in your model, or you might
have other models containing Packages
that you want to use in the current model.

Import a
Model

Uses Enterprise Architect's Model Branch
files, of which there are few, to retrieve
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Branch From
Version
Control

information about the root Package file
and to import the model branch.
Model branch files can simplify the
process of exporting and importing a
hierarchy of Packages from one model to
another.

Add
Connectors
To Locked
Elements

Generally, when working in a diagram
containing locked elements, you cannot
add a connector to a locked element.
There are scenarios in which a connector
can be created on a locked element
depending on the locking status of the
parent Packages.

Validate
Package
Configuratio
ns

You can test the validity of the Version
Control settings associated with each
Version Controlled Package within your
current model.

Resynchroniz
e the Status
of Version
Controlled
Packages

Re-synchronizes the Version Control
status of Packages within your project
with the status reported by your Version
Control provider.
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Include Other Users' Packages

Other users might be developing Packages in their own
models that you could use in your model, or you might have
other models containing Packages that you want to use in
the current model. Unless you are sharing an SQL database
or project file, those Packages are not automatically
available to you. However, if the Packages have been placed
into Version Control, you can import them into your model
as children of one of your model's Packages.

Access

Context
Menu

Right-click on Package > Package
Control > Get Package

Import Packages from Version Control into
current model

Ste
p

Action

1 On the 'Get Shared File' dialog, click on the
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drop-down arrow of the 'Version Control
Configuration' field and select the Version Control
configuration associated with the Package to
retrieve.
The file list is populated with the names of files
available through that configuration, for retrieval and
import into your model.

2 Click on the Package file to import into your model
and click on the OK button.
The Package file is imported as a new child Package,
under the parent Package you selected.

Notes

You must have access to the Package files through the·

Version Control system and you must define a Version
Control configuration through which to access those files

The Version Control configuration must use the same·

unique ID that was originally used to add the Package to
Version Control

XMI Package files associated with Packages that are·

already part of your project, are NOT included in the list
of files available for import
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Export Controlled Model Branch

Applying Version Control to a model can result in many
XMI files being placed under Version Control. It might then
be hard to locate and import the file corresponding to the
root of a particular model branch. Using Model Branch Files
(.eab files) overcomes this problem by making it easier to
export and import Package hierarchies from one model to
another.

You could export a newly created model branch from your
own private copy of a model so that, for example:

Another user can import that branch into their own private·

copy of the same model

It can be imported for inclusion as a common branch in a·

number of different models

Access

Context
Menu

Right-click on Package > Package
Control > Export as Model Branch

Create a Model Branch File to represent a
Package hierarchy stored in Version Control
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Ste
p

Action

1 On the 'Export as Model Branch' dialog, in the 'EAB
Filename' field, type a name for your Model Branch
File.
Alternatively, click on the  button and browse for
the file location.
Note that the Package name is supplied as a default.

2 Click on the OK button.
A branch file is created to represent the selected
Package. The branch file is committed to Version
Control using the same Version Control
configuration that controls the Package you selected.

Notes

You can specify any file name, including sub-folder·

names, as long as the file is contained in or below the
working folder of your Version Control configuration

The facility is only enabled for Packages that are already·

under Version Control
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Import Controlled Model Branch

Applying Version Control to a model can result in many
XMI files being placed under Version Control. It could then
be hard to locate and import the file corresponding to the
root of a particular model branch, if you want to:

Retrieve a model branch created by another user in a·

private copy of a model, to import it into your own private
copy of the same model

Retrieve a model branch that is common in many models,·

for inclusion in a new model

Model Branch Files overcome this problem by simplifying
the retrieval of Package hierarchies for use in other models.
You use Enterprise Architect's Model Branch Files, of
which there are few, to retrieve information about the root
Package file - such as the name and type of the Version
Control configuration for the selected Package, and the
relative filename of the Version Controlled XMI file
associated with the Package. The system then uses this
information to import the branch into your model.

Prerequisites

Before you begin, you must have:

An operational Version Control environment that can be·

accessed by Enterprise Architect, and

All of the Version Controlled Package files and the model·
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branch file associated with the model branch to import, in
a valid and accessible working copy folder

Access

Context
Menu

Right-click on target Package for import
> Package Control > Import a Model
Branch

Import a Model Branch

Ste
p

Action

1 On the 'Import VC Model Branch' dialog, either:
Use the lower portion of the dialog to select a·

model branch file (this is the simpler option if the
associated Version Control configuration has
already been saved in the current model; continue
to step 2)
OR
Click on the Find a Model Branch (.EAB) file·

button (this option is useful when you have not yet
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defined the Version Control configuration that is
associated with the model branch to be imported;
see the Manually Locating Model Branch Files
topic)

2 Click on the drop-down arrow in the 'Select a
Version Control Configuration' field and select a
configuration.
A list of .eab files controlled by that configuration is
displayed in the 'Select a Model Branch (.EAB) file'
list.

3 Select the Model Branch File you need, then click on
the OK button.
The system imports the root Package specified in the
Model Branch File and recursively imports and
populates all the sub-Packages contained in the root
Package.

Notes

The Import a Model Branch command is only enabled for·

Packages that you (the current user) are able to edit, as the
imported model branch is inserted into the model under
your selected Package
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Manually Locating Model Branch Files

When importing a Model Branch File from Version Control,
you might not have the associated Version Control
configuration saved in the model that is receiving the
import. In this situation, it is simpler to manually browse the
file system to locate the Model Branch File (.eab) and let
Enterprise Architect derive the details of the configuration
from the branch file you select.

Prerequisites

Before you begin, you must have:

An operational Version Control environment that can be·

accessed by Enterprise Architect, and

All of the Version Controlled Package files and the model·

branch file associated with the model branch to import, in
a valid and accessible working copy folder

Access

Context
Menu

Right-click on target Package for import
> Package Control > Import a Model
Branch : Find a Model Branch (.EAB)
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file

Locate the Model Branch File

Ste
p

Action

1 Access the 'Import VC Model Branch' dialog, then
browse for and select the Model Branch File that
represents the model branch to import.

2 Click on the Open button.
If the Version Control configuration referenced by
the file is fully defined within the current model, the
import commences at this point.
Otherwise, Enterprise Architect displays a dialog
prompting you to complete the required
configuration.

3 Click 'Yes' to proceed with completing the definition
of the Version Control configuration.
The 'Version Control Settings' dialog is displayed.

4 Complete the definition of the configuration.
(Typically this involves simply specifying the

(c) Sparx Systems 2022 Page 1959 of 1974



Modeling Fundamentals 3 October, 2022

working copy folder.)

5 Click on the Save button.
The configuration details are saved.
The import of the model branch proceeds.

Notes

The Import a Model Branch command is only enabled for·

Packages that you (the current user) are able to edit, as the
imported model branch is inserted into the model under
your selected Package
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Add Connectors To Locked Elements

Generally, when working in a diagram containing locked
elements, you cannot add a connector to a locked element.
However, this depends on the lock status of the source and
target elements (or more precisely, the lock status of the
parent Packages of the source and target elements, when the
source and target element are held in different Packages).
There are scenarios in which a connector can be created on a
locked element.

Lock Scenarios

Element
Status

Add Connectors

Source
unlocked,
target
unlocked

Yes, any kind of connector can be added

Source
unlocked,
target locked

Yes, except for Composition connectors

Source
locked, target

No, except for Composition connectors
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unlocked

Source
locked, target
locked

No, prohibited for all connectors

Notes

A connector can be added if its source is unlocked - you·

are modifying what the source can see

The exception is Composition connectors, where the·

target (the parent) must be unlocked - you are modifying
the parent by adding children
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Validate Package Configurations

Having defined the Version Control settings for your current
model, you can test the validity of those settings associated
with each Version Controlled Package within the model.

Access

Ribbon Settings > Version Control > Check
Configuration

Validate Version Control settings

Ste
p

Action

1 The validation process scans the model database and
verifies that the Version Control configuration
associated with each Version Controlled Package is
fully specified in the current model. It also queries
the corresponding Version Control provider to find
the status of the Package file associated with each
Version Controlled Package.
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The results of the validation process are sent to the
System Output window.

2 Open the 'Version Control Settings' dialog to
complete the definition of any invalid or missing
Version Control configurations.

3 Click on an error message in the System Output
window to highlight the corresponding Package in
the Browser window.

4 Right-click a Package node and select 'Package
Control | Configure Package' to open the 'Package
Control Options' dialog.
Correct any problems with the Version Control
details for the Package.
Correct any problems with the Package's associated
XMI file.
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Resynchronize the Status of Version
Controlled Packages

It is possible to update the Version Control status of
Packages within your project to re-synchronize with the
status reported by your Version Control provider. This can
be useful if you are creating copies of your project, where
checking in a Package from one copy of the model leaves
the Package in the second copy of the model with an
out-of-date Version Control status.

For a given Package, the re-synchronization process queries
the corresponding Version Control provider to find the
status of the Package file associated with the Version
Controlled Package. If necessary, the process then updates
the Package flags within the model database, to synchronize
the Package status recorded in the model with the value
reported by the Version Control provider.

Access

Ribbon Settings > Version Control > Re-Synch
Status (applies to all Packages in model)

Context
Menu

Right-click on Package > Package
Control > Re-synch Status With VC
Provider (applies to single Package only)
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Resynchronize Version Control status

Ste
p

Action

1 The results of the re-synchronization process are sent
to the System Output window.

2 Double-click on any result message to select, in the
Browser window, the corresponding Package.

Notes

This process does not cause any Package data to be either·

exported from your model to the associated Package file,
or imported from a Package file into your model's
Package data

If a Package has been checked-out and modified with·

Enterprise Architect, but your Version Control provider
reports the Package file as checked-in, running this
process marks the Package within Enterprise Architect as
being checked-in, without exporting and committing the
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pending changes; subsequently checking-out the Package
imports the latest revision of the Package file from
Version Control, effectively discarding the uncommitted
modifications from the model

Similarly, if a Package file is checked-out to you in your·

local working copy folder, but not in the Enterprise
Architect model, running this process marks the Package
within the model as checked-out, but it does not import
the associated Package file from the Version Control
system; consequently, it is possible to check-in a Package
from Enterprise Architect that is potentially out of date,
compared to the latest revision of the Package file within
the Version Control system
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More Information

Edition Information

Version Control facilities are available in the Professional,·

Corporate, Unified and Ultimate Editions of Enterprise
Architect.

A team needs to provide their own Version Control Server·

and Client that are compatible versions.

Notes

Sparx Systems strongly urge you not to manipulate·

Version Controlled Package files outside of Enterprise
Architect; it is possible to leave the Package files in a
state that Enterprise Architect cannot recognize

Database replication should not be combined with·

Version Controlled Packages

If the Packages under Version Control contain any·

alternative images and those images are subject to
frequent change, you can set the 'Export alternate images'
option on the 'Preferences' dialog to export the images to
the Version Control repository when you check in the
Packages; if the images are not subject to frequent change,
do not select this option and instead use 'Export/Import
Reference Data' to manage alternative images
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Compare Projects

Compares a Source and Target Repository for
Differences

The Compare Project facility provides a summary of the
changes to a repository by providing a comparison of the
number of rows in each system table in the source and the
target repositories. The modeling information contained in
an Enterprise Architect repository is stored in a set of tables
in a relational database. These are system tables that allow
you to compare the number of rows in each of the tables,
which will provide valuable insights into the differences
between two repositories. The tables (with rare exceptions)
have intuitive names as indicated by these examples:

t_attribute - stores element attributes·

t_diagram - stores diagrams·

t_object - stores elements·

t_package - stores Packages (folders)·
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Apart from the deliberate changes that you and other
modelers make when working on your repository, a number
of operations can also make changes to your project that you
either want to monitor carefully or that you do not want to
retain. Such events include:

Recovering from a database problem·

Restoring a backup·

Performing a Project Data Transfer·

Importing from XMI, and·

Deleting model elements·

You might have made a copy of the original project, or the
purpose of the operation is to generate a copy, in which case
you can compare the size and row counts of the 'before' and
'after' copies as a convenient 'sanity check' that the two
repositories are equivalent. The repositories can be on
different platforms and the comparison can be made
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between files and server based repositories as described
here:.

Compare a project file to another project file (e.g. a·

*.qeax file and a *.feap)

Compare a project file to a DBMS-based repository (e.g. a·

*.qeax file and an Oracle db)

Compare two DBMS repositories  (e.g. a MySQL db and·

an Oracle db)

The comparison examines the number of rows in each
database table, producing a report indicating the total
records in each and the difference in record count between
the two. If discrepancies are found, you would need to
investigate further manually. The comparison does not
examine the actual data in the tables but rather provides the
summary in the form of table row counts

Access

Ribbon Settings > Model > Integrity > Project
Compare

Compare two projects

Ste Action
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p

1 On the 'Project Compare' dialog, select the radio
button for the database types of the two projects you
want to compare:

File to File·

DBMS to File·

File to DBMS·

DBMS to DBMS·

2 In the 'Source Project' and 'Target Project' fields,
select the connection strings for the source and target
projects.

3 Click on the Compare Projects button.
The results of the comparison display in the panel at
the bottom of the dialog.

4 If you want to print the results of the comparison,
click on the Print List button.
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